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Chapter 1: Getting Started 

This chapter deals with common tasks that are necessary to understand before 

beginning to use Microsoft Dynamics CRM. 
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Common Tasks 

Getting Started and Finding Help 

Introduction to Microsoft Dynamics CRM 

Welcome to Microsoft Dynamics CRM 

Microsoft Dynamics CRM is designed to help your organization acquire and retain customers and reduce the time spent 

on administrative tasks. At its core, Microsoft Dynamics CRM provides a robust account management system that 

automatically tracks activities and revenue. Microsoft Dynamics CRM enables you to perform and automate many 

common business tasks, including:  

 Easily access information about business records from one place.  

 Schedule activities, track them, and send e-mail.  

 Generate reports.  

 Manage marketing lists.  

 Track advertising and marketing campaigns.  

 Sort customer responses to your sales and marketing initiatives.  

 Keep detailed notes and an activity history for each business record.  

 Microsoft Dynamics CRM also can run from within Microsoft Office Outlook.  

Sales Force Automation 

Sales departments can use Sales Force Automation to track sales-related activities and revenue. This system includes 

analytical, operational, and collaborative tools that you can use to improve and maintain good customer relations. Using 

Sales Force Automation, you can:  

 Qualify leads.  

 Manage contacts and accounts.  

 Track quotes, orders, and invoices.  

 Manage and track e-mail, phone call, and other communication activities with customers.  

 Run direct e-mail campaigns and measure their success.  

 Create and access a database of products that your organization sells.  

Marketing Automation 

Marketing departments can use Marketing Automation to manage many marketing-related activities. Using Marketing 

Automation, you can:  

 Create targeted marketing lists.  

 Plan and run campaigns.  

 Track each campaign response and lead generated from campaigns.  
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Customer Service Management 

The Customer Service area is designed specifically to meet the needs of customer support and product support 

departments that handle telephone, e-mail, and Web-based service requests from customers. Using the Customer 

Service area, you can:  

 Track individual cases and manage services.  

 Track and share common problems and solutions in a knowledge base.  

 Manage customer contracts.  

Appointment-based Service Scheduling 

Customer service representatives can manage service activities for your business. Using Service Scheduling, you can:  

 Define the services you offer.  

 Identify available resources and equipment for service activities.  

 Define work schedules for individual resources, as well as their locations.  

Reporting and Analysis 

Microsoft Dynamics CRM includes several features to help you generate reports and analyze data:  

 Run a default report.  

 Create an Advanced Find query to find a filtered set of records and then export the list for analysis.  

 Create a custom report using Microsoft SQL Server Reporting Services or other reporting tools.  

Customization 

System administrators can adapt Microsoft Dynamics CRM to fit the needs of their business organizations. Using the 

customization capabilities of Microsoft Dynamics CRM, you can:  

 Create new Microsoft Dynamics CRM entities, attributes, and application forms without custom 

programming.  

 Customize forms and views for enhanced integration with other Web applications, portals, and 

business systems.  

 Apply form validation and add client-side business logic through scripting.  

Workflow 

Beyond the business automation included in Microsoft Dynamics CRM, you can use additional workflows to further 

automate your organization's business logic. Then you can make your workflows available as an on-demand workflow 

or automatic workflow.  

Microsoft Dynamics CRM for Microsoft Office Outlook  

Microsoft Dynamics CRM for Outlook is a client application that provides the Sales Force Automation functionality of 

Microsoft Dynamics CRM within Outlook. When you run Microsoft Dynamics CRM for Outlook, you can work either in 

online or offline mode. 

Find Answers 

You can find information by using Help, the Resource Center, and Documentation Feedback.  
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Help 

Help provides conceptual overviews for each area and step-by-step procedures for tasks. Help topics may reference 

things that are unavailable or may differ from the Microsoft Dynamics CRM user interface for the following reasons: 

 Functionality depends on a user's security role. Some Microsoft Dynamics CRM lists, forms, and 

options are not available to all users. Help topics for restricted areas are marked with .  

 If your organization has created a new record type or customized existing record types, Help will not 

match the changes. For instructions about customizing help, see Customizing Help (Microsoft 

Dynamics CRM SDK).  

Help is updated periodically. You are currently reading Microsoft Dynamics CRM Help 4.1. To check to see if a more 

recent update is available, on the Microsoft Dynamics CRM Help menu, click Help Updates. You also can sign-up to 

receive notification of updates to Microsoft Dynamics CRM, including Help updates. More information: Manage 

Administration Settings  

Resource Center 

The Resource Center provides articles explaining how to do common tasks, and includes links to the Microsoft Dynamics 

CRM community newsgroups, blogs, and trainings. The Resource Center is updated regularly.  

Documentation Feedback 

The documentation team wants to make it easy for you to find answers. In every Help topic, you can rate whether it 

was helpful and tell us what you were looking for.  

All feedback must be in English. Your feedback will be used to make improvements to the Help and shape the content 

delivered to the Resource Center.  

Accessibility for People with Disabilities 

Microsoft is committed to making its products and services easier for everyone to use. Microsoft Dynamics CRM offers 

assistance through keyboard shortcuts to address issues faced by people with limited dexterity or motion disabilities.  

If you are using High Contrast settings in either your browser or operating systems, you should also set the High 

Contrast option in your personal options.  

More information: Set Personal Options 

Note 

For more information about features, products, and services that make Microsoft products more accessible for all users, 

on the Start menu, click Help and Support, and then click Accessibility.  

Welcome to the Resource Center 

The Resource Center brings together information that will help you get the most from your use of Microsoft Dynamics 

CRM. The Resource Center provides a central location where you can find:  

 Information to help you get started.  

 Tips to make you more productive.  

 In-depth descriptions of product features and recommendations for using them to build your business.  

 Examples and advice from subject matter experts.  

 Easy access to other online resources related to Microsoft Dynamics CRM.  

 Search tools that help you find information related to Microsoft Dynamics CRM within the Resource 

Center and on other resources available on the web.  

http://go.microsoft.com/fwlink/?LinkId=97598
http://go.microsoft.com/fwlink/?LinkId=97598
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Information in the Resource Center is regularly updated and organized to help you quickly find the information you 

need.  

 The Highlights page shows you new content or content that has been highly rated.  

 The Sales page groups information that will be of interest to salespeople, sales managers, and 

executives focused on using Microsoft Dynamics CRM to increase sales.  

 The Marketing page focuses on information that shows how to identify and qualify leads using 

Microsoft Dynamics CRM.  

 The Service page provides insight about how you can use Microsoft Dynamics CRM to provide 

superior customer service and manage the services you provide.  

 The Settings page is where you will find more technical information about configuring and 

customizing Microsoft Dynamics CRM to support all aspects or your business.  

Use Keyboard Shortcuts 

The shortcut keys described in this section refer to the U.S. keyboard layout. Keys on other layouts might not 
correspond exactly to the keys on a U.S. keyboard.  

 

 General keyboard shortcuts  

To Press 

Copy text. CTRL+C 

Paste text. CTRL+V 

Undo previous text change. CTRL+Z 

Save a record. CTRL+S 

Close a record. CTRL+F4 

Cut text. CTRL+X 

Delete text. DELETE 

Delete selected text immediately without putting it 

on the Clipboard. 

SHIFT+DELETE 
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Move the insertion point to the start of the next 

word. 

CTRL+RIGHT ARROW 

Move the insertion point to the start of the previous 

word. 

CTRL+LEFT ARROW 

Select all text in the current field. CTRL+A 

Display the System menu for the active window. ALT+SPACEBAR 

Move forward through the form's fields. TAB 

Move backward through the form's fields. SHIFT+TAB 

Display the shortcut menu for the selected item. SHIFT+F10 

Display the corresponding menu. ALT+the key for the underlined letter in the menu 

name. 

Cancel the current task or command, or close a 

selected list or dialog box. 

ESC 

Move up through a list of records. UP ARROW 

Move down through a list of records. DOWN ARROW 

Expand or collapse the preview in a list view. SPACEBAR 

Open the selected record. ENTER 

Select all records on the current page. CTRL+A 

 

 Dialog box keyboard shortcuts  
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To Press 

Move to the next option or option group. TAB 

Move to the previous option or option group. SHIFT+TAB 

Complete the command for the active option or 

button. 

ENTER 

Move between options in an open list, or between 

options in a group of options. 

ARROW keys 

Cancel a command, or close a selected list or dialog 

box.  

ESC 

 

 Form keyboard shortcuts  

To Press 

Save.  CTRL+S or SHIFT+F12 

Save and close. ALT+S 

Expand or collapse Form Assistant. CTRL+SHIFT+F 

Cancel edits and close (Close). ESC 

Delete the record. CTRL+D  

Save and then open a new form (Save and New). CTRL+SHIFT+S 

 

 Accessibility keyboard shortcuts  

In a computer running on Microsoft Windows, you can set system accessibility options to change the way 
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you work. For example, you can use Windows Sticky Keys if you have difficulty holding down two or more 

keys at a time, such as CTRL+P. Sticky Keys enable you to press the CTRL key and have it remain active 

until you press the P.  

To Press 

Switch Sticky Keys on and off. SHIFT five times 

Switch Filter Keys on and off. RIGHT SHIFT for eight seconds 

Switch Toggle Keys on and off. NUM LOCK for five seconds 

Switch High Contrast on and off. LEFT ALT+LEFT SHIFT+PRINT SCREEN 

Switch Mouse Keys on and off. LEFT ALT+LEFT SHIFT+NUM LOCK 

 

Managing Records 

Find Things 

There are several ways to locate a specific record when you're working with a list of records, or when you're filling out a 

form. With Advanced Find, you can also save your search as a saved view to use again later.  

 

Find records in a list 

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Common Task Permissions  

 

 

 Use one of the following methods to find records in a list:  

 Filter a list 

Select a view from the View drop-down list at the top of any list of records. Some lists, such as Activities 

and History, provide additional choices to help filter a list.  

The View list includes two types of views: System Views and My Views.  

 Search for a text string 

In the Search for records box, type a few letters to narrow your search, and then click the Lookup 
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button .  

Use an asterisk (* ) as a wildcard if the text you're looking for is not at the beginning of a field. For 

example, to find all records that contain the word "advanced" in the searched columns, enter *advanced.  

Important The search is not related to the view currently selected in the View menu. Only active records 

are returned.  

 Tip 

For each record type, which fields are searched can be customized. By default, the following 

fields are searched:  

 Account: Account Name, Account Number, E-mail  

 Activity and individual activity types including Appointment, E-mail, Letter, Fax, and 

Phone Call: Subject  

 Campaign: Campaign Code, Name  

 Case: Title, Case Number  

 Contact: Full Name, First Name, Middle Name, Last Name, E-mail, Case Number  

 Contract: Contract Name  

 Lead: Company Name, First Name, Last Name, Name, Topic  

 Marketing List: Name  

 Opportunity: Topic  

 Quote, Order, Invoice: Name  

 Product: Product Name, ID  

 Sales Literature: Title  

More information: Work with Entities.  
 

 Sort a list 

 To sort a list of records, click a column heading. To reverse the sort order, click the column 

heading again.  

An arrow icon in the column heading shows that the list is sorted: the Ascending Sort icon 

indicates ascending, and the Descending Sort icon indicates descending.  

 To sort by an additional column, press SHIFT while you click the additional column heading.  

You cannot sort by columns that display data from a related record type.  

 Use Advanced Find to filter the list 

1. To start an Advanced Find search:  

In the View box, select the view that is closest to what you want, and then on the Standard 

toolbar, click Advanced Find.  

- OR -  
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On the Actions toolbar, click Advanced Find.  

2. Specify criteria for your search and the columns to display.  

More information: Work with Advanced Find  

 Create your own view 

1. To start an Advanced Find search:  

In the View box, select the view that is closest to what you want, and then on the Standard 

toolbar, click Advanced Find.  

- OR -  

On the Actions toolbar, click Advanced Find.  

2. Specify criteria for your search and the columns to display.  

More information: Work with Advanced Find  

3. Click Save As.  

4. In the Query Properties dialog box, in the Name field, type a name for the search.  

5. In the Description box, type a brief description, and then click OK.  

The search is saved as a view and appears on the Saved Views tab of the Advanced Find form. 

This new view is also available from the list page for the record type in the View box, in the My 

Views section. 

 Go to the next page of records 

If there is more than one page of records available to view in the list of records, use the Page arrows at 

the bottom of the list to view the additional pages.  

 Use the alphabetical index 

For lists that include an Index at the bottom of the list:  

 To view records with the information in the sorted column that begin with a specific letter, click 

the letter.  

 To view records with the information in the sorted column that begin with 0-9, click #.  

 To view all records, click All.  

Tips 

 To make sure a list of records is current, at the top of the list, click the Refresh button , or right-

click any record and then click Refresh list.  

 To preview a record, click the Preview button  next to the record. To close the preview, click the 

Close Preview button .  

 To see the exact criteria used for any saved view and most system views, select the view, on the 

Standard toolbar click Advanced Find, and then click Show Details.  

 It is not possible to find or retrieve deleted records.  
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 In any list, select multiple records:  

o Select several records by pressing the CTRL key while you click each record.  

o Select a sequence of records by clicking the first record that you want, and then press the 

SHIFT key while you select the last record that you want.  

o Select all records on the page by selecting the Select/clear all records on this page 

check box at the top of the list.  

 By default, the Microsoft Dynamics CRM Web application displays 50 records per page. You can 

increase the number of records displayed and thereby increase the number of records you can 

select at one time. To display up to a maximum of 250 records per page:  

1. On the Tools menu, click Options.  

2. On the General tab, in the Records Per Page list, select the number of records to display 

per page.  

3. Click OK.  

This changes the number of items that is displayed for all lists, which may slow response time when you 

switch record types. Therefore, you might want to set it back to a smaller number when you are done with 

this bulk action.  

Find records while filling out a form  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Common Task Permissions  

 

 

 When you fill out a form and need to select a record in a field, you can use the Lookup button , 

or in some forms, you also can use the Form Assistant pane.  

 Use the Lookup button 

1. Click the Lookup button .  

2. In the Look for box, if needed, select a record type, enter some letters to search for, and then 

click the Find button .  

3. Select the record, click the Add Selected Records button , and then click OK.  

4. In the Advanced Find page, click Find.  

– OR –  

Use the Form Assistant pane:  

 To show or hide the Form Assistant pane, in the title bar of the pane, click the Expand 

button  or Collapse button .  

 To collapse or expand an individual section, in the title bar of the section, click the Collapse 

button  or the Expand button .  

file:\\crmshare\Users\abecraft\Modified_Help_for_Print\content\how_sec_commontasks.htm
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 To select a record:  

1. Put the insertion point in the text box for which you want to search for a record.  

If a suggestion is available, the Form Assistant pane filters and displays the appropriate 

records.  

2. In the Form Assistant pane, click a record.  

The appropriate data fills the text box.  

 To create follow-up activities related to the open record:  

1. From an open record, on the Actions toolbar, click Follow Up .  

The Form Assistant pane displays a partially completed activity.  

2. Select the activity type.  

You cannot create a follow up task activity for an e-mail activity created with a quick 

campaign. Select a phone call, letter, fax, e-mail or appointment activity.  

3. Complete the required fields.  

4. Click Save or Save and Open.  

Create, edit, or save an Advanced Find search  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Common Task Permissions  

 

 

1. On the Standard toolbar, click Advanced Find.  

Tip: Advanced Find starts with criteria based on where you are in Microsoft Dynamics CRM. If you 

click Advanced Find from a view, the criteria for that view will be preloaded for you.  

– OR –  

To edit a saved search, on the Standard toolbar, click Advanced Find, click the Saved Views tab, 

and then double-click the saved view.  

2. Specify the search criteria.  

 If Show Details is visible in the criteria toolbar, click it.  

a.  Specify what to search for 

b. In the Look for list, select the type of record you want to search for, such as 

Accounts, Leads, or Users.  

c. Click Select to select criteria for the search, including the field to search on (for 

example, Account Name or City), the query relational operator, and the values to 

locate (for example, "Seattle" or "E-mail").  

You can select fields from the current record type, or from related records.  

 For some values, you can click the Lookup button  to open the Select Values dialog 

box and select the value you want.  

At the bottom of the Select list, the Related section shows related record types are. When you select a 
related record type, a new Select link appears to select fields from this related record type.  

file:\\crmshare\Users\abecraft\Modified_Help_for_Print\content\how_sec_commontasks.htm
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 Clear, delete, or group search criteria clauses 

 Clear all search criteria to start over.  

a. Click Clear to remove all criteria.  

b. In the confirmation message, click OK.  

 Delete a row of search criteria.  

 . Click the Options menu button  next to a search criteria row, and then click Delete.  

a. In the confirmation message, click OK.  

 Group criteria.  

 . Click the Options menu button  next to a search criteria row, and then click Select 

Row.  

To group search criteria, you must select two or more rows for the same record type. 

For example, Sales Stage and Est. Revenue are both field values in the Opportunity 

record type and two rows that specify search criteria for these fields can be grouped. 

However, rows with field values from Account and Opportunity record types cannot 

be grouped.  

a. On the Filter toolbar, select Group AND or Group OR.  

b. Repeat steps a and b to create additional criteria groups.  

 Select and deselect grouped criteria.  

 . Click the Options menu button  next to a search criteria row that has been 

selected, and then click Deselect Row. You can unselect rows from a group or 

individually.  

a. Click the Options menu button  next to the group, and then click Select Group 

to select a group, or click Deselect Group to unselect a group that has been previously 

selected.  

 Add a search criteria clause to a criteria group.  

 . Click the Options menu button  next to the group, and then click Add Clause.  

a. Add search criteria to the new clause.  

 Ungroup rows of criteria that you have grouped together using Group AND or Group OR.  

 . Click the Options menu button  next to the group you want to ungroup, and 

then click Ungroup.  

a. Repeat this step to ungroup additional search criteria groups.  

 Change a Group AND group to a Group OR group, or a Group OR group to a Group AND 

group.  

 . Click the Options menu button  next to the group, and then click Change to 

OR or Change to AND.  

a. Repeat this step to change additional search criteria groups.  

 Hide or delete a row in Simple view:  

 . To hide a row, click the Options menu button  next to a search criteria row, and 

then click Hide in Simple Mode.  

a. To make a hidden row visible, click Show in Simple Mode  
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 Specify the columns to include in the search results.  

 . Click Edit Columns, and then click Add Columns.  

a. Select the record type that includes the columns you want to add.  

b. Select the check box next to the columns you want to add. If a column isn't listed, contact 

your system administrator. 

c. Click OK.  

d. The following options are also available:  

 To adjust the width of a column, click the column, click Change Properties, select a 

width, and then click OK.  

 To reorder columns, select a column, and use the arrow keys to move it to the left or 

right.  

 To remove a column, select it, and then click Remove.  

e. Click OK.  

 Specify the sort order.  

 . Click Edit Columns, click Configure Sorting, and specify the column to sort on, and the 

sort order.  

Tip: Each view is sorted by only one column. However, after you click Find, you can sort by 

additional columns. To sort a search results list by an additional column, press SHIFT while 

you click the additional column header.  

You can only sort on columns from the primary record type.  

f) Save the search as a saved view.  

a. If you're saving an existing saved view, click Save. If you are saving a new view or want to 

change the name of the view because you changed the criteria, click Save As.  

b. In the Query Properties dialog box, in the Name field, type a name for the search.  

c. In the Description box, type a brief description, and then click OK.  

The search is saved as a view and appears on the Saved Views tab of the Advanced Find 

form. This new view is also available from the list page for the record type in the View box, 

in the My Views section. 

 Click Find. The selected records are displayed.  

 Click Back to Query to return to the Find tab.  

Tips 

 When you specify search criteria to find activity records, you can either search through all types of 

activities or select one type of activity to search, such as Task or Appointment.  

 The columns that are displayed by default are controlled by the Advanced Find View for the record 

type. More information: Work with Entities.  

 If you need to search based on the names of people who participated in an activity, in the Advanced 

Find criteria, you must search fields in the related activity party. You can search based on the 

person's name (Party field), or by their role in the activity, such as sender or recipient 

(Participation Type field).  

For example, to find e-mail messages sent to a specific contact:  
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a. In the Activities list, in the Type box, select E-mail.  

b. Click Advanced Find, and then click Show Details.  

c. Click Select, and then in the Related section, select Activity Parties (Activity).  

d. Under Activity Parties (Activity), click Select.  

e. In the Fields section, click Participation Type, click Enter Value, and then click the 

Select Values button .  

f. In the Available Values list, select To Recipient, click the Add Selected Records 

button , and then click OK.  

g. Under Activity Parties (Activity), click Select.  

h. In the Fields section, click Party.  

i. Click the Equals Current User operator, and change it to Equals.  

j. Click Enter Value, and then click the Lookup button .  

k. In the Look for box, select Contact, enter some letters to search for, and then click Start 

search.  

l. Select the contact, click the Add Selected Records button , and then click OK.  

m. In the Advanced Find page, click Find.  

Note 

You cannot use Advanced Find to find records related to quick campaigns.  

Working with saved Advanced Find searches  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Common Task Permissions  

 

 

 You can run, share, assign, delete, or deactivate a saved view that you own.  

If another user has shared a saved view with you, what you can do will depend on the specific 

privileges they have given to you: Share, Assign, Delete, or Write.  

 Run a saved search 

On any list page in the View box, in the My Views section, select a saved view.  

If there is not a My Views section, there are no saved searches for this record type.  

– OR –  

On the Standard toolbar, click Advanced Find, and then click the Saved Views tab. Double-click a saved 

search, and then click Find.  

 Share a saved search 

1. On the Standard toolbar, click Advanced Find, and then click the Saved Views tab.  
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2. Select the view. On the Actions toolbar, click More Actions, and then click Sharing.  

3. In the sharing dialog box, under Common Tasks, click Add User/Team.  

4. In the Look Up Records dialog box, in the Look for list, select the type of record you want to 

find.  

5. In the Search for records box, type the first few letters of the name of the record to narrow 

your search, and then click the Find button .  

6. In the list of available records, click a user or team to select it, and then click the Add Selected 

Records button  to add the user or team to the Selected records list.  

7. Click OK.  

8. In the sharing dialog box, select the type of share access that you want. The available permissions 

are: Read, Write, Delete, Append, Assign, or Share.  

9. Click OK.  

The saved view will show up in the My Views section of your coworker's View list.  

Tips  

 To cancel any changes that you have made and retain the previous permissions settings, click 

Reset.  

 To select or clear all permissions on a selected item, click Toggle All Permissions of the 

Selected Items.  

 Assign a saved search 

1. On the Standard toolbar, click Advanced Find, and then click the Saved Views tab.  

2. Select the view, and then on the Actions toolbar, click the Assign button .  

3. In the Assign dialog box, click:  

 Assign to me  

Use this option to assign the record to yourself.  

– OR –  

 Assign to another user  

Click the Lookup button , type a part of the user's name, click the Find button 

, double-click the user's name, and then to close Look Up Records dialog box, 

click OK.  

4. Click OK.  

 Deactivate a saved search 

1. On the Standard toolbar, click Advanced Find, and then click the Saved Views tab.  

2. Select the view, and then on the More Actions menu, click Deactivate.  
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 Delete a saved search 

3. On the Standard toolbar, click Advanced Find, and then click the Saved Views tab.  

4. Select the view, and then on the Actions toolbar, click the Delete button .  

 E-mail or copy a link to a saved search 

Send a shortcut in an e-mail  

1. On the Actions toolbar, click Send Shortcut, and then click Of Current View.  

2. Complete the e-mail form and send. 

Copy a shortcut  

3. On the Actions toolbar, click Copy Shortcut, and then click Of Current View.  

4. Paste the shortcut into any application that supports copy and paste. For example, in Microsoft 

Office Word, press CTRL+V.  

More information: Send or Copy a Shortcut  

Delete Things 

Caution  Once you delete a record, it cannot be retrieved.  

Typically you should only delete records that you entered by mistake. For some record types, you can deactivate or 

close the record instead. Not all record types can be deleted. For details, select Special cases.  

Delete records  

 Can I do this task?  

If the Delete button  is not visible on the toolbar, the security role assigned to your account does 

not have permission to delete this type of record. To check your permissions for a specific record, open 

the record, click the File menu button , and then click Properties.  

If you are deleting a record that has child records, you can delete it only if you also have permission to 

delete any child records.  

More information about specific permissions and performing this task while offline: Common Task 

Permissions  

 

 

1. In any list of records, select the record that you want to delete.  

– OR –  

In any list, select multiple records:  

 Select several records by pressing the CTRL key while you click each record.  

 Select a sequence of records by clicking the first record that you want, and then press the 

SHIFT key while you select the last record that you want.  
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 Select all records on the page by selecting the Select/clear all records on this page check 

box at the top of the list.  

 Tip 

By default, the Microsoft Dynamics CRM Web application displays 50 records per page. You can increase 

the number of records displayed and thereby increase the number of records you can select at one time. To 

display up to a maximum of 250 records per page:  

4. On the Tools menu, click Options.  

5. On the General tab, in the Records Per Page list, select the number of records to display 

per page.  

6. Click OK.  

This changes the number of items that is displayed for all lists, which may slow response time when you 

switch record types. Therefore, you might want to set it back to a smaller number when you are done with 

this bulk action.  

 On the Actions toolbar, click the Delete button .  

 If you are deleting accounts or contacts, you have the option to deactivate the record 

instead of deleting it. In the Delete Confirmation dialog box, to delete the record, click Delete, 

or to deactivate it, click Deactivate.  

For other record types, in the Confirm Deletion dialog box, click OK.  

Notes 

 When you delete a record, all its relationships to other records are also deleted.  

 If the record has child records, and you have permission to delete the child records, the child records 

will also be deleted.  

Special Cases   

Record Type Notes 

More 

Information 

Accounts Can also be deactivated. Work with Accounts 

Activities in Queues When you delete an e-mail message in 

a queue, it is removed from the 

queue, but is not deleted as an active 

activity. To delete it, you must delete 

it from the Activities list.  

When you delete other activity types 

from a queue, the activity record is 

deleted both from the queue and from 

Work with Queues 
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Microsoft Dynamics CRM.  

Business Units Can be deactivated, but not deleted.  Work with Business Units 

Cases Can also be canceled.  Work with Cases 

Contacts Can also be deactivated.  Work with Contacts 

Knowledge Base Articles Articles must be unpublished from the 

knowledge base before being deleted.  

Work with Articles 

Invoices Canceled or completed invoices cannot 

be deleted. Completed invoices can be 

canceled.  

Work with Invoices 

Leads Can also be disqualified.  Work with Leads 

Marketing Lists Can also be deactivated.  Work with Marketing Lists 

Orders Only active orders can be deleted. As 

an alternative, orders can be canceled.  

Work with Orders 

Opportunities Can also be closed.  Work with Opportunities 

Price Lists Can also be deactivated.  Work with Price Lists 

Products Can only be deleted from the product 

catalog in the Settings area.  

Work with Products 
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Quick Campaigns Deleting a quick campaign record 

deletes all of the activities created by 

the quick campaign, even if those 

activities were not yet complete.  

Work with Quick Campaigns 

Quotes Only draft quotes can be deleted. You 

can select Revise on the Actions menu 

to return an active quote to draft 

status.  

Work with Quotes 

Services Can be deactivated, but not deleted.  Work with Services 

Teams Can remove members, but cannot 

delete or deactivate.  

Work with Teams 

Users Can be deactivated, but not deleted.  Manage a User's Record 

Remove an attached file  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Common Task Permissions  

 

 

1. Open the record that you want.  

2. For most record types, click the Notes tab.  

 On the E-mail form, click the Attachments tab.  

 On the Service Activity form, click the Service Activity tab.  

 On the Case form, click the Notes and Article tab.  

3. Double-click the status row of the note that contains the attachment you want to remove.  

4. To keep the note, but remove the attachment, in the Note form, in the File Attachment area, click 

Remove, click OK, and then click OK again.  

– OR –  

To remove the note and the attachment, on the Actions  menu, click Delete Note, and then 

click OK.  

5. Click Save or Save and Close.  
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Note 

You cannot update an attached file. Instead, save the file on your computer and edit the file, delete the attachment, 

and then attach the edited file.  

Print Things 

Print the details of a record  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Common Task Permissions  

 

 

1. In the list of records, open the record that you want.  

2. On the Actions toolbar, click the Print button .  

3. In the Preview form, click Print.  

4. In the Print dialog box, select the print options you want, and then click Print.  

5. On the Standard toolbar of the Preview form, click Close.  

Note 

To print a note, open the record, click the Notes tab, right-click the note that you want, and then click Print.  

Print a list of records  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Common Task Permissions  

 

 

1. On the Actions toolbar, click the Print button .  

2. If the records in the list extend beyond the current view, you will see the Print List dialog box.  

To print a list that is limited to the items listed on the current page, click All records on 

current page, and then click OK.  

– OR –  

To print a list of all items that are on all pages for that view, click All records on all pages, and 

then click OK.  

3. In the Preview form, click Print.  

4. In the Print dialog box, select the print options you want, and then click Print.  

5. On the Standard toolbar of the Preview form, click Close.  

Tips 
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 By default, the Microsoft Dynamics CRM Web application displays 50 records per page. You can 

increase the number of records displayed and thereby increase the number of records you can select 

at one time. To display up to a maximum of 250 records per page:  

1. On the Tools menu, click Options.  

2. On the General tab, in the Records Per Page list, select the number of records to 

display per page.  

3. Click OK.  

This changes the number of items that is displayed for all lists, which may slow response time when 

you switch record types. Therefore, you might want to set it back to a smaller number when you are 

done with this bulk action.  

 If you need to print other columns than the ones in the list, use Advanced Find to create a new view 

that includes all the columns you need. More information: Work with Advanced Find  

 If you want to format the list before printing it, export the list to Microsoft Office Excel, and format it 

there. More information: Export Data to Excel  

 When you print a list, a title describing the list is not included. If you need a title on your printout, 

export the list to Microsoft Office Excel, add a title, and then print the worksheet.  

Print the details of an activity from a calendar  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Common Task Permissions  

You can print the details of an appointment or service activity from the Workplace calendar or the Service calendar.  

 

1. Locate and open the appointment or service activity you want to print.  

2. On the Actions toolbar, click the Print button .  

3. In the Preview dialog box, click Print.  

4. In the Print dialog box, set the printing options you want, and then click Print.  

5. On the Standard toolbar, click Close.  

Note 

To print the entire calendar as you see it in the window, click Print in Microsoft Internet Explorer.  

Run a report  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Report Permissions  

 

 

1. Find and open a report:  
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 From the Reports area  

a. In the Workplace, under My Work, click Reports.  

b. To narrow the list, enter the first few letters of the report name, or use the asterisk (*) wildcard in 

the Search for records box and then click the Find button . You can also select a view.  

c. In the reports list, double-click the report that you want to run.  

If the report has a default filter, the default filter will be displayed. Follow step 2 to change the filter.  
Tip: To run a report without seeing the default filter, select the report, and then on the Actions toolbar, 
click More Actions, and then click Run Report.  

 From a list of records, including the results of an Advanced Find search  

Only reports that relate to the current record type will be available.  

You can run some reports on all records in the list, up to ten selected records, or without limiting the 

records as if you were running the report from the Reports area.  

 To run a report on all records on the list:  

a. On the Actions toolbar, click Reports .  

b. Under Run on Selected Records, click the name of the report.  

c. In the Select Records dialog box, click All records on all pages in the current view, 

and then click Run Report.  

 To run a report on up to ten selected records from the list:  

a. Select the records to include. Select several records by pressing the CTRL key while you 

click each record.  

b. On the Actions toolbar, click Reports.  

c. Under Run on Selected Records, click the name of the report.  

d. In the Select Records dialog box, click The selected records, and then click Run 

Report.  

 To run a report without limiting records to items on the list:  

a. On the Actions toolbar, click Reports.  

b. If the report is listed under Run on All Records, select the report.  

– OR –  

Under Run on Selected Records, click the name of the report. In the Select Records 

dialog box, click All applicable records, and then click Run Report.  

– OR –  

If the report you want to run is not listed, you must go to the Reports area to run the 

report.  
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 From a record 

Only reports that relate to the current record type will be available.  

To run a report including data from just one record:  

a. With a record open, on the Actions toolbar, click Reports .  

b. Under Run on Current Record, click the name of the report.  

 From Microsoft Dynamics CRM for Outlook  

All reports can be run when you are online.  

To run a report while you are offline, you must first create a local data group that includes the report, as 

well as a local data group that includes any data that should be included in the report.  

To create a local data group that contains reports, on the CRM menu, click Modify Local Data Groups, 

click New, select the the Report record type, and then define the criteria for which reports to include. 

More information: Work with Data to Take Offline  

 To run reports from the Reports area, in the Outlook Navigation Pane, under Microsoft 

Dynamics CRM, click Workplace, click My Work, click Reports, and then select a report to 

run.  

 To select a report from a record or list, follow the procedures above. These steps work the same 

way in Microsoft Dynamics CRM for Outlook.  

 From a report you saved locally 

If you have saved a report on your computer or shared file system that reads dynamic data from Microsoft 
Dynamics CRM, to open it, browse to the folder that contains your saved report, and double-click the file.  

 If the report offers filter criteria, if needed, modify the filter criteria and then click Run 

Report.  

The list of existing report filtering criteria is grouped by record types that you can use in the filter, 

such as Accounts or Contacts.  

To edit a parameter in simple mode, click the underlined value and enter a new value.  

– OR –  

To edit the filter criteria in detailed mode:  

 . Click Edit Filter.  

a. To add a criteria row:  

1. In the area for the record type that the field belongs to, click Select, and specify the 

field to filter on.  

2. Click the query relational operator, and select an operator.  

file:\\crmshare\Users\abecraft\Modified_Help_for_Print\content\ui_ol_offlineconfiguration_form.htm
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3. Click Enter Value, and enter a value to filter on. For some values, you can click the 

Select Values button  to open the Select Values dialog box and select the 

value you want.  

b. To group criteria, you must select two or more rows for the same record type. For example, 

Sales Stage and Est. Revenue are both field values in the Opportunity record type and 

two rows that specify filter criteria for these fields can be grouped. However, rows with field 

values from different record types, such as Account and Opportunity record types, cannot 

be grouped.  

0. For each row you want to group, in detailed mode, click the Options menu 

button  for that row, and then click Select Row.  

1. On the Filter toolbar, select Group AND or Group OR.  

2. To remove a row from a group, click the Options menu button  for that row, and 

then click Delete.  

3. To select a group, click the Options menu button  for that group, and then click 

Select Group.  

4. To add a criteria clause to a group, click the Options menu button  for that group, 

click Add Clause, and then select the field, query relational operator, and value.  

5. To unselect a group that has been previously selected, click the Options menu 

button  for that group, and then click Deselect Group.  

6. To ungroup a group, click the Options menu button  for that group, and then 

click Ungroup.  

7. To change a Group AND group to a Group OR group, or a Group OR group to a 

Group AND group, click the Options menu button  for that group, and then click 

Change to OR or Change to AND.  

 Tips 

 To clear all criteria and start over, on the Filter toolbar, click Clear, and then click Confirm.  

 To delete a row, click the Options menu button  for that row, and then click Delete.  

 To hide a row in simple mode, while you are in detailed mode, click the Options menu 

button  for that row, and then click Hide in Simple Mode.  

 If you have a hidden row when viewing filter criteria in simple mode and you want to show that 

row again, then in detailed mode, you must click the Options menu button  for that row, and 

then click Show in Simple Mode.  

 You can set your personal options so that report filters and Advanced Find criteria always open in 

simple or detailed mode. More information: Set Personal Options  

 If the report offers parameters, if needed, modify the parameters and then click View 

Report.  

 Locate data in the report.  

 To view or change a record, click the first field in the row for the record. A separate Microsoft 

Dynamics CRM window will open with the record.  

 To view all records associated with a summary or chart report, click Show All at the bottom 

of the report. To navigate back to the original report, click Original Report in the report title 

area.  
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 To view detailed information about an area in a chart, click an area of the chart. To navigate 

back to the original report, click Original Report in the report title area.  

 To page through the report, on the Report toolbar, use the Page Navigation 

buttons . To locate a specific page, type a page number in the box 

and then press Enter.  

 To quickly locate specific information in your report, in Find | Next, type a few characters, 

and then click Find.  

 To sort a column, click the column title. The direction of sorting is indicated by the 

Ascending sort button  or the Descending sort button .  

 To view or hide the filter summary, expand or collapse Filter Summary.  

 To update your report, click the Refresh button .  

 To hide the report parameters, click the Hide Parameters button . To display the report 

parameters, click the Show Parameters button .  

 Print the report. On the Report toolbar, click the Print button .  

If you are working offline using Microsoft Dynamics CRM for Outlook, on the Report toolbar, select 

Web archive format, click Export, and then on the File menu, click Print.  

Tips  

 If a chart doesn't display the first time you export a report to Web archive format, export 

the report a second time.  

 To print reports, you need a Reporting Services Microsoft ActiveX control. The first time you 

print a Reporting Services report from either Microsoft Dynamics CRM or Microsoft Dynamics 

CRM for Microsoft Office Outlook, you will see a prompt Do you want to install this 

software?.  

To install the required control, click Install.  

 Export the report.  

Important The exported report is temporary. If you need to save the exported report to a local 

file, use the viewing program to save the file to disk. The saved exported report is no longer 

connected to Microsoft Dynamics CRM. Therefore, it does not change if Microsoft Dynamics CRM 

data changes.  

 . In the Export box, select a format, and then click Export.  

A second browser window is used to display the report, using a viewer associated with the 

export format you selected.  

The formats that are available are determined by the rendering extensions that are installed 

on the Microsoft SQL Server Reporting Services report server, and also by whether you are 

online or offline.  

 If you are working offline, only the Excel and Acrobat (PDF) file formats are 

available.  

 If you are using Microsoft SQL 2005 Workgroup edition, the XML file with report 

data format is not available.  

If a viewer is not available for the format you select, you must select a different format or 

install the viewer.  
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The following export formats are included in a default installation when you are online. The 

list of export formats available to you may vary from those listed here.  

 Excel  

View the report in Microsoft Office Excel. This format includes all the row, column, and 

field labels, in addition to report formatting.  

Large reports and reports with charts might not display with the expected formatting 

when exported in this file format. To export only the data, instead of using this format, 

from any list in Microsoft Dynamics CRM, including results of Advanced Find searches, 

export the data into Microsoft Office Excel, and then save as a comma-delimited (CSV) 

file. More information: Export Data to Excel  

 Web archive  

View the report in Microsoft Internet Explorer, as a MIME-encoded HTML format that 

keeps images and linked content together with a report. For chart reports, if the chart 

is not displayed correctly the first time that you export the report, export the report 

again.  

Choose this format to view a report offline or for e-mailing the report.  

 Acrobat (PDF) file  

View the report using a client-side PDF viewer. You must have Adobe Acrobat Reader 

to use this format.  

Choose this format for long reports, paginated reports, or reports that are delivered as 

a file.  

 TIFF file  

View the report in the default TIFF viewer. For some Windows clients, this is the 

Windows Pictures and Fax Viewer.  

Choose this format to a view a report in a page-oriented layout. The TIFF format is the 

recommended format for printing reports.  

 CSV (comma delimited)  

View the report as a text file, with fields separated by commas. This format includes all 

the row, column, and field labels.  

To export only the data, instead of using this format, export data from any list in 

Microsoft Dynamics CRM, including results of Advanced Find searches, into Microsoft 

Office Excel, and then save as a comma-delimited (CSV) file.  

 XML file with report data  

View the report as an XML file.  

Tips 

 If there is no report that gives you the information you need, you can either export data to Microsoft 

Office Excel, or create your own report. More information: Export Data to Excel, Create and Work 

with Reports  

 If a snapshot of a Reporting Services report exists, you can view it from the Reports area. To see if 

any snapshots exist for a report, click the View Snapshots button  next to the report. If a 

snapshot exists, click the snapshot link to view the snapshot.  

Note 

If multiple Language Packs are installed, only reports that are marked for display in the language you specified in 

Personal Options will be visible. More information: Set Personal Options  
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Manage Activities 

Create or edit an activity  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Common Task Permissions  

 

 

1. Navigate to activity records. In the Navigation Pane, click Workplace, and then under My Work click 

Activities.  

– OR –  

To work with activities associated with a record, open the record and then click Activities.  

2. To add new activities from the Activities list, on the Actions toolbar, click New.  

– OR –  

To add a new activity from a record, click New Activity. You can also click the activity icons on the 

Actions toolbar, or on the New menu, point to New Activity, and then select the activity type.  

 Tip 

To quickly create a follow-up activity from a record, in the Actions toolbar, click Follow Up , fill in the 
details in the Form Assistant pane, and then click Save.  

3. Select an activity type, and then click OK.  

4. Enter the information that you want. At a minimum, entering information in the following boxes is 

useful when you or others in your organization refer to the activity at a later date:  

 Subject  

Enter a meaningful description that can help you easily identify the activity in the Activities list 

view. The subject field is required because, by default, most of the Activities views are sorted 

by it. This field is not related to Subjects, which are the hierarchical list of categories used to 

relate and organize information in Microsoft Dynamics CRM.  

 Regarding  

This field is used to link the activity to another record so that you can view the activity from 

the record. If you create a new activity from a record, this is automatically filled out.  

 Owner  

This box represents the user who owns the activity. By default, it is set to the user who 

creates the activity.  

 Duration 

If this activity is related to a case, make sure that you record the time you spend on the 

activity in this box. If the case is linked to a contract line, the durations of all the activities for 

this case are tallied and updated automatically in the related active contract. The total, which 

includes the totals from any other cases relating to that contract, can be adjusted manually 

before billing the customer. The maximum duration of an appointment or service activity is 10 

days.  
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 Due 

Enter the date and time that the activity is expected to take place or be completed. You can 

quickly sort on the Due field when you view activities.  

 Tip 

To automatically update the Regarding field with information from a record, click the Expand button  
in the right pane to open the Form Assistant pane, and then select a record.  

5. Some activities also have the following optional fields:  

 Sender 

You can use this field to record the user in your organization who initiated an outgoing 

communication. Alternatively, if this is an incoming communication from a customer, you can 

select the lead, account, or contact who initiates the communication. The sender must be a 

valid Microsoft Dynamics CRM account, contact, or lead, but can also be a Microsoft Dynamics 

CRM user. By default, this box contains the name of the user who creates the activity.  

 Recipient 

This is the person, typically an account, contact, lead, or Microsoft Dynamics CRM user, that 

receives the communication.  

 Category, Sub-Category  

You can use these text fields to categorize tasks so that you can sort or view your tasks by 

category and/or sub-category.  

6. Click Save or Save and Close.  

 Tip 

If you are using the activity to track something that has already been completed, on the File menu, click 

Save as Completed.  

Notes 

 To create the same activity for multiple records, use a quick campaign. More information: Work with 

Quick Campaigns  

 You cannot edit multiple activities at once.  

 You cannot schedule recurring activities.  

 You cannot edit closed activities.  

 You cannot change one activity into another type of activity.  

 You cannot set reminders in Microsoft Dynamics CRM for Microsoft Office Outlook for faxes, phone 

calls, e-mails, letters, or campaign responses activities created in the Web application or Microsoft 

Dynamics CRM for Outlook.  

 When the duration of an activity is more than 60 minutes (an hour), the time you enter is converted 

into hours. When the activity is saved, the value is rounded up and might change from the entry 

that was originally displayed when it was converted from minutes into hours. Note that rounding is 

only observed on the hundredth of an hour. The exact value for the duration, however, is stored in 
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the database in minutes, and this value is used to calculate the total billing time when resolving 

cases.  

 The letter and fax activities record when the letter or fax is sent or received. When you create the 

activity, you attach the letter or fax document, such as a Microsoft Office Word file, to the record. 

With the mail merge feature, you can write your letter and include Microsoft Dynamics CRM data. 

More information: Create Customer-Ready Documents and Messages  

Create and send an e-mail activity in the Web application  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: E-mail Permissions  

You can create and send e-mail activities from Microsoft Dynamics CRM from the Activities area. E-mail messages sent 

from Microsoft Dynamics CRM do not appear in the Microsoft Dynamics CRM mail folders in Outlook.  

 

1. Start Microsoft Dynamics CRM 4.0.  

2. In the Navigation Pane, click Workplace, and then click Activities.  

3. On the Actions toolbar, click New.  

4. In the New Activity dialog box, click E-mail, and then click OK.  

5. On the E-mail tab, you must enter the following information.  

 From  

Locate and select the sender's name.  

 To  

Locate and select one or more recipients. You can select a record from a filtered list in the 

Form Assistant pane, or you can click the Lookup button  to search for other records.  

 Subject  

Type a subject for your e-mail message.  

 Duration  

This field is not required, but if you are tracking the amount of time spent on cases, and this 

message is related to a case, enter the amount of time spent on this message.  

 Due  

If you are not sending your e-mail message immediately, enter a date to complete and send 

the message. The message is not sent automatically.  

 Enter any additional information you want. Use the Formatting toolbar  

You cannot enter HTML tags or insert images into the body text of the message.  

 Tip 

 You can copy and paste content from Microsoft Office Word. This lets you take advantage of 

features such as spelling check and some text formatting. If your text is double-spaced, you 

can press SHIFT+ENTER to single-space lines of text.  

 You can include an image if the file is hosted on a public Web site. Use the copy and paste 

feature of Microsoft Internet Explorer to include a link to the image in the message. The image 
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is displayed as long as the receipient has access to the Web site.  

6. You can also attach an article, template, or file to an e-mail activity.  

 To attach an article 

a. To look up and select an article, on the Formatting toolbar, click Insert KB Article.  

b. Use the Search tab to specify conditions or criteria to locate the article.  

c. In the results list, select the article, and then click OK.  

The article appears the body of in your e-mail message.  

d. Type any additional text, or edit the article.  

 To attach an e-mail template 

a. To look up and select an e-mail template, click Insert Template.  

b. On the Insert Template dialog box, select the template you want to use. You can either use 

a global template, or a template specific to the record type you selected as the recipient. For 

example, account or customer.  

c. Click OK. 

The template appears in the body of your e-mail message and the subject line is updated with 

the subject line of the template.  

d. Type any additional text or edit the text provided. Editing the text or subject line in the 

message does not change the template.  

 To attach a file 

a. Save the activity.  

b. On the Attachments tab, click New E-mail Attachment.  

c. In the Add Attachment dialog box, in the File Name box, type the name of the file, or click 

Browse to locate the file that you want to attach.  

d. Click Attach.  

 To send the message immediately, click Send.  

The message is sent and the new closed activity appears in the History area with an assigned 

message number appended to the Subject column and the date sent in the Actual End column.  

– OR –  

To send the message at a later time, click Save and Close. The new draft activity appears in the 

Activities area. You can delete draft messages.  

To send the message, in the list of activities, open the e-mail activity, and click Send.  

Important 

After you save your e-mail message as a Microsoft Dynamics CRM e-mail activity, the saved message can be accessed 

by anyone who has access to your activities in Microsoft Dynamics CRM.  
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Notes 

 You can view the sent date of an e-mail message on the Activities list. The Actual End Date is the 

date the message was sent and closed.  

 You can forward or reply to an e-mail activity, but you cannot resend it.  

To reply to only the original sender, on the Actions toolbar, click Reply.  

To reply to the original sender and to send copies to everyone who originally received the message, 

click Reply All.  

To forward the e-mail activity to new recipients, click Forward, and then select new recipients.  

 There is no spelling checker built into Microsoft Dynamics CRM. There may be third-party solutions 

available. For more information, visit Microsoft Dynamics CRM Solution Finder.  

Close an activity  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Common Task Permissions  

 Activity types that can be closed  

 Tasks  

 Faxes  

 Phone Calls  

 Letters  

 Appointments  

 Service Activities  

 Campaign Activities  

Unless you have created an activity record by mistake, it is better to close or convert an activity than to delete it. You 

can view closed or converted activities at a later date for reference, or run reports to determine the success rate of 

your activities.  

 

1. Navigate to activity records. In the Navigation Pane, click Workplace, and then under My Work click 

Activities.  

– OR –  

To work with activities associated with a record, open the record and then click Activities.  

2. Open the activity that you want.  

3. On the Actions  menu, click Close activity type. For example, if you are in a task record, click 

Close Task.  

4. In the confirmation dialog box, select the status that you want from the Status list, such as 

Completed or Canceled, and then click OK.  

http://go.microsoft.com/fwlink/?LinkId=98752
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Notes 

 When you close an activity, the activity becomes read-only and cannot be edited or reopened.  

 To view closed activities, do one of the following:  

o In the Activities list, select the Closed Activities view.  

o Use Advanced Find, and specify Activity Status in the search criteria.  

o From an Account, Contact, Lead, or Opportunity record, under Details, click History. In the 

Filter on and Include lists, select the view options that you want.  

 It is not possible to close multiple activities at once.  

 The only way to close an e-mail activity is to send it. If you do not use Microsoft Dynamics CRM to 

send or receive e-mail, click Send. This will close the activity, but no e-mail message will be sent.  

Convert an activity to an opportunity  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Common Task Permissions  

 Activity types that can be converted  

 Faxes  

 Phone Calls  

 E-mail Messages  

 Letters  

 Appointments  

 

 

1. Navigate to activity records. In the Navigation Pane, click Workplace, and then under My Work click 

Activities.  

– OR –  

To work with activities associated with a record, open the record and then click Activities.  

2. Open the activity that you want.  

3. On the Actions toolbar, click Convert Activity, and then click To Opportunity.  

4. In the Convert Activity to Opportunity dialog box, enter information in the following boxes:  

 Customer 

You must click the Lookup button  to select or create a new customer.  

 Source Campaign 

Click Lookup if you want to associate a source campaign with this activity.  
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 More Actions 

By default, Microsoft Dynamics CRM automatically completes the following operations during 

the conversion.  

o Close the activity as completed.  

o Open the new opportunity after the conversion.  

o Create a campaign response based on the information included in the opportunity.  

Important  If you are converting an activity to an opportunity that is not associated 

with a Source Campaign, you must clear the Record a closed campaign response 

check box.  

To change the conversion operations, clear the associated check boxes.  

5. In the Convert Activity to Opportunity dialog box, click OK.  

6. Click Save or Save and Close.  

Note 

The originating activity becomes a related activity for the new opportunity. If the activity is open, it appears in the 

Activities list for the opportunity. If the activity is closed, it appears in the History list.  

Convert an activity to a case  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Common Task Permissions  

 

 

1. Navigate to activity records. In the Navigation Pane, click Workplace, and then under My Work click 

Activities.  

– OR –  

To work with activities associated with a record, open the record and then click Activities.  

2. Open the activity that you want.  

 Activity types that can be converted  

 Faxes  

 Phone Calls  

 E-mail Messages  

 Letters  

 Appointments  

3. On the Actions toolbar, point to Convert Activity and then to Case.  

4. In the Convert Activity to Case dialog box, enter information in the following boxes:  
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 Customer 

You must click the Lookup button  to select or create a new customer.  

 By default, Microsoft Dynamics CRM automatically completes the following operations during 

the conversion:  

o Close the activity as completed.  

o Open the new case after the conversion.  

To change the conversion operations, clear the associated check boxes.  

5. In the Convert Activity to Case dialog box, click OK.  

Note 

The originating activity becomes a related activity for the new case. If the activity is open, it appears in the Activities 

list for the case. If the activity is closed, it appears in the History list.  

Convert an e-mail to a lead  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Common Task Permissions  

 

 

1. Navigate to activity records. In the Navigation Pane, click Workplace, and then under My Work click 

Activities.  

– OR –  

To work with activities associated with a record, open the record and then click Activities.  

2. Open the e-mail activity that you want to convert.  

3. On the Actions toolbar, point to Convert Activity and then to To Lead.  

4. In the Convert E-mail to Lead dialog box, enter information in the following boxes:  

 First Name 

 Last Name 

 Company 

 E-mail Address 

 By default, Microsoft Dynamics CRM automatically completes the following operations during 

the conversion:  

o Open the new lead after the conversion, if all the required information for the lead is 

available. Otherwise this option is not available.  

o Close the e-mail form.  

To change the conversion operations, clear the associated check boxes.  

5. Click OK.  
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Notes 

 The originating activity becomes a related activity for the new lead. If the activity is open, it appears in 

the Activities list for the case. If the activity is closed, it appears in the History list.  

 The icon in the Activities list changes.  

Assign an activity to a user or queue  

 Can I do this task?  

If the Assign button  is not visible on the toolbar, the security role assigned to your account does 

not have permission to assign this type of record. To check your permissions for a specific record, open 

the record, click the File menu button , and then click Properties.  

More information about specific permissions and performing this task while offline: Common Task 

Permissions  

 

 

1. Navigate to activity records. In the Navigation Pane, click Workplace, and then under My Work click 

Activities.  

– OR –  

To work with activities associated with a record, open the record and then click Activities.  

2. In the list of records, select the record that you want.  

 Or, select multiple records  

 Select several records by pressing the CTRL key while you click each record.  

 Select a sequence of records by clicking the first record that you want, and then press the SHIFT 

key while you select the last record that you want.  

 Select all records on the page by selecting the Select/clear all records on this page check box 

at the top of the list.  

By default, the Microsoft Dynamics CRM Web application displays 50 records per page. You can increase 

the number of records displayed and thereby increase the number of records you can select at one time. To 

display up to a maximum of 250 records per page:  

4. On the Tools menu, click Options.  

5. On the General tab, in the Records Per Page list, select the number of records to display 

per page.  

6. Click OK.  

This changes the number of items that is displayed for all lists, which may slow response time when you 

switch record types. Therefore, you might want to set it back to a smaller number when you are done with 

this bulk action.  

 On the Actions toolbar, click the Assign button .  



 

 

 Microsoft Dynamics CRM 4.0 User’s Guide 37 

 

 In the Assign to Queue or User dialog box, type all or part of the queue or user name, 

and then click the Lookup button .  

 In the Look Up Records dialog box, in the Look for list, select the type of record you want 

to find.  

 In the Search for records box, type the first few letters of the name of the record to 

narrow your search, and then click the Find button .  

 In the list of records, click a record to select it, click the Add Selected Records 

button  to add the record to the Selected records list, and then click OK.  

 On the User or Queues form, click OK.  

Add a Note or Attach a File 

Add, edit, or delete a note  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Common Task Permissions  

 Record types that you can add notes to  

 Accounts  

 Appointments  

 Campaigns  

 Campaign Responses  

 Cases  

 Competitors  

 Contacts  

 Contracts  

 Faxes  

 Leads  

 Letters  

 Marketing Lists  

 Opportunities  

 Phone Calls  

 Products  

 Service Activities  

 Tasks  

 

 

1. Open the record that you want.  
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2. For most record types, click the Notes tab.  

 On the E-mail form, click the Attachments tab.  

 On the Service Activity form, click the Service Activity tab.  

 On the Case form, click the Notes and Article tab.  

3. To add a note, click Click here to enter a new note.  

– OR –  

To open and edit a note, double-click the status row above the note, or right-click the note and then 

click Open.  

4. In the Note form, you can make changes to the following boxes:  

 Title 

Change the title of the note. Titles must have a length of 64 characters or less. Titles are not 

displayed in the notes list.  

 Note content 

Add, remove, or edit the note content. 

 Regarding 

You can use this item to open and make changes to the activity or record that this note is 

associated with. 

 File Attachment section 

Add or remove a file attachment. In the File Name box, type the name of the file, or click 

Browse to locate the file that you want to attach, and then click Attach.  

 Tips 

 Each note can have only one attached file, so if you need to attach multiple files, create a note for 

each file.  

 The maximum size of the file that you can attach to a record is defined by your system 

administrator. More information: System Settings Dialog Box - E-mail Tab  

5. Click Save or Save and Close.  

Tips 

 To paste text from the Clipboard into a note, open the note, and then press CTRL+V.  

 To use a tab in a note, copy the text from a file that includes the tab, and then use CTRL+V to paste 

the text into the note.  

Note 

To delete a note, double-click the status row of the note to open it, and then on the Actions  menu, click Delete 

Note. If you do not have appropriate permissions to delete any of the records associated with the note, you will not be 

able to delete it. 
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Attach a file  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Common Task Permissions  

 

 

1. Open the record that you want.  

2. On the Actions toolbar, click the Attach a File button .  

3. In the Add Attachment dialog box, type the path and name of the file to attach or click Browse to 

locate the file.  

4. Click Attach, and then click Close.  

The attachment is added as a note.  

5. Click Save or Save and Close.  

Notes 

 To add multiple files, for each file, repeat steps 2 through 4. Each attachment is added as a new note.  

 You cannot update an attached file. Instead, save the file on your computer and edit the file, delete 

the attachment, and then attach the edited file.  

 To add an attachment to an e-mail activity, first save the activity, and then on the Attachments tab, 

click New E-mail Attachment. After selecting or browsing for a file, click Attach.  

 The maximum size of the file that you can attach to a record is defined by your system administrator. 

More information: System Settings Dialog Box - E-mail Tab  

 The types of files that can be attached are defined by your system administrator. More information: 

Manage System Settings  

Remove an attached file  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Common Task Permissions  

 

 

1. Open the record that you want.  

2. For most record types, click the Notes tab.  

 On the E-mail form, click the Attachments tab.  

 On the Service Activity form, click the Service Activity tab.  

 On the Case form, click the Notes and Article tab.  

3. Double-click the status row of the note that contains the attachment you want to remove.  

4. To keep the note, but remove the attachment, in the Note form, in the File Attachment area, click 

Remove, click OK, and then click OK again.  
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– OR –  

To remove the note and the attachment, on the Actions  menu, click Delete Note, and then 

click OK.  

5. Click Save or Save and Close.  

Note 

You cannot update an attached file. Instead, save the file on your computer and edit the file, delete the attachment, 

and then attach the edited file.  

Edit Multiple Records 

Caution  When you edit or delete multiple records, you cannot undo the changes.  

Edit multiple records  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Common Task Permissions  

 Record types that can be bulk edited  

 Accounts  

 Cases  

 Contacts  

 Leads  

 Marketing Lists  

 Opportunities  

 

 

1. In any list, select multiple records:  

 Select several records by pressing the CTRL key while you click each record.  

 Select a sequence of records by clicking the first record that you want, and then press the 

SHIFT key while you select the last record that you want.  

 Select all records on the page by selecting the Select/clear all records on this page check 

box at the top of the list.  

 Tip 

By default, the Microsoft Dynamics CRM Web application displays 50 records per page. You can increase 

the number of records displayed and thereby increase the number of records you can select at one time. To 

display up to a maximum of 250 records per page:  

4. On the Tools menu, click Options.  
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5. On the General tab, in the Records Per Page list, select the number of records to display 

per page.  

6. Click OK.  

This changes the number of items that is displayed for all lists, which may slow response time when you 

switch record types. Therefore, you might want to set it back to a smaller number when you are done with 

this bulk action.  

 On the Actions toolbar, click More Actions, and then click Edit.  

 In the Edit Multiple Records form, make the changes that you want.  

Any fields that you enter data in will change in all selected records. Other fields will be left 

unchanged.  

 Click Save.  

Notes 

 You cannot perform a multiple edit operation on activities, lookup fields, or notes.  

 You cannot use this form to clear data in a field.  

 You cannot use this form to change the status of records. However, to change the status for a group 

of leads, add them to a marketing list. More information: Work with Marketing Lists  

Delete records  

 Can I do this task?  

If the Delete button  is not visible on the toolbar, the security role assigned to your account does 

not have permission to delete this type of record. To check your permissions for a specific record, open 

the record, click the File menu button , and then click Properties.  

If you are deleting a record that has child records, you can delete it only if you also have permission to 

delete any child records.  

More information about specific permissions and performing this task while offline: Common Task 

Permissions  

 

 

1. In any list of records, select the record that you want to delete.  

– OR –  

In any list, select multiple records:  

 Select several records by pressing the CTRL key while you click each record.  

 Select a sequence of records by clicking the first record that you want, and then press the 

SHIFT key while you select the last record that you want.  

 Select all records on the page by selecting the Select/clear all records on this page check 

box at the top of the list.  
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 Tip 

By default, the Microsoft Dynamics CRM Web application displays 50 records per page. You can increase 

the number of records displayed and thereby increase the number of records you can select at one time. To 

display up to a maximum of 250 records per page:  

4. On the Tools menu, click Options.  

5. On the General tab, in the Records Per Page list, select the number of records to display 

per page.  

6. Click OK.  

This changes the number of items that is displayed for all lists, which may slow response time when you 

switch record types. Therefore, you might want to set it back to a smaller number when you are done with 

this bulk action.  

 On the Actions toolbar, click the Delete button .  

 If you are deleting accounts or contacts, you have the option to deactivate the record 

instead of deleting it. In the Delete Confirmation dialog box, to delete the record, click Delete, 

or to deactivate it, click Deactivate.  

For other record types, in the Confirm Deletion dialog box, click OK.  

Notes 

 When you delete a record, all its relationships to other records are also deleted.  

 If the record has child records, and you have permission to delete the child records, the child records 

will also be deleted.  

Check for Duplicates 

Search for potential duplicate records  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Common Task Permissions  

Duplicate detection can take place only if duplicate detection is enabled in Duplicate Detection Settings and if at 
least one duplicate-detection rule exists for the record type.  

 

1. Start duplicate detection:  

 Start duplicate detection from any list of records, including results of an Advanced Find search 

a. In any list, on the More Actions menu, click Detect Duplicates.  

b. To search selected records, click For Selected Records.  

– OR –  
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To search all records on all pages of the current view, click For All Records on All Pages.  

 Start duplicate detection from the Workplace, Tools menu, or Settings area 

a. On the Tools menu, click Duplicate Detection.  

– OR –  

In the Workplace, in the My Work section, click Duplicate Detection, and then click New.  

– OR –  

In the Navigation Pane, click Settings, click Data Management, click Duplicate Detection 

Jobs, and then click New.  

b. Click Next.  

c. To specify the record type to check for duplicates, in the Look for box, select a record type.  

Only record types that have published duplicate-detection rules will be included in the Look for 

box. More information: Work with Duplicate-detection Rules  

d. Select criteria to define the records to check for duplicates:  

 To use criteria from a saved view, in the Use Saved View box, select a view from the 

System Views or My Views section.  

– OR –  

For each criteria to add, click Select. More information: Work with Advanced Find  

e. Tips:  

 To preview the records to make sure you have the records you want, click Preview 

Records.  

 To change which columns are displayed in the preview, or the column order, sort order, or 

column widths, click Edit Columns.  

 To save these criteria to use later, click Save As. This saves the criteria as a saved view. 

This saved view will be available in the My Views section of the View box.  

f. Click Next.  

3. Specify:  

 The name of the duplicate-detection job.  

 When you want the duplicate-detection job to start. You also can specify to run the job on a 

regular schedule.  

 Whether you want notification sent to you and to other users when the background 

duplicate-detection job completes.  

 Click OK, or click Finish.  

Duplicate-detection is processed in the background. If you requested notification, you will receive an 

e-mail notification when the job completes, with a link to the page where you can resolve 

duplicates.  
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 To view the potential duplicates, after the duplicate-detection job completes, in the 

Workplace, under My Work, click Duplicate Detection.  

 Open your duplicate-detection job.  

 Under Details, click View Duplicates.  

The top list displays all records that have potential duplicates. When you select a record in the top 

list, the bottom list shows all the potential duplicate records.  

 In the top list of records that may have duplicates, select a record.  

 In the list of potential duplicate records, for each potential duplicate record found, select the 

record, and then do any of the following actions:  

 View the record. To view the contents of a record to help you decide what to do, double-

click the record.  

 Edit the record. On the Actions toolbar, click More Actions, and then click Edit.  

 Deactivate the record. On the Actions toolbar, click More Actions, click Deactivate, and 

then in the confirmation dialog box, click OK.  

 Merge the records. On the Actions toolbar click the Merge button .  

If you want the record in the top list to be the master record, click Automatically.  

– OR –  

If you want to choose the master record:  

1. Click Select Master.  

2. In the Merge Records dialog box, select which record to make the new master 

record.  

3. Select the fields from each record that you want to include in the master record. Fields 

that are shaded will overwrite the corresponding unshaded field during the merge 

operation.  

4. When you are ready to merge the two records, click OK.  

When you receive the message The selected records are merged and the subordinate 

record is deactivated, click OK.  

 Delete the record. On the Actions toolbar, click the Delete button . In the Select 

Delete or Deactivate dialog box, click Delete, and then in the confirmation dialog box, 

click OK.  

 When you have finished resolving duplicates, click Close.  

Notes 

 Your system administrator or system customizer determines the criteria for identifying a record as a 

potential duplicate. More information: Requesting User Interface Changes  

 If you enter a duplicate record within a few minutes of entering the first record, Microsoft Dynamics 

CRM will not detect the duplicate record. The matchcodes for new and updated records are created 

every five minutes, rather than as a record is created.  

 To refresh the list of duplicate records, you must run a new duplicate-detection job:  

o After a record has been merged or deactivated, the record is still displayed on the bottom list.  
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o You can use the Modified On column to determine whether a record was modified after the 

duplicate-detection job was run.  

o After a record has been deleted, merged or deactivated, the record is still displayed on the 

top list.  

Merge records  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Common Task Permissions  

You can merge two lead, account, or contact records. 

 

1. Click to select a record, and then press the CTRL key while you click the second record.  

2. On the Actions toolbar click the Merge button .  

3. If you want the record in the top list to be the master record, click Automatically.  

– OR –  

If you want to choose the master record:  

a. Click Select Master.  

b. In the Merge Records dialog box, select which record to make the new master record.  

c. Select the fields from each record that you want to include in the master record. Fields that 

are shaded will overwrite the corresponding unshaded field during the merge operation.  

d. When you are ready to merge the two records, click OK.  

4. When you receive the message The selected records are merged and the subordinate record 

is deactivated, click OK. 

Check Your Permissions for a Record 

View your permissions for a record   

1. In the list of records, open the record that you want.  

2. Click the File menu button , and then click Properties.  

Tip 

If you do not have permissions that you need to do your job, contact your manager. More information: Requesting User 

Interface Changes 
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View your user profile  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Common Task Permissions  

Your user profile displays information about you, including general information such as your contact information and 

addresses, what teams and resource groups you belong to, which services you can perform, and your work hours and 

security roles. This information is visible to the entire organization. Depending on your security role, you may be able 

to make changes to your user profile. 

If you are working in Microsoft Dynamics CRM for Outlook, you can view this information from the User form. More 

information: Work with Your User Record and Work Hours  

 

1. Under Workplace, click the Personalize Workplace link.  

2. In the Set Personal Options dialog box, click the General tab.  

3. At the bottom of the page, click the View your user profile here link. 

The User form with your information opens.  

4. To view details or make changes, under Details or Service click any of the following:  

 Teams 

 Roles 

 Quotas 

 Work Hours 

 Services 

 Resource groups 

 Workflows 

5. To close the form, on the File menu, click Close.  

6. To close the Set Personal Options dialog box, click OK.  

Start an On-Demand Workflow 

If you or your organization have created on-demand workflows, you can apply these workflows to records that appear 

in a list.  

 

Start an on-demand workflow  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Common Task Permissions  

 

 

1. Open the list of records that contains the record you want to apply a workflow to, such as leads or 

cases.  

file:\\crmshare\Users\abecraft\Modified_Help_for_Print\content\how_sec_commontasks.htm
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2. Select the record or records that you want to apply a workflow to.  

3. On the Actions toolbar, click Run Workflow.  

4. In the Look Up Records dialog box, select the workflow that you want to run, and then click OK.  

5. In the confirmation message, click OK.  

Note 

The Run Workflow button does not appear on the Actions toolbar if no on-demand workflows have been created for 

the record type that you are viewing.  

Sharing Records with Coworkers 

Share or Assign Records 

When you share a record with another user, you are giving that user specific permissions, such as Read, Write, or 

Delete, to that record. When you assign a record to another user, you are making that user the owner of the record.  

Share a record  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Common Task Permissions  

 Record types that can be shared  

 Accounts  

 Cases  

 Campaigns  

 Contacts  

 Contracts  

 Invoices  

 Leads  

 Marketing Lists  

 Opportunities  

 Orders  

 Quotes  

 Reports  

 

 

1. In the list of records, select the record that you want.  

 Or, select multiple records  

 Select several records by pressing the CTRL key while you click each record.  
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 Select a sequence of records by clicking the first record that you want, and then press the SHIFT 

key while you select the last record that you want.  

 Select all records on the page by selecting the Select/clear all records on this page check box 

at the top of the list.  

By default, the Microsoft Dynamics CRM Web application displays 50 records per page. You can increase 

the number of records displayed and thereby increase the number of records you can select at one time. To 

display up to a maximum of 250 records per page:  

4. On the Tools menu, click Options.  

5. On the General tab, in the Records Per Page list, select the number of records to display 

per page.  

6. Click OK.  

This changes the number of items that is displayed for all lists, which may slow response time when you 

switch record types. Therefore, you might want to set it back to a smaller number when you are done with 

this bulk action.  

 On the Actions toolbar, click More Actions, and then click Sharing.  

 In the sharing dialog box, under Common Tasks, click Add User/Team.  

 In the Look Up Records dialog box, in the Look for list, select the type of record you want 

to find.  

 In the Search for records box, type the first few letters of the name of the record to 

narrow your search, and then click the Find button .  

 In the list of available records, click a user or team to select it, and then click the Add 

Selected Records button  to add the user or team to the Selected records list.  

 Repeat step 6 to add more users or teams.  

 Click OK.  

 In the sharing dialog box, select the type of share access that you want. The available 

permissions are: Read, Write, Delete, Append, Assign, or Share.  

 Click OK.  

Tips 

 To see records that have been shared with you, use Advanced Find to create a saved view that 

includes the owner column. If you can access the record, but are not the owner, it has been shared 

with you.  

 If you want to limit the permissions on a record you own, you can share the record with yourself. 

Then, you can limit the permissions on the record. For example, if you clear the delete permission 

on a record, you will not be able to delete that record.  

Notes 

 To cancel any changes that you have made and retain the previous permissions settings, click Reset.  

 To select or clear all permissions on a selected item, click Toggle All Permissions of the Selected 

Items.  
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 You cannot create a new contact or account that is shared by default.  

 When you share a record, the user with whom you share the record inherits the privileges on certain 

associated records. For example, when you share a contact, the user is also granted the same 

privileges on the parent account. To prevent privileges from cascading, a user with the appropriate 

security role can change this behavior by customizing the relationship definition for the record type. 

More information: Work with Entities  

Unshare or change sharing for a record  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Common Task Permissions  

 

 

1. In the list of records, select the record that you want.  

 Or, select multiple records  

 Select several records by pressing the CTRL key while you click each record.  

 Select a sequence of records by clicking the first record that you want, and then press the SHIFT 

key while you select the last record that you want.  

 Select all records on the page by selecting the Select/clear all records on this page check box 

at the top of the list.  

By default, the Microsoft Dynamics CRM Web application displays 50 records per page. You can increase 

the number of records displayed and thereby increase the number of records you can select at one time. To 

display up to a maximum of 250 records per page:  

4. On the Tools menu, click Options.  

5. On the General tab, in the Records Per Page list, select the number of records to display 

per page.  

6. Click OK.  

This changes the number of items that is displayed for all lists, which may slow response time when you 

switch record types. Therefore, you might want to set it back to a smaller number when you are done with 

this bulk action.  

 On the Actions toolbar, click More Actions, and then click Sharing.  

 To remove a user or team, in the row for the user or team whose rights you want to change, 

select the check box, and then under Common Tasks click Remove Selected Items.  

– OR –  

To edit permissions on a record for a user or team, select or clear one or more permissions check 

boxes, such as Read or Delete.  

 Click OK.  

Notes 
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 To cancel any changes that you have made and retain the previous permission settings, click Reset.  

 To select or clear all permissions on a selected item, click Toggle All Permissions of the Selected 

Items.  

Assign a record to a user  

 Can I do this task?  

If the Assign button  is not visible on the toolbar, the security role assigned to your account does 

not have permission to assign this type of record. To check your permissions for a specific record, open 

the record, click the File menu button , and then click Properties.  

More information about specific permissions and performing this task while offline: Common Task 

Permissions  

 

 

1. In the list of records, select the record that you want.  

 Or, select multiple records  

 Select several records by pressing the CTRL key while you click each record.  

 Select a sequence of records by clicking the first record that you want, and then press the SHIFT 

key while you select the last record that you want.  

 Select all records on the page by selecting the Select/clear all records on this page check box 

at the top of the list.  

By default, the Microsoft Dynamics CRM Web application displays 50 records per page. You can increase 

the number of records displayed and thereby increase the number of records you can select at one time. To 

display up to a maximum of 250 records per page:  

4. On the Tools menu, click Options.  

5. On the General tab, in the Records Per Page list, select the number of records to display 

per page.  

6. Click OK.  

This changes the number of items that is displayed for all lists, which may slow response time when you 

switch record types. Therefore, you might want to set it back to a smaller number when you are done with 

this bulk action.  

 On the Actions toolbar, click the Assign button .  

 In the Assign dialog box, click:  

 Assign to me  

Use this option to assign the record to yourself.  

– OR –  
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 Assign to another user  

Click the Lookup button , type a part of the user's name, click the Find button , 

double-click the user's name, and then to close Look Up Records dialog box, click OK.  

 Click OK.  

Tips 

 You can create your own Advanced Find view that includes records belonging to users to whom you 

normally assign records.  

  If you have a security role with appropriate permissions, you can reassign all records belonging to 

one user to another user.  

1. In the Navigation Pane, click Settings, click Administration, and then click Users.  

2. Open the record for the user whose records you want to reassign.  

3. On the Actions  menu, click Reassign Records, and then click Assign to another 

user.  

4. Click the Lookup button , type a part of the user's name, click the Find button , 

double-click the user's name, and then to close Look Up Records dialog box, click OK.  

Notes 

 You cannot assign records to teams. To give a team access to a record, share the record with the 

team.  

 Your system administrator may have enabled reassigned records to be automatically shared with the 

original owner. More information: Manage System Settings  

Assign an activity to a user or queue  

 Can I do this task?  

If the Assign button  is not visible on the toolbar, the security role assigned to your account does 

not have permission to assign this type of record. To check your permissions for a specific record, open 

the record, click the File menu button , and then click Properties.  

More information about specific permissions and performing this task while offline: Common Task 

Permissions  

 

 

1. Navigate to activity records. In the Navigation Pane, click Workplace, and then under My Work click 

Activities.  

– OR –  

To work with activities associated with a record, open the record and then click Activities.  

2. In the list of records, select the record that you want.  
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 Or, select multiple records  

 Select several records by pressing the CTRL key while you click each record.  

 Select a sequence of records by clicking the first record that you want, and then press the SHIFT 

key while you select the last record that you want.  

 Select all records on the page by selecting the Select/clear all records on this page check box 

at the top of the list.  

By default, the Microsoft Dynamics CRM Web application displays 50 records per page. You can increase 

the number of records displayed and thereby increase the number of records you can select at one time. To 

display up to a maximum of 250 records per page:  

4. On the Tools menu, click Options.  

5. On the General tab, in the Records Per Page list, select the number of records to display 

per page.  

6. Click OK.  

This changes the number of items that is displayed for all lists, which may slow response time when you 

switch record types. Therefore, you might want to set it back to a smaller number when you are done with 

this bulk action.  

 On the Actions toolbar, click the Assign button .  

 In the Assign to Queue or User dialog box, type all or part of the queue or user name, 

and then click the Lookup button .  

 In the Look Up Records dialog box, in the Look for list, select the type of record you want 

to find.  

 In the Search for records box, type the first few letters of the name of the record to 

narrow your search, and then click the Find button .  

 In the list of records, click a record to select it, click the Add Selected Records 

button  to add the record to the Selected records list, and then click OK.  

 On the User or Queues form, click OK.  

Assign a case to a user or queue  

 Can I do this task?  

This task requires permissions that are found in all default service security roles. More information about 
specific permissions and performing this task while offline: Service Permissions  

After a case is created, it can be assigned to another user or to a queue. After accepting a case, the assigned user 

can continue working with the customer. 

 

1. In the Navigation Pane, click Service, and then click Cases.  

2. In the list of cases, select the case you want to assign.  
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 Or, select multiple records  

 Select several records by pressing the CTRL key while you click each record.  

 Select a sequence of records by clicking the first record that you want, and then press the SHIFT 

key while you select the last record that you want.  

 Select all records on the page by selecting the Select/clear all records on this page check box 

at the top of the list.  

By default, the Microsoft Dynamics CRM Web application displays 50 records per page. You can increase 

the number of records displayed and thereby increase the number of records you can select at one time. To 

display up to a maximum of 250 records per page:  

4. On the Tools menu, click Options.  

5. On the General tab, in the Records Per Page list, select the number of records to display 

per page.  

6. Click OK.  

This changes the number of items that is displayed for all lists, which may slow response time when you 

switch record types. Therefore, you might want to set it back to a smaller number when you are done with 

this bulk action.  

 On the Actions toolbar, click the Assign button .  

 In the Assign to Queue or User dialog box, to assign the case to another user or queue, 

select Assign to another user or queue. 

Then to select a record, click the Lookup button .  

 Click OK.  

Note 

After a case is assigned to a queue, it is displayed in the Queues area. If it was assigned to a user, it will appear in his 

or her Assigned area. An assigned case belongs to the user who created it until it is accepted by another user.  

Make a report available to all Microsoft Dynamics CRM users  

 Can I do this task?  

This task requires the System Administrator or System Customizer security role or equivalent 
permissions. More information about specific permissions and performing this task while offline: Report 
Permissions  

 

 

1. In the Navigation Pane, click Workplace, and then under My Work, click Reports.  

2. Select the report you created, and on the Actions toolbar, click Edit Report.  

3. On the Actions  menu, click Make Report Available to Organization.  

Note 

To revert a report back to a personal report, on the Actions  menu, click Revert to Personal Report.  
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Send or Copy a Shortcut  

Only another Microsoft Dynamics CRM user who has permission to see the view or the record will be able to open the 

record.  

Send or copy a shortcut to a record  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Common Task Permissions  

You can send a shortcut to a specific record or group of selected records in Microsoft Dynamics CRM in an e-mail 

message to any user.  

This feature does not use Microsoft Dynamics CRM e-mail; it uses your default Microsoft Internet Explorer e-mail. If 

the person receiving the e-mail does not have permissions to the view, they will receive an error. Not all views are 

available. No activity is created for this action. 

You can also copy the shortcut and paste it into any document. 

 

1. In the list of records, select the record that you want.  

 Or, select multiple records  

 Select several records by pressing the CTRL key while you click each record.  

 Select a sequence of records by clicking the first record that you want, and then press the SHIFT 

key while you select the last record that you want.  

 Select all records on the page by selecting the Select/clear all records on this page check box 

at the top of the list.  

By default, the Microsoft Dynamics CRM Web application displays 50 records per page. You can increase 

the number of records displayed and thereby increase the number of records you can select at one time. To 

display up to a maximum of 250 records per page:  

4. On the Tools menu, click Options.  

5. On the General tab, in the Records Per Page list, select the number of records to display 

per page.  

6. Click OK.  

This changes the number of items that is displayed for all lists, which may slow response time when you 

switch record types. Therefore, you might want to set it back to a smaller number when you are done with 

this bulk action.  

 Do one of the following:  

 Send a shortcut in an e-mail  

 . On the Actions toolbar, click Send Shortcut, and then click Of Selected Item.  

a. Complete the e-mail form and send. 

Tip: If you are working in Microsoft Dynamics CRM for Outlook and you want to track this e-mail, you can 
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use Track in CRM.  

 Copy a shortcut  

 . On the Actions toolbar, click Copy Shortcut, and then click Of Selected Item.  

a. Paste the shortcut into any application that supports copy and paste. For example, in Microsoft 

Office Word, press CTRL+V.  

Important 

The shortcut is not a snapshot of the data, but a link to the live data.  

Send or copy a shortcut to a view  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Common Task Permissions  

You can send a shortcut to a specific saved view in Microsoft Dynamics CRM in an e-mail message to any user.  

This feature does not use Microsoft Dynamics CRM e-mail; it uses your default Microsoft Internet Explorer e-mail. If 

the person receiving the e-mail does not have permissions to the view, they will receive an error. Not all views are 

available. No activity is created for this action. 

You can also copy the shortcut and paste it into any document. 

 Pages that you cannot e-mail or copy  

 Contract Template list  

 Article list  

 

 

 In any available, saved view, do one of the following:  

 Send a shortcut in an e-mail  

a. On the Actions toolbar, click Send Shortcut, and then click Of Current View.  

b. Complete the e-mail form and send. 

Tip: If you are working in Microsoft Dynamics CRM for Outlook and you want to track this e-mail, you can 

use Track in CRM.  

 Copy a shortcut  

a. On the Actions toolbar, click Copy Shortcut, and then click Of Current View.  

b. Paste the shortcut into any application that supports copy and paste. For example, in Microsoft 

Office Word, press CTRL+V.  

Important 
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The shortcut is not a snapshot of the data, but a link to the live data.  

Export Data to Excel 

You can export any list to Microsoft Office Excel, including the results of an Advanced Find search.  

You can export to a static or dynamic Excel worksheet or to a PivotTable.  

Export data to an Excel static worksheet  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Common Task Permissions  

 

 

1. In any area with a list of records, select the columns to include in the exported list.  

By default, an exported worksheet includes the fields that are displayed in the list, using the same 

field order, sorting, and field widths.  

To make changes to the columns in an Advanced Find View, click Edit Columns. You can make the 

following types of changes:  

 Change the column order  

To change the column order, select a column heading, such as Account Name, and then under Common 

Tasks, click the Move Left button  or the Move Right button  to move the column.  

 Add columns  

a. To add columns to the export list, click Add Columns.  

b. To add columns for the main record type, select it, and then in the Add Columns list, click to 

select fields that you want to add as columns.  

c. To add columns from related records, first select the related record type, and then in the Add 

Columns list, click to select fields that you want to add as columns.  

d. Click OK.  

 Configure sorting  

To change the sort order, click Configure Sorting, in the Column list, select the column that you want to 

sort, in the Order area, click Ascending Order or click Descending Order, and then click OK.  

You cannot sort on columns from related record types. 

 Change column width  

To change the column width that will appear in the Excel worksheet, select a column heading, such as 

Account Name, click Change Properties. In the Change Column Properties dialog box, select the 
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width (in pixels) that you want, and then click OK.  

 Remove columns  

To remove a column, select the column heading that you want to remove, and under Common Tasks, 

click Remove, and then in the confirmation message, click OK.  

You cannot change the columns for a system view, such as All Active Accounts. You must either 

customize the view, which requires the System Administrator or System Customizer security role, or 

use Advanced Find to create your own view based on the current view. To create your own view, 

with the system view open, click Advanced Find.  

2. On the Actions toolbar, click the Export to Excel button .  

3. In the Export Data to Excel dialog box, select Static worksheet with records from this page.  

– OR –  

Select Static worksheet with records from all pages in the current view.  

This option will be visible only when your view includes more than one page of records.  

4. Click Export.  

5. To view the static worksheet, click Open.  

If you are using Microsoft Office Excel 2007, you will see a message that says the file you are trying 

open is in a different format than specified by the file extension. Click Yes.  

6. To save the exported data to a file, in Excel, on the File menu, click Save.  

Tip 

You can e-mail a static exported worksheet to anyone, or store it in a shared file. Anyone who opens the file will see all 

the data in the file, whether or not they are a Microsoft Dynamics CRM user or have privileges to view the data in 

Microsoft Dynamics CRM.  

Notes 

 There is potential for data loss if you export from Microsoft Dynamics CRM to a Microsoft Office Excel 

2003 comma-separated value (CSV) file.  

To ensure that the file is exported correctly, you must have data in every row of the last column of 

the list you are exporting. You can add a space or other character in last column of the file or 

reorder the columns so that the last column always contains data. More information: Microsoft 

Knowledge Base Article 77295  

 By default, in Microsoft Dynamics CRM, you cannot export a list of more than 10,000 records at a time 

to a static Excel worksheet. Your system administrator can change this. More information: Microsoft 

Knowledge Base Article 911395  

 By default, Microsoft Dynamics CRM lists up to 50 records per page. If there is more than one page of 

records available to view in the list of records, use the Page arrows at the bottom of the list to view 

the additional pages.  

http://go.microsoft.com/fwlink/?LinkId=105633
http://go.microsoft.com/fwlink/?LinkId=105633
http://go.microsoft.com/fwlink/?LinkId=105633
http://go.microsoft.com/fwlink/?LinkId=99131
http://go.microsoft.com/fwlink/?LinkId=99131
http://go.microsoft.com/fwlink/?LinkId=99131


 

58 Microsoft Dynamics CRM 4.0 User’s Guide 
 

Export data to an Excel PivotTable   

1. In any area with a list of records, on the Actions toolbar, click the Export to Excel button .  

2. Click Dynamic PivotTable.  

3. To add or remove a column in the report, click Select Columns.  

4. In the Select PivotTable Columns list, select or clear the check boxes for the fields as needed, and 

then click OK. 

By default, only fields that are displayed in the Select PivotTable Columns list are included in the 

PivotTable Field List. 

5. Click Export.  

6. Open the file containing the PivotTable:  

a. To view the PivotTable, click Open.  

b. If you are using Microsoft Office Excel 2003, click Enable automatic refresh.  

– OR –  

If you are using Microsoft Office Excel 2007:  

 You will see a message that says the file you are trying open is in a different format 

than specified by the file extension. Click Yes.  

 If you see the security warning Data connections have been disabled, click 

Options, and then click Enable this content, and then click OK.  

7. Drag the fields from the PivotTable Field List to the PivotTable. For more information, see Microsoft 

Office Excel Help.  

8. To refresh data in the file:  

 In Microsoft Office Excel 2007, click the Data tab, and in the Connections area, click 

Refresh All.  

 In Microsoft Office Excel 2003, on the Data menu, click Refresh Data.  

 To save the exported data to a file, in Excel, on the File menu, click Save.  

Each time you open the file, you have the option to refresh data from the Microsoft Dynamics CRM 

database.  

Tips 

 If you export a dynamic worksheet or PivotTable that you think will be useful to other Microsoft 

Dynamics CRM users, you can add the list as a report, and then share it with others, or make it 

available to all Microsoft Dynamics CRM users.  

 If the recipients are in the same domain as you, and are Microsoft Dynamics CRM users, you can e-

mail a dynamic Excel file, or store it as a shared file. When recipients open the dynamic file, they 

will see data they have permission to view in Microsoft Dynamics CRM, so the data they see may be 

different from what you see.  

Notes 
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 There is potential for data loss if you export from Microsoft Dynamics CRM to a Microsoft Office Excel 

2003 comma-separated value (CSV) file.  

To ensure that the file is exported correctly, you must have data in every row of the last column of 

the list you are exporting. You can add a space or other character in last column of the file or 

reorder the columns so that the last column always contains data. More information: Microsoft 

Knowledge Base Article 77295  

 You must use Microsoft Office Excel XP, Excel 2003, or Excel 2007 to export a list to a PivotTable.  

 Some system views, such as Accounts: No Campaign Activities in Last 3 Months, can be exported only 

to a static Excel worksheet.  

Export data to an Excel dynamic worksheet   

1. In any area with a list of records, on the Actions toolbar, click the Export to Excel button .  

2. Click Dynamic worksheet.  

3. By default, an exported worksheet includes the fields that are displayed in the list, using the same 

field order, sorting, and field widths.  

To make changes to the columns, click Edit Columns. You can make the following types of 

changes:  

 Change the column order  

To change the column order, select a column heading, such as Account Name, and then under Common 

Tasks, click the Move Left button  or the Move Right button  to move the column.  

 Add columns  

a. To add columns to the export list, click Add Columns.  

b. To add columns for the main record type, select it, and then in the Add Columns list, click to 

select fields that you want to add as columns.  

c. To add columns from related records, first select the related record type, and then in the Add 

Columns list, click to select fields that you want to add as columns.  

d. Click OK.  

 Configure sorting  

To change the sort order, click Configure Sorting, in the Column list, select the column that you want to 

sort, in the Order area, click Ascending Order or click Descending Order, and then click OK.  

You cannot sort on columns from related record types. 

 Change column width  

http://go.microsoft.com/fwlink/?LinkId=105633
http://go.microsoft.com/fwlink/?LinkId=105633
http://go.microsoft.com/fwlink/?LinkId=105633
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To change the column width that will appear in the Excel worksheet, select a column heading, such as 

Account Name, click Change Properties. In the Change Column Properties dialog box, select the 

width (in pixels) that you want, and then click OK.  

 Remove columns  

To remove a column, select the column heading that you want to remove, and under Common Tasks, 

click Remove, and then in the confirmation message, click OK.  

4. Click OK, and then click Export.  

5. View the file containing the dynamic worksheet:  

a. To view the worksheet, click Open.  

b. If you are using Microsoft Office Excel 2003, click Enable automatic refresh.  

– OR –  

If you are using Microsoft Office Excel 2007:  

 You will see a message that says the file you are trying open is in a different format 

than specified by the file extension. Click Yes.  

 If you see the security warning Data connections have been disabled, click 

Options, and then click Enable this content, and then click OK.  

6. To refresh data in the file:  

 In Microsoft Office Excel 2007, click the Data tab, and in the Connections area, click 

Refresh All.  

 In Microsoft Office Excel 2003, on the Data menu, click Refresh Data.  

 To save the exported data to a file, in Excel, on the File menu, click Save.  

Each time you open the file, you have the option to refresh data from the Microsoft Dynamics CRM 

database.  

Tips 

 If you export a dynamic worksheet or PivotTable that you think will be useful to other Microsoft 

Dynamics CRM users, you can add the list as a report, and then share it with others, or make it 

available to all Microsoft Dynamics CRM users.  

 If the recipients are in the same domain as you, and are Microsoft Dynamics CRM users, you can e-

mail a dynamic Excel file, or store it as a shared file. When recipients open the dynamic file, they 

will see data they have permission to view in Microsoft Dynamics CRM, so the data they see may be 

different from what you see.  

Notes 

 There is potential for data loss if you export from Microsoft Dynamics CRM to a Microsoft Office Excel 

2003 comma-separated value (CSV) file.  
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To ensure that the file is exported correctly, you must have data in every row of the last column of 

the list you are exporting. You can add a space or other character in last column of the file or 

reorder the columns so that the last column always contains data. More information: Microsoft 

Knowledge Base Article 77295  

 Some system views, such as Accounts: No Campaign Activities in Last 3 Months, can be exported only 

to a static Excel worksheet.  

Importing Data 

Importing Data 

Microsoft Dynamics CRM provides several tools to add bulk data into Microsoft Dynamics CRM:  

 Import Data Wizard  

 Data Migration Manager  

If you want to automate the import or migration process, you can use the information in the Microsoft Dynamics CRM 

Software Development Kit to write a custom import tool.  

Comparison: Import Data Wizard and Data Migration Manager 

The following table summarizes which tool to use for each task:  

Task Import Data Wizard Data Migration Manager 

Bring data into more than 50 Microsoft 

Dynamics CRM record types 

Yes (All users with appropriate 

permissions can import data.) 

Yes (Only the system administrator 

can migrate data.) 

Bring data into custom record types 

and attributes 

Yes Yes 

Use multiple source files that contain 

related data 

No (You can import only one file at a 

time.) 

Yes 

Assign records to multiple users No (The wizard assigns all records to 

one user.) 

Yes 

Detect duplicates Yes No (You can run duplicate detection 

after migrating the records.) 

Delete all records associated with one 

job 

No Yes 

Automatically map data based on 

column headings in source file  

Yes No 

http://go.microsoft.com/fwlink/?LinkId=105633
http://go.microsoft.com/fwlink/?LinkId=105633
http://go.microsoft.com/fwlink/?LinkId=105633
http://go.microsoft.com/fwlink/?LinkId=97596
http://go.microsoft.com/fwlink/?LinkId=97596
http://go.microsoft.com/fwlink/?LinkId=97596
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Map drop-down list values  Yes No (To map list values, you must 

manually edit a data map.) 

Set value of Created On attribute 

from source data 

No Yes 

Customize Microsoft Dynamics CRM to 

match data 

No (Customization must be performed 

prior to import.) 

Yes (Data Migration Manager can 

create custom record types and 

attributes.) 

Transform data No (You must use a one-to-one 

mapping of attributes.) 

Yes (Complex data transformations 
are possible.) 

Send e-mail message to user when 

task is done 

Yes No 

Importing Your Data Using the Import Data Wizard 

The Import Data Wizard is useful for importing data you have stored in a spreadsheet or importing leads that you have 

purchased. It can be used for importing data into most record types. The Import Data Wizard is designed for use by 

people in sales, marketing, and customer service to use with their own data. All data imported will be owned by the 

user who does the import, or, if the user has permission to assign records, all records in an import can be assigned to 

another user.  

The data must be in a comma-separated value (CSV) file or in a delimited text (.txt) file with columns delimited by 

commas. You can export or save data in comma-delimited format from many applications, such as Microsoft Office 

Excel or Microsoft Office Outlook contacts, and most databases.  

If your import file uses column headings that match Microsoft Dynamics CRM display names, the file is automatically 

mapped. If you frequently import data that is in the same format, you can use a data map to map your data to speed 

the import process.  

Microsoft Dynamics CRM processes imports in the background, and you can select to receive an e-mail message when 

the import completes. Once an import completes, you can review the records that succeeded or failed to import. You 

can export failed records into a separate file so that you can fix them, and then try to import them again. Or, you can 

delete all records associated with an import.  

If your system administrator has enabled duplicate detection during import, you can select whether to import 

duplicates. After an import completes, you also can run a duplicate-detection job to detect potential duplicates.  

Migrating Data Using the Data Migration Manager 

The Data Migration Manager is a downloadable tool that can be used to migrate data from another customer 

relationship management system to Microsoft Dynamics CRM. The tool typically is used when Microsoft Dynamics CRM 

is first installed to migrate data from previous systems, but also can be used later. It can migrate:  

 Multiple files containing record types that are related to each other, such as accounts with related 

contacts  

 Records that need to be assigned to different Microsoft Dynamics CRM users  



 

 

 Microsoft Dynamics CRM 4.0 User’s Guide 63 

 

 Notes and attachments  

You can delete all records associated with a specific data-migration job.  

Data to be migrated must be stored in comma-separated value (CSV) files.  

To simplify the migration process, a data map can be used to map data from your source data to Microsoft Dynamics 

CRM. Data maps can be exported and imported, and can be edited manually if needed.  

The data migration tools must be used by a person with the System Administrator security role in Microsoft 

Dynamics CRM.  

More information: Install and Run the Data Migration Manager Back to the top 

Work with Imports 

 Data that can be imported  

Data can be imported into system attributes and custom attributes in most record types, and can also be imported 

into custom record types.  

For a complete list of record types you can import into, on the second page of the Import Data Wizard, view the 

values in the Record Type list.  

Prepare a file for import  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Common Task Permissions  

Follow the guidelines in this topic to ensure that your file imports successfully.  

 

1. Put records for each record type in a separate file.  

You can import only one record type at a time. For ease of use, name the file the same name as the 

record type in Microsoft Dynamics CRM. For example, put all your contact records in a file named 

contacts.txt or contacts.csv.  

2. Only put records that need to be assigned to one user in each file.  

3. The file must be in delimited text format (.txt) with columns separated by commas, or in a comma-

separated values (.csv) format.  

You can easily create delimited.txt or.csv format files by using Microsoft Office Excel.  

 If your file uses only ASCII characters, save the file as a comma-delimited values (.csv) file.  

 In Microsoft Office Excel, click Save As, and select CSV (Comma delimited)(*.csv).  

 If your file uses non-ASCII characters, save the file as a Unicode text (.txt) file and change the field 

separator to commas.  

If your import file contains non-ASCII characters, the import file must be in a Unicode or UTF-8 format.  

file:\\crmshare\Users\abecraft\Modified_Help_for_Print\content\ug_imp_importenrich.htm%23top
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b. In Excel, click Save As, and select Unicode Text (*.txt).  

c. Use Notepad to open the.txt file.  

d. Search for commas in the file. Enclose any data that includes commas with double-quotes. For 

example:  

 "23 State Street, Apt 2".  

e. Replace all tab characters with commas.  

a. In Notepad, select the tab character with the keyboard or mouse and press CTRL+C to 

copy it to the Clipboard.  

b. On the Edit menu, click Replace.  

c. In the Find what box, press CTRL+V to paste the Clipboard contents. This pastes the 

tab character.  

d. In the Replace with box, type a comma (,).  

e. Click Replace All.  

f. Click Save As.  

g. In the Save as type box, select Text Documents (*.txt), and in the Encoding box, 

select Unicode.  

 Make sure the first line of the file contains column headings.  

Edit your file and add column headings if they are not already present.  

If the column headings exactly match attribute display namevalues in Microsoft Dynamics CRM, 

columns in your source file will be mapped automatically to Microsoft Dynamics CRM columns, which 

will save time.  

Tips  

 To identify display name values, open the form for the record type as if you were creating a 

new record. The labels on the form typically match the display names, although it is possible 

for your system customizer to have changed the form label values.  

If you have the appropriate security role, you identify display names in the Customization 

area:  

1. In the Navigation Pane, click Settings, click Customization, and then click 

Customize Entities.  

2. Open the entity, and then click Attributes.  

 If you are working in a multi-language environment, automatic mapping of columns uses the 

display names from the user interface language, set on the Regional Options tab of the 

Set Personal Options dialog box. More information: Set Personal Options  

 Make sure the first column heading is not the name of a record type.  

The first column heading in your file cannot be the name of another record type. For example, 

phone call, task, letter, fax, and appointment records all require a Subject column. As Subject is also 

the name of a record type, the Subject column must not be the first column in your file.  

 Make sure data exists for all business-required attributes.  
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A record will only import if all Microsoft Dynamics CRM business-required attributes are mapped, 

and if the data exists in each of the source columns that are mapped to the required attributes.  

You can either determine the required attributes in advance, or use the Import Data Wizard to 

identify missing required mappings. In either case, make sure you have required data in each 

record. To determine which fields are business-required, open the form for the record type as if you 

were creating a new record, and identify fields that are marked with a red asterisk (*).  

The following list shows default business-required fields for commonly imported record types.  

 Account: Account Name  

 Contact: Last Name  

 Lead: Topic, Last Name, Company Name  

 Product: Default Unit, Unit Group, Decimals Supported  

 Campaign Response: Parent Campaign, Subject, Owner  

 If records in your import file should be related to an existing Microsoft Dynamics CRM record, 

make sure the column heading and data in the column that connects the records is valid.  

 The value in the column that refers to another record must be unique in the primary 

attribute for the related record. The lookup is not case-sensitive.  

For example, if you are importing a contact that you want associated with an existing 

account, you must have a column in your source file containing the Account Name for an 

existing Microsoft Dynamics CRM account record. If you want to perform automatic mapping, 

the column heading for this column should be Parent Customer.  

The Parent Customer attribute can be resolved either to an account or contact. The Import 

Data Wizard looks for a unique account or contact record. If there is a contact record and an 

account record that have identical values in the Account Name field in the account record 

and the Full Name field in the contact record, the record will not be imported.  

 The value in the column can also be a Microsoft Dynamics CRM globally unique identifier 

(GUID).  

 If the column in your source file that is used to create the relationship contains multiple 

values, edit the data to contain just one value.  

For example, if you are importing e-mail activities, and your source data has a record with 

multiple values in the To column, edit the data to contain just one value.  

 Example showing sample leads to import  

The following lines show what the data might look like for a.csv format file containing leads to import. The first line 

contains the field names, and the remaining lines are imported as data.  

Company,Last Name,First Name,Topic,Email,Mobile Phone 

Designer Bikes,Groth,Brian,Mountain bikes,someone@example.com,555-555-0112 

Major Sporting Goods,Bedecs,Anna,Components,,555-555-0171 

 

 Example showing sample products to import  

The following lines show the minimum amount of data required for a.csv format file containing products to import. 

The first line contains the field names, and the remaining lines are imported as data. Because Unit Group and 

Default Unit are record types in Microsoft Dynamics CRM, the values for these columns must map to valid values in 

Microsoft Dynamics CRM.  

Product,Unit Group,Default Unit,Decimals Supported 
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Front Brakes,Single pair,Unit pair,0 

Vest,Clothing,Single article,2 

 

Note 

By default, the maximum size of the file that you can upload is 4 megabytes (MB). This can be changed by your system 

administrator. More information: Microsoft Knowledge Base Article 295626  

Import records from a file  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Common Task Permissions  

To ensure a successful import, be sure to follow the steps in Prepare a file for import.  

 

1. In the Navigation Pane, click Workplace, and then under My Work, click Imports.  

– OR –  

On the Tools menu, click Import Data.  

2. On the Actions toolbar, click New.  

3. Click Browse to find the file to import.  

4. If you are not using the default delimiters, which for data are double quotation marks (" ") and for 

fields are commas (,), you can select other symbols as the delimiters.  

Other recognized delimiters for data include: single quotation marks (' ') and none.  

Other recognized delimiters for fields include: colons (:), tabs, and semicolons (;).  

5. Click Next.  

6. Select the record type to import the records to.  

7. Determine how the source data will be mapped to Microsoft Dynamics CRM data:  

 If the column headings in your file exactly match Microsoft Dynamics CRM display names 

Display, an automatic data map will be used, and the word Automatic will be entered in the 

Data map box.  

 If the Data map box remains empty, check your data file to make sure the column headings 

are actual display name values from the selected record type, or click the Lookup 

button  to select a data map. If you do not yet have a data map, you need to create one, 

and then return to the wizard. More information: Work with Data Maps  

8. In the Mapping Results section, if there are any unmapped columns or errors, click View Details.  

 If you have columns that cannot be imported, you will see Ignored columns: Count.  

Two types of columns are ignored: computed columns, such as Full Name in the contact 

record type, and columns for attributes that cannot be created and updated, such as Created 

On, Created By, Modified On, and Modified By in all record types.  

 If you have not mapped all business-required columns, you will see Unmapped required 

columns Count.  

http://go.microsoft.com/fwlink/?LinkId=99118
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9. After reviewing the details, if none of them need to be fixed, click OK.  

– OR –  

If you need to fix your source file, open your source file and fix the problems, click Back, and return 

to step 3 to select your source file.  

10. Click Next.  

11. In the Assign To section, to assign all the records in this import to a different user, click Lookup, 

and select the user.  

This option is not available for organization-owned record types such as Product.  

12. By default, if duplicate detection is enabled for this record type, duplicate records are not imported.  

If you want to import duplicates, select Import duplicate records.  

This option is not available if duplicate detection is not enabled or not available for the record type 

you are importing.  

13. Click Next.  

14. Rename the import job if needed, change the notification options if needed, and then click Import.  

An import job is started in the background. You can continue to work in Microsoft Dynamics CRM 

while the import runs.  

Tips 

 The direct import of Microsoft Office Outlook contacts is not supported in Microsoft Dynamics CRM. 

However, you can export your Outlook contacts to a comma separated value (.csv) file, and then 

import them into Microsoft Dynamics CRM by using the Import Data Wizard. For more information 

about how to export items in Outlook, see the Help information in Outlook.  

 To pause or postpone an import:  

1. In the Navigation Pane, click Settings, and then click System Jobs.  

2. Select the scheduled import job, and then on the More Actions menu, click Pause or 

Postpone.  

Note 

By default, the maximum size of the file that you can upload is 4 megabytes (MB). This can be changed by your system 

administrator. More information: Microsoft Knowledge Base Article 295626  

Create a data map for use with import  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Common Task Permissions  

Data maps created for use with data import are not the same as data maps used for data migration. You cannot 
use a data migration data map with the Import Data Wizard.  

 

1. In the Navigation Pane, click Settings, click Data Management, and then click Data Maps.  

2. To edit a data map, double-click the data map.  

– OR –  

http://go.microsoft.com/fwlink/?LinkId=99118
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To create a new data map, on the Actions toolbar, click New, type a name and select the record 

type that you will use the data map with.  

3. Create a sample comma-separated value (CSV) file containing:  

 A heading row containing all column headings that might be included in a source file you plan 

to import.  

 Data rows that have data for each Microsoft Dynamics CRM drop-down list attribute. For 

example, if you are importing leads, lead source data is stored in the Lead Source drop-

down list attribute in Microsoft Dynamics CRM. You would need one row of data to include 

every possible lead source used in your source data, such as Web site inquiry, tradeshow, and 

advertisement.  

 File size smaller than 50 KB.  

 Tip 

 One way to create this file is to use a file you intend to import as your sample file. However, the 

sample file must be smaller than 50 KB.  

4. Load your sample file:  

a. Click Attributes, and then click Load Sample Data.  

b. Click Browse, select the comma-separated value file, click Open, and then click OK.  

The source file column headings will be displayed.  

 Tip 

 The sample file is not saved as part of the data map. You need to load the sample data each time 

you edit your data map.  

 Map each source file column heading to a Microsoft Dynamics CRM attribute:  

 . Under Source, select a source file column heading from the Column Headings column.  

a. Select an attribute from the listed unmapped Microsoft Dynamics CRM attributes.  

Important All business-required attributes must be mapped. To identify unmapped business-

required attributes, in the Target area, in the Unmapped Attributes box, select Business 

Required.  

b. Click Map.  

 Tips 

 To change a mapping, click the source value, and then click Unmap.  

 To ignore values in a column during import, click the source column heading, and then click 

Ignore.  

 To map one source column to multiple Microsoft Dynamics CRM attributes, select one attribute 

and click Map, and then select another attribute and click Map again.  
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 The Created On and Modified On attributes cannot be imported so they do not appear in the 

target attribute list.  

 If you selected any Microsoft Dynamics CRM drop-down list attributes, map all values in each 

list.  

If you didn't select any drop-down list attributes, go to step 7.  

 . Under Mappings, click List Values.  

a. Under List Attributes, select a source file column heading from the Column Headings 

column.  

b. Under Corresponding List Values, for each item in the Source Record Type column, select 

a value from the Microsoft Dynamics CRM Value list, and then click Map.  

The mapped value will appear in the Target Record Type column.  

c. In addition to any values from your sample file, you must also specify a target Microsoft 

Dynamics CRM value for rows in your source data that have no data in this attribute 

(Empty), and for rows that contain data that is not mapped (Unmapped).  

For example, if you are importing leads, you might want to map any empty or unmapped 

values in the Rating column to Cold.  

 Tips 

 If your list of values from your sample file does not appear in the list, under Mappings, click 

Attributes, and reload your source sample file.  

 If you need additional list values in Microsoft Dynamics CRM, contact your system administrator or 

system customizer. More information: Requesting User Interface Changes  

 Once you have mapped a value, you can change it to another value, but you cannot unmap it.  

 Click Save or Save and Close.  

View the progress and results of an import, and correct errors  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Common Task Permissions  

You must wait for an import job to complete before you can repair failures. If you selected to receive e-mail 

notification in the Import Data Wizard, you will receive an e-mail message when the import completes.  

 

1. In the Navigation Pane, click Workplace, and then under My Work, click Imports.  

 Monitor the progress of the import. To monitor status for an import, watch the Status Reason column. The values 

will change from Submitted to Parsing to Transforming to Importing to Completed.  

These values correspond with the three stages of each import: parsing the file, transforming the data, and 

importing the data.  

For detailed information about the progress of the import job, double-click the import job record, and then under 

Details, click System Jobs. One system job is created for each import stage.  
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Tip: To refresh the status, click the Refresh button .  

2. Once an import has completed, view the summary information showing the number of records created 

and the number of records containing errors.  

3. To open the import record to view the records that did not import, double-click the import record.  

4. To view rows that were successfully imported, under Details, click Record Types Created.  

5. To view rows that were not imported, under Details, click Failures.  

To export rows that failed to import to a new comma-separated value (CSV) file, click Export Error 

Rows. You can correct the errors in this file, and then import it.  

Work with Data Maps 

Create a data map for use with import  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Common Task Permissions  

Data maps created for use with data import are not the same as data maps used for data migration. You cannot use a 
data migration data map with the Import Data Wizard.  

 

1. In the Navigation Pane, click Settings, click Data Management, and then click Data Maps.  

2. To edit a data map, double-click the data map.  

– OR –  

To create a new data map, on the Actions toolbar, click New, type a name and select the record 

type that you will use the data map with.  

3. Create a sample comma-separated value (CSV) file containing:  

 A heading row containing all column headings that might be included in a source file you plan 

to import.  

 Data rows that have data for each Microsoft Dynamics CRM drop-down list attribute. For 

example, if you are importing leads, lead source data is stored in the Lead Source drop-

down list attribute in Microsoft Dynamics CRM. You would need one row of data to include 

every possible lead source used in your source data, such as Web site inquiry, tradeshow, and 

advertisement.  

 File size smaller than 50 KB.  

 Tip 

 One way to create this file is to use a file you intend to import as your sample file. However, the 

sample file must be smaller than 50 KB.  

4. Load your sample file:  

a. Click Attributes, and then click Load Sample Data.  
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b. Click Browse, select the comma-separated value file, click Open, and then click OK.  

The source file column headings will be displayed.  

 Tip 

 The sample file is not saved as part of the data map. You need to load the sample data each time 

you edit your data map.  

 Map each source file column heading to a Microsoft Dynamics CRM attribute:  

 . Under Source, select a source file column heading from the Column Headings column.  

a. Select an attribute from the listed unmapped Microsoft Dynamics CRM attributes.  

Important All business-required attributes must be mapped. To identify unmapped business-

required attributes, in the Target area, in the Unmapped Attributes box, select Business 

Required.  

b. Click Map.  

 Tips 

 To change a mapping, click the source value, and then click Unmap.  

 To ignore values in a column during import, click the source column heading, and then click 

Ignore.  

 To map one source column to multiple Microsoft Dynamics CRM attributes, select one attribute 

and click Map, and then select another attribute and click Map again.  

 The Created On and Modified On attributes cannot be imported so they do not appear in the 

target attribute list.  

 If you selected any Microsoft Dynamics CRM drop-down list attributes, map all values in each 

list.  

If you didn't select any drop-down list attributes, go to step 7.  

 . Under Mappings, click List Values.  

a. Under List Attributes, select a source file column heading from the Column Headings 

column.  

b. Under Corresponding List Values, for each item in the Source Record Type column, select 

a value from the Microsoft Dynamics CRM Value list, and then click Map.  

The mapped value will appear in the Target Record Type column.  

c. In addition to any values from your sample file, you must also specify a target Microsoft 

Dynamics CRM value for rows in your source data that have no data in this attribute 

(Empty), and for rows that contain data that is not mapped (Unmapped).  

For example, if you are importing leads, you might want to map any empty or unmapped 

values in the Rating column to Cold.  

 Tips 
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 If your list of values from your sample file does not appear in the list, under Mappings, click 

Attributes, and reload your source sample file.  

 If you need additional list values in Microsoft Dynamics CRM, contact your system administrator or 

system customizer. More information: Requesting User Interface Changes  

 Once you have mapped a value, you can change it to another value, but you cannot unmap it.  

 Click Save or Save and Close.  

Export a data map  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Common Task Permissions  

 

 

1. In the Navigation Pane, click Settings, click Data Management, and then click Data Maps.  

2. On the Actions toolbar, click Export.  

3. In the File Download dialog box, click Open or Save.  

Notes 

 Data maps created for use with data import are not the same as data maps used for data migration. 

You cannot use a data migration data map with the Import Data Wizard.  

 Exported XML files containing data maps can be edited manually. The complete syntax can be found in 

the Data Map Schema section of the Microsoft Dynamics CRM 4.0 Software Development Kit.  

Import a data map  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Common Task Permissions  

 

 

1. In the Navigation Pane, click Settings, click Data Management, and then click Data Maps.  

2. On the Actions toolbar, click Import.  

3. In the Import Data Map dialog box, type the name of the file to import, or click Browse and locate 

the file, and then click OK.  

A data map must be a well-formed and valid XML file.  

Notes 

 Data maps created for use with data import are not the same as data maps used for data migration. 

You cannot use a data migration data map with the Import Data Wizard.  

 Exported XML files containing data maps can be edited manually. The complete syntax can be found in 

the Data Map Schema section of the Microsoft Dynamics CRM 4.0 Software Development Kit.  
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Tip 

If you create a data map that you think will be useful for other users in your organization, you can share it. More 

information: Share or Assign Records  

Install and Run the Data Migration Manager 

Concepts:  

 Importing Data  

 

Install and run the Data Migration Manager  

 Can I do this task?  

This task requires the System Administrator security role, and you must also be in the local 
Administrators group on the computer on which you are installing Data Migration Manager. More 
information about specific permissions and performing this task while offline: Configuration Permissions  

The Data Migration Manager is included on the Microsoft Dynamics CRM Client CD.  

 

1. Install Data Migration Manager:  

a. On the computer on which you plan to install Data Migration Manager, use Microsoft Internet 

Explorer to browse to your Microsoft Dynamics CRM server.  

If you cannot use Microsoft Dynamics CRM from this computer, you will not be able to install 

and use Data Migration Manager on this computer.  

 If the Microsoft Internet Explorer Connect to dialog box is displayed, select the 

Remember my password check box.  

 If you are using Windows Vista:  

a. In Control Panel, click User Accounts, and then click Manage Your 

Network Passwords.  

b. In the Store User Names and Passwords screen, click Add.  

c. In the Store Credential Properties screen, specify the name of your Microsoft 

Dynamics CRM server.  

d. In the Credential type section, select A Web site or program credential, 

click OK, and then click Close.  

b. Insert the Microsoft Dynamics CRM Client CD, and double-click Setup.exe.  

c. On the Setup screen, click Install Microsoft Dynamics CRM Data Migration Manager, 

and follow the instructions in the setup wizard.  

 If you choose to install Microsoft SQL Server Express, note that it cannot be installed on 

a compressed drive.  

 If you choose to use an existing SQL Server, note that it must be in the same domain 

as the computer on which you are installing Data Migration Manager.  

2. Configure Data Migration Manager:  
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a. On the Start menu, point to All Programs, point to Microsoft Dynamics CRM, and then 

click Data Migration Manager.  

It takes the Data Migration Manager a few minutes to start the first time.  

b. Complete the steps in the configuration wizard.  

Note: If you are using a computer running Microsoft SQL Server rather than Microsoft SQL 

Server Express, by default the configuration wizard will attempt to connect to the CRM 

instance on your server. If you prefer to use a different instance, on the Specify SQL Server 

page, specify the instance name in the format server_name/instance_name.  

3. Start the Data Migration Manager:  

 On the Start menu, point to All Programs, point to Microsoft Dynamics CRM, and then 

click Data Migration Manager.  

Notes:  

o Data Migration Manager cannot be used while Microsoft Office Outlook is running.  

If you have closed Outlook, and get an error message stating that Outlook is still running, you 

need to use Task Manager to stop the Outlook.exe process.  

o Data Migration Manager can only be used by the person who installs it.  

Note 

For information about how to prepare your files for data migration, and for help troubleshooting Data Migration 

Manager configuration, after Data Migration Manager is installed, on the Start menu, point to All Programs, point to 

Microsoft Dynamics CRM, and then click Data Migration Manager Help.  

Analyzing Information 

Running Reports and Analyzing Data 

When you want to analyze data or view a report in Microsoft Dynamics CRM, there are several ways to view the 

relevant data:  

 Run a default report. More information: Default Reports  

 Use Advanced Find to search for the subset of data you need. Then export the results list to a static or 

dynamic Microsoft Office Excel worksheet or a PivotTable for further analysis. Once the data is 

exported, you can create your own Microsoft Office Word file and mail-merge the data. More 

information: Export Data to Excel  

 Create your own report:  

 Use the Report Wizard to create a new Reporting Services report. The wizard helps you group 

and summarize data, create charts and tables, and generates an easily printable report. More 

information: Create, Edit, or Copy a Report Using the Report Wizard  

 Add any exported Excel file as a personal report, and share it with your colleagues if 

appropriate.  

Or, ask your system administrator or system customizer to add any exported Excel file as a 

report available to everyone in your organization.  

If the Excel file is dynamic, the data in the file will be refreshed any time the file is opened, 

and each person who runs the report will see data that only they have permission to see. 

More information: Customizing and Organizing Reports  
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 Add any file or link to a Web page as a personal report, and share it with your colleagues if 

appropriate. More information: Customizing and Organizing Reports  

 Write a new report using Microsoft Office Excel, Microsoft SQL Server Reporting Services, or 

other ODBC-compliant reporting tools. Add it as a personal report, and share it with your 

colleagues if appropriate. More information: Write a Report Using Report-Writing Tools  

Reports can be used when Microsoft Dynamics CRM for Outlook is offline. More information: Working Offline  

Work with Advanced Find 

Create, edit, or save an Advanced Find search  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Common Task Permissions  

 

 

1. On the Standard toolbar, click Advanced Find.  

Tip: Advanced Find starts with criteria based on where you are in Microsoft Dynamics CRM. If you 

click Advanced Find from a view, the criteria for that view will be preloaded for you.  

– OR –  

To edit a saved search, on the Standard toolbar, click Advanced Find, click the Saved Views tab, 

and then double-click the saved view.  

2. Specify the search criteria.  

 If Show Details is visible in the criteria toolbar, click it.  

 Specify what to search for 

b. In the Look for list, select the type of record you want to search for, such as 

Accounts, Leads, or Users.  

c. Click Select to select criteria for the search, including the field to search on (for 

example, Account Name or City), the query relational operator, and the values to locate (for 

example, "Seattle" or "E-mail").  

You can select fields from the current record type, or from related records.  

 For some values, you can click the Lookup button  to open the Select Values dialog 

box and select the value you want.  

At the bottom of the Select list, the Related section shows related record types. When you select a 
related record type, a new Select link appears to select fields from this related record type.  

 Clear, delete, or group search criteria clauses 

 Clear all search criteria to start over.  

a. Click Clear to remove all criteria.  

b. In the confirmation message, click OK.  
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 Delete a row of search criteria.  

 . Click the Options menu button  next to a search criteria row, and then click Delete.  

a. In the confirmation message, click OK.  

 Group criteria.  

 . Click the Options menu button  next to a search criteria row, and then click Select Row.  

To group search criteria, you must select two or more rows for the same record type. For example, 

Sales Stage and Est. Revenue are both field values in the Opportunity record type and two rows 

that specify search criteria for these fields can be grouped. However, rows with field values from 

Account and Opportunity record types cannot be grouped.  

a. On the Filter toolbar, select Group AND or Group OR.  

b. Repeat steps a and b to create additional criteria groups.  

 Select and deselect grouped criteria.  

 . Click the Options menu button  next to a search criteria row that has been selected, and 

then click Deselect Row. You can unselect rows from a group or individually.  

a. Click the Options menu button  next to the group, and then click Select Group to select 

a group, or click Deselect Group to unselect a group that has been previously selected.  

 Add a search criteria clause to a criteria group.  

 . Click the Options menu button  next to the group, and then click Add Clause.  

a. Add search criteria to the new clause.  

 Ungroup rows of criteria that you have grouped together using Group AND or Group OR.  

 . Click the Options menu button  next to the group you want to ungroup, and then click 

Ungroup.  

a. Repeat this step to ungroup additional search criteria groups.  

 Change a Group AND group to a Group OR group, or a Group OR group to a Group AND 

group.  

 . Click the Options menu button  next to the group, and then click Change to OR or 

Change to AND.  

a. Repeat this step to change additional search criteria groups.  

 Hide or delete a row in Simple view:  

 . To hide a row, click the Options menu button  next to a search criteria row, and then click 

Hide in Simple Mode.  

a. To make a hidden row visible, click Show in Simple Mode  

 Specify the columns to include in the search results.  

 . Click Edit Columns, and then click Add Columns.  

a. Select the record type that includes the columns you want to add.  

b. Select the check box next to the columns you want to add. If a column isn't listed, contact 

your system administrator. 

c. Click OK.  

d. The following options are also available:  
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 To adjust the width of a column, click the column, click Change Properties, select a 

width, and then click OK.  

 To reorder columns, select a column, and use the arrow keys to move it to the left or 

right.  

 To remove a column, select it, and then click Remove.  

e. Click OK.  

 Specify the sort order.  

 Click Edit Columns, click Configure Sorting, and specify the column to sort on, and the 

sort order.  

Tip: Each view is sorted by only one column. However, after you click Find, you can sort by 

additional columns. To sort a search results list by an additional column, press SHIFT while 

you click the additional column header.  

You can only sort on columns from the primary record record type.  

 Save the search as a saved view.  

 . If you're saving an existing saved view, click Save. If you are saving a new view or want to 

change the name of the view because you changed the criteria, click Save As.  

a. In the Query Properties dialog box, in the Name field, type a name for the search.  

b. In the Description box, type a brief description, and then click OK.  

The search is saved as a view and appears on the Saved Views tab of the Advanced Find 

form. This new view is also available from the list page for the record type in the View box, 

in the My Views section. 

 Click Find. The selected records are displayed.  

 Click Back to Query to return to the Find tab.  

Tips 

 When you specify search criteria to find activity records, you can either search through all types of 

activities or select one type of activity to search, such as Task or Appointment.  

 The columns that are displayed by default are controlled by the Advanced Find View for the record 

type. More information: Work with Entities.  

 If you need to search based on the names of people who participated in an activity, in the Advanced 

Find criteria, you must search fields in the related activity party. You can search based on the 

person's name (Party field), or by their role in the activity, such as sender or recipient 

(Participation Type field).  

For example, to find e-mail messages sent to a specific contact:  

a. In the Activities list, in the Type box, select E-mail.  

b. Click Advanced Find, and then click Show Details.  

c. Click Select, and then in the Related section, select Activity Parties (Activity).  

d. Under Activity Parties (Activity), click Select.  

e. In the Fields section, click Participation Type, click Enter Value, and then click the 

Select Values button .  
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f. In the Available Values list, select To Recipient, click the Add Selected Records 

button , and then click OK.  

g. Under Activity Parties (Activity), click Select.  

h. In the Fields section, click Party.  

i. Click the Equals Current User operator, and change it to Equals.  

j. Click Enter Value, and then click the Lookup button .  

k. In the Look for box, select Contact, enter some letters to search for, and then click Start 

search.  

l. Select the contact, click the Add Selected Records button , and then click OK.  

m. In the Advanced Find page, click Find.  

Note 

You cannot use Advanced Find to find records related to quick campaigns.  

Working with saved Advanced Find searches  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Common Task Permissions  

 

 

 You can run, share, assign, delete, or deactivate a saved view that you own.  

If another user has shared a saved view with you, what you can do will depend on the specific 

privileges they have given to you: Share, Assign, Delete, or Write.  

 Run a saved search 

On any list page in the View box, in the My Views section, select a saved view.  

If there is not a My Views section, there are no saved searches for this record type.  

– OR –  

On the Standard toolbar, click Advanced Find, and then click the Saved Views tab. Double-click a saved 

search, and then click Find.  

 Share a saved search 

1. On the Standard toolbar, click Advanced Find, and then click the Saved Views tab.  

2. Select the view. On the Actions toolbar, click More Actions, and then click Sharing.  

3. In the sharing dialog box, under Common Tasks, click Add User/Team.  

4. In the Look Up Records dialog box, in the Look for list, select the type of record you want to 

find.  

5. In the Search for records box, type the first few letters of the name of the record to narrow 

your search, and then click the Find button .  
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6. In the list of available records, click a user or team to select it, and then click the Add Selected 

Records button  to add the user or team to the Selected records list.  

7. Click OK.  

8. In the sharing dialog box, select the type of share access that you want. The available permissions 

are: Read, Write, Delete, Append, Assign, or Share.  

9. Click OK.  

The saved view will show up in the My Views section of your coworker's View list.  

Tips  

 To cancel any changes that you have made and retain the previous permissions settings, click 

Reset.  

 To select or clear all permissions on a selected item, click Toggle All Permissions of the 

Selected Items.  

 Assign a saved search 

1. On the Standard toolbar, click Advanced Find, and then click the Saved Views tab.  

2. Select the view, and then on the Actions toolbar, click the Assign button .  

3. In the Assign dialog box, click:  

 Assign to me  

Use this option to assign the record to yourself.  

– OR –  

 Assign to another user  

Click the Lookup button , type a part of the user's name, click the Find button 

, double-click the user's name, and then to close Look Up Records dialog box, 

click OK.  

4. Click OK.  

 Deactivate a saved search 

1. On the Standard toolbar, click Advanced Find, and then click the Saved Views tab.  

2. Select the view, and then on the More Actions menu, click Deactivate.  

 Delete a saved search 

1. On the Standard toolbar, click Advanced Find, and then click the Saved Views tab.  

2. Select the view, and then on the Actions toolbar, click the Delete button .  

 E-mail or copy a link to a saved search 
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Send a shortcut in an e-mail  

l. On the Actions toolbar, click Send Shortcut, and then click Of Current View.  

m. Complete the e-mail form and send. 

Copy a shortcut  

n. On the Actions toolbar, click Copy Shortcut, and then click Of Current View.  

o. Paste the shortcut into any application that supports copy and paste. For example, in Microsoft 

Office Word, press CTRL+V.  

More information: Send or Copy a Shortcut  

Export Data to Excel 

You can export any list to Microsoft Office Excel, including the results of an Advanced Find search.  

You can export to a static or dynamic Excel worksheet or to a PivotTable. 

Export data to an Excel static worksheet  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Common Task Permissions  

 

 

1. In any area with a list of records, select the columns to include in the exported list.  

By default, an exported worksheet includes the fields that are displayed in the list, using the same 

field order, sorting, and field widths.  

To make changes to the columns in an Advanced Find View, click Edit Columns. You can make the 

following types of changes:  

 Change the column order  

To change the column order, select a column heading, such as Account Name, and then under Common 

Tasks, click the Move Left button  or the Move Right button  to move the column.  

 Add columns  

a. To add columns to the export list, click Add Columns.  

b. To add columns for the main record type, select it, and then in the Add Columns list, click to 

select fields that you want to add as columns.  

c. To add columns from related records, first select the related record type, and then in the Add 

Columns list, click to select fields that you want to add as columns.  

d. Click OK.  
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 Configure sorting  

To change the sort order, click Configure Sorting, in the Column list, select the column that you want to 

sort, in the Order area, click Ascending Order or click Descending Order, and then click OK.  

You cannot sort on columns from related record types. 

 Change column width  

To change the column width that will appear in the Excel worksheet, select a column heading, such as 

Account Name, click Change Properties. In the Change Column Properties dialog box, select the 

width (in pixels) that you want, and then click OK.  

 Remove columns  

To remove a column, select the column heading that you want to remove, and under Common Tasks, 

click Remove, and then in the confirmation message, click OK.  

You cannot change the columns for a system view, such as All Active Accounts. You must either 

customize the view, which requires the System Administrator or System Customizer security role, or 

use Advanced Find to create your own view based on the current view. To create your own view, 

with the system view open, click Advanced Find.  

2. On the Actions toolbar, click the Export to Excel button .  

3. In the Export Data to Excel dialog box, select Static worksheet with records from this page.  

– OR –  

Select Static worksheet with records from all pages in the current view.  

This option will be visible only when your view includes more than one page of records.  

4. Click Export.  

5. To view the static worksheet, click Open.  

If you are using Microsoft Office Excel 2007, you will see a message that says the file you are trying 

open is in a different format than specified by the file extension. Click Yes.  

6. To save the exported data to a file, in Excel, on the File menu, click Save.  

Tip 

You can e-mail a static exported worksheet to anyone, or store it in a shared file. Anyone who opens the file will see all 

the data in the file, whether or not they are a Microsoft Dynamics CRM user or have privileges to view the data in 

Microsoft Dynamics CRM.  

Notes 

 There is potential for data loss if you export from Microsoft Dynamics CRM to a Microsoft Office Excel 

2003 comma-separated value (CSV) file.  
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To ensure that the file is exported correctly, you must have data in every row of the last column of 

the list you are exporting. You can add a space or other character in last column of the file or 

reorder the columns so that the last column always contains data. More information: Microsoft 

Knowledge Base Article 77295  

 By default, in Microsoft Dynamics CRM, you cannot export a list of more than 10,000 records at a time 

to a static Excel worksheet. Your system administrator can change this. More information: Microsoft 

Knowledge Base Article 911395  

 By default, Microsoft Dynamics CRM lists up to 50 records per page. If there is more than one page of 

records available to view in the list of records, use the Page arrows at the bottom of the list to view 

the additional pages.  

Export data to an Excel PivotTable   

1. In any area with a list of records, on the Actions toolbar, click the Export to Excel button .  

2. Click Dynamic PivotTable.  

3. To add or remove a column in the report, click Select Columns.  

4. In the Select PivotTable Columns list, select or clear the check boxes for the fields as needed, and 

then click OK. 

By default, only fields that are displayed in the Select PivotTable Columns list are included in the 

PivotTable Field List. 

5. Click Export.  

6. Open the file containing the PivotTable:  

a. To view the PivotTable, click Open.  

b. If you are using Microsoft Office Excel 2003, click Enable automatic refresh.  

– OR –  

If you are using Microsoft Office Excel 2007:  

 You will see a message that says the file you are trying open is in a different format 

than specified by the file extension. Click Yes.  

 If you see the security warning Data connections have been disabled, click 

Options, and then click Enable this content, and then click OK.  

7. Drag the fields from the PivotTable Field List to the PivotTable. For more information, see Microsoft 

Office Excel Help.  

8. To refresh data in the file:  

 In Microsoft Office Excel 2007, click the Data tab, and in the Connections area, click 

Refresh All.  

 In Microsoft Office Excel 2003, on the Data menu, click Refresh Data.  

 To save the exported data to a file, in Excel, on the File menu, click Save.  

Each time you open the file, you have the option to refresh data from the Microsoft Dynamics CRM 

database.  

Tips 

http://go.microsoft.com/fwlink/?LinkId=105633
http://go.microsoft.com/fwlink/?LinkId=105633
http://go.microsoft.com/fwlink/?LinkId=99131
http://go.microsoft.com/fwlink/?LinkId=99131
http://go.microsoft.com/fwlink/?LinkId=99131
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 If you export a dynamic worksheet or PivotTable that you think will be useful to other Microsoft 

Dynamics CRM users, you can add the list as a report, and then share it with others, or make it 

available to all Microsoft Dynamics CRM users.  

 If the recipients are in the same domain as you, and are Microsoft Dynamics CRM users, you can e-

mail a dynamic Excel file, or store it as a shared file. When recipients open the dynamic file, they 

will see data they have permission to view in Microsoft Dynamics CRM, so the data they see may be 

different from what you see.  

Notes 

 There is potential for data loss if you export from Microsoft Dynamics CRM to a Microsoft Office Excel 

2003 comma-separated value (CSV) file.  

To ensure that the file is exported correctly, you must have data in every row of the last column of 

the list you are exporting. You can add a space or other character in last column of the file or 

reorder the columns so that the last column always contains data. More information: Microsoft 

Knowledge Base Article 77295  

 You must use Microsoft Office Excel XP, Excel 2003, or Excel 2007 to export a list to a PivotTable.  

 Some system views, such as Accounts: No Campaign Activities in Last 3 Months, can be exported only 

to a static Excel worksheet.  

Export data to an Excel dynamic worksheet   

1. In any area with a list of records, on the Actions toolbar, click the Export to Excel button .  

2. Click Dynamic worksheet.  

3. By default, an exported worksheet includes the fields that are displayed in the list, using the same 

field order, sorting, and field widths.  

To make changes to the columns, click Edit Columns. You can make the following types of 

changes:  

 Change the column order  

To change the column order, select a column heading, such as Account Name, and then under Common 

Tasks, click the Move Left button  or the Move Right button  to move the column.  

 Add columns  

a. To add columns to the export list, click Add Columns.  

b. To add columns for the main record type, select it, and then in the Add Columns list, click to 

select fields that you want to add as columns.  

c. To add columns from related records, first select the related record type, and then in the Add 

Columns list, click to select fields that you want to add as columns.  

d. Click OK.  

http://go.microsoft.com/fwlink/?LinkId=105633
http://go.microsoft.com/fwlink/?LinkId=105633
http://go.microsoft.com/fwlink/?LinkId=105633
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 Configure sorting  

To change the sort order, click Configure Sorting, in the Column list, select the column that you want to 

sort, in the Order area, click Ascending Order or click Descending Order, and then click OK.  

You cannot sort on columns from related record types. 

 Change column width  

To change the column width that will appear in the Excel worksheet, select a column heading, such as 

Account Name, click Change Properties. In the Change Column Properties dialog box, select the 

width (in pixels) that you want, and then click OK.  

 Remove columns  

To remove a column, select the column heading that you want to remove, and under Common Tasks, 

click Remove, and then in the confirmation message, click OK.  

4. Click OK, and then click Export.  

5. View the file containing the dynamic worksheet:  

a. To view the worksheet, click Open.  

b. If you are using Microsoft Office Excel 2003, click Enable automatic refresh.  

– OR –  

If you are using Microsoft Office Excel 2007:  

 You will see a message that says the file you are trying open is in a different format 

than specified by the file extension. Click Yes.  

 If you see the security warning Data connections have been disabled, click 

Options, and then click Enable this content, and then click OK.  

6. To refresh data in the file:  

 In Microsoft Office Excel 2007, click the Data tab, and in the Connections area, click 

Refresh All.  

 In Microsoft Office Excel 2003, on the Data menu, click Refresh Data.  

 To save the exported data to a file, in Excel, on the File menu, click Save.  

Each time you open the file, you have the option to refresh data from the Microsoft Dynamics CRM 

database.  

Tips 

 If you export a dynamic worksheet or PivotTable that you think will be useful to other Microsoft 

Dynamics CRM users, you can add the list as a report, and then share it with others, or make it 

available to all Microsoft Dynamics CRM users.  
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 If the recipients are in the same domain as you, and are Microsoft Dynamics CRM users, you can e-

mail a dynamic Excel file, or store it as a shared file. When recipients open the dynamic file, they 

will see data they have permission to view in Microsoft Dynamics CRM, so the data they see may be 

different from what you see.  

Notes 

 There is potential for data loss if you export from Microsoft Dynamics CRM to a Microsoft Office Excel 

2003 comma-separated value (CSV) file.  

To ensure that the file is exported correctly, you must have data in every row of the last column of 

the list you are exporting. You can add a space or other character in last column of the file or 

reorder the columns so that the last column always contains data. More information: Microsoft 

Knowledge Base Article 77295  

 Some system views, such as Accounts: No Campaign Activities in Last 3 Months, can be exported only 

to a static Excel worksheet.  

Run a Report 

Run a report  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Report Permissions  

 

 

1. Find and open a report:  

 From the Reports area  

a. In the Workplace, under My Work, click Reports.  

b. To narrow the list, enter the first few letters of the report name, or use the asterisk (*) wildcard in 

the Search for records box and then click the Find button . You can also select a view.  

c. In the reports list, double-click the report that you want to run.  

If the report has a default filter, the default filter will be displayed. Follow step 2 to change the filter.  
Tip: To run a report without seeing the default filter, select the report, and then on the Actions toolbar, 
click More Actions, and then click Run Report.  

 From a list of records, including the results of an Advanced Find search  

Only reports that relate to the current record type will be available.  

You can run some reports on all records in the list, up to ten selected records, or without limiting the 

records as if you were running the report from the Reports area.  

 To run a report on all records on the list:  

a. On the Actions toolbar, click Reports .  

http://go.microsoft.com/fwlink/?LinkId=105633
http://go.microsoft.com/fwlink/?LinkId=105633
http://go.microsoft.com/fwlink/?LinkId=105633
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b. Under Run on Selected Records, click the name of the report.  

c. In the Select Records dialog box, click All records on all pages in the current view, 

and then click Run Report.  

 To run a report on up to ten selected records from the list:  

a. Select the records to include. Select several records by pressing the CTRL key while you 

click each record.  

b. On the Actions toolbar, click Reports.  

c. Under Run on Selected Records, click the name of the report.  

d. In the Select Records dialog box, click The selected records, and then click Run 

Report.  

 To run a report without limiting records to items on the list:  

a. On the Actions toolbar, click Reports.  

b. If the report is listed under Run on All Records, select the report.  

– OR –  

Under Run on Selected Records, click the name of the report. In the Select Records 

dialog box, click All applicable records, and then click Run Report.  

– OR –  

If the report you want to run is not listed, you must go to the Reports area to run the 

report.  

 From a record 

Only reports that relate to the current record type will be available.  

To run a report including data from just one record:  

a. With a record open, on the Actions toolbar, click Reports .  

b. Under Run on Current Record, click the name of the report.  

 From Microsoft Dynamics CRM for Outlook  

All reports can be run when you are online.  

To run a report while you are offline, you must first create a local data group that includes the report, as 

well as a local data group that includes any data that should be included in the report.  

To create a local data group that contains reports, on the CRM menu, click Modify Local Data Groups, 

click New, select the Report record type, and then define the criteria for which reports to include. More 

information: Work with Data to Take Offline  

 To run reports from the Reports area, in the Outlook Navigation Pane, under Microsoft 

Dynamics CRM, click Workplace, click My Work, click Reports, and then select a report to 

run.  
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 To select a report from a record or list, follow the procedures above. These steps work the same 

way in Microsoft Dynamics CRM for Outlook.  

 From a report you saved locally 

If you have saved a report on your computer or shared file system that reads dynamic data from Microsoft 
Dynamics CRM, to open it, browse to the folder that contains your saved report, and double-click the file.  

 If the report offers filter criteria, if needed, modify the filter criteria and then click Run 

Report.  

The list of existing report filtering criteria is grouped by record types that you can use in the filter, 

such as Accounts or Contacts.  

To edit a parameter in simple mode, click the underlined value and enter a new value.  

– OR –  

To edit the filter criteria in detailed mode:  

 . Click Edit Filter.  

a. To add a criteria row:  

1. In the area for the record type that the field belongs to, click Select, and specify the field to filter on.  

2. Click the query relational operator, and select an operator.  

3. Click Enter Value, and enter a value to filter on. For some values, you can click the Select Values 

button  to open the Select Values dialog box and select the value you want.  

b. To group criteria, you must select two or more rows for the same record type. For example, 

Sales Stage and Est. Revenue are both field values in the Opportunity record type and 

two rows that specify filter criteria for these fields can be grouped. However, rows with field 

values from different record types, such as Account and Opportunity record types, cannot 

be grouped.  

0. For each row you want to group, in detailed mode, click the Options menu button  for that row, 

and then click Select Row.  

1. On the Filter toolbar, select Group AND or Group OR.  

2. To remove a row from a group, click the Options menu button  for that row, and then click 

Delete.  

3. To select a group, click the Options menu button  for that group, and then click Select Group.  

4. To add a criteria clause to a group, click the Options menu button  for that group, click Add 

Clause, and then select the field, query relational operator, and value.  

5. To unselect a group that has been previously selected, click the Options menu button  for that 

group, and then click Deselect Group.  

6. To ungroup a group, click the Options menu button  for that group, and then click Ungroup.  

7. To change a Group AND group to a Group OR group, or a Group OR group to a Group AND 

group, click the Options menu button  for that group, and then click Change to OR or Change to AND.  

 Tips 



 

88 Microsoft Dynamics CRM 4.0 User’s Guide 
 

 To clear all criteria and start over, on the Filter toolbar, click Clear, and then click Confirm.  

 To delete a row, click the Options menu button  for that row, and then click Delete.  

 To hide a row in simple mode, while you are in detailed mode, click the Options menu 

button  for that row, and then click Hide in Simple Mode.  

 If you have a hidden row when viewing filter criteria in simple mode and you want to show that 

row again, then in detailed mode, you must click the Options menu button  for that row, and 

then click Show in Simple Mode.  

 You can set your personal options so that report filters and Advanced Find criteria always open in 

simple or detailed mode. More information: Set Personal Options  

 If the report offers parameters, if needed, modify the parameters and then click View 

Report.  

 Locate data in the report.  

 To view or change a record, click the first field in the row for the record. A separate Microsoft 

Dynamics CRM window will open with the record.  

 To view all records associated with a summary or chart report, click Show All at the bottom 

of the report. To navigate back to the original report, click Original Report in the report title 

area.  

 To view detailed information about an area in a chart, click an area of the chart. To navigate 

back to the original report, click Original Report in the report title area.  

 To page through the report, on the Report toolbar, use the Page Navigation 

buttons . To locate a specific page, type a page number in the box 

and then press Enter.  

 To quickly locate specific information in your report, in Find | Next, type a few characters, 

and then click Find.  

 To sort a column, click the column title. The direction of sorting is indicated by the 

Ascending sort button  or the Descending sort button .  

 To view or hide the filter summary, expand or collapse Filter Summary.  

 To update your report, click the Refresh button .  

 To hide the report parameters, click the Hide Parameters button . To display the report 

parameters, click the Show Parameters button .  

 Print the report. On the Report toolbar, click the Print button .  

If you are working offline using Microsoft Dynamics CRM for Outlook, on the Report toolbar, select 

Web archive format, click Export, and then on the File menu, click Print.  

Tips  

 If a chart doesn't display the first time you export a report to Web archive format, export 

the report a second time.  

 To print reports, you need a Reporting Services Microsoft ActiveX control. The first time you 

print a Reporting Services report from either Microsoft Dynamics CRM or Microsoft Dynamics 

CRM for Microsoft Office Outlook, you will see a prompt Do you want to install this 

software?.  
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To install the required control, click Install.  

 Export the report.  

Important The exported report is temporary. If you need to save the exported report to a local 

file, use the viewing program to save the file to disk. The saved exported report is no longer 

connected to Microsoft Dynamics CRM. Therefore, it does not change if Microsoft Dynamics CRM 

data changes.  

 . In the Export box, select a format, and then click Export.  

A second browser window is used to display the report, using a viewer associated with the 

export format you selected.  

The formats that are available are determined by the rendering extensions that are installed 

on the Microsoft SQL Server Reporting Services report server, and also by whether you are 

online or offline.  

 If you are working offline, only the Excel and Acrobat (PDF) file formats are 

available.  

 If you are using Microsoft SQL 2005 Workgroup edition, the XML file with report 

data format is not available.  

If a viewer is not available for the format you select, you must select a different format or 

install the viewer.  

The following export formats are included in a default installation when you are online. The 

list of export formats available to you may vary from those listed here.  

 Excel  

View the report in Microsoft Office Excel. This format includes all the row, column, and 

field labels, in addition to report formatting.  

Large reports and reports with charts might not display with the expected formatting 

when exported in this file format. To export only the data, instead of using this format, 

from any list in Microsoft Dynamics CRM, including results of Advanced Find searches, 

export the data into Microsoft Office Excel, and then save as a comma-delimited (CSV) 

file. More information: Export Data to Excel  

 Web archive  

View the report in Microsoft Internet Explorer, as a MIME-encoded HTML format that 

keeps images and linked content together with a report. For chart reports, if the chart 

is not displayed correctly the first time that you export the report, export the report 

again.  

Choose this format to view a report offline or for e-mailing the report.  

 Acrobat (PDF) file  

View the report using a client-side PDF viewer. You must have Adobe Acrobat Reader 

to use this format.  

Choose this format for long reports, paginated reports, or reports that are delivered as 

a file.  

 TIFF file  

View the report in the default TIFF viewer. For some Windows clients, this is the 

Windows Pictures and Fax Viewer.  

Choose this format to a view a report in a page-oriented layout. The TIFF format is the 

recommended format for printing reports.  
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 CSV (comma delimited)  

View the report as a text file, with fields separated by commas. This format includes all 

the row, column, and field labels.  

To export only the data, instead of using this format, export data from any list in 

Microsoft Dynamics CRM, including results of Advanced Find searches, into Microsoft 

Office Excel, and then save as a comma-delimited (CSV) file.  

 XML file with report data  

View the report as an XML file.  

Tips 

 If there is no report that gives you the information you need, you can either export data to Microsoft 

Office Excel, or create your own report. More information: Export Data to Excel, Create and Work 

with Reports  

 If a snapshot of a Reporting Services report exists, you can view it from the Reports area. To see if 

any snapshots exist for a report, click the View Snapshots button  next to the report. If a 

snapshot exists, click the snapshot link to view the snapshot.  

Note 

If multiple Language Packs are installed, only reports that are marked for display in the language you specified in 

Personal Options will be visible. More information: Set Personal Options  

Default Reports 

Microsoft Dynamics CRM has four categories of default reports: sales, marketing, service, and administrative.  

This topic shows you how to use the different reports. You also can find more information when you generate a report, 

click Help, and then click Help on This Page.  

Sales 

The following default sales reports are available:  

 Account Distribution Report  

Use this report to identify patterns in your top revenue-generating accounts. The report displays two 

charts. The earned revenue chart displays a chart of the earned revenue grouped by a market facet, 

such as product, territory, or industry. The accounts count chart, displays the amount of earned 

revenue using the same grouping as the earned revenue chart.  

 Account Overview Report  

Use this report to obtain a one-page overview of everything occurring with an account. The report 

displays a profile of the account, contact information, and summaries of opportunities and case 

activities.  

 Account Summary Report  

Use this report to determine historically what has occurred with an account. This report also displays 

what is scheduled to occur in the future. The report displays a chronological summary for an 

account, including sales and service activities, notes, and records.  

 Activities Report  

Use this report to identify patterns in activities. Activities can be grouped by owner or activity type, 

or by the record the activity is regarding.  
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 Competitor Win Loss Report  

Use this report to compare how your sales team performs against your competitors. The report 

displays a list of competitors, with data on open, closed, won, and lost opportunities for each.  

 Invoices Report  

Use this report to print invoices.  

 Invoice Status Report  

Use this report to view your accounts receivable. The chart displays invoices grouped by status.  

 Lead Source Effectiveness Report  

Use this report to compare how effective your lead sources are at generating quality opportunities. 

The report lists the percentage of qualified leads, and leads that generate revenue for each lead 

category.  

 Neglected Leads Report  

Use this report to identify any leads that have not been contacted. The report displays a chart of 

leads that have had no associated activities or notes during a specified time period.  

 Orders Report  

Use this report to print orders.  

 Quotes Report  

Use this report to print quotes.  

 Sales Pipeline Report  

Use this report to see anticipated potential sales. The report displays a chart of potential sales 

grouped by user, sales territory, customer territory, date, products, rating, or sales stage.  

 Sales History Report  

Use this report to view a history of sales performance by sales representative. The report displays a 

chart of both lost and earned revenue.  

 Neglected Accounts Report  

Use this report to identify accounts that have not been contacted recently. The report displays a 

chart with accounts that have had no activities completed in a specified number of days.  

 Products by Account Report  

Use this report to see which products are used by an account. For each account, the report lists the 

associated products.  

 Products by Contact Report  

Use this report to see which products are used by a contact. For each contact, the report lists the 

associated products.  

Marketing 

The following default marketing reports are available:  

 Campaign Activity Status Report  

Use this report to track a campaign. The report displays a summary for one campaign, including 

planned and actual time parameters, parent campaign details, and definition status.  

 Campaign Comparison Report  

Use this report to identify your most and least successful campaigns. The report compares two 

campaigns based on parameters such as cost effectiveness and number of responses.  

 Campaign Performance Report  

Use this report to track the progress and status of your campaigns. The report provides a detailed 
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view, including all the dates, targets, definitions, responses, and financial returns from each 

campaign.  

Service 

The following default service reports are available:  

 Case Summary Table Report  

Use this report to find out what kind of cases are being opened and resolved. You can select how 

data is grouped in both the rows and columns in this report. This report provides a chart of cases, 

organized by status reason, owner, priority, subject, customer, or product.  

 Neglected Cases Report  

Use this report to identify cases that have not been contacted recently. The report displays a chart 

of cases that have had no changes to activities, notes, or the case itself in the specified number of 

days, and no scheduled activities.  

 Service Activity Volume Report  

Use this report to review the patterns in service activity volume. The report displays either the 

duration of or number of service activities, grouped by services, resources, time periods, and 

additional criteria.  

 Top Knowledge Base Articles Report  

Use this report to identify the most frequently used knowledge base articles. The report displays a 

chart grouped by the subject of the article or case, or by the product associated with the case.  

Administrative 

The following default administrative report is available:  

 User Summary Report  

Use this report to identify contact information and Microsoft Dynamics CRM security roles for all 

Microsoft Dynamics CRM users.  

Customizing and Organizing Reports 

Microsoft Dynamics CRM includes default reports for many common business needs. However, most organizations 

customize the default reports and add custom reports for specific needs. To customize reports, you need to understand:  

 Report ownership  

 Report types  

 Data security  

 Options for creating new reports  

 Options for modifying existing reports  

Report Ownership 

Reports can be owned by the system or by individual users. System reports are available to all users. Reports owned by 

individual users can be shared with specific colleagues or teams, or can be made available to the organization so that 

all users can use them.  

Report Types 

All default Microsoft Dynamics CRM reports and all reports created using the Report Wizard are Microsoft SQL Server 

Reporting Services reports. In addition, reports can also be:  
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 Web links  

 Static files  

 Dynamic files that read data from the Microsoft Dynamics CRM database such as Microsoft Office files, 

Reporting Services reports, or reports created with other ODBC-compliant reporting tools.  

For each report, you can edit the report properties, including: 

 The type of report  

 The file name or URL  

 The display name  

 The description  

 Information about where the report is displayed in the user interface.  

Data Security 

All reports read Microsoft Dynamics CRM data from filtered views, which filter the data based on the user's security role. 

Reports only display data that the person running the report has permission to view.  

Options for Creating New Reports 

To create a new report, users with appropriate permissions can:  

 Add a file or a link to a Web page as a report.  

 Run the Report Wizard to create a new Reporting Services report. The Report Wizard can create table 

and chart reports, including drill-through reports and top N reports.  

 Write a new report using Reporting Services, Microsoft Office, or another ODBC-compliant reporting 

tool. Creating a new Reporting Services report requires a report development environment. More 

information: Create and Work with Reports, Write a Report Using Report-Writing Tools  

When you connect to the Microsoft Dynamics CRM database to write your own report, you must use 

the filtered views to ensure data security. Filtered views exist for all record types. When a new 

record type is created, a new filtered view is automatically created.  

Options for Modifying Existing Reports 

For existing reports, users with appropriate permissions can:  

 Organize reports into categories to control which views in the Reports area display each report.  

 Determine where a report is visible in the user interface, and edit other properties of the report.  

 Edit a report created with the Report Wizard.  

 Edit a default report. For example, if you customize Microsoft Dynamics CRM, you might need to 

modify labels or add or remove fields in default reports. Editing a default report requires a report 

development environment. More information: Create and Work with Reports, Writing Reporting 

Services Reports (Microsoft Dynamics CRM SDK)  

 Edit the default filter for a default report, a report created with the Report Wizard, or other Reporting 

Services reports.  

 Create a one-time snapshot for a Reporting Services report or schedule a Reporting Services report to 

run at set intervals.  
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 Share a personal report with other users, or make it available to everyone in your organization.  

 Publish a report so that it is available for use with external applications such as Microsoft SharePoint or 

custom programs.  

Create, Edit, or Copy a Report Using the Report Wizard 

Create, edit, or copy a report using the Report Wizard  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Report Permissions  

 How to determine which record types have the data you need 

There is one record type for each type of data, such as accounts, contacts, or services.  

In addition, there are separate record types for:  

 Notes. Every note and attachment is stored as a separate record in the Notes record type.  

 Close activities. Whenever you close an opportunity, quote or order, an activity is created 

that tracks the reason for closing the record. These are stored respectively in the 

Opportunity Close Activity, Quote Close Activity, and Order Close Activity record types. 

When you close a case, the data is stored in the Case Resolution Activity.  

If your report includes data from communication activities, you have two options:  

 If you want data about multiple types of communication activities in one report such as the 

activity subjects and due dates for all types of activities, use the Activity record type.  

 If you need specific information about a specific type of activity, such as the recipients, use 

the Task, E-mail Message, Fax, Appointment, Letter, or Phone Call record type.  

Tip:  

 While you are creating your report, keep a window open showing a record from the data 

type you are including in your report. It will help you determine which columns to include.  

 

 

1. In the Navigation Pane, click Workplace, and then under My Work, click Reports.  

2. To add a new report, click New, and then click Report Wizard.  

– OR –  

To edit an existing Report Wizard report, select the report, on the Actions toolbar, click Edit 

Report , and then click Report Wizard.  

You can only use the Report Wizard to edit reports that were created with the wizard.  

3. Select a starting point for your report.  

a. To create a new report, select Start a new report.  
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– OR –  

To start from a copy of an existing report, select Start from an existing report, select the 

report, and also clear the Overwrite existing report check box.  

– OR –  

To edit an existing report, select Start from an existing report, select the report, and 

check the Overwrite existing report check box.  

b. If multiple languages are installed, select the language to use for column names, record 

types, and wizard-generated text in the report.  

c. Click Next.  

4. Enter the name of the report, and specify which record types the report will use.  

The purpose of this step is to identify where the data in the report comes from. You can include 

data from one or two record types, plus data from related records.  

a. Enter data in each field:  

 Report name. This value will be displayed on the Reports  menu and in the 

Reports area.  

 Primary record type. Data from all fields in this record type and related record 

types will be available when you are defining criteria for which records to include. 

Data from this record type will be available when you are selecting fields to display.  

 Related record type. If you need to display data from a related record type, select 

an additional record type here.  

Tip: If you don't need data from a related record type, don't select one, as it makes 

the report take longer to load.  

b. Click Next.  

5. Specify which records to include.  

The purpose of this step is to determine which records are included in your report. This information 

is saved as the default filter for the report.  

You can select criteria based on the selected record types or on columns from related records.  

a. To include only records defined by an existing system view or saved view, select a view.  

– OR –  

To define which records to include by selecting criteria:  

 To add a criteria row:  

1. In the area for the record type that the field belongs to, click Select, and 

specify the field to filter on.  

2. Click the query relational operator, and select an operator.  

3. Click Enter Value, and enter a value to filter on. For some values, you can 

click the Select Values button  to open the Select Values dialog box 

and select the value you want.  
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 To group criteria, you must select two or more rows for the same record type. For 

example, Sales Stage and Est. Revenue are both field values in the Opportunity 

record type and two rows that specify filter criteria for these fields can be grouped. 

However, rows with field values from different record types, such as Account and 

Opportunity record types, cannot be grouped.  

a. For each row you want to group, click the Select Row button  for that row, and then click Select 

Row.  

b. On the Filter toolbar, select Group AND or Group OR.  

c. To remove a row from a group, click the Options menu button  for that row, and then click 

Delete.  

d. To select a group, click the Options menu button  for that group, and then click Select Group.  

e. To add a criteria clause to a group, click the Options menu button  for that group, click Add 

Clause, and then select the field, query relational operator, and value.  

f. To unselect a group that has been previously selected, click the Options menu button  for that 

group, and then click Deselect Group.  

g. To ungroup a group, click the Options menu button  for that group, and then click Ungroup.  

h. To change a Group AND group to a Group OR group, or a Group OR group to a Group AND 

group, click the Options menu button  for that group, and then click Change to OR or Change to AND.  

 Click Next.  

 Organize and lay out your data.  

The purpose of this step is to determine which columns to include, the order in which they are 

displayed, and whether to group data into subcategories. At a minimum, a report just includes 

columns. By grouping and summarizing the data, you make it easier to see the patterns.  

For example, your report could use one level of grouping to group opportunities by salesperson, or 

add a second level of grouping to show each quarter's opportunities, or add a third level to show 

the percentage won and lost in each quarter.  

To use a chart in your report, if your report has no grouping, you must select at least one numeric 

column. If your report uses grouping, you must select at least one numeric column with a summary 

type defined.  

 Define how to organize the report:  

 To group items so that they are organized together in the report by date or other 

common properties:  

0. For each grouping level you need, click Click here to add a grouping.  

1. Define the grouping:  

 Record type. You can select records from the primary record type you 

selected, and from any related record types. If you selected a 

secondary record type, you can also select records from the secondary 

record type and its related records types.  

 Column. The name of the Microsoft Dynamics CRM field that contains 

the data to define the grouping.  

 Time interval. For datetime fields, group the data by Month, Day, 

Week, or Year.  

 Sort order. Sort order for displaying the groups.  
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 Column width. Width of the column heading in pixels.  

 Summary type. You can group records by a count of matching 

records.  

2. To reorder the grouping levels, use the up and down arrows in the Common Tasks section.  

3. Click OK.  

 To define the sort order within each group, click Configure Sorting, select a 

column and sort order, and then click OK.  

 To limit reports to groups with the highest or lowest values, click Set Top or 

Bottom Number:  

0. Select Top or Bottom.  

1. Select the number of groups to display.  

2. Click OK.  

 Define which columns to display in the report. You can display columns that show data from 

a record, or columns that show summary information:  

0. For each column you want to include, click Click here to add a column:  

 Record type. You can select records from the primary record type you 

selected, and from any related record types. If you selected a secondary 

record type, you can also select records from the secondary record type and 

its related records types.  

 Column. The name of the Microsoft Dynamics CRM field that contains the 

data to display or summarize.  

 Data type. The data type of the column, one of: primarykey, nvarchar, 

picklist, bit, decimal, int, float, money, ntext, datetime, owner, lookup.  

 Name. The name used in the database.  

 Column width. The width in pixels of the column.  

 Summary type. The specific type of summaries available depends on the 

data type of the column.  

o None: lookup, datetime, owner, picklist, bit, ntext 

o Average, Maximum, Minimum, Percent of Total, Sum: all 

numeric record types (decimal, int, float, money)  

 Use the left and right arrows to reorganize the columns.  

1. Click OK.  

 Click Next.  

 Select whether to use a chart in the report.  

The purpose of this step is to determine whether to use a chart, and which type of chart to use.  

 Select whether to include a chart:  

 Table only. This provides a table grouped and sorted as you specified.  

 Chart and table. Displays both a chart and table.  

o Show table below the chart on same page. Clicking on the chart does 

nothing.  
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o Show chart. To view data for a chart region, click the chart region. 

Clicking on an area in the chart will display a table with details for that section 

of the chart.  

 Click Next.  

 If the report includes a chart, format the chart.  

The purpose of this step is to specify the type of chart, and how the data is displayed in the chart.  

 Select the chart type, and then click Next.  

The Chart preview area shows how the data will be displayed.  

 For vertical and horizontal bar charts and line charts, specify which data to display on 

each axis:  

o In the Format Column (X) Axis section, select the field to use for the X axis, 

and the label that is displayed on the chart for the field.  

o In the Format Value (Y) Axis section, you can select two fields. For each 

field, you can specify the label that is displayed on the chart.  

o In the Format Labels and Legends section, specify whether or not to show 

the data labels and a legend.  

 For pie charts, specify the slices and values for the chart.  

o For slices, you must select one of the groupings in your report.  

o For values, you must select a numeric column with a summary type.  

 Click Next.  

 Review the summary of the report, click Next, and then click Finish.  

 Determine where the report can be run from.  

When you finish defining the report, you return to the Report form, where you can update the name 

and description of the report, and determine where the report is displayed:  

 Categories 

To specify the categories in which to include this report, click the Select Values button , 

and then select the categories. More information: System Settings Dialog Box - Reporting 

Tab  

By default, a new report is not put into any category. If you want the report to be included in 

the category views in the Reports area, such as the Marketing Reports view, add a 

category in the Categories box.  

 Related Record Types 

To have the report appear in the Reports list on a page for specific record types, click the 

Select Values button , and then select record types.  

For example, if your new report includes data from accounts and activities, select Accounts 

and Activities.  

 Display In 

To specify where reports should be visible, click the Select Values button , and then 

select one or more options:  

o Reports area  

Report will be displayed in the Reports area.  
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o Forms for related record types  

Report will be displayed on the form for the record type you select in Related 

Record Types 

o Lists for related record types  

Report will be displayed from specified list view pages.  

If no values are selected, the report will not be visible to end-users. To view or manage 

reports not visible to end-users, in the Reports area, select the All Reports, Including 

Sub-Reports view.  

 Languages 

If your Microsoft Dynamics CRM implementation has multiple languages enabled, specify a 

language. The report will be displayed for all users who have selected that language in their 

personal options. To make this report available to all users, select All Languages.  

Note that this does not change the language used inside the report.  

Tip: If you use the Microsoft Dynamics CRM for Outlook with Offline Access, by default all reports 

that you own will be available when you are offline. More information: Work with Data to Take 

Offline  

 Test the report, and modify it if needed.  

On the Report toolbar, click Run Report .  

If the report needs modifications, start with step 2 and edit the existing report.  

 Determine who can use the report. By default, the report is a personal report. This means 

that you are the only one who can use it.  

 To share this report with other users, in the Reports area, select the report, and then on the 

More Actions menu, click Sharing.  

 To make this report available to everyone in the organization, in the Reports area, select the 

report, on the Actions toolbar menu, click Edit Report, and then on the Actions  menu, 

click Make Report Available to Organization.  

If you use the Microsoft Dynamics CRM for Outlook with Offline Access, by default all reports that 

you own will be available when you are offline. More information: Work with Data to Take Offline  

Note 

All reports generated with the Report Wizard print in landscape mode.  

Create and Work with Reports 

Run a report  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Report Permissions  

 

 

1. Find and open a report:  
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 From the Reports area  

a. In the Workplace, under My Work, click Reports.  

b. To narrow the list, enter the first few letters of the report name, or use the asterisk (*) wildcard in 

the Search for records box and then click the Find button . You can also select a view.  

c. In the reports list, double-click the report that you want to run.  

If the report has a default filter, the default filter will be displayed. Follow step 2 to change the filter.  
Tip: To run a report without seeing the default filter, select the report, and then on the Actions toolbar, 
click More Actions, and then click Run Report.  

 From a list of records, including the results of an Advanced Find search  

Only reports that relate to the current record type will be available.  

You can run some reports on all records in the list, up to ten selected records, or without limiting the 

records as if you were running the report from the Reports area.  

 To run a report on all records on the list:  

a. On the Actions toolbar, click Reports .  

b. Under Run on Selected Records, click the name of the report.  

c. In the Select Records dialog box, click All records on all pages in the current view, 

and then click Run Report.  

 To run a report on up to ten selected records from the list:  

a. Select the records to include. Select several records by pressing the CTRL key while you 

click each record.  

b. On the Actions toolbar, click Reports.  

c. Under Run on Selected Records, click the name of the report.  

d. In the Select Records dialog box, click The selected records, and then click Run 

Report.  

 To run a report without limiting records to items on the list:  

a. On the Actions toolbar, click Reports.  

b. If the report is listed under Run on All Records, select the report.  

– OR –  

Under Run on Selected Records, click the name of the report. In the Select Records 

dialog box, click All applicable records, and then click Run Report.  

– OR –  

If the report you want to run is not listed, you must go to the Reports area to run the 

report.  

 From a record 
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Only reports that relate to the current record type will be available.  

To run a report including data from just one record:  

a. With a record open, on the Actions toolbar, click Reports .  

b. Under Run on Current Record, click the name of the report.  

 From Microsoft Dynamics CRM for Outlook  

All reports can be run when you are online.  

To run a report while you are offline, you must first create a local data group that includes the report, as 

well as a local data group that includes any data that should be included in the report.  

To create a local data group that contains reports, on the CRM menu, click Modify Local Data Groups, 

click New, select the the Report record type, and then define the criteria for which reports to include. 

More information: Work with Data to Take Offline  

 To run reports from the Reports area, in the Outlook Navigation Pane, under Microsoft 

Dynamics CRM, click Workplace, click My Work, click Reports, and then select a report to 

run.  

 To select a report from a record or list, follow the procedures above. These steps work the same 

way in Microsoft Dynamics CRM for Outlook.  

 From a report you saved locally 

If you have saved a report on your computer or shared file system that reads dynamic data from Microsoft 
Dynamics CRM, to open it, browse to the folder that contains your saved report, and double-click the file.  

 If the report offers filter criteria, if needed, modify the filter criteria and then click Run 

Report.  

The list of existing report filtering criteria is grouped by record types that you can use in the filter, 

such as Accounts or Contacts.  

To edit a parameter in simple mode, click the underlined value and enter a new value.  

– OR –  

To edit the filter criteria in detailed mode:  

 . Click Edit Filter.  

a. To add a criteria row:  

1. In the area for the record type that the field belongs to, click Select, and specify the 

field to filter on.  

2. Click the query relational operator, and select an operator.  

3. Click Enter Value, and enter a value to filter on. For some values, you can click the 

Select Values button  to open the Select Values dialog box and select the 

value you want.  

file:\\crmshare\Users\abecraft\Modified_Help_for_Print\content\ui_ol_offlineconfiguration_form.htm
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b. To group criteria, you must select two or more rows for the same record type. For example, 

Sales Stage and Est. Revenue are both field values in the Opportunity record type and 

two rows that specify filter criteria for these fields can be grouped. However, rows with field 

values from different record types, such as Account and Opportunity record types, cannot 

be grouped.  

0. For each row you want to group, in detailed mode, click the Options menu 

button  for that row, and then click Select Row.  

1. On the Filter toolbar, select Group AND or Group OR.  

2. To remove a row from a group, click the Options menu button  for that row, and 

then click Delete.  

3. To select a group, click the Options menu button  for that group, and then click 

Select Group.  

4. To add a criteria clause to a group, click the Options menu button  for that group, 

click Add Clause, and then select the field, query relational operator, and value.  

5. To unselect a group that has been previously selected, click the Options menu 

button  for that group, and then click Deselect Group.  

6. To ungroup a group, click the Options menu button  for that group, and then 

click Ungroup.  

7. To change a Group AND group to a Group OR group, or a Group OR group to a 

Group AND group, click the Options menu button  for that group, and then click 

Change to OR or Change to AND.  

 Tips 

 To clear all criteria and start over, on the Filter toolbar, click Clear, and then click Confirm.  

 To delete a row, click the Options menu button  for that row, and then click Delete.  

 To hide a row in simple mode, while you are in detailed mode, click the Options menu 

button  for that row, and then click Hide in Simple Mode.  

 If you have a hidden row when viewing filter criteria in simple mode and you want to show that 

row again, then in detailed mode, you must click the Options menu button  for that row, and 

then click Show in Simple Mode.  

 You can set your personal options so that report filters and Advanced Find criteria always open in 

simple or detailed mode. More information: Set Personal Options  

 If the report offers parameters, if needed, modify the parameters and then click View 

Report.  

 Locate data in the report.  

 To view or change a record, click the first field in the row for the record. A separate Microsoft 

Dynamics CRM window will open with the record.  

 To view all records associated with a summary or chart report, click Show All at the bottom 

of the report. To navigate back to the original report, click Original Report in the report title 

area.  

 To view detailed information about an area in a chart, click an area of the chart. To navigate 

back to the original report, click Original Report in the report title area.  
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 To page through the report, on the Report toolbar, use the Page Navigation 

buttons . To locate a specific page, type a page number in the box 

and then press Enter.  

 To quickly locate specific information in your report, in Find | Next, type a few characters, 

and then click Find.  

 To sort a column, click the column title. The direction of sorting is indicated by the 

Ascending sort button  or the Descending sort button .  

 To view or hide the filter summary, expand or collapse Filter Summary.  

 To update your report, click the Refresh button .  

 To hide the report parameters, click the Hide Parameters button . To display the report 

parameters, click the Show Parameters button .  

 Print the report. On the Report toolbar, click the Print button .  

If you are working offline using Microsoft Dynamics CRM for Outlook, on the Report toolbar, select 

Web archive format, click Export, and then on the File menu, click Print.  

Tips  

 If a chart doesn't display the first time you export a report to Web archive format, export 

the report a second time.  

 To print reports, you need a Reporting Services Microsoft ActiveX control. The first time you 

print a Reporting Services report from either Microsoft Dynamics CRM or Microsoft Dynamics 

CRM for Microsoft Office Outlook, you will see a prompt Do you want to install this 

software?.  

To install the required control, click Install.  

 Export the report.  

Important The exported report is temporary. If you need to save the exported report to a local 

file, use the viewing program to save the file to disk. The saved exported report is no longer 

connected to Microsoft Dynamics CRM. Therefore, it does not change if Microsoft Dynamics CRM 

data changes.  

 . In the Export box, select a format, and then click Export.  

A second browser window is used to display the report, using a viewer associated with the 

export format you selected.  

The formats that are available are determined by the rendering extensions that are installed 

on the Microsoft SQL Server Reporting Services report server, and also by whether you are 

online or offline.  

 If you are working offline, only the Excel and Acrobat (PDF) file formats are 

available.  

 If you are using Microsoft SQL 2005 Workgroup edition, the XML file with report 

data format is not available.  

If a viewer is not available for the format you select, you must select a different format or 

install the viewer.  

The following export formats are included in a default installation when you are online. The 

list of export formats available to you may vary from those listed here.  
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 Excel  

View the report in Microsoft Office Excel. This format includes all the row, column, and 

field labels, in addition to report formatting.  

Large reports and reports with charts might not display with the expected formatting 

when exported in this file format. To export only the data, instead of using this format, 

from any list in Microsoft Dynamics CRM, including results of Advanced Find searches, 

export the data into Microsoft Office Excel, and then save as a comma-delimited (CSV) 

file. More information: Export Data to Excel  

 Web archive  

View the report in Microsoft Internet Explorer, as a MIME-encoded HTML format that 

keeps images and linked content together with a report. For chart reports, if the chart 

is not displayed correctly the first time that you export the report, export the report 

again.  

Choose this format to view a report offline or for e-mailing the report.  

 Acrobat (PDF) file  

View the report using a client-side PDF viewer. You must have Adobe Acrobat Reader 

to use this format.  

Choose this format for long reports, paginated reports, or reports that are delivered as 

a file.  

 TIFF file  

View the report in the default TIFF viewer. For some Windows clients, this is the 

Windows Pictures and Fax Viewer.  

Choose this format to a view a report in a page-oriented layout. The TIFF format is the 

recommended format for printing reports.  

 CSV (comma delimited)  

View the report as a text file, with fields separated by commas. This format includes all 

the row, column, and field labels.  

To export only the data, instead of using this format, export data from any list in 

Microsoft Dynamics CRM, including results of Advanced Find searches, into Microsoft 

Office Excel, and then save as a comma-delimited (CSV) file.  

 XML file with report data  

View the report as an XML file.  

Tips 

 If there is no report that gives you the information you need, you can either export data to Microsoft 

Office Excel, or create your own report. More information: Export Data to Excel, Create and Work 

with Reports  

 If a snapshot of a Reporting Services report exists, you can view it from the Reports area. To see if 

any snapshots exist for a report, click the View Snapshots button  next to the report. If a 

snapshot exists, click the snapshot link to view the snapshot.  

Note 

If multiple Language Packs are installed, only reports that are marked for display in the language you specified in 

Personal Options will be visible. More information: Set Personal Options  
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Add a report without using the Report Wizard  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Report Permissions  

 

 

1. In the Navigation Pane, click Workplace, and then under My Work, click Reports.  

2. To add a new report, click New.  

 Add a new file that reads data from the Microsoft Dynamics CRM database.  

You can add a static file, or a dynamic Microsoft Office, Microsoft SQL Server Reporting Services or other 

ODBC-compliant file that reads data from the Microsoft Dynamics CRM database.  

1. In the Source section, in the Report Type box, select Existing File.  

2. In the File Location box, enter the path and file name of the dynamic or static file to add, or 

click Browse to locate the file.  

When you add a new Reporting Services report, if the report is enabled for pre-filtering and the 

report doesn't already have a default filter, a default filter that limits the data in the report to 

records modified within the past 30 days that have status set to active is added.  

For information about creating Microsoft Office files or other ODBC-compliant files that read 

directly from the Microsoft Dynamics CRM database, see: Write a Report Using Report-Writing 

Tools.  

Tips  

 To change a file that has been added as a report, you must download it, make any changes, and 

then add it again.  

 By default, the maximum size of the file that you can upload is 4 megabytes (MB). This can be 

changed by your system administrator. More information: Microsoft Knowledge Base Article 

295626  

 Add a new link to a Web page 

1. In the Source section, in Report Type, select Link to Web page.  

2. In the Web Page URL box, enter the URL of the Web page to add.  

 Specify the properties for the report.  

 Name 

The name for the report that is shown in the Reports area and on the Reports  menu in 

forms and lists.  

 Description 

The description that is displayed in the Reports area.  

http://go.microsoft.com/fwlink/?LinkId=99118
http://go.microsoft.com/fwlink/?LinkId=99118
http://go.microsoft.com/fwlink/?LinkId=99118
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 Parent Report 

If this report is a sub-report or a drill-through report, specify an existing parent report. If this 

is not specified, the parent report will display a "Report not found" error.  

 Categories 

To specify the categories in which to include this report, click the Select Values button , 

and then select the categories. More information: System Settings Dialog Box - Reporting 

Tab  

 Related Record Types 

To have the report appear in the Reports list on a page for specific record types, click the 

Select Values button , and then select record types.  

For example, if your new report includes data from accounts and activities, select Accounts 

and Activities.  

 Display In 

To specify where reports should be visible, click the Select Values button , and then 

select one or more options:  

 Reports area  

Report will be displayed in the Reports area.  

 Forms for related record types  

Report will be displayed on the form for the record type you select in Related 

Record Types 

If the report is enabled for pre-filtering, from the record, users can specify running 

the report on the current record.  

 Lists for related record types  

Report will be displayed from specifie                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                     

d list view pages.  

If the report has pre-filtering enabled, from the list view, users can specify running 

the report on selected records.  

 If no values are selected, the report will not be visible to end-users. To view or manage 

reports not visible to end-users, in the Reports area, select the All Reports, Including 

Sub-Reports view.  

 Languages 

If your Microsoft Dynamics CRM implementation has multiple languages enabled, specify a 

language. The report will be displayed for all users who have selected that language in their 

personal options. To make this report available to all users, select All Languages.  

Note that this does not change the language used inside the report.  

 Click Save or Save and Close.  

The report is added as a personal report.  

Tips 

 To share this report with other users, in the Reports area, select the report, and then on the More 

Actions menu, click Sharing.  

 To make this report available to everyone in the organization, in the Reports area, select the report, 

on the Actions toolbar menu, click Edit Report, and then on the Actions  menu, click Make 

Report Available to Organization.  
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 If you use the Microsoft Dynamics CRM for Outlook with Offline Access, by default all reports that you 

own will be available when you are offline. More information: Work with Data to Take Offline  

Edit report properties  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Report Permissions  

 

 

1. In the Navigation Pane, click Workplace, and then under My Work, click Reports.  

2. Select the report, and on the Actions toolbar, click Edit Report .  

3. Specify the properties for the report:  

 Source 

This section specifies the source file for the report. If you are just changing properties for the 

report, do not change the information in this section.  

 Name 

The name for the report that is shown in the Reports area and on the Reports  menu in 

forms and lists.  

 Description 

The description that is displayed in the Reports area.  

 Parent Report 

If this report is a sub-report or a drill-through report, specify an existing parent report. If this 

is not specified, the parent report will display a "Report not found" error.  

 Categories 

To specify the categories in which to include this report, click the Select Values button , 

and then select the categories. More information: System Settings Dialog Box - Reporting Tab  

 Related Record Types 

To have the report appear in the Reports list on a page for specific record types, click the 

Select Values button , and then select record types.  

For example, if your new report includes data from accounts and activities, select Accounts 

and Activities.  

 Display In 

To specify where reports should be visible, click the Select Values button , and then 

select one or more options:  

 Reports area  

Report will be displayed in the Reports area.  

 Forms for related record types  

Report will be displayed on the form for the record type you select in Related Record 

Types 

If the report is enabled for pre-filtering, from the record, users can specify running the 

report on the current record.  
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 Lists for related record types  

Report will be displayed from specified list view pages.  

If the report has pre-filtering enabled, from the list view, users can specify running the 

report on selected records.  

 If no values are selected, the report will not be visible to end-users. To view or manage 

reports not visible to end-users, in the Reports area, select the All Reports, Including Sub-

Reports view.  

 Languages 

If your Microsoft Dynamics CRM implementation has multiple languages enabled, specify a 

language. The report will be displayed for all users who have selected that language in their 

personal options. To make this report available to all users, select All Languages.  

Note that this does not change the language used inside the report.  

4. Click Save or Save and Close.  

Tips 

 To see all reports, including sub-reports that are not visible in the default view, select the All 

Reports, Including Sub-Reports view.  

 If you use the Microsoft Dynamics CRM for Outlook with Offline Access, by default all reports that you 

own will be available when you are offline. More information: Work with Data to Take Offline  

Note 

If multiple Language Packs are installed, only reports that are marked for display in the language you specified in 

Personal Options will be visible. More information: Set Personal Options  

Create a new report from an existing report  

 Can I do this task?  

This task requires the System Administrator or System Customizer security role or equivalent 
permissions. More information about specific permissions and performing this task while offline: Report 
Permissions  

To copy a Report Wizard report and modify it using Report Wizard, see Create, Edit, or Copy a Report Using the 

Report Wizard.  

 

1. In the Navigation Pane, click Workplace, and then under My Work, click Reports.  

2. Select a report.  

To see all reports, including sub-reports that are not visible in the default view, select the All 

Reports, Including Sub-Reports view.  

3. On the Actions toolbar, click Edit Report , and then on the Actions  menu, click Download 

Report.  

4. Click Save, and specify the location in which to save the file. If you are creating a new report rather 

than modifying a report, rename the file.  

Whenever a Microsoft SQL Server Reporting Services report is downloaded, the datasource for the 

report is changed to Adventure_Works_Cycle_MSCRM. This is done for security reasons: you can 
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share the.RDL file with the report without worrying about revealing your database name. You will 

need to change the datasource name back to the name of your Microsoft Dynamics CRM database 

prior to uploading changes to the file.  

5. In the Download Complete dialog box, click Close.  

6. To copy a report and add it to Microsoft Dynamics CRM:  

a. Follow the previous steps to download the file.  

b. Copy the downloaded file and rename the copy.  

c. For Reporting Services reports, change the datasource name in the report to the name of 

your Microsoft Dynamics CRM database.  

d. Make any changes required to the new report. For Reporting Services reports, use Reporting 

Services Report Designer. You will need a report development environment:  

 How to set up a report development environment 

Install the required components on your computer:  

 Microsoft Visual Studio, or any product that uses the Visual Studio.NET integrated development 

environment (such as Microsoft Visual Basic.NET).  

 Reporting Services Report Designer 

Reporting Services Report Designer 2005 can be installed from the Microsoft SQL Server 2005 

CD, and requires Visual Studio.NET 2005.  

 Make sure a security role assigned to your account includes the Publish Reports and Add 

Reporting Services Reports privileges.  

In addition to the required components, the following documentation is helpful:  

 Report Writers Guide section of the Microsoft CRM 4.0 Software Development Kit. More 

information: Writing Reporting Services Reports (Microsoft Dynamics CRM SDK)  

 Reporting Services Books Online provides help for Reporting Services. More information: SQL 

Server 2005 Reporting Services Books Online  

e. Add the new report back to Microsoft Dynamics CRM.  

Tip 

If you don't want users to run the base report you started from:  

1. In the Reports area, select the report.  

2. On the Actions toolbar, click Edit Report .  

3. On the Actions  menu, click Revert to Personal Report.  

Note 

When you download a drill-through report created with the Report Wizard, and edit the downloaded report in Reporting 

Services Report Designer, there are manual changes required. More information: Writing Reporting Services Reports 

(Microsoft Dynamics CRM SDK)  

http://go.microsoft.com/fwlink/?LinkId=97586
http://go.microsoft.com/fwlink/?LinkId=98256
http://go.microsoft.com/fwlink/?LinkId=98256
http://go.microsoft.com/fwlink/?LinkId=98256
http://go.microsoft.com/fwlink/?LinkId=99536
http://go.microsoft.com/fwlink/?LinkId=99536
http://go.microsoft.com/fwlink/?LinkId=99536
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Edit the default filter for a report  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Report Permissions  

If a report is a Microsoft SQL Server Reporting Services report, is enabled for pre-filtering, and has a default filter, you 
can change the default filter that will be used each time any user runs the report.  

 

1. In the Navigation Pane, click Workplace, and then under My Work, click Reports.  

2. Select a report.  

To see all reports, including sub-reports that are not visible in the default view, select the All 

Reports, Including Sub-Reports view.  

3. On the Actions toolbar, click More Actions, and then click Edit Default Filter.  

4. Modify the filter criteria.  

The criteria are grouped by record types that you can use in the filter, such as Accounts or 

Contacts.  

 To edit an existing row, click the query relational operator and select an operator, or click the 

underlined value and enter a new value.  

 Click the query relational operator, and select an operator.  

 To add a criteria row:  

a. In the area for the record type that the field belongs to, click Select, and specify the 

field to filter on.  

b. Click the query relational operator, and select an operator.  

c. Click Enter Value, and enter a value to filter on. For some values, you can click the 

Select Values button  to open the Select Values dialog box and select the 

value you want.  

 To group criteria, you must select two or more rows for the same record type. For example, 

Sales Stage and Est. Revenue are both field values in the Opportunity record type and 

two rows that specify filter criteria for these fields can be grouped. However, rows with field 

values from different record types, such as Account and Opportunity record types, cannot 

be grouped.  

a. For each row you want to group, in detailed mode, click the Options menu 

button  for that row, and then click Select Row.  

b. On the Filter toolbar, select Group AND or Group OR.  

c. To remove a row from a group, click the Options menu button  for that row, and 

then click Delete.  

d. To select a group, click the Options menu button  for that group, and then click 

Select Group.  

e. To add a criteria clause to a group, click the Options menu button  for that group, 

click Add Clause, and then select the field, query relational operator, and value.  

f. To unselect a group that has been previously selected, click the Options menu 

button  for that group, and then click Deselect Group.  
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g. To ungroup a group, click the Options menu button  for that group, and then 

click Ungroup.  

h. To change a Group AND group to a Group OR group, or a Group OR group to a 

Group AND group, click the Options menu button  for that group, and then click 

Change to OR or Change to AND.  

 Tips 

 To clear all criteria and start over, on the Filter toolbar, click Clear, and then click Confirm.  

 To delete a row, click the Options menu button  for that row, and then click Delete.  

5. Click Save Default Filter.  

6. Click Save or Save and Close.  

Edit a default report or create a Reporting Services report  

 Can I do this task?  

This task requires the System Administrator or System Customizer security role or equivalent 
permissions. More information about specific permissions and performing this task while offline: Report 
Permissions  

The default reports in Microsoft Dynamics CRM are all Reporting Services reports. Default reports cannot be edited 

with the Report Wizard. To edit the default reports or create a new Reporting Services report other than one created 

by using the Report Wizard, you need a report development environment:  

 How to set up a report development environment 

Install the required components on your computer:  

 Microsoft Visual Studio, or any product that uses the Visual Studio.NET integrated 

development environment (such as Microsoft Visual Basic.NET).  

 Reporting Services Report Designer 

Reporting Services Report Designer 2005 can be installed from the Microsoft SQL Server 

2005 CD, and requires Visual Studio.NET 2005.  

 Make sure a security role assigned to your account includes the Publish Reports and Add 

Reporting Services Reports privileges.  

In addition to the required components, the following documentation is helpful:  

 Report Writers Guide section of the Microsoft CRM 4.0 Software Development Kit. More 

information: Writing Reporting Services Reports (Microsoft Dynamics CRM SDK)  

 Reporting Services Books Online provides help for Reporting Services. More information: 

SQL Server 2005 Reporting Services Books Online  

 

 

1. Identify the existing report that is closest in design to your new report.  

http://go.microsoft.com/fwlink/?LinkId=97586
http://go.microsoft.com/fwlink/?LinkId=98256
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2. Download the report from Microsoft Dynamics CRM to a computer that is set up with the report 

development environment.  

a. In the Navigation Pane, click Workplace, and then under My Work, click Reports.  

b. On the Actions toolbar, click Edit Report , and then on the Actions  menu, click 

Download Report.  

c. Click Save, and specify the location in which to save the file. If you are creating a new 

report rather than modifying a report, rename the file.  

d. In the Download Complete dialog box, click Close.  

3. In a product using the Visual Studio integrated development environment (IDE), open the report, and 

make the required changes.  

If you are making major changes, first read Writing Reporting Services Reports (Microsoft Dynamics 

CRM SDK).  

4. Add the report to Microsoft Dynamics CRM.  

a. In the Microsoft Dynamics CRM Reports area, click New.  

b. In the Report Type box, select Existing File.  

c. In the File Location box, enter the path and file name of the dynamic or static file to add, 

or click Browse to locate the file.  

d. Edit the report properties:  

 Name 

The name for the report that is shown in the Reports area and on the Reports  

menu in forms and lists.  

 Description 

The description that is displayed in the Reports area.  

 Parent Report 

If this report is a sub-report or a drill-through report, specify an existing parent 

report. If this is not specified, the parent report will display a "Report not found" 

error.  

 Categories 

To specify the categories in which to include this report, click the Select Values 

button , and then select the categories. More information: System Settings Dialog 

Box - Reporting Tab  

 Related Record Types 

To have the report appear in the Reports list on a page for specific record types, 

click the Select Values button , and then select record types.  

For example, if your new report includes data from accounts and activities, select 

Accounts and Activities.  

 Display In 

To specify where reports should be visible, click the Select Values button , and 

then select one or more options:  

 Reports area  

Report will be displayed in the Reports area.  

 Forms for related record types  

Report will be displayed on the form for the record type you select in Related 

Record Types 

http://go.microsoft.com/fwlink/?LinkId=97586
http://go.microsoft.com/fwlink/?LinkId=97586
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If the report is enabled for pre-filtering, from the record, users can specify 

running the report on the current record.  

 Lists for related record types  

Report will be displayed from specified list view pages.  

If the report has pre-filtering enabled, from the list view, users can specify 

running the report on selected records.  

 If no values are selected, the report will not be visible to end-users. To view or 

manage reports not visible to end-users, in the Reports area, select the All Reports, 

Including Sub-Reports view.  

 Languages 

If your Microsoft Dynamics CRM implementation has multiple languages enabled, 

specify a language. The report will be displayed for all users who have selected that 

language in their personal options. To make this report available to all users, select 

All Languages.  

Note that this does not change the language used inside the report.  

e. Click Save.  

f. To modify the filter for the report, on the Actions toolbar, click More Actions, and then click 

Edit Default Filter.  

Tips 

 To share your new file with other users, do one of the following:  

 Add your file as a report in Microsoft Dynamics CRM, and select the report. On the More 

Actions menu, click Sharing, and specify users with whom to share the report.  

 If the report would be useful for all users, add your file as a report in Microsoft Dynamics 

CRM, and ask your system administrator to make it available to the organization. If you have 

the appropriate permissions:  

1. In the Microsoft Dynamics CRM Reports area, select the report.  

2. Click Edit Report .  

3. On the Actions  menu, click Make Report Available to Organization.  

 Put the report in a shared file system.  

 E-mail the report to other Microsoft Dynamics CRM users in the same domain.  

 If you don't want users to run the base report you started from:  

1. In the Reports area, select the report.  

2. On the Actions toolbar, click Edit Report .  

3. On the Actions  menu, click Revert to Personal Report.  
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Create one-time or scheduled Reporting Services report snapshots  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Report Permissions  

To create a snapshot of a Reporting Services report, you create a snapshot definition, which can be used to create 

on-demand snapshots or to schedule snapshots to occur at specific times. Each snapshot definition can create and 

store up to eight snapshots. When the ninth snapshot is created, the first snapshot is automatically deleted.  

Caution: When you make a snapshot available to other users, all the data in the snapshot is visible, whether or not 

the other users have permission to view this data directly in Microsoft Dynamics CRM. Make sure you don't share 

information that other users do not have permission to view.  

 

1. In the Navigation Pane, click Workplace, and then under My Work, click Reports.  

2. Select a report.  

3. On the More Actions menu, click Schedule Report and complete the steps in the wizard.  

Tips 

 After you create a snapshot definition, rename the snapshot definition so that users can easily 

understand the purpose of the snapshot.  

1.  

2. In the Name box, enter a new name, and then click Save and Close.  

 After you have created snapshots, if you don't want users to be able to run the base report:  

1. In the Reports area, select the report.  

2. On the Actions toolbar, click Edit Report .  

3. On the Actions  menu, click Revert to Personal Report.  

Make a report available to all Microsoft Dynamics CRM users  

 Can I do this task?  

This task requires the System Administrator or System Customizer security role or equivalent 
permissions. More information about specific permissions and performing this task while offline: Report 
Permissions  

 

 

1. In the Navigation Pane, click Workplace, and then under My Work, click Reports.  

2. Select the report you created, and on the Actions toolbar, click Edit Report.  

3. On the Actions  menu, click Make Report Available to Organization.  

Note 

To revert a report back to a personal report, on the Actions  menu, click Revert to Personal Report.  
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Create, edit, or copy a report using the Report Wizard  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Report Permissions  

 How to determine which record types have the data you need 

There is one record type for each type of data, such as accounts, contacts, or services.  

In addition, there are separate record types for:  

 Notes. Every note and attachment is stored as a separate record in the Notes record type.  

 Close activities. Whenever you close an opportunity, quote or order, an activity is created 

that tracks the reason for closing the record. These are stored respectively in the 

Opportunity Close Activity, Quote Close Activity, and Order Close Activity record types. 

When you close a case, the data is stored in the Case Resolution Activity.  

If your report includes data from communication activities, you have two options:  

 If you want data about multiple types of communication activities in one report such as the 

activity subjects and due dates for all types of activities, use the Activity record type.  

 If you need specific information about a specific type of activity, such as the recipients, use 

the Task, E-mail Message, Fax, Appointment, Letter, or Phone Call record type.  

Tip:  

 While you are creating your report, keep a window open showing a record from the data 

type you are including in your report. It will help you determine which columns to include.  

 

 

1. In the Navigation Pane, click Workplace, and then under My Work, click Reports.  

2. To add a new report, click New, and then click Report Wizard.  

– OR –  

To edit an existing Report Wizard report, select the report, on the Actions toolbar, click Edit 

Report , and then click Report Wizard.  

You can only use the Report Wizard to edit reports that were created with the wizard.  

3. Select a starting point for your report.  

a. To create a new report, select Start a new report.  

– OR –  

To start from a copy of an existing report, select Start from an existing report, select the 

report, and also clear the Overwrite existing report check box.  

– OR –  
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To edit an existing report, select Start from an existing report, select the report, and 

check the Overwrite existing report check box.  

b. If multiple languages are installed, select the language to use for column names, record 

types, and wizard-generated text in the report.  

c. Click Next.  

4. Enter the name of the report, and specify which record types the report will use.  

The purpose of this step is to identify where the data in the report comes from. You can include 

data from one or two record types, plus data from related records.  

a. Enter data in each field:  

 Report name. This value will be displayed on the Reports  menu and in the 

Reports area.  

 Primary record type. Data from all fields in this record type and related record 

types will be available when you are defining criteria for which records to include. 

Data from this record type will be available when you are selecting fields to display.  

 Related record type. If you need to display data from a related record type, select 

an additional record type here.  

Tip: If you don't need data from a related record type, don't select one, as it makes 

the report take longer to load.  

b. Click Next.  

5. Specify which records to include.  

The purpose of this step is to determine which records are included in your report. This information 

is saved as the default filter for the report.  

You can select criteria based on the selected record types or on columns from related records.  

a. To include only records defined by an existing system view or saved view, select a view.  

– OR –  

To define which records to include by selecting criteria:  

 To add a criteria row:  

1. In the area for the record type that the field belongs to, click Select, and 

specify the field to filter on.  

2. Click the query relational operator, and select an operator.  

3. Click Enter Value, and enter a value to filter on. For some values, you can 

click the Select Values button  to open the Select Values dialog box 

and select the value you want.  

 To group criteria, you must select two or more rows for the same record type. For 

example, Sales Stage and Est. Revenue are both field values in the Opportunity 

record type and two rows that specify filter criteria for these fields can be grouped. 

However, rows with field values from different record types, such as Account and 

Opportunity record types, cannot be grouped.  
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a. For each row you want to group, click the Select Row button  for that row, 

and then click Select Row.  

b. On the Filter toolbar, select Group AND or Group OR.  

c. To remove a row from a group, click the Options menu button  for that 

row, and then click Delete.  

d. To select a group, click the Options menu button  for that group, and then 

click Select Group.  

e. To add a criteria clause to a group, click the Options menu button  for that 

group, click Add Clause, and then select the field, query relational operator, 

and value.  

f. To unselect a group that has been previously selected, click the Options 

menu button  for that group, and then click Deselect Group.  

g. To ungroup a group, click the Options menu button  for that group, and 

then click Ungroup.  

h. To change a Group AND group to a Group OR group, or a Group OR group 

to a Group AND group, click the Options menu button  for that group, 

and then click Change to OR or Change to AND.  

 Click Next.  

 Organize and lay out your data.  

The purpose of this step is to determine which columns to include, the order in which they are 

displayed, and whether to group data into subcategories. At a minimum, a report just includes 

columns. By grouping and summarizing the data, you make it easier to see the patterns.  

For example, your report could use one level of grouping to group opportunities by salesperson, or 

add a second level of grouping to show each quarter's opportunities, or add a third level to show 

the percentage won and lost in each quarter.  

To use a chart in your report, if your report has no grouping, you must select at least one numeric 

column. If your report uses grouping, you must select at least one numeric column with a summary 

type defined.  

 Define how to organize the report:  

 To group items so that they are organized together in the report by date or other 

common properties:  

0. For each grouping level you need, click Click here to add a grouping.  

1. Define the grouping:  

 Record type. You can select records from the primary record type you 

selected, and from any related record types. If you selected a 

secondary record type, you can also select records from the secondary 

record type and its related records types.  

 Column. The name of the Microsoft Dynamics CRM field that contains 

the data to define the grouping.  

 Time interval. For datetime fields, group the data by Month, Day, 

Week, or Year.  

 Sort order. Sort order for displaying the groups.  

 Column width. Width of the column heading in pixels.  
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 Summary type. You can group records by a count of matching 

records.  

2. To reorder the grouping levels, use the up and down arrows in the Common 

Tasks section.  

3. Click OK.  

 To define the sort order within each group, click Configure Sorting, select a 

column and sort order, and then click OK.  

 To limit reports to groups with the highest or lowest values, click Set Top or 

Bottom Number:  

0. Select Top or Bottom.  

1. Select the number of groups to display.  

2. Click OK.  

 Define which columns to display in the report. You can display columns that show data from 

a record, or columns that show summary information:  

0. For each column you want to include, click Click here to add a column:  

 Record type. You can select records from the primary record type you 

selected, and from any related record types. If you selected a secondary 

record type, you can also select records from the secondary record type and 

its related records types.  

 Column. The name of the Microsoft Dynamics CRM field that contains the 

data to display or summarize.  

 Data type. The data type of the column, one of: primarykey, nvarchar, 

picklist, bit, decimal, int, float, money, ntext, datetime, owner, lookup.  

 Name. The name used in the database.  

 Column width. The width in pixels of the column.  

 Summary type. The specific type of summaries available depends on the 

data type of the column.  

o None: lookup, datetime, owner, picklist, bit, ntext 

o Average, Maximum, Minimum, Percent of Total, Sum: all 

numeric record types (decimal, int, float, money)  

 Use the left and right arrows to reorganize the columns.  

1. Click OK.  

 Click Next.  

 Select whether to use a chart in the report.  

The purpose of this step is to determine whether to use a chart, and which type of chart to use.  

 Select whether to include a chart:  

 Table only. This provides a table grouped and sorted as you specified.  

 Chart and table. Displays both a chart and table.  

o Show table below the chart on same page. Clicking on the chart does 

nothing.  
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o Show chart. To view data for a chart region, click the chart region. 

Clicking on an area in the chart will display a table with details for that section 

of the chart.  

 Click Next.  

 If the report includes a chart, format the chart.  

The purpose of this step is to specify the type of chart, and how the data is displayed in the chart.  

 Select the chart type, and then click Next.  

The Chart preview area shows how the data will be displayed.  

 For vertical and horizontal bar charts and line charts, specify which data to display on 

each axis:  

o In the Format Column (X) Axis section, select the field to use for the X axis, 

and the label that is displayed on the chart for the field.  

o In the Format Value (Y) Axis section, you can select two fields. For each 

field, you can specify the label that is displayed on the chart.  

o In the Format Labels and Legends section, specify whether or not to show 

the data labels and a legend.  

 For pie charts, specify the slices and values for the chart.  

o For slices, you must select one of the groupings in your report.  

o For values, you must select a numeric column with a summary type.  

 Click Next.  

 Review the summary of the report, click Next, and then click Finish.  

 Determine where the report can be run from.  

When you finish defining the report, you return to the Report form, where you can update the name 

and description of the report, and determine where the report is displayed:  

 Categories 

To specify the categories in which to include this report, click the Select Values button , 

and then select the categories. More information: System Settings Dialog Box - Reporting 

Tab  

By default, a new report is not put into any category. If you want the report to be included in 

the category views in the Reports area, such as the Marketing Reports view, add a 

category in the Categories box.  

 Related Record Types 

To have the report appear in the Reports list on a page for specific record types, click the 

Select Values button , and then select record types.  

For example, if your new report includes data from accounts and activities, select Accounts 

and Activities.  

 Display In 

To specify where reports should be visible, click the Select Values button , and then 

select one or more options:  

o Reports area  

Report will be displayed in the Reports area.  
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o Forms for related record types  

Report will be displayed on the form for the record type you select in Related 

Record Types 

o Lists for related record types  

Report will be displayed from specified list view pages.  

If no values are selected, the report will not be visible to end-users. To view or manage 

reports not visible to end-users, in the Reports area, select the All Reports, Including 

Sub-Reports view.  

 Languages 

If your Microsoft Dynamics CRM implementation has multiple languages enabled, specify a 

language. The report will be displayed for all users who have selected that language in their 

personal options. To make this report available to all users, select All Languages.  

Note that this does not change the language used inside the report.  

Tip: If you use the Microsoft Dynamics CRM for Outlook with Offline Access, by default all reports 

that you own will be available when you are offline. More information: Work with Data to Take 

Offline  

 Test the report, and modify it if needed.  

On the Report toolbar, click Run Report .  

If the report needs modifications, start with step 2 and edit the existing report.  

 Determine who can use the report. By default, the report is a personal report. This means 

that you are the only one who can use it.  

 To share this report with other users, in the Reports area, select the report, and then on the 

More Actions menu, click Sharing.  

 To make this report available to everyone in the organization, in the Reports area, select the 

report, on the Actions toolbar menu, click Edit Report, and then on the Actions  menu, 

click Make Report Available to Organization.  

If you use the Microsoft Dynamics CRM for Outlook with Offline Access, by default all reports that 

you own will be available when you are offline. More information: Work with Data to Take Offline  

Note 

All reports generated with the Report Wizard print in landscape mode.  
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Make a report available for external use  

 Can I do this task?  

This task requires the System Administrator or System Customizer security role or equivalent 
permissions. More information about specific permissions and performing this task while offline: Report 
Permissions  

Publishing a report for external use makes it available for use in a Microsoft SharePoint Web part or in a custom 

program, and enables you to work with the report using Microsoft SQL Server Reporting Services.  

 

1. In the Navigation Pane, click Workplace, and then under My Work, click Reports.  

2. Select the report, and on the Actions toolbar, click Edit Report .  

3. On the Actions  menu, click Publish Report For External Use.  

Write a Report Using Report-Writing Tools 

You can use any ODBC-compliant application to read data directly from the Microsoft Dynamics CRM database. When 

possible, using built-in reporting tools is easier than using the steps in this procedure. Recommended alternatives:  

 Export Data to Excel  

 Create Customer-Ready Documents and Messages  

 Create, Edit, or Copy a Report Using the Report Wizard  
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Edit a default report or create a Reporting Services report  

 Can I do this task?  

This task requires the System Administrator or System Customizer security role or equivalent 
permissions. More information about specific permissions and performing this task while offline: Report 
Permissions  

The default reports in Microsoft Dynamics CRM are all Reporting Services reports. Default reports cannot be edited 

with the Report Wizard. To edit the default reports or create a new Reporting Services report other than one created 

by using the Report Wizard, you need a report development environment:  

 How to set up a report development environment 

Install the required components on your computer:  

 Microsoft Visual Studio, or any product that uses the Visual Studio.NET integrated 

development environment (such as Microsoft Visual Basic.NET).  

 Reporting Services Report Designer 

Reporting Services Report Designer 2005 can be installed from the Microsoft SQL Server 

2005 CD, and requires Visual Studio.NET 2005.  

 Make sure a security role assigned to your account includes the Publish Reports and Add 

Reporting Services Reports privileges.  

In addition to the required components, the following documentation is helpful:  

 Report Writers Guide section of the Microsoft CRM 4.0 Software Development Kit. More 

information: Writing Reporting Services Reports (Microsoft Dynamics CRM SDK)  

 Reporting Services Books Online provides help for Reporting Services. More information: 

SQL Server 2005 Reporting Services Books Online  

 

 

1. Identify the existing report that is closest in design to your new report.  

2. Download the report from Microsoft Dynamics CRM to a computer that is set up with the report 

development environment.  

a. In the Navigation Pane, click Workplace, and then under My Work, click Reports.  

b. On the Actions toolbar, click Edit Report , and then on the Actions  menu, click 

Download Report.  

c. Click Save, and specify the location in which to save the file. If you are creating a new 

report rather than modifying a report, rename the file.  

d. In the Download Complete dialog box, click Close.  

3. In a product using the Visual Studio integrated development environment (IDE), open the report, and 

make the required changes.  

If you are making major changes, first read Writing Reporting Services Reports (Microsoft Dynamics 

CRM SDK).  

4. Add the report to Microsoft Dynamics CRM.  

http://go.microsoft.com/fwlink/?LinkId=97586
http://go.microsoft.com/fwlink/?LinkId=98256
http://go.microsoft.com/fwlink/?LinkId=97586
http://go.microsoft.com/fwlink/?LinkId=97586
http://go.microsoft.com/fwlink/?LinkId=97586


 

 

 Microsoft Dynamics CRM 4.0 User’s Guide 123 

 

a. In the Microsoft Dynamics CRM Reports area, click New.  

b. In the Report Type box, select Existing File.  

c. In the File Location box, enter the path and file name of the dynamic or static file to add, 

or click Browse to locate the file.  

d. Edit the report properties:  

 Name 

The name for the report that is shown in the Reports area and on the Reports  

menu in forms and lists.  

 Description 

The description that is displayed in the Reports area.  

 Parent Report 

If this report is a sub-report or a drill-through report, specify an existing parent 

report. If this is not specified, the parent report will display a "Report not found" 

error.  

 Categories 

To specify the categories in which to include this report, click the Select Values 

button , and then select the categories. More information: System Settings Dialog 

Box - Reporting Tab  

 Related Record Types 

To have the report appear in the Reports list on a page for specific record types, 

click the Select Values button , and then select record types.  

For example, if your new report includes data from accounts and activities, select 

Accounts and Activities.  

 Display In 

To specify where reports should be visible, click the Select Values button , and 

then select one or more options:  

 Reports area  

Report will be displayed in the Reports area.  

 Forms for related record types  

Report will be displayed on the form for the record type you select in Related 

Record Types 

If the report is enabled for pre-filtering, from the record, users can specify 

running the report on the current record.  

 Lists for related record types  

Report will be displayed from specified list view pages.  

If the report has pre-filtering enabled, from the list view, users can specify 

running the report on selected records.  

 If no values are selected, the report will not be visible to end-users. To view or 

manage reports not visible to end-users, in the Reports area, select the All Reports, 

Including Sub-Reports view.  

 Languages 

If your Microsoft Dynamics CRM implementation has multiple languages enabled, 

specify a language. The report will be displayed for all users who have selected that 
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language in their personal options. To make this report available to all users, select 

All Languages.  

Note that this does not change the language used inside the report.  

e. Click Save.  

f. To modify the filter for the report, on the Actions toolbar, click More Actions, and then click 

Edit Default Filter.  

Tips 

 To share your new file with other users, do one of the following:  

 Add your file as a report in Microsoft Dynamics CRM, and select the report. On the More 

Actions menu, click Sharing, and specify users with whom to share the report.  

 If the report would be useful for all users, add your file as a report in Microsoft Dynamics 

CRM, and ask your system administrator to make it available to the organization. If you have 

the appropriate permissions:  

1. In the Microsoft Dynamics CRM Reports area, select the report.  

2. Click Edit Report .  

3. On the Actions  menu, click Make Report Available to Organization.  

 Put the report in a shared file system.  

 E-mail the report to other Microsoft Dynamics CRM users in the same domain.  

 If you don't want users to run the base report you started from:  

1. In the Reports area, select the report.  

2. On the Actions toolbar, click Edit Report .  

3. On the Actions  menu, click Revert to Personal Report.  
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Use Microsoft Office Word 2003  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Report Permissions  

There are several ways you can merge Microsoft Dynamics CRM data into Microsoft Office Word 2003. If you use 

Microsoft Office Word 2007, you can also use mail merge from Microsoft Dynamics CRM and from Microsoft Dynamics 

CRM for Outlook.  

 Export a list, such as the results of an Advanced Find search, into a dynamic or static Microsoft Office Excel file, 

and use the Excel file as the data source for a Microsoft Office Word 2003 mail merge. This does not create a 

Microsoft Dynamics CRM activity for each merged record. More information: Export Data to Excel  

 From Microsoft Office Word 2003, read data directly from the Microsoft Dynamics CRM database. This does not 

create a Microsoft Dynamics CRM activity for each merged record. This method is described in this topic.  

 

1. In Microsoft Office Word, on the Tools menu, point to Letters and Mailings, and then click Mail 

Merge.  

Follow the instructions in steps 1 and 2 of the Mail Merge pane.  

2. In step 3 of the Mail Merge instructions, select Use an existing list, and then click Browse.  

3. Click New SQL Server connection.odc, and then click Open.  

4. In the Server Name box, type the name of the server where the Microsoft Dynamics CRM database 

is stored, and then click Next.  

5. In the database list, select the Organization_MSCRM database.  

6. In the Name column, select a filtered view that starts with the prefix Filtered.  

7. Click Next, and then click Finish.  

8. Complete the mail merge by following the remaining steps in the Microsoft Office Word Mail Merge 

pane.  

Tip 

To share your new file with other users, do one of the following:  

 Add your file as a report in Microsoft Dynamics CRM, and select the report. On the More Actions 

menu, click Sharing, and specify users with whom to share the report.  

 If the report would be useful for all users, add your file as a report in Microsoft Dynamics CRM, and 

ask your system administrator to make it available to the organization. If you have the appropriate 

permissions:  

1. In the Microsoft Dynamics CRM Reports area, select the report.  

2. Click Edit Report .  

3. On the Actions  menu, click Make Report Available to Organization.  

 Put the report in a shared file system.  

 E-mail the report to other Microsoft Dynamics CRM users in the same domain.  
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Use Microsoft Office Word 2007  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Report Permissions  

There are several ways you can merge Microsoft Dynamics CRM data into Microsoft Office Word 2007.  

 From a list of records such as the results of an Advanced Find search, use mail merge to merge the data 

into Word 2007. You can create letters or e-mail activities for each record in the list. More information: 

Create Customer-Ready Documents and Messages  

 From Microsoft Dynamics CRM for Outlook, mail merge data from a list. You can create letters or e-mail 

activities for each record in the list. More information: Create Customer-Ready Documents and Messages  

 Export a list, such as the results of an Advanced Find search, into a dynamic or static Microsoft Office Excel 

file, and use the Excel file as the data source for a Microsoft Office Word 2007 mail merge. This does not 

create a Microsoft Dynamics CRM activity for each merged record. More information: Export Data to Excel  

 From Word, read data directly from the Microsoft Dynamics CRM database. This does not create a Microsoft 

Dynamics CRM activity for each merged record. This method is described in this topic.  

 

1. In Word 2007, on the Mailings tab, in the Start Mail Merge group, click Start Mail Merge.  

2. Click Step by Step Mail Merge Wizard.  

3. Follow the instructions in steps 1 and 2 of the Mail Merge pane.  

4. In step 3 of the Mail Merge instructions, select Use an existing list, and then click Browse.  

5. Click New SQL Server Connection.odc, and then click Open.  

6. In the Server name box, type the name of the server where the Microsoft Dynamics CRM database is 

stored, and then click Next.  

7. In the database list, select the Organization_MSCRM database.  

8. In the Name column, select a filtered view that starts with the prefix Filtered.  

9. Click Next, and then click Finish.  

10. Complete the mail merge by following the remaining steps in the Microsoft Office Word Mail Merge 

pane.  

Tip 

To share your new file with other users, do one of the following:  

 Add your file as a report in Microsoft Dynamics CRM, and select the report. On the More Actions 

menu, click Sharing, and specify users with whom to share the report.  

 If the report would be useful for all users, add your file as a report in Microsoft Dynamics CRM, and 

ask your system administrator to make it available to the organization. If you have the appropriate 

permissions:  

1. In the Microsoft Dynamics CRM Reports area, select the report.  

2. Click Edit Report .  
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3. On the Actions  menu, click Make Report Available to Organization.  

 Put the report in a shared file system.  

 E-mail the report to other Microsoft Dynamics CRM users in the same domain.  

Use Microsoft Office Excel 2003  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Report Permissions  

 

 

1. To create a PivotTable, in Excel 2003, on the Data menu, click PivotTable and PivotChart Report.  

– OR –  

To create a worksheet, in Excel 2003, on the Data menu, click Import External Data, and then 

click New Database Query.  

2. Create a new data source for the Microsoft Dynamics CRM database, or if you already have a data 

source set up that connects to the Microsoft Dynamics CRM database, connect to it.  

 To create a new data source:  

a. If you are creating a data source for a PivotTable, in the PivotTable and 

PivotChart Wizard - Step 1 of 3 dialog box, select External Data Source, click 

Next, and then click Get Data.  

b. In the Choose Data Source dialog box, select <New Data Source>, and then 

click OK.  

c. In the Create New Data Source dialog box, type a name for the data source, and 

then in the driver list, select SQL Server.  

d. Click Connect.  

e. In the SQL Server Login dialog box, in the Server list, select the Microsoft SQL 

Server or server instance where the Microsoft Dynamics CRM database is installed, 

and then click Options.  

f. In the Database box, select Organization_MSCRM, and then click OK three times.  

The Query Wizard dialog box opens.  

 To connect to an existing data source that uses the Microsoft Dynamics CRM database:  

a. If you are creating a data source for a PivotTable, in the PivotTable and 

PivotChart Wizard - Step 1 of 3 dialog box, select External Data Source, click 

Next, and then click Get Data.  

b. Select an existing data source that uses the Microsoft Dynamics CRM database, and 

then click OK.  

3. In the Query Wizard Available tables and columns list dialog box, select filtered views that start 

with the prefix Filtered. You can select columns within each filtered view, and select multiple 

filtered views.  

Caution To integrate with built-in security, only include filtered views in your query. If you connect 

directly to a database table, the spreadsheet may fail to return data for other users.  



 

128 Microsoft Dynamics CRM 4.0 User’s Guide 
 

4. Continue with the Query Wizard. For more information about the Query Wizard, click the Help button 

to open Microsoft Query Help. For more information about importing external data to Excel, search 

for "import external data" in Excel Help.  

5. For PivotTables, in the PivotTable and PivotChart Wizard - Step 2 of 3 dialog box, click Next, 

and then click Finish. Then drag the fields as needed to your PivotTable.  

Tip 

To share your new file with other users, do one of the following:  

 Add your file as a report in Microsoft Dynamics CRM, and select the report. On the More Actions 

menu, click Sharing, and specify users with whom to share the report.  

 If the report would be useful for all users, add your file as a report in Microsoft Dynamics CRM, and 

ask your system administrator to make it available to the organization. If you have the appropriate 

permissions:  

1. In the Microsoft Dynamics CRM Reports area, select the report.  

2. Click Edit Report .  

3. On the Actions  menu, click Make Report Available to Organization.  

 Put the report in a shared file system.  

 E-mail the report to other Microsoft Dynamics CRM users in the same domain.  

Use Microsoft Office Excel 2007  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Report Permissions  

 

 

1. In Excel 2007, on the Data tab, in the Get External Data group, click From Other Sources, and 

then click From Microsoft Query.  

2. In the Choose Data Source dialog box, select <New Data Source>, and then click OK.  

3. In the Create New Data Source dialog box, type a name for the data source, and then in the driver 

list, select SQL Server.  

4. Click Connect.  

5. In the SQL Server Login dialog box, in the Server list, select the Microsoft SQL Server or server 

instance where the Microsoft Dynamics CRM database is installed, and then click Options.  

6. In the Database box, select Organization_MSCRM, and then click OK three times.  

The Query Wizard - Choose Columns dialog box opens.  

7. In the Query Wizard - Choose Columns dialog box, select filtered views that start with the prefix 

Filtered. You can select columns within each filtered view, and select multiple filtered views.  

Caution To integrate with built-in security, only include filtered views in your query. If you connect 

directly to a database table, the spreadsheet may fail to return data for other users.  

8. Continue with the Query Wizard. For more information about the Query Wizard, click the Help button 

to open Microsoft Query Help. For more information about importing external data to Excel, search 

for "import external data" in Excel Help.  
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Tip 

To share your new file with other users, do one of the following:  

 Add your file as a report in Microsoft Dynamics CRM, and select the report. On the More Actions 

menu, click Sharing, and specify users with whom to share the report.  

 If the report would be useful for all users, add your file as a report in Microsoft Dynamics CRM, and 

ask your system administrator to make it available to the organization. If you have the appropriate 

permissions:  

1. In the Microsoft Dynamics CRM Reports area, select the report.  

2. Click Edit Report .  

3. On the Actions  menu, click Make Report Available to Organization.  

 Put the report in a shared file system.  

 E-mail the report to other Microsoft Dynamics CRM users in the same domain.  

Use another report-writing tool  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Report Permissions  

 

 

1. Read the online Help for the application that you are using to determine how to read external data 

from a Microsoft SQL Server database.  

2. When selecting the data source, choose the SQL Server instance used by Microsoft Dynamics CRM and 

the Organization_MSCRM database.  

3. Select filtered views that start with the prefix Filtered and any fields from the filtered views that you 

want in your report.  

Tip 

To share your new file with other users, do one of the following:  

 Add your file as a report in Microsoft Dynamics CRM, and select the report. On the More Actions 

menu, click Sharing, and specify users with whom to share the report.  

 If the report would be useful for all users, add your file as a report in Microsoft Dynamics CRM, and 

ask your system administrator to make it available to the organization. If you have the appropriate 

permissions:  

1. In the Microsoft Dynamics CRM Reports area, select the report.  

2. Click Edit Report .  

3. On the Actions  menu, click Make Report Available to Organization.  

 Put the report in a shared file system.  

 E-mail the report to other Microsoft Dynamics CRM users in the same domain.  
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Communicating with Customers 

Managing Communication Activities 

You can create fully documented correspondence with your customers by creating activity records. You can organize 

and track activities:  

 Organize activities by the completion date, so that you know what you've performed and when.  

 Organize activities by type, priority, date due, or the reason for the activity.  

 Organize activities by status.  

 Review a list of activities that have been performed for a particular customer.  

 Associate an activity with an account, contact, lead, or opportunity.  

 Create mail merge documents.  

Note 

You cannot set reminders for faxes, phone calls, letters, or campaign responses. Whether you can set reminders for 

tasks, e-mail messages, appointments, and service activities depends on whether you created the activities in Microsoft 

Dynamics CRM for Microsoft Office Outlook or in the Web application. More information: Manage Activities  

Create Customer-Ready Documents and Messages 

There are two main methods of creating customer-ready documents: mail merge and direct e-mail. With mail merge, 

you can use Microsoft Office Word and Microsoft Office Word templates to create letters, faxes, envelopes, and e-mail 

messages. With direct e-mail, you can send a mass mailing of the same message using Microsoft Dynamics CRM e-mail 

templates to multiple e-mail recipients. This is also known as sending bulk e-mail.  

Send direct e-mail  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: E-mail Permissions  

Direct e-mail uses Microsoft Dynamics CRM e-mail templates. If you want to use Microsoft Office Word templates, use 

the mail merge feature. 

You cannot attach or insert files, including image files, into an e-mail message template or an e-mail message created 

with an e-mail template, such as a direct e-mail or a quick campaign.  

 

1. In the Navigation Pane, under Sales or Marketing, click the record type you want, for example, 

Contacts.  

Which panes you see will depend on the security roles you have been assigned.  

You can also send direct e-mail to users from the Users list. 

2. In the View list, select the filtered view you want.  

3. If you want to send direct e-mail to only a few people, select the records you want.  

– OR –  

If you want to send direct e-mail to everyone displayed in the current list, go to the next step.  
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4. On the Actions toolbar, click Send Direct E-mail .  

5. In the Send Direct E-mail dialog box, select the template you want to use.  

To view a description of the template, select the template.  

6. To specify the recipients of the direct e-mail, select:  

 Selected records on current page to send the e-mail to only the contacts you selected.  

 All records on current page to send the e-mail to all the contacts on the current page of 

the current view.  

 All records on all pages to send the e-mail to all the contacts on all the pages of the 

current view. 

7. Click Send.  

An e-mail activity is created for each recipient.  

Note 

If an account or contact does not have a valid e-mail address or has the Do Not Allow option set for Bulk E-mail, the 

message is not sent to them, and no e-mail activity is created.  

Tips 

 You can also select recipients from a search in Advanced Find. When you use Advanced Find, you 

can reduce the number of message failures that are due to customers for whom you do not have e-

mail addresses. In a new or saved search, click Select, and select E-mail. Click Equals and select 

Contains Data. Enter any other search criteria and then click OK.  

 You can change the sender's contact information. To change contact information, in the User or 

Queues box, click the Lookup button  to search for a record.  
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Create a Microsoft Office Word mail merge document  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: E-mail Permissions  

In Microsoft Dynamics CRM for Outlook, only one mail merge can be run at a time. If you want to discontinue a 

mail merge, close Microsoft Office Word. You can run multiple mail merge processes at the same time in the Web 

application.  

 Record types that use mail merge  

 Account  

 Campaign 

To use mail merge with a campaign, you must first distribute a mail campaign activity to 

a selected marketing list.  

 Contact  

 Lead  

 Opportunity  

 List Member in Marketing List  

 Quick Campaign 

In Microsoft Dynamics CRM for Outlook, you can create a mail merge, and then at the 

end of the process, create a quick campaign.  

 Quote 

With mail merge, you can print only one quote at a time.  

 

 

1. Open the list of records you want.  

2. In the list, select one or more records to add to the mail-merge recipient list.  

3. On the Actions toolbar, click Mail Merge .  

4. If you have other languages installed, you can select a language to filter the list of templates.  

5. In the Mail Merge dialog box, select the type of document you want to use. 

 Note 

If the E-mail option is not available, the Enable Direct E-mail via Mail Merge option in the System 

Settings may be set to No. More information: Manage System Settings  

6. Select if you want to start with a blank document or a template. If you select a template option, click 

the Lookup button  to select a template. 

New mail merge templates are created in the Settings area. More information: Work with Mail Merge 

Templates  
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7. If necessary, you can add or delete data fields. Microsoft Office Word supports up to 64 data fields, of 

which Microsoft Dynamics CRM for Outlook reserves two data fields to store the primary key and the 

record owner.  

8. Click OK.  

Microsoft Dynamics CRM automatically opens a Microsoft Office Word document. In the File 

Download dialog box, click Open.  

This is not your mail-merge document. This is an interim page. Follow the directions in the Word 

document, including clicking CRM.  

9. In the Mail Merge Recipient dialog box, verify that the list is accurate, and then click OK.  

10. To continue the mail merge, follow the instructions provided by the Mail Merge pane. For more 

information, see the Microsoft Office Word Help documentation.  

 Tip  

 To display the information you want and select the format, in the Mail Merge wizard, click 

Address Block and then Greeting Line.  

To add data fields to display more information, click More Items. You can use up to 64 data fields.  

11. If you are working in Microsoft Dynamics CRM for Outlook and you have either created a new 

template or updated an existing template, you can upload the template.  

 To save the document as a template, on the Complete the Merge pane, click Upload 

Template to CRM. 

If you are working in the Web application, you can upload the template in the Settings area. More 

information: Work with Mail Merge Templates 

12. When you have completed work on the mail merge document, close it, and then delete the interim 

mail-merge document (Mail_Merge_nnnn.xml) and the associated text file (Mail_Merge_nnnn.txt) 

with the same name. 

 Warning Mail merge may leave sensitive data on your computer.  

The mail merge process creates two files in addition to your mail merge documents. These files are the 

data sources used by mail merge and contain Microsoft Dynamics CRM data, which may include sensitive 

customer data. You should delete these data source files after you complete the mail merge.  

Both files have the same name: Mail_Merge[nnnn], where nnnn is a 4-character, randomly generated 

number. One file is a.doc file and the other is a.txt file. Unless you moved the files or saved them to 

another directory, these files are usually in a temporary files folder on your computer. 

13. If you are working in Microsoft Dynamics CRM for Outlook, after you print or send the document, 

you can choose to create activities for mail-merge items.  

1. In the Create Activities dialog box, click Create Microsoft Dynamics CRM activities.  

2. If you want to change the default values for the activity, click Activity Details, and then 

make any changes. To save the changes, click OK.  

3. Under Assign activities to, select to whom the new activities should be assigned.  
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4. You can choose to have the new activities closed immediately. E-mail activities are closed as 

soon as the messages are sent.  

5. If you are creating a mail merge from a marketing list, you can also make the mail merge a 

quick campaign and include an link in e-mail messages for customers to remove themselves 

from your marketing lists.  

6. Click OK to save the changes and create the activities.  

Closed activities appear in the history list of the customer record. Open activities appear in the 

activities list of the customer record and in your list of active activities.  

Note 

If an account or contact does not have a valid e-mail address or has the Do Not Allow option set for Bulk E-mail, the 

message is not sent to them, and no e-mail activity is created.  

Print a quote with a mail-merge document  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: E-mail Permissions  

You can use a mail-merge template to generate a customer-ready document that displays data from a saved 

quote, and that includes a header and a footer.  

In Microsoft Dynamics CRM for Outlook, only one mail merge can be run at a time. If you want to discontinue a 
mail merge, close Microsoft Office Word. You can run multiple mail merge processes at the same time in the Web 
application.  

 

1. In the Navigation Pane, click Sales, and then click Quotes.  

2. Open the quote you want to print. If you want to use mail merge with a new quote, before starting 

the mail merge, save the quote first.  

3. On the Actions toolbar, click Print Quote for Customer .  

4. If you have other languages installed, you can select a language to filter the list of templates.  

5. In the Mail Merge dialog box, select the type of document you want to use. 

 Note 

If the E-mail option is not available, the Enable Direct E-mail via Mail Merge option in the System 

Settings may be set to No. More information: Manage System Settings  

6. Select if you want to start with a blank document or a template. If you select a template option, click 

the Lookup button  to select a template. 

New mail merge templates are created in the Settings area. More information: Work with Mail Merge 

Templates  

7. If necessary, you can add or delete data fields. Microsoft Office Word supports up to 64 data fields, of 

which Microsoft Dynamics CRM for Outlook reserves two data fields to store the primary key and the 

record owner.  
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While working with quotes, removing or re-arranging data fields may cause the quote to not display 

or print properly. The footer displays after "LastItem", which marks the end of the quote data fields. 

8. Click OK.  

Microsoft Dynamics CRM automatically opens a Microsoft Office Word document. In the File 

Download dialog box, click Open.  

This is not your mail-merge document. This is an interim page. Follow the directions in the Word 

document, including clicking CRM.  

9. In the Mail Merge Recipient dialog box, verify that the list is accurate, and then click OK.  

10. To continue the mail merge, follow the instructions provided by the Mail Merge pane. For more 

information, see the Microsoft Office Word Help documentation.  

 Tip  

 To display the information you want and select the format, in the Mail Merge wizard, click 

Address Block and then Greeting Line.  

To add data fields to display more information, click More Items. You can use up to 64 data fields.  

11. If you are working in Microsoft Dynamics CRM for Outlook and you have either created a new 

template or updated an existing template, you can upload the template.  

 To save the document as a template, on the Complete the Merge pane, click Upload 

Template to CRM. 

If you are working in the Web application, you can upload the template in the Settings area. More 

information: Work with Mail Merge Templates 

12. When you have completed work on the mail merge document, close it, and then delete the interim 

mail-merge document (Mail_Merge_nnnn.xml) and the associated text file (Mail_Merge_nnnn.txt) 

with the same name. 

 Warning Mail merge may leave sensitive data on your computer.  

The mail merge process creates two files in addition to your mail merge documents. These files are the 

data sources used by mail merge and contain Microsoft Dynamics CRM data, which may include sensitive 

customer data. You should delete these data source files after you complete the mail merge.  

Both files have the same name: Mail_Merge[nnnn], where nnnn is a 4-character, randomly generated 

number. One file is a.doc file and the other is a.txt file. Unless you moved the files or saved them to 

another directory, these files are usually in a temporary files folder on your computer. 

13. If you are working in Microsoft Dynamics CRM for Outlook, after you merge the new document, you 

can choose to create Microsoft Dynamics CRM activities for mail-merge items.  

1. In the Create Activities dialog box, click Create Microsoft Dynamics CRM activities.  

2. If you want to change the default values for the activity, click Activity Details, and then 

make any changes. To save the changes, click OK.  

3. Under Assign activities to, select to whom the new activities should be assigned.  
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4. You can choose to have the new activities closed immediately. E-mail activities are closed as 

soon as the messages are sent.  

5. If you are creating a mail merge from a marketing list, you can also make the mail merge a 

quick campaign and include an link in e-mail messages for customers to remove themselves 

from your marketing lists.  

6. Click OK to save the changes and create the activities.  

Closed activities appear in the history list of the customer record. Open activities appear in the 

activities list of the customer record and in your list of active activities.  

Note 

If an account or contact does not have a valid e-mail address or has the Do Not Allow option set for Bulk E-mail, the 

message is not sent to them, and no e-mail activity is created.  

Create a mail merge document with marketing lists  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: E-mail Permissions  

You can create a mail merge for a marketing list that is part of a campaign. 

In Microsoft Dynamics CRM for Outlook, only one mail merge can be run at a time. If you want to discontinue a 
mail merge, close Microsoft Office Word. You can run multiple mail merge processes at the same time in the Web 
application.  

 

1. In the Navigation Pane, click Marketing or Sales, and then click Marketing Lists.  

You can also open a marketing list from a campaign.  

2. On the Actions toolbar, click Mail Merge on List Members .  

3. If you have other languages installed, you can select a language to filter the list of templates.  

4. In the Mail Merge dialog box, select the type of document you want to use. 

 Note 

If the E-mail option is not available, the Enable Direct E-mail via Mail Merge option in the System 

Settings may be set to No. More information: Manage System Settings  

5. Select if you want to start with a blank document or a template. If you select a template option, click 

the Lookup button  to select a template. 

New mail merge templates are created in the Settings area. More information: Work with Mail Merge 

Templates  

6. If necessary, you can add or delete data fields. Microsoft Office Word supports up to 64 data fields, of 

which Microsoft Dynamics CRM for Outlook reserves two data fields to store the primary key and the 

record owner.  
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7. Click OK.  

Microsoft Dynamics CRM automatically opens a Microsoft Office Word document. In the File 

Download dialog box, click Open.  

This is not your mail-merge document. This is an interim page. Follow the directions in the Word 

document, including clicking CRM.  

8. In the Mail Merge Recipient dialog box, verify that the list is accurate, and then click OK.  

9. To continue the mail merge, follow the instructions provided by the Mail Merge pane. For more 

information, see the Microsoft Office Word Help documentation.  

 Tip  

 To display the information you want and select the format, in the Mail Merge wizard, click 

Address Block and then Greeting Line.  

To add data fields to display more information, click More Items. You can use up to 64 data fields.  

10. If you are working in Microsoft Dynamics CRM for Outlook and you have either created a new 

template or updated an existing template, you can upload the template.  

 To save the document as a template, on the Complete the Merge pane, click Upload 

Template to CRM. 

If you are working in the Web application, you can upload the template in the Settings area. More 

information: Work with Mail Merge Templates 

11. When you have completed work on the mail merge document, close it, and then delete the interim 

mail-merge document (Mail_Merge_nnnn.xml) and the associated text file (Mail_Merge_nnnn.txt) 

with the same name. 

 Warning Mail merge may leave sensitive data on your computer.  

The mail merge process creates two files in addition to your mail merge documents. These files are the 

data sources used by mail merge and contain Microsoft Dynamics CRM data, which may include sensitive 

customer data. You should delete these data source files after you complete the mail merge.  

Both files have the same name: Mail_Merge[nnnn], where nnnn is a 4-character, randomly generated 

number. One file is a.doc file and the other is a.txt file. Unless you moved the files or saved them to 

another directory, these files are usually in a temporary files folder on your computer. 

12. If you are working in Microsoft Dynamics CRM for Outlook, you can choose to create Microsoft 

Dynamics CRM activities for mail merge items.  

1. In the Create Activities dialog box, click Create Microsoft Dynamics CRM activities.  

2. If you want to change the default values for the activity, click Activity Details, and then 

make any changes. To save the changes, click OK.  

3. Under Assign activities to, select to whom the new activities should be assigned.  

4. You can choose to have the new activities closed immediately. E-mail activities are closed as 

soon as the messages are sent.  
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5. If you are creating a mail merge from a marketing list, you can also make the mail merge a 

quick campaign and include an link in e-mail messages for customers to remove themselves 

from your marketing lists.  

6. Click OK to save the changes and create the activities.  

Closed activities appear in the history list of the customer record. Open activities appear in the 

activities list of the customer record and in your list of active activities.  

Note 

If an account or contact does not have a valid e-mail address or has the Do Not Allow option set for Bulk E-mail, the 

message is not sent to them, and no e-mail activity is created.  

Manage Activities 

Create or edit an activity  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Common Task Permissions  

 

 

1. Navigate to activity records. In the Navigation Pane, click Workplace, and then under My Work click 

Activities.  

– OR –  

To work with activities associated with a record, open the record and then click Activities.  

2. To add new activities from the Activities list, on the Actions toolbar, click New.  

– OR –  

To add a new activity from a record, click New Activity. You can also click the activity icons on the 

Actions toolbar, or on the New menu, point to New Activity, and then select the activity type.  

 Tip 

To quickly create a follow-up activity from a record, in the Actions toolbar, click Follow Up , fill in the 
details in the Form Assistant pane, and then click Save.  

3. Select an activity type, and then click OK.  

4. Enter the information that you want. At a minimum, entering information in the following boxes is 

useful when you or others in your organization refer to the activity at a later date:  

 Subject  

Enter a meaningful description that can help you easily identify the activity in the Activities list 

view. The subject field is required because, by default, most of the Activities views are sorted 

by it. This field is not related to Subjects, which are the hierarchical list of categories used to 

relate and organize information in Microsoft Dynamics CRM.  
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 Regarding  

This field is used to link the activity to another record so that you can view the activity from 

the record. If you create a new activity from a record, this is automatically filled out.  

 Owner  

This box represents the user who owns the activity. By default, it is set to the user who 

creates the activity.  

 Duration 

If this activity is related to a case, make sure that you record the time you spend on the 

activity in this box. If the case is linked to a contract line, the durations of all the activities for 

this case are tallied and updated automatically in the related active contract. The total, which 

includes the totals from any other cases relating to that contract, can be adjusted manually 

before billing the customer. The maximum duration of an appointment or service activity is 10 

days.  

 Due 

Enter the date and time that the activity is expected to take place or be completed. You can 

quickly sort on the Due field when you view activities.  

 Tip 

To automatically update the Regarding field with information from a record, click the Expand button  
in the right pane to open the Form Assistant pane, and then select a record.  

5. Some activities also have the following optional fields:  

 Sender 

You can use this field to record the user in your organization who initiated an outgoing 

communication. Alternatively, if this is an incoming communication from a customer, you can 

select the lead, account, or contact who initiates the communication. The sender must be a 

valid Microsoft Dynamics CRM account, contact, or lead, but can also be a Microsoft Dynamics 

CRM user. By default, this box contains the name of the user who creates the activity.  

 Recipient 

This is the person, typically an account, contact, lead, or Microsoft Dynamics CRM user, that 

receives the communication.  

 Category, Sub-Category  

You can use these text fields to categorize tasks so that you can sort or view your tasks by 

category and/or sub-category.  

6. Click Save or Save and Close.  

 Tip 

If you are using the activity to track something that has already been completed, on the File menu, click 

Save as Completed.  

Notes 

 To create the same activity for multiple records, use a quick campaign. More information: Work with 

Quick Campaigns  
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 You cannot edit multiple activities at once.  

 You cannot schedule recurring activities.  

 You cannot edit closed activities.  

 You cannot change one activity into another type of activity.  

 You cannot set reminders in Microsoft Dynamics CRM for Microsoft Office Outlook for faxes, phone 

calls, e-mails, letters, or campaign responses activities created in the Web application or Microsoft 

Dynamics CRM for Outlook.  

 When the duration of an activity is more than 60 minutes (an hour), the time you enter is converted 

into hours. When the activity is saved, the value is rounded up and might change from the entry 

that was originally displayed when it was converted from minutes into hours. Note that rounding is 

only observed on the hundredth of an hour. The exact value for the duration, however, is stored in 

the database in minutes, and this value is used to calculate the total billing time when resolving 

cases.  

 The letter and fax activities record when the letter or fax is sent or received. When you create the 

activity, you attach the letter or fax document, such as a Microsoft Office Word file, to the record. 

With the mail merge feature, you can write your letter and include Microsoft Dynamics CRM data. 

More information: Create Customer-Ready Documents and Messages  

Create and send an e-mail activity in the Web application  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: E-mail Permissions  

You can create and send e-mail activities from Microsoft Dynamics CRM from the Activities area. E-mail messages 

sent from Microsoft Dynamics CRM do not appear in the Microsoft Dynamics CRM mail folders in Outlook.  

 

1. Start Microsoft Dynamics CRM 4.0.  

2. In the Navigation Pane, click Workplace, and then click Activities.  

3. On the Actions toolbar, click New.  

4. In the New Activity dialog box, click E-mail, and then click OK.  

5. On the E-mail tab, you must enter the following information.  

 From  

Locate and select the sender's name.  

 To  

Locate and select one or more recipients. You can select a record from a filtered list in the 

Form Assistant pane, or you can click the Lookup button  to search for other records.  

 Subject  

Type a subject for your e-mail message.  

 Duration  

This field is not required, but if you are tracking the amount of time spent on cases, and this 

message is related to a case, enter the amount of time spent on this message.  
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 Due  

If you are not sending your e-mail message immediately, enter a date to complete and send 

the message. The message is not sent automatically.  

 Enter any additional information you want. Use the Formatting toolbar  

You cannot enter HTML tags or insert images into the body text of the message.  

 Tip 

 You can copy and paste content from Microsoft Office Word. This lets you take advantage of 

features such as spelling check and some text formatting. If your text is double-spaced, you 

can press SHIFT+ENTER to single-space lines of text.  

 You can include an image if the file is hosted on a public Web site. Use the copy and paste 

feature of Microsoft Internet Explorer to include a link to the image in the message. The image 

is displayed as long as the recipient has access to the Web site.  

6. You can also attach an article, template, or file to an e-mail activity.  

 To attach an article 

a. To look up and select an article, on the Formatting toolbar, click Insert KB Article.  

b. Use the Search tab to specify conditions or criteria to locate the article.  

c. In the results list, select the article, and then click OK.  

The article appears the body of in your e-mail message.  

d. Type any additional text, or edit the article.  

 To attach an e-mail template 

a. To look up and select an e-mail template, click Insert Template.  

b. On the Insert Template dialog box, select the template you want to use. You can either use 

a global template, or a template specific to the record type you selected as the recipient. For 

example, account or customer.  

c. Click OK. 

The template appears in the body of your e-mail message and the subject line is updated with 

the subject line of the template.  

d. Type any additional text or edit the text provided. Editing the text or subject line in the 

message does not change the template.  

 To attach a file 

a. Save the activity.  

b. On the Attachments tab, click New E-mail Attachment.  

c. In the Add Attachment dialog box, in the File Name box, type the name of the file, or click 

Browse to locate the file that you want to attach.  

d. Click Attach.  
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 To send the message immediately, click Send.  

The message is sent and the new closed activity appears in the History area with an assigned 

message number appended to the Subject column and the date sent in the Actual End column.  

– OR –  

To send the message at a later time, click Save and Close. The new draft activity appears in the 

Activities area. You can delete draft messages.  

To send the message, in the list of activities, open the e-mail activity, and click Send.  

Important 

After you save your e-mail message as a Microsoft Dynamics CRM e-mail activity, the saved message can be accessed 

by anyone who has access to your activities in Microsoft Dynamics CRM.  

Notes 

 You can view the sent date of an e-mail message on the Activities list. The Actual End Date is the 

date the message was sent and closed.  

 You can forward or reply to an e-mail activity, but you cannot resend it.  

To reply to only the original sender, on the Actions toolbar, click Reply.  

To reply to the original sender and to send copies to everyone who originally received the message, 

click Reply All.  

To forward the e-mail activity to new recipients, click Forward, and then select new recipients.  

 There is no spelling checker built into Microsoft Dynamics CRM. There may be third-party solutions 

available. For more information, visit Microsoft Dynamics CRM Solution Finder.  

http://go.microsoft.com/fwlink/?LinkId=98752
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Close an activity  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Common Task Permissions  

 Activity types that can be closed  

 Tasks  

 Faxes  

 Phone Calls  

 Letters  

 Appointments  

 Service Activities  

 Campaign Activities  

Unless you have created an activity record by mistake, it is better to close or convert an activity than to delete it. 

You can view closed or converted activities at a later date for reference, or run reports to determine the success 

rate of your activities.  

 

1. Navigate to activity records. In the Navigation Pane, click Workplace, and then under My Work click 

Activities.  

– OR –  

To work with activities associated with a record, open the record and then click Activities.  

2. Open the activity that you want.  

3. On the Actions  menu, click Close activity type. For example, if you are in a task record, click 

Close Task.  

4. In the confirmation dialog box, select the status that you want from the Status list, such as 

Completed or Canceled, and then click OK.  

Notes 

 When you close an activity, the activity becomes read-only and cannot be edited or reopened.  

 To view closed activities, do one of the following:  

o In the Activities list, select the Closed Activities view.  

o Use Advanced Find, and specify Activity Status in the search criteria.  

o From an Account, Contact, Lead, or Opportunity record, under Details, click History. In the 

Filter on and Include lists, select the view options that you want.  

 It is not possible to close multiple activities at once.  
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 The only way to close an e-mail activity is to send it. If you do not use Microsoft Dynamics CRM to 

send or receive e-mail, click Send. This will close the activity, but no e-mail message will be sent.  

Convert an activity to an opportunity  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Common Task Permissions  

 Activity types that can be converted  

 Faxes  

 Phone Calls  

 E-mail Messages  

 Letters  

 Appointments  

 

 

1. Navigate to activity records. In the Navigation Pane, click Workplace, and then under My Work click 

Activities.  

– OR –  

To work with activities associated with a record, open the record and then click Activities.  

2. Open the activity that you want.  

3. On the Actions toolbar, click Convert Activity, and then click To Opportunity.  

4. In the Convert Activity to Opportunity dialog box, enter information in the following boxes:  

 Customer 

You must click the Lookup button  to select or create a new customer.  

 Source Campaign 

Click Lookup if you want to associate a source campaign with this activity.  

 More Actions 

By default, Microsoft Dynamics CRM automatically completes the following operations during 

the conversion.  

o Close the activity as completed.  

o Open the new opportunity after the conversion.  

o Create a campaign response based on the information included in the opportunity.  

Important  If you are converting an activity to an opportunity that is not associated 

with a Source Campaign, you must clear the Record a closed campaign response 

check box.  

To change the conversion operations, clear the associated check boxes.  

5. In the Convert Activity to Opportunity dialog box, click OK.  
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6. Click Save or Save and Close.  

Note 

The originating activity becomes a related activity for the new opportunity. If the activity is open, it appears in the 

Activities list for the opportunity. If the activity is closed, it appears in the History list.  

Convert an activity to a case  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Common Task Permissions  

 

 

1. Navigate to activity records. In the Navigation Pane, click Workplace, and then under My Work click 

Activities.  

– OR –  

To work with activities associated with a record, open the record and then click Activities.  

2. Open the activity that you want.  

 Activity types that can be converted  

 Faxes  

 Phone Calls  

 E-mail Messages  

 Letters  

 Appointments  

3. On the Actions toolbar, point to Convert Activity and then to Case.  

4. In the Convert Activity to Case dialog box, enter information in the following boxes:  

 Customer 

You must click the Lookup button  to select or create a new customer.  

 By default, Microsoft Dynamics CRM automatically completes the following operations during 

the conversion:  

o Close the activity as completed.  

o Open the new case after the conversion.  

To change the conversion operations, clear the associated check boxes.  

5. In the Convert Activity to Case dialog box, click OK.  

Note 
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The originating activity becomes a related activity for the new case. If the activity is open, it appears in the Activities 

list for the case. If the activity is closed, it appears in the History list.  

Convert an e-mail to a lead  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Common Task Permissions  

 

 

1. Navigate to activity records. In the Navigation Pane, click Workplace, and then under My Work click 

Activities.  

– OR –  

To work with activities associated with a record, open the record and then click Activities.  

2. Open the e-mail activity that you want to convert.  

3. On the Actions toolbar, point to Convert Activity and then to To Lead.  

4. In the Convert E-mail to Lead dialog box, enter information in the following boxes:  

 First Name 

 Last Name 

 Company 

 E-mail Address 

 By default, Microsoft Dynamics CRM automatically completes the following operations during 

the conversion:  

o Open the new lead after the conversion, if all the required information for the lead is 

available. Otherwise this option is not available.  

o Close the e-mail form.  

To change the conversion operations, clear the associated check boxes.  

5. Click OK.  

Notes 

 The originating activity becomes a related activity for the new lead. If the activity is open, it appears in 

the Activities list for the case. If the activity is closed, it appears in the History list.  

 The icon in the Activities list changes.  



 

 

 Microsoft Dynamics CRM 4.0 User’s Guide 147 

 

Assign an activity to a user or queue  

 Can I do this task?  

If the Assign button  is not visible on the toolbar, the security role assigned to your account does 

not have permission to assign this type of record. To check your permissions for a specific record, 

open the record, click the File menu button , and then click Properties.  

More information about specific permissions and performing this task while offline: Common Task 

Permissions  

 

 

1. Navigate to activity records. In the Navigation Pane, click Workplace, and then under My Work click 

Activities.  

– OR –  

To work with activities associated with a record, open the record and then click Activities.  

2. In the list of records, select the record that you want.  

 Or, select multiple records  

 Select several records by pressing the CTRL key while you click each record.  

 Select a sequence of records by clicking the first record that you want, and then press the SHIFT 

key while you select the last record that you want.  

 Select all records on the page by selecting the Select/clear all records on this page check box 

at the top of the list.  

By default, the Microsoft Dynamics CRM Web application displays 50 records per page. You can increase 

the number of records displayed and thereby increase the number of records you can select at one time. To 

display up to a maximum of 250 records per page:  

4. On the Tools menu, click Options.  

5. On the General tab, in the Records Per Page list, select the number of records to display 

per page.  

6. Click OK.  

This changes the number of items that is displayed for all lists, which may slow response time when you 

switch record types. Therefore, you might want to set it back to a smaller number when you are done with 

this bulk action.  

 On the Actions toolbar, click the Assign button .  

 In the Assign to Queue or User dialog box, type all or part of the queue or user name, 

and then click the Lookup button .  

 In the Look Up Records dialog box, in the Look for list, select the type of record you want 

to find.  
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 In the Search for records box, type the first few letters of the name of the record to 

narrow your search, and then click the Find button .  

 In the list of records, click a record to select it, click the Add Selected Records 

button  to add the record to the Selected records list, and then click OK.  

 On the User or Queues form, click OK.  
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Work with Integrated Instant Messaging 

Work with Integrated Instant Messaging  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Common Task Permissions  

If you have Microsoft Office Communicator 2007, MSN Messenger, or Live Messenger installed, you can send an 

instant message to any user, contact, or opportunity, or lead in Microsoft Dynamics CRM with an e-mail address and 

using one of the instant messaging applications listed.  

Note You may need to add the Microsoft Dynamics CRM server URL to the list of Internet Explorer trusted sites for 

the online presence to display. See online Help in Internet Explorer for instructions. 

 Record types and columns that can display online presence 

 Contact records: Full Name  

 Lead records: Primary Contact  

 Opportunity records: Potential Customer  

 All customer records: Users  

 All customer records: Owner  

 All customer records: Modified By  

To access the Communicator menu, click the Online Presence Jewel . 

 A green jewel indicates the person can receive an instant message and is available.  

 A red jewel indicates the person is busy. You can send a message, but they may not respond immediately.  

 A yellow jewel indicates the person is away or out of the office.  

 A peach jewel indicates the person's online status is unknown. There are other communication methods 

available from the menu.  

Enabling online presence 

There are two ways to enable the online presence for a personal view. By adding the associated e-mail address for a 

user or contact, enables online presence on the related column. For example, adding the owner's e-mail column to a 

view, enables the presence on the owner column. See the list above.  

If you do not want to include the e-mail column, you can also customize the view to enable online presence.  

These two example procedures describe how to add a presence to a saved view. If you have the correct permissions, 

you can also edit a system view for an entity to enable the presence. More information: Work with Views  

 To add an e-mail column to a saved view 

a. In the list view you want to add online presence, click Advanced Find.  

b. In the Advanced Find form, click Edit Columns.  

 



 

150 Microsoft Dynamics CRM 4.0 User’s Guide 
 

c. In Common Tasks, click Add Columns  

d. Select one of the e-mail related checkboxes, for example: E-mail.  

e. Click OK twice.  

f. In the Advanced Find form, click Find.  

To save the view, click Back to Query, and then on the Actions toolbar, click Save As. 

 To enable the online presence on a column in a saved view 

a. In the Accounts or Contacts area, click Advanced Find.  

b. In the Advanced Find form, click Edit Columns.  

c. Do one of the following:  

a. Select one of the columns that can display online presence, such as Full Name and 

then click OK.  

b. Select the column, and then click Change Properties.  

c. Select the Enable Presence for this column check box, and then click OK.  

d. To save your changes and close the dialog box, click OK.  

e. In the Advanced Find form, click Find.  

To save the view, click Back to Query, and then on the Actions toolbar, click Save 

As. 

 

Note 

You cannot enable presence on columns for related record types, or on deleted columns. 

Managing E-mail Activities 

You can create, preview, track, and save e-mail messages and relate them to the specific accounts, contacts, cases, 

and other records. These e-mail messages are tracked as activity records, and can be sent to customers and other 

internal users, or saved as drafts for future editing. This helps you create a complete history of your interaction with 

your customers. 

Working with E-mail Activities in Microsoft Dynamics CRM 

You can work with e-mail messages in Microsoft Dynamics CRM in any one of the following areas:  

 Activities area. E-mail messages are listed with the rest of the activities and you can create e-mail 

messages from the toolbar or the New menu.  

More information: Managing Communication Activities 

 Quick Campaign area. You can use the Create Quick Campaign wizard to create and send e-mail 

to advertise products and sales to your customers as part of a marketing campaign. Campaign 

responses appear in the response folder, in addition to the Activities area.  

More information: Understanding Quick Campaigns 

 Workflow area. You can use workflow rules to send customer service-related e-mail messages to 

customers and to the resources and customer service representatives that service the account.  
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More information: Creating and Using Workflows 

 Bulk Mail area. You can create and send e-mail messages to multiple customers at the same time. 

You cannot use attachments with bulk mail.  

More information: Send Direct E-mail to Customers 

 Queues area. You can accept or reassign e-mail messages from a queue. Deleting messages from a 

queue does not delete them from Microsoft Dynamics CRM. More information: Creating Queues for 

Incoming Cases  

Working with E-mail Messages 

How you work with e-mail messages depends on how your organization has set up e-mail. Some organizations chose to 

only use Microsoft Dynamics CRM to record that messages were sent and received, but not actually send or receive 

them from the application. Your organization can also use Exchange to send and receive e-mail. Other organizations 

chose to use Microsoft Dynamics CRM for Outlook to work with messages. How you access your e-mail is determined by 

your administrator and the e-mail access configuration in your user record. 

Working with E-mail Messages Microsoft Dynamics CRM 

If your administrator has set up Microsoft Dynamics CRM to manage your e-mail you can receive, read, reply, forward, 

and attach files and notes to e-mail messages.  

 You cannot resend sent e-mail messages.  

 Customers who have opted out of marketing messages  

 E-mail messages may be sent to customers for whom you do not have a valid e-mail address or who 

have an e-mail address that is associated with more than one record, but doing so may cause an 

alert to appear.  

 Your system administrator can specify settings to manage how Microsoft Dynamics CRM manages e-

mail messages without a valid Microsoft Dynamics CRM customer.  

 You can attach notes and documents to an e-mail message after you save it. 

Working with E-mail Activities in Outlook  

If you prefer to work with your e-mail activities in Outlook you can create and manage e-mail messages from the 

Microsoft Dynamics CRM for Microsoft Office Outlook. By using the Microsoft Dynamics CRM Address Book in Outlook, 

you have access to the e-mail addresses of your customers and other users in your organization.  

View your e-mail in the Microsoft Office Outlook mailbox or in Microsoft Dynamics CRM as a closed e-mail activity. Note 

that if you receive all your e-mail as a Microsoft Dynamics CRM e-mail activity, the activities can be accessed by anyone 

who can view your activities. More information: Sending and Receiving E-mail in Microsoft Dynamics CRM for Outlook 

You can save all or some of your Outlook e-mail messages as Microsoft Dynamics CRM records. Outlook, Microsoft 

Dynamics CRM checks incoming e-mail for messages to save and track based on your personal options. This option can 

be set in the Personal Options dialog box. More information: Set Personal Options  

Working with E-mail Messages from other E-mail Applications 

If your organization has installed the Microsoft Dynamics CRM E-mail Router, you can use an e-mail application other 

than Microsoft Dynamics CRM for Outlook to send and receive your e-mail. If you use a POP3 e-mail system, you need 

to provide your system administrator with a server name and e-mail address to connect.  

More information: Sending and Receiving E-mail in Microsoft Dynamics CRM for Outlook  
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Personal and Organization-wide E-mail Templates 

Microsoft Dynamics CRM provides e-mail templates for the organization. Organization templates are available for 

general use, but only users who have the appropriate administrator privileges can delete or edit them. Microsoft 

Dynamics CRM also gives users personal e-mail templates. Even when a personal template is available for general use, 

only the person who has ownership rights to a personal template can delete or edit it.  

When you create a personal or an organizational e-mail template, you must first pick a template type based on if the e-

mail message will be sent to an account, contact, lead, or other Microsoft Dynamics CRM record type. The template 

type determines which e-mail address or addresses the template uses when the e-mail is sent. Microsoft Dynamics CRM 

checks for specific e-mail addresses depending on the template type that is used.  

More information: Work with E-mail Templates  

E-mail templates for Microsoft Office Word are also available as both personal and organization templates, but are 

managed separately. More information: Work with Mail Merge Templates 

Sending and Receiving E-mail in Microsoft Dynamics CRM for Outlook 

When you are working in Microsoft Dynamics CRM for Microsoft Office Outlook, you can use all the familiar Outlook 

buttons and toolbars with the Microsoft Dynamics CRM toolbar and menu to manage e-mail messages and most other 

activities. At any time, you can track an Outlook e-mail message in Microsoft Dynamics CRM. Tracked messages still 

appear in the Outlook mail folders. There is a personal option setting to change the icon with a Microsoft Dynamics 

CRM Tracked in CRM icon . A copy of the e-mail message is saved as an activity and is available in the Microsoft 

Dynamics CRM Activities area. You can link the activity to a record in Microsoft Dynamics CRM. You can also set your 

personal options so that all incoming e-mail is tracked in Microsoft Dynamics CRM.  

More information: Set Personal Options 

Important 

Because Microsoft Dynamics CRM shares data between users, many of the default privacy assumptions of a full e-mail 

system do not apply. This means that an e-mail activity that is associated with a Microsoft Dynamics CRM record as a 

regarding record (for example, a case, account, or contact) has the same visibility as any other activity associated with 

that record, and any user who has access to the record and its associated activities also has access to the e-mail 

message. 

Managing Incoming E-mail 

When you use Microsoft Dynamics CRM for Outlook, all the e-mail you receive arrives in your Outlook Inbox, and only 

e-mail that originated as a Microsoft Dynamics CRM e-mail activity (that is, a response to e-mail you send from 

Microsoft Dynamics CRM), or that is marked as tracked in Microsoft Dynamics CRM, arrives in the Microsoft Dynamics 

CRM Activities and My Work: Queues area. If you prefer, you can:  

 Track all incoming e-mail as Microsoft Dynamics CRM e-mail activities.  

 Track only e-mail that originated in Microsoft Dynamics CRM (that is, e-mail sent in response to a 

Microsoft Dynamics CRM e-mail activity) into Microsoft Dynamics CRM e-mail activities.  

 Track only e-mail related to your accounts, contacts, or leads.  

If you choose not to track all incoming e-mail, you can manually track selected messages in Outlook as e-mail activities 

in Microsoft Dynamics CRM.  

However, if you track all your e-mail messages as Microsoft Dynamics CRM e-mail activities, they can be accessed by 

anyone who has permission to view or work with your activities. Also, when you track an e-mail message with 

attachments to a Microsoft Dynamics CRM activity, the attachments are included in the activity. If you do not want 

these attachments to be available to other users, delete them from the e-mail activity. 

More information: Save Outlook Contacts, Tasks, and E-mail Messages as Microsoft Dynamics CRM Records 
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Sending and Replying to E-Mail Messages 

You can link Microsoft Dynamics CRM e-mail activities to active contacts, accounts, leads, facilities, equipment, queues, 

or users in Microsoft Dynamics CRM. You can select active Microsoft Dynamics CRM records with e-mail addresses from 

the Microsoft Dynamics CRM address book, which is installed automatically when you install Microsoft Dynamics CRM 

for Outlook. E-mail activities can also be tracked in Microsoft Dynamics CRM without being related to another record. 

Microsoft Dynamics CRM  

When you send, reply, or forward an e-mail that is tracked as a e-mail activity, a closed activity is created for each 

account and contact referenced and displayed in the History area. Closed e-mail activities cannot be updated except to 

link them to a related Microsoft Dynamics CRM record. If a related record has not already been selected, you have the 

option of select one.  

More information: Managing E-mail Activities 

Working with Microsoft Dynamics CRM for Outlook with Offline Access 

Offline and Synchronizing with Microsoft Dynamics CRM 

If you install Microsoft Dynamics CRM for Outlook with Offline Access, you have the option of working offline from the 

Microsoft Dynamics CRM server. You can create Microsoft Dynamics CRM e-mail messages that are sent when you go 

back online. If you send Outlook e-mail messages, those are sent immediately.  

More information: Synchronizing Information 

When you are working with Microsoft Dynamics CRM for Outlook with Offline Access offline, if you create and send an 

e-mail message and the message fails to be delivered or is blocked, for example, because the recipient does not want 

to receive e-mail or the mail server is down, the e-mail is saved to your Drafts folder in Outlook, but a closed Microsoft 

Dynamics CRM activity is created. In Microsoft Dynamics CRM, you can use the Pending E-mail view to unsent 

messages. When you are working offline, Microsoft Dynamics CRM e-mail messages that you send are saved to your 

Outlook offline queue, and when you go online, Microsoft Dynamics CRM automatically tries to send them and create 

the activities. If an e-mail message cannot be sent, it is saved in Microsoft Dynamics CRM as a draft activity, but does 

not appear in your Drafts folder in Outlook. 

More information: Working Offline 

Using the Microsoft Dynamics CRM Address Book 

You can use the Microsoft Dynamics CRM address book to select records from Microsoft Dynamics CRM in Outlook. The 

address book includes accounts, contacts, facilities/equipment, leads, queues, and users. You can access the Microsoft 

Dynamics CRM address book from the same menu as your other Outlook address books and use it in the same way.  

The address book is also used to reconcile e-mail recipients in incoming messages to Microsoft Dynamics CRM contacts 

and link them automatically. How the contacts are matched is set in your personal options. 

More information: Set Personal Options 
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Work with E-mail Activities 

and send an e-mail activity in the Web application  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: E-mail Permissions  

You can create and send e-mail activities from Microsoft Dynamics CRM from the Activities area. E-mail messages sent 

from Microsoft Dynamics CRM do not appear in the Microsoft Dynamics CRM mail folders in Outlook.  

 

1. Start Microsoft Dynamics CRM 4.0.  

2. In the Navigation Pane, click Workplace, and then click Activities.  

3. On the Actions toolbar, click New.  

4. In the New Activity dialog box, click E-mail, and then click OK.  

5. On the E-mail tab, you must enter the following information.  

 From  

Locate and select the sender's name.  

 To  

Locate and select one or more recipients. You can select a record from a filtered list in the 

Form Assistant pane, or you can click the Lookup button  to search for other records.  

 Subject  

Type a subject for your e-mail message.  

 Duration  

This field is not required, but if you are tracking the amount of time spent on cases, and this 

message is related to a case, enter the amount of time spent on this message.  

 Due  

If you are not sending your e-mail message immediately, enter a date to complete and send 

the message. The message is not sent automatically.  

 Enter any additional information you want. Use the Formatting toolbar  

You cannot enter HTML tags or insert images into the body text of the message.  

 Tip 

 You can copy and paste content from Microsoft Office Word. This lets you take advantage of 

features such as spelling check and some text formatting. If your text is double-spaced, you 

can press SHIFT+ENTER to single-space lines of text.  

 You can include an image if the file is hosted on a public Web site. Use the copy and paste 

feature of Microsoft Internet Explorer to include a link to the image in the message. The image 

is displayed as long as the receipient has access to the Web site.  

6. You can also attach an article, template, or file to an e-mail activity.  
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 To attach an article 

a. To look up and select an article, on the Formatting toolbar, click Insert KB Article.  

b. Use the Search tab to specify conditions or criteria to locate the article.  

c. In the results list, select the article, and then click OK.  

The article appears the body of in your e-mail message.  

d. Type any additional text, or edit the article.  

 To attach an e-mail template 

a. To look up and select an e-mail template, click Insert Template.  

b. On the Insert Template dialog box, select the template you want to use. You can either use 

a global template, or a template specific to the record type you selected as the recipient. For 

example, account or customer.  

c. Click OK. 

The template appears in the body of your e-mail message and the subject line is updated with 

the subject line of the template.  

d. Type any additional text or edit the text provided. Editing the text or subject line in the 

message does not change the template.  

 To attach a file 

a. Save the activity.  

b. On the Attachments tab, click New E-mail Attachment.  

c. In the Add Attachment dialog box, in the File Name box, type the name of the file, or click 

Browse to locate the file that you want to attach.  

d. Click Attach.  

 To send the message immediately, click Send.  

The message is sent and the new closed activity appears in the History area with an assigned 

message number appended to the Subject column and the date sent in the Actual End column.  

– OR –  

To send the message at a later time, click Save and Close. The new draft activity appears in the 

Activities area. You can delete draft messages.  

To send the message, in the list of activities, open the e-mail activity, and click Send.  

Important 

After you save your e-mail message as a Microsoft Dynamics CRM e-mail activity, the saved message can be accessed 

by anyone who has access to your activities in Microsoft Dynamics CRM.  

Notes 
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 You can view the sent date of an e-mail message on the Activities list. The Actual End Date is the 

date the message was sent and closed.  

 You can forward or reply to an e-mail activity, but you cannot resend it.  

To reply to only the original sender, on the Actions toolbar, click Reply.  

To reply to the original sender and to send copies to everyone who originally received the message, 

click Reply All.  

To forward the e-mail activity to new recipients, click Forward, and then select new recipients.  

 There is no spelling checker built into Microsoft Dynamics CRM. There may be third-party solutions 

available. For more information, visit Microsoft Dynamics CRM Solution Finder.  

Create an e-mail message in Outlook  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: E-mail Permissions  

You can create e-mail messages in Microsoft Office Outlook by using either the Microsoft Dynamics CRM forms or 
the Outlook forms. By default, the e-mail messages that have been marked for tracking are synchronized in 
Microsoft Dynamics CRM for Outlook and Microsoft Dynamics CRM, and when you reply to or forward an e-mail 
message from this message, the Outlook forms open. The option that allows you to chose which form to use does 
not affect this. 

 

1. Start Outlook. (Microsoft Dynamics CRM for Outlook must be installed.)  

2. Do one of the following:  

 Create an e-mail message in an Outlook form 

1. On the Microsoft Office Outlook Standard toolbar, click New.  

2. In the New menu, click Mail Message.  

3. In the Outlook form, you can use either your Outlook contacts or your Microsoft Dynamics CRM 

contacts. For more information, see Microsoft Office Outlook Help.  

4. On the Microsoft Dynamics CRM toolbar, click Track in CRM. 

After you send the message, the View in CRM button becomes available.  

5. Do one of the following to locate and select a parent record to link to this record:  

 In Microsoft Office Outlook 2003, click Regarding.  

 In Microsoft Office Outlook 2007, click Set Parent or Set Regarding.  

6. On the Outlook toolbar, click Send.  

The e-mail message appears in your Microsoft Dynamics CRM folders. The icon changes to the 

Track in CRM button . The sent e-mail activity is saved as a Microsoft Dynamics CRM e-mail 

activity and appears in the Microsoft Dynamics CRM Activities area.  

An e-mail activity is not created until the message is sent.  

To view the contact record, on the Microsoft Dynamics CRM toolbar click, View in CRM.  

 Create an e-mail message in a form 
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This procedure does not create an Outlook e-mail message. These e-mail messages only appear in the 

Microsoft Dynamics CRM for Outlook folders and do not appear the Outlook Sent Items folder.  

You can edit a draft e-mail message by following steps 1 through 2 to navigate to the Activities area in 

Microsoft Dynamics CRM for Outlook. Then, open the record you want to edit.  

1. In the Outlook Navigation Pane, under Microsoft Dynamics CRM, expand Workplace.  

2. Under Workplace, expand My Work, and then expand Activities.  

3. In the Activities area, on the Actions  menu, click New.  

4. In the New Activity dialog box, click E-mail, and then click OK.  

5. On the E-mail tab, you must enter the following information.  

 From  

Locate and select the sender's name.  

 To  

Locate and select one or more recipients. You can select a record from a filtered list in 

the Form Assistant pane, or you can click the Lookup button  to search for other 

records.  

 Subject  

Type a subject for your e-mail message.  

 Duration  

This field is not required, but if you are tracking the amount of time spent on cases, and 

this message is related to a case, enter the amount of time spent on this message.  

 Due  

If you are not sending your e-mail message immediately, enter a date to complete and 

send the message. The message is not sent automatically.  

 Enter any additional information you want. Use the Formatting toolbar  

You cannot enter HTML tags or insert images into the body text of the message.  

 Tip 

 You can copy and paste content from Microsoft Office Word. This lets you take 

advantage of features such as spelling check and some text formatting. If your 

text is double-spaced, you can press SHIFT+ENTER to single-space lines of text.  

 You can include an image if the file is hosted on a public Web site. Use the copy 

and paste feature of Microsoft Internet Explorer to include a link to the image in 

the message. The image is displayed as long as the receipient has access to the 

Web site.  

6. You can also attach an article, template, or file to an e-mail activity.  

 To attach an article 

a. To look up and select an article, on the Formatting toolbar, click Insert KB 

Article.  
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b. Use the Search tab to specify conditions or criteria to locate the article.  

c. In the results list, select the article, and then click OK.  

The article appears the body of in your e-mail message.  

d. Type any additional text, or edit the article.  

 To attach an e-mail template 

a. To look up and select an e-mail template, click Insert Template.  

b. On the Insert Template dialog box, select the template you want to use. You 

can either use a global template, or a template specific to the record type you 

selected as the recipient. For example, account or customer.  

c. Click OK. 

The template appears in the body of your e-mail message and the subject line is 

updated with the subject line of the template.  

d. Type any additional text or edit the text provided. Editing the text or subject line in 

the message does not change the template.  

 To attach a file 

a. Save the activity.  

b. On the Attachments tab, click New E-mail Attachment.  

c. In the Add Attachment dialog box, in the File Name box, type the name of the 

file, or click Browse to locate the file that you want to attach.  

d. Click Attach.  

 To send the message immediately, click Send.  

The message is sent and the new closed activity appears in the History area with an assigned 

message number appended to the Subject column and the date sent in the Actual End column.  

– OR –  

To send the message at a later time, click Save and Close. The new draft activity appears in the 

Activities area. You can delete draft messages.  

To send the message, in the list of activities, open the e-mail activity, and click Send.  

Important: If you are working offline, e-mail messages sent from the e-mail form will not be 

sent until you go back online. The status will still be Closed. You can view a list of unsent e-mail 

from the Activities list, with the My Pending E-mails view. 

Important 

After you save your e-mail message as a Microsoft Dynamics CRM e-mail activity, the saved message can be accessed 

by anyone who has access to your activities in Microsoft Dynamics CRM.  

Notes 



 

 

 Microsoft Dynamics CRM 4.0 User’s Guide 159 

 

 After a message is sent, the status is changed to Closed and displayed in the History folder. You 

cannot change the status or edit the message, except to link a record in the Regarding box, if one 

has not been selected.  

 You can forward or reply to an e-mail activity, but you cannot resend it.  

To reply to only the original sender, on the Actions toolbar, click Reply.  

To reply to the original sender and to send copies to everyone who originally received the message, 

click Reply All.  

To forward the e-mail activity to new recipients, click Forward, and then select new recipients.  

Create a quick campaign  

 Can I do this task?  

This task requires permissions that are found in all default marketing security roles. More information 
about specific permissions and performing this task while offline: Marketing Permissions  

You can use quick campaigns to create one type of activity for many accounts, contacts, or leads at once.  

 

1. Select the records or list you want to run a quick campaign on, and then start the Create Quick 

Campaign Wizard.  

 From a list of records, including the results of a search You can run a quick campaign from any list of accounts, 

contacts, or leads.  

a. Select the record or records for which you want to create a quick campaign. If you want to include all 

records on the current page or all records on all pages, then skip this step.  

b. On the Actions toolbar, click Create Quick Campaign , and then click one of the following:  

 For Selected Records  

Select this option if you have selected one or more records in the list.  

 For All Records on Current Page  

Select this option to include all records on the page for the quick campaign activity.  

 For All Records on All Pages  

Select this option to include all records on all pages for the quick campaign activity.  

 From the Marketing Lists list You can run a quick campaign on one or more marketing lists in the Marketing 

Lists list.  

a. In the Navigation Pane, click Marketing or Sales, and then click Marketing Lists.  

b. Select the marketing list or marketing lists for which you want to create a quick campaign.  

c. On the Actions toolbar, click Create Quick Campaign, and then click For Selected Records.  

 From a marketing list You can run a quick campaign on the accounts, contacts, or leads in any marketing list.  

a. In the Navigation Pane, click Marketing or Sales, and then click Marketing Lists.  

b. Double-click the marketing list for which you want to create a quick campaign.  

c. On the Actions toolbar, click Create Quick Campaign.  

4. In the Create Quick Campaign Wizard, follow the instructions to create the quick campaign.  
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Notes 

 You cannot add additional records to a quick campaign after you have created it.  

 In the Create Quick Campaign Wizard, you can select who you want Microsoft Dynamics CRM to 

assign the activity to and whether Microsoft Dynamics CRM should perform the activity automatically 

for appropriate activities (such as sending e-mail messages). This choice affects who can see and 

take action on an activity. For example, if you were creating a phone call activity for all of the sales 

representatives, you could select the phone call activity, and then select The owners of the 

records that are included in the quick campaign. Each sales representative could then see the 

activity and take action on it. However, if you were creating a large number of e-mail activities that 

Microsoft Dynamics CRM would perform automatically, you could assign the e-mail activity to 

yourself instead of the record owners.  

 Whether or not some activities are performed automatically depends on an option available to users 

who have the Organization Settings Write privilege. More information: Manage System Settings  

Resolve red text in e-mail message addresses  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: E-mail Permissions  

E-mail messages that appear as red text with the Unresolved Address button  cannot be matched to records 

in Microsoft Dynamics CRM. These messages contain e-mail addresses that are either not related to a user, 

account, contact or lead record, or are related to multiple records. You can either match the e-mail address to an 

existing record or create a new one. 

 

1. Open the message.  

2. Double-click the unresolved e-mail address.  

3. In the Resolve Address dialog box, do one of the following procedures:  

 If the e-mail address belongs to an existing user, account, contact, or lead 

 Click Resolve to an existing record. Click the Lookup button  to search for records.  

 If the e-mail address is not in the system  

a. Click Resolve to a new record, select a record type, and then click Go.  

b. Complete the form, and then click OK  

 Click OK.  
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Set the option to send and receive e-mail from a user or queue  

 Can I do this task?  

This task requires a manager, vice president, CEO-Business Manager, System Administrator, or 
System Customizer security role or equivalent permissions. More information about specific 
permissions and performing this task while offline: E-mail Permissions  

If this option is not set correctly, e-mail is not sent and a warning message "This message has not been submitted 

for delivery" appears. 

 

1. In the Navigation Pane, click Settings, click Administration, and then click Users.  

– OR –  

In the Navigation Pane, click Settings, click Business Management, and then click Queues.  

2. Open the user or queue you want to modify.  

3. Under E-mail Access Configuration, select how e-mail will be accessed for incoming and outgoing 

mail.  

 None  

E-mail will not be sent or received.  

 Forward Mailbox  

E-mail will be forwarded from another e-mail address.  

 Microsoft Dynamics CRM for Outlook  

E-mail is sent and received with Microsoft Dynamics CRM for Outlook.  

 E-mail Router  

E-mail is sent and received with the Microsoft Dynamics CRM E-mail Router. If this item is 

selected, the Allow credentials check box is displayed. To require that credentials be 

entered, select the check box.  

4. Click Save or Save and Close.  

Notes 

 If you have selected an e-mail option, verify that there is a valid e-mail address in the E-mail box.  

 If you select Microsoft Dynamics CRM for Outlook as your e-mail option, you must also allow 

Microsoft Dynamics CRM to send mail through Microsoft Dynamics CRM for Outlook.  
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Convert an e-mail to a lead  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Common Task Permissions  

 

 

1. Navigate to activity records. In the Navigation Pane, click Workplace, and then under My Work click 

Activities.  

– OR –  

To work with activities associated with a record, open the record and then click Activities.  

2. Open the e-mail activity that you want to convert.  

3. On the Actions toolbar, point to Convert Activity and then to To Lead.  

4. In the Convert E-mail to Lead dialog box, enter information in the following boxes:  

 First Name 

 Last Name 

 Company 

 E-mail Address 

 By default, Microsoft Dynamics CRM automatically completes the following operations during 

the conversion:  

o Open the new lead after the conversion, if all the required information for the lead is 

available. Otherwise this option is not available.  

o Close the e-mail form.  

To change the conversion operations, clear the associated check boxes.  

5. Click OK.  

Notes 

 The originating activity becomes a related activity for the new lead. If the activity is open, it appears in 

the Activities list for the case. If the activity is closed, it appears in the History list.  

 The icon in the Activities list changes.  
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Convert an activity to a case  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Common Task Permissions  

 

 

1. Navigate to activity records. In the Navigation Pane, click Workplace, and then under My Work click 

Activities.  

– OR –  

To work with activities associated with a record, open the record and then click Activities.  

2. Open the activity that you want.  

 Activity types that can be converted  

 Faxes  

 Phone Calls  

 E-mail Messages  

 Letters  

 Appointments  

3. On the Actions toolbar, point to Convert Activity and then to Case.  

4. In the Convert Activity to Case dialog box, enter information in the following boxes:  

 Customer 

You must click the Lookup button  to select or create a new customer.  

 By default, Microsoft Dynamics CRM automatically completes the following operations during 

the conversion:  

o Close the activity as completed.  

o Open the new case after the conversion.  

To change the conversion operations, clear the associated check boxes.  

5. In the Convert Activity to Case dialog box, click OK.  

Note 

The originating activity becomes a related activity for the new case. If the activity is open, it appears in the Activities 

list for the case. If the activity is closed, it appears in the History list.  

Work with E-mail Templates 

E-mail templates provide boilerplate text and Microsoft Dynamics CRM data for e-mail messages. These templates 

cannot be used with Microsoft Office Word mail merges.  
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Concepts:  

 Managing E-mail Activities  

 Work with Mail Merge Templates  

Create or edit an e-mail template  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: E-mail Permissions  

An e-mail template is attached to an e-mail message after it is created. The template that can be attached to an e-

mail depends on which type of record the template is related to. For example, you can only attach a case e-mail 

template to an e-mail activity created from a case record. Global templates are available for any record type. You can 

create personal templates that are available only to you, or organizational templates that are available to anyone in 

your organization. 

You cannot add an attachment to a template. You can either attach files to individual messages after they are created 

with the template, or save the file to a public Web site and include a Web address in the template.  

This feature is not available in Microsoft Dynamics CRM for Outlook. Use Microsoft Office Word mail merge templates 

instead. More information: Create Customer-Ready Documents and Messages 

 

1. Do one of the following.  

 To work with organization templates  

a. In the Navigation Pane, click Settings, click Templates, and then click E-mail Templates.  

– OR –  

 To work with personal templates  

 On the Tools menu, click Options, and then click the E-mail Templates tab.  

 On the Actions toolbar, click New.  

 In the E-Mail Template dialog box, in the Template Type list, select the type, and then 

click OK.  

Important The template is available only for the selected record type, such as a lead or 

opportunity. This cannot be changed. To use the same content for another record type, create a 

new template.  

 On the E-mail Templates form, you must enter the following information.  

 Title  

Enter a meaningful and descriptive title for the template. The title displays in the list of 

templates.  

 Subject  

Enter the subject of the e-mail message created with this template. This appears as the 

Subject line in the e-mail message and overwrites the existing text.  



 

 

 Microsoft Dynamics CRM 4.0 User’s Guide 165 

 

 You can enter a description of the template. This is not displayed to the recipient.  

 Enter the text you want to send in this message. Use the Formatting toolbar to edit the text.  

 Tips 

 Although you cannot insert images or HTML directly into Microsoft Dynamics CRM e-mail 

messages or e-mail templates, you can use the copy feature in Internet Explorer to copy an image 

from a Web site and paste it into the e-mail message or e-mail template. The image is available as 

long as the Web site is accessible.  

 To include a hyperlink in an e-mail template, type the URL including the http://, for example, 

http://www.microsoft.com and then press Enter. Do not include a period or comma or a space 

after the URL, or the link will break. A link is automatically added to the URL and the text is 

underlined and changed to blue.  

 There is no spelling checker built into Microsoft Dynamics CRM. There may be third-party solutions 

available. For more information, visit Microsoft Dynamics CRM Solution Finder.  

 The Formating toolbar has limited fonts and font sizes. However, you can copy and paste content 

from Microsoft Office Word. This allows you to take advantage of features such as spell checking 

and some advanced text formatting. To single-space a line of text, at the end of the line press 

Shift+Enter.  

 To insert data fields to display information such as a customer's name or data from a quote, 

from Microsoft Dynamics CRM records, in the Actions  toolbar, click Insert/Update, and then 

in the Data Field Values dialog box, click Add. In the Add Data Value dialog box, select the 

Record Type and Field and then click OK. Click OK again to insert the data.  

 Tip 

Use the Default Text box to define what text displays if the record does not have data for the field. 

 Click Save or Save and Close.  

 If necessary, click OK to close the Set Personal Options dialog box.  

Notes 

 To change a shared template to a personal one or to a shared one, on the template form, on the 

Actions  menu, click Revert to Personal Template or click Make Template Available to 

Organization.  

 If you use an e-mail template as a signature in addition to another template, insert the signature 

template first, otherwise, the Subject line will be overwritten.  

http://go.microsoft.com/fwlink/?LinkId=98752
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Add and edit the data fields in an e-mail template  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: E-mail Permissions  

 

 

Data fields are used with e-mail templates in the Web application. You can use custom fields, attributes, and 

entities with e-mail templates.  

This procedure does not work for Microsoft Office Word mail merge templates. You can use Microsoft Office Word 

templates. 

 

1. In the e-mail template, on the Form toolbar, click Insert/Update.  

2. In the Data Field Values dialog box, do one of the following:  

 To add a field, click Add, and then in the Add Data Value dialog box, select the record type 

and field you want to add, and then click OK.  

The field appears in the Data Field Values list.  

 To change the order in which your data fields appear, select the field, and then click Move 

Up or Move Down.  

 To provide substitute text for a field if there is no data, select the field, and then type the text 

in the Default Text box.  

 To remove a data field, select the field, and then click Delete.  

 To insert the data fields into the e-mail template, click OK.  

3. You can change the format for text displayed in a data field. Select the field, double-click the text, and 

then highlight the yellow text in the field, and then make the changes you want. If you select the 

field itself, you will not be able to reformat the text it contains because format changes must be 

applied directly to text and not to a field as a whole.  

4. Click Save or Save and Close.  

Important 

 If you want multiple data fields to appear on your template, you must add each data field individually 

and for one record type at a time. For example, if you want to create data fields for the first name 

and last name, you must perform step 2 twice, once to create a data field for the first name, and 

again to create a data field for the last name. If you add multiple data fields at once, Microsoft 

Dynamics CRM automatically adds a semicolon (;) between each data field and treats it as an 

EITHER/OR statement. Using the example of first name and last name, Microsoft Dynamics CRM 

looks for a first name, and if one is available, displays it. If a first name is not available, Microsoft 

Dynamics CRM then looks for a last name, and displays it. It will not display both names.  

 If you want to include data from different record types, repeat step 2 and select a different record 

type. 
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Increasing Your Efficiency 

Personalizing Microsoft Dynamics CRM 

Configuring Personal Options 

Viewing Your User Information 

In Microsoft Dynamics CRM you can view your personal information in your personal profile, though you may not be 

able to update it. This information includes your name, contact information, working hours, the teams and resource 

groups you belong to, as well as the services you can perform. You can also review your security roles. Understanding 

your security role is key to knowing what you can and cannot view, create, or edit in Microsoft Dynamics CRM.  

Personalizing Microsoft Dynamics CRM  

Every user has the option of configuring his or her personal workspace within Microsoft Dynamics CRM. You can change 

how Microsoft Dynamics CRM displays information, including:  

 What links appear in your Workplace  

 How many records display in lists  

 Your language preferences  

 How to display numbers and dates  

More information: View Your User Profile 

Creating Personal Views 

You can create personal views of lists by creating custom Advanced Find queries and then saving them as views. 

More information: Find Things 

Managing Your E-mail 

You can create personal e-mail templates that you can reuse with your e-mail messages. If you are using an e-mail 

service other than Microsoft Dynamics CRM for Microsoft Office Outlook, you can update your e-mail password. 

More information: Managing E-mail Activities 

Synchronizing with Microsoft Dynamics CRM  

If you use Microsoft Dynamics CRM for Outlook, you can change how Microsoft Dynamics CRMlooks for you as well as 

what information is synchronized and how often.  

More information: Synchronizing Information 

Set Personal Options 

You can set your personal options for Microsoft Dynamics CRM and Microsoft Dynamics CRM for Outlook. Not all options 

are available for both the Web application and Microsoft Dynamics CRM for Outlook.  
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View your user profile  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Common Task Permissions  

Your user profile displays information about you, including general information such as your contact information and 

addresses, what teams and resource groups you belong to, which services you can perform, and your work hours and 

security roles. This information is visible to the entire organization. Depending on your security role, you may be able 

to make changes to your user profile. 

If you are working in Microsoft Dynamics CRM for Outlook, you can view this information from the User form. More 

information: Work with Your User Record and Work Hours  

 

1. Under Workplace, click the Personalize Workplace link.  

2. In the Set Personal Options dialog box, click the General tab.  

3. At the bottom of the page, click the View your user profile here link. 

The User form with your information opens.  

4. To view details or make changes, under Details or Service click any of the following:  

 Teams 

 Roles 

 Quotas 

 Work Hours 

 Services 

 Resource groups 

 Workflows 

5. To close the form, on the File menu, click Close.  

6. To close the Set Personal Options dialog box, click OK.  

Set start page and view options  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Common Task Permissions  

You can update the options that determine how Microsoft Dynamics CRM displays information. Not all settings on 

this tab are available in Microsoft Dynamics CRM for Outlook.  

 

1. Under Workplace, click the Personalize Workplace link.  

– OR –  

In Outlook, in the Microsoft Dynamics CRM menu bar, click Options.  
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2. In the Set Personal Options dialog box, on the General tab, you can set any of the following 

options:  

 Select activity forms used by Microsoft CRM client for Outlook 

Select the forms that you want to use to create activities in Microsoft Dynamics CRM for 

Outlook.  

 Default Pane 

Select the area that you want to display when you open Microsoft Dynamics CRM. This option 

is not available in Outlook.  

 Default Tab 

Select the tab that you want to display when you open Microsoft Dynamics CRM. This option 

is not available in Outlook.  

 Records Per Page 

Select the number of records you want to display in a list. The number of records displayed 

can affect the performance of Microsoft Dynamics CRM.  

 Advanced Find Mode  

Select the display mode for Advanced Find, which also affects Microsoft Dynamics CRM for 

Outlook data groups, and report filtering. The Simple mode only lets you change the values. 

The Detailed mode displays the Filter toolbar and lets you add additional criteria.  

 Time Zone 

If you are in a different time zone than the rest of your organization, select the time zone for 

your current location. This option is not available in Outlook.  

If you are using the Microsoft Dynamics CRM for Outlook, we recommend that the Microsoft 

Dynamics CRM time zone be set to the same time zone as Outlook, otherwise issues with 

mismatched times and dates could occur.  

 Currency 

Click the Lookup button  to select the currency to display.  

 View your user profile here 

Click the View your user profile here link to view your user record in Microsoft Dynamics 

CRM. This option is not available in Outlook.  

 Always run the Microsoft Dynamics CRM application hoster process 

Select this check box if you want Microsoft Dynamics CRM for Outlook to run continuously in 

the background, even if Outlook is not running. This will improve how quickly pages are 

displayed. This option is not available in the Web application.  

 Enable high contrast 

Select this check box if you have turned on High Contrast settings in either your browser or 

operating system. This option improves the display of buttons and icons for accessiblity.  

3. To save your changes and close the dialog box, click OK.  
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Set synchronization options in Microsoft Dynamics CRM for Outlook  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Common Task Permissions  

You can select which record types you want to synchronize between Outlook and Microsoft Dynamics CRM for 
Outlook and how often you want to synchronize between applications. This tab is not available in the Web 
application.  

 

1. Start Outlook. (Microsoft Dynamics CRM for Outlook must be installed.)  

2. On the Microsoft Dynamics CRM menu bar, click Options.  

3. In the Set Personal Options dialog box, on the Synchronization tab, you can select which record 

types are synchronized:  

 Appointments I'm attending 

Select this option if you want to synchronize appointments and service activities in which you 

are a participant and have accepted the appointment.  

 My tasks  

Select this option if you want to synchronize tasks that you own in Microsoft Dynamics CRM.  

 Contacts 

Select this option if you want to synchronize contacts that you own in Microsoft Dynamics 

CRM. 

If you delete a contact you own in Microsoft Dynamics CRM or in Microsoft Dynamics CRM for 

Outlook, it will not be deleted in the other application.  

 My phone calls 

Select this option if you want to synchronize phone calls that you own in Microsoft Dynamics 

CRM.  

 My letters 

Select this option if you want to synchronize letters that you own in Microsoft Dynamics CRM.  

 My faxes 

Select this option if you want to synchronize faxes that you own in Microsoft Dynamics CRM.  

4. If you want to include company names from Outlook contacts, select Update Company fields with 

parent account names.  

Important: This setting only affects newly tracked contacts. Future changes are not synchronized.  

5. If you have more than one computer running Microsoft Dynamics CRM for Outlook, select this 

computer to be the synchronizing client.  

6. If your organization permits it, you can define how often Microsoft Dynamics CRM items in your 

Microsoft Dynamics CRM for Outlook folders are updated:  

 Synchronize the CRM items in my Outlook folders every 

Select this option and select the number of minutes. You can increase the amount of time 

between synchronization of items in your Microsoft Dynamics CRM for Outlook folders. Your 

administrator sets the minimum time allowed between synchronization.  

7. Select how duplicates are handled during synchronization:  
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 Create the duplicates 

This option allows records to be created even if key fields contain the same data. 

More information: Avoiding Duplicate Records  

 Do not create duplicates 

This option blocks records from being created if key fields contain the same data.  

8. To save your changes and close the dialog box, click OK.  

Set Workplace pane options  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Common Task Permissions  

You can select which areas and record types are displayed in the Navigation Pane when you view your 

Workplace. By default, the My Work area and the Customers area appear in the Navigation Pane in both 

Microsoft Dynamics CRM and Microsoft Dynamics CRM for Outlook.  

 

1. Under Workplace, click the Personalize Workplace link.  

– OR –  

In Outlook, in the Microsoft Dynamics CRM menu bar, click Options.  

2. In the Set Personal Options dialog box, on the Workplace tab, select the areas you want to 

display. The Preview pane displays each area and its sub-areas.  

 Sales 

This area displays marketing list, orders, invoices, leads, opportunity, and quotes.  

 Marketing 

This area displays marketing lists, campaigns, and quick campaigns.  

 Service 

This area displays cases, contracts, and the knowledge base.  

 Scheduling 

This area displays the Service calendar. 

The option to select this area is not available in the Microsoft Dynamics CRM for Outlook, but 

the area displays.  

3. To save your changes and close the dialog box, click OK.  
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Set Activities options  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Common Task Permissions  

You can set the default view for your Workplace calendar, and set your working hours. This tab is not available in 

Microsoft Dynamics CRM for Outlook.  

 

1. Under Workplace, click the Personalize Workplace link.  

2. In the Set Personal Options dialog box, on the Activities tab, you can make changes to the 

following options:  

 Default Calendar 

Select whether you want your default calendar view to be by day, week, or month.  

 Start Time and End Time 

Select the time you start and end your work day. This affects scheduling and your calendars.  

3. To save your changes and close the dialog box, click OK.  

Set regional options for yourself  

You can control how Microsoft Dynamics CRM displays numbers, currencies, times, and dates in your account.  

 Can I do this task?  

This task requires permissions that are found in all default security roles. This task can be performed 
only in the Web application. More information: Common Task Permissions  

 

 

1. Under Workplace, click the Personalize Workplace link.  

– OR –  

In Outlook, in the Microsoft Dynamics CRM menu bar, click Options.  

2. Click the Formats tab.  

3. From the Current Format list, select the name of the language and region that corresponds to the 

format you want to use.  

4. To save your changes and close the dialog box, click OK.  

Tip 

In addition to selecting a predefined combination of language and region, you can also personalize number, 

currency, time, and date formats. To personalize these formats, click Customize. 
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Create or edit an e-mail template  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: E-mail Permissions  

An e-mail template is attached to an e-mail message after it is created. The template that can be attached to an 

e-mail depends on which type of record the template is related to. For example, you can only attach a case e-mail 

template to an e-mail activity created from a case record. Global templates are available for any record type. You 

can create personal templates that are available only to you, or organizational templates that are available to 

anyone in your organization. 

You cannot add an attachment to a template. You can either attach files to individual messages after they are 

created with the template, or save the file to a public Web site and include a Web address in the template.  

This feature is not available in Microsoft Dynamics CRM for Outlook. Use Microsoft Office Word mail merge 

templates instead. More information: Create Customer-Ready Documents and Messages 

 

1. Do one of the following.  

 To work with organization templates  

a. In the Navigation Pane, click Settings, click Templates, and then click E-mail Templates.  

– OR –  

 To work with personal templates  

 On the Tools menu, click Options, and then click the E-mail Templates tab.  

 On the Actions toolbar, click New.  

 In the E-Mail Template dialog box, in the Template Type list, select the type, and then 

click OK.  

Important The template is available only for the selected record type, such as a lead or 

opportunity. This cannot be changed. To use the same content for another record type, create a 

new template.  

 On the E-mail Templates form, you must enter the following information.  

 Title  

Enter a meaningful and descriptive title for the template. The title displays in the list of 

templates.  

 Subject  

Enter the subject of the e-mail message created with this template. This appears as the 

Subject line in the e-mail message and overwrites the existing text.  

 You can enter a description of the template. This is not displayed to the recipient.  

 Enter the text you want to send in this message. Use the Formatting toolbar to edit the text.  
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 Tips 

 Although you cannot insert images or HTML directly into Microsoft Dynamics CRM e-mail 

messages or e-mail templates, you can use the copy feature in Internet Explorer to copy an image 

from a Web site and paste it into the e-mail message or e-mail template. The image is available as 

long as the Web site is accessible.  

 To include a hyperlink in an e-mail template, type the URL including the http://, for example, 

http://www.microsoft.com and then press Enter. Do not include a period or comma or a space 

after the URL, or the link will break. A link is automatically added to the URL and the text is 

underlined and changed to blue.  

 There is no spelling checker built into Microsoft Dynamics CRM. There may be third-party solutions 

available. For more information, visit Microsoft Dynamics CRM Solution Finder.  

 The Formating toolbar has limited fonts and font sizes. However, you can copy and paste content 

from Microsoft Office Word. This allows you to take advantage of features such as spell checking 

and some advanced text formatting. To single-space a line of text, at the end of the line press 

Shift+Enter.  

 To insert data fields to display information such as a customer's name or data from a quote, 

from Microsoft Dynamics CRM records, in the Actions  toolbar, click Insert/Update, and then 

in the Data Field Values dialog box, click Add. In the Add Data Value dialog box, select the 

Record Type and Field and then click OK. Click OK again to insert the data.  

 Tip 

Use the Default Text box to define what text displays if the record does not have data for the field. 

 Click Save or Save and Close.  

 If necessary, click OK to close the Set Personal Options dialog box.  

Notes 

 To change a shared template to a personal one or to a shared one, on the template form, on the 

Actions  menu, click Revert to Personal Template or click Make Template Available to 

Organization.  

 If you use an e-mail template as a signature in addition to another template, insert the signature 

template first, otherwise, the Subject line will be overwritten.  

http://go.microsoft.com/fwlink/?LinkId=98752
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Set how your e-mail is tracked  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Common Task Permissions  

You can use an existing e-mail address to send and receive e-mail with Microsoft Dynamics CRM. After your 

system administrator sets up your e-mail address, you can update the password.  

 

1. Under Workplace, click the Personalize Workplace link.  

2. In the Set Personal Options dialog box, on the E-mail tab, select the option that you want from the 

Track list:  

 All e-mail messages 

All of the messages from the account listed in your user profile will be saved as Microsoft 

Dynamics CRM activities.  

 E-mail messages in response to CRM e-mail 

Only e-mail messages received as replies from messages sent from Microsoft Dynamics CRM 

will be saved as Microsoft Dynamics CRM activities.  

 E-mail messages from CRM Leads, Contacts, and Accounts 

Only e-mail messages received from leads and customers will be saved as Microsoft Dynamics 

CRM activities.  

3. To save your changes and close the dialog box, click OK. 

Set address book options in Microsoft Dynamics CRM for Outlook  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Common Task Permissions  

You can select how the address book is managed in Outlook and Microsoft Dynamics CRM for Outlook and how 
often you want to synchronize between applications. This tab is not available in the Web application.  

 

1. Start Outlook. (Microsoft Dynamics CRM for Outlook must be installed.)  

2. On the Microsoft Dynamics CRM menu bar, click Options.  

3. In the Set Personal Options dialog box, on the Address Book tab, you can select how contacts 

and other record types are synchronized, and whether or not e-mail recipients are linked to 

Microsoft Dynamics CRM records.  

4. By default, the Outlook Address Book is synchronized with the Microsoft Dynamics CRM address book 

every 24 hours. If your organization permits it, you can change this interval. To change this interval, 

change the number between 1 and 60. Your administrator sets the minimum time allowed between 

synchronization.  

5. To save your changes and close the dialog box, click OK.  

Note 
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If you want to synchronize your address book manually, synchronize Microsoft Dynamics CRM manually. In Microsoft 

Dynamics CRM for Outlook, on the Microsoft Dynamics CRM menu bar, click Synchronize Outlook with CRM. 

Set local data synchronization options in Microsoft Dynamics CRM for 

Outlook  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Common Task Permissions  

If your organization allows it, you can select how frequently you want to synchronize between Microsoft 
Dynamics CRM and Microsoft Dynamics CRM for Outlook. This tab is not available in the Web application.  

 

1. Start Outlook. (Microsoft Dynamics CRM for Outlook must be installed.)  

2. On the Microsoft Dynamics CRM menu bar, click Options.  

3. In the Set Personal Options dialog box, on the Local Data tab, you can select how frequently the 

data on your local computer is synchronized.  

4. By default, the Outlook local data is synchronized with the Microsoft Dynamics CRM address book 

every 15 minutes. To change this interval, select a number between 1 and 60. Your administrator 

sets the minimum time allowed between synchronization.  

5. To save your changes and close the dialog box, click OK.  

Note 

You can start synchronization Microsoft Dynamics CRM manually. In Microsoft Dynamics CRM for Outlook, on the 

Microsoft Dynamics CRM menu bar, click Synchronize Outlook with CRM. 

Set privacy options  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Common Task Permissions  

You can specify whether errors you encounter in Microsoft Dynamics CRM are sent to Microsoft. This data is used 

to improve the quality of Microsoft Dynamics CRM.  

 

1. Under Workplace, click the Personalize Workplace link.  

– OR –  

In Outlook, in the Microsoft Dynamics CRM menu bar, click Options.  

2. Click the Privacy tab, and select when to send an error report to Microsoft Dynamics CRM. For more 

information about the program, click the View Privacy Statement link.  

3. To save your changes and close the dialog box, click OK.  

Important 
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In the above options, if you chose to never send an error report, but continue to receive notification of script errors, 

disable script debugging in Microsoft Internet Explorer. For instructions about how to do this, see the Microsoft Internet 

Explorer Help.  

Set language options  

You can control the language in which the Microsoft Dynamics CRM user interface and Help are displayed.  

 Can I do this task?  

This task requires permissions that are found in all default security roles. This task can be performed 
only in the Web application. More information: Common Task Permissions  

 

 

1. Under Workplace, click the Personalize Workplace link.  

– OR –  

In Outlook, in the Microsoft Dynamics CRM menu bar, click Options.  

2. Click the Languages tab.  

3. From the User Interface Language list, select the language in which you want Microsoft Dynamics 

CRM to be displayed.  

4. From the Help Language list, select the language in which you want Microsoft Dynamics CRM Help 

to be displayed.  

5. To save your changes and close the dialog box, click OK.  

View Your User Profile 

View your user profile  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Common Task Permissions  

Your user profile displays information about you, including general information such as your contact information and 

addresses, what teams and resource groups you belong to, which services you can perform, and your work hours and 

security roles. This information is visible to the entire organization. Depending on your security role, you may be able 

to make changes to your user profile. 

If you are working in Microsoft Dynamics CRM for Outlook, you can view this information from the User form. More 

information: Work with Your User Record and Work Hours  

 

1. Under Workplace, click the Personalize Workplace link.  

2. In the Set Personal Options dialog box, click the General tab.  

3. At the bottom of the page, click the View your user profile here link. 

The User form with your information opens.  

4. To view details or make changes, under Details or Service click any of the following:  

 Teams 
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 Roles 

 Quotas 

 Work Hours 

 Services 

 Resource groups 

 Workflows 

5. To close the form, on the File menu, click Close.  

6. To close the Set Personal Options dialog box, click OK.  

Requesting User Interface Changes  

The user interface of Microsoft Dynamics CRM can be customized. 

Because customizations affect all users, only a user with the System Administrator or System Customizer security 

role or equivalent permissions can make customizations. So if you see something that would make it easier to do your 

job, let your manager or system administrator know.  

Common customizations include:  

 Changing your permissions if needed to do your job.  

 Changing the choices and the default value for each list, such as the industry values in accounts and 

leads, or the reasons for closing an activity, case, or lead.  

 Changing the criteria that are used to determine if there are potential duplicate records.  

 Changing the names of record types or the text labels used in forms and views to reflect the 

terminology used in your organization.  

 Creating new record types and relationships to link them with other record types to capture 

information you need.  

 Adding new fields on forms to track information that doesn't fit in existing fields.  

 Hiding features you don't use to simplify your experience.  

 Modifying the default reports.  

 Changing which columns are displayed in views, the order columns are displayed, and how the views 

are sorted. For each record type, there are several types of views that can be changed:  

 The system views that appear in the View list.  

 The view that shows search results when you search with Advanced Find.  

 The view that shows search results when you type information in the Search for records 

box.  

 The view when you click a link in the Details area.  

 Controlling which fields are searched when you type information in the Search for records box.  

You cannot customize the values or default text in the Filter on and Include boxes in the History and Activities 

areas of records.  

Export Data to Excel 

You can export any list to Microsoft Office Excel, including the results of an Advanced Find search.  
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You can export to a static or dynamic Excel worksheet or to a PivotTable.  

Export data to an Excel static worksheet  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Common Task Permissions  

 

 

1. In any area with a list of records, select the columns to include in the exported list.  

By default, an exported worksheet includes the fields that are displayed in the list, using the same 

field order, sorting, and field widths.  

To make changes to the columns in an Advanced Find View, click Edit Columns. You can make the 

following types of changes:  

 Change the column order  

To change the column order, select a column heading, such as Account Name, and then under Common 

Tasks, click the Move Left button  or the Move Right button  to move the column.  

 Add columns  

a. To add columns to the export list, click Add Columns.  

b. To add columns for the main record type, select it, and then in the Add Columns list, click to 

select fields that you want to add as columns.  

c. To add columns from related records, first select the related record type, and then in the Add 

Columns list, click to select fields that you want to add as columns.  

d. Click OK.  

 Configure sorting  

To change the sort order, click Configure Sorting, in the Column list, select the column that you want to 

sort, in the Order area, click Ascending Order or click Descending Order, and then click OK.  

You cannot sort on columns from related record types. 

 Change column width  

To change the column width that will appear in the Excel worksheet, select a column heading, such as 

Account Name, click Change Properties. In the Change Column Properties dialog box, select the 

width (in pixels) that you want, and then click OK.  

 Remove columns  
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To remove a column, select the column heading that you want to remove, and under Common Tasks, 

click Remove, and then in the confirmation message, click OK.  

You cannot change the columns for a system view, such as All Active Accounts. You must either 

customize the view, which requires the System Administrator or System Customizer security role, or 

use Advanced Find to create your own view based on the current view. To create your own view, 

with the system view open, click Advanced Find.  

2. On the Actions toolbar, click the Export to Excel button .  

3. In the Export Data to Excel dialog box, select Static worksheet with records from this page.  

– OR –  

Select Static worksheet with records from all pages in the current view.  

This option will be visible only when your view includes more than one page of records.  

4. Click Export.  

5. To view the static worksheet, click Open.  

If you are using Microsoft Office Excel 2007, you will see a message that says the file you are trying 

open is in a different format than specified by the file extension. Click Yes.  

6. To save the exported data to a file, in Excel, on the File menu, click Save.  

Tip 

You can e-mail a static exported worksheet to anyone, or store it in a shared file. Anyone who opens the file will see all 

the data in the file, whether or not they are a Microsoft Dynamics CRM user or have privileges to view the data in 

Microsoft Dynamics CRM.  

Notes 

 There is potential for data loss if you export from Microsoft Dynamics CRM to a Microsoft Office Excel 

2003 comma-separated value (CSV) file.  

To ensure that the file is exported correctly, you must have data in every row of the last column of 

the list you are exporting. You can add a space or other character in last column of the file or 

reorder the columns so that the last column always contains data. More information: Microsoft 

Knowledge Base Article 77295  

 By default, in Microsoft Dynamics CRM, you cannot export a list of more than 10,000 records at a time 

to a static Excel worksheet. Your system administrator can change this. More information: Microsoft 

Knowledge Base Article 911395  

By default, Microsoft Dynamics CRM lists up to 50 records per page. If there is more than one page of 

records available to view in the list of records, use the Page arrows at the bottom of the list to view the 

additional pages.  

http://go.microsoft.com/fwlink/?LinkId=105633
http://go.microsoft.com/fwlink/?LinkId=105633
http://go.microsoft.com/fwlink/?LinkId=99131
http://go.microsoft.com/fwlink/?LinkId=99131
http://go.microsoft.com/fwlink/?LinkId=99131
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Create, Edit, or Copy a Report Using the Report Wizard 

Create, edit, or copy a report using the Report Wizard  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Report Permissions  

 How to determine which record types have the data you need 

There is one record type for each type of data, such as accounts, contacts, or services.  

In addition, there are separate record types for:  

 Notes. Every note and attachment is stored as a separate record in the Notes record type.  

 Close activities. Whenever you close an opportunity, quote or order, an activity is created 

that tracks the reason for closing the record. These are stored respectively in the 

Opportunity Close Activity, Quote Close Activity, and Order Close Activity record types. 

When you close a case, the data is stored in the Case Resolution Activity.  

If your report includes data from communication activities, you have two options:  

 If you want data about multiple types of communication activities in one report such as the 

activity subjects and due dates for all types of activities, use the Activity record type.  

 If you need specific information about a specific type of activity, such as the recipients, use 

the Task, E-mail Message, Fax, Appointment, Letter, or Phone Call record type.  

Tip:  

 While you are creating your report, keep a window open showing a record from the data 

type you are including in your report. It will help you determine which columns to include.  

 

 

1. In the Navigation Pane, click Workplace, and then under My Work, click Reports.  

2. To add a new report, click New, and then click Report Wizard.  

– OR –  

To edit an existing Report Wizard report, select the report, on the Actions toolbar, click Edit 

Report , and then click Report Wizard.  

You can only use the Report Wizard to edit reports that were created with the wizard.  

3. Select a starting point for your report.  

a. To create a new report, select Start a new report.  

– OR –  

To start from a copy of an existing report, select Start from an existing report, select the 

report, and also clear the Overwrite existing report check box.  
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– OR –  

To edit an existing report, select Start from an existing report, select the report, and 

check the Overwrite existing report check box.  

b. If multiple languages are installed, select the language to use for column names, record 

types, and wizard-generated text in the report.  

c. Click Next.  

4. Enter the name of the report, and specify which record types the report will use.  

The purpose of this step is to identify where the data in the report comes from. You can include 

data from one or two record types, plus data from related records.  

a. Enter data in each field:  

 Report name. This value will be displayed on the Reports  menu and in the 

Reports area.  

 Primary record type. Data from all fields in this record type and related record 

types will be available when you are defining criteria for which records to include. 

Data from this record type will be available when you are selecting fields to display.  

 Related record type. If you need to display data from a related record type, select 

an additional record type here.  

Tip: If you don't need data from a related record type, don't select one, as it makes 

the report take longer to load.  

b. Click Next.  

5. Specify which records to include.  

The purpose of this step is to determine which records are included in your report. This information 

is saved as the default filter for the report.  

You can select criteria based on the selected record types or on columns from related records.  

a. To include only records defined by an existing system view or saved view, select a view.  

– OR –  

To define which records to include by selecting criteria:  

 To add a criteria row:  

1. In the area for the record type that the field belongs to, click Select, and 

specify the field to filter on.  

2. Click the query relational operator, and select an operator.  

3. Click Enter Value, and enter a value to filter on. For some values, you can 

click the Select Values button  to open the Select Values dialog box 

and select the value you want.  

 To group criteria, you must select two or more rows for the same record type. For 

example, Sales Stage and Est. Revenue are both field values in the Opportunity 

record type and two rows that specify filter criteria for these fields can be grouped. 
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However, rows with field values from different record types, such as Account and 

Opportunity record types, cannot be grouped.  

a. For each row you want to group, click the Select Row button  for that row, 

and then click Select Row.  

b. On the Filter toolbar, select Group AND or Group OR.  

c. To remove a row from a group, click the Options menu button  for that 

row, and then click Delete.  

d. To select a group, click the Options menu button  for that group, and then 

click Select Group.  

e. To add a criteria clause to a group, click the Options menu button  for that 

group, click Add Clause, and then select the field, query relational operator, 

and value.  

f. To unselect a group that has been previously selected, click the Options 

menu button  for that group, and then click Deselect Group.  

g. To ungroup a group, click the Options menu button  for that group, and 

then click Ungroup.  

h. To change a Group AND group to a Group OR group, or a Group OR group 

to a Group AND group, click the Options menu button  for that group, 

and then click Change to OR or Change to AND.  

 Click Next.  

 Organize and lay out your data.  

The purpose of this step is to determine which columns to include, the order in which they are 

displayed, and whether to group data into subcategories. At a minimum, a report just includes 

columns. By grouping and summarizing the data, you make it easier to see the patterns.  

For example, your report could use one level of grouping to group opportunities by salesperson, or 

add a second level of grouping to show each quarter's opportunities, or add a third level to show 

the percentage won and lost in each quarter.  

To use a chart in your report, if your report has no grouping, you must select at least one numeric 

column. If your report uses grouping, you must select at least one numeric column with a summary 

type defined.  

 Define how to organize the report:  

 To group items so that they are organized together in the report by date or other 

common properties:  

0. For each grouping level you need, click Click here to add a grouping.  

1. Define the grouping:  

 Record type. You can select records from the primary record type you 

selected, and from any related record types. If you selected a 

secondary record type, you can also select records from the secondary 

record type and its related records types.  

 Column. The name of the Microsoft Dynamics CRM field that contains 

the data to define the grouping.  

 Time interval. For datetime fields, group the data by Month, Day, 

Week, or Year.  

 Sort order. Sort order for displaying the groups.  
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 Column width. Width of the column heading in pixels.  

 Summary type. You can group records by a count of matching 

records.  

2. To reorder the grouping levels, use the up and down arrows in the Common 

Tasks section.  

3. Click OK.  

 To define the sort order within each group, click Configure Sorting, select a 

column and sort order, and then click OK.  

 To limit reports to groups with the highest or lowest values, click Set Top or 

Bottom Number:  

0. Select Top or Bottom.  

1. Select the number of groups to display.  

2. Click OK.  

 Define which columns to display in the report. You can display columns that show data from 

a record, or columns that show summary information:  

0. For each column you want to include, click Click here to add a column:  

 Record type. You can select records from the primary record type you 

selected, and from any related record types. If you selected a secondary 

record type, you can also select records from the secondary record type and 

its related records types.  

 Column. The name of the Microsoft Dynamics CRM field that contains the 

data to display or summarize.  

 Data type. The data type of the column, one of: primarykey, nvarchar, 

picklist, bit, decimal, int, float, money, ntext, datetime, owner, lookup.  

 Name. The name used in the database.  

 Column width. The width in pixels of the column.  

 Summary type. The specific type of summaries available depends on the 

data type of the column.  

o None: lookup, datetime, owner, picklist, bit, ntext 

o Average, Maximum, Minimum, Percent of Total, Sum: all 

numeric record types (decimal, int, float, money)  

 Use the left and right arrows to reorganize the columns.  

1. Click OK.  

 Click Next.  

 Select whether to use a chart in the report.  

The purpose of this step is to determine whether to use a chart, and which type of chart to use.  

 Select whether to include a chart:  

 Table only. This provides a table grouped and sorted as you specified.  

 Chart and table. Displays both a chart and table.  

o Show table below the chart on same page. Clicking on the chart does 

nothing.  
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o Show chart. To view data for a chart region, click the chart region. 

Clicking on an area in the chart will display a table with details for that section 

of the chart.  

 Click Next.  

 If the report includes a chart, format the chart.  

The purpose of this step is to specify the type of chart, and how the data is displayed in the chart.  

 Select the chart type, and then click Next.  

The Chart preview area shows how the data will be displayed.  

 For vertical and horizontal bar charts and line charts, specify which data to display on 

each axis:  

o In the Format Column (X) Axis section, select the field to use for the X axis, 

and the label that is displayed on the chart for the field.  

o In the Format Value (Y) Axis section, you can select two fields. For each 

field, you can specify the label that is displayed on the chart.  

o In the Format Labels and Legends section, specify whether or not to show 

the data labels and a legend.  

 For pie charts, specify the slices and values for the chart.  

o For slices, you must select one of the groupings in your report.  

o For values, you must select a numeric column with a summary type.  

 Click Next.  

 Review the summary of the report, click Next, and then click Finish.  

 Determine where the report can be run from.  

When you finish defining the report, you return to the Report form, where you can update the name 

and description of the report, and determine where the report is displayed:  

 Categories 

To specify the categories in which to include this report, click the Select Values button , 

and then select the categories. More information: System Settings Dialog Box - Reporting 

Tab  

By default, a new report is not put into any category. If you want the report to be included in 

the category views in the Reports area, such as the Marketing Reports view, add a 

category in the Categories box.  

 Related Record Types 

To have the report appear in the Reports list on a page for specific record types, click the 

Select Values button , and then select record types.  

For example, if your new report includes data from accounts and activities, select Accounts 

and Activities.  

 Display In 

To specify where reports should be visible, click the Select Values button , and then 

select one or more options:  

o Reports area  

Report will be displayed in the Reports area.  
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o Forms for related record types  

Report will be displayed on the form for the record type you select in Related 

Record Types 

o Lists for related record types  

Report will be displayed from specified list view pages.  

If no values are selected, the report will not be visible to end-users. To view or manage 

reports not visible to end-users, in the Reports area, select the All Reports, Including 

Sub-Reports view.  

 Languages 

If your Microsoft Dynamics CRM implementation has multiple languages enabled, specify a 

language. The report will be displayed for all users who have selected that language in their 

personal options. To make this report available to all users, select All Languages.  

Note that this does not change the language used inside the report.  

Tip: If you use the Microsoft Dynamics CRM for Outlook with Offline Access, by default all reports 

that you own will be available when you are offline. More information: Work with Data to Take 

Offline  

 Test the report, and modify it if needed.  

On the Report toolbar, click Run Report .  

If the report needs modifications, start with step 2 and edit the existing report.  

 Determine who can use the report. By default, the report is a personal report. This means 

that you are the only one who can use it.  

 To share this report with other users, in the Reports area, select the report, and then on the 

More Actions menu, click Sharing.  

 To make this report available to everyone in the organization, in the Reports area, select the 

report, on the Actions toolbar menu, click Edit Report, and then on the Actions  menu, 

click Make Report Available to Organization.  

If you use the Microsoft Dynamics CRM for Outlook with Offline Access, by default all reports that 

you own will be available when you are offline. More information: Work with Data to Take Offline  

Note 

All reports generated with the Report Wizard print in landscape mode.  

Create and Work with Reports 

Run a report  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Report Permissions  

 

 

1. Find and open a report:  



 

 

 Microsoft Dynamics CRM 4.0 User’s Guide 187 

 

 From the Reports area  

a. In the Workplace, under My Work, click Reports.  

b. To narrow the list, enter the first few letters of the report name, or use the asterisk (*) wildcard in 

the Search for records box and then click the Find button . You can also select a view.  

c. In the reports list, double-click the report that you want to run.  

If the report has a default filter, the default filter will be displayed. Follow step 2 to change the filter.  
Tip: To run a report without seeing the default filter, select the report, and then on the Actions toolbar, 
click More Actions, and then click Run Report.  

 From a list of records, including the results of an Advanced Find search  

Only reports that relate to the current record type will be available.  

You can run some reports on all records in the list, up to ten selected records, or without limiting the 

records as if you were running the report from the Reports area.  

 To run a report on all records on the list:  

a. On the Actions toolbar, click Reports .  

b. Under Run on Selected Records, click the name of the report.  

c. In the Select Records dialog box, click All records on all pages in the current view, 

and then click Run Report.  

 To run a report on up to ten selected records from the list:  

a. Select the records to include. Select several records by pressing the CTRL key while you 

click each record.  

b. On the Actions toolbar, click Reports.  

c. Under Run on Selected Records, click the name of the report.  

d. In the Select Records dialog box, click The selected records, and then click Run 

Report.  

 To run a report without limiting records to items on the list:  

a. On the Actions toolbar, click Reports.  

b. If the report is listed under Run on All Records, select the report.  

– OR –  

Under Run on Selected Records, click the name of the report. In the Select Records 

dialog box, click All applicable records, and then click Run Report.  

– OR –  

If the report you want to run is not listed, you must go to the Reports area to run the 

report.  

 From a record 



 

188 Microsoft Dynamics CRM 4.0 User’s Guide 
 

Only reports that relate to the current record type will be available.  

To run a report including data from just one record:  

a. With a record open, on the Actions toolbar, click Reports .  

b. Under Run on Current Record, click the name of the report.  

 From Microsoft Dynamics CRM for Outlook  

All reports can be run when you are online.  

To run a report while you are offline, you must first create a local data group that includes the report, as 

well as a local data group that includes any data that should be included in the report.  

To create a local data group that contains reports, on the CRM menu, click Modify Local Data Groups, 

click New, select the the Report record type, and then define the criteria for which reports to include. 

More information: Work with Data to Take Offline  

 To run reports from the Reports area, in the Outlook Navigation Pane, under Microsoft 

Dynamics CRM, click Workplace, click My Work, click Reports, and then select a report to 

run.  

 To select a report from a record or list, follow the procedures above. These steps work the same 

way in Microsoft Dynamics CRM for Outlook.  

 From a report you saved locally 

If you have saved a report on your computer or shared file system that reads dynamic data from Microsoft 
Dynamics CRM, to open it, browse to the folder that contains your saved report, and double-click the file.  

 If the report offers filter criteria, if needed, modify the filter criteria and then click Run 

Report.  

The list of existing report filtering criteria is grouped by record types that you can use in the filter, 

such as Accounts or Contacts.  

To edit a parameter in simple mode, click the underlined value and enter a new value.  

– OR –  

To edit the filter criteria in detailed mode:  

 . Click Edit Filter.  

a. To add a criteria row:  

1. In the area for the record type that the field belongs to, click Select, and specify the 

field to filter on.  

2. Click the query relational operator, and select an operator.  

3. Click Enter Value, and enter a value to filter on. For some values, you can click the 

Select Values button  to open the Select Values dialog box and select the 

value you want.  
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b. To group criteria, you must select two or more rows for the same record type. For example, 

Sales Stage and Est. Revenue are both field values in the Opportunity record type and 

two rows that specify filter criteria for these fields can be grouped. However, rows with field 

values from different record types, such as Account and Opportunity record types, cannot 

be grouped.  

0. For each row you want to group, in detailed mode, click the Options menu 

button  for that row, and then click Select Row.  

1. On the Filter toolbar, select Group AND or Group OR.  

2. To remove a row from a group, click the Options menu button  for that row, and 

then click Delete.  

3. To select a group, click the Options menu button  for that group, and then click 

Select Group.  

4. To add a criteria clause to a group, click the Options menu button  for that group, 

click Add Clause, and then select the field, query relational operator, and value.  

5. To unselect a group that has been previously selected, click the Options menu 

button  for that group, and then click Deselect Group.  

6. To ungroup a group, click the Options menu button  for that group, and then 

click Ungroup.  

7. To change a Group AND group to a Group OR group, or a Group OR group to a 

Group AND group, click the Options menu button  for that group, and then click 

Change to OR or Change to AND.  

 Tips 

 To clear all criteria and start over, on the Filter toolbar, click Clear, and then click Confirm.  

 To delete a row, click the Options menu button  for that row, and then click Delete.  

 To hide a row in simple mode, while you are in detailed mode, click the Options menu 

button  for that row, and then click Hide in Simple Mode.  

 If you have a hidden row when viewing filter criteria in simple mode and you want to show that 

row again, then in detailed mode, you must click the Options menu button  for that row, and 

then click Show in Simple Mode.  

 You can set your personal options so that report filters and Advanced Find criteria always open in 

simple or detailed mode. More information: Set Personal Options  

 If the report offers parameters, if needed, modify the parameters and then click View 

Report.  

 Locate data in the report.  

 To view or change a record, click the first field in the row for the record. A separate Microsoft 

Dynamics CRM window will open with the record.  

 To view all records associated with a summary or chart report, click Show All at the bottom 

of the report. To navigate back to the original report, click Original Report in the report title 

area.  

 To view detailed information about an area in a chart, click an area of the chart. To navigate 

back to the original report, click Original Report in the report title area.  
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 To page through the report, on the Report toolbar, use the Page Navigation 

buttons . To locate a specific page, type a page number in the box 

and then press Enter.  

 To quickly locate specific information in your report, in Find | Next, type a few characters, 

and then click Find.  

 To sort a column, click the column title. The direction of sorting is indicated by the 

Ascending sort button  or the Descending sort button .  

 To view or hide the filter summary, expand or collapse Filter Summary.  

 To update your report, click the Refresh button .  

 To hide the report parameters, click the Hide Parameters button . To display the report 

parameters, click the Show Parameters button .  

 Print the report. On the Report toolbar, click the Print button .  

If you are working offline using Microsoft Dynamics CRM for Outlook, on the Report toolbar, select 

Web archive format, click Export, and then on the File menu, click Print.  

Tips  

 If a chart doesn't display the first time you export a report to Web archive format, export 

the report a second time.  

 To print reports, you need a Reporting Services Microsoft ActiveX control. The first time you 

print a Reporting Services report from either Microsoft Dynamics CRM or Microsoft Dynamics 

CRM for Microsoft Office Outlook, you will see a prompt Do you want to install this 

software?.  

To install the required control, click Install.  

 Export the report.  

Important The exported report is temporary. If you need to save the exported report to a local 

file, use the viewing program to save the file to disk. The saved exported report is no longer 

connected to Microsoft Dynamics CRM. Therefore, it does not change if Microsoft Dynamics CRM 

data changes.  

 . In the Export box, select a format, and then click Export.  

A second browser window is used to display the report, using a viewer associated with the 

export format you selected.  

The formats that are available are determined by the rendering extensions that are installed 

on the Microsoft SQL Server Reporting Services report server, and also by whether you are 

online or offline.  

 If you are working offline, only the Excel and Acrobat (PDF) file formats are 

available.  

 If you are using Microsoft SQL 2005 Workgroup edition, the XML file with report 

data format is not available.  

If a viewer is not available for the format you select, you must select a different format or 

install the viewer.  

The following export formats are included in a default installation when you are online. The 

list of export formats available to you may vary from those listed here.  



 

 

 Microsoft Dynamics CRM 4.0 User’s Guide 191 

 

 Excel  

View the report in Microsoft Office Excel. This format includes all the row, column, and 

field labels, in addition to report formatting.  

Large reports and reports with charts might not display with the expected formatting 

when exported in this file format. To export only the data, instead of using this format, 

from any list in Microsoft Dynamics CRM, including results of Advanced Find searches, 

export the data into Microsoft Office Excel, and then save as a comma-delimited (CSV) 

file. More information: Export Data to Excel  

 Web archive  

View the report in Microsoft Internet Explorer, as a MIME-encoded HTML format that 

keeps images and linked content together with a report. For chart reports, if the chart 

is not displayed correctly the first time that you export the report, export the report 

again.  

Choose this format to view a report offline or for e-mailing the report.  

 Acrobat (PDF) file  

View the report using a client-side PDF viewer. You must have Adobe Acrobat Reader 

to use this format.  

Choose this format for long reports, paginated reports, or reports that are delivered as 

a file.  

 TIFF file  

View the report in the default TIFF viewer. For some Windows clients, this is the 

Windows Pictures and Fax Viewer.  

Choose this format to a view a report in a page-oriented layout. The TIFF format is the 

recommended format for printing reports.  

 CSV (comma delimited)  

View the report as a text file, with fields separated by commas. This format includes all 

the row, column, and field labels.  

To export only the data, instead of using this format, export data from any list in 

Microsoft Dynamics CRM, including results of Advanced Find searches, into Microsoft 

Office Excel, and then save as a comma-delimited (CSV) file.  

 XML file with report data  

View the report as an XML file.  

Tips 

 If there is no report that gives you the information you need, you can either export data to Microsoft 

Office Excel, or create your own report. More information: Export Data to Excel, Create and Work 

with Reports  

 If a snapshot of a Reporting Services report exists, you can view it from the Reports area. To see if 

any snapshots exist for a report, click the View Snapshots button  next to the report. If a 

snapshot exists, click the snapshot link to view the snapshot.  

Note 

If multiple Language Packs are installed, only reports that are marked for display in the language you specified in 

Personal Options will be visible. More information: Set Personal Options  
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Add a report without using the Report Wizard  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Report Permissions  

 

 

1. In the Navigation Pane, click Workplace, and then under My Work, click Reports.  

2. To add a new report, click New.  

 Add a new file that reads data from the Microsoft Dynamics CRM database.  

You can add a static file, or a dynamic Microsoft Office, Microsoft SQL Server Reporting Services or other 

ODBC-compliant file that reads data from the Microsoft Dynamics CRM database.  

1. In the Source section, in the Report Type box, select Existing File.  

2. In the File Location box, enter the path and file name of the dynamic or static file to add, or 

click Browse to locate the file.  

When you add a new Reporting Services report, if the report is enabled for pre-filtering and the 

report doesn't already have a default filter, a default filter that limits the data in the report to 

records modified within the past 30 days that have status set to active is added.  

For information about creating Microsoft Office files or other ODBC-compliant files that read 

directly from the Microsoft Dynamics CRM database, see: Write a Report Using Report-Writing 

Tools.  

Tips  

 To change a file that has been added as a report, you must download it, make any changes, and 

then add it again.  

 By default, the maximum size of the file that you can upload is 4 megabytes (MB). This can be 

changed by your system administrator. More information: Microsoft Knowledge Base Article 

295626  

 Add a new link to a Web page 

1. In the Source section, in Report Type, select Link to Web page.  

2. In the Web Page URL box, enter the URL of the Web page to add.  

 Specify the properties for the report.  

 Name 

The name for the report that is shown in the Reports area and on the Reports  menu in 

forms and lists.  

 Description 

The description that is displayed in the Reports area.  

http://go.microsoft.com/fwlink/?LinkId=99118
http://go.microsoft.com/fwlink/?LinkId=99118
http://go.microsoft.com/fwlink/?LinkId=99118
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 Parent Report 

If this report is a sub-report or a drill-through report, specify an existing parent report. If this 

is not specified, the parent report will display a "Report not found" error.  

 Categories 

To specify the categories in which to include this report, click the Select Values button , 

and then select the categories. More information: System Settings Dialog Box - Reporting 

Tab  

 Related Record Types 

To have the report appear in the Reports list on a page for specific record types, click the 

Select Values button , and then select record types.  

For example, if your new report includes data from accounts and activities, select Accounts 

and Activities.  

 Display In 

To specify where reports should be visible, click the Select Values button , and then 

select one or more options:  

 Reports area  

Report will be displayed in the Reports area.  

 Forms for related record types  

Report will be displayed on the form for the record type you select in Related 

Record Types 

If the report is enabled for pre-filtering, from the record, users can specify running 

the report on the current record.  

 Lists for related record types  

Report will be displayed from specified list view pages.  

If the report has pre-filtering enabled, from the list view, users can specify running 

the report on selected records.  

 If no values are selected, the report will not be visible to end-users. To view or manage 

reports not visible to end-users, in the Reports area, select the All Reports, Including 

Sub-Reports view.  

 Languages 

If your Microsoft Dynamics CRM implementation has multiple languages enabled, specify a 

language. The report will be displayed for all users who have selected that language in their 

personal options. To make this report available to all users, select All Languages.  

Note that this does not change the language used inside the report.  

 Click Save or Save and Close.  

The report is added as a personal report.  

Tips 

 To share this report with other users, in the Reports area, select the report, and then on the More 

Actions menu, click Sharing.  

 To make this report available to everyone in the organization, in the Reports area, select the report, 

on the Actions toolbar menu, click Edit Report, and then on the Actions  menu, click Make 

Report Available to Organization.  
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 If you use the Microsoft Dynamics CRM for Outlook with Offline Access, by default all reports that you 

own will be available when you are offline. More information: Work with Data to Take Offline  

Edit report properties  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Report Permissions  

 

 

1. In the Navigation Pane, click Workplace, and then under My Work, click Reports.  

2. Select the report, and on the Actions toolbar, click Edit Report .  

3. Specify the properties for the report:  

 Source 

This section specifies the source file for the report. If you are just changing properties for the 

report, do not change the information in this section.  

 Name 

The name for the report that is shown in the Reports area and on the Reports  menu in 

forms and lists.  

 Description 

The description that is displayed in the Reports area.  

 Parent Report 

If this report is a sub-report or a drill-through report, specify an existing parent report. If this 

is not specified, the parent report will display a "Report not found" error.  

 Categories 

To specify the categories in which to include this report, click the Select Values button , 

and then select the categories. More information: System Settings Dialog Box - Reporting Tab  

 Related Record Types 

To have the report appear in the Reports list on a page for specific record types, click the 

Select Values button , and then select record types.  

For example, if your new report includes data from accounts and activities, select Accounts 

and Activities.  

 Display In 

To specify where reports should be visible, click the Select Values button , and then 

select one or more options:  

 Reports area  

Report will be displayed in the Reports area.  

 Forms for related record types  

Report will be displayed on the form for the record type you select in Related Record 

Types 

If the report is enabled for pre-filtering, from the record, users can specify running the 

report on the current record.  
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 Lists for related record types  

Report will be displayed from specified list view pages.  

If the report has pre-filtering enabled, from the list view, users can specify running the 

report on selected records.  

 If no values are selected, the report will not be visible to end-users. To view or manage 

reports not visible to end-users, in the Reports area, select the All Reports, Including Sub-

Reports view.  

 Languages 

If your Microsoft Dynamics CRM implementation has multiple languages enabled, specify a 

language. The report will be displayed for all users who have selected that language in their 

personal options. To make this report available to all users, select All Languages.  

Note that this does not change the language used inside the report.  

4. Click Save or Save and Close.  

Tips 

 To see all reports, including sub-reports that are not visible in the default view, select the All 

Reports, Including Sub-Reports view.  

 If you use the Microsoft Dynamics CRM for Outlook with Offline Access, by default all reports that you 

own will be available when you are offline. More information: Work with Data to Take Offline  

Note 

If multiple Language Packs are installed, only reports that are marked for display in the language you specified in 

Personal Options will be visible. More information: Set Personal Options  

Create a new report from an existing report  

 Can I do this task?  

This task requires the System Administrator or System Customizer security role or equivalent 
permissions. More information about specific permissions and performing this task while offline: 
Report Permissions  

To copy a Report Wizard report and modify it using Report Wizard, see Create, Edit, or Copy a Report Using the 

Report Wizard.  

 

1. In the Navigation Pane, click Workplace, and then under My Work, click Reports.  

2. Select a report.  

To see all reports, including sub-reports that are not visible in the default view, select the All 

Reports, Including Sub-Reports view.  

3. On the Actions toolbar, click Edit Report , and then on the Actions  menu, click Download 

Report.  

4. Click Save, and specify the location in which to save the file. If you are creating a new report rather 

than modifying a report, rename the file.  

Whenever a Microsoft SQL Server Reporting Services report is downloaded, the datasource for the 

report is changed to Adventure_Works_Cycle_MSCRM. This is done for security reasons: you can 

file:\\crmshare\Users\abecraft\Modified_Help_for_Print\content\ui_ol_offlineconfiguration_form.htm
file:\\crmshare\Users\abecraft\Modified_Help_for_Print\content\ui_persopt_dlg.htm
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share the.RDL file with the report without worrying about revealing your database name. You will 

need to change the datasource name back to the name of your Microsoft Dynamics CRM database 

prior to uploading changes to the file.  

5. In the Download Complete dialog box, click Close.  

6. To copy a report and add it to Microsoft Dynamics CRM:  

a. Follow the previous steps to download the file.  

b. Copy the downloaded file and rename the copy.  

c. For Reporting Services reports, change the datasource name in the report to the name of 

your Microsoft Dynamics CRM database.  

d. Make any changes required to the new report. For Reporting Services reports, use Reporting 

Services Report Designer. You will need a report development environment:  

 How to set up a report development environment 

Install the required components on your computer:  

 Microsoft Visual Studio, or any product that uses the Visual Studio.NET integrated development 

environment (such as Microsoft Visual Basic.NET).  

 Reporting Services Report Designer 

Reporting Services Report Designer 2005 can be installed from the Microsoft SQL Server 2005 

CD, and requires Visual Studio.NET 2005.  

 Make sure a security role assigned to your account includes the Publish Reports and Add 

Reporting Services Reports privileges.  

In addition to the required components, the following documentation is helpful:  

 Report Writers Guide section of the Microsoft CRM 4.0 Software Development Kit. More 

information: Writing Reporting Services Reports (Microsoft Dynamics CRM SDK)  

 Reporting Services Books Online provides help for Reporting Services. More information: SQL 

Server 2005 Reporting Services Books Online  

e. Add the new report back to Microsoft Dynamics CRM.  

Tip 

If you don't want users to run the base report you started from:  

1. In the Reports area, select the report.  

2. On the Actions toolbar, click Edit Report .  

3. On the Actions  menu, click Revert to Personal Report.  

Note 

When you download a drill-through report created with the Report Wizard, and edit the downloaded report in Reporting 

Services Report Designer, there are manual changes required. More information: Writing Reporting Services Reports 

(Microsoft Dynamics CRM SDK)  

http://go.microsoft.com/fwlink/?LinkId=97586
http://go.microsoft.com/fwlink/?LinkId=98256
http://go.microsoft.com/fwlink/?LinkId=98256
http://go.microsoft.com/fwlink/?LinkId=98256
http://go.microsoft.com/fwlink/?LinkId=99536
http://go.microsoft.com/fwlink/?LinkId=99536
http://go.microsoft.com/fwlink/?LinkId=99536
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Edit the default filter for a report  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Report Permissions  

If a report is a Microsoft SQL Server Reporting Services report, is enabled for pre-filtering, and has a default filter, 
you can change the default filter that will be used each time any user runs the report.  

 

1. In the Navigation Pane, click Workplace, and then under My Work, click Reports.  

2. Select a report.  

To see all reports, including sub-reports that are not visible in the default view, select the All 

Reports, Including Sub-Reports view.  

3. On the Actions toolbar, click More Actions, and then click Edit Default Filter.  

4. Modify the filter criteria.  

The criteria are grouped by record types that you can use in the filter, such as Accounts or 

Contacts.  

 To edit an existing row, click the query relational operator and select an operator, or click the 

underlined value and enter a new value.  

 Click the query relational operator, and select an operator.  

 To add a criteria row:  

a. In the area for the record type that the field belongs to, click Select, and specify the 

field to filter on.  

b. Click the query relational operator, and select an operator.  

c. Click Enter Value, and enter a value to filter on. For some values, you can click the 

Select Values button  to open the Select Values dialog box and select the 

value you want.  

 To group criteria, you must select two or more rows for the same record type. For example, 

Sales Stage and Est. Revenue are both field values in the Opportunity record type and 

two rows that specify filter criteria for these fields can be grouped. However, rows with field 

values from different record types, such as Account and Opportunity record types, cannot 

be grouped.  

a. For each row you want to group, in detailed mode, click the Options menu 

button  for that row, and then click Select Row.  

b. On the Filter toolbar, select Group AND or Group OR.  

c. To remove a row from a group, click the Options menu button  for that row, and 

then click Delete.  

d. To select a group, click the Options menu button  for that group, and then click 

Select Group.  

e. To add a criteria clause to a group, click the Options menu button  for that group, 

click Add Clause, and then select the field, query relational operator, and value.  

f. To unselect a group that has been previously selected, click the Options menu 

button  for that group, and then click Deselect Group.  
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g. To ungroup a group, click the Options menu button  for that group, and then 

click Ungroup.  

h. To change a Group AND group to a Group OR group, or a Group OR group to a 

Group AND group, click the Options menu button  for that group, and then click 

Change to OR or  Change to AND.  

 Tips 

 To clear all criteria and start over, on the Filter toolbar, click Clear, and then click Confirm.  

 To delete a row, click the Options menu button  for that row, and then click Delete.  

5. Click Save Default Filter.  

6. Click Save or Save and Close.  

Edit a default report or create a Reporting Services report  

 Can I do this task?  

This task requires the System Administrator or System Customizer security role or equivalent 
permissions. More information about specific permissions and performing this task while offline: 
Report Permissions  

The default reports in Microsoft Dynamics CRM are all Reporting Services reports. Default reports cannot be 

edited with the Report Wizard. To edit the default reports or create a new Reporting Services report other than 

one created by using the Report Wizard, you need a report development environment:  

 How to set up a report development environment 

Install the required components on your computer:  

 Microsoft Visual Studio, or any product that uses the Visual Studio.NET integrated 

development environment (such as Microsoft Visual Basic.NET).  

 Reporting Services Report Designer 

Reporting Services Report Designer 2005 can be installed from the Microsoft SQL Server 

2005 CD, and requires Visual Studio.NET 2005.  

 Make sure a security role assigned to your account includes the Publish Reports and Add 

Reporting Services Reports privileges.  

In addition to the required components, the following documentation is helpful:  

 Report Writers Guide section of the Microsoft CRM 4.0 Software Development Kit. More 

information: Writing Reporting Services Reports (Microsoft Dynamics CRM SDK)  

 Reporting Services Books Online provides help for Reporting Services. More information: 

SQL Server 2005 Reporting Services Books Online  

 

 

1. Identify the existing report that is closest in design to your new report.  

http://go.microsoft.com/fwlink/?LinkId=97586
http://go.microsoft.com/fwlink/?LinkId=98256
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2. Download the report from Microsoft Dynamics CRM to a computer that is set up with the report 

development environment.  

a. In the Navigation Pane, click Workplace, and then under My Work, click Reports.  

b. On the Actions toolbar, click Edit Report , and then on the Actions  menu, click 

Download Report.  

c. Click Save, and specify the location in which to save the file. If you are creating a new 

report rather than modifying a report, rename the file.  

d. In the Download Complete dialog box, click Close.  

3. In a product using the Visual Studio integrated development environment (IDE), open the report, and 

make the required changes.  

If you are making major changes, first read Writing Reporting Services Reports (Microsoft Dynamics 

CRM SDK).  

4. Add the report to Microsoft Dynamics CRM.  

a. In the Microsoft Dynamics CRM Reports area, click New.  

b. In the Report Type box, select Existing File.  

c. In the File Location box, enter the path and file name of the dynamic or static file to add, 

or click Browse to locate the file.  

d. Edit the report properties:  

 Name 

The name for the report that is shown in the Reports area and on the Reports  

menu in forms and lists.  

 Description 

The description that is displayed in the Reports area.  

 Parent Report 

If this report is a sub-report or a drill-through report, specify an existing parent 

report. If this is not specified, the parent report will display a "Report not found" 

error.  

 Categories 

To specify the categories in which to include this report, click the Select Values 

button , and then select the categories. More information: System Settings Dialog 

Box - Reporting Tab  

 Related Record Types 

To have the report appear in the Reports list on a page for specific record types, 

click the Select Values button , and then select record types.  

For example, if your new report includes data from accounts and activities, select 

Accounts and Activities.  

 Display In 

To specify where reports should be visible, click the Select Values button , and 

then select one or more options:  

 Reports area  

Report will be displayed in the Reports area.  

 Forms for related record types  

Report will be displayed on the form for the record type you select in Related 

Record Types 

http://go.microsoft.com/fwlink/?LinkId=97586
http://go.microsoft.com/fwlink/?LinkId=97586
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If the report is enabled for pre-filtering, from the record, users can specify 

running the report on the current record.  

 Lists for related record types  

Report will be displayed from specified list view pages.  

If the report has pre-filtering enabled, from the list view, users can specify 

running the report on selected records.  

 If no values are selected, the report will not be visible to end-users. To view or 

manage reports not visible to end-users, in the Reports area, select the All Reports, 

Including Sub-Reports view.  

 Languages 

If your Microsoft Dynamics CRM implementation has multiple languages enabled, 

specify a language. The report will be displayed for all users who have selected that 

language in their personal options. To make this report available to all users, select 

All Languages.  

Note that this does not change the language used inside the report.  

e. Click Save.  

f. To modify the filter for the report, on the Actions toolbar, click More Actions, and then click 

Edit Default Filter.  

Tips 

 To share your new file with other users, do one of the following:  

 Add your file as a report in Microsoft Dynamics CRM, and select the report. On the More 

Actions menu, click Sharing, and specify users with whom to share the report.  

 If the report would be useful for all users, add your file as a report in Microsoft Dynamics 

CRM, and ask your system administrator to make it available to the organization. If you have 

the appropriate permissions:  

1. In the Microsoft Dynamics CRM Reports area, select the report.  

2. Click Edit Report .  

3. On the Actions  menu, click Make Report Available to Organization.  

 Put the report in a shared file system.  

 E-mail the report to other Microsoft Dynamics CRM users in the same domain.  

 If you don't want users to run the base report you started from:  

1. In the Reports area, select the report.  

2. On the Actions toolbar, click Edit Report .  

3. On the Actions  menu, click Revert to Personal Report.  
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Create one-time or scheduled Reporting Services report snapshots  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Report Permissions  

To create a snapshot of a Reporting Services report, you create a snapshot definition, which can be used to create 

on-demand snapshots or to schedule snapshots to occur at specific times. Each snapshot definition can create and 

store up to eight snapshots. When the ninth snapshot is created, the first snapshot is automatically deleted.  

Caution: When you make a snapshot available to other users, all the data in the snapshot is visible, whether or 

not the other users have permission to view this data directly in Microsoft Dynamics CRM. Make sure you don't 

share information that other users do not have permission to view.  

 

1. In the Navigation Pane, click Workplace, and then under My Work, click Reports.  

2. Select a report.  

3. On the More Actions menu, click Schedule Report and complete the steps in the wizard.  

Tips 

 After you create a snapshot definition, rename the snapshot definition so that users can easily 

understand the purpose of the snapshot.  

1.  

2. In the Name box, enter a new name, and then click Save and Close.  

 After you have created snapshots, if you don't want users to be able to run the base report:  

1. In the Reports area, select the report.  

2. On the Actions toolbar, click Edit Report .  

3. On the Actions  menu, click Revert to Personal Report.  

Make a report available to all Microsoft Dynamics CRM users  

 Can I do this task?  

This task requires the System Administrator or System Customizer security role or equivalent 
permissions. More information about specific permissions and performing this task while offline: 
Report Permissions  

 

 

1. In the Navigation Pane, click Workplace, and then under My Work, click Reports.  

2. Select the report you created, and on the Actions toolbar, click Edit Report.  

3. On the Actions  menu, click Make Report Available to Organization.  

Note 

To revert a report back to a personal report, on the Actions  menu, click Revert to Personal Report.  
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Create, edit, or copy a report using the Report Wizard  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Report Permissions  

 How to determine which record types have the data you need 

There is one record type for each type of data, such as accounts, contacts, or services.  

In addition, there are separate record types for:  

 Notes. Every note and attachment is stored as a separate record in the Notes record 

type.  

 Close activities. Whenever you close an opportunity, quote or order, an activity is 

created that tracks the reason for closing the record. These are stored respectively in 

the Opportunity Close Activity, Quote Close Activity, and Order Close Activity record 

types. When you close a case, the data is stored in the Case Resolution Activity.  

If your report includes data from communication activities, you have two options:  

 If you want data about multiple types of communication activities in one report such as 

the activity subjects and due dates for all types of activities, use the Activity record type.  

 If you need specific information about a specific type of activity, such as the recipients, 

use the Task, E-mail Message, Fax, Appointment, Letter, or Phone Call record type.  

Tip:  

 While you are creating your report, keep a window open showing a record from the data 

type you are including in your report. It will help you determine which columns to 

include.  

 

 

1. In the Navigation Pane, click Workplace, and then under My Work, click Reports.  

2. To add a new report, click New, and then click Report Wizard.  

– OR –  

To edit an existing Report Wizard report, select the report, on the Actions toolbar, click Edit 

Report , and then click Report Wizard.  

You can only use the Report Wizard to edit reports that were created with the wizard.  

3. Select a starting point for your report.  

a. To create a new report, select Start a new report.  

– OR –  

To start from a copy of an existing report, select Start from an existing report, select the 

report, and also clear the Overwrite existing report check box.  
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– OR –  

To edit an existing report, select Start from an existing report, select the report, and 

check the Overwrite existing report check box.  

b. If multiple languages are installed, select the language to use for column names, record 

types, and wizard-generated text in the report.  

c. Click Next.  

4. Enter the name of the report, and specify which record types the report will use.  

The purpose of this step is to identify where the data in the report comes from. You can include 

data from one or two record types, plus data from related records.  

a. Enter data in each field:  

 Report name. This value will be displayed on the Reports  menu and in the 

Reports area.  

 Primary record type. Data from all fields in this record type and related record 

types will be available when you are defining criteria for which records to include. 

Data from this record type will be available when you are selecting fields to display.  

 Related record type. If you need to display data from a related record type, select 

an additional record type here.  

Tip: If you don't need data from a related record type, don't select one, as it makes 

the report take longer to load.  

b. Click Next.  

5. Specify which records to include.  

The purpose of this step is to determine which records are included in your report. This information 

is saved as the default filter for the report.  

You can select criteria based on the selected record types or on columns from related records.  

a. To include only records defined by an existing system view or saved view, select a view.  

– OR –  

To define which records to include by selecting criteria:  

 To add a criteria row:  

1. In the area for the record type that the field belongs to, click Select, and 

specify the field to filter on.  

2. Click the query relational operator, and select an operator.  

3. Click Enter Value, and enter a value to filter on. For some values, you can 

click the Select Values button  to open the Select Values dialog box 

and select the value you want.  

 To group criteria, you must select two or more rows for the same record type. For 

example, Sales Stage and Est. Revenue are both field values in the Opportunity 

record type and two rows that specify filter criteria for these fields can be grouped. 
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However, rows with field values from different record types, such as Account and 

Opportunity record types, cannot be grouped.  

a. For each row you want to group, click the Select Row button  for that row, 

and then click Select Row.  

b. On the Filter toolbar, select Group AND or Group OR.  

c. To remove a row from a group, click the Options menu button  for that 

row, and then click Delete.  

d. To select a group, click the Options menu button  for that group, and then 

click Select Group.  

e. To add a criteria clause to a group, click the Options menu button  for that 

group, click Add Clause, and then select the field, query relational operator, 

and value.  

f. To unselect a group that has been previously selected, click the Options 

menu button  for that group, and then click Deselect Group.  

g. To ungroup a group, click the Options menu button  for that group, and 

then click Ungroup.  

h. To change a Group AND group to a Group OR group, or a Group OR group 

to a Group AND group, click the Options menu button  for that group, 

and then click Change to OR or Change to AND.  

 Click Next.  

 Organize and lay out your data.  

The purpose of this step is to determine which columns to include, the order in which they are 

displayed, and whether to group data into subcategories. At a minimum, a report just includes 

columns. By grouping and summarizing the data, you make it easier to see the patterns.  

For example, your report could use one level of grouping to group opportunities by salesperson, or 

add a second level of grouping to show each quarter's opportunities, or add a third level to show 

the percentage won and lost in each quarter.  

To use a chart in your report, if your report has no grouping, you must select at least one numeric 

column. If your report uses grouping, you must select at least one numeric column with a summary 

type defined.  

 Define how to organize the report:  

 To group items so that they are organized together in the report by date or other 

common properties:  

0. For each grouping level you need, click Click here to add a grouping.  

1. Define the grouping:  

 Record type. You can select records from the primary record type you 

selected, and from any related record types. If you selected a 

secondary record type, you can also select records from the secondary 

record type and its related records types.  

 Column. The name of the Microsoft Dynamics CRM field that contains 

the data to define the grouping.  

 Time interval. For datetime fields, group the data by Month, Day, 

Week, or Year.  

 Sort order. Sort order for displaying the groups.  
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 Column width. Width of the column heading in pixels.  

 Summary type. You can group records by a count of matching 

records.  

2. To reorder the grouping levels, use the up and down arrows in the Common 

Tasks section.  

3. Click OK.  

 To define the sort order within each group, click Configure Sorting, select a 

column and sort order, and then click OK.  

 To limit reports to groups with the highest or lowest values, click Set Top or 

Bottom Number:  

0. Select Top or Bottom.  

1. Select the number of groups to display.  

2. Click OK.  

 Define which columns to display in the report. You can display columns that show data from 

a record, or columns that show summary information:  

0. For each column you want to include, click Click here to add a column:  

 Record type. You can select records from the primary record type you 

selected, and from any related record types. If you selected a secondary 

record type, you can also select records from the secondary record type and 

its related records types.  

 Column. The name of the Microsoft Dynamics CRM field that contains the 

data to display or summarize.  

 Data type. The data type of the column, one of: primarykey, nvarchar, 

picklist, bit, decimal, int, float, money, ntext, datetime, owner, lookup.  

 Name. The name used in the database.  

 Column width. The width in pixels of the column.  

 Summary type. The specific type of summaries available depends on the 

data type of the column.  

o None: lookup, datetime, owner, picklist, bit, ntext 

o Average, Maximum, Minimum, Percent of Total, Sum: all 

numeric record types (decimal, int, float, money)  

 Use the left and right arrows to reorganize the columns.  

1. Click OK.  

 Click Next.  

 Select whether to use a chart in the report.  

The purpose of this step is to determine whether to use a chart, and which type of chart to use.  

 Select whether to include a chart:  

 Table only. This provides a table grouped and sorted as you specified.  

 Chart and table. Displays both a chart and table.  

o Show table below the chart on same page. Clicking on the chart does 

nothing.  
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o Show chart. To view data for a chart region, click the chart region. 

Clicking on an area in the chart will display a table with details for that section 

of the chart.  

 Click Next.  

 If the report includes a chart, format the chart.  

The purpose of this step is to specify the type of chart, and how the data is displayed in the chart.  

 Select the chart type, and then click Next.  

The Chart preview area shows how the data will be displayed.  

 For vertical and horizontal bar charts and line charts, specify which data to display on 

each axis:  

o In the Format Column (X) Axis section, select the field to use for the X axis, 

and the label that is displayed on the chart for the field.  

o In the Format Value (Y) Axis section, you can select two fields. For each 

field, you can specify the label that is displayed on the chart.  

o In the Format Labels and Legends section, specify whether or not to show 

the data labels and a legend.  

 For pie charts, specify the slices and values for the chart.  

o For slices, you must select one of the groupings in your report.  

o For values, you must select a numeric column with a summary type.  

 Click Next.  

 Review the summary of the report, click Next, and then click Finish.  

 Determine where the report can be run from.  

When you finish defining the report, you return to the Report form, where you can update the name 

and description of the report, and determine where the report is displayed:  

 Categories 

To specify the categories in which to include this report, click the Select Values button , 

and then select the categories. More information: System Settings Dialog Box - Reporting 

Tab  

By default, a new report is not put into any category. If you want the report to be included in 

the category views in the Reports area, such as the Marketing Reports view, add a 

category in the Categories box.  

 Related Record Types 

To have the report appear in the Reports list on a page for specific record types, click the 

Select Values button , and then select record types.  

For example, if your new report includes data from accounts and activities, select Accounts 

and Activities.  

 Display In 

To specify where reports should be visible, click the Select Values button , and then 

select one or more options:  

o Reports area  

Report will be displayed in the Reports area.  
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o Forms for related record types  

Report will be displayed on the form for the record type you select in Related 

Record Types 

o Lists for related record types  

Report will be displayed from specified list view pages.  

If no values are selected, the report will not be visible to end-users. To view or manage 

reports not visible to end-users, in the Reports area, select the All Reports, Including 

Sub-Reports view.  

 Languages 

If your Microsoft Dynamics CRM implementation has multiple languages enabled, specify a 

language. The report will be displayed for all users who have selected that language in their 

personal options. To make this report available to all users, select All Languages.  

Note that this does not change the language used inside the report.  

Tip: If you use the Microsoft Dynamics CRM for Outlook with Offline Access, by default all reports 

that you own will be available when you are offline. More information: Work with Data to Take 

Offline  

 Test the report, and modify it if needed.  

On the Report toolbar, click Run Report .  

If the report needs modifications, start with step 2 and edit the existing report.  

 Determine who can use the report. By default, the report is a personal report. This means 

that you are the only one who can use it.  

 To share this report with other users, in the Reports area, select the report, and then on the 

More Actions menu, click Sharing.  

 To make this report available to everyone in the organization, in the Reports area, select the 

report, on the Actions toolbar menu, click Edit Report, and then on the Actions  menu, 

click Make Report Available to Organization.  

If you use the Microsoft Dynamics CRM for Outlook with Offline Access, by default all reports that 

you own will be available when you are offline. More information: Work with Data to Take Offline  

Note 

file:\\crmshare\Users\abecraft\Modified_Help_for_Print\content\ui_ol_offlineconfiguration_form.htm
file:\\crmshare\Users\abecraft\Modified_Help_for_Print\content\ui_ol_offlineconfiguration_form.htm
file:\\crmshare\Users\abecraft\Modified_Help_for_Print\content\ui_ol_offlineconfiguration_form.htm
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Make a report available for external use  

 Can I do this task?  

This task requires the System Administrator or System Customizer security role or equivalent 
permissions. More information about specific permissions and performing this task while offline: 
Report Permissions  

Publishing a report for external use makes it available for use in a Microsoft SharePoint Web part or in a custom 

program, and enables you to work with the report using Microsoft SQL Server Reporting Services.  

 

1. In the Navigation Pane, click Workplace, and then under My Work, click Reports.  

2. Select the report, and on the Actions toolbar, click Edit Report .  

3. On the Actions  menu, click Publish Report For External Use.  

Write a Report Using Report-Writing Tools 

You can use any ODBC-compliant application to read data directly from the Microsoft Dynamics CRM database. When 

possible, using built-in reporting tools is easier than using the steps in this procedure. Recommended alternatives:  

 Export Data to Excel  

 Create Customer-Ready Documents and Messages  

 Create, Edit, or Copy a Report Using the Report Wizard  
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Edit a default report or create a Reporting Services report  

 Can I do this task?  

This task requires the System Administrator or System Customizer security role or equivalent 
permissions. More information about specific permissions and performing this task while offline: Report 
Permissions  

The default reports in Microsoft Dynamics CRM are all Reporting Services reports. Default reports cannot be edited 

with the Report Wizard. To edit the default reports or create a new Reporting Services report other than one created 

by using the Report Wizard, you need a report development environment:  

 How to set up a report development environment 

Install the required components on your computer:  

 Microsoft Visual Studio, or any product that uses the Visual Studio.NET integrated 

development environment (such as Microsoft Visual Basic.NET).  

 Reporting Services Report Designer 

Reporting Services Report Designer 2005 can be installed from the Microsoft SQL Server 

2005 CD, and requires Visual Studio.NET 2005.  

 Make sure a security role assigned to your account includes the Publish Reports and Add 

Reporting Services Reports privileges.  

In addition to the required components, the following documentation is helpful:  

 Report Writers Guide section of the Microsoft CRM 4.0 Software Development Kit. More 

information: Writing Reporting Services Reports (Microsoft Dynamics CRM SDK)  

 Reporting Services Books Online provides help for Reporting Services. More information: 

SQL Server 2005 Reporting Services Books Online  

 

 

1. Identify the existing report that is closest in design to your new report.  

2. Download the report from Microsoft Dynamics CRM to a computer that is set up with the report 

development environment.  

a. In the Navigation Pane, click Workplace, and then under My Work, click Reports.  

b. On the Actions toolbar, click Edit Report , and then on the Actions  menu, click 

Download Report.  

c. Click Save, and specify the location in which to save the file. If you are creating a new 

report rather than modifying a report, rename the file.  

d. In the Download Complete dialog box, click Close.  

3. In a product using the Visual Studio integrated development environment (IDE), open the report, and 

make the required changes.  

If you are making major changes, first read Writing Reporting Services Reports (Microsoft Dynamics 

CRM SDK).  

4. Add the report to Microsoft Dynamics CRM.  

http://go.microsoft.com/fwlink/?LinkId=97586
http://go.microsoft.com/fwlink/?LinkId=98256
http://go.microsoft.com/fwlink/?LinkId=97586
http://go.microsoft.com/fwlink/?LinkId=97586


 

210 Microsoft Dynamics CRM 4.0 User’s Guide 
 

a. In the Microsoft Dynamics CRM Reports area, click New.  

b. In the Report Type box, select Existing File.  

c. In the File Location box, enter the path and file name of the dynamic or static file to add, 

or click Browse to locate the file.  

d. Edit the report properties:  

 Name 

The name for the report that is shown in the Reports area and on the Reports  

menu in forms and lists.  

 Description 

The description that is displayed in the Reports area.  

 Parent Report 

If this report is a sub-report or a drill-through report, specify an existing parent 

report. If this is not specified, the parent report will display a "Report not found" 

error.  

 Categories 

To specify the categories in which to include this report, click the Select Values 

button , and then select the categories. More information: System Settings Dialog 

Box - Reporting Tab  

 Related Record Types 

To have the report appear in the Reports list on a page for specific record types, 

click the Select Values button , and then select record types.  

For example, if your new report includes data from accounts and activities, select 

Accounts and Activities.  

 Display In 

To specify where reports should be visible, click the Select Values button , and 

then select one or more options:  

 Reports area  

Report will be displayed in the Reports area.  

 Forms for related record types  

Report will be displayed on the form for the record type you select in Related 

Record Types 

If the report is enabled for pre-filtering, from the record, users can specify 

running the report on the current record.  

 Lists for related record types  

Report will be displayed from specified list view pages.  

If the report has pre-filtering enabled, from the list view, users can specify 

running the report on selected records.  

 If no values are selected, the report will not be visible to end-users. To view or 

manage reports not visible to end-users, in the Reports area, select the All Reports, 

Including Sub-Reports view.  

 Languages 

If your Microsoft Dynamics CRM implementation has multiple languages enabled, 

specify a language. The report will be displayed for all users who have selected that 
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language in their personal options. To make this report available to all users, select 

All Languages.  

Note that this does not change the language used inside the report.  

e. Click Save.  

f. To modify the filter for the report, on the Actions toolbar, click More Actions, and then click 

Edit Default Filter.  

Tips 

 To share your new file with other users, do one of the following:  

 Add your file as a report in Microsoft Dynamics CRM, and select the report. On the More 

Actions menu, click Sharing, and specify users with whom to share the report.  

 If the report would be useful for all users, add your file as a report in Microsoft Dynamics 

CRM, and ask your system administrator to make it available to the organization. If you have 

the appropriate permissions:  

1. In the Microsoft Dynamics CRM Reports area, select the report.  

2. Click Edit Report .  

3. On the Actions  menu, click Make Report Available to Organization.  

 Put the report in a shared file system.  

 E-mail the report to other Microsoft Dynamics CRM users in the same domain.  

 If you don't want users to run the base report you started from:  

1. In the Reports area, select the report.  

2. On the Actions toolbar, click Edit Report .  

3. On the Actions  menu, click Revert to Personal Report.  
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Use Microsoft Office Word 2003  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Report Permissions  

There are several ways you can merge Microsoft Dynamics CRM data into Microsoft Office Word 2003. If you use 

Microsoft Office Word 2007, you can also use mail merge from Microsoft Dynamics CRM and from Microsoft Dynamics 

CRM for Outlook.  

 Export a list, such as the results of an Advanced Find search, into a dynamic or static Microsoft Office Excel file, 

and use the Excel file as the data source for a Microsoft Office Word 2003 mail merge. This does not create a 

Microsoft Dynamics CRM activity for each merged record. More information: Export Data to Excel  

 From Microsoft Office Word 2003, read data directly from the Microsoft Dynamics CRM database. This does not 

create a Microsoft Dynamics CRM activity for each merged record. This method is described in this topic.  

 

1. In Microsoft Office Word, on the Tools menu, point to Letters and Mailings, and then click Mail 

Merge.  

Follow the instructions in steps 1 and 2 of the Mail Merge pane.  

2. In step 3 of the Mail Merge instructions, select Use an existing list, and then click Browse.  

3. Click New SQL Server connection.odc, and then click Open.  

4. In the Server Name box, type the name of the server where the Microsoft Dynamics CRM database 

is stored, and then click Next.  

5. In the database list, select the Organization_MSCRM database.  

6. In the Name column, select a filtered view that starts with the prefix Filtered.  

7. Click Next, and then click Finish.  

8. Complete the mail merge by following the remaining steps in the Microsoft Office Word Mail Merge 

pane.  

Tip 

To share your new file with other users, do one of the following:  

 Add your file as a report in Microsoft Dynamics CRM, and select the report. On the More Actions 

menu, click Sharing, and specify users with whom to share the report.  

 If the report would be useful for all users, add your file as a report in Microsoft Dynamics CRM, and 

ask your system administrator to make it available to the organization. If you have the appropriate 

permissions:  

1. In the Microsoft Dynamics CRM Reports area, select the report.  

2. Click Edit Report .  

3. On the Actions  menu, click Make Report Available to Organization.  

 Put the report in a shared file system.  

 E-mail the report to other Microsoft Dynamics CRM users in the same domain.  
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Use Microsoft Office Word 2007  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Report Permissions  

There are several ways you can merge Microsoft Dynamics CRM data into Microsoft Office Word 2007.  

 From a list of records such as the results of an Advanced Find search, use mail merge to merge the data 

into Word 2007. You can create letters or e-mail activities for each record in the list. More information: 

Create Customer-Ready Documents and Messages  

 From Microsoft Dynamics CRM for Outlook, mail merge data from a list. You can create letters or e-mail 

activities for each record in the list. More information: Create Customer-Ready Documents and Messages  

 Export a list, such as the results of an Advanced Find search, into a dynamic or static Microsoft Office Excel 

file, and use the Excel file as the data source for a Microsoft Office Word 2007 mail merge. This does not 

create a Microsoft Dynamics CRM activity for each merged record. More information: Export Data to Excel  

 From Word, read data directly from the Microsoft Dynamics CRM database. This does not create a Microsoft 

Dynamics CRM activity for each merged record. This method is described in this topic.  

 

1. In Word 2007, on the Mailings tab, in the Start Mail Merge group, click Start Mail Merge.  

2. Click Step by Step Mail Merge Wizard.  

3. Follow the instructions in steps 1 and 2 of the Mail Merge pane.  

4. In step 3 of the Mail Merge instructions, select Use an existing list, and then click Browse.  

5. Click New SQL Server Connection.odc, and then click Open.  

6. In the Server name box, type the name of the server where the Microsoft Dynamics CRM database is 

stored, and then click Next.  

7. In the database list, select the Organization_MSCRM database.  

8. In the Name column, select a filtered view that starts with the prefix Filtered.  

9. Click Next, and then click Finish.  

10. Complete the mail merge by following the remaining steps in the Microsoft Office Word Mail Merge 

pane.  

Tip 

To share your new file with other users, do one of the following:  

 Add your file as a report in Microsoft Dynamics CRM, and select the report. On the More Actions 

menu, click Sharing, and specify users with whom to share the report.  

 If the report would be useful for all users, add your file as a report in Microsoft Dynamics CRM, and 

ask your system administrator to make it available to the organization. If you have the appropriate 

permissions:  

1. In the Microsoft Dynamics CRM Reports area, select the report.  

2. Click Edit Report .  
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3. On the Actions  menu, click Make Report Available to Organization.  

 Put the report in a shared file system.  

 E-mail the report to other Microsoft Dynamics CRM users in the same domain.  

Use Microsoft Office Excel 2003  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Report Permissions  

 

 

1. To create a PivotTable, in Excel 2003, on the Data menu, click PivotTable and PivotChart Report.  

– OR –  

To create a worksheet, in Excel 2003, on the Data menu, click Import External Data, and then 

click New Database Query.  

2. Create a new data source for the Microsoft Dynamics CRM database, or if you already have a data 

source set up that connects to the Microsoft Dynamics CRM database, connect to it.  

 To create a new data source:  

a. If you are creating a data source for a PivotTable, in the PivotTable and 

PivotChart Wizard - Step 1 of 3 dialog box, select External Data Source, click 

Next, and then click Get Data.  

b. In the Choose Data Source dialog box, select <New Data Source>, and then 

click OK.  

c. In the Create New Data Source dialog box, type a name for the data source, and 

then in the driver list, select SQL Server.  

d. Click Connect.  

e. In the SQL Server Login dialog box, in the Server list, select the Microsoft SQL 

Server or server instance where the Microsoft Dynamics CRM database is installed, 

and then click Options.  

f. In the Database box, select Organization_MSCRM, and then click OK three times.  

The Query Wizard dialog box opens.  

 To connect to an existing data source that uses the Microsoft Dynamics CRM database:  

a. If you are creating a data source for a PivotTable, in the PivotTable and 

PivotChart Wizard - Step 1 of 3 dialog box, select External Data Source, click 

Next, and then click Get Data.  

b. Select an existing data source that uses the Microsoft Dynamics CRM database, and 

then click OK.  

3. In the Query Wizard Available tables and columns list dialog box, select filtered views that start 

with the prefix Filtered. You can select columns within each filtered view, and select multiple 

filtered views.  

Caution To integrate with built-in security, only include filtered views in your query. If you connect 

directly to a database table, the spreadsheet may fail to return data for other users.  
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4. Continue with the Query Wizard. For more information about the Query Wizard, click the Help button 

to open Microsoft Query Help. For more information about importing external data to Excel, search 

for "import external data" in Excel Help.  

5. For PivotTables, in the PivotTable and PivotChart Wizard - Step 2 of 3 dialog box, click Next, 

and then click Finish. Then drag the fields as needed to your PivotTable.  

Tip 

To share your new file with other users, do one of the following:  

 Add your file as a report in Microsoft Dynamics CRM, and select the report. On the More Actions 

menu, click Sharing, and specify users with whom to share the report.  

 If the report would be useful for all users, add your file as a report in Microsoft Dynamics CRM, and 

ask your system administrator to make it available to the organization. If you have the appropriate 

permissions:  

1. In the Microsoft Dynamics CRM Reports area, select the report.  

2. Click Edit Report .  

3. On the Actions  menu, click Make Report Available to Organization.  

 Put the report in a shared file system.  

 E-mail the report to other Microsoft Dynamics CRM users in the same domain.  

Use Microsoft Office Excel 2007  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Report Permissions  

 

 

1. In Excel 2007, on the Data tab, in the Get External Data group, click From Other Sources, and 

then click From Microsoft Query.  

2. In the Choose Data Source dialog box, select <New Data Source>, and then click OK.  

3. In the Create New Data Source dialog box, type a name for the data source, and then in the driver 

list, select SQL Server.  

4. Click Connect.  

5. In the SQL Server Login dialog box, in the Server list, select the Microsoft SQL Server or server 

instance where the Microsoft Dynamics CRM database is installed, and then click Options.  

6. In the Database box, select Organization_MSCRM, and then click OK three times.  

The Query Wizard - Choose Columns dialog box opens.  

7. In the Query Wizard - Choose Columns dialog box, select filtered views that start with the prefix 

Filtered. You can select columns within each filtered view, and select multiple filtered views.  

Caution To integrate with built-in security, only include filtered views in your query. If you connect 

directly to a database table, the spreadsheet may fail to return data for other users.  

8. Continue with the Query Wizard. For more information about the Query Wizard, click the Help button 

to open Microsoft Query Help. For more information about importing external data to Excel, search 

for "import external data" in Excel Help.  
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Tip 

To share your new file with other users, do one of the following:  

 Add your file as a report in Microsoft Dynamics CRM, and select the report. On the More Actions 

menu, click Sharing, and specify users with whom to share the report.  

 If the report would be useful for all users, add your file as a report in Microsoft Dynamics CRM, and 

ask your system administrator to make it available to the organization. If you have the appropriate 

permissions:  

1. In the Microsoft Dynamics CRM Reports area, select the report.  

2. Click Edit Report .  

3. On the Actions  menu, click Make Report Available to Organization.  

 Put the report in a shared file system.  

 E-mail the report to other Microsoft Dynamics CRM users in the same domain.  

Use another report-writing tool  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Report Permissions  

 

 

1. Read the online Help for the application that you are using to determine how to read external data 

from a Microsoft SQL Server database.  

2. When selecting the data source, choose the SQL Server instance used by Microsoft Dynamics CRM and 

the Organization_MSCRM database.  

3. Select filtered views that start with the prefix Filtered and any fields from the filtered views that you 

want in your report.  

Tip 

To share your new file with other users, do one of the following:  

 Add your file as a report in Microsoft Dynamics CRM, and select the report. On the More Actions 

menu, click Sharing, and specify users with whom to share the report.  

 If the report would be useful for all users, add your file as a report in Microsoft Dynamics CRM, and 

ask your system administrator to make it available to the organization. If you have the appropriate 

permissions:  

1. In the Microsoft Dynamics CRM Reports area, select the report.  

2. Click Edit Report .  

3. On the Actions  menu, click Make Report Available to Organization.  

 Put the report in a shared file system.  

 E-mail the report to other Microsoft Dynamics CRM users in the same domain.  
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Using the Knowledge Base 

Using Articles in the Knowledge Base 

The knowledge base is a repository of an organization's information. This information is stored as articles, and is 

organized by subject. It can contain many different types of articles, such as:  

 Frequently Asked Questions (FAQs)  

 Common problems and their solutions  

 Schematics  

 Product user guides  

 Data sheets  

 Release schedules  

The knowledge base should include anything that would provide customer service representatives (CSRs) with the 

information that they need to answer questions about a product or service. CSRs can link an article to a case to track 

what information was given to the customer. Microsoft Dynamics CRM provides the tools and templates to create, edit, 

and publish browser-based content about your organization's products and services.  

Articles cannot be viewed in Microsoft Dynamics CRM for Microsoft Office Outlook when offline. 

Finding Articles 

In the knowledge base area, you can either browse the list of articles in the article queue or the subject tree. You can 

use the Search tab to create a search query with specific criteria. Search can return exact matches as well as possible 

matches. You can perform a full-text search to find specific references, or a keyword search to find articles by alternate 

terminology. You can search by title or article number.  

To improve your search results, you can add keywords to associate alternate terms to an article. For example, an article 

about fixing a bike tire might have the keywords patch, mend, and tube. Even if these exact words do not appear in the 

article itself, the search identifies and returns the article in the result set based on the keywords.  

You can also use Advanced Find anywhere in Microsoft Dynamics CRM to search for articles.  

Sending Articles 

CSRs can send articles directly to customers or to each other through e-mail, either from a case, or from any open e-

mail activity. For example, if there is an article that describes how to adjust a part, the CSR can send the article to the 

customer. The e-mail is recorded as an an e-mail activity.  

Work with Published Articles 

You can search or browse the knowledge base for published articles, view articles, print articles, or e-mail articles to 
customers. More information: Work with Articles 
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Find an article in the Knowledge Base  

 Can I do this task?  

This task requires permissions that are found in all default service security roles. More information about 
specific permissions and performing this task while offline: Service Permissions  

Search results do not include unpublished articles. 

 

1. In the Navigation Pane, click Service, and then click Knowledge Base.  

2. In the Search list, in the list, select a type of search.  

 Full Text Search  

This search looks through all of the words in all published articles to find articles that match 

your search criteria.  

 Keyword Search  

This search compares your search criteria with alternate terminology assigned to an article to 

find articles. For example, an article about bicycles might use keywords such as 

"bike,""cycle," or "trike."  

 Title Search  

This search look at the title of all published articles to find articles that match your search 

criteria.  

 Article Number Search  

This search looks for the number that is assigned to the article when it is published. If you 

know the article number, this is the fastest way to find a specific article.  

3. In the Search for box, type a word, phrase, keyword, or article number.  

4. To narrow your search by subject, locate and select a subject. You can click the Lookup button  

to search for a subject. If you want to search the entire database, do not select a subject.  

5. In the Options list, select Exact Text to search for the exact words that you enter in the Search for 

box, or select Use Like Words to search for similar words. For example, if you enter "run," the 

search would include "running" and "runs."  

6. Click Search to perform the search. 

The articles that match your criteria are displayed in the right pane. Double-click an article to open 

it.  

Important 

When you add a new article or comment to the knowledge base, you cannot search for it until the catalog index is 

updated. Microsoft Dynamics CRM updates the catalog index automatically every 15 minutes.  

Notes 

 If you want to view the article queues, in the Search list, select Article Queues, and then select the 

queue.  

 If you want to browse the subject tree for articles, in the Search list, select Subject Browse. When 

you expand the subject tree, the related articles appear in the right pane.  

 You can also view articles in the Workplace area, under My Work.  
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View unpublished articles 

 Can I do this task?  

This task requires a manager, vice president, CEO-Business Manager, System Administrator, or 
System Customizer security role or equivalent permissions. More information about specific 
permissions and performing this task while offline: Service Permissions  

 

 

1. In the Navigation Pane, click Service, and then click Knowledge Base.  

2. In the Knowledge Base area, you can do any of the following:  

 View a list of articles.  

The list of articles is displayed in the right pane.  

 Sort the articles.  

In the list of articles, click a heading to sort by that column. For example, to sort by title, click 

Title. To reverse the sort order, click the column heading a second time.  

  

 View an article and comments. 

a. On the Article Queues tab, click the Draft, Unapproved, or Published folder, and then open 

the article with the comments you want to read.  

b. In the article form, click the Comments tab.  

c. In the list, open the comment you want to read or append.  

d. When you finish, click OK to close the comment.  

Important 

When you add a new article or comment to the knowledge base, you cannot search for it until the catalog index is 

updated. Microsoft Dynamics CRM updates the catalog index automatically every 15 minutes. To update the results 

grid, click the Refresh button . 

Note 

You can also view articles in the Workplace area, under My Work.  

Add or delete a comment  

 Can I do this task?  

This task requires permissions that are found in all default service security roles. More information 
about specific permissions and performing this task while offline: Service Permissions  

You can use comments to collect corrections and additions to an article. 

 

1. In the Navigation Pane, click Service, and then click Knowledge Base.  

2. On the Article Queues tab, click the Draft, Unapproved, or Published folder to display the list of 

articles, and then open the article to which you want to add or delete a comment.  
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3. Click the Comments tab.  

4. Add a comment.  

a. On the Actions toolbar, click New Article Comment.  

b. In the Comment on This Article dialog box, in the Comment Title box, type a title for 

your comment.  

c. In the blank box, type your comment, and then click OK.  

5. Delete a comment.  

a. In the list of comments, select the comment you want to delete.  

b. On the Actions toolbar, click the Delete button , and then click OK.  

6. Click Save or Save and Close.  

Creating Workflows 

Creating and Using Workflows 

You can automate business processes by creating workflows and applying them to records or allowing Microsoft 

Dynamics CRM to apply them automatically. By using workflows to automate your business processes, you can:  

 Ensure consistency in how records are handled.  

 Ensure consistency in the information that is stored in your organization's Microsoft Dynamics CRM 

database.  

 Allow people in your organization to focus on growing your business instead of performing repetitive 

tasks.  

If you have the System Administrator or System Customizer security role, you have the necessary permissions to create 

workflows that can affect records throughout your organization's implementation of Microsoft Dynamics CRM. However, 

even if you do not have one of these security roles, you can still create workflows that affect the records that you own.  

Three ways to create workflows 

There are three ways that you can add workflows to your implementation of Microsoft Dynamics CRM:  

 Create workflows by using the Microsoft Dynamics CRM Web application. You can create workflows 

and workflow templates in the Settings area.  

 Create custom workflows and custom workflow actions by using the information that is available in the 

Microsoft Dynamics CRM 4.0 Software Development Kit. For more information, refer to the Microsoft 

Dynamics CRM 4.0 Software Development Kit.  

 Purchase custom workflows or custom workflow actions from third-party vendors who develop 

solutions that are compatible with Microsoft Dynamics CRM. For more information about how to 

integrate a third-party workflow or workflow action, contact the vendor.  

Creating workflows by using the Web application 

There are four basic steps to creating a workflow by using the Web application:  

1. Create an empty workflow or use a workflow template to create the workflow.  

2. Specify the workflow properties.  

3. Add conditions, workflow actions, and other elements that define your workflow logic.  

4. Publish the workflow.  
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Using workflows 

You use workflows by either applying an on-demand workflow yourself or by specifying when Microsoft Dynamics CRM 

should start an automatic workflow for you.  

Workflow Lifecycle 

If you want to use workflows to automate your business processes, it is important to understand the lifecycle of a 

workflow, from creation and publication through monitoring the workflow jobs created by the workflow.  

Creating workflows 

There are four basic steps to creating a workflow by using the Web application:  

1. Create an empty workflow or use a workflow template to create the workflow.  

2. Specify the workflow properties.  

3. Add conditions, workflow actions, and other elements that define your workflow logic.  

4. Publish the workflow.  

More information:  

 Work with Workflows  

 Workflow Structure  

Publishing workflows 

Before you can use the workflow you have created, you must publish it. Publishing a workflow changes its status from 

Draft to Published. Depending on the type of workflow you created, publishing a workflow also makes it available for 

use in various contexts:  

 If you have created an automatic workflow, the workflow starts to run when the criteria defined in its 

conditions are met.  

 If you have created an on-demand workflow, the workflow becomes available to you and other users 

from Microsoft Dynamics CRM menus and toolbars.  

 If you have created a child workflow, the workflow becomes available to be started from within other 

workflows.  

You can make a single workflow available in any combination of these three contexts.  

Monitoring workflow jobs 

Whenever the criteria defined in a workflow are met, or you decide to apply an on-demand workflow to a record, 

Microsoft Dynamics CRM creates a workflow job. By monitoring the workflow jobs created by a workflow, you can check 

progress and make sure that there have been no problems with the workflow, or its workflow jobs.  

Workflow Structure 

All workflows in Microsoft Dynamics CRM are a combination of workflow properties and workflow logic. Workflow 

properties and workflow logic form the structure of each workflow record.  

Workflow properties 

Workflows include a number of options and settings, called workflow properties that are required as part of any 

workflow in Microsoft Dynamics CRM.  

At a minimum, each workflow requires the following properties:  
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 Name.  

 Entity. Although a workflow can take action on more than one entity, it is still associated with a single 

primary entity.  

 Scope. A workflow's scope determines the records that the workflow can take action on. The scope is 

limited by the permissions that the workflow's owner has, as well as by the view the owner selects 

for the scope when they are creating the workflow.  

 Type. You can select whether the workflow you create is a workflow or workflow template.  

 How automatic workflows are started. You can specify what events in your Microsoft Dynamics 

CRM implementation will cause the workflow to take action, such as the creation of a new lead 

record or a specific change to a case record.  

 Availability. In addition to workflows that run automatically when certain events occur, you make the 

workflow available as an on-demand workflow, a child workflow, or both.  

Workflow logic 

The workflow logic you add to your workflow determines the specific actions that the workflow will take on records.  

Workflow logic includes the following elements:  

 Stages. By adding workflow stages to your workflow logic, you can group the steps in your workflow. 

Workflow stages make the workflow logic easier to read, and explain the workflow logic. However, 

stages do not affect the logic or behavior of workflows. 

Workflow stage descriptions appear as headings in system job forms, which display the progress of 

a workflow job. Stage descriptions can also appear in reports. 

You can use stages to define business processes that your organization uses. For example, one 

workflow could use stages to describe the opportunity management process for your sales team, 

while another workflow could define the case resolution process for your customer service 

representatives.  

 Steps. Each workflow step you add defines the underlying logic of your workflow. Workflow steps can 

contain actions, such as creating a new record or sending an e-mail notification, or even other 

steps. (There is no limit to how deeply you can nest workflow steps.)  

You can add the following types of steps to workflows:  

 Check condition 

 Conditional branch 

 Default action 

 Wait condition 

 Parallel wait branch 

 Custom step 

 Actions. By adding workflow actions to workflow steps, you define the specific actions you want the 

workflow to perform.  

You can add the following actions to workflows:  

 Create a record  

 Update a record  

 Assign a record  
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 Send an e-mail notification  

 Start a child workflow 

 Change the status of a record  

 Stop the current workflow  

 Perform a custom workflow action  

Work with Workflows 

By creating workflows, you can create the business logic necessary to automate some or all of your business processes.  

Concepts:  

 Start an On-Demand Workflow  

 Creating and Using Workflows  

 Workflow Lifecycle  

 Workflow Structure  

 Monitoring and Managing Workflows  

Create or edit a workflow  

 Can I do this task?  

This task requires the System Administrator or System Customizer security role or equivalent 
permissions. Customization tasks can be performed only while you are online. More information: 
Customization Permissions  

 

 

1. In the Navigation Pane, click Settings, and then click Workflows.  

2. On the Actions toolbar, click New.  

3. In the Create Workflow dialog box, set required properties for the workflow.  

a. In the Workflow name box, type the name that you want to use for this workflow.  

b. From the Entity list, select the primary entity that you want to use with this workflow.  

c. In the Type area, select whether you want to create a completely new workflow or whether 

you want to use a workflow template.  

If you want to view details about the workflow template, select the workflow template and 

click Properties.  

d. Click OK.  

4. In the Workflow Properties area in the top half of the Workflow form, set additional properties for 

the workflow.  

a. If you plan to publish this workflow to automate your business processes, from the Publish 

As list, select Workflow.  

– OR –  

If you plan to publish this workflow as a workflow template, from the Publish As list, select 

Workflow Template.  
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b. Under Available to Run, select how you want to make the workflow available to other 

users in your organization:  

 On demand. If you want to make the workflow available as an on-demand workflow, 

select this check box.  

 As a child workflow. If you want to make the workflow available as a child 

workflow, select this check box.  

c. If you are creating an automatic workflow, under Options for Automatic Workflows, set 

options unique to workflows that run automatically:  

 Scope. Select the access level that matches the workflow scope that you want to set 

for this workflow.  

Note: The items available to you in this list depend on the privileges that have been 

assigned to your security role for the workflow's primary entity.  

 Start when. Select the check boxes that correspond to the events in your 

implementation of Microsoft Dynamics CRM that you want to start the workflow.  

Note: If you select the Record attributes change check box, you must click 

Select and specify the attributes of the primary entity that you want the workflow to 

monitor for changes.  

5. Add stages to your workflow logic.  

In the Workflow Logic area in the lower half of the Workflow form, you can add workflow stages 

to your workflow logic.  

a. Select the line in your workflow logic where you want to add the workflow stage.  

b. On the Workflow Logic toolbar, click Add Step and select Stage.  

c. Click OK.  

d. Click Type a stage description here and replace the default text with a description of 

what your workflow stage includes.  

Note: If you want to add more stages to your workflow, first click the area to the left of the existing 

workflow stage. Next, click the Insert menu and select whether you want to add the stage above 

or below the one you selected. Click Add Step, select Stage, and click OK.  

6. Add steps to your workflow logic.  

In the Workflow Logic area in the lower half of the Workflow form, you can add workflow steps to 

your workflow logic.  

Tip: You can repeat these steps to add whatever steps you want to include in your workflow logic.  

a. Select the line in your workflow logic where you want to add the workflow step.  

b. On the Workflow Logic toolbar, click Add Step and select one of the following items:  

 Check Condition. Adds a check condition to the workflow. You can add a check 

condition at any level in your workflow logic.  

After you have added a check condition to your workflow, you can add one or more 

conditional branches and a default action to the check condition:  
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 Conditional Branch. Adds a conditional branch to the workflow. To add a 

conditional branch, you must select the If line in a check condition or the 

Otherwise, if line in another conditional branch.  

Note that more than six levels of conditional branching are not displayed.  

 Default Action. Adds a default action to the workflow. You can include only 

one default action associated with a check condition. To add a default action, 

you must select the If line in a check condition or the Otherwise, if line in a 

conditional branch.  

 Wait Condition. Adds a wait condition to the workflow. You can add a wait condition 

at any level in your workflow logic.  

After you have added a wait condition to your workflow, you can add one or more 

parallel wait branches to the wait condition:  

 Parallel Wait Branch. Adds a parallel wait branch to the workflow. To add a 

parallel wait branch, you must select the Wait until line in a wait condition or 

the Otherwise, wait until line in another parallel wait branch.  

c. Click <condition>.  

d. In the Specify Workflow Condition dialog box, select the condition for the workflow step:  

Tip: After you specify one condition, move your cursor over the area to the right of the 

condition you just specified. New fields appear, in which you can specify additional details 

about the condition.  

i. In the first list, select a primary entity or related entity.  

ii. In the second list, select an attribute in the entity you selected in the previous step.  

iii. In the third list, select the logical operator that best fits the condition you want to 

specify, such as Contains or Equals.  

iv. In the last lists or boxes, enter the value that you want to use as the criteria for your 

workflow condition.  

v. Click Save and Close.  

Tip: You can specify multiple conditions for a single workflow step. After you select an entity 

from the first column, a second line appears, where you can specify another condition. The 

workflow considers the conditions to have been met only when an event matches all of the 

criteria.  

 On the Workflow form, click Type a step description here and replace the default text 

with a description of what your workflow step includes.  

 Add actions to your workflow logic.  

In the Workflow Logic area in the lower half of the Workflow form, you can add workflow actions 

to your workflow logic.  

Tip: You can repeat these steps to add whatever actions you want to include in your workflow logic.  

 Select the line in your workflow logic where you want to add an action.  

 On the Workflow Logic toolbar, click Add Step and select one of the following items:  

 Create Record. Creates a new record. From the Create list, select the entity for 

which you want to create individual records.  
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 Update Record. Updates a record. From the Update list, select the record that you 

want to update.  

 Assign Record. Assigns a record from one user to another user. From the Assign 

list, select the record that you want to reassign, and then click the Lookup 

button  and select the user you want to assign the record to.  

 Send E-mail. Sends an e-mail notification. From the Send e-mail list, select 

whether you want to create a new e-mail message or use an E-mail Template.  

 Start Child Workflow. Starts a child workflow. From the Start child workflow list, 

select the primary entity of the child workflow you want to use, and then click the 

Lookup button  and select the child workflow.  

 Change Status. Changes the status of a record. From the first Change status list, 

select the record that you want to change the status of, and then select the status 

from the second list.  

 Stop Workflow. Stops the current workflow. From the Stop workflow with 

status of list, select the status that you want to set for the stopped workflow.  

 If a Set Properties button appears next to the new action you added, click Set Properties 

and specify details about the entity that this step in your workflow is taking action on.  

 Click Type a step description here and replace the default text with a description of what 

your workflow step includes.  

 Click Save or Save and Close.  

Note 

If you use a wait condition to wait for a timeout, you will no longer be able to change the timeout condition (you can 

change individual details for the timeout, but you cannot change the timeout to another type of condition). If you need 

to change the conditions, delete the timeout and add a new wait condition.  

Add or change dynamic values in a workflow  

 Can I do this task?  

This task requires permissions that are found in all default security roles. Customization tasks can be 
performed only while you are online. More information: Customization Permissions  

You can use dynamic values in the entities or records that you use in a workflow, as well as in the conditions in 
your workflow logic.  

 

1. In the Navigation Pane, click Settings, and then click Workflows.  

2. Open the workflow that includes fields where you want to use dynamic values.  

3. If you want to add dynamic values to fields in a workflow condition, open the condition that includes 

the fields.  

– OR –  

If you want to add dynamic values to fields in an entity or record that a workflow action uses, click 

Set Properties for that entity or record.  

4. If the Form Assistant pane is not displayed, click the Expand button .  
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5. Click the field where you want to insert a dynamic value.  

6. Under Dynamic Values in the Form Assistant pane, from the Operator list, select a logical 

operator.  

7. From the first list under Look for, select the entity or record that includes the attributes you want to 

insert as dynamic values.  

8. From the second list under Look for, select the specific attribute you want to insert, and then click 

Add.  

9. If you want Microsoft Dynamics CRM to insert alternative attribute values in cases when the attribute 

you specified in steps 4 through 6 is empty, repeat these steps to add additional attributes, and 

then use the Move Up and Move Down buttons to arrange the attributes in the order that you 

want Microsoft Dynamics CRM to evaluate them.  

10. If you want Microsoft Dynamics CRM to insert static text when none of the attributes you have 

specified contain any data, in the Default text box, type the text that you want Microsoft Dynamics 

CRM to display instead of a dynamic value.  

11. Click OK.  

The dynamic values appear as yellow boxes in the field where you inserted them.  

12. In the form for the entity, record, or conditions used in your workflow, click Save and Close.  

13. In the Workflow form, click Save or Save and Close.  

Note 

You cannot edit dynamic values that you have already inserted in a field. To change a dynamic value, you must remove 

the old value and add a new one. Select the yellow box in the field for the value you want to change, press the DELETE 

key on your keyboard, and then add the dynamic value you want to use in its place.  

Publish or unpublish a workflow  

 Can I do this task?  

This task requires permissions that are found in all default security roles. Customization tasks can be 
performed only while you are online. More information: Customization Permissions  

Publishing a workflow makes it available to use as an automatic workflow, on-demand workflow, or child 
workflow. Unpublished workflows that are in a draft state cannot be used.  

 

1. In the Navigation Pane, click Settings, and then click Workflows.  

2. Select the workflow that you want to publish or unpublish.  

3. To publish a workflow, on the Actions toolbar, click Publish.  

– OR –  

To unpublish a workflow, on the Actions toolbar, click Unpublish.  

4. In the confirmation message, click OK.  

Note 

You cannot unpublish workflows that have active workflow jobs. Before you unpublish a workflow, check for any active 

workflow jobs and cancel them. More information: Work with System Jobs  
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Start an On-Demand Workflow 

If you or your organization have created on-demand workflows, you can apply these workflows to records that appear 

in a list.  

Concepts:  

 Creating and Using Workflows  

 Monitoring and Managing Workflows  

 

Start an on-demand workflow  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Common Task Permissions  

 

 

1. Open the list of records that contains the record you want to apply a workflow to, such as leads or 

cases.  

2. Select the record or records that you want to apply a workflow to.  

3. On the Actions toolbar, click Run Workflow.  

4. In the Look Up Records dialog box, select the workflow that you want to run, and then click OK.  

5. In the confirmation message, click OK.  

Note 

The Run Workflow button does not appear on the Actions toolbar if no on-demand workflows have been created for 

the record type that you are viewing.  

Communicating with other Microsoft Dynamics CRM Users 

Work with Announcements 

You can view Announcements in the Workplace area.  

View announcements  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Configuration Permissions  

 

 

 Under Workplace, click Announcements.  
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Create or edit an announcement  

 Can I do this task?  

This task requires a manager, vice president, CEO-Business Manager, System Administrator, or 
System Customizer security role or equivalent permissions. More information about specific 
permissions and performing this task while offline: Configuration Permissions  

 

 

1. In the Navigation Pane, click Settings, click Administration, and then click Announcements.  

2. On the Actions toolbar, click New.  

3. On the Announcement tab, enter information or observe any noted restrictions or requirements as 

needed:  

 Title 

Enter a title that clearly and unambiguously describes the nature and purpose of the 

announcement.  

 Body 

Enter the entire text of the announcement. You can cut and paste an announcement text 

from another application. However, any formatting will be lost.  

4. Under Additional Settings, you can also enter additional information.  

 More Information URL 

Enter a Web address path for a Web site with more details related to the announcement. A 

Web address that does not include "http://" is automatically expanded to a full Web address. 

In the announcement, the Web address is an active external link.  

 Expiration Date 

Enter the expiration date for the announcement, or click the Select Date button  to 

select the date.  

When an announcement expires, its expiration date cannot be updated. Microsoft Dynamics 

CRM removes it from the Announcements area, and you must create a new announcement.  

5. Click Save or Save and Close.  

Note 

You must enter the date in the format your organization has set for dates. For example, 01/01/2006 or 31.12.2005.  

If you omit leading zeros in a date, Microsoft Dynamics CRM will add them automatically. For example, when you type 

1/1/06, Microsoft Dynamics CRM will display it as 01/01/2006, if that is the date format of your organization.  
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Work with Integrated Instant Messaging 

Work with Integrated Instant Messaging  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Common Task Permissions  

If you have Microsoft Office Communicator 2007, MSN Messenger, or Live Messenger installed, you can send an 

instant message to any user, contact, or opportunity, or lead in Microsoft Dynamics CRM with an e-mail address and 

using one of the instant messaging applications listed.  

Note You may need to add the Microsoft Dynamics CRM server URL to the list of Internet Explorer trusted sites for 

the online presence to display. See online Help in Internet Explorer for instructions. 

 Record types and columns that can display online presence 

 Contact records: Full Name  

 Lead records: Primary Contact  

 Opportunity records: Potential Customer  

 All customer records: Users  

 All customer records: Owner  

 All customer records: Modified By  

To access the Communicator menu, click the Online Presence Jewel . 

 A green jewel indicates the person can receive an instant message and is available.  

 A red jewel indicates the person is busy. You can send a message, but they may not respond immediately.  

 A yellow jewel indicates the person is away or out of the office.  

 A peach jewel indicates the person's online status is unknown. There are other communication methods 

available from the menu.  

Enabling online presence 

There are two ways to enable the online presence for a personal view. By adding the associated e-mail address for a 

user or contact, enables online presence on the related column. For example, adding the owner's e-mail column to a 

view, enables the presence on the owner column. See the list above.  

If you do not want to include the e-mail column, you can also customize the view to enable online presence.  

These two example procedures describe how to add a presence to a saved view. If you have the correct permissions, 

you can also edit a system view for an entity to enable the presence. More information: Work with Views  

 To add an e-mail column to a saved view 

a. In the list view you want to add online presence, click Advanced Find.  

b. In the Advanced Find form, click Edit Columns.  
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c. In Common Tasks, click Add Columns  

d. Select one of the e-mail related checkboxes, for example: E-mail.  

e. Click OK twice.  

f. In the Advanced Find form, click Find.  

To save the view, click Back to Query, and then on the Actions toolbar, click Save As. 

 To enable the online presence on a column in a saved view 

a. In the Accounts or Contacts area, click Advanced Find.  

b. In the Advanced Find form, click Edit Columns.  

c. Do one of the following:  

a. Select one of the columns that can display online presence, such as Full Name and 

then click OK.  

b. Select the column, and then click Change Properties.  

c. Select the Enable Presence for this column check box, and then click OK.  

d. To save your changes and close the dialog box, click OK.  

e. In the Advanced Find form, click Find.  

To save the view, click Back to Query, and then on the Actions toolbar, click Save 

As. 

 

Note 

You cannot enable presence on columns for related record types, or on deleted columns. 
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Chapter 2: Sales 

This chapter details information about using the sales module in Microsoft Dynamics 

CRM. 
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Managing Customer Relationships 

Managing Accounts and Contacts 

In Microsoft Dynamics CRM, you can manage, share, and collaborate on accounts and contacts within your 

organization. The logging and tracking features benefit the person who makes the sale, his or her sales team, other 

supporting teams, and their management. All activities, such as e-mail, phone calls and meetings, are logged and a 

running history of every activity with the account or contact is kept.  

You can enter accounts or contacts individually or you can use Microsoft Dynamics CRM to import lists of these records 

into the database. You might already have customer records in Microsoft Office Outlook or Microsoft Office Excel that 

you can import using the Import Data Wizard, and then use the account list or contact list to view or open the records 

to make sure that all the information is imported successfully.  

Deciding between Using Accounts and Contacts 

Accounts are companies that you do business with, whereas contacts represent individuals or specific representatives 

for an account. Therefore, if you have mostly businesses that you sell to, then you will primarily create account records. 

However, if you typically provide goods or services to individuals, then you will want to create contact records.  

Even if you only sell to individuals, you might still find accounts useful for tracking your competitors or vendors. You 

can have one or more contacts associated with a single account, but only one of the contacts can be designated as the 

primary contact. You can create and edit accounts or contacts from the Workplace, Sales, Marketing, and Services 

areas.  

You can create a relationship between accounts and contacts, specify the type of relationship between them, and 

define the relationship role that the account or contact has with regard to the primary record. For example, if you add a 

contact as a relationship to an account, anyone who views the contact data will see that the individual can influence the 

purchasing choices of the account.  

Adding Sales Transactions 

You can start a sales transaction, such as a quote, order, or invoice, from within an account or a contact record. The 

advantage of starting sales transactions this way is that much of the information is automatically entered based on the 

account or contact data. You can also view any sales transaction records from within these customer records to track 

the overall sales process and expected revenue.  

Adding Services 

You can create a case or contract from within an account or contact record. When you save the record, it is 

automatically linked to the account or contact. This information provides sales staff with important details about the 

type of service the customer is entitled to receive.  

Managing Customer Records for Campaigns 

You can add customer records to marketing lists that already exist as part of your marketing efforts directly from the 

account or contact form. You can also view related campaign information from within a customer record. In addition, 

you can use a quick campaign to run an activity for either a selected customer record, a page of customer records, or 

all customer records for a particular view.  

Note 

If you are working offline, you can create a relationship between two records and specify details about the relationship. 

However, you must go online before the changes take effect.  
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Work with Accounts  

Accounts represent companies that your organization may do business with. Concepts: Managing Accounts and 

Contacts  

Create or edit an account  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Sales Permissions  

 

 

1. In the Navigation Pane, click Sales, and then click Accounts.  

2. On the Actions toolbar, click New, or open the record that you want to edit.  

3. On the General tab, enter information or observe any noted restrictions or requirements as needed:  

 Account Name  

You can use accent marks when you enter data, for example, in a customer's name. Your 

ability to sort and find information is not affected by these accent marks.  

 Account Number  

You must enter a number of 20 characters or less.  

 Parent Account  

If the account you are creating is a sub-account, then you will want to set up a relationship to 

its parent account.  

To locate and select a parent account, click the Parent Account box. You can select a record 

from a filtered list in the Form Assistant pane, or you can click the Lookup button  to 

search for other records. If you are creating a parent account, leave this field blank.  

 Primary Contact  

To locate and select a primary contact, click the Primary Contact box. You can select a 

record from a filtered list in the Form Assistant pane, or you can click Lookup to search for 

other records.  

 Relationship Type  

Select an option from the list. This field can be customized, so the values will vary.  

Your organization might set up relationship roles, to indicate the role of your customers as 

they relate to your business. This field is not required.  

If there are no relationship roles in the list or the relationship role you want is not listed, 

contact your system administrator and ask them to add the relationship role to the 

Relationship Roles area, which is located in the Settings area.  

 E-mail  

E-mail addresses must be valid. For example, someone@microsoft.com. Although this field 

is optional, including an e-mail address allows you to communicate with the account by using 

e-mail.  

 ZIP/Postal Code  

Enter a code of 20 characters or fewer. Although this field is optional, including a ZIP Code or 
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postal code can provide basic geographical information about the account that you can use in 

other areas of the application, such as reports and workflows.  

4. On the Details tab, observe any noted restrictions or requirements and enter all the information you 

have available in the following fields:  

 Territory  

You can select a record from a filtered list in the Form Assistant pane, or you can click 

Lookup to search for other records.  

This field can be customized, so the values will vary. If there are no territories in the list or 

the territory you want is not listed, contact your system administrator and ask them to add 

the territory to the Sales Territories area, which is located in the Settings area.  

 Category  

Select an option from the list. This field can be customized, so the values will vary.  

The default values are Preferred Customer and Standard. Your organization might add 

other values to manage territories.  

These values help determine how to set up territories so that your organization has roughly 

an equal number of highly rated accounts. It might also reflect the priority of the account.  

 Industry  

Select an option from the list. This field can be customized, so the values will vary.  

If the account specifies an industry that is not in the list, you can work with your system 

administrator to get new industries added to the list. This field is used in various reports such 

as Account Overview.  

Another form that includes the industry field is the lead form. If your system administrator 

adds custom industries to the account form, he or she should also add them to the lead form 

to keep the two lists in synch.  

 Annual Revenue  

You must enter numbers between 0.00 and 1,000,000,000.00.  

You can use commas and a decimal point, but you cannot use a currency symbol, such as the 

dollar ($), euro (€), or yen (¥).  

 No. of Employees  

You must enter a whole number between 0 and 1,000,000.  

 SIC Code  

Indicate the Standard Industrial Classification (SIC) code for this account. You can search on 

SIC for organizations with a particular code to display all accounts of businesses in that 

category. Enter a code of 20 characters or fewer.  

 Ownership  

Select an option that indicates how shares of the company are held. For example, if the 

company is held publicly, meaning its stock is traded on the open market, then its ownership 

would be public.  

 Ticker Symbol  

If you enter a ticker symbol for a market outside the United States, you must prefix it with 

the country code, for example US:MSFT (country code:ticker symbol). This information is 

available only for markets that are currently listed on the MSN Money Web site. In addition to 

the United States (US), MSN Money also provides information for markets in Australia (AU), 
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Belgium (BE), Canada (CA), France (FR), Germany (DE), Great Britain (GB), Italy (IT), Japan 

(JP), Netherlands (NL), Spain (ES), and Sweden (SE). For more information, go to the MSN 

Money Web site.  

5. On the Administration tab, enter information or observe any noted restrictions or requirements as 

needed:  

 Owner  

This box is filled automatically with the name of the user who is creating the record. You can 

click the Lookup button  to search for other records.  

 Originating Lead  

If this account was the result of converting a lead, then this field will automatically show the 

lead record. You can also enter the originating lead.  

To locate and select a lead, click the Originating Lead box. You can select a record from a 

filtered list in the Form Assistant pane, or you can click Lookup to search for a lead.  

 Credit Limit  

This field is not used as part of the business logic in Microsoft Dynamics CRM; however, your 

organization might use it as part of a workflow process.  

 Credit Hold  

This field is not used as part of the business logic in Microsoft Dynamics CRM; however, your 

organization might use it as part of a workflow process.  

 Payment Terms  

This field is mapped to any orders that are created for the record.  

 Price List  

If your organization has price lists set up, you can use Lookup to search for and select the 

appropriate price list.  

This field is mapped to any orders that are created for the record.  

 Contact Methods  

o Preferred  

Select the option that best describes the preferred method of contact.  

o E-mail  

If you select Allow, Microsoft Dynamics CRM allows all e-mail, including e-mails 

related to campaign activities, to be sent to the e-mail address associated with the 

record. However, if you select Do Not Allow, Microsoft Dynamics CRM does not allow 

any e-mail to be sent to the e-mail address associated with the record.  

o Bulk E-mail  

If you select Allow, Microsoft Dynamics CRM allows any e-mail as part of a bulk e-mail 

process, including bulk e-mails related to campaign activities, to be sent to the e-mail 

address associated with the record. However, if you select Do Not Allow, Microsoft 

Dynamics CRM does not allow any bulk e-mail to be sent to the e-mail address 

associated with the record.  

o Phone  

The selected option simply provides information to anyone who views the record. This 

field is not used by Microsoft Dynamics CRM to control initiating or receiving phone 

calls.  

http://go.microsoft.com/fwlink/?LinkId=95957
http://go.microsoft.com/fwlink/?LinkId=95957
http://go.microsoft.com/fwlink/?LinkId=95957
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o Fax  

The selected option simply provides information to anyone who views the record.  

o Mail  

The selected option simply provides information to anyone who views the record. This 

field is not used by Microsoft Dynamics CRM to control initiating or receiving mail.  

 Marketing Information  

o Send Marketing Materials  

If you select Yes, marketing material corresponding to campaigns is sent to the 

respective addresses (e-mail, physical address) for the record. This includes general 

marketing mailers that might be sent on a regular basis that are not part of a targeted 

marketing campaign. If you select No, marketing materials are not sent, nor can 

activities related to sending marketing materials be created for the record.  

o Last Date Included in Campaign  

Microsoft Dynamics CRM automatically sets the date for this field when any marketing 

communication is sent to the addresses for the record. You can also manually update 

this field and enter a date. This field is used as filter criteria in Marketing Automation. 

For example, the Anti-spam Setting area of a Campaign form uses the date in this 

field to ensure that you do not send frequent mailers to a customer.  

 Service Preferences  

Select the customer's preferred time and day for appointments.  

 Click the Preferred Service, Preferred Facility/Equipment, or Preferred User box to 

search for the appropriate record.  

You can select a record from a filtered list in the Form Assistant pane, or you can click 

Lookup to search for other records.  

6. On the Notes tab, click Click here to enter a new note, and add the information that applies to 

your record.  

7. Click Save or Save and Close.  

 Resolve potential duplicate records.  

1. If the system detects that your record might be a potential duplicate, instead of saving the 

record, you'll see the Duplicates Detected dialog box.  

2. To open a record to make sure it is a potential duplicate, in the Potential duplicate records 

list, double-click the record.  

 If the duplicate-detection rule identified potential duplicate records in other record 

types, review records from each record type listed.  

3. If your new or updated record is not a duplicate, to create the new record, click Save Record.  

– OR –  

If your new or updated record is a duplicate, to cancel your changes, click Cancel.  

Notes  

 If you enter a duplicate record within a few minutes of entering the first record, Microsoft 

Dynamics CRM will not detect the duplicate record. The matchcodes for new and updated 

records are created every five minutes, rather than as a record is created.  
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Duplicate detection can take place only if duplicate detection is enabled in Duplicate Detection Settings 
and if at least one duplicate-detection rule exists for the record type. More information: Avoiding Duplicate 
Records  

Tips 

 You can add more addresses to handle various locations for a given account or contact. To do this, 

under Details, click More Addresses, and then on the Actions toolbar, click New Address.  

 When the Look Up Records dialog box is open, if the record you need doesn't exist, click New, and 

create the record.  

 If you create both accounts and subaccounts, and create relationships between them, then you can 

use the reporting features to get subtotals or total revenue reports for all the related accounts.  

Associate an opportunity with an account or contact  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Sales Permissions  

You associate opportunities with accounts or contacts by creating an opportunity relationship between them. The 
relationship you set up is based on your selection in the Opportunity Relationship dialog box. Therefore, if 
you want to create an opportunity relationship with the specific account or contact that you open, make sure 
that you select that record.  

 

1. In the Navigation Pane, click Sales, and then click either Accounts or Contacts.  

2. In the list of accounts or contacts, open the record to which you want to add an opportunity 

relationship.  

3. On the Actions  menu, point to Add Relationship, and then click Opportunity.  

4. In the Opportunity Relationship dialog box, enter information in the following boxes:  

 Opportunity  

You must select the opportunity that will be associated with the record. Click the Lookup 

button  to search for an opportunity.  

 Customer  

This field is automatically filled with the account or contact record.  

 Customer Role  

Select an option from the list. This field can be customized, so the values will vary.  

Your organization might set up relationship roles, to indicate the role of your customers as 

they relate to your business. This field is not required.  

If there are no relationship roles in the list or the relationship role you want is not listed, 

contact your system administrator and ask them to add the relationship role to the 

Relationship Roles area, which is located in the Settings area.  

 Description  

Use this field to provide additional information about the relationship.  

5. Click Save or Save and Close.  

Repeat this step to save the account or contact.  
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Note 

You cannot set up duplicate relationships between a customer record and an opportunity. For example, if you create a 

relationship between an account and the opportunity, and the customer's relationship role is set to Distributor, you 

cannot create a new relationship for the account that uses the same customer opportunity and relationship role.  

Set customer preferences for a service activity  

 Can I do this task?  

This task requires permissions that are found in all default service scheduling security roles. More 
information about specific permissions and performing this task while offline: Service Scheduling 
Permissions  

You can provide personalized customer service for your customers by recording their preferences regarding 
services and service times. These preferences become the default criteria the next time that a service activity is 
scheduled for the customer and they are offered in the Form Assistant pane.  

 

1. In the Navigation Pane, click Workplace, and then under Customers, click either Accounts or 

Contacts.  

2. In the list, open the record you want.  

3. Under Details, click Information.  

4. On the Administration tab, under Service Preferences, select the customer's preferred time and 

day for appointments.  

5. Click the Preferred Service, Preferred Facility/Equipment, or Preferred User box to search for 

the appropriate record. You can select a record from a filtered list in the Form Assistant pane, or 

you can click the Lookup button  to search for other records.  

6. Click Save or Save and Close.  

Add or remove a customer record in a marketing list  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Sales Permissions  

You can add a customer record, such as a lead, account, or contact, to a marketing list. If a customer record is 
added to a marketing list from another area within Microsoft Dynamics CRM, the customer record is updated to 
reflect this association. Therefore, if you want to add a customer record, such as a lead, to a marketing list, you 
might find that the lead is already associated with the list.  

 

1. In the Navigation Pane, click Sales, and then click Leads, Accounts, or Contacts depending on 

which type of record you want to add to a marketing list.  

2. In the list, open the record that you want to add to a marketing list.  

3. Under Marketing, click Marketing Lists.  

4. On the Actions toolbar, click Add to Marketing List.  

5. In the Look Up Records dialog box, locate and select the marketing list you want to add the record 

to, and then click OK.  

6. Click Save or Save and Close.  
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Note 

To remove a record from a marketing list, open the customer record you want to remove from the marketing list. On 

the Actions toolbar, click More Actions, and then click Remove. In the confirmation message, click OK.  

Tip 

If you cannot locate the marketing list you want to add, you might need to create it. To do this, in the Look Up 

Records dialog box, click New and then complete the form.  

View associated campaigns from customer records  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Sales Permissions  

You can view a list of campaigns for a customer from within the Customer Record form. When a customer record 
is added to a marketing list and that marketing list is added to a campaign, the customer record is updated to 
reflect this association.  

 

1. In the Navigation Pane, click Sales, and then click Leads, Accounts, or Contacts, depending on 

which type of record you want to view associated campaigns for.  

2. In the list, open the record that you want to view.  

3. Under Marketing, click Campaigns to see the list of campaigns the customer is included in.  

Add or remove a customer relationship for an account or contact  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Sales Permissions  

In Microsoft Dynamics CRM, you can create relationships between one customer record and one or more other 
records. These relationships are defined by their relationship role. The relationship that you set up is based on 
your selection in the Customer Relationship dialog box. If you want to create a relationship between the 
account or contact that you are working with and another specific account or contact, make sure that you select 
that account or contact.  

 

1. In the Navigation Pane, click Sales, and then click either Accounts or Contacts.  

2. In the list of accounts or contacts, open the record to which you want to add a customer relationship.  

3. Under Details, click Relationships, and then on the Actions toolbar, click New Customer 

Relationship.  

4. In the Customer Relationship dialog box, enter information in the following boxes:  

 Party 1  

This field automatically displays the name of the customer that you opened in step 2.  

However, you can also click the Lookup button  to search for and select a different 

account or contact record. If you do so, the new relationship you set up will not appear in the 

customer record you originally opened.  
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 Party 2  

Select the customer record to associate with the Party 1 record. Click the Lookup 

button  to search for an account or contact record.  

 Role 1  

Select an option from the list. This field can be customized, so the values will vary.   

Your organization might set up relationship roles, to indicate the role of your customers as 

they relate to your business. This field is not required.  

If there are no relationship roles in the list or the relationship role you want is not listed, 

contact your system administrator and ask them to add the relationship role to the 

Relationship Roles area, which is located in the Settings area.  

 Description 1  

Use this field to provide additional information about the relationship.  

 Role 2  

From the list, select the relationship role that best describes the relationship of Party 1 to 

Party 2. The same items will appear in both lists.  

For example, if you selected Supplier from Role 1, you might select Retailer from Role 2.  

 Description 2  

Use this field to provide additional information about the relationship.  

5. Click Save or Save and Close.  

Repeat this step to save the account or contact.  

Important 

You cannot set up duplicate relationships between an account and the same account or contact. It works the same way 

when setting up a contact relationship. For example, if you create a relationship between a new account and the 

account, Fabrikam, Inc., and the customer's relationship role is set to Distributor, you cannot create a new relationship 

for the account that uses the same customer and relationship role.  

Note 

To remove a relationship, open the account or contact, and then under Details, click Relationships. In the 

relationships list, click the relationship that you want to delete, and then click the Delete button .  
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Deactivate or activate an account or contact 

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Sales Permissions  

Instead of deleting an account or contact, you can deactivate it and still have an audit trail for your sales process. 

When an account or contact is deactivated, it cannot be edited, and relationships between the account or contact 

and other records cannot be created.  

The only way to view a deactivated account or contact is to select Inactive Accounts or Inactive Contacts in 

the View list. If the representative of the account or the individual contact for the record you deactivated 

contacts you in the future, you have the option of reactivating the account or contact without re-entering all the 

data.  

 

1. In the Navigation Pane, click Sales, and then click either Accounts or Contacts.  

2. Select the account or contact you want to deactivate or activate.  

3. On the Actions toolbar, click More Actions, and then click one of the following:  

 Deactivate  

– OR –  

 Activate  

4. In the confirmation dialog box, click OK.  

Note 

When you deactivate a record, all relationships created while it was active continue to be available; however, you 

cannot create new relationships with a deactivated record.  

Create a quick campaign  

 Can I do this task?  

This task requires permissions that are found in all default marketing security roles. More information 
about specific permissions and performing this task while offline: Marketing Permissions  

You can use quick campaigns to create one type of activity for many accounts, contacts, or leads at once.  

 

1. Select the records or list you want to run a quick campaign on, and then start the Create Quick 

Campaign Wizard.  

 From a list of records, including the results of a search You can run a quick campaign from any list of accounts, 

contacts, or leads.  

a. Select the record or records for which you want to create a quick campaign. If you want to include all 

records on the current page or all records on all pages, then skip this step.  

b. On the Actions toolbar, click Create Quick Campaign , and then click one of the following:  
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 For Selected Records  

Select this option if you have selected one or more records in the list.  

 For All Records on Current Page  

Select this option to include all records on the page for the quick campaign activity.  

 For All Records on All Pages  

Select this option to include all records on all pages for the quick campaign activity.  

 From the Marketing Lists list You can run a quick campaign on one or more marketing lists in the Marketing 

Lists list.  

a. In the Navigation Pane, click Marketing or Sales, and then click Marketing Lists.  

b. Select the marketing list or marketing lists for which you want to create a quick campaign.  

c. On the Actions toolbar, click Create Quick Campaign, and then click For Selected Records.  

 From a marketing list You can run a quick campaign on the accounts, contacts, or leads in any marketing list.  

a. In the Navigation Pane, click Marketing or Sales, and then click Marketing Lists.  

b. Double-click the marketing list for which you want to create a quick campaign.  

c. On the Actions toolbar, click Create Quick Campaign.  

4. In the Create Quick Campaign Wizard, follow the instructions to create the quick campaign.  

Notes 

 You cannot add additional records to a quick campaign after you have created it.  

 In the Create Quick Campaign Wizard, you can select who you want Microsoft Dynamics CRM to 

assign the activity to and whether Microsoft Dynamics CRM should perform the activity automatically 

for appropriate activities (such as sending e-mail messages). This choice affects who can see and 

take action on an activity. For example, if you were creating a phone call activity for all of the sales 

representatives, you could select the phone call activity, and then select The owners of the 

records that are included in the quick campaign. Each sales representative could then see the 

activity and take action on it. However, if you were creating a large number of e-mail activities that 

Microsoft Dynamics CRM would perform automatically, you could assign the e-mail activity to 

yourself instead of the record owners.  

 Whether or not some activities are performed automatically depends on an option available to users 

who have the Organization Settings Write privilege. More information: Manage System Settings  

Default sales reports 

The following sales reports are available:  

This topic shows you how to use the different reports. You also can find more information when you generate a 

report, click Help, and then click Help on This Page.  

 Account Distribution Report  

Use this report to identify patterns in your top revenue-generating accounts. The report displays two 

charts. The earned revenue chart displays a chart of the earned revenue grouped by a market facet, such 

as product, territory, or industry. The accounts count chart, displays the amount of earned revenue using 

the same grouping as the earned revenue chart.  
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 Account Overview Report  

Use this report to obtain a one-page overview of everything occurring with an account. The report 

displays a profile of the account, contact information, and summaries of opportunities and case activities.  

 Account Summary Report  

Use this report to determine historically what has occurred with an account. This report also displays what 

is scheduled to occur in the future. The report displays a chronological summary for an account, including 

sales and service activities, notes, and records.  

 Activities Report  

Use this report to identify patterns in activities. Activities can be grouped by owner or activity type, or by 

the record the activity is regarding.  

 Competitor Win Loss Report  

Use this report to compare how your sales team performs against your competitors. The report displays a 

list of competitors, with data on open, closed, won, and lost opportunities for each.  

 Invoices Report  

Use this report to print invoices.  

 Invoice Status Report  

Use this report to view your accounts receivable. The chart displays invoices grouped by status.  

 Lead Source Effectiveness Report  

Use this report to compare how effective your lead sources are at generating quality opportunities. The 

report lists the percentage of qualified leads, and leads that generate revenue for each lead category.  

 Neglected Leads Report  

Use this report to identify any leads that have not been contacted. The report displays a chart of leads 

that have had no associated activities or notes during a specified time period.  

 Orders Report  

Use this report to print orders.  

 Quotes Report  

Use this report to print quotes.  

 Sales Pipeline Report  

Use this report to see anticipated potential sales. The report displays a chart of potential sales grouped by 

user, sales territory, customer territory, date, products, rating, or sales stage.  

 Sales History Report  

Use this report to view a history of sales performance by sales representative. The report displays a chart 

of both lost and earned revenue.  

 Neglected Accounts Report  

Use this report to identify accounts that have not been contacted recently. The report displays a chart 

with accounts that have had no activities completed in a specified number of days.  

 Products by Account Report  

Use this report to see which products are used by an account. For each account, the report lists the 

associated products.  

 Products by Contact Report  

Use this report to see which products are used by a contact. For each contact, the report lists the 

associated products.  

If the default reports don't provide the information you need, try creating an Advanced Find search, and 
exporting the results to Microsoft Office Excel.  
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Note 

This topic documents the list of default reports as they were shipped. If this list differs from the reports that are 

available to you, contact your report administrator or system administrator for information about the customized 

reports.  

Work with Contacts 

Contacts are people who represent customers or potential customers, or someone related to an account.  

Create or edit a contact  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Sales Permissions  

 

 

1. In the Navigation Pane, click Sales, and then click Contacts.  

2. On the Actions toolbar, click New, or open the record that you want to edit.  

3. On the General tab, enter information or observe any noted restrictions or requirements as needed:  

 First Name 

If you enter a first name, it can only be a name with a length of 50 characters or fewer. You 

can use accent marks when you enter data, for example, in a customer's name. Your ability to 

sort and find information is not affected by these accent marks.  

 Last Name 

You must enter a name with a length of 50 characters or fewer.  

 Parent Customer  

If the contact you are creating is a subcontact, then you will want to set up a relationship to 

its parent contact. If you are setting up a parent customer, leave this field blank. To locate 

and select a parent customer, click the Parent Customer box. You can select a record from 

a filtered list in the Form Assistant pane, or you can click the Lookup button  to 

search for other records.  

 E-mail  

E-mail addresses must be valid. For example, someone@microsoft.com.  

 ZIP/Postal Code  

Enter a code of 20 characters or fewer.  

4. On the Details tab, observe any noted restrictions or requirements and enter all the information you 

have available in the following fields:  

 Birthday  

You must enter the date in the format your organization has set for dates. For example, 

01/01/2006 or 31.12.2005.  

If you omit leading zeros in a date, Microsoft Dynamics CRM will add them automatically. For 

example, when you type 1/1/06, Microsoft Dynamics CRM will display it as 01/01/2006, if that 

is the date format of your organization.  

 Anniversary  

You must enter the date in the format your organization has set for dates. For example, 

01/01/2006 or 31.12.2005.  

If you omit leading zeros in a date, Microsoft Dynamics CRM will add them automatically. For 
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example, when you type 1/1/06, Microsoft Dynamics CRM will display it as 01/01/2006, if that 

is the date format of your organization.  

5. On the Administration tab, enter information or observe any noted restrictions or requirements as 

needed:  

 Owner  

This box is filled automatically with the name of the user who is creating the record. You can 

click the Lookup button  to search for other records.  

 Originating Lead  

If this contact was the result of converting a lead, then this field will automatically show the 

lead record. You can also enter the originating lead. To locate and select a lead, click the 

Originating Lead box. You can select a record from a filtered list in the Form Assistant 

pane, or you can click Lookup to search for a lead.  

 Credit Limit  

This field is not used as part of the business logic in Microsoft Dynamics CRM; however, your 

organization might use it as part of a workflow process.  

 Credit Hold  

This field is not used as part of the business logic in Microsoft Dynamics CRM; however, your 

organization might use it as part of a workflow process.  

 Payment Terms  

This field is mapped to any orders that are created for the record.  

 Price List  

If your organization has price lists set up, you can select a record from a filtered list in the 

Form Assistant pane, or you can click Lookup to search for and select the appropriate price 

list. This field is mapped to any orders that are created for the record.  

 Contact Methods  

o Preferred  

Select the option that best describes the preferred method of contact.  

o E-mail  

If you select Allow, Microsoft Dynamics CRM allows all e-mail, including e-mails 

related to campaign activities, to be sent to the e-mail address associated with the 

record. However, if you select Do Not Allow, Microsoft Dynamics CRM does not allow 

any e-mail to be sent to the e-mail address associated with the record.  

o Bulk E-mail  

If you select Allow, Microsoft Dynamics CRM allows any e-mail as part of a bulk e-mail 

process, including bulk e-mails related to campaign activities, to be sent to the e-mail 

address associated with the record. However, if you select Do Not Allow, Microsoft 

Dynamics CRM does not allow any bulk e-mail to be sent to the e-mail address 

associated with the record.  

o Phone  

The selected option simply provides information to anyone who views the record. This 

field is not used by Microsoft Dynamics CRM to control initiating or receiving phone 

calls.  

o Fax  

The selected option simply provides information to anyone who views the record.  
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o Mail  

The selected option simply provides information to anyone who views the record. This 

field is not used by Microsoft Dynamics CRM to control initiating or receiving mail.  

 Marketing Information  

o Send Marketing Materials  

If you select Yes, marketing material corresponding to campaigns is sent to the 

respective addresses (e-mail, physical address) for the record. This includes general 

marketing mailers that might be sent on a regular basis that are not part of a targeted 

marketing campaign. If you select No, marketing materials are not sent, nor can 

activities related to sending marketing materials be created for the record.  

o Last Date Included in Campaign  

Microsoft Dynamics CRM automatically sets the date for this field when any marketing 

communication is sent to the addresses for the record. You can also manually update 

this field and enter a date. This field is used as filter criteria in Marketing Automation. 

For example, the Anti-spam Setting area of a Campaign form uses the date in this 

field to ensure that you do not send frequent mailers to a customer.  

 Service Preferences  

Select the customer's preferred time and day for service activities.  

Click the Preferred Service, Preferred Facility/Equipment, or Preferred User box to 

search for the appropriate record.  

You can select a record from a filtered list in the Form Assistant pane, or you can click 

Lookup to search for other records.  

6. On the Notes tab, click Click here to enter a new note, and add the information that applies to 

your record.  

7. Click Save or Save and Close.  

 Resolve potential duplicate records.  

1. If the system detects that your record might be a potential duplicate, instead of saving the 

record, you'll see the Duplicates Detected dialog box.  

2. To open a record to make sure it is a potential duplicate, in the Potential duplicate records 

list, double-click the record.  

 If the duplicate-detection rule identified potential duplicate records in other record 

types, review records from each record type listed.  

3. If your new or updated record is not a duplicate, to create the new record, click Save Record.  

– OR –  

If your new or updated record is a duplicate, to cancel your changes, click Cancel.  

Notes  

 If you enter a duplicate record within a few minutes of entering the first record, Microsoft 

Dynamics CRM will not detect the duplicate record. The matchcodes for new and updated 

records are created every five minutes, rather than as a record is created.  

Duplicate detection can take place only if duplicate detection is enabled in Duplicate Detection Settings 
and if at least one duplicate-detection rule exists for the record type. More information: Avoiding Duplicate 
Records  
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Note 

After you create contacts, you can associate one or more of them with an account, but only one contact can be the 

primary contact for an account. If you consolidate both contacts and sub-contacts, and create relationships between 

them, then you can use the reporting features to get subtotals or total revenue reports for all the related contacts.  

Tips 

 You can add more addresses to handle various locations for a given account or contact. To do this, 

under Details, click More Addresses, and then on the Actions toolbar, click New Address.  

 When the Look Up Records dialog box is open, if the record you need doesn't exist, click New, and 

create the record.  

 To add a related record, on the Actions  menu, point to Add Related, and then click the record 

type you want. Complete the form as needed.  

Associate an opportunity with an account or contact  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Sales Permissions  

You associate opportunities with accounts or contacts by creating an opportunity relationship between them. The 
relationship you set up is based on your selection in the Opportunity Relationship dialog box. Therefore, if you 
want to create an opportunity relationship with the specific account or contact that you open, make sure that you 
select that record.  

 

1. In the Navigation Pane, click Sales, and then click either Accounts or Contacts.  

2. In the list of accounts or contacts, open the record to which you want to add an opportunity 

relationship.  

3. On the Actions  menu, point to Add Relationship, and then click Opportunity.  

4. In the Opportunity Relationship dialog box, enter information in the following boxes:  

 Opportunity  

You must select the opportunity that will be associated with the record. Click the Lookup 

button  to search for an opportunity.  

 Customer  

This field is automatically filled with the account or contact record.  

 Customer Role  

Select an option from the list. This field can be customized, so the values will vary.  

Your organization might set up relationship roles, to indicate the role of your customers as 

they relate to your business. This field is not required.  

If there are no relationship roles in the list or the relationship role you want is not listed, 

contact your system administrator and ask them to add the relationship role to the 

Relationship Roles area, which is located in the Settings area.  

 Description  

Use this field to provide additional information about the relationship.  
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5. Click Save or Save and Close.  

Repeat this step to save the account or contact.  

Note 

You cannot set up duplicate relationships between a customer record and an opportunity. For example, if you create a 

relationship between an account and the opportunity, and the customer's relationship role is set to Distributor, you 

cannot create a new relationship for the account that uses the same customer opportunity and relationship role.  

Set customer preferences for a service activity  

 Can I do this task?  

This task requires permissions that are found in all default service scheduling security roles. More 
information about specific permissions and performing this task while offline: Service Scheduling 
Permissions  

You can provide personalized customer service for your customers by recording their preferences regarding 
services and service times. These preferences become the default criteria the next time that a service activity is 
scheduled for the customer and they are offered in the Form Assistant pane.  

 

1. In the Navigation Pane, click Workplace, and then under Customers, click either Accounts or 

Contacts.  

2. In the list, open the record you want.  

3. Under Details, click Information.  

4. On the Administration tab, under Service Preferences, select the customer's preferred time and 

day for appointments.  

5. Click the Preferred Service, Preferred Facility/Equipment, or Preferred User box to search for 

the appropriate record. You can select a record from a filtered list in the Form Assistant pane, or 

you can click the Lookup button  to search for other records.  

6. Click Save or Save and Close.  

Add or remove a customer record in a marketing list  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Sales Permissions  

You can add a customer record, such as a lead, account, or contact, to a marketing list. If a customer record is 
added to a marketing list from another area within Microsoft Dynamics CRM, the customer record is updated to 
reflect this association. Therefore, if you want to add a customer record, such as a lead, to a marketing list, you 
might find that the lead is already associated with the list.  

 

1. In the Navigation Pane, click Sales, and then click Leads, Accounts, or Contacts depending on 

which type of record you want to add to a marketing list.  

2. In the list, open the record that you want to add to a marketing list.  

3. Under Marketing, click Marketing Lists.  

4. On the Actions toolbar, click Add to Marketing List.  
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5. In the Look Up Records dialog box, locate and select the marketing list you want to add the record 

to, and then click OK.  

6. Click Save or Save and Close.  

Note 

To remove a record from a marketing list, open the customer record you want to remove from the marketing list. On 

the Actions toolbar, click More Actions, and then click Remove. In the confirmation message, click OK.  

Tip 

If you cannot locate the marketing list you want to add, you might need to create it. To do this, in the Look Up 

Records dialog box, click New and then complete the form.  

View associated campaigns from customer records  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Sales Permissions  

You can view a list of campaigns for a customer from within the Customer Record form. When a customer record 
is added to a marketing list and that marketing list is added to a campaign, the customer record is updated to 
reflect this association.  

 

1. In the Navigation Pane, click Sales, and then click Leads, Accounts, or Contacts, depending on 

which type of record you want to view associated campaigns for.  

2. In the list, open the record that you want to view.  

3. Under Marketing, click Campaigns to see the list of campaigns the customer is included in.  

Add or remove a customer relationship for an account or contact  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Sales Permissions  

In Microsoft Dynamics CRM, you can create relationships between one customer record and one or more other 
records. These relationships are defined by their relationship role. The relationship that you set up is based on 
your selection in the Customer Relationship dialog box. If you want to create a relationship between the 
account or contact that you are working with and another specific account or contact, make sure that you select 
that account or contact.  

 

1. In the Navigation Pane, click Sales, and then click either Accounts or Contacts.  

2. In the list of accounts or contacts, open the record to which you want to add a customer relationship.  

3. Under Details, click Relationships, and then on the Actions toolbar, click New Customer 

Relationship.  

4. In the Customer Relationship dialog box, enter information in the following boxes:  

 Party 1  

This field automatically displays the name of the customer that you opened in step 2.  
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However, you can also click the Lookup button  to search for and select a different 

account or contact record. If you do so, the new relationship you set up will not appear in the 

customer record you originally opened.  

 Party 2  

Select the customer record to associate with the Party 1 record. Click the Lookup 

button  to search for an account or contact record.  

 Role 1  

Select an option from the list. This field can be customized, so the values will vary.   

Your organization might set up relationship roles, to indicate the role of your customers as 

they relate to your business. This field is not required.  

If there are no relationship roles in the list or the relationship role you want is not listed, 

contact your system administrator and ask them to add the relationship role to the 

Relationship Roles area, which is located in the Settings area.  

 Description 1  

Use this field to provide additional information about the relationship.  

 Role 2  

From the list, select the relationship role that best describes the relationship of Party 1 to 

Party 2. The same items will appear in both lists.  

For example, if you selected Supplier from Role 1, you might select Retailer from Role 2.  

 Description 2  

Use this field to provide additional information about the relationship.  

5. Click Save or Save and Close.  

Repeat this step to save the account or contact.  

Important 

You cannot set up duplicate relationships between an account and the same account or contact. It works the same way 

when setting up a contact relationship. For example, if you create a relationship between a new account and the 

account, Fabrikam, Inc., and the customer's relationship role is set to Distributor, you cannot create a new relationship 

for the account that uses the same customer and relationship role.  

Note 

To remove a relationship, open the account or contact, and then under Details, click Relationships. In the 

relationships list, click the relationship that you want to delete, and then click the Delete button .  
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Deactivate or activate an account or contact 

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Sales Permissions  

Instead of deleting an account or contact, you can deactivate it and still have an audit trail for your sales process. 

When an account or contact is deactivated, it cannot be edited, and relationships between the account or contact 

and other records cannot be created.  

The only way to view a deactivated account or contact is to select Inactive Accounts or Inactive Contacts in 

the View list. If the representative of the account or the individual contact for the record you deactivated 

contacts you in the future, you have the option of reactivating the account or contact without re-entering all the 

data.  

 

1. In the Navigation Pane, click Sales, and then click either Accounts or Contacts.  

2. Select the account or contact you want to deactivate or activate.  

3. On the Actions toolbar, click More Actions, and then click one of the following:  

 Deactivate  

– OR –  

 Activate  

4. In the confirmation dialog box, click OK.  

Note 

When you deactivate a record, all relationships created while it was active continue to be available; however, you 

cannot create new relationships with a deactivated record.  

Create a quick campaign  

 Can I do this task?  

This task requires permissions that are found in all default marketing security roles. More information 
about specific permissions and performing this task while offline: Marketing Permissions  

You can use quick campaigns to create one type of activity for many accounts, contacts, or leads at once.  

 

1. Select the records or list you want to run a quick campaign on, and then start the Create Quick 

Campaign Wizard.  

 From a list of records, including the results of a search You can run a quick campaign from any list of accounts, 

contacts, or leads.  

a. Select the record or records for which you want to create a quick campaign. If you want to include all 

records on the current page or all records on all pages, then skip this step.  

b. On the Actions toolbar, click Create Quick Campaign , and then click one of the following:  
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 For Selected Records  

Select this option if you have selected one or more records in the list.  

 For All Records on Current Page  

Select this option to include all records on the page for the quick campaign activity.  

 For All Records on All Pages  

Select this option to include all records on all pages for the quick campaign activity.  

 From the Marketing Lists list You can run a quick campaign on one or more marketing lists in the Marketing 

Lists list.  

a. In the Navigation Pane, click Marketing or Sales, and then click Marketing Lists.  

b. Select the marketing list or marketing lists for which you want to create a quick campaign.  

c. On the Actions toolbar, click Create Quick Campaign, and then click For Selected Records.  

 From a marketing list You can run a quick campaign on the accounts, contacts, or leads in any marketing list.  

a. In the Navigation Pane, click Marketing or Sales, and then click Marketing Lists.  

b. Double-click the marketing list for which you want to create a quick campaign.  

c. On the Actions toolbar, click Create Quick Campaign.  

4. In the Create Quick Campaign Wizard, follow the instructions to create the quick campaign.  

Notes 

 You cannot add additional records to a quick campaign after you have created it.  

 In the Create Quick Campaign Wizard, you can select who you want Microsoft Dynamics CRM to 

assign the activity to and whether Microsoft Dynamics CRM should perform the activity automatically 

for appropriate activities (such as sending e-mail messages). This choice affects who can see and 

take action on an activity. For example, if you were creating a phone call activity for all of the sales 

representatives, you could select the phone call activity, and then select The owners of the 

records that are included in the quick campaign. Each sales representative could then see the 

activity and take action on it. However, if you were creating a large number of e-mail activities that 

Microsoft Dynamics CRM would perform automatically, you could assign the e-mail activity to 

yourself instead of the record owners.  

 Whether or not some activities are performed automatically depends on an option available to users 

who have the Organization Settings Write privilege. More information: Manage System Settings  
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Default sales reports 

The following sales reports are available:  

This topic shows you how to use the different reports. You also can find more information when you generate a 

report, click Help, and then click Help on This Page.  

 Account Distribution Report  

Use this report to identify patterns in your top revenue-generating accounts. The report displays two 

charts. The earned revenue chart displays a chart of the earned revenue grouped by a market facet, such 

as product, territory, or industry. The accounts count chart, displays the amount of earned revenue using 

the same grouping as the earned revenue chart.  

 Account Overview Report  

Use this report to obtain a one-page overview of everything occurring with an account. The report displays 

a profile of the account, contact information, and summaries of opportunities and case activities.  

 Account Summary Report  

Use this report to determine historically what has occurred with an account. This report also displays what 

is scheduled to occur in the future. The report displays a chronological summary for an account, including 

sales and service activities, notes, and records.  

 Activities Report  

Use this report to identify patterns in activities. Activities can be grouped by owner or activity type, or by 

the record the activity is regarding.  

 Competitor Win Loss Report  

Use this report to compare how your sales team performs against your competitors. The report displays a 

list of competitors, with data on open, closed, won, and lost opportunities for each.  

 Invoices Report  

Use this report to print invoices.  

 Invoice Status Report  

Use this report to view your accounts receivable. The chart displays invoices grouped by status.  

 Lead Source Effectiveness Report  

Use this report to compare how effective your lead sources are at generating quality opportunities. The 

report lists the percentage of qualified leads, and leads that generate revenue for each lead category.  

 Neglected Leads Report  

Use this report to identify any leads that have not been contacted. The report displays a chart of leads that 

have had no associated activities or notes during a specified time period.  

 Orders Report  

Use this report to print orders.  

 Quotes Report  

Use this report to print quotes.  

 Sales Pipeline Report  

Use this report to see anticipated potential sales. The report displays a chart of potential sales grouped by 

user, sales territory, customer territory, date, products, rating, or sales stage.  

 Sales History Report  

Use this report to view a history of sales performance by sales representative. The report displays a chart 

of both lost and earned revenue.  

 Neglected Accounts Report  
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Use this report to identify accounts that have not been contacted recently. The report displays a chart with 

accounts that have had no activities completed in a specified number of days.  

 Products by Account Report  

Use this report to see which products are used by an account. For each account, the report lists the 

associated products.  

 Products by Contact Report  

Use this report to see which products are used by a contact. For each contact, the report lists the 

associated products.  

If the default reports don't provide the information you need, try creating an Advanced Find search, and exporting 
the results to Microsoft Office Excel.  

Note 

This topic documents the list of default reports as they were shipped. If this list differs from the reports that are 

available to you, contact your report administrator or system administrator for information about the customized 

reports.  
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Generating New Sales 

Managing Leads 

In Microsoft Dynamics CRM, you can get lead information in the Sales area. Your organization might refer to leads as 

inquiries, prospects, or sales opportunities. All activities are logged and a running history of every activity with the lead 

is kept, once it is completed.  

You can enter leads individually. In addition, you can use Microsoft Dynamics CRM to import lead lists into the 

database, perform the common qualifying activities, and convert leads to opportunities, if they qualify.  

Each disqualified lead is retained in the database for business-reporting purposes. For example, you might want to 

analyze the success of different list sources or assess how much time the sales force spends prospecting leads.  

Importing leads is the quickest way to add them to Microsoft Dynamics CRM. You might already have prospects in 

Microsoft Office Outlook or Microsoft Office Excel that you can import using the Import Data Wizard, and then use the 

leads list to view or open leads to ensure that all the information imported successfully.  

You can track information about prospective customers, and then qualify and assign inquiries. Because leads are 

tracked separately from customers throughout the sales cycle, you can focus on building your customer base.  

Understanding How Accounts, Contacts, Leads, and Opportunities Relate  

Account and contact records represent established customers. Leads are potential or prospective customers. 

Opportunities are not a specific customer, such as a lead, contact, or account, and therefore require a customer record 

to be added to the opportunity.  

How you can use lead, opportunity, contact and account records to facilitate the process of generating new customers 

is described in the following scenario:  

A Sales and Marketing team uses methods to gather leads. For example, the sales and marketing team holds a seminar 

and gathers business cards from participants. Personal names, businesses names, addresses, and phone numbers are 

gathered from the seminar and then entered into Microsoft Dynamics CRM as lead records. The lead records are 

assigned to the sales staff based on certain criteria, such as the lead's ZIP Code/Postal Code.  

Next, sales staff contact the leads to qualify them. The salesperson may initiate a telephone call to the lead and ask 

questions such as "Are you interested in purchasing our products?" and "When do you intend to purchase?"  

Based on the information collected from the previous lead qualification process, the salesperson uses Microsoft 

Dynamics CRM to either disqualify the lead or convert the lead into three new records in Microsoft Dynamics CRM:  

 An account for the business  

 A contact for the person who the sales staff is working with  

 An opportunity for the potential sale  

The contact that is created has the account configured as the parent account.  

Work with Leads 

Leads represent potential customers who have not yet been qualified by your sales process. As you qualify leads, you 

can convert them to other types of records.  
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Create or edit a lead  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Sales Permissions  

When you create a lead, you might be tempted to only enter the system-required fields (marked with asterisks 

Business-required symbol ) or business-recommended fields (marked with plus signs Business-recommended 

symbol ) ; however, the more data you collect and enter into this form, the more likely you are to turn those leads 
into business opportunities. Remember that e-mail addresses, the source of the lead, and specific product interests 
are key factors in helping your sales staff complete the necessary follow-up.  

 

1. In the Navigation Pane, click Sales, and then click Leads.  

2. On the Actions toolbar, click New, or open the record that you want to edit.  

3. On the General tab, enter information or observe any noted restrictions or requirements as needed:  

 Topic  

This information should reflect what the lead is interested in. For example, if a potential 

customer calls and asks for details on a product, list the name of the product here.  

 First Name 

If you enter a first name, it can only be a name with a length of 50 characters or fewer. You 

can use accent marks when you enter data, for example, in a customer's name. Your ability to 

sort and find information is not affected by these accent marks.  

 Last Name 

You must enter a name with a length of 50 characters or fewer.  

 Company Name 

You must enter a name with a length of 100 characters or fewer.  

In the Contact Information area, enter all the contact information you have available for this lead 

because this information will assist a salesperson in making future contacts. E-mail addresses must 

be valid. For example, someone@microsoft.com.  

4. On the Details tab, enter all the information you have available in the following sections:  

 Address  

 Company Information  

 Lead Information 

It is very important to provide the lead source information so that you can determine which 

marketing method, such as advertisement or trade shows, generates the most leads for your 

organization. If you specify lead information, you can filter on Lead Source to determine 

how many leads were generated by a given method.  

In the following boxes, observe any noted restrictions or requirements: 

 ZIP/Postal Code 

Enter a code of 20 characters or fewer.  

 Annual Revenue 

You must enter numbers between 0.00 and 1,000,000,000.00.  
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You can use commas and a decimal point, but you cannot use a currency symbol, such as the 

dollar ($), euro (€), or yen (¥).  

 No. of Employees 

You must enter a whole number between 0 and 1,000,000.  

 SIC Code 

Indicate the Standard Industrial Classification (SIC) code for this account. You can search on 

SIC for organizations with a particular code to display all accounts of businesses in that 

category. Enter a code of 20 characters or fewer.  

 Industry 

If the lead specifies an industry that is not in the list, you can work with your system 

administrator to get new industries added to the list because this field is customizable. This 

field is used in various reports such as Lead Source Effectiveness; which, if used with filtering, 

can display the lead source effectiveness by industry. Another form that includes the industry 

field is the Account form. If your system administrator adds custom industries to the Leads 

form, they should also add them to the Account form to keep the two lists in synch.  

5. On the Administration tab, enter information or observe any noted restrictions or requirements as 

needed:  

 Owner 

This box is filled automatically with the name of the user who is creating the record. You can 

click the Lookup button  to search for other records.  

 Status Reason 

This value appears in the list of leads in the Leads area. You can sort by the Status Reason 

column in that area to quickly view new leads or those already contacted.  

 Source Campaign 

Search for and enter the campaign record if this lead was generated as a result of a campaign 

that has been created in Microsoft Dynamics CRM.  

 Contact Methods 

o Preferred  

Select the option that best describes the preferred method of contact.  

o E-mail  

If you select Allow, Microsoft Dynamics CRM allows all e-mail, including e-mails 

related to campaign activities, to be sent to the e-mail address associated with the 

record. However, if you select Do Not Allow, Microsoft Dynamics CRM does not allow 

any e-mail to be sent to the e-mail address associated with the record.  

o Bulk E-mail  

If you select Allow, Microsoft Dynamics CRM allows any e-mail as part of a bulk e-mail 

process, including bulk e-mails related to campaign activities, to be sent to the e-mail 

address associated with the record. However, if you select Do Not Allow, Microsoft 

Dynamics CRM does not allow any bulk e-mail to be sent to the e-mail address 

associated with the record.  

o Phone  

The selected option simply provides information to anyone who views the record. This 

field is not used by Microsoft Dynamics CRM to control initiating or receiving phone 

calls.  

o Fax  

The selected option simply provides information to anyone who views the record.  
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o Mail  

The selected option simply provides information to anyone who views the record. This 

field is not used by Microsoft Dynamics CRM to control initiating or receiving mail.  

 Marketing Information 

o Send Marketing Materials  

If you select Yes, marketing material corresponding to campaigns is sent to the 

respective addresses (e-mail, physical address) for the record. This includes general 

marketing mailers that might be sent on a regular basis that are not part of a targeted 

marketing campaign. If you select No, marketing materials are not sent, nor can 

activities related to sending marketing materials be created for the record.  

o Last Date Included in Campaign  

Microsoft Dynamics CRM automatically sets the date for this field when any marketing 

communication is sent to the addresses for the record. You can also manually update 

this field and enter a date. This field is used as filter criteria in Marketing Automation. 

For example, the Anti-spam Setting area of a Campaign form uses the date in this 

field to ensure that you do not send frequent mailers to a customer.  

6. On the Notes tab, click Click here to enter a new note, and add the information that applies to 

your record.  

7. Click Save or Save and Close.  

 Resolve potential duplicate records.  

1. If the system detects that your record might be a potential duplicate, instead of saving the 

record, you'll see the Duplicates Detected dialog box.  

2. To open a record to make sure it is a potential duplicate, in the Potential duplicate records 

list, double-click the record.  

 If the duplicate-detection rule identified potential duplicate records in other record 

types, review records from each record type listed.  

3. If your new or updated record is not a duplicate, to create the new record, click Save Record.  

– OR –  

If your new or updated record is a duplicate, to cancel your changes, click Cancel.  

Notes  

 If you enter a duplicate record within a few minutes of entering the first record, Microsoft 

Dynamics CRM will not detect the duplicate record. The matchcodes for new and updated 

records are created every five minutes, rather than as a record is created.  

Duplicate detection can take place only if duplicate detection is enabled in Duplicate Detection Settings 
and if at least one duplicate-detection rule exists for the record type. More information: Avoiding Duplicate 
Records  

Tip 

To qualify or disqualify a lead, you convert the lead. First, open the lead that you want to convert, click Convert Lead, 

select options for how you want to convert the lead, and then click OK.  
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Qualify and convert a lead to an account, contact, and/or opportunity  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Sales Permissions  

Turning leads into customers, or at least opportunities, is the goal of any organization. After you qualify a lead 

based on metrics used by your organization, you can use Microsoft Dynamics CRM to quickly create up to three 

new records in which the lead is represented as an account, contact, and/or opportunity.  

Only one lead at a time can be converted, unless you add the leads you want to convert to a marketing list. More 
information: Work with Marketing Lists  

 

1. In the Navigation Pane, click Sales, and then click Leads.  

2. In the list of leads, open the lead you want to qualify and convert.  

3. On the Standard toolbar, click Convert Lead.  

4. In the Convert Lead dialog box, select Qualify and convert into the following records, and 

then select one or more of the following:  

 Account  

Select this option to create an account record. This applies if there is an actual company you 

are doing business with.  

 Contact  

Select this option to create a contact record. This applies if you are doing business with an 

specific individual at a company or just an individual customer (consumer).  

 Opportunity  

If this is the only option you select, then in the Potential Customer box, you must associate 

either an account or contact with the lead. Click the Lookup button  to search for an 

account or contact.  

 Open newly created records  

Select this option to open the record in a new window. If you only select a single option, such 

as Account, the new record opens as an account. If you select Account and Contact, the 

new record opens as a contact. If you select all three options, the new record opens as an 

opportunity.  

 Currency  

If you select Opportunity, you must select the currency in which the opportunity will be 

calculated.  

5. Click OK.  

6. If you did not select the Open newly created records check box, then on the Standard toolbar, you 

must click Close to close the lead record.  

Tip 

To view the lead record after it has been converted to an opportunity, open the opportunity, and then click 

Originating Lead on the Administration tab.  
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Notes 

 Based on the security privileges assigned to your user account, you might not be able to qualify leads 

that you do not own. If you have to qualify them, you must get the necessary privileges. Also, 

regardless of who qualifies the lead and performs the conversion, all the newly created records are, 

by default, owned by the user who owned the original lead.  

 Any notes on a lead record do not transfer to the new account, contact or opportunity record, and 

remain with the originating lead record.  

Qualify or convert multiple records at once  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Sales Permissions  

If you need to disqualify a group of leads or if you decide a group of leads are all good, you do not have to 
process them one by one. Instead, put the leads into a marketing list, and then disqualify the whole group or 
qualify them by converting the whole group into accounts, contacts, or opportunities all in one step.  

 

1. Create a new marketing list.  

a. In the Navigation Pane, click Marketing or Sales, and then click Marketing Lists.  

b. On the Actions toolbar, click New.  

c. In the Name box, type a name for the list, and in the Member type box, select Lead.  

d. Click Save.  

2. Under Details, click Marketing List Members.  

3. On the Actions toolbar, click Manage Members.  

4. In the Manage Members dialog box, click Use Advanced Find to add members, and then click 

OK.  

5. Create a query to find the list of leads to disqualify or convert.  

a. From the Use Saved View list, select My Open Leads.  

b. Add any additional criteria you need to the query.  

 Tip 

If this query is one that you will use again, click Save As, and specify a name for the query.  

6. To see the records, click Find.  

7. Select one of the option buttons at the bottom of the window either to add all the leads returned by 

the search to the list or to add only selected leads to the list, and then click Add to Marketing 

List.  

8. In the marketing list, select multiple lead records:  

 Select several records by pressing the CTRL key while you click each record.  

 Select a sequence of records by clicking the first record that you want, and then press the 

SHIFT key while you select the last record that you want.  
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 Select all records on the page by selecting the Select/clear all records on this page check 

box at the top of the list.  

 Tip 

By default, the Microsoft Dynamics CRM Web application displays 50 records per page. You can increase 

the number of records displayed and thereby increase the number of records you can select at one time. To 

display up to a maximum of 250 records per page:  

4. On the Tools menu, click Options.  

5. On the General tab, in the Records Per Page list, select the number of records to display 

per page.  

6. Click OK.  

This changes the number of items that is displayed for all lists, which may slow response time when you 

switch record types. Therefore, you might want to set it back to a smaller number when you are done with 

this bulk action.  

 After you select the leads you want to convert, on the More Actions menu, click Convert 

Lead.  

 In the Convert Lead dialog box, disqualify the leads, or select the record types to convert 

the leads to, and then click OK. The leads will still appear on your marketing list, but will no longer 

appear in your My Open Leads view.  

Disqualify and close a lead  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Sales Permissions  

When you decide that a lead will not turn into an opportunity or become a customer, you can disqualify it and still 
have an audit trail for your sales process. If you delete a lead, rather than disqualify it, any attachments or notes 
will be removed. If a lead you disqualify contacts you in the future, you have the option of reactivating the record 
without having to re-enter all the data.  

 

1. In the Navigation Pane, click Sales, and then click Leads.  

2. In the list of leads, open the lead you want to disqualify.  

3. On the Standard toolbar, click Convert Lead.  

4. In the Convert Lead dialog box, select Disqualify, and then from the Status list, select an option.  

5. Click OK.  

6. On the Standard toolbar, click Close.  

Note 

Disqualified leads appear in the Closed Leads view.  
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Reactivate a closed lead  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Sales Permissions  

You disqualify a lead by closing the lead record. Although closed leads can be reactivated, deleted leads are 
permanently removed and cannot be reactivated. When you reactivate a lead, you save time by not having to re-
enter any data and you maintain the original history of the lead.  

 

1. In the Navigation Pane, click Sales, and then click Leads.  

2. In the View list, click Closed Leads.  

3. In the list of closed leads, open the lead you want to reactivate.  

4. On the Actions  menu, click Reactivate Lead.  

5. In the Confirm Lead Activation dialog box, click OK.  

6. Click Save or Save and Close.  

Add or remove a customer record in a marketing list  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Sales Permissions  

You can add a customer record, such as a lead, account, or contact, to a marketing list. If a customer record is 
added to a marketing list from another area within Microsoft Dynamics CRM, the customer record is updated to 
reflect this association. Therefore, if you want to add a customer record, such as a lead, to a marketing list, you 
might find that the lead is already associated with the list.  

 

1. In the Navigation Pane, click Sales, and then click Leads, Accounts, or Contacts depending on 

which type of record you want to add to a marketing list.  

2. In the list, open the record that you want to add to a marketing list.  

3. Under Marketing, click Marketing Lists.  

4. On the Actions toolbar, click Add to Marketing List.  

5. In the Look Up Records dialog box, locate and select the marketing list you want to add the record 

to, and then click OK.  

6. Click Save or Save and Close.  

Note 

To remove a record from a marketing list, open the customer record you want to remove from the marketing list. On 

the Actions toolbar, click More Actions, and then click Remove. In the confirmation message, click OK.  

Tip 

If you cannot locate the marketing list you want to add, you might need to create it. To do this, in the Look Up 

Records dialog box, click New and then complete the form.  
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View associated campaigns from customer records  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Sales Permissions  

You can view a list of campaigns for a customer from within the Customer Record form. When a customer record 
is added to a marketing list and that marketing list is added to a campaign, the customer record is updated to 
reflect this association.  

 

1. In the Navigation Pane, click Sales, and then click Leads, Accounts, or Contacts, depending on 

which type of record you want to view associated campaigns for.  

2. In the list, open the record that you want to view.  

3. Under Marketing, click Campaigns to see the list of campaigns the customer is included in.  

Create a quick campaign  

 Can I do this task?  

This task requires permissions that are found in all default marketing security roles. More information 
about specific permissions and performing this task while offline: Marketing Permissions  

You can use quick campaigns to create one type of activity for many accounts, contacts, or leads at once.  

 

1. Select the records or list you want to run a quick campaign on, and then start the Create Quick 

Campaign Wizard.  

 From a list of records, including the results of a search You can run a quick campaign from any list of accounts, 

contacts, or leads.  

a. Select the record or records for which you want to create a quick campaign. If you want to include all 

records on the current page or all records on all pages, then skip this step.  

b. On the Actions toolbar, click Create Quick Campaign , and then click one of the following:  

 For Selected Records  

Select this option if you have selected one or more records in the list.  

 For All Records on Current Page  

Select this option to include all records on the page for the quick campaign activity.  

 For All Records on All Pages  

Select this option to include all records on all pages for the quick campaign activity.  

 From the Marketing Lists list You can run a quick campaign on one or more marketing lists in the Marketing 

Lists list.  

a. In the Navigation Pane, click Marketing or Sales, and then click Marketing Lists.  

b. Select the marketing list or marketing lists for which you want to create a quick campaign.  

c. On the Actions toolbar, click Create Quick Campaign, and then click For Selected Records.  

 From a marketing list You can run a quick campaign on the accounts, contacts, or leads in any marketing list.  

Haghighat Sabet
Highlight



 

266 Microsoft Dynamics CRM 4.0 User’s Guide 
 

a. In the Navigation Pane, click Marketing or Sales, and then click Marketing Lists.  

b. Double-click the marketing list for which you want to create a quick campaign.  

c. On the Actions toolbar, click Create Quick Campaign.  

4. In the Create Quick Campaign Wizard, follow the instructions to create the quick campaign.  

Notes 

 You cannot add additional records to a quick campaign after you have created it.  

 In the Create Quick Campaign Wizard, you can select who you want Microsoft Dynamics CRM to 

assign the activity to and whether Microsoft Dynamics CRM should perform the activity automatically 

for appropriate activities (such as sending e-mail messages). This choice affects who can see and 

take action on an activity. For example, if you were creating a phone call activity for all of the sales 

representatives, you could select the phone call activity, and then select The owners of the 

records that are included in the quick campaign. Each sales representative could then see the 

activity and take action on it. However, if you were creating a large number of e-mail activities that 

Microsoft Dynamics CRM would perform automatically, you could assign the e-mail activity to 

yourself instead of the record owners.  

 Whether or not some activities are performed automatically depends on an option available to users 

who have the Organization Settings Write privilege. More information: Manage System Settings  
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Default sales reports 

The following sales reports are available:  

This topic shows you how to use the different reports. You also can find more information when you generate a 

report, click Help, and then click Help on This Page.  

 Account Distribution Report  

Use this report to identify patterns in your top revenue-generating accounts. The report displays two 

charts. The earned revenue chart displays a chart of the earned revenue grouped by a market facet, such 

as product, territory, or industry. The accounts count chart, displays the amount of earned revenue using 

the same grouping as the earned revenue chart.  

 Account Overview Report  

Use this report to obtain a one-page overview of everything occurring with an account. The report displays 

a profile of the account, contact information, and summaries of opportunities and case activities.  

 Account Summary Report  

Use this report to determine historically what has occurred with an account. This report also displays what 

is scheduled to occur in the future. The report displays a chronological summary for an account, including 

sales and service activities, notes, and records.  

 Activities Report  

Use this report to identify patterns in activities. Activities can be grouped by owner or activity type, or by 

the record the activity is regarding.  

 Competitor Win Loss Report  

Use this report to compare how your sales team performs against your competitors. The report displays a 

list of competitors, with data on open, closed, won, and lost opportunities for each.  

 Invoices Report  

Use this report to print invoices.  

 Invoice Status Report  

Use this report to view your accounts receivable. The chart displays invoices grouped by status.  

 Lead Source Effectiveness Report  

Use this report to compare how effective your lead sources are at generating quality opportunities. The 

report lists the percentage of qualified leads, and leads that generate revenue for each lead category.  

 Neglected Leads Report  

Use this report to identify any leads that have not been contacted. The report displays a chart of leads that 

have had no associated activities or notes during a specified time period.  

 Orders Report  

Use this report to print orders.  

 Quotes Report  

Use this report to print quotes.  

 Sales Pipeline Report  

Use this report to see anticipated potential sales. The report displays a chart of potential sales grouped by 

user, sales territory, customer territory, date, products, rating, or sales stage.  

 Sales History Report  

Use this report to view a history of sales performance by sales representative. The report displays a chart 

of both lost and earned revenue.  

 Neglected Accounts Report  
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Use this report to identify accounts that have not been contacted recently. The report displays a chart with 

accounts that have had no activities completed in a specified number of days.  

 Products by Account Report  

Use this report to see which products are used by an account. For each account, the report lists the 

associated products.  

 Products by Contact Report  

Use this report to see which products are used by a contact. For each contact, the report lists the 

associated products.  

If the default reports don't provide the information you need, try creating an Advanced Find search, and exporting 
the results to Microsoft Office Excel.  

Note 

This topic documents the list of default reports as they were shipped. If this list differs from the reports that are 

available to you, contact your report administrator or system administrator for information about the customized 

reports.  

Managing Opportunities 

An opportunity is a potential sale, which is similar to a lead. However, the subtle difference is that with an opportunity 

you can forecast sales revenue, set a potential close date, and factor in a probability for the sale to occur.  

When you create an opportunity, you must specify an existing account or contact record. Also, an opportunity requires 

that you link the record to a particular price list. This is needed for the automated pricing of the proposed products that 

the opportunity is interested in purchasing.  

Using opportunities in your business process enables you to run pipeline reports to view estimated revenue flows based 

on pending new sales.  

Creating and Converting Opportunities 

You can create a new opportunity that did not originate from a lead, or you can convert qualified leads to opportunities 

without re-entering the data, and then you can track opportunities through the sales cycle.  

When you convert a qualified lead to an account, contact, or opportunity, you can access the lead record, which 

includes activities and notes, from the corresponding opportunity form. You can also access the lead information if you 

create a new opportunity and link it to a lead record. You cannot convert an opportunity to a lead; you can only close 

opportunities.  

You can use Microsoft Dynamics CRM to track information about each opportunity, such as:  

 Contact information.  

 Salesperson who is actively working on the opportunity.  

 Assessment on the probability of closing the sale and turning the opportunity into a customer.  

 Projected closing date of the sale.  

Understanding How Accounts, Contacts, Leads, and Opportunities Relate  

Account and contact records represent established customers. Leads are potential or prospective customers. 

Opportunities are not a specific customer, such as a lead, contact, or account, and therefore require a customer record 

to be added to the opportunity.  

How you can use lead, opportunity, contact and account records to facilitate the process of generating new customers 

is described in the following scenario:  
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A Sales and Marketing team uses methods to gather leads. For example, the sales and marketing team holds a seminar 

and gathers business cards from participants. Personal names, businesses names, addresses, and phone numbers are 

gathered from the seminar and then entered into Microsoft Dynamics CRM as lead records. The lead records are 

assigned to the sales staff based on certain criteria, such as the lead's ZIP Code/Postal Code.  

Next, sales staff contact the leads to qualify them. The salesperson may initiate a telephone call to the lead and ask 

questions such as "Are you interested in purchasing our products?" and "When do you intend to purchase?"  

Based on the information collected from the previous lead qualification process, the salesperson uses Microsoft 

Dynamics CRM to either disqualify the lead or convert the lead into three new records in Microsoft Dynamics CRM:  

 An account for the business  

 A contact for the person who the sales staff is working with  

 An opportunity for the potential sale  

The contact that is created has the account configured as the parent account.  

Recalculating Opportunities 

Opportunities with products added to them have their estimated revenue value calculated based on the base price, 

volume discounts, manual discounts, taxes, and other pricing modifications. When opportunities are saved, Microsoft 

Dynamics CRM recalculates the estimated revenue value based on any changes to the products or product quantities 

associated with the opportunity.  

However, if you want to update the estimated revenue value of an opportunity without saving, closing, and reopening 

it, you can do this by manually recalculating the value. Recalculating an opportunity is useful when there are two or 

three different scenarios in terms of the estimated revenue that could be generated by the opportunity.  

In this case, you can modify the selection of products to match each scenario and then recalculate the opportunity. 

Microsoft Dynamics CRM does not save the recalculations unless you choose to save and close the opportunity. If you 

modify products without recalculating, you must save and close the opportunity and then reopen it to see the updated 

estimated revenue.  

Associating Relationships 

You can create a relationship between opportunities, accounts, or contacts; specify the type of relationship between 

them; and define the relationship role that the account or contact has with regard to the opportunity.  

The relationship role assigned to the associated account or contact determines how the account or contact affects, 

influences, or contributes to the opportunity. For example, if you add an account as a relationship to the opportunity, 

anyone who views the account data will see that there is a current opportunity with the account that could result in a 

new sale.  

Adding Sales Transactions 

You can start a sales transaction, such as a quote, order, or invoice, from within the opportunity record. The advantage 

of starting sales transactions in this manner is that much of the information is automatically entered based on the 

opportunity data. You can also view any sales transaction records from within the opportunity record to track the 

overall sales process and expected revenue. You cannot convert an opportunity to an order, quote, or invoice, but you 

can associate the opportunity to these records.  

Associating Competitors 

You can associate the opportunity with competitors so that you and your team know who you are working against. 

Opportunities can be linked with competitor information and analyzed to identify the most effective selling strategies. If 

you determine that the competitor you have associated with an opportunity is no longer a threat to making the sale, 

you can disassociate that competitor from the opportunity without deleting the competitor record from Microsoft 

Dynamics CRM.  
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Work with Opportunities 

Opportunities represent a potential sale to an account or contact.  

Create or edit an opportunity  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Sales Permissions  

Part of your sales process will likely involve creating opportunities. You may have an existing customer call and ask 
about a new product or service your organization is offering. In this case, you would want to create an opportunity 
because it is an existing customer and there is a greater chance that this opportunity will result in a sale.  

 

1. In the Navigation Pane, click Sales, and then click Opportunities.  

2. On the Actions toolbar, click New, or open the record that you want to edit.  

3. On the General tab, enter information or observe any noted restrictions or requirements as needed:  

 Topic  

This information should reflect what the opportunity is interested in. For example, if an 

existing customer called and asked for details on a product, then you would want to list the 

name of the product as the topic. You can use accent marks when you enter data, for 

example, in a customer's name. Your ability to sort and find information is not affected by 

these accent marks.  

 Potential Customer  

This customer will be either the account or contact associated with this opportunity.  

This value appears in the list of opportunities on the main opportunities page.  

 Price List  

If your company has price lists set up, specify the appropriate price list.  

 Currency  

Select the currency in which the opportunity will be calculated.  

 Revenue  

If pricing is automated for your company, select System Calculated. If not, select User 

Provided.  

 Est. Revenue  

Opportunities with products added to them have their estimated revenue value calculated 

based on the base price, volume discounts, manual discounts, taxes and other pricing 

modifications. When opportunities are saved, Microsoft Dynamics CRM recalculates the 

estimated revenue value based on any changes to the products or product quantities 

associated with the opportunity.  

This value appears in the list of opportunities on the main opportunities page.  

 Est. Close Date  

You must enter the date in the format your organization has set for dates. For example, 

01/01/2006 or 31.12.2005.  

If you omit leading zeros in a date, Microsoft Dynamics CRM will add them automatically. For 

example, when you type 1/1/06, Microsoft Dynamics CRM will display it as 01/01/2006, if that 

is the date format of your organization.  

This value appears in the list of opportunities on the main opportunities page.  
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 Probability  

Enter a number between 1 and 100 to indicate the likelihood of a sale occurring.  

4. On the Administration tab, enter information or observe any noted restrictions or requirements as 

needed:  

 Owner  

This box is filled automatically with the name of the user who is creating the record. You can 

click the Lookup button  to search for other records.  

 Originating Lead  

If this opportunity was the result of converting a lead, then this field will automatically show 

the lead record.  

 Source Campaign  

If this opportunity was a result of converting a campaign response to a lead, or if this field 

was set when the lead was created, then this field will automatically show the campaign 

record. However, you cannot set the Source Campaign field for a completely new 

opportunity record.  

5. On the Notes tab, click Click here to enter a new note, and add the information that applies to 

your record.  

6. Click Save or Save and Close.  

 Resolve potential duplicate records.  

1. If the system detects that your record might be a potential duplicate, instead of saving the 

record, you'll see the Duplicates Detected dialog box.  

2. To open a record to make sure it is a potential duplicate, in the Potential duplicate records 

list, double-click the record.  

 If the duplicate-detection rule identified potential duplicate records in other record 

types, review records from each record type listed.  

3. If your new or updated record is not a duplicate, to create the new record, click Save Record.  

– OR –  

If your new or updated record is a duplicate, to cancel your changes, click Cancel.  

Notes  

 If you enter a duplicate record within a few minutes of entering the first record, Microsoft 

Dynamics CRM will not detect the duplicate record. The matchcodes for new and updated 

records are created every five minutes, rather than as a record is created.  

Duplicate detection can take place only if duplicate detection is enabled in Duplicate Detection Settings 
and if at least one duplicate-detection rule exists for the record type. More information: Avoiding Duplicate 
Records  

Note 

To convert an opportunity into the originating lead, open the opportunity, click the Administration tab, and then click 

the lead in the Originating Lead box. Then, in the lead form, click Reactivate Lead on the Actions  menu. Close 

the opportunity that was created when you converted the lead.  

Tips 

Haghighat Sabet
Highlight



 

272 Microsoft Dynamics CRM 4.0 User’s Guide 
 

 When the Look Up Records dialog box is open, if the record you need doesn't exist, click New, and 

create the record.  

 To add a related record, on the Actions  menu, point to Add Related, and then click the record 

type you want. Complete the form as needed.  

Add or remove a product  

 Can I do this task?  

This task requires a manager, vice president, CEO-Business Manager, System Administrator, or 
System Customizer security role or equivalent permissions. More information about specific 
permissions and performing this task while offline: Sales Permissions  

 

 

1. In the Navigation Pane, click Sales, and then click Opportunities.  

2. In the list of opportunities, open the opportunity to which you want to add a product.  

3. On the General tab, verify that a price list appears in the Price List field.  

Selecting a price list is required before you can add a product. Microsoft Dynamics CRM uses the 

price list to automatically calculate values for the following fields after you save the opportunity:  

 Price Per Unit  

 Volume Discount  

 Manual Discount  

 Extended Amount ($)  

4. Under Details, click Products.  

5. On the Actions  bar, click New Opportunity Product.  

6. On the General tab, enter information or observe any noted restrictions or requirements as needed:  

 Product  

Click the Lookup button  to search for and add a product.  

 Unit  

Click Lookup to search for and add a unit.  

 Quantity  

Enter the number of product items.  

You must enter numbers between 0.00 and 1,000,000,000.00.  

You can use commas and a decimal point, but you cannot use a currency symbol, such as the 

dollar ($), euro (€), or yen (¥).  

 Manual Discount  

If appropriate, enter a discount.  

You must enter numbers between 0.00 and 1,000,000,000.00.  

You can use commas and a decimal point, but you cannot use a currency symbol, such as the 

dollar ($), euro (€), or yen (¥).  

7. Click Save or Save and Close.  

Notes 
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 You can also remove a product from an opportunity. Under Details, click Products, and then select 

the product you want to remove. On the Actions toolbar, click the Delete button .  

 To add a write-in product, you must create at least one price list in the product catalog. To add a 

product from the product catalog, you must create at least one unit group, price list, and product. 

More information: Creating the Product Catalog  

Associate an account or contact with an opportunity  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Sales Permissions  

You associate opportunities with accounts or contacts by creating an opportunity relationship between them. The 
relationship you set up is based on your selection in the Opportunity Relationship dialog box. Therefore, if you 
want to create an opportunity relationship with the specific opportunity you open, make sure that you select that 
opportunity.  

 

1. In the Navigation Pane, click Sales, and then click Opportunities.  

2. In the list of opportunities, open the opportunity to which you want to add a relationship with a 

customer record.  

3. On the Actions  menu, click Add Relationship.  

4. In the Opportunity Relationship dialog box, enter information in the following boxes:  

 Opportunity  

You must select the opportunity that will be associated with the customer. Click the Lookup 

button  to search for an opportunity.  

 Customer  

You must associate either an account or contact with the opportunity. Click the Lookup 

button  to search for an account or contact.  

 Customer Role  

Select an option from the list. This field can be customized, so the values will vary.  

Your organization might set up relationship roles, to indicate the role of your customers as 

they relate to your business. This field is not required.  

If there are no relationship roles in the list or the relationship role you want is not listed, 

contact your system administrator and ask them to add the relationship role to the 

Relationship Roles area, which is located in the Settings area.  

 Description  

Use this field to provide additional information about the relationship.  

5. Click Save or Save and Close.  

Repeat this step to save the account or contact.  

Notes 
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 To remove a relationship, open the opportunity, and then under Details, click Relationships. In the 

relationships list, click the relationship that you want to delete, and then click the Delete button 

.  

 You cannot set up duplicate relationships between a customer record and an opportunity. For 

example, if you create a relationship between an account and the opportunity, and the customer's 

relationship role is set to Distributor, you cannot create a new relationship for the account that uses 

the same customer opportunity and relationship role.  

Add or delete a quote, order, or invoice  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Sales Permissions  

 

 

1. In the Navigation Pane, click Sales, and then click Opportunities.  

2. In the list of opportunities, open the opportunity to which you want to add a quote, order, or invoice.  

3. Under Sales, click one of the following:  

 Quotes  

If you select this option, on the Actions toolbar, click New Quote.  

 Orders  

If you select this option, on the Actions toolbar, click New Order.  

 Invoices  

If you select this option, on the Actions toolbar, click New Invoice.  

4. Complete the form as needed. More information:  

 Work with Quotes  

 Work with Orders  

 Work with Invoices  

5. Click Save or Save and Close. Repeat this step to save the opportunity.  

Note 

To delete a quote, order, or invoice from within an opportunity, under Sales, click Quotes, Orders, or Invoices. 

Select the record you want to remove. On the Actions toolbar, click the Delete button . Deleting the quote, order, 

or invoice from the opportunity permanently deletes the record.  
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Add or remove a competitor  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Sales Permissions  

You can add a known competitor to an opportunity record to help you track other companies who are competing 
against you for a potential sale. If you determine that the competitor you have associated with an opportunity is 
no longer a threat to making the sale, then you can disassociate that competitor from the opportunity without 
deleting the competitor from Microsoft Dynamics CRM.  

 

1. In the Navigation Pane, click Sales, and then click Opportunities.  

2. In the list of opportunities, open the opportunity to which you want to add or remove a competitor.  

3. Under Sales, click Competitors.  

4. On the Actions toolbar, click Add Existing Competitor.  

5. Locate and select the competitor or competitors.  

6. Click Save or Save and Close.  

Note 

To disassociate a competitor from an opportunity, first open the appropriate opportunity, and then under Sales, click 

Competitors. On the Actions toolbar, click More Actions, and then click Remove. In the confirmation message, click 

OK.  

Recalculate the estimated revenue  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Sales Permissions  

 

 

1. In the Navigation Pane, click Sales, and then click Opportunities.  

2. In the list of opportunities, open the opportunity for which you want to recalculate the estimated 

revenue.  

3. Modify the list of products associated with the opportunity. (When opportunities are saved, Microsoft 

Dynamics CRM recalculates the estimated revenue value based on any changes to the products or 

product quantities associated with the opportunity.)  

4. In the Estimated Revenue section, verify that System Calculated is selected, and then on the 

Actions  menu, click Recalculate.  

5. Click Save or Save and Close.  
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Close an opportunity  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Sales Permissions  

Whether you win a sale or lose it, you probably want to close the opportunity. If you have lost the sale, you can 
delete the opportunity, but deletions are not recommended because they are permanent. If you delete the 
opportunity, related items such as attachments and notes are also deleted, in addition to the audit trail for your 
sales organization. Therefore, it is best to close the opportunity. You will have the option to reopen the 
opportunity later if it becomes a viable sale. 

 

1. In the Navigation Pane, click Sales, and then click Opportunities.  

2. In the list of opportunities, open the opportunity you want to close.  

3. On the Actions  menu, click Close Opportunity.  

4. In the Close Opportunity dialog box, click a Status option.  

If you select Won, enter the appropriate information in the following fields:  

 Status Reason 

The default for this field is Won. Your systems administrator can make changes to the default 

status for your organization if desired.  

 Actual Revenue 

You must enter numbers between 0.00 and 1,000,000,000.00.  

You can use commas and a decimal point, but you cannot use a currency symbol, such as the 

dollar ($), euro (€), or yen (¥).  

This value should represent the actual agreed upon price.  

 Close Date 

You must enter the date in the format your organization has set for dates. For example, 

01/01/2006 or 31.12.2005.  

If you omit leading zeros in a date, Microsoft Dynamics CRM will add them automatically. For 

example, when you type 1/1/06, Microsoft Dynamics CRM will display it as 01/01/2006, if that 

is the date format of your organization.  

 Description 

Enter the reason for the win.  

If you select Lost, enter the appropriate information in the following fields:  

 Status Reason 

Select an option. The default options are Canceled or Out-Sold. Your systems administrator 

can change the default status for your organization that you want.  

 Actual Revenue 

You do not have to enter a value. However, it is helpful to know what the deal was worth had 

it been achieved. 

You must enter numbers between 0.00 and 1,000,000,000.00.  

You can use commas and a decimal point, but you cannot use a currency symbol, such as the 

dollar ($), euro (€), or yen (¥).  
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 Close Date 

You must enter the date in the format your organization has set for dates. For example, 

01/01/2006 or 31.12.2005.  

If you omit leading zeros in a date, Microsoft Dynamics CRM will add them automatically. For 

example, when you type 1/1/06, Microsoft Dynamics CRM will display it as 01/01/2006, if that 

is the date format of your organization.  

 Competitor 

If you know the competitor you lost the deal to, click the Lookup button  to search for a 

competitor.  

 Description 

Enter the reason for the loss.  

5. Click OK.  

6. On the Standard toolbar, click Close.  

Reopen an opportunity  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Sales Permissions  

An opportunity you closed previously might become viable again. If this occurs, you can reopen the opportunity. 
You cannot reopen a deleted opportunity. You must create a new opportunity if you deleted one instead of closing 
it.  

 

1. In the Navigation Pane, click Sales, and then click Opportunities.  

2. In the View list, click Closed Opportunities.  

3. In the list of opportunities, open the opportunity you want to reopen.  

4. On the Actions  menu, click Reopen This Opportunity.  

5. In the Reopen This Opportunity dialog box, click OK.  

6. Click Save or Save and Close.  

Haghighat Sabet
Highlight



 

278 Microsoft Dynamics CRM 4.0 User’s Guide 
 

Default sales reports 

The following sales reports are available:  

This topic shows you how to use the different reports. You also can find more information when you generate a 

report, click Help, and then click Help on This Page.  

 Account Distribution Report  

Use this report to identify patterns in your top revenue-generating accounts. The report displays two 

charts. The earned revenue chart displays a chart of the earned revenue grouped by a market facet, such 

as product, territory, or industry. The accounts count chart, displays the amount of earned revenue using 

the same grouping as the earned revenue chart.  

 Account Overview Report  

Use this report to obtain a one-page overview of everything occurring with an account. The report displays 

a profile of the account, contact information, and summaries of opportunities and case activities.  

 Account Summary Report  

Use this report to determine historically what has occurred with an account. This report also displays what 

is scheduled to occur in the future. The report displays a chronological summary for an account, including 

sales and service activities, notes, and records.  

 Activities Report  

Use this report to identify patterns in activities. Activities can be grouped by owner or activity type, or by 

the record the activity is regarding.  

 Competitor Win Loss Report  

Use this report to compare how your sales team performs against your competitors. The report displays a 

list of competitors, with data on open, closed, won, and lost opportunities for each.  

 Invoices Report  

Use this report to print invoices.  

 Invoice Status Report  

Use this report to view your accounts receivable. The chart displays invoices grouped by status.  

 Lead Source Effectiveness Report  

Use this report to compare how effective your lead sources are at generating quality opportunities. The 

report lists the percentage of qualified leads, and leads that generate revenue for each lead category.  

 Neglected Leads Report  

Use this report to identify any leads that have not been contacted. The report displays a chart of leads that 

have had no associated activities or notes during a specified time period.  

 Orders Report  

Use this report to print orders.  

 Quotes Report  

Use this report to print quotes.  

 Sales Pipeline Report  

Use this report to see anticipated potential sales. The report displays a chart of potential sales grouped by 

user, sales territory, customer territory, date, products, rating, or sales stage.  

 Sales History Report  

Use this report to view a history of sales performance by sales representative. The report displays a chart 

of both lost and earned revenue.  

 Neglected Accounts Report  
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Use this report to identify accounts that have not been contacted recently. The report displays a chart with 

accounts that have had no activities completed in a specified number of days.  

 Products by Account Report  

Use this report to see which products are used by an account. For each account, the report lists the 

associated products.  

 Products by Contact Report  

Use this report to see which products are used by a contact. For each contact, the report lists the 

associated products.  

If the default reports don't provide the information you need, try creating an Advanced Find search, and exporting 
the results to Microsoft Office Excel.  

Note 

This topic documents the list of default reports as they were shipped. If this list differs from the reports that are 

available to you, contact your report administrator or system administrator for information about the customized 

reports.  

Competing for Customers 

Using competitor information management, you can compile a repository of information, such as product literature, 

pricing structures and product reviews, for each of your competitors. If you add products or sales literature to a 

competitor record, your sales staff will be able to access the competitor data from within the product or sales literature 

forms.  

You can also create and maintain information about your competitors' strengths and weaknesses, and the opportunities 

you are both working on. Your sales force can use this information to better understand who they are working against 

on a deal. If you create a relationship between a competitor and an opportunity, you can access information about both 

from either form.  

The competitor information management in Microsoft Dynamics CRM also helps you associate opportunities to 

competitors so you can assess opportunities lost to or won against each competitor.  

Work with Competitor Records 

Competitors represent people or organizations that your business unit competes with for sales opportunities.  

 

 

 

 

 

 

Create or edit a competitor  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Sales Permissions  

Tracking competitors is a key aspect of a sales process. The more information your team has about a competitor's 
strengths, weaknesses, opportunities, and the threats a competitor might have to your organization's ability to make a 
sale, the more likely you are to win against that company.  

 

1. In the Navigation Pane, click Sales, and then click Competitors.  
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2. On the Actions toolbar, click New, or open the record that you want to edit.  

3. On the General tab, enter information or observe any noted restrictions or requirements as needed:  

 Name  

You must enter a name with a length of 100 characters or fewer. The information should be 

meaningful and unique. You can use accent marks when you enter data, for example, in a 

customer's name. Your ability to sort and find information is not affected by these accent 

marks.  

 Ticker Symbol  

If you enter a ticker symbol for a market outside the United States, you must prefix it with 

the country code, for example US:MSFT (country code:ticker symbol). This information is 

available only for markets that are currently listed on the MSN Money Web site. In addition to 

the United States (US), MSN Money also provides information for markets in Australia (AU), 

Belgium (BE), Canada (CA), France (FR), Germany (DE), Great Britain (GB), Italy (IT), Japan 

(JP), Netherlands (NL), Spain (ES), and Sweden (SE). For more information, go to the MSN 

Money Web site.  

 Key Product 

Enter the competitor's product that you most frequently compete with for sales.  

 Web Site 

Web site addresses must be valid. For example, http://www.adventure-works.com.  

 Reported Revenue 

You must enter numbers between 0.00 and 1,000,000,000.00.  

You can use commas and a decimal point, but you cannot use a currency symbol, such as the 

dollar ($), euro (€), or yen (¥).  

 Address 

Enter all the address information you have available for this competitor. Note this restriction:  

ZIP/Postal Code 

Enter a code of 20 characters or fewer.  

4. On the Analysis tab, enter everything you know about the competitor.  

5. On the Notes tab, click Click here to enter a new note, and add the information that applies to 

your record.  

6. Click Save or Save and Close.  

 Resolve potential duplicate records.  

1. If the system detects that your record might be a potential duplicate, instead of saving the 

record, you'll see the Duplicates Detected dialog box.  

2. To open a record to make sure it is a potential duplicate, in the Potential duplicate records 

list, double-click the record.  

 If the duplicate-detection rule identified potential duplicate records in other record types, 

review records from each record type listed.  

3. If your new or updated record is not a duplicate, to create the new record, click Save Record.  

– OR –  

If your new or updated record is a duplicate, to cancel your changes, click Cancel.  

Notes  

http://go.microsoft.com/fwlink/?LinkId=95957
http://go.microsoft.com/fwlink/?LinkId=95957
http://go.microsoft.com/fwlink/?LinkId=95957
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 If you enter a duplicate record within a few minutes of entering the first record, Microsoft 

Dynamics CRM will not detect the duplicate record. The match codes for new and updated 

records are created every five minutes, rather than as a record is created.  

Duplicate detection can take place only if duplicate detection is enabled in Duplicate Detection Settings 
and if at least one duplicate-detection rule exists for the record type. More information: Avoiding Duplicate 
Records  

Add or remove products for a competitor  

 Can I do this task?  

This task requires a manager, vice president, CEO-Business Manager, System Administrator, or 
System Customizer security role or equivalent permissions. More information about specific 
permissions and performing this task while offline: Sales Permissions  

Knowing the products your competitors carry helps you to identify areas within your own inventory where you can 
expect the greatest challenges to making a sale. If you list the products your competitors carry, then you can 
create a scorecard that helps your sales organization present data to potential customers about how your products 
provide benefits that your competitors cannot meet.  

 

1. In the Navigation Pane, click Sales, and then click Competitors.  

2. In the list of competitors, open the competitor you want to add products to.  

3. Under Details, click Products.  

4. On the Actions toolbar, click Add Existing Product.  

5. In the Look Up Records dialog box, search for and select the products you want to add to the 

competitor, and then click OK.  

6. Click Save or Save and Close.  

Notes 

 To remove products from a competitor, follow steps 1, 2, and 3 above to navigate to the appropriate 

area. Select the products you want to remove. On the Actions toolbar, click More Actions, and 

then click Remove. In the confirmation message, click OK.  

 By default, you cannot add a competitor's product to a competitor record. If you want your 

competitor's product in Microsoft Dynamics CRM, you have to customize the product catalog to allow 

for products sold by your competitors, instead of by your organization. If you customize the product 

catalog with competitor products, then you can link competitor products as substitute products in 

the competitor record.  
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Add or remove opportunities for a competitor  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Sales Permissions  

Adding existing opportunities to a competitor record helps you track other companies who are competing against 
you for a potential sale. If you determine that the competitor is no longer a threat to making the sale with the 
associated opportunity, then you can remove that opportunity from the competitor without deleting the 
opportunity from Microsoft Dynamics CRM.  

 

1. In the Navigation Pane, click Sales, and then click Competitors.  

2. In the list of competitors, open the competitor you want to add an opportunity to.  

3. Under Sales, click Opportunities.  

4. On the Actions toolbar, click Add Existing Opportunity.  

5. In the Look Up Records dialog box, search for and select the opportunity you want to add to the 

competitor, and then click OK.  

6. Click Save or Save and Close.  

Tip 

If you cannot locate the opportunity you want to add, you might need to create it. To do this, in the Look Up Records 

dialog box, click New and then complete the form.  

Note 

To remove an opportunity from a competitor, follow steps 1, 2, and 3 above to navigate to the appropriate area. Select 

the opportunity you want to remove. On the Actions toolbar, click More Actions, and then click Remove. In the 

confirmation message, click OK.  

Add or remove sales literature for a competitor  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Sales Permissions  

Adding existing sales literature to a competitor record helps you to track information, such as product or service 
offerings, about the competitor. You can relate or link a competitor's sales literature that you collect directly from 
the competitor form. If the sales literature becomes out-dated or the competitor no longer offers the products, 
then you can remove the sales literature from the competitor without deleting the sales literature from Microsoft 
Dynamics CRM.  

 

1. In the Navigation Pane, click Sales, and then click Competitors.  

2. In the list of competitors, open the competitor you want to add sales literature to.  

3. Under Sales, click Sales Literature.  

4. On the Actions toolbar, click Add Existing Sales Literature.  

5. In the Look Up Records dialog box, search for and select the sales literature you want to add to the 

competitor, and then click OK.  
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6. Click Save or Save and Close.  

Note 

To remove sales literature from a competitor, follow steps 1, 2, and 3 above to navigate to the appropriate area. Select 

the sales literature you want to remove. On the Actions toolbar, click More Actions, and then click Remove. In the 

confirmation message, click OK.  
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Default sales reports 

The following sales reports are available:  

This topic shows you how to use the different reports. You also can find more information when you generate a 

report, click Help, and then click Help on This Page.  

 Account Distribution Report  

Use this report to identify patterns in your top revenue-generating accounts. The report displays two 

charts. The earned revenue chart displays a chart of the earned revenue grouped by a market facet, such 

as product, territory, or industry. The accounts count chart, displays the amount of earned revenue using 

the same grouping as the earned revenue chart.  

 Account Overview Report  

Use this report to obtain a one-page overview of everything occurring with an account. The report displays 

a profile of the account, contact information, and summaries of opportunities and case activities.  

 Account Summary Report  

Use this report to determine historically what has occurred with an account. This report also displays what 

is scheduled to occur in the future. The report displays a chronological summary for an account, including 

sales and service activities, notes, and records.  

 Activities Report  

Use this report to identify patterns in activities. Activities can be grouped by owner or activity type, or by 

the record the activity is regarding.  

 Competitor Win Loss Report  

Use this report to compare how your sales team performs against your competitors. The report displays a 

list of competitors, with data on open, closed, won, and lost opportunities for each.  

 Invoices Report  

Use this report to print invoices.  

 Invoice Status Report  

Use this report to view your accounts receivable. The chart displays invoices grouped by status.  

 Lead Source Effectiveness Report  

Use this report to compare how effective your lead sources are at generating quality opportunities. The 

report lists the percentage of qualified leads, and leads that generate revenue for each lead category.  

 Neglected Leads Report  

Use this report to identify any leads that have not been contacted. The report displays a chart of leads that 

have had no associated activities or notes during a specified time period.  

 Orders Report  

Use this report to print orders.  

 Quotes Report  

Use this report to print quotes.  

 Sales Pipeline Report  

Use this report to see anticipated potential sales. The report displays a chart of potential sales grouped by 

user, sales territory, customer territory, date, products, rating, or sales stage.  

 Sales History Report  

Use this report to view a history of sales performance by sales representative. The report displays a chart 

of both lost and earned revenue.  

 Neglected Accounts Report  
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Use this report to identify accounts that have not been contacted recently. The report displays a chart with 

accounts that have had no activities completed in a specified number of days.  

 Products by Account Report  

Use this report to see which products are used by an account. For each account, the report lists the 

associated products.  

 Products by Contact Report  

Use this report to see which products are used by a contact. For each contact, the report lists the 

associated products.  

If the default reports don't provide the information you need, try creating an Advanced Find search, and exporting 
the results to Microsoft Office Excel.  

Note 

This topic documents the list of default reports as they were shipped. If this list differs from the reports that are 

available to you, contact your report administrator or system administrator for information about the customized 

reports.  

Work with Sales Literature 

Use this page to create, view, edit, and print sales literature records. You can also use this list to preview or open 

existing sales literature records.  

Add or edit sales literature  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Sales Permissions  

 

 

1. In the Navigation Pane, click Sales, and then click Sales Literature.  

2. On the Actions toolbar, click New, or open the sales literature record that you want to edit.  

3. In the Title box, type a title for the sales literature. This field is required.  

4. In the Subject box, click the Lookup button  to search for the subject you want. This field is 

required. If the subject you want does not appear in the list, contact your system administrator to 

add it. More information: Requesting User Interface Changes  

5. In the Subject Lookup dialog box, select the subject you want, and then click OK.  

6. In the Employee Contact box, click Lookup. In the Look Up Records dialog box, select the user 

record for the employee you want to associate with the sales literature record, and then click OK. 

The person you select is typically the person responsible for the creation or maintenance of the 

sales literature.  

7. In the Type list, select the sales literature type that most closely matches the description of the sales 

literature.  

8. In the Expiration Date box, select or enter a date. For example, if the sales literature is associated 

with a sale, the date the sale ends would be the expiration date. You must enter the date in the 

format your organization has set for dates. For example, 01/01/2006 or 31.12.2005.  

If you omit leading zeros in a date, Microsoft Dynamics CRM will add them automatically. For 

example, when you type 1/1/06, Microsoft Dynamics CRM will display it as 01/01/2006, if that is the 

date format of your organization.  
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9. Under Details, click Documents.  

10. On the Actions toolbar, click New Document.  

11. Enter a title (required field), author name, keywords, and an abstract for your document.  

12. If you want to attach a file to the document, type its name in the File Name box or click Browse 

to locate the file, and then click Attach. Attaching a file might take a few minutes, depending on 

the size of the file.  

13. In the document form, click Save and Close.  

14. In the sales literature form, click Save or Save and Close.  

 Resolve potential duplicate records.  

1. If the system detects that your record might be a potential duplicate, instead of saving the 

record, you'll see the Duplicates Detected dialog box.  

2. To open a record to make sure it is a potential duplicate, in the Potential duplicate records 

list, double-click the record.  

 If the duplicate-detection rule identified potential duplicate records in other record 

types, review records from each record type listed.  

3. If your new or updated record is not a duplicate, to create the new record, click Save Record.  

– OR –  

If your new or updated record is a duplicate, to cancel your changes, click Cancel.  

Notes  

 If you enter a duplicate record within a few minutes of entering the first record, Microsoft 

Dynamics CRM will not detect the duplicate record. The matchcodes for new and updated 

records are created every five minutes, rather than as a record is created.  

Duplicate detection can take place only if duplicate detection is enabled in Duplicate Detection Settings 
and if at least one duplicate-detection rule exists for the record type. More information: Avoiding Duplicate 
Records  

Tip 

Although you cannot attach sales literature documents directly to e-mail activities and send them to customers, you can 

save the document to your desktop and then attach it to the outgoing e-mail.  

Add or remove documents  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Sales Permissions  

Similar to how you attach a file to any record, you can attach documents to your sales literature. However, when 
you add a document, you must enter a title. You can also specify the author and add keywords, which you or 
someone else can use later to locate the document.  

 

1. In the Navigation Pane, click Sales, and then click Sales Literature.  

2. In the list of sales literature, open the sales literature record you want to add a document to.  
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3. Under Details, click Documents.  

4. On the Actions toolbar, click New Document.  

5. Enter a title (required field), author name, keywords, and an abstract for your document.  

6. If you want to attach a file to the document, type its name in the File Name box or click Browse to 

locate the file, and then click Attach. Attaching a file might take a few minutes, depending on the 

size of the file.  

7. Click Save or Save and Close.  

Tip 

Although you cannot attach sales literature documents directly to e-mail activities and send them to customers, you can 

save the document to your desktop and then attach it to the outgoing e-mail.  

Note 

To remove documents from sales literature, follow steps 1, 2, and 3 above to navigate to the appropriate area. Select 

the documents you want to remove. On the Actions toolbar, click the Delete button . In the confirmation message, 

click OK.  

Add or remove products  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Sales Permissions  

If you develop sales literature to support your products, you can link the two types of records. When you are 
selling a particular product, you will know what information is available about the product.  

 

1. In the Navigation Pane, click Sales, and then click Sales Literature.  

2. In the list of sales literature, open the sales literature you want to add products to.  

3. Under Details, click Products.  

4. On the Actions toolbar, click Add Existing Product.  

5. In the Look Up Records dialog box, search for and select the products you want to add to the sales 

literature, and then click OK.  

6. Click Save or Save and Close.  

Notes 

 To remove products from sales literature, follow steps 1, 2, and 3 above to navigate to the appropriate 

area. Select the products you want to remove. On the Actions toolbar, click More Actions, and 

then click Remove. In the confirmation message, click OK.  

 When you add or remove a product from a sales literature record, both records are updated to reflect 

the association between them.  

Understanding Quick Campaigns 

You can use a quick campaign to communicate with an ad-hoc list of customers (accounts, contacts, or leads). More 

information: Work with Quick Campaigns  
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Selecting recipients for the quick campaign 

There are three ways you can select the list of recipients for your quick campaign:  

 Select the accounts, contacts, or leads directly.  

 Select one or more marketing lists.  

 Do a search in Advanced Find and create a quick campaign from the resulting list of records.  

Creating the quick campaign 

When you create your new quick campaign, you can choose whether you want to own the activities that you distribute, 

or whether each of the users who own the records in your quick campaign should own the distributed activities. If you 

use the quick campaign to create and distribute e-mail activities, you can also choose whether you want Microsoft 

Dynamics CRM to automatically send the e-mail messages and whether the corresponding e-mail activities should be 

closed.  

After you finish configuring your quick campaign, Microsoft Dynamics CRM immediately creates and distributes the 

activity you specified for all of the customers you selected.  

Working with the completed quick campaign record 

After you have used a quick campaign to quickly distribute activities, you can use the quick campaign record to:  

 Collect, view, and take action on campaign responses.  

 View the activities created from the quick campaign and the current status on those activities.  

 Close one or more open activities created from the quick campaign.  

 View the records for the customers who were contacted.  

 View the records for customers who could not be contacted and an explanation for why these 

customers were not included in the quick campaign.  

Differences between campaigns and quick campaigns 

In contrast to campaigns, quick campaigns do not include many of the same tracking and reporting features, and 

support only one type of activity for each quick campaign. However, you can use quick campaigns to distribute a single 

activity automatically to an ad-hoc selection of marketing lists, accounts, contacts, or leads.  

Campaigns can represent an organization's marketing efforts over an extended period of time. The effects of a quick 

campaign are immediate.  

Another key difference between campaigns and quick campaigns is in how marketing lists work with quick campaigns. 

Using quick campaigns, you can still select one or more marketing lists and create activities for all of the records in 

those lists. However, Microsoft Dynamics CRM does not associate the marketing list itself with the quick campaign. 

Instead, activities are created only for the accounts, contacts, or leads that were included in the marketing list or lists 

when you selected them.  

Additional quick campaign features in Microsoft Dynamics CRM for Outlook  

Some quick campaign features are available only in Microsoft Dynamics CRM for Outlook :  

 Compose personalized e-mail messages using a template.  

 Send messages in simple HTML or rich text format with the mail merge feature.  

Haghighat Sabet
Highlight

Haghighat Sabet
Highlight

Haghighat Sabet
Highlight

Haghighat Sabet
Highlight

Haghighat Sabet
Highlight

Haghighat Sabet
Highlight



 

 

 Microsoft Dynamics CRM 4.0 User’s Guide 289 

 

Work with Quick Campaigns 

Although you can print or export the quick campaign list and delete quick campaigns you no longer need, you must 

select records in other lists to create a new quick campaign.  

Caution: Deleting a quick campaign record deletes all of the activities created by the quick campaign, even if those 

activities were not yet complete.  

Create a quick campaign  

 Can I do this task?  

This task requires permissions that are found in all default marketing security roles. More information 
about specific permissions and performing this task while offline: Marketing Permissions  

You can use quick campaigns to create one type of activity for many accounts, contacts, or leads at once.  

 

1. Select the records or list you want to run a quick campaign on, and then start the Create Quick 

Campaign Wizard.  

 From a list of records, including the results of a search You can run a quick campaign from any list of accounts, 

contacts, or leads.  

a. Select the record or records for which you want to create a quick campaign. If you want to include all 

records on the current page or all records on all pages, then skip this step.  

b. On the Actions toolbar, click Create Quick Campaign , and then click one of the following:  

 For Selected Records  

Select this option if you have selected one or more records in the list.  

 For All Records on Current Page  

Select this option to include all records on the page for the quick campaign activity.  

 For All Records on All Pages  

Select this option to include all records on all pages for the quick campaign activity.  

 From the Marketing Lists list You can run a quick campaign on one or more marketing lists in the Marketing 

Lists list.  

a. In the Navigation Pane, click Marketing or Sales, and then click Marketing Lists.  

b. Select the marketing list or marketing lists for which you want to create a quick campaign.  

c. On the Actions toolbar, click Create Quick Campaign, and then click For Selected Records.  

 From a marketing list You can run a quick campaign on the accounts, contacts, or leads in any marketing list.  

a. In the Navigation Pane, click Marketing or Sales, and then click Marketing Lists.  

b. Double-click the marketing list for which you want to create a quick campaign.  

c. On the Actions toolbar, click Create Quick Campaign.  

4. In the Create Quick Campaign Wizard, follow the instructions to create the quick campaign.  

Notes 
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 You cannot add additional records to a quick campaign after you have created it.  

 In the Create Quick Campaign Wizard, you can select who you want Microsoft Dynamics CRM to 

assign the activity to and whether Microsoft Dynamics CRM should perform the activity automatically 

for appropriate activities (such as sending e-mail messages). This choice affects who can see and 

take action on an activity. For example, if you were creating a phone call activity for all of the sales 

representatives, you could select the phone call activity, and then select The owners of the 

records that are included in the quick campaign. Each sales representative could then see the 

activity and take action on it. However, if you were creating a large number of e-mail activities that 

Microsoft Dynamics CRM would perform automatically, you could assign the e-mail activity to 

yourself instead of the record owners.  

 Whether or not some activities are performed automatically depends on an option available to users 

who have the Organization Settings Write privilege. More information: Manage System Settings  
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Completing Sales Transactions 

Completing Sales Transactions 

The life of a successful sales transaction typically starts with a draft quote. When the quote is ready, it is activated and 

sent to the customer. A quote frequently undergoes several revisions between the salesperson and customer before it is 

accepted.  

After the quote is accepted, an order is generated from the quote. The order is used to fulfill the agreement of goods or 

services that were offered in the quote. Finally, after the order for the goods or services is shipped, an invoice is 

generated.  

In Microsoft Dynamics CRM, quotes, orders, and invoices are considered to be the same item, but in different states of 

transition.  

Your sales force can use the tools and templates in Microsoft Dynamics CRM to create and print quotes, orders, and 

invoices when they are working either online or offline at a customer site. Additionally, these tools are used to set 

expiration dates and convert quotes into orders or orders into invoices.  

Understanding Quote Stages 

To some extent, the definitions of the stages of quotes will be set at your organization. However, when you create a 

new quote, it is automatically set to Draft, and the revision ID is set to 0.  

In many organizations, a quote needs a manager's confirmation before being set to Active. Some organizations use 

workflow to route the quote to the manager to review it and turn it to Active. In other organizations, the person who 

creates the quote can set it to Active.  

Only an active quote should be sent to a customer. Once a quote is made active, it becomes read-only so that the 

version you sent to the customer matches what you have in-house. If you need to revise a quote, you can revise it, and 

the revision ID will increase by one. This way, you can correlate your revision of the quote with what has been sent to 

the customer.  

When you close a quote, you have three choices: Lost, Canceled, or Revised. If you choose to revise the quote, a new 

quote is created, set to Draft status, and you can start over. If you choose not to revise the quote, the quote is closed.  

Differences between Current Pricing and Prices Locked 

Microsoft Dynamics CRM has two kinds of pricing behavior on orders and invoices: Use Current Pricing and Prices 

Locked. 

The Use Current Pricing behavior is directly associated with the price per unit for a product that is in the product 

catalog. Therefore, if a price is changed for a product in the product catalog, the unit price will change in all open 

invoices as well as both draft and active orders that include that product. This may not be the behavior you want with 

existing orders or invoices that have already been presented to the customer.  

Prices Locked locks the price per unit for a product in an open order or invoice. Even if a price change is made to a 

product that is in the product catalog, the open order or invoice that has Prices Locked enabled will remain at the 

original price.  

Note that, when you enable Prices Locked, you disable Use Current Pricing. 

Work with Quotes 

Most sales are preceded by a quote or a series of quotes. A quote might go through several revisions before it becomes 

an order. When you revise a quote by changing products or discounts, those changes are also reflected in your overall 

sales forecast.  
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When you first create a quote it has a status of Draft. A quote that is a draft can be changed. When the quote is ready 

to send to the customer, you change the status of the quote to Active. When you open a quote that is active, the quote 

information is displayed as read-only and cannot be changed.  

Create or edit a quote  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Sales Permissions  

 

 

1. In the Navigation Pane, click Sales, and then click Quotes.  

2. On the Actions toolbar, click New, or open the record that you want to edit.  

Note: To edit an active quote, you must select Revise on the Actions  menu. The status of a 

quote is listed in the Status column.  

3. On the General tab, enter information or observe any noted restrictions or requirements as needed:  

You can use accent marks when you enter data, for example, in a customer's name. Your ability to 

sort and find information is not affected by these accent marks.  

 Quote ID  

This information is automatically created. System administrators can set the auto-numbering 

format for this ID from the Administration page, under Set Auto-Numbering.  

 Revision ID  

This information is automatically created. The Revision ID tracks the number of times an 

active quote has been revised.  

 Name  

You must enter a name with a length of 100 characters or fewer. The information should be 

meaningful and unique. By default, these records are sorted by Name in the records list.  

 Potential Customer  

Search for and select an account or contact. You can select a record from a filtered list in the 

Form Assistant pane, or you can click the Lookup button  to search for other records.  

 Currency  

Select the currency in which the quote will be calculated.  

 Price List  

Search for and select the price list that you want. Price lists are created in the product 

catalog. At least one price list must exist in the product catalog before you can select it. You 

can select a record from a filtered list in the Form Assistant pane, or you can click Lookup to 

search for other records.  

In the Totals area, enter all the information you have available. If you are adding a discount, you 

can add a percentage discount, a monetary discount amount, or both.  

 Detail Amount  

This box is read-only and automatically calculates the sum of all existing quote, order, or 

invoice line items, which includes products and write-in products.  
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 Quote Discount (%)  

This number represents a percentage of the total amount (not including freight charges) that 

will be discounted from the total amount. This must be a number between 0.00 and 100.00. 

You can use a decimal point, but you cannot use a percent sign (%).  

 Quote Discount  

This number represents a whole monetary amount that will be discounted from the total 

amount. This must be a number between 0.00 and 100,000,000,000.00. You can use commas 

and a decimal point, but you cannot use a currency symbol, such as dollar ($), euro (€), or 

yen (¥).  

 Pre-Freight Amount  

This box is read-only and automatically calculates a subtotal based on the detail amount and 

any discounts.  

 Freight Amount  

This must be a number between 0.00 and 100,000,000,000.00. You can use commas and a 

decimal point, but you cannot use a currency symbol, such as dollar ($) or euro (€).  

 Total Tax  

The total tax is calculated when you click Recalculate or when you click Save.  

 Total Amount  

The total amount is calculated when you click Recalculate or when you click Save.  

4. On the Notes tab, click Click here to enter a new note, and add the information that applies to 

your record.  

5. Click Save or Save and Close.  

 Resolve potential duplicate records.  

1. If the system detects that your record might be a potential duplicate, instead of saving the 

record, you'll see the Duplicates Detected dialog box.  

2. To open a record to make sure it is a potential duplicate, in the Potential duplicate records 

list, double-click the record.  

 If the duplicate-detection rule identified potential duplicate records in other record 

types, review records from each record type listed.  

3. If your new or updated record is not a duplicate, to create the new record, click Save Record.  

– OR –  

If your new or updated record is a duplicate, to cancel your changes, click Cancel.  

Notes  

 If you enter a duplicate record within a few minutes of entering the first record, Microsoft 

Dynamics CRM will not detect the duplicate record. The matchcodes for new and updated 

records are created every five minutes, rather than as a record is created.  

Duplicate detection can take place only if duplicate detection is enabled in Duplicate Detection Settings 
and if at least one duplicate-detection rule exists for the record type. More information: Avoiding Duplicate 
Records  

Tips 

 To activate a quote, on the Quote form, on the Actions menu, click Activate Quote.  
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 You must manually enter the tax amount when you add a product to a quote, order, or invoice. 

Microsoft Dynamics CRM does not automatically calculate tax for individual products. However, the 

total tax is calculated automatically based on the sum of the tax amounts for all of the individual 

products in a quote, order, or invoice.  

 When the Look Up Records dialog box is open, if the record you need doesn't exist, click New, and 

create the record.  

Add or remove a contact  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Sales Permissions  

 

 

1. In the Navigation Pane, click Sales, and then click Quotes.  

– OR –  

In the Navigation Pane, click Sales, and then click Orders.  

– OR –  

In the Navigation Pane, click Sales, and then click Invoices.  

2. In the list of quotes, orders or invoices, open the record you want to add a contact to.  

3. Under Details, click Other Contacts.  

4. On the Actions toolbar, click Add Existing Contact.  

5. In the Look Up Records dialog box, search for and select the contact records you want to add to the 

quote, order or invoice, and then click OK.  

6. Click Save or Save and Close.  

Tip 

If you cannot locate the contact you want to add, you might need to create it. To do this, in the Look Up Records 

dialog box, click New and then complete the form.  

Note 

To remove a contact from a quote, order, or invoice, follow steps 1, 2, and 3 above to navigate to the appropriate area. 

Select the contact or contacts you want to remove, and then on the Actions toolbar, click More Actions, and then click 

Remove. In the confirmation message, click OK.  
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Activate a quote  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Sales Permissions  

Before you send your quote to a customer, you must activate it. When you activate a quote, the quote is 

displayed as read-only.  

 

1. In the Navigation Pane, click Sales, and then click Quotes.  

2. Open the draft quote that you want to activate.  

3. On the Actions  menu, click Activate Quote.  

Edit an active quote  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Sales Permissions  

When you revise an active quote, a new quote with a new quote ID is created. The original quote is closed and 
stored in the Microsoft Dynamics CRM database for tracking purposes.  

 

1. In the Navigation Pane, click Sales, and then click Quotes.  

2. Open the record that you want.  

3. On the Actions  menu, click Revise.  

4. On the General tab, make the changes that you want in the following boxes:  

 Quote ID  

This information is automatically created. System administrators can set the auto-numbering 

format for this ID from the Administration page, under Set Auto-Numbering.  

 Revision ID  

This information is automatically created. The Revision ID tracks the number of times an 

active quote has been revised.  

 Name  

You must enter a name with a length of 100 characters or fewer. The information should be 

meaningful and unique. By default, these records are sorted by Name in the records list.  

 Potential Customer  

Search for and select an account or contact. You can select a record from a filtered list in the 

Form Assistant pane, or you can click the Lookup button  to search for other records.  

 Currency  

Select the currency in which the quote will be calculated.  
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 Price List  

Search for and select the price list that you want. Price lists are created in the product 

catalog. At least one price list must exist in the product catalog before you can select it. You 

can select a record from a filtered list in the Form Assistant pane, or you can click Lookup to 

search for other records.  

In the Totals area, enter all the information you have available. If you are adding a discount, you 

can add a percentage discount, a monetary discount amount, or both.  

 Quote Discount (%)  

This number represents a percentage of the total amount (not including freight charges) that 

will be discounted from the total amount. This must be a number between 0.00 and 100.00. 

You can use a decimal point, but you cannot use a percent sign (%).  

 Quote Discount  

This number represents a whole monetary amount that will be discounted from the total 

amount. This must be a number between 0.00 and 100,000,000,000.00. You can use commas 

and a decimal point, but you cannot use a currency symbol, such as dollar ($), euro (€), or 

yen (¥).  

 Freight Amount  

This must be a number between 0.00 and 100,000,000,000.00. You can use commas and a 

decimal point, but you cannot use a currency symbol, such as dollar ($) or euro (€).  

 Total Tax  

The total tax is calculated when you click Recalculate or when you click Save.  

 Total Amount  

The total amount is calculated when you click Recalculate or when you click Save.  

5. On the Notes tab, click Click here to enter a new note, and add the information that applies to 

your record.  

6. Click Save or Save and Close.  

Print a quote with a mail-merge document  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: E-mail Permissions  

You can use a mail-merge template to generate a customer-ready document that displays data from a saved 

quote, and that includes a header and a footer.  

In Microsoft Dynamics CRM for Outlook, only one mail merge can be run at a time. If you want to discontinue a 
mail merge, close Microsoft Office Word. You can run multiple mail merge processes at the same time in the Web 
application.  

 

1. In the Navigation Pane, click Sales, and then click Quotes.  

2. Open the quote you want to print. If you want to use mail merge with a new quote, before starting 

the mail merge, save the quote first.  

3. On the Actions toolbar, click Print Quote for Customer .  

4. If you have other languages installed, you can select a language to filter the list of templates.  

5. In the Mail Merge dialog box, select the type of document you want to use. 
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 Note 

If the E-mail option is not available, the Enable Direct E-mail via Mail Merge option in the System 

Settings may be set to No. More information: Manage System Settings  

6. Select if you want to start with a blank document or a template. If you select a template option, click 

the Lookup button  to select a template. 

New mail merge templates are created in the Settings area. More information: Work with Mail Merge 

Templates  

7. If necessary, you can add or delete data fields. Microsoft Office Word supports up to 64 data fields, of 

which Microsoft Dynamics CRM for Outlook reserves two data fields to store the primary key and the 

record owner.  

While working with quotes, removing or re-arranging data fields may cause the quote to not display 

or print properly. The footer displays after "LastItem", which marks the end of the quote data fields. 

8. Click OK.  

Microsoft Dynamics CRM automatically opens a Microsoft Office Word document. In the File 

Download dialog box, click Open.  

This is not your mail-merge document. This is an interim page. Follow the directions in the Word 

document, including clicking CRM.  

9. In the Mail Merge Recipient dialog box, verify that the list is accurate, and then click OK.  

10. To continue the mail merge, follow the instructions provided by the Mail Merge pane. For more 

information, see the Microsoft Office Word Help documentation.  

 Tip  

 To display the information you want and select the format, in the Mail Merge wizard, click 

Address Block and then Greeting Line.  

To add data fields to display more information, click More Items. You can use up to 64 data fields.  

11. If you are working in Microsoft Dynamics CRM for Outlook and you have either created a new 

template or updated an existing template, you can upload the template.  

 To save the document as a template, on the Complete the Merge pane, click Upload 

Template to CRM. 

If you are working in the Web application, you can upload the template in the Settings area. More 

information: Work with Mail Merge Templates 

12. When you have completed work on the mail merge document, close it, and then delete the interim 

mail-merge document (Mail_Merge_nnnn.xml) and the associated text file (Mail_Merge_nnnn.txt) 

with the same name. 

 Warning Mail merge may leave sensitive data on your computer.  
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The mail merge process creates two files in addition to your mail merge documents. These files are the 

data sources used by mail merge and contain Microsoft Dynamics CRM data, which may include sensitive 

customer data. You should delete these data source files after you complete the mail merge.  

Both files have the same name: Mail_Merge[nnnn], where nnnn is a 4-character, randomly generated 

number. One file is a.doc file and the other is a.txt file. Unless you moved the files or saved them to 

another directory, these files are usually in a temporary files folder on your computer. 

13. If you are working in Microsoft Dynamics CRM for Outlook, after you merge the new document, you 

can choose to create Microsoft Dynamics CRM activities for mail-merge items.  

1. In the Create Activities dialog box, click Create Microsoft Dynamics CRM activities.  

2. If you want to change the default values for the activity, click Activity Details, and then 

make any changes. To save the changes, click OK.  

3. Under Assign activities to, select to whom the new activities should be assigned.  

4. You can choose to have the new activities closed immediately. E-mail activities are closed as 

soon as the messages are sent.  

5. If you are creating a mail merge from a marketing list, you can also make the mail merge a 

quick campaign and include an link in e-mail messages for customers to remove themselves 

from your marketing lists.  

6. Click OK to save the changes and create the activities.  

Closed activities appear in the history list of the customer record. Open activities appear in the 

activities list of the customer record and in your list of active activities.  

Note 

If an account or contact does not have a valid e-mail address or has the Do Not Allow option set for Bulk E-mail, the 

message is not sent to them, and no e-mail activity is created.  

Create an order from a quote  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Sales Permissions  

When your customer has agreed to the terms of your quote, you can convert it to an order. In Microsoft Dynamics 

CRM, you can only convert an active quote to an order.  

Note: After you create an order from a quote, you can no longer revise the quote.  

 

1. In the Navigation Pane, click Sales, and then click Quotes.  

2. Open the active quote that you want.  

3. On the Actions  menu, click Create Order.  

4. In the Create Order dialog box, you can change the date in the Date Won box and add a 

description in the Description box.  

5. Click OK. The new order record opens automatically.  
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6. On the General tab, make the changes that you want in the following boxes:  

 Order ID 

This information is automatically created. System administrators can set the auto-numbering 

format for this ID from the Administration page, under Set Auto-Numbering.  

 Name  

You must enter a name with a length of 100 characters or fewer. The information should be 

meaningful and unique. You can use accent marks when you enter data, for example, in a 

customer's name. Your ability to sort and find information is not affected by these accent 

marks. By default, these records are sorted by Name in the records list.  

 Customer  

You must search for and select an account or contact. You can select a record from a filtered 

list in the Form Assistant pane, or you can click the Lookup button  to search for other 

records.  

 Price List  

Search for and select the price list that you want. Price lists are created in the product 

catalog. At least one price list must exist in the product catalog before you can select it. You 

can select a record from a filtered list in the Form Assistant pane, or you can click Lookup to 

search for other records.  

In the Totals area, enter all the information you have available. If you are adding a discount, you 

can add a percentage discount, a monetary discount amount, or both.  

 Order Discount (%) 

This number represents a percentage of the total amount (not including freight charges) that 

will be discounted from the total amount. This must be a number between 0.00 and 100.00. 

You can use a decimal point, but you cannot use a percent sign (%).  

 Order Discount 

This number represents a whole monetary amount that will be discounted from the total 

amount. This must be a number between 0.00 and 100,000,000,000.00. You can use commas 

and a decimal point, but you cannot use a currency symbol, such as dollar ($), euro (€), or 

yen (¥).  

 Freight Amount  

This must be a number between 0.00 and 100,000,000,000.00. You can use commas and a 

decimal point, but you cannot use a currency symbol, such as dollar ($) or euro (€).  

 Total Tax  

The total tax is calculated when you click Recalculate or when you click Save.  

 Total Amount  

The total amount is calculated when you click Recalculate or when you click Save.  

 Prices Locked  

This check box is read-only. You set Prices Locked by clicking the Actions  menu, and 

then click Lock Pricing. Alternatively, you disable Prices Locked by clicking the Actions 

menu, and then clicking Use Current Pricing.  

More information: Completing Sales Transactions  

7. On the Shipping tab, enter all the information you have available and observe any noted restrictions 

or requirements.  
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You must enter the date in the format your organization has set for dates. For example, 01/01/2006 

or 31.12.2005.  

If you omit leading zeros in a date, Microsoft Dynamics CRM will add them automatically. For 

example, when you type 1/1/06, Microsoft Dynamics CRM will display it as 01/01/2006, if that is the 

date format of your organization.  

8. On the Addresses tab, enter all the information that you have available in the following sections:  

 Bill To Address  

Enter the address where the billing information will be sent.  

 Ship To Address  

Enter the address information to ship the items to the customer. Select Will Call if the 

customer will pick up the items.  

To look up the Bill To Address or Ship To Address information, follow these steps:  

1. On the Form toolbar, click Look Up Address.  

2. In the Look Up Address dialog box, select the Bill To Address check box, the Ship 

To Address check box, or both.  

3. Click Lookup.  

4. In the list of records, select the record you want, and then click OK.  

9. On the Administration tab, enter information or observe any noted restrictions or requirements as 

needed:  

 Owner 

This box is filled automatically with the name of the user who is creating the record. You can 

click the Lookup button  to search for other records.  

 Status Reason 

Select the status of the item.  

 Source Campaign  

The campaign record that appears in this field is automatically assigned when you convert a 

quote associated with a campaign into an order.  

 Opportunity 

Select an opportunity if you want to associate this item with an opportunity.  

 Quote 

Select a quote if you want to associate this order with a quote.  

10. On the Notes tab, click Click here to enter a new note, and add the information that applies to 

your record.  

11. Click Save or Save and Close.  

 Resolve potential duplicate records.  

1. If the system detects that your record might be a potential duplicate, instead of saving the 

record, you'll see the Duplicates Detected dialog box.  

2. To open a record to make sure it is a potential duplicate, in the Potential duplicate records 

list, double-click the record.  

 If the duplicate-detection rule identified potential duplicate records in other record 

types, review records from each record type listed.  

3. If your new or updated record is not a duplicate, to create the new record, click Save Record.  
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– OR –  

If your new or updated record is a duplicate, to cancel your changes, click Cancel.  

Notes  

 If you enter a duplicate record within a few minutes of entering the first record, Microsoft 

Dynamics CRM will not detect the duplicate record. The matchcodes for new and updated 

records are created every five minutes, rather than as a record is created.  

Duplicate detection can take place only if duplicate detection is enabled in Duplicate Detection Settings 
and if at least one duplicate-detection rule exists for the record type. More information: Avoiding Duplicate 
Records  

Tip 

When the Look Up Records dialog box is open, if the record you need doesn't exist, click New, and create the record.  

Close an active quote  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Sales Permissions  

Important: You cannot edit a closed quote record.  

 

1. In the Navigation Pane, click Sales, and then click Quotes.  

2. Open the active quote that you want to close.  

3. On the Actions  menu, click Close Quote.  

 Status Reason 

Select the status of the item. The choices available by default are Lost, Canceled, and 

Revised.  

 Close Date 

Enter the date that the quote was closed.  

 Create a revised quote  

You may be closing the quote because you need to create a new, revised quote. If this is the 

case, select this option.  

– OR –  

Do not revise this quote  

If you do not want to create a revised quote, select this option.  

 Close the associated opportunity  

If this quote is associated with an opportunity, you can select Close the associated 

opportunity to close the opportunity.  
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Default sales reports 

The following sales reports are available:  

This topic shows you how to use the different reports. You also can find more information when you generate a 

report, click Help, and then click Help on This Page.  

 Account Distribution Report  

Use this report to identify patterns in your top revenue-generating accounts. The report displays two 

charts. The earned revenue chart displays a chart of the earned revenue grouped by a market facet, such 

as product, territory, or industry. The accounts count chart, displays the amount of earned revenue using 

the same grouping as the earned revenue chart.  

 Account Overview Report  

Use this report to obtain a one-page overview of everything occurring with an account. The report displays 

a profile of the account, contact information, and summaries of opportunities and case activities.  

 Account Summary Report  

Use this report to determine historically what has occurred with an account. This report also displays what 

is scheduled to occur in the future. The report displays a chronological summary for an account, including 

sales and service activities, notes, and records.  

 Activities Report  

Use this report to identify patterns in activities. Activities can be grouped by owner or activity type, or by 

the record the activity is regarding.  

 Competitor Win Loss Report  

Use this report to compare how your sales team performs against your competitors. The report displays a 

list of competitors, with data on open, closed, won, and lost opportunities for each.  

 Invoices Report  

Use this report to print invoices.  

 Invoice Status Report  

Use this report to view your accounts receivable. The chart displays invoices grouped by status.  

 Lead Source Effectiveness Report  

Use this report to compare how effective your lead sources are at generating quality opportunities. The 

report lists the percentage of qualified leads, and leads that generate revenue for each lead category.  

 Neglected Leads Report  

Use this report to identify any leads that have not been contacted. The report displays a chart of leads that 

have had no associated activities or notes during a specified time period.  

 Orders Report  

Use this report to print orders.  

 Quotes Report  

Use this report to print quotes.  

 Sales Pipeline Report  

Use this report to see anticipated potential sales. The report displays a chart of potential sales grouped by 

user, sales territory, customer territory, date, products, rating, or sales stage.  

 Sales History Report  

Use this report to view a history of sales performance by sales representative. The report displays a chart 

of both lost and earned revenue.  

 Neglected Accounts Report  
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Use this report to identify accounts that have not been contacted recently. The report displays a chart with 

accounts that have had no activities completed in a specified number of days.  

 Products by Account Report  

Use this report to see which products are used by an account. For each account, the report lists the 

associated products.  

 Products by Contact Report  

Use this report to see which products are used by a contact. For each contact, the report lists the 

associated products.  

If the default reports don't provide the information you need, try creating an Advanced Find search, and exporting 
the results to Microsoft Office Excel.  

Note 

This topic documents the list of default reports as they were shipped. If this list differs from the reports that are 

available to you, contact your report administrator or system administrator for information about the customized 

reports.  

Work with Orders 

When a customer is ready to purchase a product, you can create an order to record the potential sale.  

You can delete an order only when it is active. Closed orders are read-only and cannot be deleted. Open the order and 

view the Status field if you are not sure about the status of your selection.  

Create or edit an order  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Sales Permissions  

Typically, you convert a quote that is won into an order. However, you can also use Microsoft Dynamics CRM to 
create an order that does not originate from a quote.  

 

1. In the Navigation Pane, click Sales, and then click Orders.  

2. On the Actions toolbar, click New, or open the record that you want to edit.  

3. On the General tab, enter information or observe any noted restrictions or requirements as needed:  

 Order ID  

This information is automatically created. System administrators can set the auto-numbering 

format for this ID from the Administration page, under Set Auto-Numbering.  

 Name  

You must enter a name with a length of 100 characters or fewer. The information should be 

meaningful and unique. You can use accent marks when you enter data, for example, in a 

customer's name. Your ability to sort and find information is not affected by these accent 

marks. By default, these records are sorted by Name in the records list.  

 Customer  

You must search for and select an account or contact. You can select a record from a filtered 

list in the Form Assistant pane, or you can click the Lookup button  to search for other 

records.  
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 Currency  

Select the currency in which the order will be calculated.  

 Price List  

Search for and select the price list that you want. Price lists are created in the product 

catalog. At least one price list must exist in the product catalog before you can select it. You 

can select a record from a filtered list in the Form Assistant pane, or you can click Lookup to 

search for other records.  

In the Totals area, enter all the information you have available. If you are adding a discount, you 

can add a percentage discount, a monetary discount amount, or both.  

 Detail Amount 

This box is read-only and automatically calculates the sum of all existing quote, order, or 

invoice line items, which includes products and write-in products.  

 Order Discount (%)  

This number represents a percentage of the total amount (not including freight charges) that 

will be discounted from the total amount. This must be a number between 0.00 and 100.00. 

You can use a decimal point, but you cannot use a percent sign (%).  

 Order Discount  

This number represents a whole monetary amount that will be discounted from the total 

amount. This must be a number between 0.00 and 100,000,000,000.00. You can use commas 

and a decimal point, but you cannot use a currency symbol, such as dollar ($), euro (€), or 

yen (¥).  

 Freight Amount  

This must be a number between 0.00 and 100,000,000,000.00. You can use commas and a 

decimal point, but you cannot use a currency symbol, such as dollar ($) or euro (€).  

 Total Tax  

The total tax is calculated when you click Recalculate or when you click Save.  

 Total Amount  

The total amount is calculated when you click Recalculate or when you click Save.  

 Prices Locked  

This check box is read-only. You set Prices Locked by clicking the Actions  menu, and 

then click Lock Pricing. Alternatively, you disable Prices Locked by clicking the Actions 

menu, and then clicking Use Current Pricing.  

More information: Completing Sales Transactions  

4. On the Shipping tab, enter all the information you have available and observe any noted restrictions 

or requirements.  

You must enter the date in the format your organization has set for dates. For example, 01/01/2006 

or 31.12.2005.  

If you omit leading zeros in a date, Microsoft Dynamics CRM will add them automatically. For 

example, when you type 1/1/06, Microsoft Dynamics CRM will display it as 01/01/2006, if that is the 

date format of your organization.  

5. On the Addresses tab, enter all the information that you have available in the following sections:  

 Bill To Address  

Enter the address where the billing information will be sent.  
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 Ship To Address  

Enter the address information to ship the items to the customer. Select Will Call if the 

customer will pick up the items.  

To look up the Bill To Address or Ship To Address information, follow these steps:  

1. On the Form toolbar, click Look Up Address.  

2. In the Look Up Address dialog box, select the Bill To Address check box, the Ship 

To Address check box, or both.  

3. Click Lookup.  

4. In the list of records, select the record you want, and then click OK.  

6. On the Administration tab, enter information or observe any noted restrictions or requirements as 

needed:  

 Owner  

This box is filled automatically with the name of the user who is creating the record. You can 

click the Lookup button  to search for other records.  

 Status Reason  

Select the status of the item.  

 Source Campaign  

The campaign record that appears in this field is automatically assigned if the order is 

converted from a quote associated with a campaign. You cannot assign a source campaign to 

completely new orders.  

 Opportunity 

Select an opportunity if you want to associate this item with an opportunity.  

 Quote 

Select a quote if you want to associate this order with a quote.  

7. On the Notes tab, click Click here to enter a new note, and add the information that applies to 

your record.  

8. Click Save or Save and Close.  

 Resolve potential duplicate records.  

1. If the system detects that your record might be a potential duplicate, instead of saving the 

record, you'll see the Duplicates Detected dialog box.  

2. To open a record to make sure it is a potential duplicate, in the Potential duplicate records 

list, double-click the record.  

 If the duplicate-detection rule identified potential duplicate records in other record 

types, review records from each record type listed.  

3. If your new or updated record is not a duplicate, to create the new record, click Save Record.  

– OR –  

If your new or updated record is a duplicate, to cancel your changes, click Cancel.  

Notes  

 If you enter a duplicate record within a few minutes of entering the first record, Microsoft 

Dynamics CRM will not detect the duplicate record. The matchcodes for new and updated 
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records are created every five minutes, rather than as a record is created.  

Duplicate detection can take place only if duplicate detection is enabled in Duplicate Detection Settings 
and if at least one duplicate-detection rule exists for the record type. More information: Avoiding Duplicate 
Records  

Tip 

When the Look Up Records dialog box is open, if the record you need doesn't exist, click New, and create the record.  

Note 

You must manually enter the tax amount when you add a product to a quote, order, or invoice. Microsoft Dynamics 

CRM does not automatically calculate tax for individual products. However, the total tax is calculated automatically 

based on the sum of the tax amounts for all of the individual products in a quote, order, or invoice.  

Add or remove a contact  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Sales Permissions  

 

 

1. In the Navigation Pane, click Sales, and then click Quotes.  

– OR –  

In the Navigation Pane, click Sales, and then click Orders.  

– OR –  

In the Navigation Pane, click Sales, and then click Invoices.  

2. In the list of quotes, orders or invoices, open the record you want to add a contact to.  

3. Under Details, click Other Contacts.  

4. On the Actions toolbar, click Add Existing Contact.  

5. In the Look Up Records dialog box, search for and select the contact records you want to add to the 

quote, order or invoice, and then click OK.  

6. Click Save or Save and Close.  

Tip 

If you cannot locate the contact you want to add, you might need to create it. To do this, in the Look Up Records 

dialog box, click New and then complete the form.  

Note 

To remove a contact from a quote, order, or invoice, follow steps 1, 2, and 3 above to navigate to the appropriate area. 

Select the contact or contacts you want to remove, and then on the Actions toolbar, click More Actions, and then click 

Remove. In the confirmation message, click OK.  
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Lock or unlock the price for an order or invoice  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Sales Permissions  

To determine whether your order or invoice is using Prices Locked, view the Prices Locked check box on the 

General tab of the Invoice or Order form. If the Prices Locked check box is not selected, Use Current Pricing 

is enabled.  

Note that this check box is read-only. You cannot enable or disable Prices Locked by clicking the Prices Locked 

check box on the General tab.  

 

1. In the Navigation Pane, click Sales, and then click Orders or Invoices.  

2. Open the order or invoice that you want.  

3. To enable Prices Locked, on the Actions  menu, click Lock Pricing.  

– OR –  

To enable Use Current Pricing, on the Actions  menu, click Use Current Pricing.  

Create an invoice from an order  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Sales Permissions  

In Microsoft Dynamics CRM, you can quickly generate an invoice based on the information that is in an order.  

 

1. In the Navigation Pane, click Sales, and then click Orders.  

2. Open the record that you want.  

3. On the Actions toolbar, click Create Invoice.  

4. On the General tab, make the changes that you want in the following boxes:  

 Invoice ID 

This information is automatically created. System administrators can set the auto-numbering 

format for this ID from the Administration page, under Set Auto-Numbering.  

 Name  

You must enter a name with a length of 100 characters or fewer. The information should be 

meaningful and unique. You can use accent marks when you enter data, for example, in a 

customer's name. Your ability to sort and find information is not affected by these accent 

marks. By default, these records are sorted by Name in the records list.  

 Customer  

You must search for and select an account or contact. You can select a record from a filtered 

list in the Form Assistant pane, or you can click the Lookup button  to search for other 

records.  
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 Currency  

Select the currency in which the invoice will be calculated.  

 Price List  

Search for and select the price list that you want. Price lists are created in the product 

catalog. At least one price list must exist in the product catalog before you can select it. You 

can select a record from a filtered list in the Form Assistant pane, or you can click Lookup to 

search for other records.  

In the Totals area, enter all the information you have available. If you are adding a discount, you 

can add a percentage discount, a monetary discount amount, or both.  

 Invoice Discount (%)  

This number represents a percentage of the total amount (not including freight charges) that 

will be discounted from the total amount. This must be a number between 0.00 and 100.00. 

You can use a decimal point, but you cannot use a percent sign (%).  

 Invoice Discount  

This number represents a whole monetary amount that will be discounted from the total 

amount. This must be a number between 0.00 and 100,000,000,000.00. You can use commas 

and a decimal point, but you cannot use a currency symbol, such as dollar ($), euro (€), or 

yen (¥).  

 Pre-Freight Amount  

This box is read-only and automatically calculates a subtotal based on the detail amount and 

any discounts.  

 Freight Amount  

This must be a number between 0.00 and 100,000,000,000.00. You can use commas and a 

decimal point, but you cannot use a currency symbol, such as dollar ($) or euro (€).  

 Total Tax  

The total tax is calculated when you click Recalculate or when you click Save.  

 Total Amount  

The total amount is calculated when you click Recalculate or when you click Save.  

 Prices Locked  

This check box is read-only. You set Prices Locked by clicking the Actions  menu, and 

then click Lock Pricing. Alternatively, you disable Prices Locked by clicking the Actions 

menu, and then clicking Use Current Pricing.  

More information: Completing Sales Transactions  

5. On the Shipping tab, enter all the information you have available and observe any noted restrictions 

or requirements.  

You must enter the date in the format your organization has set for dates. For example, 01/01/2006 

or 31.12.2005.  

If you omit leading zeros in a date, Microsoft Dynamics CRM will add them automatically. For 

example, when you type 1/1/06, Microsoft Dynamics CRM will display it as 01/01/2006, if that is the 

date format of your organization.  

6. On the Addresses tab, enter all the information that you have available in the following sections:  

 Bill To Address  

Enter the address where the billing information will be sent.  
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 Ship To Address  

Enter the address information to ship the items to the customer. Select Will Call if the 

customer will pick up the items.  

To look up the Bill To Address or Ship To Address information, follow these steps:  

1. On the Form toolbar, click Look Up Address.  

2. In the Look Up Address dialog box, select the Bill To Address check box, the Ship 

To Address check box, or both.  

3. Click Lookup.  

4. In the list of records, select the record you want, and then click OK.  

7. On the Administration tab, enter information or observe any noted restrictions or requirements as 

needed:  

 Owner  

This box is filled automatically with the name of the user who is creating the record. You can 

click the Lookup button  to search for other records.  

 Status Reason  

Select the status of the item.  

 Opportunity  

Select an opportunity if you want to associate this item with an opportunity.  

 Order  

Select an order if you want to associate this invoice with an order.  

8. On the Notes tab, click Click here to enter a new note, and add the information that applies to 

your record.  

9. Click Save or Save and Close.  

 Resolve potential duplicate records.  

1. If the system detects that your record might be a potential duplicate, instead of saving the 

record, you'll see the Duplicates Detected dialog box.  

2. To open a record to make sure it is a potential duplicate, in the Potential duplicate records 

list, double-click the record.  

 If the duplicate-detection rule identified potential duplicate records in other record 

types, review records from each record type listed.  

3. If your new or updated record is not a duplicate, to create the new record, click Save Record.  

– OR –  

If your new or updated record is a duplicate, to cancel your changes, click Cancel.  

Notes  

 If you enter a duplicate record within a few minutes of entering the first record, Microsoft 

Dynamics CRM will not detect the duplicate record. The matchcodes for new and updated 

records are created every five minutes, rather than as a record is created.  

Duplicate detection can take place only if duplicate detection is enabled in Duplicate Detection Settings 
and if at least one duplicate-detection rule exists for the record type. More information: Avoiding Duplicate 
Records  
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Tip 

When the Look Up Records dialog box is open, if the record you need doesn't exist, click New, and create the record.  

Close an order  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Sales Permissions  

You close an order by either fulfilling the order or canceling the order. Products or services that are shipped are 
fulfilled. Conversely, products or services that are not shipped should be canceled.  

 

1. In the Navigation Pane, click Sales, and then click Orders.  

2. In the Orders list, open the order that you want.  

3. On the Actions  menu, click Fulfill Order if the order is fulfilled, or click Cancel Order if the 

order is canceled.  

4. In the dialog box, enter information in the following boxes, and then click OK:  

 Status Reason  

Select the status of the item.  

 Date Fulfilled or Cancel Date 

Select the date that the order was fulfilled or canceled.  

 Description 

Enter a description of the order fulfillment or cancellation.  

Important 

You cannot update or change an order after it has been closed. Additionally, you cannot update or change an order that 

been partially or completely fulfilled.  
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Default sales reports 

The following sales reports are available:  

This topic shows you how to use the different reports. You also can find more information when you generate a 

report, click Help, and then click Help on This Page.  

 Account Distribution Report  

Use this report to identify patterns in your top revenue-generating accounts. The report displays two 

charts. The earned revenue chart displays a chart of the earned revenue grouped by a market facet, such 

as product, territory, or industry. The accounts count chart, displays the amount of earned revenue using 

the same grouping as the earned revenue chart.  

 Account Overview Report  

Use this report to obtain a one-page overview of everything occurring with an account. The report displays 

a profile of the account, contact information, and summaries of opportunities and case activities.  

 Account Summary Report  

Use this report to determine historically what has occurred with an account. This report also displays what 

is scheduled to occur in the future. The report displays a chronological summary for an account, including 

sales and service activities, notes, and records.  

 Activities Report  

Use this report to identify patterns in activities. Activities can be grouped by owner or activity type, or by 

the record the activity is regarding.  

 Competitor Win Loss Report  

Use this report to compare how your sales team performs against your competitors. The report displays a 

list of competitors, with data on open, closed, won, and lost opportunities for each.  

 Invoices Report  

Use this report to print invoices.  

 Invoice Status Report  

Use this report to view your accounts receivable. The chart displays invoices grouped by status.  

 Lead Source Effectiveness Report  

Use this report to compare how effective your lead sources are at generating quality opportunities. The 

report lists the percentage of qualified leads, and leads that generate revenue for each lead category.  

 Neglected Leads Report  

Use this report to identify any leads that have not been contacted. The report displays a chart of leads that 

have had no associated activities or notes during a specified time period.  

 Orders Report  

Use this report to print orders.  

 Quotes Report  

Use this report to print quotes.  

 Sales Pipeline Report  

Use this report to see anticipated potential sales. The report displays a chart of potential sales grouped by 

user, sales territory, customer territory, date, products, rating, or sales stage.  

 Sales History Report  

Use this report to view a history of sales performance by sales representative. The report displays a chart 

of both lost and earned revenue.  

 Neglected Accounts Report  
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Use this report to identify accounts that have not been contacted recently. The report displays a chart with 

accounts that have had no activities completed in a specified number of days.  

 Products by Account Report  

Use this report to see which products are used by an account. For each account, the report lists the 

associated products.  

 Products by Contact Report  

Use this report to see which products are used by a contact. For each contact, the report lists the 

associated products.  

If the default reports don't provide the information you need, try creating an Advanced Find search, and exporting 
the results to Microsoft Office Excel.  

Note 

This topic documents the list of default reports as they were shipped. If this list differs from the reports that are 

available to you, contact your report administrator or system administrator for information about the customized 

reports.  

Work with Invoices 

When a customer has agreed to the terms of an order for one or more of your products, you can create an invoice to 

record the upcoming sale.  

You can delete an invoice only when it is active. Closed invoices are read-only and cannot be deleted. Open the invoice 

and view the Status field if you are not sure about the status of your selection.  

Create or edit an invoice  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Sales Permissions  

Typically, you convert an order into an invoice. However, in Microsoft Dynamics CRM, an invoice can be created that 
does not originate from an order.  

 

1. In the Navigation Pane, click Sales, and then click Invoices.  

2. On the Actions toolbar, click New, or open the record that you want to edit.  

3. On the General tab, enter information or observe any noted restrictions or requirements as needed:  

 Invoice ID  

This information is automatically created. System administrators can set the auto-numbering 

format for this ID from the Administration page, under Set Auto-Numbering.  

 Name  

You must enter a name with a length of 100 characters or fewer. The information should be 

meaningful and unique. You can use accent marks when you enter data, for example, in a 

customer's name. Your ability to sort and find information is not affected by these accent 

marks. By default, these records are sorted by Name in the records list.  

 Customer  

You must search for and select an account or contact. You can select a record from a filtered 

list in the Form Assistant pane, or you can click the Lookup button  to search for other 

records.  
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 Currency  

Select the currency in which the invoice will be calculated.  

 Price List  

Search for and select the price list that you want. Price lists are created in the product 

catalog. At least one price list must exist in the product catalog before you can select it. You 

can select a record from a filtered list in the Form Assistant pane, or you can click Lookup to 

search for other records.  

In the Totals area, enter all the information you have available. If you are adding a discount, you 

can add a percentage discount, a monetary discount amount, or both.  

 Detail Amount  

This box is read-only and automatically calculates the sum of all existing quote, order, or 

invoice line items, which includes products and write-in products.  

 Invoice Discount (%)  

This number represents a percentage of the total amount (not including freight charges) that 

will be discounted from the total amount. This must be a number between 0.00 and 100.00. 

You can use a decimal point, but you cannot use a percent sign (%).  

 Invoice Discount  

This number represents a whole monetary amount that will be discounted from the total 

amount. This must be a number between 0.00 and 100,000,000,000.00. You can use commas 

and a decimal point, but you cannot use a currency symbol, such as dollar ($), euro (€), or 

yen (¥).  

 Pre-Freight Amount  

This box is read-only and automatically calculates a subtotal based on the detail amount and 

any discounts.  

 Freight Amount  

This must be a number between 0.00 and 100,000,000,000.00. You can use commas and a 

decimal point, but you cannot use a currency symbol, such as dollar ($) or euro (€).  

 Total Tax  

The total tax is calculated when you click Recalculate or when you click Save.  

 Total Amount  

The total amount is calculated when you click Recalculate or when you click Save.  

 Prices Locked  

This check box is read-only. You set Prices Locked by clicking the Actions  menu, and 

then click Lock Pricing. Alternatively, you disable Prices Locked by clicking the Actions 

menu, and then clicking Use Current Pricing.  

More information: Completing Sales Transactions  

4. On the Shipping tab, enter all the information you have available and observe any noted restrictions 

or requirements.  

You must enter the date in the format your organization has set for dates. For example, 01/01/2006 

or 31.12.2005.  

If you omit leading zeros in a date, Microsoft Dynamics CRM will add them automatically. For 

example, when you type 1/1/06, Microsoft Dynamics CRM will display it as 01/01/2006, if that is the 

date format of your organization.  

5. On the Addresses tab, enter all the information that you have available in the following sections:  
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 Bill To Address  

Enter the address where the billing information will be sent.  

 Ship To Address  

Enter the address information to ship the items to the customer. Select Will Call if the 

customer will pick up the items.  

To look up the Bill To Address or Ship To Address information, follow these steps:  

1. On the Form toolbar, click Look Up Address.  

2. In the Look Up Address dialog box, select the Bill To Address check box, the Ship 

To Address check box, or both.  

3. Click Lookup.  

4. In the list of records, select the record you want, and then click OK.  

6. On the Administration tab, enter information or observe any noted restrictions or requirements as 

needed:  

 Owner  

This box is filled automatically with the name of the user who is creating the record. You can 

click the Lookup button  to search for other records.  

 Status Reason  

Select the status of the item.  

 Opportunity  

Select an opportunity if you want to associate this item with an opportunity.  

 Order  

Select an order if you want to associate this invoice with an order.  

7. On the Notes tab, click Click here to enter a new note, and add the information that applies to 

your record.  

8. Click Save or Save and Close.  

 Resolve potential duplicate records.  

1. If the system detects that your record might be a potential duplicate, instead of saving the 

record, you'll see the Duplicates Detected dialog box.  

2. To open a record to make sure it is a potential duplicate, in the Potential duplicate records 

list, double-click the record.  

 If the duplicate-detection rule identified potential duplicate records in other record 

types, review records from each record type listed.  

3. If your new or updated record is not a duplicate, to create the new record, click Save Record.  

– OR –  

If your new or updated record is a duplicate, to cancel your changes, click Cancel.  

Notes  

 If you enter a duplicate record within a few minutes of entering the first record, Microsoft 

Dynamics CRM will not detect the duplicate record. The matchcodes for new and updated 

records are created every five minutes, rather than as a record is created.  

Duplicate detection can take place only if duplicate detection is enabled in Duplicate Detection Settings 
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and if at least one duplicate-detection rule exists for the record type. More information: Avoiding Duplicate 
Records  

Note 

You must manually enter the tax amount when you add a product to a quote, order, or invoice. Microsoft Dynamics 

CRM does not automatically calculate tax for individual products. However, the total tax is calculated automatically 

based on the sum of the tax amounts for all of the individual products in a quote, order, or invoice.  

Tip 

When the Look Up Records dialog box is open, if the record you need doesn't exist, click New, and create the record.  

Add or remove a contact  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Sales Permissions  

 

 

1. In the Navigation Pane, click Sales, and then click Quotes.  

– OR –  

In the Navigation Pane, click Sales, and then click Orders.  

– OR –  

In the Navigation Pane, click Sales, and then click Invoices.  

2. In the list of quotes, orders or invoices, open the record you want to add a contact to.  

3. Under Details, click Other Contacts.  

4. On the Actions toolbar, click Add Existing Contact.  

5. In the Look Up Records dialog box, search for and select the contact records you want to add to the 

quote, order or invoice, and then click OK.  

6. Click Save or Save and Close.  

Tip 

If you cannot locate the contact you want to add, you might need to create it. To do this, in the Look Up Records 

dialog box, click New and then complete the form.  

Note 

To remove a contact from a quote, order, or invoice, follow steps 1, 2, and 3 above to navigate to the appropriate area. 

Select the contact or contacts you want to remove, and then on the Actions toolbar, click More Actions, and then click 

Remove. In the confirmation message, click OK.  
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Lock or unlock the price for an order or invoice  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Sales Permissions  

To determine whether your order or invoice is using Prices Locked, view the Prices Locked check box on the 

General tab of the Invoice or Order form. If the Prices Locked check box is not selected, Use Current Pricing is 

enabled.  

Note that this check box is read-only. You cannot enable or disable Prices Locked by clicking the Prices Locked 

check box on the General tab.  

 

1. In the Navigation Pane, click Sales, and then click Orders or Invoices.  

2. Open the order or invoice that you want.  

3. To enable Prices Locked, on the Actions  menu, click Lock Pricing.  

– OR –  

To enable Use Current Pricing, on the Actions  menu, click Use Current Pricing.  

Close an invoice as paid or canceled  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Sales Permissions  

You close an invoice either by canceling the invoice or setting the invoice status as paid.  

 

1. In the Navigation Pane, click Sales, and then click Invoices.  

2. Open the record that you want.  

3. On the Actions  menu, click Invoice Paid if the invoice is paid, or click Cancel Invoice if the 

invoice is canceled.  

4. In the Paid Invoice or Cancel Invoice dialog box, select the reason in the Status Reason list.  

5. Click OK.  
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Default sales reports 

The following sales reports are available:  

This topic shows you how to use the different reports. You also can find more information when you generate a 

report, click Help, and then click Help on This Page.  

 Account Distribution Report  

Use this report to identify patterns in your top revenue-generating accounts. The report displays two 

charts. The earned revenue chart displays a chart of the earned revenue grouped by a market facet, such 

as product, territory, or industry. The accounts count chart, displays the amount of earned revenue using 

the same grouping as the earned revenue chart.  

 Account Overview Report  

Use this report to obtain a one-page overview of everything occurring with an account. The report displays 

a profile of the account, contact information, and summaries of opportunities and case activities.  

 Account Summary Report  

Use this report to determine historically what has occurred with an account. This report also displays what 

is scheduled to occur in the future. The report displays a chronological summary for an account, including 

sales and service activities, notes, and records.  

 Activities Report  

Use this report to identify patterns in activities. Activities can be grouped by owner or activity type, or by 

the record the activity is regarding.  

 Competitor Win Loss Report  

Use this report to compare how your sales team performs against your competitors. The report displays a 

list of competitors, with data on open, closed, won, and lost opportunities for each.  

 Invoices Report  

Use this report to print invoices.  

 Invoice Status Report  

Use this report to view your accounts receivable. The chart displays invoices grouped by status.  

 Lead Source Effectiveness Report  

Use this report to compare how effective your lead sources are at generating quality opportunities. The 

report lists the percentage of qualified leads, and leads that generate revenue for each lead category.  

 Neglected Leads Report  

Use this report to identify any leads that have not been contacted. The report displays a chart of leads that 

have had no associated activities or notes during a specified time period.  

 Orders Report  

Use this report to print orders.  

 Quotes Report  

Use this report to print quotes.  

 Sales Pipeline Report  

Use this report to see anticipated potential sales. The report displays a chart of potential sales grouped by 

user, sales territory, customer territory, date, products, rating, or sales stage.  

 Sales History Report  

Use this report to view a history of sales performance by sales representative. The report displays a chart 

of both lost and earned revenue.  

 Neglected Accounts Report  
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Use this report to identify accounts that have not been contacted recently. The report displays a chart with 

accounts that have had no activities completed in a specified number of days.  

 Products by Account Report  

Use this report to see which products are used by an account. For each account, the report lists the 

associated products.  

 Products by Contact Report  

Use this report to see which products are used by a contact. For each contact, the report lists the 

associated products.  

If the default reports don't provide the information you need, try creating an Advanced Find search, and exporting 
the results to Microsoft Office Excel.  

Note 

This topic documents the list of default reports as they were shipped. If this list differs from the reports that are 

available to you, contact your report administrator or system administrator for information about the customized 

reports.  
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Chapter 3: Marketing 

 

 

This chapter discusses the marketing module in Microsoft Dynamics CRM. 
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Running Campaigns 

Planning Campaigns 

Campaigns are containers for all of the information, planning tasks, and campaign activities you need to manage for the 

marketing campaigns. You can use campaigns to manage the end-to-end process of a complete marketing campaign. 

Campaigns include extensive tracking features, including detailed financial information, reports, and multiple marketing 

lists. Campaigns can also include multiple planning tasks and campaign activities required to coordinate all the 

resources that are needed for a campaign.  

Creating campaigns 

When you create a new campaign or a campaign template, you can add strategic campaign information, such as:  

 Budgets and expenses  

 Promotion codes  

 Target products 

 Marketing collateral, including sales literature 

 Target marketing lists  

Note 

Campaigns and campaign templates include the same features. You can create a completely new campaign template, 

or you can copy an existing campaign as a template. To use a campaign template as the basis of a new campaign, you 

copy the campaign template.  

Campaigns can include whatever planning tasks you want to perform before you launch the campaign, as well as the 

campaign activities you want to manage as part of the campaign.  

Running campaigns 

Because campaigns are primarily containers for tasks and activities, you do not need to "launch" a campaign from 

within Microsoft Dynamics CRM. Launching a campaign simply occurs when you perform your first campaign activity.  

To have staff in your organization perform the campaign activities you have created, you must distribute the campaign 

activity. Distributing activities from a campaign enables the owners of the records to take action on the related activities 

(such as making a phone call or personalizing a letter before sending it). During the campaign, you can create a 

campaign response whenever a potential customer shows interest as a result of the campaign.  

When your campaign is over, you do not need to close the campaign record the way you would close an individual task 

or activity. In the same way that a campaign begins with the first campaign activity, a campaign ends when the last 

campaign activity has been completed.  

Differences between campaigns and quick campaigns 

In contrast to campaigns, quick campaigns do not include many of the same tracking and reporting features, and 

support only one type of activity for each quick campaign. However, you can use quick campaigns to distribute a single 

activity automatically to an ad-hoc selection of marketing lists, accounts, contacts, or leads.  

Campaigns can represent an organization's marketing efforts over an extended period of time. The effects of a quick 

campaign are immediate.  

Another key difference between campaigns and quick campaigns is in how marketing lists work with quick campaigns. 

Using quick campaigns, you can still select one or more marketing lists and create activities for all of the records in 

those lists. However, Microsoft Dynamics CRM does not associate the marketing list itself with the quick campaign. 
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Instead, activities are created only for the accounts, contacts, or leads that were included in the marketing list or lists 

when you selected them.  

Work with Campaigns and Campaign Templates 

Use this list to work with campaigns and campaign templates.  

 Can I do this task?  

This task requires permissions that are found in all default marketing security roles. More information about 
specific permissions and performing this task while offline: Marketing Permissions  

The only difference between campaigns and campaign templates is in how you save the record. You can add planning 

tasks, campaign activities, marketing lists, sales literature, and products to both campaigns and campaign templates. 

Use a campaign to plan and track each of your marketing campaigns. Use campaign templates to create reusable 

groups of planning tasks and campaign activities for similar or recurring marketing campaigns.  

Because campaigns serve as containers for the various items you can include in them, there is no need to close a 

campaign once all of the planning tasks and campaign activities have been completed.  

Create or edit a campaign  

 Can I do this task?  

This task requires permissions that are found in all default marketing security roles. More information 
about specific permissions and performing this task while offline: Marketing Permissions  

 

 

1. In the Navigation Pane, click Marketing, and then click Campaigns.  

2. On the Actions toolbar, click New.  

3. On the General tab, you must enter information in the following boxes:  

 Name  

 Status Reason  

To save the new campaign, you must select a status reason.  

Enter any other information that you have for this campaign. At a minimum, select a price list, 

which helps you determine the cost of your campaign compared to the revenue generated by the 

campaign.  

Microsoft Dynamics CRM automatically generates a campaign code when you save the new 

campaign. Because this code is automatically generated, it cannot be changed after you save the 

campaign.  

4. On the Financials tab, enter any information that you have available in the following sections:  

 Budget Allocated  

 Estimated Revenue  

 Miscellaneous Costs  

You must enter numbers between 0.00 and 1,000,000,000.00.  

You can use commas and a decimal point, but you cannot use a currency symbol, such as the dollar 

($), euro (€), or yen (¥).  
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The Total Cost of Campaign Activities and Total Cost of Campaign values are automatically 

calculated.  

5. On the Notes tab, click Click here to enter a new note, and add the information that applies to 

your record.  

6. Click Save or Save and Close.  

Note 

All information that is displayed on the Administration tab is automatically generated. The Owner and Modified By 

boxes are populated with the name of the user who creates the account.  

Create or edit a campaign template  

You can create a campaign template by copying an existing campaign or creating a completely new campaign 
template.  

 

1. In the Navigation Pane, click Marketing, and then click Campaigns.  

2. To create a completely new template, on the Actions toolbar, click New Template.  

To copy an existing campaign as a template, open the campaign you want to copy. On the Standard 

toolbar, click Actions , and then click Copy as Template.  

3. Fill out the campaign template form as you would for a campaign, and add items such as planning 

tasks, campaign activities, and marketing lists.  

4. Click Save or Save and Close 

Add a marketing list, sales literature, or product to a campaign  

 Can I do this task?  

This task requires permissions that are found in all default marketing security roles. More information 
about specific permissions and performing this task while offline: Marketing Permissions  

After you create a campaign, add items that are associated with this campaign. You can add a target marketing list, 

products, sales literature, and related campaigns.  

 

1. In the Navigation Pane, click Marketing, and then click Campaigns.  

2. Open the campaign to which you want to add a list, product, or sales literature, and then:  

 If you want to add a marketing list, under Marketing, click Target Marketing Lists, and 

then on the Actions toolbar click Add.  

 If you want to add a product, under Sales, click Target Products, and then on the Actions 

toolbar click Add Existing.  

 If you want to add sales literature, under Sales, click Sales Literature, and then on the 

Actions toolbar click Add Existing.  

 If you want to add a related campaign, under Marketing, click Related Campaigns, and 

then on the Actions toolbar click Add Existing.  

3. In the Look Up Records dialog box, in the Look for list, select the type of record you want to find.  

4. Click Save or Save and Close.  
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Note 

To verify that the item you selected was added to the campaign, reopen the campaign, and then under Marketing, 

click Target Lists, or under Sales click either Target Products or Sales Literature. The information that you added 

appears in the list.  

Add a planning task to a campaign  

 Can I do this task?  

This task requires permissions that are found in all default marketing security roles. More information 
about specific permissions and performing this task while offline: Marketing Permissions  

 

 

1. In the Navigation Pane, click Marketing, and then click Campaigns.  

2. Open the campaign you want to add a task to.  

3. Under Details, click Planning Tasks, and then on the Actions toolbar, click New.  

4. In the Subject box, enter text that describes the task.  

In the box below, you can add specific details about how to complete the task.  

5. If needed, specify a new owner for the record in the Owner box. This box is filled automatically with 

the name of the user who is creating the record. You can click the Lookup button  to search 

for other records.  

6. On the Notes tab, click Click here to enter a new note, and add the information that applies to 

your record.  

7. Click Save or Save and Close.  

Add a campaign activity to a campaign or campaign template  

 Can I do this task?  

This task requires permissions that are found in all default marketing security roles. More information 
about specific permissions and performing this task while offline: Marketing Permissions  

 

 

1. In the Navigation Pane, click Marketing, and then click Campaigns.  

2. Open the campaign or campaign template that you want to add an activity to.  

3. Under Details, click Campaign Activities, and then on the Actions toolbar, click New.  

4. Select the channel for the activity that you are creating.  

5. In the Type box, select the option that describes the activity.  

6. In the Subject box, enter text that describes the activity.  

In the box below, you can add specific details about how to complete the task.  

7. If needed, specify a new owner for the record in the Owner box. Click the Lookup button  to 

search for another owner.  
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8. In the Outsource Vendors box, click the Lookup button  to select a vendor that is involved in 

the activity.  

9. In the Scheduled Start and Scheduled End boxes, select the start and end dates for the activity.  

The end date that you select is displayed in the Due Date column in Activities in the Workplace.  

10. In the Budget Allocated box, enter the amount designated for the campaign activity.  

11. Select the appropriate priority level in the Priority box.  

12. Under the Anti-Spam Setting, select the number of days you want to pass before a marketing list 

member is contacted again.  

13. Click Save or Save and Close.  

Important 

After you create a campaign activity, you must distribute the activity. To distribute your new campaign activity, on the 

Actions toolbar, click Distribute Campaign Activity.  

Notes 

 You can only distribute mail merge campaign activities to marketing lists that all contain the same type 

of record. For example, if one marketing list contains accounts and a second marketing list contains 

leads, the mail merge campaign activity will fail. Create a separate mail merge campaign activity for 

each group of marketing lists with the same record type.  

 Microsoft Dynamics CRM applies a date and time stamp to any accounts, contacts, or leads in a 

marketing list in which you have specified contact restrictions using the Anti-Spam Setting option. 

You will not be able to distribute activities to these accounts, contacts, or leads for the exact 

amount of time you have specified.  

Create or edit a campaign response  

 Can I do this task?  

This task requires permissions that are found in all default marketing security roles. More information 
about specific permissions and performing this task while offline: Marketing Permissions  

There are four ways to create new campaign responses in Microsoft Dynamics CRM. More information: Understanding 

Campaign Responses  

 

1. In the Navigation Pane, click Marketing, and then click Campaigns.  

2. Open the campaign you want to add a campaign response to.  

3. Under Details, click Campaign Responses, and then on the Actions toolbar, click New, or open the 

campaign response that you want to edit.  

4. On the Campaign Response tab, enter information or observe any noted restrictions or 

requirements as needed.  

 Parent Campaign  

This information is automatically entered based on the name of the campaign you selected to 

add this response to.  
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 Response Code  

Select an option from the list that reflects the type of response provided by the customer.  

 Customer  

If an existing customer provided the response, then you can link that customer record to the 

response. To locate and specify a customer, select a record from a filtered list in the Form 

Assistant pane, or click Lookup to search for other records. If the customer record does 

not exist, you can click New to create a new customer record.  

 Outsource Vendor  

You can specify an account or contact as the vendor who provided the response information. 

To locate and specify an outsource vendor, select a record from a filtered list in the Form 

Assistant pane, or click Lookup to search for other records or to add a new record.  

 Originating Activity  

You can link the campaign response to an activity, such as a phone call that you or someone 

else in your organization recorded. To locate and specify an activity, select a record from a 

filtered list in the Form Assistant pane, or click Lookup to search for other records.  

 Subject  

Type in the subject of the campaign response.  

 Owner  

This box is filled automatically with the name of the user who is creating the record. You can 

click the Lookup button  to search for other records.  

5. Click Save or Save and Close.  

Tip 

You can also create a campaign response from the Activities area. To do this, in the Navigation Pane, click Workplace, 

and then under My Work, click Activities. On the Actions toolbar, click New and then in the New Activity dialog 

box, click Campaign Response. If you create a response from this area, you must specify a value for the Parent 

Campaign.  

Default marketing reports 

The following marketing reports are available:  

This topic shows you how to use the different reports. You also can find more information when you generate a report, 

click Help, and then click Help on This Page.  

 Campaign Activity Status Report  

Use this report to track a campaign. The report displays a summary for one campaign, including planned and 

actual time parameters, parent campaign details, and definition status.  

 Campaign Comparison Report  

Use this report to identify your most and least successful campaigns. The report compares two campaigns based 

on parameters such as cost effectiveness and number of responses.  

 Campaign Performance Report  

Use this report to track the progress and status of your campaigns. The report provides a detailed view, including 

all the dates, targets, definitions, responses, and financial returns from each campaign.  

If the default reports don't provide the information you need, try creating an Advanced Find search, and exporting the 
results to Microsoft Office Excel. 
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Understanding Quick Campaigns 

You can use a quick campaign to communicate with an ad-hoc list of customers (accounts, contacts, or leads). More 

information: Work with Quick Campaigns  

Selecting recipients for the quick campaign 

There are three ways you can select the list of recipients for your quick campaign:  

 Select the accounts, contacts, or leads directly.  

 Select one or more marketing lists.  

 Do a search in Advanced Find and create a quick campaign from the resulting list of records.  

Creating the quick campaign 

When you create your new quick campaign, you can choose whether you want to own the activities that you distribute, 

or whether each of the users who own the records in your quick campaign should own the distributed activities. If you 

use the quick campaign to create and distribute e-mail activities, you can also choose whether you want Microsoft 

Dynamics CRM to automatically send the e-mail messages and whether the corresponding e-mail activities should be 

closed.  

After you finish configuring your quick campaign, Microsoft Dynamics CRM immediately creates and distributes the 

activity you specified for all of the customers you selected.  

Working with the completed quick campaign record 

After you have used a quick campaign to quickly distribute activities, you can use the quick campaign record to:  

 Collect, view, and take action on campaign responses.  

 View the activities created from the quick campaign and the current status on those activities.  

 Close one or more open activities created from the quick campaign.  

 View the records for the customers who were contacted.  

 View the records for customers who could not be contacted and an explanation for why these 

customers were not included in the quick campaign.  

Differences between campaigns and quick campaigns 

In contrast to campaigns, quick campaigns do not include many of the same tracking and reporting features, and 

support only one type of activity for each quick campaign. However, you can use quick campaigns to distribute a single 

activity automatically to an ad-hoc selection of marketing lists, accounts, contacts, or leads.  

Campaigns can represent an organization's marketing efforts over an extended period of time. The effects of a quick 

campaign are immediate.  

Another key difference between campaigns and quick campaigns is in how marketing lists work with quick campaigns. 

Using quick campaigns, you can still select one or more marketing lists and create activities for all of the records in 

those lists. However, Microsoft Dynamics CRM does not associate the marketing list itself with the quick campaign. 

Instead, activities are created only for the accounts, contacts, or leads that were included in the marketing list or lists 

when you selected them.  

Additional quick campaign features in Microsoft Dynamics CRM for Outlook  

Some quick campaign features are available only in Microsoft Dynamics CRM for Outlook :  

 Compose personalized e-mail messages using a template.  
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 Send messages in simple HTML or rich text format with the mail merge feature.  

Work with Quick Campaigns 

Although you can print or export the quick campaign list and delete quick campaigns you no longer need, you must 

select records in other lists to create a new quick campaign.  

Caution: Deleting a quick campaign record deletes all of the activities created by the quick campaign, even if those 

activities were not yet complete. 

Create a quick campaign  

 Can I do this task?  

This task requires permissions that are found in all default marketing security roles. More information 
about specific permissions and performing this task while offline: Marketing Permissions  

You can use quick campaigns to create one type of activity for many accounts, contacts, or leads at once.  

 

1. Select the records or list you want to run a quick campaign on, and then start the Create Quick 

Campaign Wizard.  

 From a list of records, including the results of a search You can run a quick campaign from any list of accounts, 

contacts, or leads.  

a. Select the record or records for which you want to create a quick campaign. If you want to include all 

records on the current page or all records on all pages, then skip this step.  

b. On the Actions toolbar, click Create Quick Campaign , and then click one of the following:  

 For Selected Records  

Select this option if you have selected one or more records in the list.  

 For All Records on Current Page  

Select this option to include all records on the page for the quick campaign activity.  

 For All Records on All Pages  

Select this option to include all records on all pages for the quick campaign activity.  

 From the Marketing Lists list You can run a quick campaign on one or more marketing lists in the Marketing 

Lists list.  

a. In the Navigation Pane, click Marketing or Sales, and then click Marketing Lists.  

b. Select the marketing list or marketing lists for which you want to create a quick campaign.  

c. On the Actions toolbar, click Create Quick Campaign, and then click For Selected Records.  

 From a marketing list You can run a quick campaign on the accounts, contacts, or leads in any marketing list.  

a. In the Navigation Pane, click Marketing or Sales, and then click Marketing Lists.  

b. Double-click the marketing list for which you want to create a quick campaign.  

c. On the Actions toolbar, click Create Quick Campaign.  

4. In the Create Quick Campaign Wizard, follow the instructions to create the quick campaign.  
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Notes 

 You cannot add additional records to a quick campaign after you have created it.  

 In the Create Quick Campaign Wizard, you can select who you want Microsoft Dynamics CRM to 

assign the activity to and whether Microsoft Dynamics CRM should perform the activity automatically 

for appropriate activities (such as sending e-mail messages). This choice affects who can see and 

take action on an activity. For example, if you were creating a phone call activity for all of the sales 

representatives, you could select the phone call activity, and then select The owners of the 

records that are included in the quick campaign. Each sales representative could then see the 

activity and take action on it. However, if you were creating a large number of e-mail activities that 

Microsoft Dynamics CRM would perform automatically, you could assign the e-mail activity to 

yourself instead of the record owners.  

 Whether or not some activities are performed automatically depends on an option available to users 

who have the Organization Settings Write privilege. More information: Manage System Settings  

Managing Campaign Activities and Planning Tasks 

 Using Microsoft Dynamics CRM, you can create and track the various planning tasks and campaign 

activities that you have to complete for your marketing campaign to be successful.  

Examples of planning tasks and campaign activities 

 For a new product launch campaign, examples of planning tasks might include "Identify collateral 

pieces to be created" and "Review advertising copy."  

 Campaign activities form the central part of your campaign, and can include a range of Microsoft 

Dynamics CRM activities, such as phone calls, letters via mail merge, or an e-mail blast.  

Including campaign-specific information in campaign activities 

 You can specify the campaign activity's priority and the amount of budget your organization wants to 

allocate to the activity. For example, if you have created a letter activity, the budget might include the 

cost of paper, printing, envelopes, and postage.  

 This information can help you determine the overall value of your campaign. When the activity has 

been completed, you can update the campaign activity record with the actual costs, which can help 

guide you in planning future campaign activities.  

Distributing campaign activities 

 After you have created a campaign activity, you can distribute it if you have a marketing list associated 

with the campaign. Each person in your organization to whom the activity was assigned can then 

complete the activity.  

 For example, if you want your sales staff to personally contact each of their customers on the 

marketing list and invite them to your opening night, you can create a phone call campaign activity and 

distribute it. When you distribute an activity, you can designate who should complete the activity. For e-

mail activities, you can also choose to send the e-mail messages automatically.  

 Note 

 Fax, letter, and e-mail campaign activities that take advantage of the mail merge feature can be 

completed only by using Microsoft Dynamics CRM for Outlook.  
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Understanding Campaign Responses 

In Microsoft Dynamics CRM, campaign responses are records of the communication you receive from potential 

customers in response to a specific marketing campaign. You can record or capture responses to various marketing 

campaign activities to ensure that the right follow-up happens. There are four ways to create campaign responses:  

 Record campaign responses manually.  

 Convert an existing activity to a campaign response.  

 Automatically generate campaign responses.  

 Import responses from a file, such as a Microsoft Office Excel workbook.  

Capturing campaign responses in Microsoft Dynamics CRM helps to make sure that your team is aware that a customer 

has responded. Knowing this enables you to follow up appropriately. By running reports that contain the campaign 

response data that you have captured in Microsoft Dynamics CRM, you can measure the success of specific activities 

based on their response rates.  

Note 

Campaign responses are records of the responses you have received from potential customers, not automated 

responses back to your potential customers. Understanding this difference is especially important when you work with 

automatically generated campaign responses for e-mail activities. In other words, campaign responses for e-mail 

activities are not sent back to the people who responded to your e-mail; instead, the campaign response only tracks 

that the potential customer responded.  

Creating New Campaign Responses 

Sales and Marketing teams can use Microsoft Dynamics CRM to manually record customer responses as campaign 

response records, based on a direct marketing activity. You can create responses manually by first creating an activity 

and then converting it, or by creating a new campaign response within a campaign record. More information: Work with 

Campaigns and Campaign Templates  

Converting Activities to Campaign Responses 

When a potential customer responds to an activity created for them as part of a marketing campaign, you can convert 

the corresponding activity, such as a phone call, e-mail, or appointment, to a campaign response. To convert an 

activity, it must have been saved and have had no modifications since it was last saved. More information: Campaign 

Activity Form  

Note 

You create campaign responses from activities at the same time that you convert an individual activity to an 

opportunity.  

Automatically Creating Campaign Responses 

For e-mail activities you have included in your campaign, you can also use Microsoft Dynamics CRM to generate the 

campaign responses automatically. When customers respond to e-mail activities, you can choose to have Microsoft 

Dynamics CRM create the corresponding campaign response records automatically.  

Important 

This option is available only if e-mail tracking is enabled. This is a setting your administrator can set. More information: 

Manage System Settings  
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Importing Campaign Responses 

In addition to creating campaign responses within Microsoft Dynamics CRM, you can also create them outside the 

system and then import them. By importing campaign responses, you can capture a record of the responses received as 

part of campaign efforts performed outside Microsoft Dynamics CRM. For example, instead of hiring additional telesales 

representatives to handle the temporary increase in call volume during the product launch, you may outsource some of 

this work to a vendor. When you import the file, you can specify that it contains campaign responses. Each item in the 

file then becomes a campaign response in Microsoft Dynamics CRM.  

Note 

The minimum data that you must have to import a campaign response is the name of the parent campaign in Microsoft 

Dynamics CRM and a subject, such as "E-mail campaign result" or "Ayla Kol wants to place a bulk order".  

Work with Campaign Responses 

A campaign response is a record of the communication you receive from a potential customer in response to a specific 

campaign.  

Create or edit a campaign response  

 Can I do this task?  

This task requires permissions that are found in all default marketing security roles. More information 
about specific permissions and performing this task while offline: Marketing Permissions  

There are four ways to create new campaign responses in Microsoft Dynamics CRM. More information: Understanding 

Campaign Responses  

 

1. In the Navigation Pane, click Marketing, and then click Campaigns.  

2. Open the campaign you want to add a campaign response to.  

3. Under Details, click Campaign Responses, and then on the Actions toolbar, click New, or open the 

campaign response that you want to edit.  

4. On the Campaign Response tab, enter information or observe any noted restrictions or 

requirements as needed.  

 Parent Campaign  

This information is automatically entered based on the name of the campaign you selected to 

add this response to.  

 Response Code  

Select an option from the list that reflects the type of response provided by the customer.  

 Customer  

If an existing customer provided the response, then you can link that customer record to the 

response. To locate and specify a customer, select a record from a filtered list in the Form 

Assistant pane, or click Lookup to search for other records. If the customer record does 

not exist, you can click New to create a new customer record.  

 Outsource Vendor  

You can specify an account or contact as the vendor who provided the response information. 

To locate and specify an outsource vendor, select a record from a filtered list in the Form 

Assistant pane, or click Lookup to search for other records or to add a new record.  
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 Originating Activity  

You can link the campaign response to an activity, such as a phone call that you or someone 

else in your organization recorded. To locate and specify an activity, select a record from a 

filtered list in the Form Assistant pane, or click Lookup to search for other records.  

 Subject  

Type in the subject of the campaign response.  

 Owner  

This box is filled automatically with the name of the user who is creating the record. You can 

click the Lookup button  to search for other records.  

5. Click Save or Save and Close.  

Tip 

You can also create a campaign response from the Activities area. To do this, in the Navigation Pane, click Workplace, 

and then under My Work, click Activities. On the Actions toolbar, click New and then in the New Activity dialog 

box, click Campaign Response. If you create a response from this area, you must specify a value for the Parent 

Campaign.  

Copy a campaign response  

 Can I do this task?  

This task requires permissions that are found in all default marketing security roles. More information 
about specific permissions and performing this task while offline: Marketing Permissions  

 

 

1. In the Navigation Pane, click Marketing, and then click Campaigns.  

2. Open the campaign that contains the campaign response that you want to copy.  

3. Under Details, click Campaign Responses.  

4. Open the campaign response that you want to copy.  

5. On the Actions  menu, click Copy Campaign Response.  

6. A new campaign response form will open with the same information as the original campaign 

response. Make any changes as needed, such as changing the subject.  

7. Click Save or Save and Close.  

Convert campaign responses to leads or opportunities  

You qualify a campaign response by converting it to another record, such as a lead, quote, order, or opportunity. You 

can also use the campaign response to convert an existing lead to an account. Converting a campaign response 

automatically closes it.  

 Can I do this task?  

This task requires permissions that are found in all default marketing security roles. More information 
about specific permissions and performing this task while offline: Marketing Permissions  

 

 

1. In the Navigation Pane, click Marketing, and then click Campaigns.  
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2. Open the campaign that contains responses you want to qualify.  

3. Under Details, click Campaign Responses.  

4. Open the individual campaign response that you want to qualify.  

5. On the Form toolbar, click Convert Campaign Response.  

6. In the Close and Convert the Response dialog box, under Close response and convert into a 

record, select from the following options:  

 If you want to create a new lead record, click Create New Lead.  

 If you want to use the campaign response to convert an existing lead to an account or 

contact record, click Convert an existing lead. You can click the Lookup button  to 

search for the existing lead.  

 If you want to create an opportunity, quote, or order for an existing customer, click Create 

new record for a customer, click the button for the new record you want to create, and 

then click the Lookup button  to search for and select an existing account or contact 

record.  

If you do not have a record for the existing customer, you can click New in the Look Up 

Records dialog box to create the record now.  

7. Click OK.  

Tips 

 If you want to view the new records you have created, select the Open newly created records 

check box. After you click OK, forms for any new leads, quotes, orders, or opportunities open, and 

you can fill out additional information about each new record.  

 If you want to disqualify the campaign response, you can close it without converting it to another 

record.  

Close a campaign response  

You disqualify a campaign response by closing it without converting it to another record.  

 Can I do this task?  

This task requires permissions that are found in all default marketing security roles. More information 
about specific permissions and performing this task while offline: Marketing Permissions  

 

 

1. In the Navigation Pane, click Marketing, and then click Campaigns.  

2. Open the campaign that contains responses you want to disqualify.  

3. Under Details, click Campaign Responses.  

4. Select the campaign responses that you want to disqualify.  

5. On the Actions toolbar, click More Actions, and then click Close Campaign Response.  

6. Select an appropriate status for the disqualified campaign response, and then click OK.  

Haghighat Sabet
Highlight

Haghighat Sabet
Highlight

Haghighat Sabet
Highlight

Haghighat Sabet
Highlight

Haghighat Sabet
Highlight

Haghighat Sabet
Highlight



 

 

 Microsoft Dynamics CRM 4.0 User’s Guide 333 

 

Reactivate a campaign response  

 Can I do this task?  

This task requires permissions that are found in all default marketing security roles. More information 
about specific permissions and performing this task while offline: Marketing Permissions  

 

 

1. In the Navigation Pane, click Marketing, and then click Campaigns.  

2. Open the campaign that contains the campaign response that you want to reactivate.  

3. Open the closed campaign response that you want to reactivate.  

4. On the Actions  menu, click Reactivate Campaign Response.  

5. In the confirmation message, click OK.  

6. Click Save or Save and Close.  

Default marketing reports 

 

The following marketing reports are available:  

This topic shows you how to use the different reports. You also can find more information when you generate a report, 

click Help, and then click Help on This Page.  

 Campaign Activity Status Report  

Use this report to track a campaign. The report displays a summary for one campaign, including planned and 

actual time parameters, parent campaign details, and definition status.  

 Campaign Comparison Report  

Use this report to identify your most and least successful campaigns. The report compares two campaigns based 

on parameters such as cost effectiveness and number of responses.  

 Campaign Performance Report  

Use this report to track the progress and status of your campaigns. The report provides a detailed view, including 

all the dates, targets, definitions, responses, and financial returns from each campaign.  

If the default reports don't provide the information you need, try creating an Advanced Find search, and exporting the 
results to Microsoft Office Excel. 
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Using Marketing Lists 

Creating and Managing Marketing Lists 

In Microsoft Dynamics CRM, marketing lists are groups of accounts, contacts, or leads filtered by criteria that you 

specify. You can associate marketing lists with campaigns, create quick campaigns for the records in one or more 

marketing lists, and export marketing lists to Microsoft Office Excel.  

Note 

Marketing lists can contain only one type of record, such as accounts, contacts, or leads.  

Adding members to marketing lists 

There are several ways you can add members to a marketing list:  

 Look up. Add members individually or as a group using the Lookup feature. For example, find and 

add a specific contact, or add all contacts.  

 Advanced Find. Add members that match an Advanced Find query. For example, find and add only 

contacts with addresses in California, Oregon, and Washington.  

 Import. Add members when you import accounts, contacts, or leads from an external file. For 

example, a list of leads from a telesales vendor saved in a Microsoft Office Excel workbook.  

Qualifying marketing list members 

After you create a marketing list and add members to it, you can further qualify list members and remove members 

that do not match specific criteria:  

 Remove members that match an Advanced Find query. For example, find and remove all leads older 

than two years.  

 Remove members that do not match an Advanced Find query. For example, keep only the accounts 

with no activity in the last six months and remove all others.  

Managing marketing lists 

In addition to adding marketing lists to campaigns and managing the members of a marketing list, you can also 

manage the lists themselves:  

 Delete marketing lists you no longer need. Deleting a marketing list does not remove the 

accounts, contacts, or leads that were in that list.  

 Merge marketing lists. By copying members of one marketing list to another list, you can merge 

the two lists.  

 Activate or deactivate a marketing list. Inactive marketing lists do not appear in the default view 

for marketing lists. After you have deactivated a marketing list, you can activate it again if you need 

to. 

Work with Marketing Lists 

Marketing lists are lists of accounts, contacts, or leads that match a specific set of criteria.  
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Create or edit a marketing list  

 Can I do this task?  

This task requires permissions that are found in all default marketing security roles. More information 
about specific permissions and performing this task while offline: Marketing Permissions  

 

 

1. In the Navigation Pane, click Marketing or Sales, and then click Marketing Lists.  

2. On the Actions toolbar, click New, or open the marketing list that you want to edit.  

3. On the General tab, you must enter information in the following boxes:  

 Name  

 Member type  

Enter any other information that you have for the list. If you want to prevent members from being 

added or removed from the list, set Locked to Yes.  

4. On the Notes tab, click Click here to enter a new note and add any other information that applies 

to your marketing list.  

5. Click Save or Save and Close.  

Notes 

 After you create a marketing list, you cannot change the member type.  

 After you create an empty marketing list, you must add marketing list members before you can use 

the list.  

 In Cost, you must enter a value with commas and decimal points only. Do not enter a currency 

symbol.  

Activate a marketing list  

 Can I do this task?  

This task requires permissions that are found in all default marketing security roles. More information 
about specific permissions and performing this task while offline: Marketing Permissions  

Before you can use a marketing list, you must activate it. After the list is activated, you can add or remove members, 
attach a file, create a follow up activity, use the list in a quick campaign, and add the list to a campaign.  

 

1. In the Navigation Pane, click Marketing or Sales, and then click Marketing Lists.  

2. Select the list you want to activate.  

3. On the Actions toolbar, click More Actions, click Activate, and then click OK.  
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Add members to a marketing list  

 Can I do this task?  

This task requires permissions that are found in all default marketing security roles. More information 
about specific permissions and performing this task while offline: Marketing Permissions  

 

 

1. In the Navigation Pane, click Marketing or Sales, and then click Marketing Lists.  

2. Open the marketing list to which you want to add members.  

3. Under Details, click Marketing List Members.  

4. On the Actions toolbar, click Manage Members.  

5. In the Manage Members dialog box, click one of the following options, and then click OK:  

 Use Lookup to add members  

a. In the Search for records box, type the first few letters of the name of the record to narrow 

your search, and then click the Find button .  

b. In the list of records, click a record to select it, click the Add Selected Records button  to 

add the record to the Selected records list, and then click OK.  

 Use Advanced Find to add members  

a. Select options to search for list members, and then click Find. More information: Find Things  

b. To add all the records to the marketing list, click Add all the members returned by the 

search to the marketing list, and then click Add to Marketing List.  

c. To add only some records to the list, select the records that you want, click Add only the 

selected members to the marketing list, and then click Add to Marketing List.  

7. Click Save or Save and Close.  

Tip 

You can also add members to a marketing list from the Sales area. To do this, in the Navigation Pane, click Sales, and 

then click Accounts, Contacts, or Leads. Next, select the records you want to add to a marketing list, and on the 

Actions toolbar, click More Actions, and then click Add to Marketing List. Locate and select the marketing list you 

want to add the records to and then click OK. If necessary, you can create a new marketing list from the Look Up 

Records dialog box.  

Note 

Based on the type of list to which you are adding records, a member can be an account, contact, or lead. For example, 

if you open a leads list, you can add new leads to the member list, but you cannot add accounts or contacts.  
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Add members from one marketing list to another marketing list  

 Can I do this task?  

This task requires permissions that are found in all default marketing security roles. More information 
about specific permissions and performing this task while offline: Marketing Permissions  

 

 

1. In the Navigation Pane, click Marketing or Sales, and then click Marketing Lists.  

2. Open the marketing list from which you want to add members to another list.  

3. Under Details, click Marketing List Members.  

4. In the list of members, select the member you want to add to another list.  

5. On the Actions toolbar, click More Actions, and then click Add to Another Marketing List.  

6. In the Look Up Records dialog box, in the Look for box, type the information you are looking for, 

and then click the Find button .  

7. Select the list you want to add the member to and click OK.  

8. When the confirmation message appears, click OK.  

9. Click Save or Save and Close.  

Merge marketing lists  

 Can I do this task?  

This task requires permissions that are found in all default marketing security roles. More information 
about specific permissions and performing this task while offline: Marketing Permissions  

 

 

1. In the Navigation Pane, click Marketing or Sales, and then click Marketing Lists.  

2. From the list, select the marketing list that contains the accounts, contacts, or leads that you want to 

merge into another marketing list.  

3. On the Actions toolbar, on the More Actions menu, click Copy to.  

4. In the Look Up Records dialog box, select the marketing list you want to merge members into, and 

then click OK.  

 Important 

When you copy marketing list members, the marketing lists must both contain the same record type, such 

as all accounts or all contacts.  

5. When the confirmation message appears, click OK.  

6. Click Save or Save and Close.  

Important 

When you copy marketing list members, the marketing lists must both contain the same record type, such as all 
accounts or all contacts.  
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Remove members from a marketing list  

 Can I do this task?  

This task requires permissions that are found in all default marketing security roles. More information 
about specific permissions and performing this task while offline: Marketing Permissions  

 

 

1. In the Navigation Pane, click Marketing or Sales, and then click Marketing Lists.  

2. Open the marketing list from which you want to remove members.  

3. Under Details, click Marketing List Members.  

4. In the marketing list, select the records you want to remove:  

 Select several records by pressing the CTRL key while you click each record.  

 Select a sequence of records by clicking the first record that you want, and then press the 

SHIFT key while you select the last record that you want.  

 Select all records on the page by selecting the Select/clear all records on this page check 

box at the top of the list.  

 Tip 

By default, the Microsoft Dynamics CRM Web application displays 50 records per page. You can increase 

the number of records displayed and thereby increase the number of records you can select at one time. To 

display up to a maximum of 250 records per page:  

4. On the Tools menu, click Options.  

5. On the General tab, in the Records Per Page list, select the number of records to display 

per page.  

6. Click OK.  

This changes the number of items that is displayed for all lists, which may slow response time when you 

switch record types. Therefore, you might want to set it back to a smaller number when you are done with 

this bulk action.  

 On the Actions toolbar, click More Actions, and then click Remove from Marketing List.  

 When the confirmation message appears, click OK.  

 Click Save or Save and Close.  

Evaluate and remove members in a marketing list  

 Can I do this task?  

This task requires permissions that are found in all default marketing security roles. More information 
about specific permissions and performing this task while offline: Marketing Permissions  

 

 

1. In the Navigation Pane, click Marketing or Sales, and then click Marketing Lists.  



 

 

 Microsoft Dynamics CRM 4.0 User’s Guide 339 

 

2. Open the marketing list to which you want to remove members.  

3. Under Details, click Marketing List Members.  

4. On the Actions toolbar, click Manage Members.  

5. In the Manage Members dialog box, click one of the following options, and then click OK:  

 Use Advanced Find to remove members  

a. Select options to search for list members that you want to remove from your list, and then click 

Find. More information: Find Things  

b. To remove all the records returned to the list, click Remove all the members returned by the 

search from the marketing list, and then click Remove from Marketing List.  

c. To remove just the selected records from the list, select the records you want to remove, click 

Remove only the selected members from the marketing list, and then click Remove from 

Marketing List.  

 Use Advanced Find to evaluate members  

a. Select options to search for and locate list members that you want to keep on your list, and then 

click Find. More information: Find Things  

b. To keep all the records returned to the list, click Keep all the members returned by search in 

the marketing list, and then click Update Marketing List.  

c. To keep just the selected records from the list, select the records you want to keep, click Keep 

only the selected members in the marketing list, and then click Update Marketing List.  

7. Click Save or Save and Close.  

Qualify or convert multiple records at once  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Sales Permissions  

If you need to disqualify a group of leads or if you decide a group of leads are all good, you do not have to process 
them one by one. Instead, put the leads into a marketing list, and then disqualify the whole group or qualify them by 
converting the whole group into accounts, contacts, or opportunities all in one step.  

 

1. Create a new marketing list.  

a. In the Navigation Pane, click Marketing or Sales, and then click Marketing Lists.  

b. On the Actions toolbar, click New.  

c. In the Name box, type a name for the list, and in the Member type box, select Lead.  

d. Click Save.  

2. Under Details, click Marketing List Members.  

3. On the Actions toolbar, click Manage Members.  

4. In the Manage Members dialog box, click Use Advanced Find to add members, and then click 

OK.  
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5. Create a query to find the list of leads to disqualify or convert.  

a. From the Use Saved View list, select My Open Leads.  

b. Add any additional criteria you need to the query.  

 Tip 

If this query is one that you will use again, click Save As, and specify a name for the query.  

6. To see the records, click Find.  

7. Select one of the option buttons at the bottom of the window either to add all the leads returned by 

the search to the list or to add only selected leads to the list, and then click Add to Marketing 

List.  

8. In the marketing list, select multiple lead records:  

 Select several records by pressing the CTRL key while you click each record.  

 Select a sequence of records by clicking the first record that you want, and then press the 

SHIFT key while you select the last record that you want.  

 Select all records on the page by selecting the Select/clear all records on this page check 

box at the top of the list.  

 Tip 

By default, the Microsoft Dynamics CRM Web application displays 50 records per page. You can increase 

the number of records displayed and thereby increase the number of records you can select at one time. To 

display up to a maximum of 250 records per page:  

4. On the Tools menu, click Options.  

5. On the General tab, in the Records Per Page list, select the number of records to display 

per page.  

6. Click OK.  

This changes the number of items that is displayed for all lists, which may slow response time when you 

switch record types. Therefore, you might want to set it back to a smaller number when you are done with 

this bulk action.  

 After you select the leads you want to convert, on the More Actions menu, click Convert 

Lead.  

 In the Convert Lead dialog box, disqualify the leads, or select the record types to convert 

the leads to, and then click OK. The leads will still appear on your marketing list, but will no longer 

appear in your My Open Leads view. 
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Change the columns displayed for marketing list members  

 Can I do this task?  

This task requires permissions that are found in all default marketing security roles. More information 
about specific permissions and performing this task while offline: Marketing Permissions  

Although you cannot change the default view for marketing list members, you can create your own views with the 
columns you need, and export these views to Microsoft Office Excel if you need them for printing mailing labels or 
creating call lists.  

 

1. In the Navigation Pane, click Marketing or Sales, and then click Marketing Lists.  

2. Open a marketing list.  

3. Under Details, click Marketing List Members.  

4. On the Actions toolbar, click Manage Members.  

5. In the Manage Members dialog box, click Use Advanced Find to evaluate members.  

6. On the Standard toolbar, click Edit Columns, and then in the Common Tasks area, click Add 

Columns.  

7. Select the columns to add, and then click OK twice.  

8. In the lower right corner of the window, click Find.  

Tip 

If you save the Advanced Find view to use later, to return to it from any marketing list, click Manage Members. When 

you select to add, remove, or evaluate members, you can select the saved view from the View list.  

Create a quick campaign  

 Can I do this task?  

This task requires permissions that are found in all default marketing security roles. More information 
about specific permissions and performing this task while offline: Marketing Permissions  

You can use quick campaigns to create one type of activity for many accounts, contacts, or leads at once.  

 

1. Select the records or list you want to run a quick campaign on, and then start the Create Quick 

Campaign Wizard.  

 From a list of records, including the results of a search You can run a quick campaign from any list of accounts, 

contacts, or leads.  

a. Select the record or records for which you want to create a quick campaign. If you want to include all 

records on the current page or all records on all pages, then skip this step.  

b. On the Actions toolbar, click Create Quick Campaign , and then click one of the following:  

 For Selected Records  

Select this option if you have selected one or more records in the list.  

 For All Records on Current Page  



 

342 Microsoft Dynamics CRM 4.0 User’s Guide 
 

Select this option to include all records on the page for the quick campaign activity.  

 For All Records on All Pages  

Select this option to include all records on all pages for the quick campaign activity.  

 From the Marketing Lists list You can run a quick campaign on one or more marketing lists in the Marketing 

Lists list.  

a. In the Navigation Pane, click Marketing or Sales, and then click Marketing Lists.  

b. Select the marketing list or marketing lists for which you want to create a quick campaign.  

c. On the Actions toolbar, click Create Quick Campaign, and then click For Selected Records.  

 From a marketing list You can run a quick campaign on the accounts, contacts, or leads in any marketing list.  

a. In the Navigation Pane, click Marketing or Sales, and then click Marketing Lists.  

b. Double-click the marketing list for which you want to create a quick campaign.  

c. On the Actions toolbar, click Create Quick Campaign.  

4. In the Create Quick Campaign Wizard, follow the instructions to create the quick campaign.  

Notes 

 You cannot add additional records to a quick campaign after you have created it.  

 In the Create Quick Campaign Wizard, you can select who you want Microsoft Dynamics CRM to 

assign the activity to and whether Microsoft Dynamics CRM should perform the activity automatically 

for appropriate activities (such as sending e-mail messages). This choice affects who can see and 

take action on an activity. For example, if you were creating a phone call activity for all of the sales 

representatives, you could select the phone call activity, and then select The owners of the 

records that are included in the quick campaign. Each sales representative could then see the 

activity and take action on it. However, if you were creating a large number of e-mail activities that 

Microsoft Dynamics CRM would perform automatically, you could assign the e-mail activity to 

yourself instead of the record owners.  

 Whether or not some activities are performed automatically depends on an option available to users 

who have the Organization Settings Write privilege. More information: Manage System Settings  
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Managing Customer Records 

For information on managing leads, working with leads, managing accounts and 

contacts, and working with accounts and contacts, see the following references: 

 Managing Leads 
 Work with Leads 
 Managing Accounts and Contacts 
 Work with Accounts 
 Work with Contacts 
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Chapter 4: Service 

 

This chapter explains the service module in Microsoft Dynamics CRM. 
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Scheduling Services for Your Customers 

Navigating the Service Calendar 

You can use the Service calendar that is available in the Service area to schedule service activities and appointments for 

your organization. In the Service calendar, you can do all of the following tasks and activities:  

 View your organization's daily, weekly, and monthly schedule of appointments and service activities.  

 View work schedules and service activity schedules for a variety of resources.  

 Create new appointments and schedule service activities.  

 Change the status of an existing service activity.  

 Search for conflicts in the schedule. 

You cannot customize the Service calendar or change the default view with the application. However, you can use 

ISV.Config to change the colors of the time blocks. 

Viewing Appointments and Service Activities 

When you open the Service calendar, a list of resources is displayed on the left side of the calendar in alphabetical 

order. If there are more than 50 resources, click the arrows to view the next page of resources. You can also use the 

clickable Index at the bottom of the list to jump to a specific letter in the alphabet. 

In the center of the page, a linear calendar displays the schedule for each resource. This display is divided into days 

and hours. Appointments and service activities appear in the linear calendar as labeled color blocks. Each color 

represents whether the time is for an appointment or a service activity, and also indicates the current status of the 

appointment or service activity. 

Back to the top 

 Legend of Colors and Statuses 

Color Status 

Service Activity Statuses  

 

Requested 

 

Tentative 

 

Pending 

 

Reserved 

http://crmuxtestcrm/help/1033/OP/content/ug_ss_navigating_Service_Calendar.htm#top
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Arrived 

 

Canceled 

 

Completed 

 

No Show 

 

Busy 

 

Out of Office 

 

Not Working or Business Closure  

Appointment Statuses  

 

Canceled 

 

Completed 

 

Viewing Details for Resources, Appointments, and Service Activities 

You can view the resources, appointments, and service activities for anyone in your organization. In the Type list, 

select Resources, and then in the View list select the resource view. To find a specific resource, in the Search for 

records box, enter the first few letters of a name to search for a particular resource. To search for another record, 

clear the search criteria. 

The linear calendar displays the resource's schedule. To view the details of any resource, appointment, or service 

activity, select the record in the list to the left of the calendar, and then at the very bottom of the calendar, under the 

Zoom scale, click the Expand button  to expand the preview pane. You can also double-click a record to open it. 

Note: The calendars in the Workplace area and in the Service area are not customizable.  

Using the Calendar Pane to Change the Date Display 

The Calendar Pane appears on the right side of the calendar. It can be collapsed or expanded.  

 To collapse the Calendar Pane, click the Collapse Calendar button .  

 To expand the Calendar Pane, click the Expand Calendar button .  

 To change the date, click a date in the Calendar control. Use the arrows on either side of the month to 

change the month displayed.  
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 To change the range of dates, click a date on the Calendar control and then drag to the end date.  

In the Calendar Pane, you can change the number of days that are displayed in the linear calendar by clicking any of 

the calendar options.  

You can use the Zoom scale to change how much of the calendar is available to view. For example, you can set the 

calendar to display a whole week, or just a few hours. To view more of the calendar, click closer to the plus end of the 

scale. To view less of the schedule, click closer to the minus end of the scale. You can select specific date ranges to 

view in the From and To lists.  

Service Calendar 

Use the calendar to create, view, and edit service activities and appointments.  

More information: Navigating the Service Calendar 

Find the next available time  

 Can I do this task?  

This task requires permissions that are found in all default service scheduling security roles. More 
information about specific permissions and performing this task while offline: Service Scheduling 
Permissions  

Use this procedure to find the next available times for a service. This is the fastest way to schedule a service activity.  

 

1. In the Navigation Pane, click Service, and then click Service Calendar.  

2. On the Actions toolbar, click Schedule.  

Note: If you click New, and then Service Activity, you will create a service activity without 

checking for available times.  

3. On the Schedule Service Activity form, you must enter the following information:  

 Service  

Locate and select the service you want to schedule. You can select a record from a filtered list 

in the Form Assistant pane, or you can click the Lookup button  to search for other 

records.  

 Duration  

Do not clear the Use Default Duration check box and change the duration unless you want 

to schedule more time than the default duration of the service. The maximum duration of a 

service activity is 10 days.  

4. Click Find Available Times. The next available times are displayed. If there is more than one page 

of records available to view in the list of records, use the Page arrows at the bottom of the list to 

view the additional pages.  

5. Under Available Times click on the start or end time of the time you want to schedule, and then 

click Schedule. If you click the service or resource links, the related form opens.  

The Schedule Service Activity form closes and Microsoft Dynamics CRM fills in the information 

from the selected time into the Service Activity form.  

6. On the Service Activity form, enter any additional information about the service activity.  

 Subject  

You must enter a subject. The first 12 characters appear on the Service calendar and the 
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calendar in your Workplace.  

You can save the service activity now, or continue to add information.  

 Customers  

If this service activity is for a customer, you can locate and select the account or contact. You 

can select a record from a filtered list in the Form Assistant pane, or you can click Lookup to 

search for other records.  

 Resources  

Locate and select the user, or facility and equipment that you want to schedule. You can 

select a record from a filtered list in the Form Assistant pane, or you can click Lookup to 

search for other records.  

 Location  

You can enter an address or room number where the service activity will occur.  

 Show Time As  

If you want to change the initial status of the service activity, select a status from the list. If 

you select any of the statuses under Scheduled, that block of time on the schedule is set so 

that another service activity or appointment cannot conflict with it during automatic 

scheduling. Forced service activities and appointments might conflict.  

 Site  

Changing the Site after you have selected a time for the service activity is not recommended. 

Resources are assigned to sites. If the selected resources are not available at the selected 

site, there might be conflicts. To record the specific room or address of the service activity, 

enter that information in the Location box on the Service Activity form.  

 Notes  

You can add additional information about the customer and service activity in this area. For 

example, you could enter the symptoms of a problem, special requests by the customer, or 

any messages to pass on to the resources providing the service.  

7. On the Details tab, you can select and locate a record in the Regarding box to link to this service 

activity. You can also set a Priority for the service activity, and record a Category and Sub-

Category.  

8. Click Save or Save and Close.  

The service activity appears as a color block on the Service calendar, as well as on the calendar in 

the Workplace and Activities areas.  

Tip 

You can record a customer's preferences for a specific time, day, service, facility, equipment, and customer service 

representative in the customer record on the Administration tab. As you are scheduling a service activity, the 

customer's preference is displayed in the Form Assistant pane.  

Notes 

 Changing any information in the Scheduling Information area after you have selected a time for the 

service activity is not recommended. Doing so might cause conflicts in the schedule.  

 In the list of possible service activity search results, you can click the Page Back arrow to initiate a 

new search. Paging back does not display the previous page.  
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Find the next available time within a specific time period  

 Can I do this task?  

This task requires permissions that are found in all default service scheduling security roles. More 
information about specific permissions and performing this task while offline: Service Scheduling 
Permissions  

Use this procedure to find the next available time based on a specific date, or range of dates, within the next day, 

week, or month.  

 

1. In the Navigation Pane, click Service, and then click Service Calendar.  

2. On the Actions toolbar, click Schedule.  

Note: If you click New, and then Service Activity, you will create a service activity without 

checking for available times.  

3. On the Schedule Service Activity form, you must enter the following information:  

 Service  

Locate and select the service you want to schedule. You can select a record from a filtered list 

in the Form Assistant pane, or you can click the Lookup button  to search for other 

records.  

4. Under Requested Time, select criteria for the times you want.  

 Start Date  

 To search for a time on a specific date, select Specific Date, and then enter the date 

you want.  

 To search within a range of dates, select Range of Dates, and then enter the On or 

After and On or Before dates. You can also select specific days of the week.  

 To search for times today, select Today.  

 You can also search for times based on dates relative to today, such as Tomorrow, 

This Week, or Next Week.  

 Start Time  

 To search for a specific time, select Specific Time, and then enter the specific time.  

 To search within a specific range of time, select Range of Times, and then enter the 

earliest and latest times you want the service activity to start.  

 You can also search for times based on the time of day, such as Morning or 

Evening.  

 Duration  

Do not clear the Use Default Duration check box and change the duration unless you want 

to schedule more time than the default duration of the service. The maximum duration of a 

service activity is 10 days.  

5. Click Find Available Times. The next available times are displayed.  

6. Under Available Times click on the start or end time of the time you want to schedule, and then 

click Schedule. If you click the service or resource links, the related form opens.  
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The Schedule Service Activity form closes and Microsoft Dynamics CRM fills in the information 

from the selected time into the Service Activity form.  

7. On the Service Activity form, enter any additional information about the service activity.  

 Subject  

You must enter a subject. The first 12 characters appear on the Service calendar and the 

calendar in your Workplace.  

You can save the service activity now, or continue to add information.  

 Customers  

If this service activity is for a customer, you can locate and select the account or contact. 

You can select a record from a filtered list in the Form Assistant pane, or you can click 

Lookup to search for other records.  

 Resources  

Locate and select the user, or facility and equipment that you want to schedule. You can 

select a record from a filtered list in the Form Assistant pane, or you can click Lookup to 

search for other records.  

 Location  

You can enter an address or room number where the service activity will occur.  

 Show Time As  

If you want to change the initial status of the service activity, select a status from the list. If 

you select any of the statuses under Scheduled, that block of time on the schedule is set so 

that another service activity or appointment cannot conflict with it during automatic 

scheduling. Forced service activities and appointments might conflict.  

 Site  

Changing the Site after you have selected a time for the service activity is not 

recommended. Resources are assigned to sites. If the selected resources are not available at 

the selected site, there might be conflicts. To record the specific room or address of the 

service activity, enter that information in the Location box on the Service Activity form.  

 Notes  

You can add additional information about the customer and service activity in this area. For 

example, you could enter the symptoms of a problem, special requests by the customer, or 

any messages to pass on to the resources providing the service.  

8. On the Details tab, you can select and locate a record in the Regarding box to link to this service 

activity. You can also set a Priority for the service activity, and record a Category and Sub-

Category.  

9. Click Save or Save and Close.  

The service activity appears as a color block on the Service calendar, as well as on the calendar in 

the Workplace and Activities areas.  

Tip 

You can record a customer's preferences for a specific time, day, service, facility, equipment, and customer service 

representative in the customer record on the Administration tab. As you are scheduling a service activity, the 

customer's preference is displayed in the Form Assistant pane.  

Important 

 Changing any information in the Scheduling Information area after you have selected a time for the 

service activity is not recommended. Doing so might cause conflicts in the schedule.  
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 In the list of possible service activity search results, you can click the Page Back arrow to initiate a 

new search. Paging back does not display the previous page.  

Find an available time with specific criteria  

 Can I do this task?  

This task requires permissions that are found in all default service scheduling security roles. More 
information about specific permissions and performing this task while offline: Service Scheduling 
Permissions  

Use this procedure to find the next available time based on a set of specific criteria. For example, if the customer 

wants your head mechanic to work on his bicycle, you can search the head mechanic's schedule for the next available 

time. 

 

1. In the Navigation Pane, click Service, and then click Service Calendar.  

2. On the Actions toolbar, click Schedule.  

Note: If you click New, and then Service Activity, you will create a service activity without 

checking for available times.  

3. On the Schedule Service Activity form, you must enter the following information:  

 Service  

Locate and select the service you want to schedule. You can select a record from a filtered list 

in the Form Assistant pane, or you can click the Lookup button  to search for other 

records.  

 Duration  

Do not clear the Use Default Duration check box and change the duration unless you want 

to schedule more time than the default duration of the service. The maximum duration of a 

service activity is 10 days.  

4. Click Find Available Times. The next available times in the selected resource's schedule are 

displayed. If there is more than one page of records available to view in the list of records, use the 

Page arrows at the bottom of the list to view the additional pages.  

5. Under Available Times click on the start or end time of the time you want to schedule, and then 

click Schedule. If you click the service or resource links, the related form opens.  

The Schedule Service Activity form closes and Microsoft Dynamics CRM fills in the information 

from the selected time into the Service Activity form.  

6. On the Service Activity form, enter any additional information about the service activity.  

 Subject  

You must enter a subject. The first 12 characters appear on the Service calendar and the 

calendar in your Workplace.  

You can save the service activity now, or continue to add information.  

 Customers  

If this service activity is for a customer, you can locate and select the account or contact. 

You can select a record from a filtered list in the Form Assistant pane, or you can click 

Lookup to search for other records.  

 Location  

You can enter an address or room number where the service activity will occur.  
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 Show Time As  

If you want to change the initial status of the service activity, select a status from the list. If 

you select any of the statuses under Scheduled, that block of time on the schedule is set so 

that another service activity or appointment cannot conflict with it during automatic 

scheduling. Forced service activities and appointments might conflict.  

 Site  

Changing the Site after you have selected a time for the service activity is not 

recommended. Resources are assigned to sites. If the selected resources are not available at 

the selected site, there might be conflicts. To record the specific room or address of the 

service activity, enter that information in the Location box on the Service Activity form.  

 Notes  

You can add additional information about the customer and service activity in this area. For 

example, you could enter the symptoms of a problem, special requests by the customer, or 

any messages to pass on to the resources providing the service.  

On the Details tab, you can select and locate a record in the Regarding box to link to this service 

activity. You can also set a Priority for the service activity, and record a Category and Sub-

Category.  

7. Click Save or Save and Close.  

The service activity appears as a color block on the Service calendar, as well as on the calendar in 

the Workplace and Activities areas.  

Tip 

You can record a customer's preferences for a specific time, day, service, facility, equipment, and customer service 

representative in the customer record on the Administration tab. As you are scheduling a service activity, the 

customer's preference is displayed in the Form Assistant pane.  

Notes 

 Changing any information in the Scheduling Information area after you have selected a time for the 

service activity is not recommended. Doing so might cause conflicts in the schedule.  

 In the list of possible service activity search results, you can click the Page Back arrow to initiate a 

new search. Paging back does not display the previous page.  

View a list of resources 

 Can I do this task?  

This task requires permissions that are found in all default service scheduling security roles. More 
information about specific permissions and performing this task while offline: Service Scheduling 
Permissions  

You can view a list of resources in the Service calendar area. The Service calendar includes a scalable, linear view of 
the resources' schedules. 

 

1. In the Navigation Pane, click Service, and then click Service Calendar.  

2. In the Type list, select the type of resource (user, resource, or facilities and equipment), and then in 

the View list, select the view of that resource that you want to see.  

3. In the list of resources, you can do any of the following:  
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 Click a letter on the alphabetical jump bar at the bottom of the list to go to that section of the 

list.  

 Expand the list pane by dragging the right edge to view additional columns of information.  

 Reverse the sort order of the list by clicking a column heading.  

 View general information about a single resource by selecting the resource in the list and then 

clicking the Expand button  under the Zoom bar. 

Create a service activity without checking for conflicts  

 Can I do this task?  

This task requires permissions that are found in all default service scheduling security roles. More 
information about specific permissions and performing this task while offline: Service Scheduling 
Permissions  

If you save this service activity without finding available times in the schedule, then the service activity appears on 

the schedule without checking for conflicts.  

One reason to force a service activity into a time slot is to squeeze another service activity into the left-over time from 

a previous service activity. 

 

1. In the Navigation Pane, click Service, and then click Service Calendar.  

2. On the Actions toolbar, click New, and then click Service Activity.  

3. On the Service Activity form, you must enter the following information:  

 Subject  

You must enter a subject. The first 12 characters appear on the Service calendar and the 

calendar in your Workplace.  

 Service  

Locate and select the service you want to schedule. You can select a record from a filtered list 

in the Form Assistant pane, or you can click the Lookup button  to search for other 

records.  

4. You can enter additional information about the service activity.  

 Customers  

If this service activity is for a customer, you can locate and select the account or contact. 

You can select a record from a filtered list in the Form Assistant pane, or you can click 

Lookup to search for other records.  

 Resources  

Locate and select the user, or facility and equipment that you want to schedule. You can 

select a record from a filtered list in the Form Assistant pane, or you can click Lookup to 

search for other records.  

 Location  

You can enter an address or room number where the service activity will occur.  

 Show Time As  

If you want to change the initial status of the service activity, select a status from the list. If 

you select any of the statuses under Scheduled, that block of time on the schedule is set so 
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that another service activity or appointment cannot conflict with it during automatic 

scheduling. Forced service activities and appointments might conflict.  

 Site  

Locate and select the site for the service activity. Sites are defined in Microsoft Dynamics 

CRM and assigned to resources. Only resources from the same site will be selected. To 

record the specific room or address of the service activity, enter information in the Location 

box. You can select a record from a filtered list in the Form Assistant pane, or you can click 

Lookup to search for other records.  

5. Under Scheduling Information, you must enter the Start Time and End Time, but the other 

information is optional.  

 Start Time and End Time  

Select or type in the date and times the service activity starts and ends. The Duration box is 

updated to the length of the service activity. If you select a different duration, the End Time 

is adjusted. If you type in both the start and end times, the duration will change.  

If this is an all-day event, click All Day Event. An all-day event is actually the entire working 

day of the selected resource. If the resource works 8 a.m. to noon, then an all-day event is 

four hours.  

 Duration  

You can add additional time to the end of a time slot by changing the duration. The 

maximum duration of an activity is 10 days. The default duration is determined by the 

selected service.  

 Notes  

You can add additional information about the customer and service activity in this area. For 

example, you could enter the symptoms of a problem, special requests by the customer, or 

any messages to pass on to the resources providing the service.  

6. On the Details tab, you can select and locate a record in the Regarding box to link to this service 

activity. You can also set a Priority for the service activity, and record a Category and Sub-

Category.  

7. Click Save or Save and Close.  

The service activity appears as a color block on the Service calendar, as well as on the calendar in 

the Workplace and Activities areas.  

Tip 

You can record a customer's preferences for a specific time, day, service, facility, equipment, and customer service 

representative in the customer record on the Administration tab. As you are scheduling a service activity, the 

customer's preference is displayed in the Form Assistant pane.  

Notes 

 If at any time before you save this service activity, you want to search the schedule for an available 

time, you can click Schedule on the Actions toolbar to open the Schedule Service Activity dialog 

box.  

 Check the schedule for schedule conflicts  



 

356 Microsoft Dynamics CRM 4.0 User’s Guide 
 

Find and view the work schedule for an individual resource  

 Can I do this task?  

This task requires permissions that are found in all default service scheduling security roles. More 
information about specific permissions and performing this task while offline: Service Scheduling 
Permissions  

 

 

1. In the Navigation Pane, click Service, and then click Service Calendar.  

2. In the Type list, click Resource.  

3. In the Look for box, type the name of the resource, or the last name of a user, and then click Find.  

You can use asterisks (*) as wildcards in your search. 

The search results appear in the list pane.  

4. In the Service calendar, you can do the following:  

 To view current appointments and service activities for a resource, select the name from the 

list. The schedule appears in the schedule pane to the right of the list.  

 To view a specific date, select a date in the Calendar pane.  

 To quickly change the date range, use the Zoom controls at the bottom of the schedule 

pane.  

5. To view work hours for a specific resource, follow these steps:  

a. In the list of resources, open the resource you want to view. 

The User or Facilities/Equipment form opens. If you have sufficient permissions, this form can 

be edited.  

b. On the User or Facilities/Equipment form, click Work Hours. The monthly calendar displays 

the start and end time for each day's schedule. If a schedule has not been set, or the 

resource is always available, the calendar displays All Day.  

c. To change the month you are viewing, at the top of the calendar, click the forward and back 

arrows on either side of the displayed month and year.  

d. To edit the schedule, double-click a date on the calendar. Change the schedule as needed.  

Check the schedule for schedule conflicts  

 Can I do this task?  

This task requires permissions that are found in all default service scheduling security roles. More 
information about specific permissions and performing this task while offline: Service Scheduling 
Permissions  

 

 

1. In the Navigation Pane, click Service, and then click Service Calendar.  

2. On the Actions toolbar, click Show Conflicts. 

The button label changes to Hide Conflicts and any service activities, appointments, or resources 

that have scheduling conflicts are outlined in red.  
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Change the status of a service activity  

 Can I do this task?  

This task requires permissions that are found in all default service scheduling security roles. More 
information about specific permissions and performing this task while offline: Service Scheduling 
Permissions  

After a service activity is created, you can change the service activity status. The status of a service activity is 
displayed in the Service calendar and the Workplace calendar. 

 

1. In the Navigation Pane, click Service, and then click Service Calendar.  

2. On the Service calendar, select the service activity you want to change.  

3. On the Actions toolbar, click Change Status.  

4. In the Change Status dialog box, in the Show Time As list, select the new status, and then click 

OK. 

The status of the service activity is updated and the color of the service activity time slot changes.  

Note 

When you close a service activity, the activity becomes read-only and cannot be edited.  

Reschedule a service activity  

 Can I do this task?  

This task requires permissions that are found in all default service scheduling security roles. More 
information about specific permissions and performing this task while offline: Service Scheduling 
Permissions  

 

 

1. In the Navigation Pane, click Service, and then click Service Calendar.  

2. Locate and select the service activity you want to reschedule.  

3. On the Actions toolbar, click Reschedule.  

4. On the Schedule Service Activity form, change any of the information you want.  

5. Click Find Available Times.  

Microsoft Dynamics CRM returns a list of available time slots that meet the criteria on the form. If 

you do not find a suitable time slot, change the criteria, and try again.  

6. In the Available Times list, select a time slot.  

7. Click Schedule.  

8. Click Save or Save and Close.  

Note 

You cannot reopen closed service activities. To reactivate canceled service activities, on the Actions  menu, click 

Reactivate. The service activity will be reopened and the status will be updated to Requested. If the time is no longer 

available, you may get a message. To reschedule the service activity for an available time, click Schedule. 
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Close or cancel a service activity  

 Can I do this task?  

This task requires permissions that are found in all default service scheduling security roles. More 
information about specific permissions and performing this task while offline: Service Scheduling 
Permissions  

You cannot reopen closed service activities.  

 

1. In the Navigation Pane, click Service, and then click Service Calendar.  

2. Locate and open the service activity you want to close.  

3. On the Actions  menu, click Close Service Activity.  

4. In the Service Activity Close Confirmation dialog box, in the Status list, do one of the following:  

 If the service activity is completed and can be billed, select Completed.  

 If the service activity will not be completed and cannot be billed, click Canceled.  

 If the customer never arrived and the service activity cannot be billed, select No Show.  

5. Click OK.  

6. On the Standard toolbar, click Close.  

The service activity appears in the Service calendar, color-coded with its current status and the 

subject of the service activity.  

Note 

To reactivate canceled service activities, on the Actions menu, click Reactivate. The service activity will be reopened 

and the status will be updated to Requested. If the time is no longer available, you may get a message. To reschedule 

the service activity for an available time, click Schedule. 

Booking Service Activities in the Service Calendar 

The Service calendar displays all of your organization's scheduled service activities and appointments as blocks of time 

in a linear view of the daily, weekly, or monthly calendar. Resources can also see their service activities in their 

Workplace calendar. 

The main purpose of the service calendar is to monitor service activities and book services for customers. Services are 

defined to require specific personnel, facility, and equipment. Resources have schedules that define when they are 

available to perform services. When you schedule a service, you can search for an available time, and then book the 

service by saving the service activity. That time is reserved for the selected resources.  

Conflicts in Schedules and Rescheduling Service Activities 

When you save a service activity or an appointment, an alert informs you if there is a potential conflict. You can choose 

to select another time, or book the service activity anyway. At any time, you can identify any service activities or 

appointments with conflicts and reschedule them.  

Schedule Service Activity  

Use this form to search for an available time for a service activity. You can either search for an open time using search 

criteria that at a minimum includes selecting a service, or you can define a more complex set of criteria. You can also 

create a service activity without checking for conflicts in the scheduled service. The service activity appears as a color 

block on the Service calendar, as well as on the calendar in the Workplace and Activities areas.  
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You cannot create a recurring service activity. Create individual service activities as appropriate.  

Find the next available time  

 Can I do this task?  

This task requires permissions that are found in all default service scheduling security roles. More 
information about specific permissions and performing this task while offline: Service Scheduling 
Permissions  

Use this procedure to find the next available times for a service. This is the fastest way to schedule a service activity.  

 

1. In the Navigation Pane, click Service, and then click Service Calendar.  

2. On the Actions toolbar, click Schedule.  

Note: If you click New, and then Service Activity, you will create a service activity without 

checking for available times.  

3. On the Schedule Service Activity form, you must enter the following information:  

 Service  

Locate and select the service you want to schedule. You can select a record from a filtered list 

in the Form Assistant pane, or you can click the Lookup button  to search for other 

records.  

 Duration  

Do not clear the Use Default Duration check box and change the duration unless you want 

to schedule more time than the default duration of the service. The maximum duration of a 

service activity is 10 days.  

4. Click Find Available Times. The next available times are displayed. If there is more than one page 

of records available to view in the list of records, use the Page arrows at the bottom of the list to 

view the additional pages.  

5. Under Available Times click on the start or end time of the time you want to schedule, and then 

click Schedule. If you click the service or resource links, the related form opens.  

The Schedule Service Activity form closes and Microsoft Dynamics CRM fills in the information 

from the selected time into the Service Activity form.  

6. On the Service Activity form, enter any additional information about the service activity.  

 Subject  

You must enter a subject. The first 12 characters appear on the Service calendar and the 

calendar in your Workplace.  

You can save the service activity now, or continue to add information.  

 Customers  

If this service activity is for a customer, you can locate and select the account or contact. You 

can select a record from a filtered list in the Form Assistant pane, or you can click Lookup to 

search for other records.  

 Resources  

Locate and select the user, or facility and equipment that you want to schedule. You can 

select a record from a filtered list in the Form Assistant pane, or you can click Lookup to 

search for other records.  
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 Location  

You can enter an address or room number where the service activity will occur.  

 Show Time As  

If you want to change the initial status of the service activity, select a status from the list. If 

you select any of the statuses under Scheduled, that block of time on the schedule is set so 

that another service activity or appointment cannot conflict with it during automatic 

scheduling. Forced service activities and appointments might conflict.  

 Site  

Changing the Site after you have selected a time for the service activity is not recommended. 

Resources are assigned to sites. If the selected resources are not available at the selected 

site, there might be conflicts. To record the specific room or address of the service activity, 

enter that information in the Location box on the Service Activity form.  

 Notes  

You can add additional information about the customer and service activity in this area. For 

example, you could enter the symptoms of a problem, special requests by the customer, or 

any messages to pass on to the resources providing the service.  

7. On the Details tab, you can select and locate a record in the Regarding box to link to this service 

activity. You can also set a Priority for the service activity, and record a Category and Sub-

Category.  

8. Click Save or Save and Close.  

The service activity appears as a color block on the Service calendar, as well as on the calendar in 

the Workplace and Activities areas.  

Tip 

You can record a customer's preferences for a specific time, day, service, facility, equipment, and customer service 

representative in the customer record on the Administration tab. As you are scheduling a service activity, the 

customer's preference is displayed in the Form Assistant pane.  

Notes 

 Changing any information in the Scheduling Information area after you have selected a time for the 

service activity is not recommended. Doing so might cause conflicts in the schedule.  

 In the list of possible service activity search results, you can click the Page Back arrow to initiate a 

new search. Paging back does not display the previous page.  

Find the next available time within a specific time period  

 Can I do this task?  

This task requires permissions that are found in all default service scheduling security roles. More 
information about specific permissions and performing this task while offline: Service Scheduling 
Permissions  

Use this procedure to find the next available time based on a specific date, or range of dates, within the next day, 

week, or month.  

 

1. In the Navigation Pane, click Service, and then click Service Calendar.  
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2. On the Actions toolbar, click Schedule.  

Note: If you click New, and then Service Activity, you will create a service activity without 

checking for available times.  

3. On the Schedule Service Activity form, you must enter the following information:  

 Service  

Locate and select the service you want to schedule. You can select a record from a filtered list 

in the Form Assistant pane, or you can click the Lookup button  to search for other 

records.  

4. Under Requested Time, select criteria for the times you want.  

 Start Date  

 To search for a time on a specific date, select Specific Date, and then enter the date 

you want.  

 To search within a range of dates, select Range of Dates, and then enter the On or 

After and On or Before dates. You can also select specific days of the week.  

 To search for times today, select Today.  

 You can also search for times based on dates relative to today, such as Tomorrow, 

This Week, or Next Week.  

 Start Time  

 To search for a specific time, select Specific Time, and then enter the specific time.  

 To search within a specific range of time, select Range of Times, and then enter the 

earliest and latest times you want the service activity to start.  

 You can also search for times based on the time of day, such as Morning or 

Evening.  

 Duration  

Do not clear the Use Default Duration check box and change the duration unless you want 

to schedule more time than the default duration of the service. The maximum duration of a 

service activity is 10 days.  

5. Click Find Available Times. The next available times are displayed.  

6. Under Available Times click on the start or end time of the time you want to schedule, and then 

click Schedule. If you click the service or resource links, the related form opens.  

The Schedule Service Activity form closes and Microsoft Dynamics CRM fills in the information 

from the selected time into the Service Activity form.  

7. On the Service Activity form, enter any additional information about the service activity.  

 Subject  

You must enter a subject. The first 12 characters appear on the Service calendar and the 

calendar in your Workplace.  

You can save the service activity now, or continue to add information.  

 Customers  

If this service activity is for a customer, you can locate and select the account or contact. 

You can select a record from a filtered list in the Form Assistant pane, or you can click 

Lookup to search for other records.  
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 Resources  

Locate and select the user, or facility and equipment that you want to schedule. You can 

select a record from a filtered list in the Form Assistant pane, or you can click Lookup to 

search for other records.  

 Location  

You can enter an address or room number where the service activity will occur.  

 Show Time As  

If you want to change the initial status of the service activity, select a status from the list. If 

you select any of the statuses under Scheduled, that block of time on the schedule is set so 

that another service activity or appointment cannot conflict with it during automatic 

scheduling. Forced service activities and appointments might conflict.  

 Site  

Changing the Site after you have selected a time for the service activity is not 

recommended. Resources are assigned to sites. If the selected resources are not available at 

the selected site, there might be conflicts. To record the specific room or address of the 

service activity, enter that information in the Location box on the Service Activity form.  

 Notes  

You can add additional information about the customer and service activity in this area. For 

example, you could enter the symptoms of a problem, special requests by the customer, or 

any messages to pass on to the resources providing the service.  

8. On the Details tab, you can select and locate a record in the Regarding box to link to this service 

activity. You can also set a Priority for the service activity, and record a Category and Sub-

Category.  

9. Click Save or Save and Close.  

The service activity appears as a color block on the Service calendar, as well as on the calendar in 

the Workplace and Activities areas.  

Tip 

You can record a customer's preferences for a specific time, day, service, facility, equipment, and customer service 

representative in the customer record on the Administration tab. As you are scheduling a service activity, the 

customer's preference is displayed in the Form Assistant pane.  

Important 

 Changing any information in the Scheduling Information area after you have selected a time for the 

service activity is not recommended. Doing so might cause conflicts in the schedule.  

 In the list of possible service activity search results, you can click the Page Back arrow to initiate a 

new search. Paging back does not display the previous page.  
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Find an available time with specific criteria  

 Can I do this task?  

This task requires permissions that are found in all default service scheduling security roles. More 
information about specific permissions and performing this task while offline: Service Scheduling 
Permissions  

Use this procedure to find the next available time based on a set of specific criteria. For example, if the customer 

wants your head mechanic to work on his bicycle, you can search the head mechanic's schedule for the next 

available time. 

 

1. In the Navigation Pane, click Service, and then click Service Calendar.  

2. On the Actions toolbar, click Schedule.  

Note: If you click New, and then Service Activity, you will create a service activity without 

checking for available times.  

3. On the Schedule Service Activity form, you must enter the following information:  

 Service  

Locate and select the service you want to schedule. You can select a record from a filtered list 

in the Form Assistant pane, or you can click the Lookup button  to search for other 

records.  

 Duration  

Do not clear the Use Default Duration check box and change the duration unless you want 

to schedule more time than the default duration of the service. The maximum duration of a 

service activity is 10 days.  

4. Click Find Available Times. The next available times in the selected resource's schedule are 

displayed. If there is more than one page of records available to view in the list of records, use the 

Page arrows at the bottom of the list to view the additional pages.  

5. Under Available Times click on the start or end time of the time you want to schedule, and then 

click Schedule. If you click the service or resource links, the related form opens.  

The Schedule Service Activity form closes and Microsoft Dynamics CRM fills in the information 

from the selected time into the Service Activity form.  

6. On the Service Activity form, enter any additional information about the service activity.  

 Subject  

You must enter a subject. The first 12 characters appear on the Service calendar and the 

calendar in your Workplace.  

You can save the service activity now, or continue to add information.  

 Customers  

If this service activity is for a customer, you can locate and select the account or contact. 

You can select a record from a filtered list in the Form Assistant pane, or you can click 

Lookup to search for other records.  

 Location  

You can enter an address or room number where the service activity will occur.  
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 Show Time As  

If you want to change the initial status of the service activity, select a status from the list. If 

you select any of the statuses under Scheduled, that block of time on the schedule is set so 

that another service activity or appointment cannot conflict with it during automatic 

scheduling. Forced service activities and appointments might conflict.  

 Site  

Changing the Site after you have selected a time for the service activity is not 

recommended. Resources are assigned to sites. If the selected resources are not available at 

the selected site, there might be conflicts. To record the specific room or address of the 

service activity, enter that information in the Location box on the Service Activity form.  

 Notes  

You can add additional information about the customer and service activity in this area. For 

example, you could enter the symptoms of a problem, special requests by the customer, or 

any messages to pass on to the resources providing the service.  

On the Details tab, you can select and locate a record in the Regarding box to link to this service 

activity. You can also set a Priority for the service activity, and record a Category and Sub-

Category.  

7. Click Save or Save and Close.  

The service activity appears as a color block on the Service calendar, as well as on the calendar in 

the Workplace and Activities areas.  

Tip 

You can record a customer's preferences for a specific time, day, service, facility, equipment, and customer service 

representative in the customer record on the Administration tab. As you are scheduling a service activity, the 

customer's preference is displayed in the Form Assistant pane.  

Notes 

 Changing any information in the Scheduling Information area after you have selected a time for the 

service activity is not recommended. Doing so might cause conflicts in the schedule.  

 In the list of possible service activity search results, you can click the Page Back arrow to initiate a 

new search. Paging back does not display the previous page.  

Create a service activity without checking for conflicts  

 Can I do this task?  

This task requires permissions that are found in all default service scheduling security roles. More 
information about specific permissions and performing this task while offline: Service Scheduling 
Permissions  

If you save this service activity without finding available times in the schedule, then the service activity appears 

on the schedule without checking for conflicts.  

One reason to force a service activity into a time slot is to squeeze another service activity into the left-over time 

from a previous service activity. 

 

1. In the Navigation Pane, click Service, and then click Service Calendar.  
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2. On the Actions toolbar, click New, and then click Service Activity.  

3. On the Service Activity form, you must enter the following information:  

 Subject  

You must enter a subject. The first 12 characters appear on the Service calendar and the 

calendar in your Workplace.  

 Service  

Locate and select the service you want to schedule. You can select a record from a filtered list 

in the Form Assistant pane, or you can click the Lookup button  to search for other 

records.  

4. You can enter additional information about the service activity.  

 Customers  

If this service activity is for a customer, you can locate and select the account or contact. 

You can select a record from a filtered list in the Form Assistant pane, or you can click 

Lookup to search for other records.  

 Resources  

Locate and select the user, or facility and equipment that you want to schedule. You can 

select a record from a filtered list in the Form Assistant pane, or you can click Lookup to 

search for other records.  

 Location  

You can enter an address or room number where the service activity will occur.  

 Show Time As  

If you want to change the initial status of the service activity, select a status from the list. If 

you select any of the statuses under Scheduled, that block of time on the schedule is set so 

that another service activity or appointment cannot conflict with it during automatic 

scheduling. Forced service activities and appointments might conflict.  

 Site  

Locate and select the site for the service activity. Sites are defined in Microsoft Dynamics 

CRM and assigned to resources. Only resources from the same site will be selected. To 

record the specific room or address of the service activity, enter information in the Location 

box. You can select a record from a filtered list in the Form Assistant pane, or you can click 

Lookup to search for other records.  

5. Under Scheduling Information, you must enter the Start Time and End Time, but the other 

information is optional.  

 Start Time and End Time  

Select or type in the date and times the service activity starts and ends. The Duration box is 

updated to the length of the service activity. If you select a different duration, the End Time 

is adjusted. If you type in both the start and end times, the duration will change.  

If this is an all-day event, click All Day Event. An all-day event is actually the entire working 

day of the selected resource. If the resource works 8 a.m. to noon, then an all-day event is 

four hours.  

 Duration  

You can add additional time to the end of a time slot by changing the duration. The 

maximum duration of an activity is 10 days. The default duration is determined by the 

selected service.  

 Notes  

You can add additional information about the customer and service activity in this area. For 
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example, you could enter the symptoms of a problem, special requests by the customer, or 

any messages to pass on to the resources providing the service.  

6. On the Details tab, you can select and locate a record in the Regarding box to link to this service 

activity. You can also set a Priority for the service activity, and record a Category and Sub-

Category.  

7. Click Save or Save and Close.  

The service activity appears as a color block on the Service calendar, as well as on the calendar in 

the Workplace and Activities areas.  

Tip 

You can record a customer's preferences for a specific time, day, service, facility, equipment, and customer service 

representative in the customer record on the Administration tab. As you are scheduling a service activity, the 

customer's preference is displayed in the Form Assistant pane.  

Notes 

 If at any time before you save this service activity, you want to search the schedule for an available 

time, you can click Schedule on the Actions toolbar to open the Schedule Service Activity dialog 

box.  

 Check the schedule for schedule conflicts  

Reschedule a service activity  

 Can I do this task?  

This task requires permissions that are found in all default service scheduling security roles. More 
information about specific permissions and performing this task while offline: Service Scheduling 
Permissions  

 

 

1. In the Navigation Pane, click Service, and then click Service Calendar.  

2. Locate and select the service activity you want to reschedule.  

3. On the Actions toolbar, click Reschedule.  

4. On the Schedule Service Activity form, change any of the information you want.  

5. Click Find Available Times.  

Microsoft Dynamics CRM returns a list of available time slots that meet the criteria on the form. If 

you do not find a suitable time slot, change the criteria, and try again.  

6. In the Available Times list, select a time slot.  

7. Click Schedule.  

8. Click Save or Save and Close.  

Note 

You cannot reopen closed service activities. To reactivate canceled service activities, on the Actions  menu, click 

Reactivate. The service activity will be reopened and the status will be updated to Requested. If the time is no longer 

available, you may get a message. To reschedule the service activity for an available time, click Schedule. 
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Close or cancel a service activity  

 Can I do this task?  

This task requires permissions that are found in all default service scheduling security roles. More 
information about specific permissions and performing this task while offline: Service Scheduling 
Permissions  

You cannot reopen closed service activities.  

 

1. In the Navigation Pane, click Service, and then click Service Calendar.  

2. Locate and open the service activity you want to close.  

3. On the Actions  menu, click Close Service Activity.  

4. In the Service Activity Close Confirmation dialog box, in the Status list, do one of the following:  

 If the service activity is completed and can be billed, select Completed.  

 If the service activity will not be completed and cannot be billed, click Canceled.  

 If the customer never arrived and the service activity cannot be billed, select No Show.  

5. Click OK.  

6. On the Standard toolbar, click Close.  

The service activity appears in the Service calendar, color-coded with its current status and the 

subject of the service activity.  

Note 

To reactivate canceled service activities, on the Actions menu, click Reactivate. The service activity will be reopened 

and the status will be updated to Requested. If the time is no longer available, you may get a message. To reschedule 

the service activity for an available time, click Schedule. 

Work with Service Activities 

You can search for an available time to perform a service for a customer. Notices and reminders are not sent 

automatically to the customer or the resource providing the service.  

Find the next available time  

 Can I do this task?  

This task requires permissions that are found in all default service scheduling security roles. More 
information about specific permissions and performing this task while offline: Service Scheduling 
Permissions  

Use this procedure to find the next available times for a service. This is the fastest way to schedule a service activity.  

 

1. In the Navigation Pane, click Service, and then click Service Calendar.  

2. On the Actions toolbar, click Schedule.  

Note: If you click New, and then Service Activity, you will create a service activity without 

checking for available times.  
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3. On the Schedule Service Activity form, you must enter the following information:  

 Service  

Locate and select the service you want to schedule. You can select a record from a filtered list 

in the Form Assistant pane, or you can click the Lookup button  to search for other 

records.  

 Duration  

Do not clear the Use Default Duration check box and change the duration unless you want 

to schedule more time than the default duration of the service. The maximum duration of a 

service activity is 10 days.  

4. Click Find Available Times. The next available times are displayed. If there is more than one page 

of records available to view in the list of records, use the Page arrows at the bottom of the list to 

view the additional pages.  

5. Under Available Times click on the start or end time of the time you want to schedule, and then 

click Schedule. If you click the service or resource links, the related form opens.  

The Schedule Service Activity form closes and Microsoft Dynamics CRM fills in the information 

from the selected time into the Service Activity form.  

6. On the Service Activity form, enter any additional information about the service activity.  

 Subject  

You must enter a subject. The first 12 characters appear on the Service calendar and the 

calendar in your Workplace.  

You can save the service activity now, or continue to add information.  

 Customers  

If this service activity is for a customer, you can locate and select the account or contact. You 

can select a record from a filtered list in the Form Assistant pane, or you can click Lookup to 

search for other records.  

 Resources  

Locate and select the user, or facility and equipment that you want to schedule. You can 

select a record from a filtered list in the Form Assistant pane, or you can click Lookup to 

search for other records.  

 Location  

You can enter an address or room number where the service activity will occur.  

 Show Time As  

If you want to change the initial status of the service activity, select a status from the list. If 

you select any of the statuses under Scheduled, that block of time on the schedule is set so 

that another service activity or appointment cannot conflict with it during automatic 

scheduling. Forced service activities and appointments might conflict.  

 Site  

Changing the Site after you have selected a time for the service activity is not recommended. 

Resources are assigned to sites. If the selected resources are not available at the selected 

site, there might be conflicts. To record the specific room or address of the service activity, 

enter that information in the Location box on the Service Activity form.  

 Notes  

You can add additional information about the customer and service activity in this area. For 

example, you could enter the symptoms of a problem, special requests by the customer, or 

any messages to pass on to the resources providing the service.  
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7. On the Details tab, you can select and locate a record in the Regarding box to link to this service 

activity. You can also set a Priority for the service activity, and record a Category and Sub-

Category.  

8. Click Save or Save and Close.  

The service activity appears as a color block on the Service calendar, as well as on the calendar in 

the Workplace and Activities areas.  

Tip 

You can record a customer's preferences for a specific time, day, service, facility, equipment, and customer service 

representative in the customer record on the Administration tab. As you are scheduling a service activity, the 

customer's preference is displayed in the Form Assistant pane.  

Notes 

 Changing any information in the Scheduling Information area after you have selected a time for the 

service activity is not recommended. Doing so might cause conflicts in the schedule.  

 In the list of possible service activity search results, you can click the Page Back arrow to initiate a 

new search. Paging back does not display the previous page.  

Work with the Workplace Calendar 

Use the Workplace calendar to view by the day, week, or month and to create and edit appointments and service 

activities. 

View the calendar in the Workplace area  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Common Task Permissions  

The Workplace calendar displays the appointments and service activities to which you are a participant.  

 

1. In the Navigation Pane, click Workplace, and then under My Work click Calendar.  

2. On the calendar, you can change the view by doing any of the following:  

 To change the calendar view, under Calendar Views, click one of the views:  

o Month 

The calendar displays a monthly calendar.  

o Week  

The calendar displays a 7-day week.  

o Day 

The calendar displays an hourly list for a single day.  

 To view a summary of an appointment, on the calendar, place the cursor over the 

appointment.  

 To view or edit the details of an appointment, on the calendar, click the appointment link. The 

Appointment form opens.  

3. To change the dates displayed on the calendar, on the calendar control, click the arrows or a specific 

date.  
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4. To view today's appointments and service activities, on the calendar control, click Today. The 

calendar displays the hourly list for today.  

5. To refresh the calendar, in the top right corner of the calendar, click the Refresh button .  

Note 

The calendar displays canceled and completed appointments and service activities. To remove an appointment or 

service activity from the calendar, delete the record.  

Print the details of an activity from a calendar  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Common Task Permissions  

You can print the details of an appointment or service activity from the Workplace calendar or the Service 

calendar.  

 

1. Locate and open the appointment or service activity you want to print.  

2. On the Actions toolbar, click the Print button .  

3. In the Preview dialog box, click Print.  

4. In the Print dialog box, set the printing options you want, and then click Print.  

5. On the Standard toolbar, click Close.  

Note 

To print the entire calendar as you see it in the window, click Print in Microsoft Internet Explorer.  

Create or edit an appointment  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Common Task Permissions  

You can modify any of the information in an open appointment. If you change the date and times of the 
appointment, Microsoft Dynamics CRM will recheck for schedule conflicts. You cannot create a recurring 
appointment. The calendar displays canceled and completed appointments and service activities. To remove an 
appointment or service activity from the calendar, delete the record.  

 

1. Create an appointment in:  

 Calendar in Workplace  

a. In the Navigation Pane, click Workplace, and then under My Work click Calendar.  

b. Under Create a New, click Appointment.  

 Service Calendar  

a. In the Navigation Pane, click Service, and then click Service Calendar.  
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b. On the Actions toolbar, click New, and then click Appointment.  

 Activities area  

a. In the Navigation Pane, click Workplace, and then under My Work click Activities.  

b. On the Actions toolbar, click New.  

c. In the New Activity dialog box, click Appointment, and then click OK.  

4. In the Appointment dialog box, on the Appointment tab, you must enter information in the 

following fields:  

 Subject  

Enter a description of the appointment. The first 12 characters appear in the Workplace 

calendar and Service calendar.  

 Start Time  

Enter the date and time that the appointment begins.  

 End Time  

Enter the date and time that the appointment ends. Microsoft Dynamics CRM automatically 

sets the appointment for a duration of 30 minutes starting on the next half hour.  

 Required  

To locate and select participants that must attend this appointment, click the box next to the 

label. You can select a record from a filtered list in the Form Assistant pane, or you can click 

the Lookup button  to search for other records.  

Participants are not sent notification of new or updated appointments. In Microsoft Dynamics 

CRM for Outlook you can include recipients that are not contacts in Microsoft Dynamics CRM. 

The names are displayed as red text. Click the red name to resolve it to an existing contact or 

account, or create a new record.  

 Add optional information.  

 To add Optional participants, click Lookup to search for records.  

 In the Location box, enter the room or address where the appointment will occur. 

 In the Show Time As list, select how you want the appointment to appear on your 

calendar. If you select Free or Tentative, other appointments and service activities can be 

scheduled during that time. 

 In the Duration box, record the time you spend on the activity. If this activity is related to a 

case and the case is linked to a contract line, the durations of all the activities for this case 

are tallied and updated automatically in the related active contract. The total, which includes 

the totals from any other cases relating to that contract, can be adjusted manually before 

billing the customer. The maximum duration of an appointment or service activity is 10 days.  

 Click All Day Event if this event is for the entire time you are working. The appointment's 

duration will be the same as your working hours. For example, if your working hours are 9 

a.m. to 6 p.m., then the duration of your appointment is 9 hours, but will display as "1 day".  

 On the Notes tab, click Click here to enter a new note, and add the information that 

applies to your record.  

 On the Details tab, you can link the appointment to another Microsoft Dynamics CRM record 

and change the Organizer. If your business uses Category and Sub-Category to organize your 

business data, enter them on this tab.  
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 Click Save or Save and Close.  

If one or more of the participants (including you as the originator) have a service activity or 

appointment during this time, a warning appears. You can click Ignore and Save to save the 

appointment anyway.  

The new appointment appears in the calendar and list of activities for the participants. If the owner 

is not a participant, the activity will not appear in his or her calendar.  

Notes 

 Appointments created in the Web application and synchronized with Microsoft Dynamics CRM for 

Outlook automatically set a 15-minute reminder and appear in the Outlook calendar. You can 

change the reminder in Outlook.  

 To re-open a canceled appointment, on the Actions  menu, click Reactivate.  

Find the next available time  

 Can I do this task?  

This task requires permissions that are found in all default service scheduling security roles. More 
information about specific permissions and performing this task while offline: Service Scheduling 
Permissions  

Use this procedure to find the next available times for a service. This is the fastest way to schedule a service 

activity.  

 

1. In the Navigation Pane, click Service, and then click Service Calendar.  

2. On the Actions toolbar, click Schedule.  

Note: If you click New, and then Service Activity, you will create a service activity without 

checking for available times.  

3. On the Schedule Service Activity form, you must enter the following information:  

 Service  

Locate and select the service you want to schedule. You can select a record from a filtered list 

in the Form Assistant pane, or you can click the Lookup button  to search for other 

records.  

 Duration  

Do not clear the Use Default Duration check box and change the duration unless you want 

to schedule more time than the default duration of the service. The maximum duration of a 

service activity is 10 days.  

4. Click Find Available Times. The next available times are displayed. If there is more than one page 

of records available to view in the list of records, use the Page arrows at the bottom of the list to 

view the additional pages.  

5. Under Available Times click on the start or end time of the time you want to schedule, and then 

click Schedule. If you click the service or resource links, the related form opens.  

The Schedule Service Activity form closes and Microsoft Dynamics CRM fills in the information 

from the selected time into the Service Activity form.  

6. On the Service Activity form, enter any additional information about the service activity.  
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 Subject  

You must enter a subject. The first 12 characters appear on the Service calendar and the 

calendar in your Workplace.  

You can save the service activity now, or continue to add information.  

 Customers  

If this service activity is for a customer, you can locate and select the account or contact. You 

can select a record from a filtered list in the Form Assistant pane, or you can click Lookup to 

search for other records.  

 Resources  

Locate and select the user, or facility and equipment that you want to schedule. You can 

select a record from a filtered list in the Form Assistant pane, or you can click Lookup to 

search for other records.  

 Location  

You can enter an address or room number where the service activity will occur.  

 Show Time As  

If you want to change the initial status of the service activity, select a status from the list. If 

you select any of the statuses under Scheduled, that block of time on the schedule is set so 

that another service activity or appointment cannot conflict with it during automatic 

scheduling. Forced service activities and appointments might conflict.  

 Site  

Changing the Site after you have selected a time for the service activity is not recommended. 

Resources are assigned to sites. If the selected resources are not available at the selected 

site, there might be conflicts. To record the specific room or address of the service activity, 

enter that information in the Location box on the Service Activity form.  

 Notes  

You can add additional information about the customer and service activity in this area. For 

example, you could enter the symptoms of a problem, special requests by the customer, or 

any messages to pass on to the resources providing the service.  

7. On the Details tab, you can select and locate a record in the Regarding box to link to this service 

activity. You can also set a Priority for the service activity, and record a Category and Sub-

Category.  

8. Click Save or Save and Close.  

The service activity appears as a color block on the Service calendar, as well as on the calendar in 

the Workplace and Activities areas.  

Tip 

You can record a customer's preferences for a specific time, day, service, facility, equipment, and customer service 

representative in the customer record on the Administration tab. As you are scheduling a service activity, the 

customer's preference is displayed in the Form Assistant pane.  

Notes 

 Changing any information in the Scheduling Information area after you have selected a time for the 

service activity is not recommended. Doing so might cause conflicts in the schedule.  

 In the list of possible service activity search results, you can click the Page Back arrow to initiate a 

new search. Paging back does not display the previous page.  
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Find the next available time within a specific time period  

 Can I do this task?  

This task requires permissions that are found in all default service scheduling security roles. More 
information about specific permissions and performing this task while offline: Service Scheduling 
Permissions  

Use this procedure to find the next available time based on a specific date, or range of dates, within the next day, 

week, or month.  

 

1. In the Navigation Pane, click Service, and then click Service Calendar.  

2. On the Actions toolbar, click Schedule.  

Note: If you click New, and then Service Activity, you will create a service activity without 

checking for available times.  

3. On the Schedule Service Activity form, you must enter the following information:  

 Service  

Locate and select the service you want to schedule. You can select a record from a filtered list 

in the Form Assistant pane, or you can click the Lookup button  to search for other 

records.  

4. Under Requested Time, select criteria for the times you want.  

 Start Date  

 To search for a time on a specific date, select Specific Date, and then enter the date 

you want.  

 To search within a range of dates, select Range of Dates, and then enter the On or 

After and On or Before dates. You can also select specific days of the week.  

 To search for times today, select Today.  

 You can also search for times based on dates relative to today, such as Tomorrow, 

This Week, or Next Week.  

 Start Time  

 To search for a specific time, select Specific Time, and then enter the specific time.  

 To search within a specific range of time, select Range of Times, and then enter the 

earliest and latest times you want the service activity to start.  

 You can also search for times based on the time of day, such as Morning or 

Evening.  

 Duration  

Do not clear the Use Default Duration check box and change the duration unless you want 

to schedule more time than the default duration of the service. The maximum duration of a 

service activity is 10 days.  

5. Click Find Available Times. The next available times are displayed.  

6. Under Available Times click on the start or end time of the time you want to schedule, and then 

click Schedule. If you click the service or resource links, the related form opens.  
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The Schedule Service Activity form closes and Microsoft Dynamics CRM fills in the information 

from the selected time into the Service Activity form.  

7. On the Service Activity form, enter any additional information about the service activity.  

 Subject  

You must enter a subject. The first 12 characters appear on the Service calendar and the 

calendar in your Workplace.  

You can save the service activity now, or continue to add information.  

 Customers  

If this service activity is for a customer, you can locate and select the account or contact. 

You can select a record from a filtered list in the Form Assistant pane, or you can click 

Lookup to search for other records.  

 Resources  

Locate and select the user, or facility and equipment that you want to schedule. You can 

select a record from a filtered list in the Form Assistant pane, or you can click Lookup to 

search for other records.  

 Location  

You can enter an address or room number where the service activity will occur.  

 Show Time As  

If you want to change the initial status of the service activity, select a status from the list. If 

you select any of the statuses under Scheduled, that block of time on the schedule is set so 

that another service activity or appointment cannot conflict with it during automatic 

scheduling. Forced service activities and appointments might conflict.  

 Site  

Changing the Site after you have selected a time for the service activity is not 

recommended. Resources are assigned to sites. If the selected resources are not available at 

the selected site, there might be conflicts. To record the specific room or address of the 

service activity, enter that information in the Location box on the Service Activity form.  

 Notes  

You can add additional information about the customer and service activity in this area. For 

example, you could enter the symptoms of a problem, special requests by the customer, or 

any messages to pass on to the resources providing the service.  

8. On the Details tab, you can select and locate a record in the Regarding box to link to this service 

activity. You can also set a Priority for the service activity, and record a Category and Sub-

Category.  

9. Click Save or Save and Close.  

The service activity appears as a color block on the Service calendar, as well as on the calendar in 

the Workplace and Activities areas.  

Tip 

You can record a customer's preferences for a specific time, day, service, facility, equipment, and customer service 

representative in the customer record on the Administration tab. As you are scheduling a service activity, the 

customer's preference is displayed in the Form Assistant pane.  

Important 

 Changing any information in the Scheduling Information area after you have selected a time for the 

service activity is not recommended. Doing so might cause conflicts in the schedule.  
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 In the list of possible service activity search results, you can click the Page Back arrow to initiate a 

new search. Paging back does not display the previous page. 

Find an available time with specific criteria  

 Can I do this task?  

This task requires permissions that are found in all default service scheduling security roles. More 
information about specific permissions and performing this task while offline: Service Scheduling 
Permissions  

Use this procedure to find the next available time based on a set of specific criteria. For example, if the customer 

wants your head mechanic to work on his bicycle, you can search the head mechanic's schedule for the next available 

time. 

 

1. In the Navigation Pane, click Service, and then click Service Calendar.  

2. On the Actions toolbar, click Schedule.  

Note: If you click New, and then Service Activity, you will create a service activity without 

checking for available times.  

3. On the Schedule Service Activity form, you must enter the following information:  

 Service  

Locate and select the service you want to schedule. You can select a record from a filtered list 

in the Form Assistant pane, or you can click the Lookup button  to search for other 

records.  

 Duration  

Do not clear the Use Default Duration check box and change the duration unless you want 

to schedule more time than the default duration of the service. The maximum duration of a 

service activity is 10 days.  

4. Click Find Available Times. The next available times in the selected resource's schedule are 

displayed. If there is more than one page of records available to view in the list of records, use the 

Page arrows at the bottom of the list to view the additional pages.  

5. Under Available Times click on the start or end time of the time you want to schedule, and then 

click Schedule. If you click the service or resource links, the related form opens.  

The Schedule Service Activity form closes and Microsoft Dynamics CRM fills in the information 

from the selected time into the Service Activity form.  

6. On the Service Activity form, enter any additional information about the service activity.  

 Subject  

You must enter a subject. The first 12 characters appear on the Service calendar and the 

calendar in your Workplace.  

You can save the service activity now, or continue to add information.  

 Customers  

If this service activity is for a customer, you can locate and select the account or contact. 

You can select a record from a filtered list in the Form Assistant pane, or you can click 

Lookup to search for other records.  

 Location  

You can enter an address or room number where the service activity will occur.  
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 Show Time As  

If you want to change the initial status of the service activity, select a status from the list. If 

you select any of the statuses under Scheduled, that block of time on the schedule is set so 

that another service activity or appointment cannot conflict with it during automatic 

scheduling. Forced service activities and appointments might conflict.  

 Site  

Changing the Site after you have selected a time for the service activity is not 

recommended. Resources are assigned to sites. If the selected resources are not available at 

the selected site, there might be conflicts. To record the specific room or address of the 

service activity, enter that information in the Location box on the Service Activity form.  

 Notes  

You can add additional information about the customer and service activity in this area. For 

example, you could enter the symptoms of a problem, special requests by the customer, or 

any messages to pass on to the resources providing the service.  

On the Details tab, you can select and locate a record in the Regarding box to link to this service 

activity. You can also set a Priority for the service activity, and record a Category and Sub-

Category.  

7. Click Save or Save and Close.  

The service activity appears as a color block on the Service calendar, as well as on the calendar in 

the Workplace and Activities areas.  

Tip 

You can record a customer's preferences for a specific time, day, service, facility, equipment, and customer service 

representative in the customer record on the Administration tab. As you are scheduling a service activity, the 

customer's preference is displayed in the Form Assistant pane.  

Notes 

 Changing any information in the Scheduling Information area after you have selected a time for the 

service activity is not recommended. Doing so might cause conflicts in the schedule.  

 In the list of possible service activity search results, you can click the Page Back arrow to initiate a 

new search. Paging back does not display the previous page.  

Create a service activity without checking for conflicts  

 Can I do this task?  

This task requires permissions that are found in all default service scheduling security roles. More 
information about specific permissions and performing this task while offline: Service Scheduling 
Permissions  

If you save this service activity without finding available times in the schedule, then the service activity appears on 

the schedule without checking for conflicts.  

One reason to force a service activity into a time slot is to squeeze another service activity into the left-over time from 

a previous service activity. 

 

1. In the Navigation Pane, click Service, and then click Service Calendar.  
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2. On the Actions toolbar, click New, and then click Service Activity.  

3. On the Service Activity form, you must enter the following information:  

 Subject  

You must enter a subject. The first 12 characters appear on the Service calendar and the 

calendar in your Workplace.  

 Service  

Locate and select the service you want to schedule. You can select a record from a filtered list 

in the Form Assistant pane, or you can click the Lookup button  to search for other 

records.  

4. You can enter additional information about the service activity.  

 Customers  

If this service activity is for a customer, you can locate and select the account or contact. 

You can select a record from a filtered list in the Form Assistant pane, or you can click 

Lookup to search for other records.  

 Resources  

Locate and select the user, or facility and equipment that you want to schedule. You can 

select a record from a filtered list in the Form Assistant pane, or you can click Lookup to 

search for other records.  

 Location  

You can enter an address or room number where the service activity will occur.  

 Show Time As  

If you want to change the initial status of the service activity, select a status from the list. If 

you select any of the statuses under Scheduled, that block of time on the schedule is set so 

that another service activity or appointment cannot conflict with it during automatic 

scheduling. Forced service activities and appointments might conflict.  

 Site  

Locate and select the site for the service activity. Sites are defined in Microsoft Dynamics 

CRM and assigned to resources. Only resources from the same site will be selected. To 

record the specific room or address of the service activity, enter information in the Location 

box. You can select a record from a filtered list in the Form Assistant pane, or you can click 

Lookup to search for other records.  

5. Under Scheduling Information, you must enter the Start Time and End Time, but the other 

information is optional.  

 Start Time and End Time  

Select or type in the date and times the service activity starts and ends. The Duration box is 

updated to the length of the service activity. If you select a different duration, the End Time 

is adjusted. If you type in both the start and end times, the duration will change.  

If this is an all-day event, click All Day Event. An all-day event is actually the entire working 

day of the selected resource. If the resource works 8 a.m. to noon, then an all-day event is 

four hours.  

 Duration  

You can add additional time to the end of a time slot by changing the duration. The 

maximum duration of an activity is 10 days. The default duration is determined by the 

selected service.  

 Notes  

You can add additional information about the customer and service activity in this area. For 
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example, you could enter the symptoms of a problem, special requests by the customer, or 

any messages to pass on to the resources providing the service.  

6. On the Details tab, you can select and locate a record in the Regarding box to link to this service 

activity. You can also set a Priority for the service activity, and record a Category and Sub-

Category.  

7. Click Save or Save and Close.  

The service activity appears as a color block on the Service calendar, as well as on the calendar in 

the Workplace and Activities areas.  

Tip 

You can record a customer's preferences for a specific time, day, service, facility, equipment, and customer service 

representative in the customer record on the Administration tab. As you are scheduling a service activity, the 

customer's preference is displayed in the Form Assistant pane.  

Notes 

 If at any time before you save this service activity, you want to search the schedule for an available 

time, you can click Schedule on the Actions toolbar to open the Schedule Service Activity dialog 

box.  

 Check the schedule for schedule conflicts  

Close or cancel a service activity  

 Can I do this task?  

This task requires permissions that are found in all default service scheduling security roles. More 
information about specific permissions and performing this task while offline: Service Scheduling 
Permissions  

You cannot reopen closed service activities.  

 

1. In the Navigation Pane, click Service, and then click Service Calendar.  

2. Locate and open the service activity you want to close.  

3. On the Actions  menu, click Close Service Activity.  

4. In the Service Activity Close Confirmation dialog box, in the Status list, do one of the following:  

 If the service activity is completed and can be billed, select Completed.  

 If the service activity will not be completed and cannot be billed, click Canceled.  

 If the customer never arrived and the service activity cannot be billed, select No Show.  

5. Click OK.  

6. On the Standard toolbar, click Close.  

The service activity appears in the Service calendar, color-coded with its current status and the 

subject of the service activity.  

Note 
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To reactivate canceled service activities, on the Actions menu, click Reactivate. The service activity will be reopened 

and the status will be updated to Requested. If the time is no longer available, you may get a message. To reschedule 

the service activity for an available time, click Schedule. 

Reschedule a service activity  

 Can I do this task?  

This task requires permissions that are found in all default service scheduling security roles. More 
information about specific permissions and performing this task while offline: Service Scheduling 
Permissions  

 

 

1. In the Navigation Pane, click Service, and then click Service Calendar.  

2. Locate and select the service activity you want to reschedule.  

3. On the Actions toolbar, click Reschedule.  

4. On the Schedule Service Activity form, change any of the information you want.  

5. Click Find Available Times.  

Microsoft Dynamics CRM returns a list of available time slots that meet the criteria on the form. If 

you do not find a suitable time slot, change the criteria, and try again.  

6. In the Available Times list, select a time slot.  

7. Click Schedule.  

8. Click Save or Save and Close.  

Note 

You cannot reopen closed service activities. To reactivate canceled service activities, on the Actions  menu, click 

Reactivate. The service activity will be reopened and the status will be updated to Requested. If the time is no longer 

available, you may get a message. To reschedule the service activity for an available time, click Schedule. 

Work with Appointments 

Use this form to create, edit, or reschedule an appointment for an account, contact, facility/equipment, lead, or user. 

After you save this form, you can add attachments, check for duplicates, and convert this appointment to an 

opportunity or case.  

Create or edit an appointment  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Common Task Permissions  

You can modify any of the information in an open appointment. If you change the date and times of the appointment, 
Microsoft Dynamics CRM will recheck for schedule conflicts. You cannot create a recurring appointment. The calendar 
displays canceled and completed appointments and service activities. To remove an appointment or service activity 
from the calendar, delete the record.  

 

1. Create an appointment in:  

 Calendar in Workplace  
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a. In the Navigation Pane, click Workplace, and then under My Work click Calendar.  

b. Under Create a New, click Appointment.  

 Service Calendar  

a. In the Navigation Pane, click Service, and then click Service Calendar.  

b. On the Actions toolbar, click New, and then click Appointment.  

 Activities area  

a. In the Navigation Pane, click Workplace, and then under My Work click Activities.  

b. On the Actions toolbar, click New.  

c. In the New Activity dialog box, click Appointment, and then click OK.  

4. In the Appointment dialog box, on the Appointment tab, you must enter information in the 

following fields:  

 Subject  

Enter a description of the appointment. The first 12 characters appear in the Workplace 

calendar and Service calendar.  

 Start Time  

Enter the date and time that the appointment begins.  

 End Time  

Enter the date and time that the appointment ends. Microsoft Dynamics CRM automatically 

sets the appointment for a duration of 30 minutes starting on the next half hour.  

 Required  

To locate and select participants that must attend this appointment, click the box next to the 

label. You can select a record from a filtered list in the Form Assistant pane, or you can click 

the Lookup button  to search for other records.  

Participants are not sent notification of new or updated appointments. In Microsoft Dynamics 

CRM for Outlook you can include recipients that are not contacts in Microsoft Dynamics CRM. 

The names are displayed as red text. Click the red name to resolve it to an existing contact or 

account, or create a new record.  

 Add optional information.  

 To add Optional participants, click Lookup to search for records.  

 In the Location box, enter the room or address where the appointment will occur. 

 In the Show Time As list, select how you want the appointment to appear on your 

calendar. If you select Free or Tentative, other appointments and service activities can be 

scheduled during that time. 

 In the Duration box, record the time you spend on the activity. If this activity is related to a 

case and the case is linked to a contract line, the durations of all the activities for this case 

are tallied and updated automatically in the related active contract. The total, which includes 

the totals from any other cases relating to that contract, can be adjusted manually before 

billing the customer. The maximum duration of an appointment or service activity is 10 days.  
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 Click All Day Event if this event is for the entire time you are working. The appointment's 

duration will be the same as your working hours. For example, if your working hours are 9 

a.m. to 6 p.m., then the duration of your appointment is 9 hours, but will display as "1 day".  

 On the Notes tab, click Click here to enter a new note, and add the information that 

applies to your record.  

 On the Details tab, you can link the appointment to another Microsoft Dynamics CRM record 

and change the Organizer. If your business uses Category and Sub-Category to organize your 

business data, enter them on this tab.  

 Click Save or Save and Close.  

If one or more of the participants (including you as the originator) have a service activity or 

appointment during this time, a warning appears. You can click Ignore and Save to save the 

appointment anyway.  

The new appointment appears in the calendar and list of activities for the participants. If the owner 

is not a participant, the activity will not appear in his or her calendar.  

Notes 

 Appointments created in the Web application and synchronized with Microsoft Dynamics CRM for 

Outlook automatically set a 15-minute reminder and appear in the Outlook calendar. You can 

change the reminder in Outlook.  

 To re-open a canceled appointment, on the Actions  menu, click Reactivate.  

Close an activity  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Common Task Permissions  

 Activity types that can be closed  

 Tasks  

 Faxes  

 Phone Calls  

 Letters  

 Appointments  

 Service Activities  

 Campaign Activities  

Unless you have created an activity record by mistake, it is better to close or convert an activity than to delete it. 

You can view closed or converted activities at a later date for reference, or run reports to determine the success 

rate of your activities.  

 

1. Navigate to activity records. In the Navigation Pane, click Workplace, and then under My Work click 

Activities.  
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– OR –  

To work with activities associated with a record, open the record and then click Activities.  

2. Open the activity that you want.  

3. On the Actions  menu, click Close activity type. For example, if you are in a task record, click 

Close Task.  

4. In the confirmation dialog box, select the status that you want from the Status list, such as 

Completed or Canceled, and then click OK.  

Notes 

 When you close an activity, the activity becomes read-only and cannot be edited or reopened.  

 To view closed activities, do one of the following:  

o In the Activities list, select the Closed Activities view.  

o Use Advanced Find, and specify Activity Status in the search criteria.  

o From an Account, Contact, Lead, or Opportunity record, under Details, click History. In the 

Filter on and Include lists, select the view options that you want.  

 It is not possible to close multiple activities at once.  

 The only way to close an e-mail activity is to send it. If you do not use Microsoft Dynamics CRM to 

send or receive e-mail, click Send. This will close the activity, but no e-mail message will be sent.  

Convert an activity to a case  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Common Task Permissions  

 

 

1. Navigate to activity records. In the Navigation Pane, click Workplace, and then under My Work click 

Activities.  

– OR –  

To work with activities associated with a record, open the record and then click Activities.  

2. Open the activity that you want.  

 Activity types that can be converted  

 Faxes  

 Phone Calls  

 E-mail Messages  

 Letters  

 Appointments  
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3. On the Actions toolbar, point to Convert Activity and then to Case.  

4. In the Convert Activity to Case dialog box, enter information in the following boxes:  

 Customer 

You must click the Lookup button  to select or create a new customer.  

 By default, Microsoft Dynamics CRM automatically completes the following operations during 

the conversion:  

o Close the activity as completed.  

o Open the new case after the conversion.  

To change the conversion operations, clear the associated check boxes.  

5. In the Convert Activity to Case dialog box, click OK.  

Note 

The originating activity becomes a related activity for the new case. If the activity is open, it appears in the Activities 

list for the case. If the activity is closed, it appears in the History list.  
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Providing Customer Service with Contracts and Cases 

Creating Contracts 

Contracts record service level agreements (SLAs) and entitlements. You can create contracts for existing customers that 

specify the type of service and terms that apply to each customer. This information includes the duration of the 

contract, how many case incidents or minutes of service purchased, what hours and days of the week coverage is 

available, and the service entitlements. The contracts can also include the notes for that entitlement, to record 

additional details such as the response time; preventive maintenance plans; which products or parts of the product are 

covered; and service details such as the type of service and billing for labor, parts, and other expenses. 

Creating a Contract 

New contracts are created based on contract templates, which pre-define some information, such as allotment types. 

You can create contracts only for existing accounts and contacts. A contract has the status of draft until it is invoiced. 

You can change the contract template until the contract status changes. Each new contract is assigned a unique ID that 

cannot be used for another contract unless it is being renewed. When you renew a contract, it is saved as a draft with 

an ID that corresponds to the original contract. If a contract with a status of Invoiced or Active is modified, the 

amended contract remains associated with the original account. 

More information: Work with Contract Templates and Work with Contracts 

You can record specific service level agreements, such as pricing and how the support is allocated, as contract lines. For 

example, you can note whether the service agreement is limited by the number of cases opened, or by the total 

number of minutes of customer service allowed. You cannot invoice a contract unless it has at least one contract line. 

Contract lines also let you track how much of a service allotment has been used. 

You can add notes and attachments to contracts, and set rules to run based on the contract status, contract start date, 

or contract end date. For example, you could set a workflow rule to create a task to review the contract when the 

contract end date is reached.  

Invoicing and Activating a Contract 

After a contract has at least one contract line and a billable address, you can mark the contract as invoiced. When you 

change the status, it implies that you have accepted the contract. Microsoft Dynamics CRM does not automatically 

invoice the customer or create an invoice record unless your business has integrated Microsoft Dynamics CRM with a 

Microsoft BackOffice product. The contract status is Invoiced until the start date has passed, and then the status 

changes to Active. You cannot delete a contract with the Invoiced or Active status.  

Viewing Contracts 

By default, the Customer Service Representative (CSR) security role grants all CSRs the permissions required to retrieve 

contracts and view their details. 

Verifying Entitlements for a Case by Viewing a Contract 

When a CSR opens a case, he or she can look up a customer's contract and determine the appropriate level of support. 

The CSR can associate a case to a specific contract and contract line. The amount of support allotment used is recorded 

automatically in the contract, however, the CSR can manually change it. 

Putting a Contract on Hold or Canceling a Contract 

A contract is Active and CSRs can open cases against it until the date the contract ends unless the contract is put on 

hold or canceled. 

If you want to suspend or deactivate a contract for an indefinite period of time, you can put it on hold. You cannot 

open cases or log an activity against a contract. If the contract end date passes while the contract is set on hold and 

then the contract is reactivated, the contract status changes to Expired. 

Haghighat Sabet
Highlight

Haghighat Sabet
Highlight

Haghighat Sabet
Highlight

Haghighat Sabet
Highlight

Haghighat Sabet
Highlight

Haghighat Sabet
Highlight

Haghighat Sabet
Highlight

Haghighat Sabet
Highlight

Haghighat Sabet
Highlight

Haghighat Sabet
Highlight



 

386 Microsoft Dynamics CRM 4.0 User’s Guide 
 

After a contract has been canceled, it cannot be reopened or renewed.  

Renewing a Contract 

After the end date of the contract has passed, the contract is expired and cases cannot be opened against it. To open a 

new case against the contract, renew the contract. When you renew a contract, a draft copy of the contract is created 

with the same ID number as the original, expired contract. You can make modifications to the new draft contract, 

including adding or modifying contract lines. You also have the option of including contract lines that were canceled 

from the original contract. When the original contract expires, you can invoice and activate the renewed contract. 

A renewed contract has the same ID number as the original contract, with the renewal action reflected in the contract's 

history. The start date is automatically set to the day after the existing contract expires, and for the same duration as 

the original contract. However, you can manually change the duration. 

Work with Contracts 

After you save a contract record, you can add contract lines, activities, attachments, and cases. 

Create or edit a contract  

 Can I do this task?  

This task requires permissions that are found in all default service security roles. More information about 
specific permissions and performing this task while offline: Service Permissions  

You can edit an existing draft contract, but not invoiced or active contracts.  

Note: Although it is possible, creating a contract from an account is not recommended. The contract does not 

associate to the account correctly and allotments are not recorded. 

 

1. In the Navigation Pane, click Service, and then click Contracts.  

2. Use one of the following procedures:  

 Start a contract from a template 

The contract template determines the the allotment type (minutes or cases), billing frequency, discounts, 

and the day and times service is available; however, with the exception of allotment type, this information 

can be changed in the contract.  

a. On the Actions toolbar, click New.  

b. In the Template Explorer dialog box, select the template you want to use, and then click OK.  

c. In the contract form, in the Contract Name box, type a unique name for the contract.  

For example, Adventureworks - technical support for wireless network.  

 Start a new contract by copying an existing contract 

Microsoft Dynamics CRM creates a copy of the contract with a unique ID number. Any changes you make to 

this copy do not affect the original contract.  

a. From the list, open the contract you want to copy.  
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b. In the Contract form, on the Actions  menu, click Copy Contract.  

c. In the Copy Contract dialog box, clear Include canceled contract lines unless you want to 

keep them, and then click OK.  

In the original contract, contract lines were canceled when they expired or the allotment is 

exceeded. If you want to reuse the contract lines, do not clear the check box.  

4. On the General tab, you must enter information in the following boxes:  

 Customer 

Select the customer who this contract covers. You can select a record from a filtered list in 

the Form Assistant pane, or you can click the Lookup button  to search for other 

records.  

 Contract Start Date 

 Contract End Date 

When the contract is saved, the Contract ID is automatically assigned by Microsoft Dynamics CRM 

and the Duration in Days is calculated by Microsoft Dynamics CRM based on the contract start and 

end dates. A contract address is required to change the status of the contract to invoiced. 

In the Billing Information area, the fields are completed automatically by Microsoft Dynamics CRM 

when the corresponding Heading area fields are entered; however, you can change or enter the 

information as required. Bill To Address is required to change the status of the contract to 

invoiced. 

In the Pricing area, the amounts are read-only, and are calculated based on the pricing and 

discounts entered in the contract lines. To change the pricing, update the contract lines. To 

recalculate the amounts, on the Actions toolbar, click Recalculate.  

 On the Details tab, enter additional information about the contract.  

In the Contract Type area, you can change the discount and service level. Discounts for contract 

lines are given the same discount type that you select here. Service levels are defined by your 

business's guidelines.  

In the History area, the following fields are automatically completed when the contract was created.  

 Originating Contract 

The contract that the current contract was copied from. This field cannot be changed.  

 Owner 

This box is filled automatically with the name of the user who is creating the record. You can 

click the Lookup button  to search for other records.  

 Contract Template 

You can change the contract template, if the contract status is draft.  

 On the Notes tab, click Click here to enter a new note, and add the information that 

applies to your record.  

 Click Save or Save and Close.  

After the contract is invoiced, the contract becomes active when the start date is reached.  

 Resolve potential duplicate records.  
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0. If the system detects that your record might be a potential duplicate, instead of saving the 

record, you'll see the Duplicates Detected dialog box.  

1. To open a record to make sure it is a potential duplicate, in the Potential duplicate records 

list, double-click the record.  

 If the duplicate-detection rule identified potential duplicate records in other record 

types, review records from each record type listed.  

2. If your new or updated record is not a duplicate, to create the new record, click Save Record.  

– OR –  

If your new or updated record is a duplicate, to cancel your changes, click Cancel.  

Notes  

 If you enter a duplicate record within a few minutes of entering the first record, Microsoft 

Dynamics CRM will not detect the duplicate record. The matchcodes for new and updated 

records are created every five minutes, rather than as a record is created.  

Duplicate detection can take place only if duplicate detection is enabled in Duplicate Detection Settings 
and if at least one duplicate-detection rule exists for the record type. More information: Avoiding Duplicate 
Records  

Notes 

 You must define at least one contract line for the contract before you can change the status of the 

contract to invoiced. You can define several contract lines for each contract; for example, one for 

parts and another for maintenance. You cannot delete a contract line once it is active; instead, you 

can cancel it.  

 The default days and hours of service are defined in the contract template. To change the days and 

hours of service, on the Actions toolbar, click Calendar.  

 You cannot edit an active contract, but you can cancel it or put it on hold. A canceled contract can be 

renewed and then edited. When a contract is on hold, no cases can be opened against the contract. 

For example, you might choose to put a contract on hold if there is an invoicing dispute, and then 

release the contract when the dispute is resolved. On the Actions  menu, click Hold Contract 

or Release Hold. To view a list of contracts on hold, in the View list, click Contracts On Hold.  

Add or edit a contract line  

 Can I do this task?  

This task requires a manager, vice president, CEO-Business Manager, System Administrator, or 
System Customizer security role or equivalent permissions. More information about specific 
permissions and performing this task while offline: Configuration Permissions  

Adding contract lines to a contract is the second step in creating and invoicing a contract. Contract lines also 
include specific dates, the product covered, and how many cases or total minutes of allotted support are provided, 
for example, 15 cases or 100 minutes. You can define several contract lines for each contract, for example, one 
for parts and another for maintenance. The contract line also tracks the amount of the allotment that has been 
used.  

 

1. In the Navigation Pane, click Service, and then click Contracts.  

2. In the contract list, open the service contract to which you want to add a contract line.  
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3. Under Details, click Contract Lines.  

4. On the Actions toolbar, click New Contract Line.  

5. On the General tab, you must enter information in the following fields:  

 Title 

This information should be a descriptive of the contents of the contract line. For example, if 

this line is for a specific product, include the name in the title.  

 Start Date 

 End Date 

 The Start Date and End Date for the line are completed automatically by Microsoft 

Dynamics CRM based on the contract dates; however, you can change the dates as needed.  

 To locate and select a product, click the box. You can click the Lookup button  to search 

for other records.  

 To enter a unit, quanity, or location, click the correct box and either locate and select the 

information or enter it. You can select a record from a filtered list in the Form Assistant pane, 

or you can click the Lookup button  to search for other records.  

 In the Allotment Details area, in the Total Cases/Minutes box, type the total case or 

minute allotment.  

The contract template determines the type of allotment (cases or minutes). As cases are 

opened against this contract, the allotments used are displayed in the Allotments Used box.  

 In the Pricing area, enter pricing information. Do not type a currency symbol or decimal.  

 Total Price 

You must enter the total price for this contract line.  

 If you enter a discount, the amount must either be less than the total price, or less than 

100%.  

6. On the Administration tab, you can change the customer and enter the serial number of a product. 

Microsoft Dynamics CRM automatically fills in the Customer box based on the contract's customer. 

However, you can change it if needed.  

7. On the Notes tab, click Click here to enter a new note, and add the information that applies to 

your record.  

8. Click Save or Save and Close.  

Notes 

 If cases have been opened against this contract, Microsoft Dynamics CRM tracks how much of the 

allotted support has been used in the Allotment Details area. You can change the Total 

Cases/Minutes to increase or decrease the allotment.  

 You can cancel a contract line only when it is set to Active. When the contract is set to draft, you must 

delete contract lines. After a contract line is closed, cases cannot be opened against the contract. 

The advantage of canceling a contract line instead of deleting it is that if you renew this contract or 

create a new contract based on this contract, you can reuse the contract lines. On the Actions  

menu, click Cancel Contract Line. 

In the Cancel Contract dialog box, in the Cancellation Date box, enter the date you want to 

cancel the contract line, and then click OK.  
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Invoice and activate a contract  

 Can I do this task?  

This task requires permissions that are found in all default service security roles. More information 
about specific permissions and performing this task while offline: Service Permissions  

Microsoft Dynamics CRM does not automatically invoice the customer or create an actual invoice unless your 

business has integrated Microsoft Dynamics CRM with a Microsoft BackOffice product. The invoice record displays 

information about the invoice, not the invoice itself. 

When a contract is marked as invoiced, the status changes to Invoiced until the start date. Then, the status 

changes to Active. 

 

1. In the Navigation Pane, click Service, and then click Contracts.  

2. In the contract list, open the service contract you want to invoice.  

3. On the Actions  menu, click Invoice Contract. 

The status is listed in the Status column in the contract list. The invoice record is displayed in the 

Invoice list.  

Note 

After a contract is marked as invoiced, you cannot delete the contract or change any contract information, such as the 

dates, contract names, or the contract ID. You can add new contract lines and cancel existing contract lines. 

Cancel or delete a contract  

 Can I do this task?  

This task requires a manager, vice president, CEO-Business Manager, System Administrator, or 
System Customizer security role or equivalent permissions. More information about specific 
permissions and performing this task while offline: Configuration Permissions  

 

 

You can cancel an active contract or invoiced contract, or delete a draft contract. You cannot delete an invoiced 
contract, even if it has been canceled.  

 

1. In the Navigation Pane, click Service, and then click Contracts.  

2. From the list, open the service contract you want to cancel or delete.  

3. To cancel a contract, on the Actions  menu, click Cancel Contract. In the Cancel Contract 

dialog box, type the cancellation date, and then click OK.  

You can view canceled contracts in the Canceled Contracts view.  

4. To delete a contract, on the Actions  menu, click Delete Contract, and then click OK.  

Note 

If you want to temporarily cancel a contract, you can put the contract "on hold." When a contract is on hold, no cases 

can be opened against the contract. For example, you might choose to put a contract on hold if there is an invoicing 

dispute, and then release the contract when the dispute is resolved. On the Actions  menu, click Hold Contract or 

Release Hold. To view a list of contracts on hold, in the View list, click Contracts On Hold.  
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Renew a contract  

 Can I do this task?  

This task requires permissions that are found in all default service security roles. More information 
about specific permissions and performing this task while offline: Service Permissions  

You can renew any invoiced contracts, including those that have expired. You can work in unexpired contracts as 

drafts, but they cannot be renewed until they expire. Renewed contracts have the same contract ID as the 

expired contract. 

 

1. In the Navigation Pane, click Service, and then click Contracts.  

2. In the View list, click Expired Contracts.  

3. In the list of contracts, open the expired or invoiced contract you want to renew.  

4. In the contract form, on the Actions  menu, click Renew Contract.  

5. If you do not want to include canceled contract lines, in the Renew Contract dialog box, clear the 

Include canceled contract lines check box, and then click OK.  

6. A copy of the contract is made and the status is set to either Draft for copies of expired contracts or 

Invoiced for copies of invoiced contracts. The start date is set for one day after the existing contract 

expires.  

7. Make any changes that are necessary. If the originating contract has already expired, you will need to 

invoice this contract.  

8. Click Save or Save and Close.  

Work with Contract Lines 

After you save a contract line, you can add cases and workflow jobs.  

Add or edit a contract line  

 Can I do this task?  

This task requires a manager, vice president, CEO-Business Manager, System Administrator, or System 
Customizer security role or equivalent permissions. More information about specific permissions and 
performing this task while offline: Configuration Permissions  

Adding contract lines to a contract is the second step in creating and invoicing a contract. Contract lines also include 
specific dates, the product covered, and how many cases or total minutes of allotted support are provided, for 
example, 15 cases or 100 minutes. You can define several contract lines for each contract, for example, one for parts 
and another for maintenance. The contract line also tracks the amount of the allotment that has been used.  

 

1. In the Navigation Pane, click Service, and then click Contracts.  

2. In the contract list, open the service contract to which you want to add a contract line.  

3. Under Details, click Contract Lines.  

4. On the Actions toolbar, click New Contract Line.  

5. On the General tab, you must enter information in the following fields:  
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 Title 

This information should be a descriptive of the contents of the contract line. For example, if 

this line is for a specific product, include the name in the title.  

 Start Date 

 End Date 

 The Start Date and End Date for the line are completed automatically by Microsoft 

Dynamics CRM based on the contract dates; however, you can change the dates as needed.  

 To locate and select a product, click the box. You can click the Lookup button  to search 

for other records.  

 To enter a unit, quanity, or location, click the correct box and either locate and select the 

information or enter it. You can select a record from a filtered list in the Form Assistant pane, 

or you can click the Lookup button  to search for other records.  

 In the Allotment Details area, in the Total Cases/Minutes box, type the total case or 

minute allotment.  

The contract template determines the type of allotment (cases or minutes). As cases are 

opened against this contract, the allotments used are displayed in the Allotments Used box.  

 In the Pricing area, enter pricing information. Do not type a currency symbol or decimal.  

 Total Price 

You must enter the total price for this contract line.  

 If you enter a discount, the amount must either be less than the total price, or less than 

100%.  

6. On the Administration tab, you can change the customer and enter the serial number of a product. 

Microsoft Dynamics CRM automatically fills in the Customer box based on the contract's customer. 

However, you can change it if needed.  

7. On the Notes tab, click Click here to enter a new note, and add the information that applies to 

your record.  

8. Click Save or Save and Close.  

Notes 

 If cases have been opened against this contract, Microsoft Dynamics CRM tracks how much of the 

allotted support has been used in the Allotment Details area. You can change the Total 

Cases/Minutes to increase or decrease the allotment.  

 You can cancel a contract line only when it is set to Active. When the contract is set to draft, you must 

delete contract lines. After a contract line is closed, cases cannot be opened against the contract. 

The advantage of canceling a contract line instead of deleting it is that if you renew this contract or 

create a new contract based on this contract, you can reuse the contract lines. On the Actions  

menu, click Cancel Contract Line. 

In the Cancel Contract dialog box, in the Cancellation Date box, enter the date you want to 

cancel the contract line, and then click OK.  

Supporting Customer Service with Microsoft Dynamics CRM 

Microsoft Dynamics CRM includes a set of features that work together to help you track and record your customer 

service activities.  
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Recording Entitlements Through Contracts 

A contract and its specific contract lines record the details of the customer service to be provided to an account, 

including the number of calls allowed or the total number of minutes that can be spent with them.  

To increase consistency and efficiency when you create contracts, you can create a contract template that can be 

shared. You can associate cases with a specific contract or contract line in a contract. Allotment types in contracts keep 

track of either the number of cases opened against a contract or the total number of minutes spent working with cases 

for a contract. More information: Creating Contracts  

Tracking Customer Service Through Cases 

When a customer contacts your organization by telephone, letter, or e-mail, a Customer Service Representative (CSR) 

opens a case and enters information about the customer and the customer's issue. The CSR can review the contract 

lines in the customer's contract to determine the appropriate entitlement. If the person who opens the case is not the 

one to resolve it, the case can be either assigned to a queue or to another CSR. That CSR researches the problem, logs 

the activity and the time spent on the case, and then resolves and closes it. More information: Creating Contract 

Templates  

By logging activities and time spent on a case, a manager can track performance and productivity. Open and resolved 

cases can be searched, and resolved cases can be reopened so that additional activities and time can be logged against 

them, if necessary. More information: Using Queues to Manage Your Activities and Cases 

Queuing and Routing Services 

You can create queues to sort incoming cases according to subject-matter expertise, product teams, or other business 

designations to ensure that a CSR with the right experience gets each case. You can also assign cases directly to 

specific CSRs. More information: Creating Queues for Incoming Cases  

Sharing Information in the Knowledge Base 

CSRs can share information, including common issues and the approved fixes, product sheets, and updates, in the form 

of searchable articles stored in the knowledge base. CSRs can search for articles by title, keyword, full-text search, or 

article number. After a CSR finds the right article, the CSR can e-mail the article directly to the customer and store it 

with the case for review later. More information: Publishing Articles in the Knowledge Base 

Scheduling Services 

With scheduling, you can provide a service to your customers and ensure that the right combination of personnel, 

facilities, and equipment are available to perform the service. You can also track a customer's preferences for time of 

day, service, and personnel. More information: Defining Rules and Resources for Services 

Managing Performance and Productivity through Reports 

Reports are an efficient way to stay informed of customer service performance in your organization. The information 

tracked during case handling can be turned into reports that measure statistics, such as call length, number of cases 

handled, number of cases resolved, and types of resolutions. With this information, you can create more precise 

schedules, forecast resource needs, and manage performance improvements. More information: Default Service 

Reports 

Work with Cases 

After you save a case, you can add an activity, an attachment, or a system job.  

As the first step of resolving a case, you can view the total amount of time spent on that case. You can view this 

information without actually resolving the case. 
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Create or edit a case  

 Can I do this task?  

This task requires permissions that are found in all default service security roles. More information about 
specific permissions and performing this task while offline: Service Permissions  

 

 

1. In the Navigation Pane, click Service, and then click Cases.  

2. On the Actions toolbar, click New.  

3. On the General tab, you must enter information in the following boxes:  

 Title 

This information should include a general description of the problem. For example, if a 

customer calls about a problem with a late delivery, include the expected delivery date.  

 Customer 

To locate and select a customer, click the box beside the label. You can select a record from a 

filtered list in the Form Assistant pane, or you can click the Lookup button  to search for 

other records.  

 Subject 

Selecting a subject for the case associates that case with similar cases. This is useful for 

searching for cases with similar problems and for finding related articles. To locate and select 

a subject, click the box beside the label and use the Form Assistant pane. If the subject you 

want does not appear in the list, contact your system administrator to add it. More 

information: Requesting User Interface Changes  

 In the Overview area, enter all of the information you have about this case. This information 

can be used in reports. In the Assignment Information area, enter information about how 

you want the case managed.  

 Owner 

This box is filled automatically with the name of the user who is creating the record. You can 

click the Lookup button  to search for other records.  

 In the Contract and Product Information area, enter information about the entitlements. 

Linking the contract and contract line to the case allows you to track allotment usage and 

verify that the customer is receiving the appropriate level of service.  

4. On the Notes and Article tab, enter additional information about the case.  

 Notes 

Click to enter a longer description of the issue, or any additional information that you want to 

record about this case.  

 Knowledge Base Article area 

Locate and select an article about the issue. The Form Assistant pane displays a list of 

suggested articles based on the selected subject.  

 Show article 

Select this check box to view the article in the case.  

5. Click Save or Save and Close.  
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 Resolve potential duplicate records.  

1. If the system detects that your record might be a potential duplicate, instead of saving the 

record, you'll see the Duplicates Detected dialog box.  

2. To open a record to make sure it is a potential duplicate, in the Potential duplicate records 

list, double-click the record.  

 If the duplicate-detection rule identified potential duplicate records in other record 

types, review records from each record type listed.  

3. If your new or updated record is not a duplicate, to create the new record, click Save Record.  

– OR –  

If your new or updated record is a duplicate, to cancel your changes, click Cancel.  

Notes  

 If you enter a duplicate record within a few minutes of entering the first record, Microsoft 

Dynamics CRM will not detect the duplicate record. The matchcodes for new and updated 

records are created every five minutes, rather than as a record is created.  

Duplicate detection can take place only if duplicate detection is enabled in Duplicate Detection Settings 
and if at least one duplicate-detection rule exists for the record type. More information: Avoiding Duplicate 
Records  

Notes 

 The first time you save the case, Microsoft Dynamics CRM assigns it a unique case number.  

 When you complete an activity, be sure to record the amount of time you spend on the activity in the 

Duration box. If this case is linked to a contract line, the durations of all of the activities for this 

case are tallied and updated automatically in the related active contract. The total, which includes 

the totals from any other cases relating to that contract, can be adjusted manually before billing the 

customer.  

Assign a case to a user or queue  

 Can I do this task?  

This task requires permissions that are found in all default service security roles. More information 
about specific permissions and performing this task while offline: Service Permissions  

After a case is created, it can be assigned to another user or to a queue. After accepting a case, the assigned user 

can continue working with the customer. 

 

1. In the Navigation Pane, click Service, and then click Cases.  

2. In the list of cases, select the case you want to assign.  

 Or, select multiple records  

 Select several records by pressing the CTRL key while you click each record.  
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 Select a sequence of records by clicking the first record that you want, and then press the SHIFT 

key while you select the last record that you want.  

 Select all records on the page by selecting the Select/clear all records on this page check box 

at the top of the list.  

By default, the Microsoft Dynamics CRM Web application displays 50 records per page. You can increase 

the number of records displayed and thereby increase the number of records you can select at one time. To 

display up to a maximum of 250 records per page:  

4. On the Tools menu, click Options.  

5. On the General tab, in the Records Per Page list, select the number of records to display 

per page.  

6. Click OK.  

This changes the number of items that is displayed for all lists, which may slow response time when you 

switch record types. Therefore, you might want to set it back to a smaller number when you are done with 

this bulk action.  

 On the Actions toolbar, click the Assign button .  

 In the Assign to Queue or User dialog box, to assign the case to another user or queue, 

select Assign to another user or queue. 

Then to select a record, click the Lookup button .  

 Click OK.  

Note 

After a case is assigned to a queue, it is displayed in the Queues area. If it was assigned to a user, it will appear in his 

or her Assigned area. An assigned case belongs to the user who created it until it is accepted by another user.  

Resolve a case  

 Can I do this task?  

This task requires permissions that are found in all default service security roles. More information 
about specific permissions and performing this task while offline: Service Permissions  

When a problem has been solved or addressed to the customer's satisfaction, you can resolve the case and record 

the resolution and the amount of time to be billed to the customer.  

Before a case can be resolved, all of its activities must be closed. If the case is linked to a contract line, it must be 

active and have sufficient allotments to resolve the case. You can only resolve cases one at a time. 

 

1. Navigate to the list of cases. In the Navigation Pane, click Service, and then click Cases.  

– OR –  

In the Navigation Pane, click Workplace, and then under My Work, click Queues. Then, under 

My Work, click In Progress.  

2. In the list of cases, open the one you want to resolve.  
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3. On the Actions  menu, click Resolve Case.  

If there are any open activities for this case, you have to close them first.  

4. In the Resolve Case dialog box, in the Resolution Type list, select how the case was resolved.  

5. In the Resolution box, type a short explanation of the resolution.  

6. The actual time spent on all activities, as recorded in the Duration box in each activity, for this case 

is filled out automatically in the Total Time box.  

This total is for information only and cannot be edited.  

7. In the Billable Time list, select the amount of time spent on the case to be billed to the customer. 

If this case is linked to a contract, the billable time will be subtracted from the allotted minutes for 

that contract.  

8. Type a longer description of the resolution and any other notes in the Description box.  

9. Click OK. The form closes.  

10. On the Standard toolbar, click Close.  

Notes 

 A Case Resolution activity is created in the History area.  

 Resolved cases appear in the Resolved Cases view. A case can be reactivated at any time. It will be 

reassigned automatically to the customer service representative (CSR) who resolved it.  

Reactivate a case  

 Can I do this task?  

This task requires permissions that are found in all default service security roles. More information 
about specific permissions and performing this task while offline: Service Permissions  

If a case was resolved but additional actions are required, you can reactivate it and modify it as needed. The case 

is reassigned to the customer service representative (CSR) that owned the case when it was closed. The benefit 

of reactivating the case is that you do not have to re-enter any data. In addition, you maintain the original history 

of the case. 

 

1. In the Navigation Pane, click Service, and then click Cases.  

2. In the View list, click My Resolved Cases or Resolved Cases.  

3. In the list of cases, open the one you want to reactivate.  

4. On the Actions  menu, click Reactivate.  

5. In the Reactivate the Selected Case dialog box, click OK.  

6. Modify the information on the form or add any activities you want.  

More information: Work with Activities 

7. Click Save or Save and Close.  

Notes 
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 Reactivated cases appear in the Active Cases view and the My Active Cases view of the CSR who 

owns the case.  

 A new activity is not created, but the Case Resolution activity is canceled.  

Send an article from a case  

 Can I do this task?  

This task requires permissions that are found in all default service security roles. More information 
about specific permissions and performing this task while offline: Service Permissions  

 

 

1. In the Navigation Pane, click Service, and then click Cases.  

2. In the View list, select the filtered view you want.  

3. In the list of cases, open the case you want to view.  

4. On the Notes and Article tab, click the Article box and search for the article. You can select a 

record from a filtered list in the Form Assistant pane, or you can click the Lookup button  to 

search for other records.  

5. Select the Show article check box. 

The article appears, along with a task bar that includes Show Comments and E-mail KB Article 

commands.  

6. Click E-mail KB Article.  

The E-mail form opens with all the information about this case already filled in.  

7. Make any changes to the e-mail you want; however, any changes you make to the article will not be 

saved in the original article.  

8. To send the e-mail, click Send.  

If you are offline, you will need to go online to send the e-mail.  

9. Click Save or Save and Close.  

This saves or saves and closes the e-mail message. The e-mail message appears as an activity for 

the case.  

10. Click Save or Save and Close.  

This saves or saves and closes the case form.  
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Chapter 5: Microsoft Dynamics CRM for Outlook 

 

This chapter explains the use of the Outlook Client in Microsoft Dynamics CRM. 
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Records and Activities in Outlook 

Doing CRM Work in Outlook 

Microsoft Dynamics CRM for Microsoft Office Outlook is an add-in for Microsoft Dynamics CRM that is installed on your 

desktop or laptop computer. Microsoft Dynamics CRM for Outlook brings Microsoft Dynamics CRM into your everyday 

Microsoft Office Outlook experience because the Microsoft Dynamics CRM areas appear as sub-folders in the Outlook 

mail folders.  

You can perform most of the same sales, marketing, and customer services in Microsoft Dynamics CRM for Microsoft 

Office Outlook that you can in Microsoft Dynamics CRM, including working with accounts, contacts, and campaigns. The 

Microsoft Dynamics CRM address book gives you access to all the e-mail addresses for your Microsoft Dynamics CRM 

customers.  

For day-to-day work, you can use Microsoft Dynamics CRM for Outlook, but not all Microsoft Dynamics CRM features 

are available if you are working offline.  

More information: Working Offline  

Similarities in Working in Microsoft Dynamics CRM for Outlook and Microsoft 

Office Outlook 

Microsoft Dynamics CRM for Outlook automatically starts when Outlook is opened. An icon in the Windows notification 

area displays the current status: Online, Offline, or Disabled. To view a list of records, click the folder for that record 

type. The preview pane displays the list. If you have an older version of Outlook, you may have to expand folders to 

find the Microsoft Dynamics CRM folders. 

Microsoft Dynamics CRM appointments and service activities appear in the Outlook calendar and, in addition, task 

activities (tasks, faxes, phone calls, and letters), can have reminders.  

Differences between Working in Microsoft Dynamics CRM for Outlook and 

Outlook 

Because Microsoft Dynamics CRM uses standard Microsoft Internet Explorer controls, some Outlook features are not 

available in Microsoft Dynamics CRM for Outlook.  

Not available in Microsoft Dynamics 

CRM for Outlook  
Work around 

E-mail signatures Use a global e-mail template. 

Full-text editing features  Standard editing controls, such as press ENTER for double-

spaced lines and SHIFT+ENTER for single-spaced lines.  

Attaching files during creation Save an e-mail activity before attaching files. 

Move records by dragging and dropping. None - this causes data loss.  

More information: Using Microsoft Dynamics CRM for 

Outlook - Troubleshooting 
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Reminders After synchronization with Outlook, 15-minute reminders 
are created for appointments and service activities created 
in the Microsoft Dynamics CRM folders or in the Web 
application. 

Microsoft Dynamics CRM Service calendar  You can request that your System Administrator or System 

Customizer add it. 

Working Offline 

If you have installed Microsoft Dynamics CRM for Outlook with Offline Access, you can select a subset of the Microsoft 

Dynamics CRM for Outlook data to take with you offline as local data and on the road. Whenever you go online, your 

local data is synchronized with the server so that changes you have made to your local records when you are working 

offline are synchronized to the Microsoft Dynamics CRM database. 

More information: Synchronizing Information 

There are a few things that you cannot do, and information that you cannot access when you are offline. For example, 

managing settings and users.  

More information: Working Offline 

Synchronizing Outlook, Microsoft Dynamics CRM for Outlook, and Microsoft 

Dynamics CRM 

When you are online, Outlook and Microsoft Dynamics CRM for Outlook are constantly synchronizing updates. While 

you are online, Microsoft Dynamics CRM for Outlook and Microsoft Dynamics CRM synchronize every 15 minutes. Your 

system administrator can set a different time interval for synchronization, and you can set an even more frequent time 

interval. When you go offline, Microsoft Dynamics CRM for Outlook synchronizes automatically with Microsoft Dynamics 

CRM, and then synchronizes again when you come back online. 

While you are offline with Microsoft Dynamics CRM, contacts, tasks, appointments, phone calls, letters, faxes, and 

service anointments, that you create, delete or update in Microsoft Dynamics CRM for Outlook while offline will be 

updated to Outlook, but will not update Microsoft Dynamics CRM until you go back online.  

More information: Synchronizing Information 

Creating Mail-Merge Documents with Microsoft Office Word 

You can use Microsoft Dynamics CRM for Outlook with Microsoft Office Word to create customer-ready documents for 

your Microsoft Dynamics CRM customers that display Microsoft Dynamics CRM data. Using mail merge, you can: 

 Create new templates or use an existing template to generate form letters for yourself or, with the 

appropriate permissions, for the whole organization. 

 Send form letters or form e-mail messages to contacts, accounts, or marketing mailing lists. 

 Resend old letters to new recipients. 

 Create faxes.  

 Create quotes.  

More information: Send Direct E-mail to Customers 

Sharing a Computer with Multiple Users 

If your business has several people sharing the same computer, they each can install Microsoft Dynamics CRM for 

Outlook with their individual credentials. For example, several shift workers at a central office all working on the same 

computer can use Microsoft Dynamics CRM for Outlook and sign in as themselves. When you use a standard version of 
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Microsoft Dynamics CRM for Outlook, you cannot go offline. Regular synchronization with Outlook and Microsoft 

Dynamics CRM still occurs.  

Install Microsoft Dynamics CRM for Outlook 

Microsoft Dynamics CRM for Outlook is an add-in installed on your computer that allows you to work with Microsoft 

Dynamics CRM data in Outlook. After installing the add-in, there are options that must be set.  

More information: Doing CRM Work in Outlook 

Install Microsoft Dynamics CRM for Outlook  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: E-mail Permissions  

Before installing Microsoft Dynamics CRM for Microsoft Office Outlook, read the Installation Chapter included on the 

Download page.  

The Microsoft Dynamics CRM for Microsoft Office Outlook is included on the Microsoft Dynamics CRM Client CD, and 

then installed and run on the Microsoft Dynamics CRM server.  

 

1. Insert the Microsoft Dynamics CRM Client CD, and double-click Setup.exe  

2. On the Microsoft Dynamics CRM Setup screen, click Microsoft Dynamics CRM for Microsoft Office 

Outlook, click and follow the instructions in the Setup wizard.  

Important 

After installing Microsoft Dynamics CRM for Outlook, there are options that need to be set to enable you to send and 

receive e-mail from Outlook for Microsoft Dynamics CRM and to determine what data is synchronized.  

More information: Work with Your User Record and Work Hours, Set Personal Options  

Set address book options in Microsoft Dynamics CRM for Outlook  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Common Task Permissions  

You can select how the address book is managed in Outlook and Microsoft Dynamics CRM for Outlook and how 
often you want to synchronize between applications. This tab is not available in the Web application.  

 

1. Start Outlook. (Microsoft Dynamics CRM for Outlook must be installed.)  

2. On the Microsoft Dynamics CRM menu bar, click Options.  

3. In the Set Personal Options dialog box, on the Address Book tab, you can select how contacts 

and other record types are synchronized, and whether or not e-mail recipients are linked to 

Microsoft Dynamics CRM records.  

4. By default, the Outlook Address Book is synchronized with the Microsoft Dynamics CRM address book 

every 24 hours. If your organization permits it, you can change this interval. To change this interval, 

change the number between 1 and 60. Your administrator sets the minimum time allowed between 

synchronization.  
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5. To save your changes and close the dialog box, click OK.  

Note 

If you want to synchronize your address book manually, synchronize Microsoft Dynamics CRM manually. In Microsoft 

Dynamics CRM for Outlook, on the Microsoft Dynamics CRM menu bar, click Synchronize Outlook with CRM. 

Set the e-mail access method for a user or a queue  

 Can I do this task?  

This task requires a manager, vice president, CEO-Business Manager, System Administrator, or 
System Customizer security role or equivalent permissions. More information about specific 
permissions and performing this task while offline: E-mail Permissions  

 

 

1. In the Navigation Pane, click Settings, click Administration, and then click Users.  

– OR –  

In the Navigation Pane, click Settings, click Business Management, and then click Queues.  

2. Open the user or queue you want to modify.  

3. Under E-mail Access Configuration, select how e-mail will be accessed for incoming and outgoing 

mail.  

 None  

E-mail will not be sent or received.  

 Forward Mailbox  

E-mail will be forwarded from another e-mail address.  

 Microsoft Dynamics CRM for Outlook  

E-mail is sent and received with Microsoft Dynamics CRM for Outlook.  

 E-mail Router  

E-mail is sent and received with the Microsoft Dynamics CRM E-mail Router. If this item is 

selected, the Allow credentials check box is displayed. To require that credentials be 

entered, select the check box.  

4. Click Save or Save and Close.  

Notes 

 If you have selected an e-mail option, verify that there is a valid e-mail address in the E-mail box.  

 If you select Microsoft Dynamics CRM for Outlook as your e-mail option, you must also allow 

Microsoft Dynamics CRM to send mail through Microsoft Dynamics CRM for Outlook.  
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Specify how your e-mail is tracked  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Common Task Permissions  

You can use an existing e-mail address to send and receive e-mail with Microsoft Dynamics CRM. After your 

system administrator sets up your e-mail address, you can update the password.  

 

1. Under Workplace, click the Personalize Workplace link.  

2. In the Set Personal Options dialog box, on the E-mail tab, select the option that you want from the 

Track list:  

 All e-mail messages 

All of the messages from the account listed in your user profile will be saved as Microsoft 

Dynamics CRM activities.  

 E-mail messages in response to CRM e-mail 

Only e-mail messages received as replies from messages sent from Microsoft Dynamics CRM 

will be saved as Microsoft Dynamics CRM activities.  

 E-mail messages from CRM Leads, Contacts, and Accounts 

Only e-mail messages received from leads and customers will be saved as Microsoft Dynamics 

CRM activities.  

3. To save your changes and close the dialog box, click OK.  

Set synchronization options in Microsoft Dynamics CRM for Outlook  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Common Task Permissions  

You can select which record types you want to synchronize between Outlook and Microsoft Dynamics CRM for 
Outlook and how often you want to synchronize between applications. This tab is not available in the Web 
application.  

 

1. Start Outlook. (Microsoft Dynamics CRM for Outlook must be installed.)  

2. On the Microsoft Dynamics CRM menu bar, click Options.  

3. In the Set Personal Options dialog box, on the Synchronization tab, you can select which record 

types are synchronized:  

 Appointments I'm attending 

Select this option if you want to synchronize appointments and service activities in which you 

are a participant and have accepted the appointment.  

 My tasks  

Select this option if you want to synchronize tasks that you own in Microsoft Dynamics CRM.  
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 Contacts 

Select this option if you want to synchronize contacts that you own in Microsoft Dynamics 

CRM. 

If you delete a contact you own in Microsoft Dynamics CRM or in Microsoft Dynamics CRM for 

Outlook, it will not be deleted in the other application.  

 My phone calls 

Select this option if you want to synchronize phone calls that you own in Microsoft Dynamics 

CRM.  

 My letters 

Select this option if you want to synchronize letters that you own in Microsoft Dynamics CRM.  

 My faxes 

Select this option if you want to synchronize faxes that you own in Microsoft Dynamics CRM.  

4. If you want to include company names from Outlook contacts, select Update Company fields with 

parent account names.  

Important: This setting only affects newly tracked contacts. Future changes are not synchronized.  

5. If you have more than one computer running Microsoft Dynamics CRM for Outlook, select this 

computer to be the synchronizing client.  

6. If your organization permits it, you can define how often Microsoft Dynamics CRM items in your 

Microsoft Dynamics CRM for Outlook folders are updated:  

 Synchronize the CRM items in my Outlook folders every 

Select this option and select the number of minutes. You can increase the amount of time 

between synchronization of items in your Microsoft Dynamics CRM for Outlook folders. Your 

administrator sets the minimum time allowed between synchronization.  

7. Select how duplicates are handled during synchronization:  

 Create the duplicates 

This option allows records to be created even if key fields contain the same data. 

More information: Avoiding Duplicate Records  

 Do not create duplicates 

This option blocks records from being created if key fields contain the same data.  

8. To save your changes and close the dialog box, click OK.  

Update Microsoft Dynamics CRM for Outlook 

Occasionally, your administrator will make updates to Microsoft Dynamics CRM that require you to install the updates 

on your computer. When updates are available, you will be prompted to install them. Some updates are optional, and 

you can postpone installing them until later. Other updates are mandatory and must be installed, or Microsoft Dynamics 

CRM for Outlook will be disabled on your computer.  

You can also choose to check for updates and then choose which ones to install. 
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Update Microsoft Dynamics CRM for Outlook on your computer  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: E-mail Permissions  

This procedure is not available in the Microsoft Dynamics CRM Web application. It applies only to Microsoft Dynamics 
CRM for Outlook. 

 

1. Start Outlook. (Microsoft Dynamics CRM for Outlook must be installed.)  

2. On the Microsoft Dynamics CRM menu bar, click Check for Updates.  

3. If there are updates, in the Available Updates for Microsoft Dynamics CRM Office Client dialog 

box, click Update Now.  

Important 

If you prefer to install updates later, click Cancel. Skipping mandatory updates may cause Microsoft Dynamics CRM for 

Outlook to be disabled. If this occurs, install the updates to restore functionality.  

Connect to Another Organization in Microsoft Dynamics CRM for Outlook  

When you are in Outlook, if you belong to more than one organization, you can change the Microsoft Dynamics CRM 

organization while online. This feature is not available when you are offline.  

 

Change the organization you are logged in to  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Common Task Permissions  

This feature is available only if you are a member of more than one organization. If you need to be added to 

additional organizations, contact your system administrator. 

 

1. In Microsoft Dynamics CRM for Outlook, on the Microsoft Dynamics CRM menu bar, click Change 

Organization.  

2. In the Microsoft Dynamics CRM Office Configuration Wizard, click Change your configuration, and 

then click Next.  

3. Complete the wizard.  

Sending and Receiving E-mail in Microsoft Dynamics CRM for Outlook 

When you are working in Microsoft Dynamics CRM for Microsoft Office Outlook, you can use all the familiar Outlook 

buttons and toolbars with the Microsoft Dynamics CRM toolbar and menu to manage e-mail messages and most other 

activities. At any time, you can track an Outlook e-mail message in Microsoft Dynamics CRM. Tracked messages still 

appear in the Outlook mail folders. There is a personal option setting to change the icon with a Microsoft Dynamics 

CRM Tracked in CRM icon . A copy of the e-mail message is saved as an activity and is available in the Microsoft 

Dynamics CRM Activities area. You can link the activity to a record in Microsoft Dynamics CRM. You can also set your 

personal options so that all incoming e-mail is tracked in Microsoft Dynamics CRM.  
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More information: Set Personal Options 

Important 

Because Microsoft Dynamics CRM shares data between users, many of the default privacy assumptions of a full e-mail 

system do not apply. This means that an e-mail activity that is associated with a Microsoft Dynamics CRM record as a 

regarding record (for example, a case, account, or contact) has the same visibility as any other activity associated with 

that record, and any user who has access to the record and its associated activities also has access to the e-mail 

message. 

Managing Incoming E-mail 

When you use Microsoft Dynamics CRM for Outlook, all the e-mail you receive arrives in your Outlook Inbox, and only 

e-mail that originated as a Microsoft Dynamics CRM e-mail activity (that is, a response to e-mail you send from 

Microsoft Dynamics CRM), or that is marked as tracked in Microsoft Dynamics CRM, arrives in the Microsoft Dynamics 

CRM Activities and My Work: Queues area. If you prefer, you can:  

 Track all incoming e-mail as Microsoft Dynamics CRM e-mail activities.  

 Track only e-mail that originated in Microsoft Dynamics CRM (that is, e-mail sent in response to a 

Microsoft Dynamics CRM e-mail activity) into Microsoft Dynamics CRM e-mail activities.  

 Track only e-mail related to your accounts, contacts, or leads.  

If you choose not to track all incoming e-mail, you can manually track selected messages in Outlook as e-mail activities 

in Microsoft Dynamics CRM.  

However, if you track all your e-mail messages as Microsoft Dynamics CRM e-mail activities, they can be accessed by 

anyone who has permission to view or work with your activities. Also, when you track an e-mail message with 

attachments to a Microsoft Dynamics CRM activity, the attachments are included in the activity. If you do not want 

these attachments to be available to other users, delete them from the e-mail activity. 

More information: Save Outlook Contacts, Tasks, and E-mail Messages as Microsoft Dynamics CRM Records 

Sending and Replying to E-Mail Messages 

You can link Microsoft Dynamics CRM e-mail activities to active contacts, accounts, leads, facilities, equipment, queues, 

or users in Microsoft Dynamics CRM. You can select active Microsoft Dynamics CRM records with e-mail addresses from 

the Microsoft Dynamics CRM address book, which is installed automatically when you install Microsoft Dynamics CRM 

for Outlook. E-mail activities can also be tracked in Microsoft Dynamics CRM without being related to another record. 

Microsoft Dynamics CRM  

When you send, reply, or forward an e-mail that is tracked as a e-mail activity, a closed activity is created for each 

account and contact referenced and displayed in the History area. Closed e-mail activities cannot be updated except to 

link them to a related Microsoft Dynamics CRM record. If a related record has not already been selected, you have the 

option of select one.  

More information: Managing E-mail Activities 

Working with Microsoft Dynamics CRM for Outlook with Offline Access 

Offline and Synchronizing with Microsoft Dynamics CRM 

If you install Microsoft Dynamics CRM for Outlook with Offline Access, you have the option of working offline from the 

Microsoft Dynamics CRM server. You can create Microsoft Dynamics CRM e-mail messages that are sent when you go 

back online. If you send Outlook e-mail messages, those are sent immediately.  

More information: Synchronizing Information 

When you are working with Microsoft Dynamics CRM for Outlook with Offline Access offline, if you create and send an 

e-mail message and the message fails to be delivered or is blocked, for example, because the recipient does not want 

to receive e-mail or the mail server is down, the e-mail is saved to your Drafts folder in Outlook, but a closed Microsoft 
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Dynamics CRM activity is created. In Microsoft Dynamics CRM, you can use the Pending E-mail view to unsent 

messages. When you are working offline,Microsoft Dynamics CRM e-mail messages that you send are saved to your 

Outlook offline queue, and when you go online, Microsoft Dynamics CRM automatically tries to send them and create 

the activities. If an e-mail message cannot be sent, it is saved in Microsoft Dynamics CRM as a draft activity, but does 

not appear in your Drafts folder in Outlook. 

More information: Working Offline 

Using the Microsoft Dynamics CRM Address Book 

You can use the Microsoft Dynamics CRM address book to select records from Microsoft Dynamics CRM in Outlook. The 

address book includes accounts, contacts, facilities/equipment, leads, queues, and users. You can access the Microsoft 

Dynamics CRM address book from the same menu as your other Outlook address books and use it in the same way.  

The address book is also used to reconcile e-mail recipients in incoming messages to Microsoft Dynamics CRM contacts 

and link them automatically. How the contacts are matched is set in your personal options. 

More information: Set Personal Options 

Working with Records and Activities in Microsoft Dynamics CRM for Outlook 

With Microsoft Dynamics CRM for Microsoft Office Outlook, you can work in all areas of Microsoft Dynamics CRM for 

which you have privileges.  

Creating New Records and Activities 

There are a number of places to create new records and activities using Microsoft Dynamics CRM for Outlook :  

 Outlook toolbar buttons and menus  

You can create new contacts, tasks, appointments, and e-mail messages that use the familiar 

Outlook forms. You can track a record or activity in Microsoft Dynamics CRM. You can designate 

Outlook tasks as Microsoft Dynamics CRM phone calls, faxes, or letters. Records that you track are 

linked and updates to the records in Outlook are propagated in Microsoft Dynamics CRM and vice 

versa. You can set personal options to always use Microsoft Dynamics CRM or Outlook forms.  

After you save your e-mail message as a Microsoft Dynamics CRM e-mail activity, the saved 

message can be accessed by anyone who has access to your activities in Microsoft Dynamics CRM.  

More information: Set Personal Options 

 Microsoft Dynamics CRM toolbar  

You can create new activities and records; search for records; and link Outlook e-mails messages, 

tasks, appointments, and contacts to Microsoft Dynamics CRM records. You can also open Microsoft 

Dynamics CRM Help from this toolbar. If you are using Microsoft Dynamics CRM for Outlook with 

Offline Access, you can go online and offline. 

 CRM menu  

You can create new activities and records, open the Microsoft Dynamics CRM activity areas, and 

search for records with Advanced Find. You can also open Advanced Find and Microsoft Dynamics 

CRM Help from this menu. 

If you are working in Microsoft Dynamics CRM for Outlook with Offline Access, you can take data 

offline. From this menu, you can define what data is taken offline, initiate synchronization, and go 

online or go offline.  

 Microsoft Dynamics CRM folders  

You can use the Microsoft Dynamics CRM folders access Microsoft Dynamics CRM records and 

Microsoft Dynamics CRM that use the Microsoft Dynamics CRM activity forms. If you create records 
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when you are working offline, they are synchronized to the Microsoft Dynamics CRM server when 

you go online. This method gives you other conveniences, such as access to e-mail templates.  

Do not move Microsoft Dynamics CRM records or activities or Outlook-tracked records or activities 

from the designated folders. This can break the link to Microsoft Dynamics CRM and interrupt future 

tracking. 

More information: Save Outlook Contacts, Tasks, and E-mail Messages as Microsoft Dynamics CRM Records 

Working Offline 

Some areas cannot be accessed, and some records cannot be deleted, modified, shared, or assigned if you are offline. 

 The following list shows the features that are unavailable when you are offline  

Not available offline 

 Assigning records (except activities and cases)  

 Converting quotes to sales orders  

 Converting sales orders to invoices  

 Managing system administration  

 Updating system configuration  

 Managing service activities  

 Managing services  

 Using the Service calendar and Workplace calendar  

 Editing articles  

 Editing or managing sales literature  

 Changing organizations  

 Sharing records  

 Detecting duplicate records  

 Managing system jobs  

 Running some diagnostic tests  

 Running workflow rules  

 Create quick campaign and related activities from a Mail Merge  

Limited availability  

 Creating or viewing reports (based on local data groups and offline data)  

 Running some custom business process automating (plug-ins)  

Can be viewed, but cannot be edited offline 

 Articles  

 Sales literature  

More information: Working Offline 
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Synchronizing Reminders and Calendars 

Some activities inherit reminders from Outlook. Whether or not an activity has a reminder depends on where it was 

created:  

 Activities created in Microsoft Dynamics CRM for Outlook  

Reminders for tasks, e-mail messages, and appointments created in the Microsoft Dynamics CRM for 

Outlook forms have the reminders provided by Outlook. Service activities created in Microsoft 

Dynamics CRM for Outlook are automatically set with 15-minute reminders, which cannot be 

changed or turned off. Service activities and appointments are synchronized with the Microsoft 

Dynamics CRM Service calendar and Workplace calendar. Tasks do not appear in the calendars. You 

cannot set reminders for faxes, phone calls, e-mails, letters, or campaign response activities created 

in Microsoft Dynamics CRM for Outlook.  

 Activities created in the Web Application  

Appointments and service activities created in the Web application and synchronized with Microsoft 

Dynamics CRM for Outlook have 15-minute reminders set automatically based on the due date. 

These reminders cannot be changed or updated, even if the due date is updated. Appointments and 

service activities appear in both Outlook and Microsoft Dynamics CRM calendars. Faxes, phone calls, 

and letters that are created by tracking Outlook tasks can have reminders. These activities created 

with Microsoft Dynamics CRM forms, do not have reminders. 

Only Microsoft Dynamics CRM appointments and service activities that are tracked in Outlook as appointments appear 

in both Outlook and Microsoft Dynamics CRM calendars.  

Deleting Records and Activities 

When you delete a linked contact, task, or appointment in Outlook or in Microsoft Dynamics CRM, one of two things can 

happen: the linked item can be deleted too, or the linked item remains, but the link is broken and future changes are 

not synchronized.  

 For contacts you own:  

 If you delete a contact from Outlook, it is never deleted from Microsoft Dynamics CRM, but 

the link is broken and the record is updated.  

 If a contact is deleted from Microsoft Dynamics CRM and the contact is owned by you, it is 

not deleted from Outlook, but the link is broken and the record is not updated.  

 If a contact is deleted from Outlook by someone else and the contact is not owned by you in 

Microsoft Dynamics CRM, the contact is deleted from Microsoft Dynamics CRM.  

 For contacts you do not own:  

 If a contact is deleted from Outlook by someone else and is owned by you, the contact is not 

deleted from Microsoft Dynamics CRM, but the link is broken and the record is not updated or 

recreated in Outlook.  

 For other records and activities:  

 If a tracked record is deleted from Outlook, or an appointment declined in Outlook, and then 

the record or activity is updated in Microsoft Dynamics CRM, the record or activity may be 

recreated.  

 When you delete an e-mail message, a contact, a completed task, or a past appointment or 

service activity from Outlook, it is not deleted from Microsoft Dynamics CRM, but the link is 

broken. However, if you delete a pending (incomplete) task or future appointment from 

Outlook, it is also deleted from Microsoft Dynamics CRM.  
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 If a tracked activity is deleted from Outlook or an appointment is declined in Outlook, and 

then the Microsoft Dynamics CRM record is updated in Microsoft Dynamics CRM, the record or 

activity may be recreated during synchronization.  

 Pending appointments and tasks:  

 If the appointment is deleted from Outlook by the owner or organizer, it is deleted from 

Microsoft Dynamics CRM. If it is deleted by a participant, it is not deleted from Outlook.  

 If you delete a pending task from either Outlook or Microsoft Dynamics CRM the linked task is 

deleted. 

 Past appointments and complete tasks:  

 Past appointments and completed tasks are not deleted. 

More information: Synchronizing Information 

Save Outlook Contacts, Tasks, and E-mail Messages as Microsoft Dynamics CRM 

Records 

By using Microsoft Dynamics CRM for Outlook, you can save individual Outlook contacts, appointments, e-mail 

messages, and tasks as Microsoft Dynamics CRM records and activities and then link them to a related Microsoft 

Dynamics CRM record, such as a contact, account, or lead. Activities appear in the related record's list of activities.  

You can also set options to determine how incoming e-mail is handled.  

Save and link Outlook contacts in Microsoft Dynamics CRM  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Common Task Permissions  

You can save Outlook contacts as new Microsoft Dynamics CRM contacts. You can link the newly saved record to 

another Microsoft Dynamics CRM record, such as an account or contact. 

 

1. Start Outlook. (Microsoft Dynamics CRM for Outlook must be installed.)  

2. In the Outlook contacts folder, select up to 20 contacts.  

3. On the Microsoft Dynamics CRM toolbar, click Track in CRM. 

In the Outlook Contacts folder, the icons beside the records change to the Tracked in CRM 

icon . The contacts appear in the Contacts area in Microsoft Dynamics CRM.  

4. To add additional information to the Contact form, open the Outlook item, and then on the Microsoft 

Dynamics CRM toolbar, click View in CRM. The Microsoft Dynamics CRM contact record form 

opens.  

5. Do one of the following to locate and select a parent record to link to this record:  

 In Microsoft Office Outlook 2003, click Regarding.  

 In Microsoft Office Outlook 2007, click Set Parent or Set Regarding.  

Tip 

Click Regarding, Set Regarding, or Set Parent first, and Track in CRM is automatically activated.  
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Notes 

 Duplicate detection identifies duplicate records when a record is tracked. Duplicate detection may 

occur when you synchronize or go back online.  

 Resolve potential duplicate records.  

1. If the system detects that your record might be a potential duplicate, instead of saving the 

record, you'll see the Duplicates Detected dialog box.  

2. To open a record to make sure it is a potential duplicate, in the Potential duplicate records 

list, double-click the record.  

 If the duplicate-detection rule identified potential duplicate records in other record 

types, review records from each record type listed.  

3. If your new or updated record is not a duplicate, to create the new record, click Save Record.  

– OR –  

If your new or updated record is a duplicate, to cancel your changes, click Cancel.  

Notes  

 If you enter a duplicate record within a few minutes of entering the first record, Microsoft 

Dynamics CRM will not detect the duplicate record. The matchcodes for new and updated 

records are created every five minutes, rather than as a record is created.  

Duplicate detection can take place only if duplicate detection is enabled in Duplicate Detection Settings 
and if at least one duplicate-detection rule exists for the record type. More information: Avoiding Duplicate 
Records  

 In Microsoft Office Outlook 2007, you can remove the link and delete the corresponding 

record in Microsoft Dynamics CRM. Click Track in CRM, and then in the confirmation message, click 

Yes.  

 The Company field in an Outlook contact is not automatically added to the parent account of 

the new Microsoft Dynamics CRM contact. More information: Set Personal Options  

Save and link Outlook tasks and appointments in Microsoft Dynamics 

CRM  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Common Task Permissions  

You can save an Outlook unassigned task, nonrecurring appointment, and meeting request as a new Microsoft 

Dynamics CRM record. You can link a newly-saved Outlook record to a Microsoft Dynamics CRM record, such as 

an account or contact. You can also create a new Microsoft Dynamics CRM record that links to the saved Outlook 

record.  

 

1. Start Outlook. (Microsoft Dynamics CRM for Outlook must be installed.)  

2. In the Outlook calendar, select one or more appointments, meeting requests, or tasks that you want 

to add to Microsoft Dynamics CRM. You can select up to 20 records of the same record type at a 

time.  
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3. Save Outlook tasks as Microsoft Dynamics CRM tasks  

 On the Microsoft Dynamics CRM toolbar, click Track in CRM. 

In the Outlook tasks folder, the icons beside the records change to the Tracked in CRM 

icon . Tasks appear as activities in the Activities area of Microsoft Dynamics CRM.  

4. Save Outlook tasks as Microsoft Dynamics CRM phone calls, faxes, or letters  

 In the Outlook tasks folder, select up to 20 tasks.  

 On the Microsoft Dynamics CRM toolbar, point to Track in CRM, and then click the type of 

Microsoft Dynamics CRM activity you want to create.  

In the Outlook tasks folder, the icons beside the records change to the Tracked in CRM 

icon . New tasks appear as the selected activities in the Activities area in Microsoft 

Dynamics CRM.  

5. You can add information to the new Microsoft Dynamics CRM Activity form, open the Outlook item, 

and then on the Microsoft Dynamics CRM toolbar, click View in CRM. The record opens.  

You cannot edit an activity after it has been closed in Microsoft Dynamics CRM, except for sent e-

mail messages, which you can update with information about which record the e-mail message 

relates to.  

6. Do one of the following to locate and select a parent record to link to this record:  

 In Microsoft Office Outlook 2003, click Regarding.  

 In Microsoft Office Outlook 2007, click Set Parent or Set Regarding.  

Tip 

Click Regarding, Set Regarding, or Set Parent first, and Track in CRM is automatically activated.  

Notes 

 In Microsoft Office Outlook 2007, you can remove the link and delete the corresponding record in 

Microsoft Dynamics CRM. Click Track in CRM, and then in the confirmation message, click Yes.  

 Duplicate detection identifies duplicate records when a record is tracked. Duplicate detection may 

occur when you synchronize or go back online.  

 Resolve potential duplicate records.  

1. If the system detects that your record might be a potential duplicate, instead of saving the 

record, you'll see the Duplicates Detected dialog box.  

2. To open a record to make sure it is a potential duplicate, in the Potential duplicate records 

list, double-click the record.  

 If the duplicate-detection rule identified potential duplicate records in other record 

types, review records from each record type listed.  

3. If your new or updated record is not a duplicate, to create the new record, click Save Record.  

– OR –  

If your new or updated record is a duplicate, to cancel your changes, click Cancel.  

Notes  

 If you enter a duplicate record within a few minutes of entering the first record, Microsoft 
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Dynamics CRM will not detect the duplicate record. The matchcodes for new and updated 

records are created every five minutes, rather than as a record is created.  

Duplicate detection can take place only if duplicate detection is enabled in Duplicate Detection Settings 
and if at least one duplicate-detection rule exists for the record type. More information: Avoiding Duplicate 
Records  

 If you are not selected as one of the required resources in an appointment or service 

activity, the activity will not appear in your Outlook calendar after synchronization.  

 A task stored in the Outlook default message store, or locations other than the default 

Exchange location, cannot be linked.  

Save and link Outlook e-mail messages as Microsoft Dynamics CRM e-

mail activities  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: E-mail Permissions  

You can save Outlook e-mail messages as new Microsoft Dynamics CRM e-mail activities. You can also set the 

Regarding field for any newly tracked e-mail activity. 

Your administrator can block messages from being saved if they contain attachments of specific file types, such 

as.exe. Any messages that are stored in locations other than the default Exchange location, cannot be linked. 

After you save your e-mail message as a Microsoft Dynamics CRM e-mail activity, the saved message can be 

accessed by anyone who has access to your activities in Microsoft Dynamics CRM.  

 

1. Start Outlook. (Microsoft Dynamics CRM for Outlook must be installed.)  

2. In an Outlook folder, select one or more the e-mail messages you want to add to Microsoft Dynamics 

CRM. You can select up to 20 records at a time.  

3. On the Microsoft Dynamics CRM toolbar, click Track in CRM. 

In the Outlook folder, the icons beside the records change to the Tracked in CRM icon . E-mail 

messages appear as activities in the Activities area of Microsoft Dynamics CRM. A sent e-mail 

message is linked to a closed activity. Use the Closed Activities view to see messages.  

4. To add additional information to the Activity form, open the Outlook item, and then on the Microsoft 

Dynamics CRM toolbar, click View in CRM. The Microsoft Dynamics CRM record form opens.  

You cannot edit an e-mail message after it has been sent, except to include which record the e-mail 

message relates to.  

5. Do one of the following to locate and select a parent record to link to this record:  

 In Microsoft Office Outlook 2003, click Regarding.  

 In Microsoft Office Outlook 2007, click Set Parent or Set Regarding.  

A closed Microsoft Dynamics CRM e-mail activity is created when you send an e-mail message.  

Tip 

Click Regarding, Set Regarding, or Set Parent first, and Track in CRM is automatically activated.  

Notes 
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 In your personal options, you can set whether replies to tracked messages are also tracked. More 

information: Set Personal Options  

 You can also set the same regarding record for multiple records by selecting the records and then 

clicking Set Regarding or Set Parent, depending on the record type.  

 In Microsoft Office Outlook 2007, you can remove the link and delete the corresponding record in 

Microsoft Dynamics CRM. Click Track in CRM, and then in the confirmation message, click Yes.  

Automatically track and save incoming e-mail as Microsoft Dynamics 

CRM e-mail activities  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: E-mail Permissions  

When you track e-mail messages, activities are created in Microsoft Dynamics CRM that are linked to the original 

messages in Microsoft Office Outlook.  

After you save your e-mail message as a Microsoft Dynamics CRM e-mail activity, the saved message can be 

accessed by anyone who has access to your activities in Microsoft Dynamics CRM.  

 

1. Start Outlook. (Microsoft Dynamics CRM for Outlook must be installed.)  

2. On the Microsoft Dynamics CRM menu bar, click Options.  

3. In the Set Personal Options dialog box, on the E-mail tab, select one of the following options:  

 All e-mail messages  

Track all incoming e-mail.  

 E-mail messages in response to CRM e-mail 

Track only replies to existing Microsoft Dynamics CRM e-mail messages.  

 E-mail messages from CRM Leads, Contacts, and Accounts 

Only e-mail messages received from leads and customers will be saved as Microsoft Dynamics 

CRM activities.  

4. Click OK.  

Note 

After you open a message that has been converted and is being tracked in Microsoft Dynamics CRM, on the Microsoft 

Dynamics CRM toolbar, click View in CRM to open the record in Microsoft Dynamics CRM to view or edit it.  
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Remove tracking in Microsoft Dynamics CRM from a record  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Common Task Permissions  

Removing tracking from a record does not delete the record in Microsoft Dynamics CRM or from Microsoft Office 

Outlook. The link between the two records is broken and any changes to the regarding record will not be 

synchronized in future synchronizations.  

This feature is available only in Microsoft Outlook 2007. 

 

 On the Microsoft Dynamics CRM toolbar, click Track in CRM. In the confirmation dialog box, click OK 

In the Outlook folder, the icon beside the record changes back to the Outlook icon.  

Tip 

To change the regarding record, delete the record in Microsoft Dynamics CRM, and then in Outlook the item will still be 

tracked, but the regarding can be reset.  

Create an Activity in Outlook 

Create or edit a task or appointment in Outlook  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: E-mail Permissions  

Outlook only supports tasks, but when you create a task you can choose what type of Microsoft Dynamics CRM 

activity the task should be saved as in Microsoft Dynamics CRM. Your Outlook task can be saved as a Outlook task, 

phone call, letter, or fax. 

You can create tasks and appointments in Outlook using either the Microsoft Dynamics CRM forms or the Outlook 

forms. If you have selected to synchronize your appointments and tasks to your default Outlook folders, when you 

create a new appointment or task, the Outlook forms open. You can view your options in your personal settings. The 

option to synchronize tasks and appointments and to use Outlook forms is turned on by default.  

 Tip 

To view your synchronization options for Microsoft Dynamics CRM for Outlook, on the Microsoft 

Dynamics CRM menu bar, click Options, and then click the Synchronization tab.  

Everyone who was invited to the appointment (required and optional) can view the appointment in their calendars 

and in My Activities views. 

Recurring appointments or tasks are not fully synchronized in the Web application. Only the initial appointment is 
synchronized. Create individual appointments and tasks as appropriate.  

 

1. Start Outlook. (Microsoft Dynamics CRM for Outlook must be installed.)  
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2. Do one of the following:  

 Create an appointment in an Outlook form 

1. On the Microsoft Office Outlook Standard toolbar, click New.  

2. On the New menu, click Appointment.  

For more information, see Outlook Help.  

3. On the Microsoft Dynamics CRM toolbar, click Track in CRM. 

After you save the record, the View in CRM button becomes available.  

4. Do one of the following to locate and select a parent record to link to this record:  

 In Microsoft Office Outlook 2003, click Regarding.  

 In Microsoft Office Outlook 2007, click Set Parent or Set Regarding.  

5. Click Save or Save and Close.  

The activity appears in your Outlook folders. The icon changes to the Tracked in CRM icon . 

If reminders were set up for appointments created in Microsoft Dynamics CRM for Outlook, they 

will be observed. A new Microsoft Dynamics CRM appointment activity is created and appears in 

the Microsoft Dynamics CRM Activities and Queues areas.  

 Tip 

To open the Microsoft Dynamics CRM activity to add or edit information, click View in CRM.  

6.  

 Create a task in an Outlook form 

1. On the Microsoft Office Outlook Standard toolbar, click New.  

2. On the New menu, click Task.  

For more information, see Outlook Help.  

3. On the Microsoft Dynamics CRM toolbar, click Track in CRM, and then click the type of Microsoft 

Dynamics CRM activity you want to create. You can create a task, letter, fax, or phone call activity 

that will be linked to the Outlook task. 

After you save the record, the View in CRM button becomes available.  

4. Do one of the following to locate and select a parent record to link to this record:  

 In Microsoft Office Outlook 2003, click Regarding.  

 In Microsoft Office Outlook 2007, click Set Parent or Set Regarding.  

5. Click Save or Save and Close.  

The activity appears in your Outlook folders. The icon changes to the Tracked in CRM icon . 

If reminders were set up for appointments and tasks created in Microsoft Dynamics CRM for 

Outlook, they will be observed. A new Microsoft Dynamics CRM task or appointment activity is 

created and appears in the Microsoft Dynamics CRM Activities and Queues areas. When your local 

data synchronizes, the new activities will be copied to the Microsoft Dynamics CRM server.  
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 Tip 

To open the Microsoft Dynamics CRM activity to add or edit additional information, click View 

in CRM.  

6.  

 Create a task or an appointment in a Microsoft Dynamics CRM form 

1. In the Outlook Navigation Pane, under Microsoft Dynamics CRM, expand Workplace.  

2. Under Workplace, expand My Work, and then expand Activities.  

3. On the Actions toolbar, click New.  

4. In the New Activity dialog box, click Task or Appointment, and then click OK.  

5. Enter the information that you want. You must enter any required information. In addition, at a 

minimum, entering information in the following boxes is useful when you or others in your 

organization refer to the activity later.  

 Subject  

You can quickly sort on the subject when you view activities.  

 Owner  

Microsoft Dynamics CRM automatically fills this box with your name. You can locate and 

select another owner. The activity appears in their Activity area.  

 Duration  

If this activity is related to a case, make sure that you record the time you spend on the 

activity in this box. If the case is linked to a contract line, the durations of all the activities 

for this case are tallied and updated automatically in the related active contract. The total, 

which includes the totals from any other cases relating to that contract, can be adjusted 

manually before billing the customer.  

 Due  

Enter the date and time that the activity is expected to take place or be completed. You can 

quickly sort on the Due field when you view activities.  

6. Click Save or Save and Close.  

After records are synchronized, appointment reminders are automatically set up in Outlook for 15 

minutes prior to the appointment. Tasks created in the Web application or created for an 

appointment today do not generate reminders. 

Notes 

 When the duration of an activity is more than 60 minutes (an hour), the time you enter is converted 

into hours. When the activity is saved, the value is rounded up and might change from the entry 

that was originally displayed when it was converted from minutes into hours. Note that rounding is 

only observed on the hundredth of an hour. The exact value for the duration, however, is stored in 

the database in minutes, and this value is used to calculate the total billing time when resolving 

cases.  

 When Outlook tasks and appointments with attachments that have been saved in Microsoft Dynamics 

CRM are synchronized between the Microsoft Dynamics CRM server and Microsoft Dynamics CRM for 
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Outlook, the attachments do not synchronize, but continue to exist with the original item. To retain 

the attachment with the activity, save the file to the local drive of your computer, and then manually 

add the attachment to the Microsoft Dynamics CRM activity.  

Create or edit other activities in Outlook  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Common Task Permissions  

These activities are not displayed in the Outlook calendar or task list.  

 

1. Start Outlook. (Microsoft Dynamics CRM for Outlook must be installed.)  

2. Under Workplace, expand My Work, and then expand Activities.  

3. On the Actions toolbar, click New.  

4. In the New Activity dialog box, select the activity you want, such as Fax or Letter, and then click 

OK.  

5. Enter the information that you want. You must enter any required information. In addition, at a 

minimum, entering information in the following boxes is useful when you or others in your 

organization refer to the activity later.  

 Subject  

You can quickly sort on the subject when you view activities.  

 Owner  

Microsoft Dynamics CRM automatically fills this box with your name. You can locate and select 

another owner. The activity appears in their Activity area.  

 Duration  

If this activity is related to a case, make sure that you record the time you spend on the 

activity in this box. If the case is linked to a contract line, the durations of all the activities for 

this case are tallied and updated automatically in the related active contract. The total, which 

includes the totals from any other cases relating to that contract, can be adjusted manually 

before billing the customer.  

 Due  

Enter the date and time that the activity is expected to take place or be completed. You can 

quickly sort on the Due field when you view activities.  

6. Click Save or Save and Close.  

Microsoft Dynamics CRM for Outlook does not set reminders for these types of activities.  

Tip 

Depending on the record type, you can click the Lookup button  for the field that contains the linked record to 

search for and link to related records. For example, you can search for and enter the parent account in the Parent 

Account box. Microsoft Dynamics CRM will automatically update the fields in the record form with the information from 

the record you select.  

Note 



 

420 Microsoft Dynamics CRM 4.0 User’s Guide 
 

When the duration of an activity is more than 60 minutes (an hour), the time you enter is converted into hours. When 

the activity is saved, the value is rounded up and might change from the entry that was originally displayed when it was 

converted from minutes into hours. Note that rounding is only observed on the hundredth of an hour. The exact value 

for the duration, however, is stored in the database in minutes, and this value is used to calculate the total billing time 

when resolving cases.  

Create and send an e-mail activity in the Web application  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: E-mail Permissions  

You can create and send e-mail activities from Microsoft Dynamics CRM from the Activities area. E-mail messages 

sent from Microsoft Dynamics CRM do not appear in the Microsoft Dynamics CRM mail folders in Outlook.  

 

1. Start Microsoft Dynamics CRM 4.0.  

2. In the Navigation Pane, click Workplace, and then click Activities.  

3. On the Actions toolbar, click New.  

4. In the New Activity dialog box, click E-mail, and then click OK.  

5. On the E-mail tab, you must enter the following information.  

 From  

Locate and select the sender's name.  

 To  

Locate and select one or more recipients. You can select a record from a filtered list in the 

Form Assistant pane, or you can click the Lookup button  to search for other records.  

 Subject  

Type a subject for your e-mail message.  

 Duration  

This field is not required, but if you are tracking the amount of time spent on cases, and this 

message is related to a case, enter the amount of time spent on this message.  

 Due  

If you are not sending your e-mail message immediately, enter a date to complete and send 

the message. The message is not sent automatically.  

 Enter any additional information you want. Use the Formatting toolbar  

You cannot enter HTML tags or insert images into the body text of the message.  

 Tip 

 You can copy and paste content from Microsoft Office Word. This lets you take advantage of 

features such as spelling check and some text formatting. If your text is double-spaced, you 

can press SHIFT+ENTER to single-space lines of text.  

 You can include an image if the file is hosted on a public Web site. Use the copy and paste 

feature of Microsoft Internet Explorer to include a link to the image in the message. The image 

is displayed as long as the receipient has access to the Web site.  
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6. You can also attach an article, template, or file to an e-mail activity.  

 To attach an article 

a. To look up and select an article, on the Formatting toolbar, click Insert KB Article.  

b. Use the Search tab to specify conditions or criteria to locate the article.  

c. In the results list, select the article, and then click OK.  

The article appears the body of in your e-mail message.  

d. Type any additional text, or edit the article.  

 To attach an e-mail template 

a. To look up and select an e-mail template, click Insert Template.  

b. On the Insert Template dialog box, select the template you want to use. You can either use 

a global template, or a template specific to the record type you selected as the recipient. For 

example, account or customer.  

c. Click OK. 

The template appears in the body of your e-mail message and the subject line is updated with 

the subject line of the template.  

d. Type any additional text or edit the text provided. Editing the text or subject line in the 

message does not change the template.  

 To attach a file 

a. Save the activity.  

b. On the Attachments tab, click New E-mail Attachment.  

c. In the Add Attachment dialog box, in the File Name box, type the name of the file, or click 

Browse to locate the file that you want to attach.  

d. Click Attach.  

 To send the message immediately, click Send.  

The message is sent and the new closed activity appears in the History area with an assigned 

message number appended to the Subject column and the date sent in the Actual End column.  

– OR –  

To send the message at a later time, click Save and Close. The new draft activity appears in the 

Activities area. You can delete draft messages.  

To send the message, in the list of activities, open the e-mail activity, and click Send.  

Important 

After you save your e-mail message as a Microsoft Dynamics CRM e-mail activity, the saved message can be accessed 

by anyone who has access to your activities in Microsoft Dynamics CRM.  

Notes 
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 You can view the sent date of an e-mail message on the Activities list. The Actual End Date is the 

date the message was sent and closed.  

 You can forward or reply to an e-mail activity, but you cannot resend it.  

To reply to only the original sender, on the Actions toolbar, click Reply.  

To reply to the original sender and to send copies to everyone who originally received the message, 

click Reply All.  

To forward the e-mail activity to new recipients, click Forward, and then select new recipients.  

 There is no spelling checker built into Microsoft Dynamics CRM. There may be third-party solutions 

available. For more information, visit Microsoft Dynamics CRM Solution Finder.  

Create an e-mail message in Outlook  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: E-mail Permissions  

You can create e-mail messages in Microsoft Office Outlook by using either the Microsoft Dynamics CRM forms or 
the Outlook forms. By default, the e-mail messages that have been marked for tracking are synchronized in 
Microsoft Dynamics CRM for Outlook and Microsoft Dynamics CRM, and when you reply to or forward an e-mail 
message from this message, the Outlook forms open. The option that allows you to chose which form to use does 
not affect this. 

 

1. Start Outlook. (Microsoft Dynamics CRM for Outlook must be installed.)  

2. Do one of the following:  

 Create an e-mail message in an Outlook form 

1. On the Microsoft Office Outlook Standard toolbar, click New.  

2. In the New menu, click Mail Message.  

3. In the Outlook form, you can use either your Outlook contacts or your Microsoft Dynamics CRM 

contacts. For more information, see Microsoft Office Outlook Help.  

4. On the Microsoft Dynamics CRM toolbar, click Track in CRM. 

After you send the message, the View in CRM button becomes available.  

5. Do one of the following to locate and select a parent record to link to this record:  

 In Microsoft Office Outlook 2003, click Regarding.  

 In Microsoft Office Outlook 2007, click Set Parent or Set Regarding.  

6. On the Outlook toolbar, click Send.  

The e-mail message appears in your Microsoft Dynamics CRM folders. The icon changes to the 

Track in CRM button . The sent e-mail activity is saved as a Microsoft Dynamics CRM e-mail 

activity and appears in the Microsoft Dynamics CRM Activities area.  

An e-mail activity is not created until the message is sent.  

To view the contact record, on the Microsoft Dynamics CRM toolbar click, View in CRM.  

 Create an e-mail message in a form 

http://go.microsoft.com/fwlink/?LinkId=98752
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This procedure does not create an Outlook e-mail message. These e-mail messages only appear in the 

Microsoft Dynamics CRM for Outlook folders and do not appear the Outlook Sent Items folder.  

You can edit a draft e-mail message by following steps 1 through 2 to navigate to the Activities area in 

Microsoft Dynamics CRM for Outlook. Then, open the record you want to edit.  

1. In the Outlook Navigation Pane, under Microsoft Dynamics CRM, expand Workplace.  

2. Under Workplace, expand My Work, and then expand Activities.  

3. In the Activities area, on the Actions  menu, click New.  

4. In the New Activity dialog box, click E-mail, and then click OK.  

5. On the E-mail tab, you must enter the following information.  

 From  

Locate and select the sender's name.  

 To  

Locate and select one or more recipients. You can select a record from a filtered list in 

the Form Assistant pane, or you can click the Lookup button  to search for other 

records.  

 Subject  

Type a subject for your e-mail message.  

 Duration  

This field is not required, but if you are tracking the amount of time spent on cases, and 

this message is related to a case, enter the amount of time spent on this message.  

 Due  

If you are not sending your e-mail message immediately, enter a date to complete and 

send the message. The message is not sent automatically.  

 Enter any additional information you want. Use the Formatting toolbar  

You cannot enter HTML tags or insert images into the body text of the message.  

 Tip 

 You can copy and paste content from Microsoft Office Word. This lets you take 

advantage of features such as spelling check and some text formatting. If your 

text is double-spaced, you can press SHIFT+ENTER to single-space lines of text.  

 You can include an image if the file is hosted on a public Web site. Use the copy 

and paste feature of Microsoft Internet Explorer to include a link to the image in 

the message. The image is displayed as long as the receipient has access to the 

Web site.  

6. You can also attach an article, template, or file to an e-mail activity.  

 To attach an article 

a. To look up and select an article, on the Formatting toolbar, click Insert KB 

Article.  



 

424 Microsoft Dynamics CRM 4.0 User’s Guide 
 

b. Use the Search tab to specify conditions or criteria to locate the article.  

c. In the results list, select the article, and then click OK.  

The article appears the body of in your e-mail message.  

d. Type any additional text, or edit the article.  

 To attach an e-mail template 

a. To look up and select an e-mail template, click Insert Template.  

b. On the Insert Template dialog box, select the template you want to use. You 

can either use a global template, or a template specific to the record type you 

selected as the recipient. For example, account or customer.  

c. Click OK. 

The template appears in the body of your e-mail message and the subject line is 

updated with the subject line of the template.  

d. Type any additional text or edit the text provided. Editing the text or subject line in 

the message does not change the template.  

 To attach a file 

a. Save the activity.  

b. On the Attachments tab, click New E-mail Attachment.  

c. In the Add Attachment dialog box, in the File Name box, type the name of the 

file, or click Browse to locate the file that you want to attach.  

d. Click Attach.  

 To send the message immediately, click Send.  

The message is sent and the new closed activity appears in the History area with an assigned 

message number appended to the Subject column and the date sent in the Actual End column.  

– OR –  

To send the message at a later time, click Save and Close. The new draft activity appears in the 

Activities area. You can delete draft messages.  

To send the message, in the list of activities, open the e-mail activity, and click Send.  

Important: If you are working offline, e-mail messages sent from the e-mail form will not be 

sent until you go back online. The status will still be Closed. You can view a list of unsent e-mail 

rom the Activities list, with the My Pending E-mails view. 

Important 

After you save your e-mail message as a Microsoft Dynamics CRM e-mail activity, the saved message can be accessed 

by anyone who has access to your activities in Microsoft Dynamics CRM.  

Notes 
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 After a message is sent, the status is changed to Closed and displayed in the History folder. You 

cannot change the status or edit the message, except to link a record in the Regarding box, if one 

has not been selected.  

 You can forward or reply to an e-mail activity, but you cannot resend it.  

To reply to only the original sender, on the Actions toolbar, click Reply.  

To reply to the original sender and to send copies to everyone who originally received the message, 

click Reply All.  

To forward the e-mail activity to new recipients, click Forward, and then select new recipients.  

Create a Record in Outlook 

Create or edit a contact in Outlook  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Common Task Permissions  

By default, new contacts created in Microsoft Dynamics CRM for Outlook are updated in Microsoft Dynamics CRM 

immediately, and then Outlook is updated every 15 minutes. The option to synchronize contacts is on by default. 

When you create a new contact, the Outlook forms open. Whether an Outlook or Microsoft Dynamics CRM form opens 

is an option you can set. You can change your options in your personal options settings.  

More information: Set Personal Options, Synchronizing Information 

You can always create a contact using the Microsoft Dynamics CRM forms from the Contacts area.  

 Tip 

To view your synchronization options for Microsoft Dynamics CRM for Outlook, on the Microsoft 

Dynamics CRM menu bar, click Options, and then click the Synchronization tab.  

 

 

1. Start Outlook. (Microsoft Dynamics CRM for Outlook must be installed.)  

2. Do one of the following:  

 Create a contact in an Outlook form 

1. On the Microsoft Office Outlook Standard toolbar, click New.  

2. On the New menu, click Contact. 

You might need to expand the menu. For more information, see Outlook Help.  

3. On the Microsoft Dynamics CRM toolbar, click Track in CRM. 

After you save the record, the View in CRM button becomes available.  

4. Do one of the following to locate and select a parent record to link to this record:  

 In Microsoft Office Outlook 2003, click Regarding.  

 In Microsoft Office Outlook 2007, click Set Parent or Set Regarding.  

5. Click Save or Save and Close.  

The contact appears in your Microsoft Dynamics CRM Contact folder in Outlook. The icon changes 
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to the Track in CRM button . The contact is saved as a Microsoft Dynamics CRM contact and 

appears in the Microsoft Dynamics CRM Contacts area. 

When the contact was entered, the full name of the contact was used. When the record is saved 

to Microsoft Dynamics CRM, the name is separated into the first name and last name.  

To open the Microsoft Dynamics CRM contact to add or edit information, such as activities and addresses, 

click View in CRM. The new contact is copied to the Microsoft Dynamics CRM server immediately. Whether 

or not the Outlook Company field is copied to the Parent field is an option set by your organization. For 

more information, contact your system administrator.  

 Create a contact in a Microsoft Dynamics CRM form 

If you have selected to not synchronize contacts, these contacts only appear in the Microsoft Dynamics 

CRM folders in Outlook. 

You can edit a contact by following steps 1 and 2 to navigate to the My Work area in Microsoft Dynamics 

CRM for Outlook. Then, open the record you want to edit.  

1. In the Outlook Navigation Pane, under Microsoft Dynamics CRM, expand Workplace.  

2. Under My Work, click Contacts.  

3. On the Actions  menu, click New.  

4. On the General tab, you must enter the following information.  

 Last Name  

The last name of the contact is the minimum amount of information required.  

 First Name  

Enter the contact's full first name. Nicknames can be entered on the Notes tab.  

5. You can enter more information on these tabs:  

 On the Details tab, you can enter information about the contact's role in their company 

and personal information about them.  

 On the Administration tab, you can change the owner of this contact. You can also enter 

billing information; the preferred method of contact (such as by e-mail or phone); and 

whether or not they want to receive marketing material.  

 On the Notes tab, click Click here to enter a new note, and add the information that 

applies to your record.  

6. Click Save or Save and Close.  

 Resolve potential duplicate records.  

1. If the system detects that your record might be a potential duplicate, instead of 

saving the record, you'll see the Duplicates Detected dialog box.  

2. To open a record to make sure it is a potential duplicate, in the Potential 

duplicate records list, double-click the record.  

 If the duplicate-detection rule identified potential duplicate records in other 

record types, review records from each record type listed.  

3. If your new or updated record is not a duplicate, to create the new record, click 
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Save Record.  

– OR –  

If your new or updated record is a duplicate, to cancel your changes, click Cancel.  

Notes  

 If you enter a duplicate record within a few minutes of entering the first record, 

Microsoft Dynamics CRM will not detect the duplicate record. The matchcodes for 

new and updated records are created every five minutes, rather than as a record is 

created.  

Duplicate detection can take place only if duplicate detection is enabled in Duplicate 
Detection Settings and if at least one duplicate-detection rule exists for the record type. 
More information: Avoiding Duplicate Records  

7.  

Tip 

Depending on the record type, you can click the Lookup button  for the field that contains the linked record to 

search for and link to related records. For example, you can search for and enter the parent account in the Parent 

Account box. Microsoft Dynamics CRM will automatically update the fields in the record form with the information from 

the record you select.  

Notes 

 If you delete a contact you own in Microsoft Dynamics CRM or in Outlook, the record is not deleted in 

the other application. If a contact that you do not own is deleted in Microsoft Dynamics CRM, then it 

is deleted in Outlook.  

 Duplicates are not detected if you are offline. Duplicate detection may also occur when you 

synchronize or go back online.  

 Resolve potential duplicate records.  

1. If the system detects that your record might be a potential duplicate, instead of saving the 

record, you'll see the Duplicates Detected dialog box.  

2. To open a record to make sure it is a potential duplicate, in the Potential duplicate records 

list, double-click the record.  

 If the duplicate-detection rule identified potential duplicate records in other record types, 

review records from each record type listed.  

3. If your new or updated record is not a duplicate, to create the new record, click Save Record.  

– OR –  

If your new or updated record is a duplicate, to cancel your changes, click Cancel.  

Notes  

 If you enter a duplicate record within a few minutes of entering the first record, Microsoft 

Dynamics CRM will not detect the duplicate record. The matchcodes for new and updated 
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records are created every five minutes, rather than as a record is created.  

Duplicate detection can take place only if duplicate detection is enabled in Duplicate Detection Settings 
and if at least one duplicate-detection rule exists for the record type. More information: Avoiding Duplicate 
Records  

Save and link Outlook contacts in Microsoft Dynamics CRM  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Common Task Permissions  

You can save Outlook contacts as new Microsoft Dynamics CRM contacts. You can link the newly saved record to 

another Microsoft Dynamics CRM record, such as an account or contact. 

 

1. Start Outlook. (Microsoft Dynamics CRM for Outlook must be installed.)  

2. In the Outlook contacts folder, select up to 20 contacts.  

3. On the Microsoft Dynamics CRM toolbar, click Track in CRM. 

In the Outlook Contacts folder, the icons beside the records change to the Tracked in CRM 

icon . The contacts appear in the Contacts area in Microsoft Dynamics CRM.  

4. To add additional information to the Contact form, open the Outlook item, and then on the Microsoft 

Dynamics CRM toolbar, click View in CRM. The Microsoft Dynamics CRM contact record form 

opens.  

5. Do one of the following to locate and select a parent record to link to this record:  

 In Microsoft Office Outlook 2003, click Regarding.  

 In Microsoft Office Outlook 2007, click Set Parent or Set Regarding.  

Tip 

Click Regarding, Set Regarding, or Set Parent first, and Track in CRM is automatically activated.  

Notes 

 Duplicate detection identifies duplicate records when a record is tracked. Duplicate detection may 

occur when you synchronize or go back online.  

 Resolve potential duplicate records.  

1. If the system detects that your record might be a potential duplicate, instead of saving the 

record, you'll see the Duplicates Detected dialog box.  

2. To open a record to make sure it is a potential duplicate, in the Potential duplicate records 

list, double-click the record.  

 If the duplicate-detection rule identified potential duplicate records in other record 

types, review records from each record type listed.  

3. If your new or updated record is not a duplicate, to create the new record, click Save Record.  

– OR –  



 

 

 Microsoft Dynamics CRM 4.0 User’s Guide 429 

 

If your new or updated record is a duplicate, to cancel your changes, click Cancel.  

Notes  

 If you enter a duplicate record within a few minutes of entering the first record, Microsoft 

Dynamics CRM will not detect the duplicate record. The matchcodes for new and updated 

records are created every five minutes, rather than as a record is created.  

Duplicate detection can take place only if duplicate detection is enabled in Duplicate Detection Settings 
and if at least one duplicate-detection rule exists for the record type. More information: Avoiding Duplicate 
Records  

 In Microsoft Office Outlook 2007, you can remove the link and delete the corresponding 

record in Microsoft Dynamics CRM. Click Track in CRM, and then in the confirmation message, click 

Yes.  

 The Company field in an Outlook contact is not automatically added to the parent account of 

the new Microsoft Dynamics CRM contact. More information: Set Personal Options  

Create or edit other records in Outlook  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Common Task Permissions  

You can create the same records in Microsoft Dynamics CRM for Outlook that you can in Microsoft Dynamics CRM 

by using the same familiar forms. 

 

1. Start Outlook. (Microsoft Dynamics CRM for Outlook must be installed.)  

2. In the Outlook Navigation Pane, under Microsoft Dynamics CRM, expand the Marketing, Sales, 

or Service folder, and then expand the folder for the record type you want to create. Not all of 

these folders may be available to you.  

3. In the selected area, on the Actions  menu, click New or open the record that you want to edit.  

4. Complete the form as needed.  

5. Click Save or Save and Close.  

 Resolve potential duplicate records.  

1. If the system detects that your record might be a potential duplicate, instead of saving the 

record, you'll see the Duplicates Detected dialog box.  

2. To open a record to make sure it is a potential duplicate, in the Potential duplicate records 

list, double-click the record.  

 If the duplicate-detection rule identified potential duplicate records in other record 

types, review records from each record type listed.  

3. If your new or updated record is not a duplicate, to create the new record, click Save Record.  

– OR –  

If your new or updated record is a duplicate, to cancel your changes, click Cancel.  
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Notes  

 If you enter a duplicate record within a few minutes of entering the first record, Microsoft 

Dynamics CRM will not detect the duplicate record. The matchcodes for new and updated 

records are created every five minutes, rather than as a record is created.  

Duplicate detection can take place only if duplicate detection is enabled in Duplicate Detection Settings 
and if at least one duplicate-detection rule exists for the record type. More information: Avoiding Duplicate 
Records  

Note 

Duplicates are not detected if you are offline. Duplicate detection may also occur when you synchronize or go back 

online.  

 Resolve potential duplicate records.  

1. If the system detects that your record might be a potential duplicate, instead of saving the 

record, you'll see the Duplicates Detected dialog box.  

2. To open a record to make sure it is a potential duplicate, in the Potential duplicate records 

list, double-click the record.  

 If the duplicate-detection rule identified potential duplicate records in other record 

types, review records from each record type listed.  

3. If your new or updated record is not a duplicate, to create the new record, click Save Record.  

– OR –  

If your new or updated record is a duplicate, to cancel your changes, click Cancel.  

Notes  

 If you enter a duplicate record within a few minutes of entering the first record, Microsoft 

Dynamics CRM will not detect the duplicate record. The matchcodes for new and updated 

records are created every five minutes, rather than as a record is created.  

Duplicate detection can take place only if duplicate detection is enabled in Duplicate Detection Settings 
and if at least one duplicate-detection rule exists for the record type. More information: Avoiding Duplicate 
Records  

Working Offline 

If you install Microsoft Dynamics CRM for Outlook with Offline Access, you have the option of working offline with the 

Microsoft Dynamics CRM records that you own when you are not connected to the Microsoft Dynamics CRM server. 

 How to tell if you are offline 

You can tell that you are offline if:  

 The Windows notification area displays the Microsoft Dynamics CRM for Outlook Not 

Signed In icon .  

 The Microsoft Dynamics CRM toolbar displays the Go Online button.  

 The Microsoft Dynamics CRM menu bar displays the Go Online option.  
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Before you go offline, you can select a subset of Microsoft Dynamics CRM data to be available on your local computer. 

Any changes you make to this data when you work offline are saved to this local copy of your data. In addition, while 

you are working online, your local data is being updated periodically to help speed up going offline. 

For example, instead of taking the whole database with you, you can choose to copy only your active accounts, for 

example accounts for the State of Washington. These local data groups can be reset every time that you go offline and 

give you the flexibility to download only the data you need. This speeds up synchronization with the Microsoft Dynamics 

CRM server when you go offline and also when you go back online. However, if you chose to remove large amounts of 

data from your local copy, this can cause a longer synchronization. 

When you work offline, you can enter new information and edit existing records and activities. If you view edited 

records later, before you go online and synchronize your data, the information that you see reflects the changes that 

you've made.  

More information: Work with Data to Take Offline 

 The following list shows the features that are unavailable when you are offline  

Not available offline 

 Assigning records (except activities and cases)  

 Converting quotes to sales orders  

 Converting sales orders to invoices  

 Managing system administration  

 Updating system configuration  

 Managing service activities  

 Managing services  

 Using the Service calendar and Workplace calendar  

 Editing articles  

 Editing or managing sales literature  

 Changing organizations  

 Sharing records  

 Detecting duplicate records  

 Managing system jobs  

 Running some diagnostic tests  

 Running workflow rules  

 Create quick campaign and related activities from a Mail Merge  

Limited availability  

 Creating or viewing reports (based on local data groups and offline data)  

 Running some custom business process automating (plug-ins)  

Can be viewed, but cannot be edited offline 
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 Articles  

 Sales literature  

Microsoft Dynamics CRM applies all your additions and changes to the Microsoft Dynamics CRM server in the same 

order that you entered or updated it. If you made a change to a record while you are offline, and another user changes 

the same record during that time, when you go back online, your change will overwrite this change. 

The first time you go offline, it can take a significant amount of time to synchronize your local data with the Microsoft 

Dynamics CRM server. It is best to plan to do your first synchronization when you do not need to use Microsoft 

Dynamics CRM. While Microsoft Dynamics CRM for Outlook is synchronizing, Microsoft Dynamics CRM is not available.  

Workflows 

When you are working offline, workflow notifications are not generated until you go back online. 

Also, if the changes you've made to offline accounts are set to trigger an automated workflow process or system job, 

the process is automatically triggered after you go back online. For example, if you have a rule that routes new leads to 

a welcoming team, a qualified lead that is created offline is routed to the welcoming team after you go back online.  

Duplicate Detection 

There is no duplicate detection while you are working offline. Duplicate detection is triggered automatically when you 

go back online or synchronize. You can set a personal option to determine whether or not duplicates are created when 

they are identified. 

More information: Avoiding Duplicate Records 

Offline Security Permissions 

You have the same security permissions and rights offline as when you are online. For example, if you do not have 

permissions to create accounts online, you will not be able to do this offline. If a contact was shared with read-only 

rights, you will not be able to update or delete that contact offline even though you are working with a local copy. 

Work with Data to Take Offline 

Define filters for data to take offline  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Common Task Permissions  

You use local data groups to define what data is taken offline. Default local data groups are provided that you can 

edit.  

 Tip 

 You can set your personal options so that filters always open in Simple or Detailed mode.  

 

 

1. In Microsoft Dynamics CRM for Outlook, on the Microsoft Dynamics CRM menu bar, click Modify 

Local Data Groups.  

2. In the Local Data dialog box, on the Data Group tab, open the data group that you want to edit. To 

create a new data group, on the Actions toolbar, click New.  
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The Data Group tab lists existing data groups criteria, grouped by record types used in the filter, 

such as Competitor or Cases. Each row represents one set of filter criteria, and contains three 

columns: the field to use in the filter (for example, Account Name or City), the query relational 

operator (for example, Equals or Contains), and the value to filter on (for example, Open).  

3. To edit a filter criteria row, click the field and select a different field, or click the query relational 

operator and select a different operator, or click the value, and enter a new value. For some values, 

you can click the Select Values button  to open the Select Values dialog box and select the 

value you want.  

4. To add a criteria row:  

a. In the area for the record type that the field belongs to, click Select, and specify the field to 

filter on.  

b. Click the query relational operator, and select an operator.  

c. Click Enter Value, and enter a value to filter on. For some values, you can click the Select 

Values button  to open the Select Values dialog box and select the value you want.  

5. To group criteria, you must select two or more rows for the same record type. For example, Sales 

Stage and Est. Revenue are both field values in the Opportunity record type and two rows that 

specify filter criteria for these fields can be grouped. However, rows with field values from different 

record types, such as Account and Opportunity record types, cannot be grouped.  

a. For each row you want to group, in detailed mode, click the Options menu button  for 

that row, and then click Select Row.  

b. On the Filter toolbar, select Group AND or Group OR.  

c. To remove a row from a group, click the Options menu button  for that row, and then 

click Delete.  

d. To select a group, click the Options menu button  for that group, and then click Select 

Group.  

e. To add a criteria clause to a group, click the Options menu button  for that group, click 

Add Clause, and then select the field, query relational operator, and value.  

f. To unselect a group that has been previously selected, click the Options menu button  for 

that group, and then click Deselect Group.  

g. To ungroup a group, click the Options menu button  for that group, and then click 

Ungroup.  

h. To change a Group AND group to a Group OR group, or a Group OR group to a Group 

AND group, click the Options menu button  for that group, and then click Change to OR 

or Change to AND.  

Tips 

 To clear all criteria and start over, on the Filter toolbar, click Clear, and then click Confirm.  

 To delete a row, click the Options menu button  for that row, and then click Delete.  

 To hide a row in simple mode, while you are in detailed mode, click the Options menu button  for 

that row, and then click Hide in Simple Mode.  

 If you have a hidden row when viewing filter criteria in simple mode and you want to show that row 

again, then in detailed mode, you must click the Options menu button  for that row, and then 

click Show in Simple Mode.  



 

434 Microsoft Dynamics CRM 4.0 User’s Guide 
 

Synchronizing Information 

While you are online with Microsoft Dynamics CRM for Microsoft Office Outlook, changes you make to tracked records in 

Outlook or Microsoft Dynamics CRM are immediately visible to others. Changes that others make to Microsoft Dynamics 

CRM are immediately visible to you. Changes that others make to records you are tracking in Outlook, may not be 

visible in Outlook for up to 15 minutes.  

For example, you create a contact in Outlook, and track it. All the other online users will be able to view it in Microsoft 

Dynamics CRM when it is saved. If another user changes the contact in Microsoft Dynamics CRM, then it could take up 

to 15 minutes for you to see the change in the Outlook contact, however if you chose to "View in CRM" you would see 

the change immediately. 

If you are working offline, your changes are "stored" in your local data, which was updated when you went offline. 

Changes you make to tracked records in Outlook are also made in your local copy of the corresponding record. When 

you go back online, your changes are made to the Microsoft Dynamics CRM server and visible to everyone and the 

current data is available to you. 

The Microsoft Dynamics CRM address book is synchronized separately and on a different schedule. 

Synchronizing and Tracking Microsoft Dynamics CRM Data with Outlook 

Also, you can track messages and records in Microsoft Dynamics CRM by linking the record to a Microsoft Dynamics 

CRM record. The process of linking a record is as simple as selecting one or more records, clicking a button on the 

toolbar, and then selecting a related account or contact. You can select an option to change the message icon to 

indicate a tracked record. You can link a record at any time and all replies to linked e-mail messages are also tracked. 

Tracked e-mail messages, contacts, tasks, and appointments are updated to Microsoft Dynamics CRM immediately while 

you are online. If you are offline, these items are updated in your local data and will be synchronized with the Microsoft 

Dynamics CRM server when you go back online. 

More information: Save Outlook Contacts, Tasks, and E-mail Messages as Microsoft Dynamics CRM Records 

You can also set up your contact options to copy all your selected contacts from the Microsoft Dynamics CRM server 

into your Outlook Contacts folder. 

More information: Set Personal Options 

Synchronizing Microsoft Dynamics CRM and Local Data  

If you have Microsoft Dynamics CRM for Outlook with Offline Access you can work offline with a pre-defined set of 

Microsoft Dynamics CRM data that is on your computer. This is your local data and what data is copied is defined in a 

local data group. Microsoft Dynamics CRM for Outlook updates your local data every time that you go offline and every 

time that you go back online. You can update your Microsoft Dynamics CRM information by connecting to the Microsoft 

Dynamics CRM server either where you have high-speed network access (high bandwidth), such as at your office, or 

through a dial-up modem account, such as in your hotel room when you are traveling. 

Updating your local data when you go offline or online can take an extended period of time. To go online and offline 

more quickly, you can turn on an option to update local data in the background. After you manually synchronize the 

first time, when you are online your business's Microsoft Dynamics CRM data updates your Microsoft Dynamics CRM for 

Outlook local data on a regular schedule, also typically every 15 minutes, or on a schedule your system administrator 

sets up. You can set your personal options to synchronize your local data with Microsoft Dynamics CRM more 

frequently.  

If you synchronize your data regularly, either by manually synchronizing or setting your options to synchronize your 

offline data periodically in the background while you are online, you can make sure that you have up-to-date 

information and you can reduce the synchronization time. 
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More information: Set Personal Options 

This address book is synchronized with Microsoft Dynamics CRM automatically when you start Outlook and then once 

every 24 hours. If you make changes or additions to the address book that you need to access immediately, you can 

start a manual synchronization. 

More information: Synchronize Data 

Data Loss Prevention During the Synchronization Process 

To prevent data loss, when you go offline Microsoft Dynamics CRM synchronizes data from the server to your local 

data, and then applies all of your changes to the server. All server transactions post completely before records are 

erased from your local data.  

If you create a record offline that is identified by the system as a possible duplicate, you can set whether or not to 

create a duplicate record. 

When you run a synchronization process, Microsoft Dynamics CRM overwrites existing information without verifying or 

comparing the last saved date. For example, if you changed a record a week ago but do not synchronize that record, 

and then someone else changes that same record earlier today and you run a synchronization process in the afternoon, 

your changes will overwrite the other person's even though your changes are older. However, if you and another user 

change different data, both changes are saved. For example, if you have a customer named Jeff Smith, and you change 

his first name to John, and another user changes his last name to Rodman, when you both synchronize your data, the 

customer's name becomes John Rodman.  

Synchronize Data 

There are two types of synchronization with Microsoft Dynamics CRM for Outlook : synchronization with Outlook and 

synchronization with local data.  

If you have Microsoft Dynamics CRM for Outlook with Offline Access installed on your computer, you can work offline 

with Microsoft Dynamics CRM data. When you go offline, Microsoft Dynamics CRM copies a subset of the data on the 

Microsoft Dynamics CRM server to your computer. This local data is defined by a local data group and by the 

synchronization options set in your personal options.  

After you go back online, changes you made to your local data are updated to the Microsoft Dynamics CRM server. If 

you encounter problems during synchronization, you are given choices on how to continue. You may also be notified of 

duplicate records. 

Set synchronization options in Microsoft Dynamics CRM for Outlook  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about specific 
permissions and performing this task while offline: Common Task Permissions  

You can select which record types you want to synchronize between Outlook and Microsoft Dynamics CRM for Outlook 
and how often you want to synchronize between applications. This tab is not available in the Web application.  

 

1. Start Outlook. (Microsoft Dynamics CRM for Outlook must be installed.)  

2. On the Microsoft Dynamics CRM menu bar, click Options.  

3. In the Set Personal Options dialog box, on the Synchronization tab, you can select which record 

types are synchronized:  
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 Appointments I'm attending 

Select this option if you want to synchronize appointments and service activities in which you 

are a participant and have accepted the appointment.  

 My tasks  

Select this option if you want to synchronize tasks that you own in Microsoft Dynamics CRM.  

 Contacts 

Select this option if you want to synchronize contacts that you own in Microsoft Dynamics 

CRM. 

If you delete a contact you own in Microsoft Dynamics CRM or in Microsoft Dynamics CRM for 

Outlook, it will not be deleted in the other application.  

 My phone calls 

Select this option if you want to synchronize phone calls that you own in Microsoft Dynamics 

CRM.  

 My letters 

Select this option if you want to synchronize letters that you own in Microsoft Dynamics CRM.  

 My faxes 

Select this option if you want to synchronize faxes that you own in Microsoft Dynamics CRM.  

4. If you want to include company names from Outlook contacts, select Update Company fields with 

parent account names.  

Important: This setting only affects newly tracked contacts. Future changes are not synchronized.  

5. If you have more than one computer running Microsoft Dynamics CRM for Outlook, select this 

computer to be the synchronizing client.  

6. If your organization permits it, you can define how often Microsoft Dynamics CRM items in your 

Microsoft Dynamics CRM for Outlook folders are updated:  

 Synchronize the CRM items in my Outlook folders every 

Select this option and select the number of minutes. You can increase the amount of time 

between synchronization of items in your Microsoft Dynamics CRM for Outlook folders. Your 

administrator sets the minimum time allowed between synchronization.  

7. Select how duplicates are handled during synchronization:  

 Create the duplicates 

This option allows records to be created even if key fields contain the same data. 

More information: Avoiding Duplicate Records  

 Do not create duplicates 

This option blocks records from being created if key fields contain the same data.  

8. To save your changes and close the dialog box, click OK.  
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Set address book options in Microsoft Dynamics CRM for Outlook  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Common Task Permissions  

You can select how the address book is managed in Outlook and Microsoft Dynamics CRM for Outlook and how 
often you want to synchronize between applications. This tab is not available in the Web application.  

 

1. Start Outlook. (Microsoft Dynamics CRM for Outlook must be installed.)  

2. On the Microsoft Dynamics CRM menu bar, click Options.  

3. In the Set Personal Options dialog box, on the Address Book tab, you can select how contacts 

and other record types are synchronized, and whether or not e-mail recipients are linked to 

Microsoft Dynamics CRM records.  

4. By default, the Outlook Address Book is synchronized with the Microsoft Dynamics CRM address book 

every 24 hours. If your organization permits it, you can change this interval. To change this interval, 

change the number between 1 and 60. Your administrator sets the minimum time allowed between 

synchronization.  

5. To save your changes and close the dialog box, click OK.  

Note 

If you want to synchronize your address book manually, synchronize Microsoft Dynamics CRM manually. In Microsoft 

Dynamics CRM for Outlook, on the Microsoft Dynamics CRM menu bar, click Synchronize Outlook with CRM. 

Define filters for data to take offline  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Common Task Permissions  

You use local data groups to define what data is taken offline. Default local data groups are provided that you can 

edit.  

 Tip 

 You can set your personal options so that filters always open in Simple or Detailed 

mode.  

 

 

1. In Microsoft Dynamics CRM for Outlook, on the Microsoft Dynamics CRM menu bar, click Modify 

Local Data Groups.  

2. In the Local Data dialog box, on the Data Group tab, open the data group that you want to edit. To 

create a new data group, on the Actions toolbar, click New.  

The Data Group tab lists existing data groups criteria, grouped by record types used in the filter, 

such as Competitor or Cases. Each row represents one set of filter criteria, and contains three 
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columns: the field to use in the filter (for example, Account Name or City), the query relational 

operator (for example, Equals or Contains), and the value to filter on (for example, Open).  

3. To edit a filter criteria row, click the field and select a different field, or click the query relational 

operator and select a different operator, or click the value, and enter a new value. For some values, 

you can click the Select Values button  to open the Select Values dialog box and select the 

value you want.  

4. To add a criteria row:  

a. In the area for the record type that the field belongs to, click Select, and specify the field to 

filter on.  

b. Click the query relational operator, and select an operator.  

c. Click Enter Value, and enter a value to filter on. For some values, you can click the Select 

Values button  to open the Select Values dialog box and select the value you want.  

5. To group criteria, you must select two or more rows for the same record type. For example, Sales 

Stage and Est. Revenue are both field values in the Opportunity record type and two rows that 

specify filter criteria for these fields can be grouped. However, rows with field values from different 

record types, such as Account and Opportunity record types, cannot be grouped.  

a. For each row you want to group, in detailed mode, click the Options menu button  for 

that row, and then click Select Row.  

b. On the Filter toolbar, select Group AND or Group OR.  

c. To remove a row from a group, click the Options menu button  for that row, and then 

click Delete.  

d. To select a group, click the Options menu button  for that group, and then click Select 

Group.  

e. To add a criteria clause to a group, click the Options menu button  for that group, click 

Add Clause, and then select the field, query relational operator, and value.  

f. To unselect a group that has been previously selected, click the Options menu button  for 

that group, and then click Deselect Group.  

g. To ungroup a group, click the Options menu button  for that group, and then click 

Ungroup.  

h. To change a Group AND group to a Group OR group, or a Group OR group to a Group 

AND group, click the Options menu button  for that group, and then click Change to OR 

or Change to AND.  

Tips 

 To clear all criteria and start over, on the Filter toolbar, click Clear, and then click Confirm.  

 To delete a row, click the Options menu button  for that row, and then click Delete.  

 To hide a row in simple mode, while you are in detailed mode, click the Options menu button  for 

that row, and then click Hide in Simple Mode.  

 If you have a hidden row when viewing filter criteria in simple mode and you want to show that row 

again, then in detailed mode, you must click the Options menu button  for that row, and then 

click Show in Simple Mode.  
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Synchronize with Microsoft Outlook manually  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Common Task Permissions  

Outlook and Microsoft Dynamics CRM for Outlook regularly synchronize linked data. You can change how often 

this data is synchronized and what data is synchronized in your personal options.  

More information: Set Personal Options 

You can update linked data manually with the following procedure. This procedure does not take you offline, nor 

does it update your offline data.  

 

1. In Microsoft Dynamics CRM for Outlook, on the Microsoft Dynamics CRM menu bar, click Synchronize 

Outlook with CRM.  

2. In the Synchronizing Microsoft Dynamics CRM Data dialog box, click Details to view the 

progress of the synchronization. You can view information on the following tabs:  

 Tasks. This tab displays information about the number of records and activities that are 

being synchronized.  

 Errors. This tab displays an explanation of any errors that occur during the synchorization 

process, so that you can correct them.  

Notes 

 To view the tasks and errors of the last synchronization, on the Microsoft Dynamics CRM menu bar, 

click Synchronization Progress.  

 If you receive the error message "CRM server Not Found", verify that you have Internet connectivity 

and that the Microsoft Dynamics CRM server is running and then try again.  

 Duplicates are not detected if you are offline. Duplicate detection may also occur when you 

synchronize or go back online.  

 Resolve potential duplicate records.  

1. If the system detects that your record might be a potential duplicate, instead of saving the 

record, you'll see the Duplicates Detected dialog box.  

2. To open a record to make sure it is a potential duplicate, in the Potential duplicate records 

list, double-click the record.  

 If the duplicate-detection rule identified potential duplicate records in other record types, 

review records from each record type listed.  

3. If your new or updated record is not a duplicate, to create the new record, click Save Record.  

– OR –  

If your new or updated record is a duplicate, to cancel your changes, click Cancel.  

Notes  
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 If you enter a duplicate record within a few minutes of entering the first record, Microsoft 

Dynamics CRM will not detect the duplicate record. The matchcodes for new and updated 

records are created every five minutes, rather than as a record is created.  

Duplicate detection can take place only if duplicate detection is enabled in Duplicate Detection Settings 
and if at least one duplicate-detection rule exists for the record type. More information: Avoiding Duplicate 
Records  

Go offline  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: Common Task Permissions  

You can go offline if you have installed Microsoft Dynamics CRM for Outlook with Offline Access and have offline 

permissions.  

Whenever you go offline, data is synchronized between Microsoft Dynamics CRM and Microsoft Dynamics CRM for 

Outlook to ensure that you have access to the latest data on your computer.  

Whenever you go back online, the changes you've made to your local records are uploaded to the Microsoft 

Dynamics CRM database.  

You can also update your local data periodically while you are still online. This reduces the time it takes to 

synchronize before going offline. This interval is set in your personal options.  

More information: Set Personal Options 

 

1. In Outlook, on the Microsoft Dynamics CRM toolbar, click Go Offline.  

You can track the progress of the records as they are updated in the Synchronizing Microsoft 

CRM Data dialog box.  

2. To view the details of the synchronization, click Details. To receive a confirmation that the 

synchronization is complete, select the Show Confirmation When Complete check box.  

3. If the check box is selected, click OK to close the confirmation message and to complete the update.  

The Windows notification area displays the Microsoft Dynamics CRM for Outlook Not Signed 

In icon  and the button on the Microsoft Dynamics CRM toolbar changes to Go Online. Other 

options may also change.  

Notes 

 When you go back online, your data will be re-synchronized with Microsoft Dynamics CRM and 

Microsoft Dynamics CRM for Outlook, and you may be notified of any duplicate records. More 

information: Avoiding Duplicate Records 

To go back online, on the Microsoft Dynamics CRM toolbar, click Go Online.  

 If you attach a file to a Microsoft Dynamics CRM record while you are working offline, the attached 

files must be available in the same location when you synchronize your data in order to be uploaded 

to the Microsoft Dynamics CRM database. For example, if you are visiting a customer and you 

borrow a disk with a file that you want to attach to the customer's record, first copy the file to your 

local hard drive, then attach it from there. After you've synchronized your data and the attachment 

file has been uploaded to the Microsoft Dynamics CRM database, you can delete your local copy.  
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Resolve data synchronization errors  

 Can I do this task?  

This task requires permissions that are found in all default security roles. More information about 
specific permissions and performing this task while offline: E-mail Permissions  

During synchronization, if you encounter errors that prevent some of your Microsoft Dynamics CRM data from 

being synchronized when you go online, the Synchronizing Microsoft Dynamics CRM Data dialog box opens, 

and the Error tab displays the list of errors. 

 

1. In the Synchronizing Microsoft Dynamics CRM Data dialog box, choose one of the following 

options:  

 Finish going online and do not save the data changes made offline 

Choose this option when you are unable to fix or change errors, for example, if you no longer 

have access to a record or the record has been deleted. You can also choose this option if 

you've made minor changes that can be discarded or updated later.  

Important Discarding changes made while offline does not revert those changes. You will 

need to revert those changes manually.  

 Stay offline and try to fix the errors so all the data will synchronize 

Choose this option if you want to attempt to fix the errors by using the information provided 

in the Synchronizing Microsoft Dynamics CRM Data dialog box. Any data entered or 

changed after you went offline will be lost. If you know which records you have added or 

changed, you can print them out so you can reenter the data later.  

 Resolving Possible Duplicate Records If duplicates are detected during synchronization, 

you can resolve them.  

More information: Check for Duplicates  

2. Click OK to continue.  

 . The Synchronizing Microsoft Dynamics CRM Data dialog box will appear again. If the problem 

cannot be fixed, use the Web application to open the server version of the records that caused 

synchronization errors. Compare changes between each server version and the version you have in 

Microsoft Dynamics CRM for Outlook, and make your changes to the server version. When all the 

server versions of the items have been updated, go online and discard the changes you made 

offline.  
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Troubleshooting 

Accessing Parts of the Application - Troubleshooting 

I'm a system administrator. Why don't I don't see the Sales, Marketing, 

or Service areas?  

If your user record has the Access Mode set to Administrative, you cannot access the Sales, Marketing, or 

Service areas of Microsoft Dynamics CRM, or any of the entities in those areas. This access mode allows your 

organization to create a user for a member of the IT department for administering and customizing Microsoft 

Dynamics CRM without using up a seat from your Microsoft Dynamics CRM license.  

To see the areas, the access mode must be set to either Full or Read-Only.  

To change the access mode:  

1. In the Navigation Pane, click Settings, click Administration, and then click Users.  

2. Double-click your user record.  

3. In the Client Access License (CAL) Information section, in Access Mode, select either Full or 

Read-Only.  

4. Click Save and Close.  

 

Related Topics 

Troubleshooting 



 

444 Microsoft Dynamics CRM 4.0 User’s Guide 
 

Managing Users 

Why is an area, field, button, or action dimmed or missing?  

When you read the Help, you may find that a task is described, but that the item is dimmed or not visible to you in 

Microsoft Dynamics CRM. The areas, fields, buttons, and actions that you have access to are controlled by your 

security role.  

For example, if the Schedule Manager or Scheduler security role is the only security role assigned to your account, 

you have permission to do tasks related to service scheduling, but not to other areas of the application, so the Sales 

area would not be visible.  

It is also possible that your system administrator customized your security role. For example, some organizations 

control how new accounts are added by removing the Create privilege from many security roles. If your security role 

was missing the Account Create privilege, the accounts list you see would not include New. 

Here's another example: you have a Salesperson security role and assign an account record to another user. When 

you open the record, Assign is no longer on the Actions  menu. It's not there because you no longer own the 

record, and you only have the Assign privilege on account records you own.  

If you are curious about what privileges are assigned to your security role, all default security roles allow you to 

browse the Users and Security Roles areas.  

View the security roles you are assigned  

1. In the Navigation Pane, click Settings, click Administration, and then click Users.  

2. Find yourself in the list, and double-click your name.  

3. Click Roles, and then see which roles you are assigned.  

4. Double-click each security role you are assigned, and then click each tab to see the privileges that are 

associated with this role.  

If you don't have permission to do a required task, contact your manager or system administrator.  

For any record, you can also check what permissions you have.  

To see your permissions on a record 

1. With the record open, click the File menu button , and then click Properties.  

The privileges selected under Security indicate which permissions you have for this record.  

 

Related Topics 

Troubleshooting 

Controlling Data Access 

Can I make a record private?  

A record is private only if all security roles only include the Read privilege at the User for the record type, and if the 

record has not been shared.  

For example, by default, all security roles include the Read privilege at the Organization level for contacts, 

accounts, and activities, so unless security roles have been customized in your organization, account, contact, and 

activity records are not private.  

A user cannot reduce privileges that are granted in security roles.  

 

Related Topics 

Troubleshooting 
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Work with Security Roles 

Controlling Data Access 

Why did the Settings button in the Navigation Pane of the Microsoft 

Dynamics CRM Web application disappear?  

Some features in the Settings area are not available if you are offline or if you do not have permissions to access the 

area. Contact your system administrator to update your permissions.  

More information: Working Offline 

 

Related Topics 

Troubleshooting 

Doing CRM Work in Outlook 

Synchronizing Information 
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Why are some areas or features missing in my Microsoft Dynamics CRM 

for Outlook folders?  

 If you are offline, some data, areas, and features are not available to you. You can tell if you are offline if 

any of the following appear in your Microsoft Dynamics CRM for Microsoft Office Outlook : 

 The Windows notification area displays the Microsoft Dynamics CRM for Outlook offline 

icon .  

 The Microsoft Dynamics CRM toolbar displays the Go Online button.  

 The Microsoft Dynamics CRM menu bar displays the the Go Online option.  

If you are offline, you can go back online by clicking the Go Online button. You can set up local data 

groups to define what data you take offline. 

More information: Working Offline 

 You may not have permissions to access specific areas or features. Contact your system administrator.  

 

Why can't I view my Microsoft Dynamics CRM calendars in Outlook?  

 If you are offline, the Service calendar is not available in Microsoft Dynamics CRM for Microsoft Office Outlook.  

 If you are in Microsoft Dynamics CRM for Microsoft Office Outlook, the Workplace calendar is not available, 

unless the Site Map has been customized.  

 If you cannot view the Service calendar, you do not have the Read privilege for the Service record type. This 

might be because you have custom or edited security roles. The Read privilege for the Service record type is 

included in all the default security roles available in Microsoft Dynamics CRM. 

To make the calendar visible for users with a specific security role, click Settings, click Security Roles. Open 

the security role. On the Service Management tab, for the Service record type, add the Read privilege.  

Entering Data – Troubleshooting 

How do I copy a record?  

It is not possible to copy a record.  

Tip 

If you need to add multiple records with similar data, you can save time by using the Import Data Wizard:  

1. Create an Advanced Find search that includes all the columns that have data for the record, and displays any 

records that you want to use as original records for copying.  

2. Export the results of the Advanced Find search into a Microsoft Office Excel worksheet.  

3. In the worksheet, copy the row as needed, and edit the new rows.  

4. Save the worksheet as a comma-separated values file.  

5. Import the records.  

 

Related Topics 

Troubleshooting 

Work with Imports 
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Importing Data 

How do I link address information between accounts and contacts?  

If you use a link from the Details area of one record to create a related record, address fields are mapped. In this 

case, information from the open record populates the new record. For example, a new record created by either of the 

following actions includes address data from the first record:  

 From an open contact record, click Sub-Contacts, and then click New Contact.  

 From an open account record, click Sub-Accounts, and then click New Account. Alternatively, click 

Contacts, and then click New Contact.  

If you create a new account or contact record in any other way, address data is not mapped.  

 

Related Topics 

Troubleshooting 

Work with Accounts 

Work with Contacts 

Managing Accounts and Contacts 

What if there isn't a field for information I need to enter?  

If the data you want to track doesn't match the fields on a form, ask your system administrator or system customizer 

to customize the form.  

They can make the following changes to forms: 

 Remove fields you don't need.  

 Add new fields.  

 Change the order in which fields appear to match the order in which you enter data.  

 Change the tab order of fields to match the order in which you enter data.  

 Change the values listed, or the default value, for drop-down fields.  

 

Related Topics 

Troubleshooting 

Requesting User Interface Changes 

Customizing Entities 

Work with Entities 
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What if I need new options in a drop-down list?  

If the value you need is not in a list, such as the subject list or the reasons for closing a record, lead sources, or 

industry types, ask your system administrator or system customizer to customize the list.  

They can make the following changes to lists: 

 Remove values that are not needed.  

 Add new values.  

 Change the order in which the values are displayed.  

 Set or change the default value for the list.  

 Remove the default value requirement.  

 

Related Topics 

Troubleshooting 

Requesting User Interface Changes 

Customizing Entities 

Work with Entities 

Controlling Data Access 

How do I change the default value for a field?  

Two types of fields can have default values: Boolean (bit) fields and drop-down (picklist) lists. Contact your system 

administrator or system customizer with your suggestion for changing a default value.  

If you want default values in other types of fields, your system administrator or system customizer can add onLoad 

events to the field. More information: Form Scripting  

 

Related Topics 

Troubleshooting 

Requesting User Interface Changes 

Form Scripting 

Why do I get a "No resources selected for this activity" message when I 

create an appointment or activity?  

This error occurs if you have not selected a required resource for a service activity or appointment while creating the 

activity. You can continue to save the activity.  

If the service activity or appointment is for your own use, be sure to add yourself as a resource, or the activity will not 

appear on your Workplace calendar, but will appear in the Service calendar. If you are using Microsoft Dynamics CRM 

for Microsoft Office Outlook and do not select yourself as a resource, the appointment or service activity will not 

synchronize with your Outlook calendar. 

 

Related Topics 

Troubleshooting 

Working with Appointments 

Booking Service Activities in the Service Calendar 
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What does the message mean that I get when I create or schedule a 

service activity?  

There are several messages that you might receive while creating or editing a service activity. These are usually 

related to the lack of availability of resources for the service activity.  

 The resources available for the selected dates or times do not meet the minimum resource 

requirements for this service.  

There are not any resources available to perform this service. If you have selected a specific time or date or 

range of times and dates, there may be no resources scheduled during that time. Remove those criteria and try 

again. If you continue to see this message, ask your system administrator to confirm that resources have been 

assigned to perform the service.  

 Service Selection Rules for the required resource (user name) cannot be met. To see selection 

rules, open the record for this service.  

The resource requested does not meet the minimum requirements of the service, for example, the resource 

may not be part of a defined resource group for the service. Remove or select another resource from the 

search query and try again. If you continue to see this message, ask your system administrator to confirm that 

resources have been assigned to perform the service.  

 No results found. Try choosing different dates or letting the system choose your resources 

automatically.  

If you continue to see this message, ask your system administrator to confirm that resources have been 

assigned to perform the service.  

 

Related Topics 

Troubleshooting 

Scheduling Users and Other Resources 

Entering Data - Troubleshooting 

Why does the contract that I created to track cases and activities by 

minutes track by the number of cases instead?  

There are two types of allotment types, one tracks the number of cases opened per contract and the other tracks by 

total minutes spent on activities for the case. First, verify that the contract template used to create the contract has 

the correct allotment type. If not, you will need to cancel the contract and create a new one that uses a contract 

template with the correct allotment type.  

This issue can also occur if the contract was created from the related records for an account. When the contract is 

created, the system can associate only one record with the contract, which is the account. The contract template is 

lost. If this occurs, recreate the contract from the Contracts list in the Service area, and then re-associate any cases 

or activities. 

 

Related Topics 

Troubleshooting 

Creating Contract Templates 
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Finding Data – Troubleshooting 

Why are some fields missing from the list in Advanced Find?  

In Advanced Find, when you click Select, some fields from each entity may not be listed. For example, by default, 

the Relationship Type field (customertypecode) is not listed for accounts and contacts.  

A person with the System Administrator or System Customizer security role can specify which attributes are available 

for Advanced Find. This requires editing the properties of the attribute in the Customization area to set Searchable 

to Yes. When an attribute is set as searchable, it is also included in the list of available find columns, used during 

customization of the Quick Find View and the lookup view. More information: Create or Edit Entity Attributes  

 

Related Topics 

Troubleshooting 

Work with Advanced Find 

How can I select records from multiple results pages?  

You can select multiple records on one page in a list by holding down the CTRL key while you click the other records 

that you want. However, you cannot select multiple records from multiple pages.  

You have two options if you need to select records that are on multiple results pages:  

 Use Advanced Find to narrow the list so that all records show up on one page.  

 Change your personal options so that more records are displayed on each page. By default, the Microsoft 

Dynamics CRM Web application displays 50 records per page. You can increase the number of records 

displayed and thereby increase the number of records you can select at one time. To display up to a maximum 

of 250 records per page:  

1. On the Tools menu, click Options.  

2. On the General tab, in the Records Per Page list, select the number of records to display per 

page.  

3. Click OK.  

This changes the number of items that is displayed for all lists, which may slow response time when you switch 

record types. Therefore, you might want to set it back to a smaller number when you are done with this bulk 

action.  

 

Related Topics 

Troubleshooting 

Work with Advanced Find 
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How can I find all records that don't have a related record?  

Advanced Find cannot find all records of one record type that don't have a related record. For example, you cannot 

use Advanced Find to find all cases that have not received a phone call within the last week.  

There are two options for finding out this type of information:  

 Use one of the default reports in Microsoft Dynamics CRM for common queries, such as Neglected Cases, 

Neglected Accounts, and Neglected Leads.  

 Use Microsoft Office Excel and create a query directly from the Microsoft Dynamics CRM database. This 

requires an understanding of how Microsoft Dynamics CRM data is stored in the database, and of how to use 

Microsoft Query, a built-in query language used in Excel. For an article that provides step-by-step instructions, 

see Learn More.  

 

Related Topics 

Troubleshooting 

Neglected Cases Report 

Neglected Accounts Report 

Neglected Leads Report 

Write a Report Using Report-Writing Tools 

Work with Advanced Find 

Customizing and Organizing Reports 

How can I create a view or export data that includes fields from related 

records?  

Advanced Find search results can include fields from related records.  

To specify fields from related records in Advanced Find:  

1. Click Advanced Find.  

2. Click Edit Columns, and then click Add Columns.  

3. Select the related record type, select the columns from that record type, and then click OK.  

4. Click OK again to close the Edit Columns dialog box.  

Note: You cannot sort Advanced Find search results based on a column from a related record. If you need to sort by 

a column from a related record, export your list to a Microsoft Office Excel worksheet or PivotTable, and sort the data 

there.  

 

Related Topics 

Troubleshooting 

Write a Report Using Report-Writing Tools 

Export Data to Excel 

Work with Advanced Find 

Customizing and Organizing Reports 



 

452 Microsoft Dynamics CRM 4.0 User’s Guide 
 

How can I save an Advanced Find view as my default view?  

You cannot use an Advanced Find saved view as your default view.  

If you create a view that you think should be the default view for all users, ask your system administrator or system 

customizer to create that view.  

 

Related Topics 

Troubleshooting 

Requesting User Interface Changes 

Customizing Entities 

Work with Views 

Exporting Data to Excel – Troubleshooting 

How can I create a view or export data that includes fields from related 

records?  

Advanced Find search results can include fields from related records.  

To specify fields from related records in Advanced Find:  

1. Click Advanced Find.  

2. Click Edit Columns, and then click Add Columns.  

3. Select the related record type, select the columns from that record type, and then click OK.  

4. Click OK again to close the Edit Columns dialog box.  

Note: You cannot sort Advanced Find search results based on a column from a related record. If you need to sort by 

a column from a related record, export your list to a Microsoft Office Excel worksheet or PivotTable, and sort the data 

there.  

 

Related Topics 

Troubleshooting 

Write a Report Using Report-Writing Tools 

Export Data to Excel 

Work with Advanced Find 

Customizing and Organizing Reports 

When I export data to a Microsoft Office Excel dynamic worksheet or 

PivotTable, why do I receive a "Connection failed. Reason: not associated 

with a trusted SQL connection" error?  

This error occurs if you are accessing Microsoft Dynamics CRM from a different domain than the domain that 

Microsoft Dynamics CRM is installed on.  

To export a list of records to a dynamic Microsoft Office Excel worksheet or PivotTable, your computer must be on the 

same domain as the domain of the Microsoft Dynamics CRM server. If you are on a different domain, you can export 

a static worksheet.  

 

Related Topics 

Running Reports - Troubleshooting 
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Export Data to Excel 

Running Reports and Analyzing Data 

Importing Records – Troubleshooting 

How do I leave some fields in my source file unmapped?  

If you are using a data map for your import, you can specify that you want to ignore a column by selecting the 

column and then clicking Ignore. More information: Work with Data Maps  

If you are using automatic mapping in the Import Data Wizard, every field in your source file must be mapped to a 

unique field in Microsoft Dynamics CRM. All columns in your file will be imported. You have two options:  

 Remove columns from your source data that you do not need in Microsoft Dynamics CRM. The easiest way to 

do this is to make a copy of your source file, and open it with Microsoft Office Excel. Delete unused columns, 

and then save the file as a comma-separated values (.csv) file.  

 Customize the entity in Microsoft Dynamics CRM and add new attributes so that there is a destination for each 

source field in Microsoft Dynamics CRM.  

 

Related Topics 

Work with Imports 

Importing Data 

What are some common reasons a record might fail to import?  

When you are troubleshooting data imports, make small files with one or two records. It is much easier to locate the 

source of the problem when you are importing a small batch. To ensure a successful import, be sure to follow the 

steps in Prepare a file for import. More information: Work with Imports  

 

 Common error messages and suggested resolutions:  

 A SQL Server error occurred. For more information, contact your system administrator.  

This message indicates that a value in the source file exceeds the maximum number of characters that can 

be entered for the field. For example, a value for the Street field in a lead import exceeds the 50-character 

limit.  

To fix this error, reduce the number of characters in the field, and then run the data import again.  

 The lookup reference could not be resolved.  

Each entity in Microsoft Dynamics CRM has named lookup attributes that are used to connect one record 

with another record. For example, the Campaign Response entity has a required attribute, Source 

Campaign (campaignid).  

To fix this error, change the value to be a valid Microsoft Dynamics CRM globally unique identifier (GUID).  
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 The number of fields is different than the number of column headings.  

This error occurs when the number of columns that are present in the data row differ from the number of 

columns present in the column headings (or header row) of the source file. For example, if you have two 

column headings in a contacts file, but try to import three columns of data, the third column does not have 

a column heading.  

To fix this error, open the source file in Microsoft Office Excel and add missing column headings or data. 

Save the file as a comma-separated values (.csv) file.  

 The list value is not mapped.  

This error can occur if you are using an automatic map and the source file includes a column that is 

mapped to a drop-down list.  

To fix this error, create a data map to use with this import, and map the list values.  

 A record was not created or updated because a duplicate of the current record already exists.  

This error occurs when you are trying to import a record that has a potential duplicate in the system. 

Potential duplicates are determined based on current, published duplicate detection rules for the record 

type that you are importing.  

If the record you are trying to import is not a duplicate, determine the criteria used for identifying 

duplicates for that type of record, and modify the record so that it doesn't match the duplicate criteria.  

 An error has occurred. For more information, contact your system administrator.  

This error can occur if the format of data in one field in the row does not match what is expected in 

Microsoft Dynamics CRM. For example, you will receive this error if you have a text string instead of a date 

or a misformatted date in the Birthday field in a contact record.  

To fix this error, correct the format of any non-string fields in the row.  

 Non-printable characters found. 

For example, if the source data had paragraphs in the Description field, the Description field may have 

embedded carriage return/line feed (CR/LF) characters.  

To fix this error, save the file with Unicode or UTF-8 encoding. You can do this by using the following steps:  

1. Start Notepad.  

2. Open your comma-separated values source file.  

3. On the File menu, click Save As.  
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4. In the Encoding list, click Unicode or UTF-8.  

 The source data is not in the required format. 

For example, a picklist may have a field that is not mapped to a valid CRM field.  

To fix this error, ensure that non-empty valid values are mapped to the CRM field  

Related Topics 

Work with Imports 

Importing Data 

Why can't I process potential duplicate records as part of importing records?  

If you select duplicate detection when you start a data import, when potential duplicate records are detected as part 

of importing records, the potential duplicate records are not imported. You are not offered a choice for each record of 

whether to merge the records or delete or deactivate one of the records.  

If you want to have a choice for each potential duplicate record, turn off duplicate checking during import, and after 

the import job finishes, run duplicate detection to process potential duplicate records.  

 

Related Topics 

Work with Imports 

Work with Duplicate-detection Jobs 

Why are numbers rounded when I import data?  

When an attribute of the type decimal, money, or float is created in Microsoft Dynamics CRM, the precision, or 

number of decimals, is defined. If the number of decimals in the source data is more than the number that is 

specified for the attribute in Microsoft Dynamics CRM, the imported floating-point data is rounded to the number of 

decimals defined in the attribute definition. The precision value cannot be changed after an attribute is created.  

 

Related Topic 

Work with Imports 

When I import subjects, why don't they appear in the list of subjects?  

For imported subjects to be visible, the import source file must contain a column that maps to the Feature Mask 

attribute. The Feature Mask attribute determines whether the subject will be displayed in the subject tree. If 

Feature Mask is set to 1, the subject will be displayed. If it is empty or set to 0, the subject will not be displayed.  

To build the subject hierarchy in the subject tree, you map the column in the source file that contains the title of the 

parent subject to the Parent Subject attribute. If no parent subject is provided, the subject will appear at the top 

level of the hierarchy.  

 

Related Topics 

Importing Data 

Work with Imports 

Supporting Customer Service with Microsoft Dynamics CRM 

Work with Subjects 
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Why do I receive the message: "An error has occurred. For more 

information, contact your system administrator" when I am creating 

duplicate-detection rules, running duplicate detection, importing records, 

or saving data maps?  

Some Microsoft Internet Explorer add-ons can interfere with creating duplicate-detection rules, running duplicate 

detection jobs, importing records, and saving data maps.  

To see whether Internet Explorer is the cause of the error, try disabling Internet Explorer add-ons, one at a time:  

 On the Internet Explorer Tools menu, click Manage Add-ons, select an add-on, and then select Disable.  

 Retry the task that generated the error message. If you get the same error, enable the add-on that you 

previously disabled, and then try disabling a different add-on.  

 Repeat this process for all enabled add-ons until you find the one that must be disabled.  

 

Related Topics 

Work with Imports 

Work with Duplicate-detection Jobs 

Configuring the Application – Troubleshooting 

After I modify a security role, why does an entity disappear?  

A security role must have the Read privilege for an entity in order for it to appear anywhere in the application.  

If an entity is no longer visible to a user, make sure the security role includes Read privilege for the entity.  

 

Related Topics 

Troubleshooting 

Work with Security Roles 

Controlling Data Access 

Can I make a record private?  

A record is private only if all security roles only include the Read privilege at the User for the record type, and if the 

record has not been shared.  

For example, by default, all security roles include the Read privilege at the Organization level for contacts, 

accounts, and activities, so unless security roles have been customized in your organization, account, contact, and 

activity records are not private.  

A user cannot reduce privileges that are granted in security roles.  

 

Related Topics 

Troubleshooting 

Work with Security Roles 

Controlling Data Access 

Sending E-mail Messages – Troubleshooting 

When I send an e-mail message to someone in my organization, why are two  
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e-mail activities created? 

Microsoft Dynamics CRM is designed to create multiple e-mail activities for e-mail messages sent to users inside your 

organization, one activity for the person creating the e-mail activity and one activity for every recipient. You can turn 

off this feature.  

1. In the Navigation Pane, click Settings, click Administration, and then click System Settings.  

2. On the E-mail tab, clear the Track e-mails sent between CRM users as two activities check box.  

3. Click OK.  

Related Topics 

Doing CRM Work in Outlook 

Synchronizing Information 

What are the extra numbers in the Subject line of my e-mail messages and 

how do I get rid of them?  

The tracking token, which appears as a series of numbers and letters after the subject line of outgoing e-mail 

messages, is used to improve automatic linking of records between Microsoft Dynamics CRM for Outlook and 

Microsoft Dynamics CRM. When used, it is generated automatically and cannot be removed from existing e-mail 

messages. 

If you do not want the token to appear in future messages, you have the following options. 

 Turn off the tracking token for the entire system.  

This option is set in the System Settings area. If you do not want to lose the functionality provided by the 

tracking token, you can shorten the tag by editing the auto-numbering options for the tracking token on the E-

mail tab of the System Settings dialog box.  

More information: Manage System Settings 

 Turn off the tracking token as mentioned, and for individual users, accept all incoming e-mail messages as 

Microsoft Dynamics CRM activities. This does not enable the marketing features. This option is set in your 

Personal Options.  

More information: Set Personal Options 

 

Related Topics 

Troubleshooting 

Doing CRM Work in Outlook 

Work with Subjects 
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Why do some e-mail addresses in the Send or From lines appear in red 

text?  

A red e-mail address and the Unresolved Address button  indicates that the address does not match any 

record in Microsoft Dynamics CRM. There are several reasons why an e-mail address can be in this state:  

 The e-mail address is not in Microsoft Dynamics CRM.  

When you resolve the address, you can create a new account, contact, or lead with that e-mail address. 

New users need to be added by the system administrator before they can be resolved to the address.  

 The e-mail address is used by more than one record, for example, for both a contact and a 

user.  

Microsoft Dynamics CRM is unable to determine which account to associate with the activity. When you 

resolve the address, you can select the appropriate account, contact, lead, or user.  

 The address was not included in your Microsoft Dynamics CRM Address Book. To see what 

addresses are being reconciled and synchronized, in the Set Personal Options dialog box, click the 

Address Book tab.  

To resolve an address, open the e-mail activity record and then double-click the address. The Resolve Address 

dialog box opens. 

 

Related Topics 

Troubleshooting 

Using Microsoft Dynamics CRM for Outlook - Troubleshooting 

Send Direct E-mail to Customers 

Managing E-mail Activities 

Why aren't my e-mail messages being tracked?  

Not all e-mail messages are tracked automatically. Which e-mail messages are tracked is set in the Set Personal 

Options dialog box. You can choose to track all e-mail messages, only messages from Microsoft Dynamics CRM 

leads, contacts, or accounts, or only messages that are in response to tracked messages.  

More information: Set Personal Options 

 

Related Topic 

Troubleshooting 

Why are my e-mail messages not being sent or received?  

You may not have your incoming and outgoing e-mail configurations set correctly. Verify your settings and e-mail 

address in your user record. If you do not have permission to change your user record, contact your system 

administrator.  

More information: Work with Your User Record and Work Hours, Set Personal Options 

 

Related Topics 

Troubleshooting 

Work with Your User Record and Work Hours 

Set Personal Options 

Sending E-mail Messages - Troubleshooting 
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Why am I receiving e-mail messages without some or all of the attachments?  

Your system administrator may have chosen to block certain types of attachments, such as executable (.exe) files and 

batch (.bat) files. There is also a limit to the size of attachments allowed. Contact your system administrator for more 

information.  

If you are the administrator, you can edit the list of blocked files and file size limit in the Settings area. More 

information: Manage System Settings 

 

Related Topic 

Manage System Settings 

Creating Workflows – Troubleshooting 

How can I close multiple activities at the same time?  

You can close several activities at the same time by creating an on-demand workflow and then running it from the 

Activities list.  

 

1. For each type of activity, create an on-demand workflow with one workflow step.  

More information: Work with Workflows  

2. In the workflow step, add a workflow action to set the status of the activity to "Closed."  

3. Publish each activity-specific workflow.  

4. In the Activities list, select the activities that you want to close, and then apply the on-demand workflow.  

More information: Start an On-Demand Workflow  

Related Topics 

Start an On-Demand Workflow 

Work with Workflows 

Creating Workflows - Troubleshooting 

Creating and Using Workflows 

Why can't I run a workflow that has been shared with me?  

You may not have the privilege to run the workflow. You need Execute Workflow Job privilege on the Customization 

tab. 

If you are curious about what privileges are assigned to your security role, all default security roles allow you to 

browse the Users and Security Roles areas.  

View the security roles you are assigned  

1. In the Navigation Pane, click Settings, click Administration, and then click Users.  

2. Find yourself in the list, and double-click your name.  

3. Click Roles, and then see which security roles you are assigned.  

4. Double-click each security role you are assigned, and then click each tab to see the privileges that are 

associated with this security role.  

If you don't have permission to do a required task, contact your manager or system administrator.  

 

Related Topics 
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Start an On-Demand Workflow 

Work with Workflows 

Creating Workflows - Troubleshooting 

Creating and Using Workflows 

Synchronization Issues with Microsoft Dynamics CRM for Outlook – 

Troubleshooting 

Start Diagnostics Wizard  

Microsoft Dynamics CRM Diagnostics detects and fixes many problems you may encounter with Microsoft Dynamics 

CRM for Outlook including issues with connectivity, setup, and corrupted data. In some cases, you can also choose to 

allow the wizard to repair the problem. 

The wizard is installed on your computer at the same time you install Microsoft Dynamics CRM for Outlook.  

1. On the Start menu, click All Programs, click Microsoft Dynamics CRM, and then click Diagnostics.  

2. To start the wizard, click Run Diagnostics.  

 

Note 

If you are working with a support representative, you can enable tracking to assist the representative with diagnosing 

your problems.  

 In the wizard, click Support Mode, run the wizard, and then on the Advanced Troubleshooting tab, click 

Create File. You can save the compressed file to your desktop, and then send it to your support representative.  

Related Topic 

Managing Users 

Why aren't names for a newly tracked Microsoft Dynamics CRM 

appointment or e-mail being verified?  

There are several reasons that this might occur: 

 If none of the names are being verified, you may not have permissions to use the Microsoft Dynamics CRM 

address book. The CRM Address Book  privilege is part of the Business Management security role. Contact your 

system administrator to review your security roles.  

 The person may not have a valid e-mail address in the Microsoft Dynamics CRM record.  

 The person may not have a valid customer or account record in Microsoft Dynamics CRM.  

 The address book may not have been synchronized or is corrupted. To synchronize your address book, in 

Microsoft Dynamics CRM for Outlook, on the Microsoft Dynamics CRM toolbar, point to Synchronize with 

Microsoft CRM, and then click Address Book.  

 

Related Topics 

Using Microsoft Dynamics CRM for Outlook - Troubleshooting 

Doing CRM Work in Outlook 

Synchronizing Information 
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Why can't I fix some of the synchronization errors before going offline?  

 Not all errors can be fixed. For example, if a parent account has been deleted from Microsoft Dynamics CRM 

while you were offline. For these type of errors, delete the records, try to synchronize again, and then re-enter 

the data manually into Microsoft Dynamics CRM, while online. Some data may required changes.  

 Appointments and service activities do not have access to scheduling information and may cause scheduling 

conflicts. These conflicts can be resolved by rescheduling or updating the schedule after going back online. 

 

Related Topics 

Using Microsoft Dynamics CRM for Outlook - Troubleshooting 

Synchronize Data 

Doing CRM Work in Outlook 

Synchronizing Information 

Why didn't my attachments synchronize?  

There are several reasons why attachments may not synchronize: 

 When you trackOutlook tasks and appointments with attachments, the attachments are not saved in the 

Microsoft Dynamics CRM record, but continue to exist with the original Outlook item. To include the attachment 

with the activity, save the file to the local drive of your computer, and then manually add the attachment to the 

Microsoft Dynamics CRM record.  

If you attach a file to a Microsoft Dynamics CRM record when you are working offline, the attached files must 

be available in the same location when you synchronize your data so that they can be uploaded to the 

Microsoft Dynamics CRM database. For example, if you are visiting a customer and you borrow a disk with a 

file that you want to attach to the customer's record, first copy the file to your local hard drive, then attach it 

from there. After you've synchronized the data and the attachment file has been uploaded to the Microsoft 

Dynamics CRM database, you can delete the local copy. 

 Attachments above the maximum file size limit are not synchronized. The maximum attachment size is 5 MB. 

This can be increased by your system administrator.  

 Your system administrator may have chosen to block certain types of attachments. Contact your system 

administrator for more information.  

 

Related Topics 

Using Microsoft Dynamics CRM for Outlook - Troubleshooting 

Add a Note or Attach a File 

Doing CRM Work in Outlook 

Synchronizing Information 
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Why didn't an e-mail message in response to a tracked message get 

tracked?  

This can happen when you have sent a message and received a response to it while you are offline with Microsoft 

Dynamics CRM. Microsoft Dynamics CRM did not have an opportunity to synchronize with the sent message before 

the response was received. Missed messages do not have the Microsoft Dynamics CRM Track in CRM button . 

You can track the message in Microsoft Dynamics CRM by clicking Track in CRM, and then selecting a Regarding 

record. 

 

Related Topics 

Using Microsoft Dynamics CRM for Outlook - Troubleshooting 

Doing CRM Work in Outlook 

Synchronizing Information 

Why doesn't the time in Microsoft Dynamics CRM for Outlook match the 

time in Microsoft Dynamics CRM?  

Microsoft Dynamics CRM for Microsoft Office Outlook uses the time zone set in Microsoft Office Outlook. Microsoft 

Dynamics CRM uses the time zone set on the computer running Microsoft Dynamics CRM or for the individual user. If 

they are different, this can cause issues. 

To resolve this conflict, the system administrator must sign in to Microsoft Dynamics CRM as the user account that 

was used for installation. In the user's record, the system administrator needs to change the time zone to match the 

time zone on the computer that is running Outlook.  

 

Related Topics 

Set Personal Options 

Using Microsoft Dynamics CRM for Outlook - Troubleshooting 

Doing CRM Work in Outlook 

Synchronizing Information 
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Why are Outlook appointments not appearing in the Microsoft Dynamics 

CRM calendars?  

Microsoft Office Outlook appointments may not appear in the Microsoft Dynamics CRM calendars for several reasons: 

 Individual appointments are not marked for tracking in Microsoft Dynamics CRM.  

Tracked items appear with the Track in CRM button , unless this option has been turned off. 

 You are not selected as one of the attending parties:  

 In Outlook, you are not in the To box.  

 In Microsoft Dynamics CRM appointments, you are not in the Required or Optional boxes.  

 In Microsoft Dynamics CRM service activities, you must either be listed in the Resources box or in a 

Resource Group listed in the box.  

 The option to synchronize Appointments I'm attending was not selected on the Synchronization tab of 

the Set Personal Options dialog box.  

More information: Set Personal Options 

 The automatic synchronization has not occurred yet. It is usually scheduled for every 15 minutes. To force 

synchronization, in Microsoft Dynamics CRM for Outlook, on the Microsoft Dynamics CRM menu bar, click 

Synchronize Outlook with CRM.  

 Recurring appointments are not supported by this version of Microsoft Dynamics CRM. Only the initial 

appointment will appear. Make additional appointments manually, as appropriate.  

 On a shared computer, you must be logged on with your own credentials. Otherwise, you might be viewing the 

calendar of the person who is logged on, instead of your own calendar. Log off and log on again with your user 

name.  

 

Related Topic 

Synchronizing Information 

While trying to save an Outlook contact in Microsoft Dynamics CRM, why do 

I receive an error that the item is not valid for promotion?  

There are several reasons why this message may occur: 

 The message class of the contact, e-mail, task or appointment is not valid. For example: the default Contact 

form used by Outlook is IPM.Contact. This is usually because the contact was created using a custom Outlook 

form. You need to re-enter the contact, e-mail, task, or appointment.  

 The contact is stored outside of the Exchange local store. You can copy the contact to the local store.  

 The contact is stored in a deleted items folder. You can move the contact to a valid folder.  

 

Related Topic 

Working with Records and Activities in Microsoft Dynamics CRM for Outlook 
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Why is synchronization slow?  

There are many factors that contribute to the speed of synchronization between Microsoft Dynamics CRM for 

Outlook and Microsoft Dynamics CRM.  

To identify and fix many problems with Microsoft Dynamics CRM for Outlook, run Microsoft Dynamics CRM 

Diagnostics.  

1. On the Start menu, click All Programs, click Microsoft Dynamics CRM, and then click 

Diagnostics.  

2. To start the wizard, click Run Diagnostics.  

Initial synchronization is typically slow because you are copying data to your computer. The speed of subsequent 

synchronization depends on the amount of data that you are synchronizing. Later synchronizations are faster 

because only changes and additions are being synchronized. The best strategy for speedier synchronization is to 

reduce the amount of data. Here are a few suggestions that might help speed up synchronization: 

 Determine if you need to synchronize contacts, tasks, and appointments. If not, you can turn these off in 

the Set Personal Options dialog box. In Microsoft Dynamics CRM for Outlook, on the Microsoft Dynamics 

CRM menu bar, click Options. In the Set Personal Options dialog box, on the Synchronization tab, 

you can select which record types are synchronized and how often.  

 Increase how often your local data is updated. This reduces the amount of data to be updated when you 

go offline. In the Set Personal Options dialog box, on the Offline tab, select a shorter period of time.  

 Reduce the type of e-mail recipients that are reconciled and therefore need to be synchronized. In the Set 

Personal Options dialog box, on the Address Book tab, select fewer options.  

 Deactivate local data groups for areas you are not using in Microsoft Dynamics CRM for Outlook. To 

deactivate an active data group, on the Data Groups tab, select one or more data groups. On the toolbar, 

click the Deactivate button. This deactivates all of the data groups and moves them to the Inactive 

Data Groups tab.  

 Modify the active data groups to ensure that they are only synchronizing the data you need offline. In 

Microsoft Dynamics CRM for Outlook, on the Microsoft Dynamics CRM menu bar, click Local Data. Reduce 

the number of records that you own or share, including templates, contracts, and sales literature. To view 

the owner of a record, on the Details tab, see the Owner field.  

 If you have complex local data groups with multiple levels of filters, this can slow synchronization. Review 

your local data groups and consider reducing the number of groups.  

More information: Save Outlook Contacts, Tasks, and E-mail Messages as Microsoft Dynamics CRM Records 

After you have completed one or more of these suggestions, perform a synchronization. Note that the first 

synchronization performed after one of these steps will still be slow because records are being removed from the 

local data store. However, subsequent synchronization should be faster.  

 

Related Topics 

Using Microsoft Dynamics CRM for Outlook - Troubleshooting 

Synchronize Data 

Share or Assign Records 

Synchronizing Information 
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General Issues with Microsoft Dynamics CRM for Outlook - Troubleshooting 

Start Diagnostics Wizard  

Microsoft Dynamics CRM Diagnostics detects and fixes many problems you may encounter with Microsoft Dynamics 

CRM for Outlook including issues with connectivity, setup, and corrupted data. In some cases, you can also choose to 

allow the wizard to repair the problem. 

The wizard is installed on your computer at the same time you install Microsoft Dynamics CRM for Outlook.  

1. On the Start menu, click All Programs, click Microsoft Dynamics CRM, and then click Diagnostics.  

2. To start the wizard, click Run Diagnostics.  

 

Note 

If you are working with a support representative, you can enable tracking to assist the representative with diagnosing 

your problems.  

 In the wizard, click Support Mode, run the wizard, and then on the Advanced Troubleshooting tab, click 

Create File. You can save the compressed file to your desktop, and then send it to your support representative.  

Related Topic 

Managing Users 

Why doesn't the Navigation Pane scrollbar in the CRM Shortcuts folder 

display correctly?  

The CRM shortcuts folder does not display correctly if too many custom entities are added to the Navigation Pane. 

Have your system customizer or administrator remove some of the custom entities from the CRM shortcuts folder.  

 

Related Topic 

Doing CRM Work in Outlook 

Why is the error log reporting this error, "ConnectionListen (Shared-

Memory (LPC)) : Error 5."?  

This error occurs when Microsoft Dynamics CRM starts before the Microsoft Data Engine (MSDE) is completely started. 

These events appear in the event log, but can be safely ignored.  

 

Related Topic 

Doing CRM Work in Outlook 

Why can't I open a record? 

This could occur for several reasons, including:  

 Microsoft Dynamics CRM for Outlook is a Web application. Records are displayed in pop-up windows. If you 

have a pop-up blocker installed, it may block Microsoft Dynamics CRM pages from displaying. Disable your pop-

up blocker and try again.  

 You may not have permissions to view the record. For more information, see your system administrator.  

 The record may have been deleted and your local data may not be synchronized. Synchronize and try again.  
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 The record may be included in your local data. Review your local data groups in your personal options.  

More information: Set Personal Options 

Related Topic 

Doing CRM Work in Outlook 

Why don't all of my Microsoft Dynamics CRM contacts appear in the 

address book?  

 Only those contacts with a complete and valid e-mail address appear in the Microsoft Dynamics CRM address 

book.  

 The address book may not have been synchronized. The address book is synchronized automatically once 

every 24 hours, and does not synchronize when you go offline. To synchronize your address book, in Microsoft 

Dynamics CRM for Outlook, on the Microsoft Dynamics CRM toolbar, point to Synchronize with Microsoft 

CRM, and then click Address Book.  

 

Related Topic 

Doing CRM Work in Outlook 

When I upgraded to Microsoft Dynamics CRM 4.0, why weren't the changes 

I made to Microsoft Dynamics CRM 3.0 saved? 

This usually occurs if you were offline before you upgraded and made changes to Microsoft Dynamics CRM, and then 

a synchronization error occurred and you chose to go online anyway. This can also occur if you were offline when 

you upgraded Microsoft Dynamics CRM for Microsoft Office Outlook. If you have changes that were not synchronized 

to the Microsoft Dynamics CRM server and you want to upgrade, you can do one of the following:  

 If you are using Microsoft Dynamics CRM 3.0 or an earlier version, you can go offline, go online to synchronize 

changes, and then upgrade. If there are synchronization errors, you may need to re-enter data manually after 

the upgrade is complete.  

 To make changes after you upgrade, go offline, and then go back online to synchronize changes made while 

offline.  

 Complete the upgrade, and then re-enter the data manually. You may need to verify that you are not creating 

duplicate records.  

 For additional solutions, contact Microsoft Customer Service and Support.  

 

Related Topic 

Doing CRM Work in Outlook 

When I upgrade to Microsoft Dynamics CRM 4.0 CRM for Outlook, why do I 

get this error, "Creating a rule that is incompatible with versions of Outlook 

earlier than Outlook 2000. Are you sure you want to create this rule?"  

During the upgrade process, Microsoft Dynamics CRM creates rules for Outlook. This message can be safely ignored. 

Click Yes to continue. 

 

Related Topics 

Doing CRM Work in Outlook 
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Synchronizing Information 

When I upgrade from Microsoft Dynamics CRM 3.0 laptop client for Outlook 

to Microsoft Dynamics CRM 4.0 for Microsoft Office Outlook with Offline 

Access, why do I get this error, "There are Microsoft Dynamics CRM client 

for Outlook items that have not been uploaded to the Microsoft Dynamics 

CRM server. These items will be lost during upgrade."  

Microsoft Dynamics CRM for Outlook does not support changes made while offline. If your server is still running 

Microsoft Dynamics CRM version 1.2 or 3.0, go online and synchronize your data. Then try upgrading again.  

If your Microsoft Dynamics CRM server has been upgraded, you must upgrade to Microsoft Dynamics CRM for Outlook 

with Offline Access while offline. After upgrading, go online and synchronize your data.  

 

Related Topics 

Doing CRM Work in Outlook 

Synchronizing Information 

When I send an e-mail message to someone in my organization, why are 

two e-mail activities created? 

Microsoft Dynamics CRM is designed to create multiple e-mail activities for e-mail messages sent to users inside your 

organization, one activity for the person creating the e-mail activity and one activity for every recipient. You can turn 

off this feature.  

 

1. In the Navigation Pane, click Settings, click Administration, and then click System Settings.  

2. On the E-mail tab, clear the Track e-mails sent between CRM users as two activities check box.  

3. Click OK.  

Related Topics 

Doing CRM Work in Outlook 

Synchronizing Information 

Why can't I view my Microsoft Dynamics CRM calendars in Outlook?  

 If you are offline, the Service calendar is not available in Microsoft Dynamics CRM for Microsoft Office Outlook.  

 If you are in Microsoft Dynamics CRM for Microsoft Office Outlook, the Workplace calendar is not available, 

unless the Site Map has been customized.  

 If you cannot view the Service calendar, you do not have the Read privilege for the Service record type. This 

might be because you have custom or edited security roles. The Read privilege for the Service record type is 

included in all the default security roles available in Microsoft Dynamics CRM. 

To make the calendar visible for users with a specific security role, click Settings, click Security Roles. 

Open the security role. On the Service Management tab, for the Service record type, add the Read 

privilege.  

 

Related Topics 

Configuring the Application - Troubleshooting 

Controlling Data Access 



 

468 Microsoft Dynamics CRM 4.0 User’s Guide 
 

Why does opening an e-mail attachment with a file name that contains 

extended or accented characters appear to corrupt those characters in the 

title of the file?  

The file is not corrupted, but may appear this way when you open it in Microsoft Dynamics CRM. You can view the file 

without the corrupted characters by saving the attachment to your desktop and then opening it.  

 

1. Open the record with the attachment.  

2. On the Notes tab, in the Notes area, click the file name of the attachment you want.  

3. If the Note dialog box opens, click Save and Close to close it.  

4. In the File Download dialog box, click Save.  

5. Select a location and then click Save.  

6. Navigate to the location and open the file.  

Related Topic 

Doing CRM Work in Outlook 
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Why can't I go back online?  

 This usually occurs if you do not have a network connection or the Microsoft Dynamics CRM server is 

unavailable. Wait a few minutes, and then attempt to go back online and get a connection. If this condition 

persists, contact your system administrator.  

 While you were offline, your user record may have been deactivated or your privileges to synchronize or go 

offline may have been changed. Contact your system administrator.  

 Some data cannot be synchronized, such as appointments with conflicts or corrupt files. Attempt to reconcile 

these errors and try again. You may need to discard these changes and re-enter them after you are back online.  

 To identify and fix many problems with Microsoft Dynamics CRM for Outlook, run Microsoft Dynamics CRM 

Diagnostics.  

1. On the Start menu, click All Programs, click Microsoft Dynamics CRM, and then click 

Diagnostics.  

2. To start the wizard, click Run Diagnostics.  

Generating Reports – Troubleshooting 

Why isn't data in a report, even though I expect it to be there?  

There are several possible reasons why data you expect to be on a report does not appear:  

 Security. If you don't have permission in Microsoft Dynamics CRM to view a record, it will not appear in the 

report.  

 Data is not entered in Microsoft Dynamics CRM. The person entering data may have left fields empty.  

 Data does not match the criteria for the report. Many reports include a default filter that displays only 

active records, or you may have selected criteria that the record doesn't match.  

 You may be viewing a cached copy of the report. By default, data in Microsoft Dynamics CRM reports is 

pulled from the database each time you run a report. However, your system administrator may have changed a 

report to run from the cache. If data you entered recently is not included in the report, you may have an older 

version of the report from the cache. To refresh the report, on the Report toolbar, click the Refresh button 

.  

 You may not have permission to read records in a sub-report. If you do not have permission to read 

record types that are included in a sub-report, you will get an error message saying that the sub-report could 

not be displayed.  

 Your Microsoft Internet Explorer privacy settings may block required cookies. For chart reports, if 

instead of seeing the chart, you see a red letter X, your privacy settings may be blocking a cookie that is 

required for the chart control. To fix this problem, in your browser, enable cookies for the server that is running 

Reporting Services.  

 If you are offline, your local data groups may not include all the data. If you are using the report from 

the Microsoft Dynamics CRM for Outlook with Offline Access while you are offline, you must have a local data 

group that includes all the data that will be in the report. More information: Work with Data to Take Offline  

 

Related Topics 

Running Reports - Troubleshooting 

Create and Work with Reports 



 

470 Microsoft Dynamics CRM 4.0 User’s Guide 
 

Running Reports and Analyzing Data 

Why do one or more reports display slowly or stop responding?  

Most reports return results within a few seconds to a minute. Some reports might take longer if the report includes a 

large number of records, or if the system usage is high.  

If you are a user:  

 Edit the filter before you run the report to select fewer records.  

 If you need to run a summary report for a large number of records, such as the Account Distribution report, 

expect it to take a while to run and try to run it when system usage is low.  

If you are a system administrator:  

 Change the default filter on the report to be more restrictive.  

 Remove the report from on-demand use and schedule it to run when the system is less heavily used.  

 If the report is a custom report, for suggestions on improving performance, see Writing Reporting Services 

Reports (Microsoft Dynamics CRM SDK).  

 If the problem occurs on a matrix table report, such as the Case Summary Table report, use Task Manager to 

see if the Web service process (w3wp.exe) on the report server is consuming all memory. If this is the 

problem, you can modify the MemoryLimit setting in Reporting Services. Reports are automatically stopped if 

they exceed the percentage of memory specified in this setting. By lowering this limit, you can cause the report 

to fail without consuming so much memory that the server is unusable. For more information, see the topic 

"RSReportServer Configuration File" in Reporting Services Books Online.  

 Identify whether you need to upgrade hardware or use a separate server for Reporting Services. For more 

information, see Chapter 1-4, "Planning Deployment," and chapter 2-2, "Microsoft Dynamics CRM 4.0 Server 

Installation Instructions in the and the article Microsoft Dynamics CRM 4.0 Implementation Guide, and the 

article "Improving Performance of Microsoft Dynamics CRM by Using a Dedicated Report Server".  

 

Related Topics 

Running Reports - Troubleshooting 

Create and Work with Reports 

Customizing and Organizing Reports 

Why do I receive the error "An error has occurred during report processing. 

Cannot create connection to data source CRM. Login failed for user 'NT 

AUTHORITY\ANONYMOUS LOGON'" when I run any report?  

This error will occur if the Enable Integrated Windows Authentication check box is not selected in Microsoft 

Internet Explorer.  

To fix this problem:  

 

1. On the Internet Explorer Tools menu, click Internet Options.  

2. On the Advanced tab, in the Security section, select Enable Integrated Windows Authentication, 

and then click OK.  

3. Restart your computer.  

Related Topics 
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Running Reports - Troubleshooting 

Create and Work with Reports 

Running Reports and Analyzing Data 

Why do I receive the error "The maximum number of tables in a query 

(260) was exceeded" when I try to run a Reporting Services report?  

If you are a user, this problem may occur if you use too many related record types to filter the report. Try reducing 

the number of filter criteria for the report, and running the report again. If you are running the report from a view 

that uses several record types in the view criteria, try running it from a simpler view instead.  

If you are writing a new Reporting Services report, you may get this error if you have too many joins in the SELECT 

statement in your report. Try reducing the number of joins.  

 

Related Topics 

Running Reports - Troubleshooting 

Create and Work with Reports 

Customizing and Organizing Reports 

Printing and Exporting Reports – Troubleshooting 

When I try to print a Reporting Services report, why do I receive the error 

"Object doesn't support this property or method"?  

This error occurs the first time you try to print a report from either Microsoft Dynamics CRM or Microsoft Dynamics 

CRM for Outlook if you are not in the local Administrator group on your computer. You need a Microsoft ActiveX 

control that is required for printing reports, but do not have permission to install ActiveX controls on your computer.  

To fix this problem:  

 

 Ask a system administrator or person in the local Administrator group on your computer to log on to your 

computer and follow these instructions:  

a. Use Microsoft Internet Explorer to go to http://<CRM_Server>.  

b. In the Navigation Pane, click Workplace, and then under My Work, click Reports.  

c. Select a report, run the report, and then click Print.  

The ActiveX control required for printing will be installed on your computer.  

Related Topics 

Running Reports - Troubleshooting 

Create and Work with Reports 

Running Reports and Analyzing Data 

Why do I receive the error "Error loading resource string" when I try to 

print a Reporting Services report?  

This error might occur if the Microsoft ActiveX control used for printing reports is an old version or is not installed 

correctly. To fix this problem:  

 

1. In Microsoft Internet Explorer, on the Tools menu, click Internet Options.  
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2. In Microsoft Internet Explorer version 6, on the General tab, in the Temporary Internet files section, 

click Settings.  

In Microsoft Internet Explorer version 7, on the General tab, in the Browsing history section, click 

Settings.  

3. Click View objects.  

4. Select RSClientPrint Class, and then on the Edit menu, click Delete.  

5. Try printing the report again.  

Related Topics 

Running Reports - Troubleshooting 

Create and Work with Reports 

Running Reports and Analyzing Data 

Managing Reports – Troubleshooting 

Why do one or more reports display slowly or stop responding?  

Most reports return results within a few seconds to a minute. Some reports might take longer if the report includes a 

large number of records, or if the system usage is high.  

If you are a user:  

 Edit the filter before you run the report to select fewer records.  

 If you need to run a summary report for a large number of records, such as the Account Distribution report, 

expect it to take a while to run and try to run it when system usage is low.  

If you are a system administrator:  

 Change the default filter on the report to be more restrictive.  

 Remove the report from on-demand use and schedule it to run when the system is less heavily used.  

 If the report is a custom report, for suggestions on improving performance, see Writing Reporting Services 

Reports (Microsoft Dynamics CRM SDK).  

 If the problem occurs on a matrix table report, such as the Case Summary Table report, use Task Manager to 

see if the Web service process (w3wp.exe) on the report server is consuming all memory. If this is the 

problem, you can modify the MemoryLimit setting in Reporting Services. Reports are automatically stopped if 

they exceed the percentage of memory specified in this setting. By lowering this limit, you can cause the report 

to fail without consuming so much memory that the server is unusable. For more information, see the topic 

"RSReportServer Configuration File" in Reporting Services Books Online.  

 Identify whether you need to upgrade hardware or use a separate server for Reporting Services. For more 

information, see Chapter 1-4, "Planning Deployment," and chapter 2-2, "Microsoft Dynamics CRM 4.0 Server 

Installation Instructions in the and the article Microsoft Dynamics CRM 4.0 Implementation Guide, and the 

article "Improving Performance of Microsoft Dynamics CRM by Using a Dedicated Report Server".  

 

Related Topics 

Running Reports - Troubleshooting 

Create and Work with Reports 

Customizing and Organizing Reports 
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Why do I receive the error "SRS soap exception: The permissions granted 

to user 'DOMAIN\User' are insufficient for performing this operation" when 

I try to download a report?  

To download a report from Microsoft Dynamics CRM, you must have:  

 The Report Manager System Administrator security role. By default, users in the local Administrators group on 

the report server have this security role.  

 The Microsoft Dynamics CRM System Administrator or System Customizer security roles, or the Manage Reports 

privilege.  

To download a report, log in as a user with the necessary security roles. For more information about security roles in 

Reporting Services, see Reporting Services Books Online.  

 

Related Topics 

Running Reports - Troubleshooting 

Accessing Parts of the Application - Troubleshooting 

Create and Work with Reports 

Controlling Data Access 

Customizing and Organizing Reports 

Why do I receive the error "The permissions granted to user 'NT 

AUTHORITY\NETWORK SERVICE' are insufficient for performing this 

operation" when I try to modify report properties, or upload or download a 

report?  

This error occurs if Microsoft Dynamics CRM and Reporting Services are installed on the same server, the server is 

running Windows Server 2003 or is a Microsoft Windows Small Business Server 2003, and Domain user was 

specified on the Specify Security Account page when Microsoft Dynamics CRM was installed.  

To add the necessary permissions, make the following change in Reporting Services Report Manager.  

 

1. On the server running Microsoft Dynamics CRM, use Microsoft Internet Explorer to open Reporting Services 

Report Manager. By default, Report Manager is located at http://localhost/Reports. If you renamed the 

virtual directory for Report Manager when you installed Reporting Services, use the virtual directory name 

you used rather than Reports.  

2. Click Show Details.  

3. Click the icon in the Edit column next to the folder for your organization.  

4. Click Security.  

5. Click New Role Assignment.  

6. On the New Role Assignment page, in the Group or user name box, enter the value of the service 

account name for ASP.NET:  

 For English locales, enter NT Authority\Network Service.  

 For other locales, open the setup log file with Notepad. By default, this file is located at 

<systemdrive>:\Documents and Settings\User\Application 

Data\Microsoft\MSCRM\Logs\crm30svrsetup.log  

a. Search for ServerInstallInfo.AspNetServiceAccountName.  
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b. Look at the value in this line, and enter this value in the Group or user name box.  

7. Select the check box next to Publisher for Microsoft CRM.  

8. Click OK.  

Related Topics 

Running Reports - Troubleshooting 

Create and Work with Reports 

Customizing and Organizing Reports 

Frequently Asked Questions 

How can I make a suggestion for the next version of Microsoft Dynamics 

CRM?  

You can add suggestions for product features or vote for the suggestions of other people on the Microsoft 

Dynamics CRM Web site. When we consider product enhancements, supported ideas rank higher in the rating 

system that we use.  

Please visit the suggestion page and either add your suggestion, or if it's already there, vote for your suggestion 

to be sure our product planning team has this information to consider for future releases. More information: 

Resource Center  

 

How do I change my Microsoft Dynamics CRM password?  

Your permissions are determined by your network account and password. Microsoft Dynamics CRM doesn't have a 

separate password from your network password.  
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Glossary 

 

A 

accept (To move a case into a queue with the intention of working on it. )  

 

access level (A security role setting that determines, for a given entity, who can access records. There are four options: 

just the owner of the record, all users in the current business unit, all users in the current or child business unit, or all 

users. )  

See also: privilege (A user's right to perform a specific action on a specific record type or to perform a task. Privileges 

are assigned by system administrators to security roles. Users are then assigned security roles. Examples of privileges 

include Update Account and Publish Customizations. ), security role (A defined set of privileges. The security role 

assigned to a user determines which tasks the user can perform and which parts of the user interface the user can 

view. All users must be assigned at least one security role in order to access the system. )  

 

account (A company that might do business with your organization. )  

See also: contact (A person who represents a customer or potential customer, or an individual related to an account. 

For example, an individual who purchases products or services for their own use, or an employee of an account. A 

contact may also be a person involved in a business transaction, such as a supplier or a colleague. ), lead (A potential 

customer who must be qualified or disqualified as a sales opportunity. If a lead is qualified, it can be converted to an 

opportunity, account, and/or contact. ), opportunity (A potential revenue-generating event or sale to an account that 

needs to be tracked through a sales process to completion. )  

 

activate (To make a previously unavailable record available for use. )  

 

activity (An action to be performed, such as a task, or a communication item that is sent or received, for example, e-

mail, phone calls, and appointments. The status of activities is tracked and the activity history is stored in the system, 

so users can view the open and closed activities. )  

See also: queue (A holding container for activities that need to be completed. There are queues that contain cases and 

activities in the Workplace, and queues of articles in the knowledge base. )  

 

address book (A collection of names and e-mail addresses. The Microsoft Dynamics CRM address book is part of the 

collection of address books in the Microsoft Office Outlook Address Book, which can be used to address e-mail 

messages. )  

 

Advanced Find (A tool used to search for specific records and activities. )  

See also: Index (The dynamic alphabet bar located on the bottom of the lists in the Microsoft Dynamics CRM application 

window. When a letter or the number sign (#) is clicked, the list displays the available records by that letter. )  

 

Advanced Find View (The view used to display results of searches created with Advanced Find. )  

 

allotment type (A unit of service, such as a case or a range of coverage dates, specified in a service contract that 

indicates how much access a customer has to customer service. )  

See also: case (A customer service issue or problem reported by a customer and the activities that customer service 

representatives use to resolve it. ), contract (An agreement to provide support during specified coverage dates or for a 

specified number of cases or length of time. When customers contact customer service, the level of support they 

receive is determined by their contract. )  

 

appointment (An activity represented by a time interval that has a start time, an end time, and a duration. An 

appointment does not include a service or check for conflicts, and you cannot search for available times. )  

See also: service activity (A schedulable appointment to provide a service to a customer. A service activity uses one or 
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more resources to perform a service at a specific time and place. )  

 

article (A text-based piece of content in the knowledge base. )  

See also: knowledge base (A feature in Microsoft Dynamics CRM that provides a process for drafting, submitting, 

reviewing, and publishing articles about an organization's products and services. Users with manager-level security roles 

can approve, reject, add comments to, and unpublish articles that are submitted for review. ), template (A framework 

for an e-mail message, contract, or article. Templates are used to ensure consistent layouts and content in similar types 

of documents. )  

 

assign (To specify the owner of a record, such as an account or case, or an activity, such as an e-mail message or 

phone call. Users can assign cases and activities to either a user or a queue. )  

See also: queue (A holding container for activities that need to be completed. There are queues that contain cases and 

activities in the Workplace, and queues of articles in the knowledge base. ), share (To allow another user or team to 

have a specified amount of access to a record, such as a case, account, or contract. For example, you can share an 

account with a team and specify that its members can read the account record, but cannot have write access to it. )  

 

associated record (A record that is referenced in the current record. For example, an account might have many 

associated contact records. )  

 

associated view (The view of an entity that is displayed in the forms of other entities. The associated view is different 

from the views that are visible for the entity in its own area of the user interface. For example, in an account record, 

under Details, you can click Contacts to view and open a contact form. That is the Contacts associated view. There 

can be only one associated view of each entity. )  

See also: Index (The dynamic alphabet bar located on the bottom of the lists in the Microsoft Dynamics CRM application 

window. When a letter or the number sign (#) is clicked, the list displays the available records by that letter. ), record 

(An entry in the Microsoft Dynamics CRM database that stores all the information about a specific item, such as a 

contact. Records are like individual index cards in an index-card filing system. You can view basic information about 

records in a list, and you can view or change detailed information about records in a form. ), record type (A group of 

records. For example, all account records are grouped as the Account record type. Also called an entity. ), view (A filter 

applied to a list of records. Users can choose different views that contain all the records or activities of a particular type 

or that are a subset of that type. )  

 

attribute (A property of an entity with a specific data type. Attributes are analogous to columns in a database table. 

When attributes are added to an entity form, they are displayed as fields that correspond to their data type. )  

 

automatic mapping (Importing a data file where the column headings exactly match the Microsoft Dynamics CRM 

display names. )  

 

automatic workflow (A type of workflow that runs as soon as the conditions defined in the workflow logic are met. No 

user action is required to start the workflow. )  

See also: on-demand workflow (A type of workflow that only runs when a user chooses to apply it to records from a 

toolbar or menu in Microsoft Dynamics CRM. )  

 

auto-response (An e-mail feature that sends a standard response whenever an e-mail message is received. )  

 

availability (The periods of time when a resource can be scheduled to participate in a service activity. )  

See also: capacity (A measurement of the amount of work or skill level a resource can provide in relationship to the 

amount of effort required to perform a service. Every time a resource performs a service, its capacity is reduced by the 

amount of effort required. )  

 

B 
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base currency (The primary or default currency in which your organization conducts business. Any transactions in other 

currencies are automatically converted to the base currency in the Microsoft Dynamics CRM database, using the 

exchange rate defined in the record for that currency. )  

 

base language (The default language for your organization's implementation of Microsoft Dynamics CRM. )  

 

base unit (The initial measurement of a product. A unit group contains the lowest unit of measurement in which a 

product is available, such as a liter. It then lists all the different increments that this base unit is packaged in for sale, 

and indicates which one is the primary unit. )  

See also: primary unit (The measurement used to define the most commonly sold unit of a product. ), unit (A 

measurement that specifies in what quantity a product will be sold. ), unit group (A compilation of the different 

measurements that a product is available in. A unit group contains the base unit in which a product is available, for 

example, a two-liter bottle. It then lists all the different increments that this base unit is packaged in for sale, such as 

an individual two-liter bottle or a case of 6 two-liter bottles, and also indicates which measurement is the primary unit. )  

 

billing frequency (A pre-defined period of time that specifies how often a customer should be billed. Common billing 

frequencies are monthly, quarterly, and annually. )  

See also: allotment type (A unit of service, such as a case or a range of coverage dates, specified in a service contract 

that indicates how much access a customer has to customer service. ), contract line (A line item in a contract that 

describes the service support to be provided. A contract line often includes pricing information and how support will be 

allotted. ), service coverage (The specific hours and days of the week for which service support will be provided. This is 

defined in the contract template, but is not enforced by the system. )  

 

business closure (A period of time that the entire business is closed and service activities cannot be made. )  

 

Business Recommended (A requirement level used for fields that should be filled in, but don't have to be, in order to 

save the record. Fields with this requirement level appear in the Quick Create form. Recommended fields are marked 

with plus symbols. )  

 

Business Required (A requirement level used for fields that must be filled in before a record can be saved. Fields with 

this requirement level appear in the Quick Create form. Required fields are marked with an asterisk. )  

 

business unit (A way of representing a division or department in a company. Business units are arranged in a hierarchy, 

and all users are assigned to one business unit. )  

See also: child business unit (A business unit that is immediately under another business unit in the business hierarchy 

of an organization. ), division (An organizational level of a company. Divisions can be based on geography, (East 

Division, West Division); product specializations, (New Technologies Division); or any other characteristics. In Microsoft 

Dynamics CRM, a division can be represented by a business unit. ), organization (The top level of the business 

hierarchy. The organization is divided into business units. There can be only one organization per deployment. )  

 

C 

campaign (A marketing program that uses many communication vehicles to accomplish a specific result. For example, 

using advertisements and direct mail to increase market share, introduce new products, or retain customers. )  

 

campaign activity (An activity associated with a specific campaign, such as a letter, fax, or phone call. Campaign 

activities include campaign-specific information, and must be distributed to create the individual activities for users to 

perform. )  

 

campaign response (A record of the communication you receive from a potential customer in response to a specific 

campaign. )  

 

campaign template (A framework for a marketing program that uses many communication vehicles to accomplish a 
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specific result. For example, using advertisements and direct mail to increase market share, introduce new products, or 

retain customers. )  

 

capacity (A measurement of the amount of work or skill level a resource can provide in relationship to the amount of 

effort required to perform a service. Every time a resource performs a service, its capacity is reduced by the amount of 

effort required. )  

See also: availability (The periods of time when a resource can be scheduled to participate in a service activity. )  

 

case (A customer service issue or problem reported by a customer and the activities that customer service 

representatives use to resolve it. )  

 

channel (The type of activity in a marketing campaign, such as e-mail or phone call. )  

 

check condition (An element of workflow logic that defines a specific situation and any actions that should be taken if 

that situation occurs. A logical "if-then" statement in a workflow. )  

 

child business unit (A business unit that is immediately under another business unit in the business hierarchy of an 

organization. )  

See also: business unit (A way of representing a division or department in a company. Business units are arranged in a 

hierarchy, and all users are assigned to one business unit. ), organization (The top level of the business hierarchy. The 

organization is divided into business units. There can be only one organization per deployment. ),  

 

child record (A record in a hierarchical relationship with a parent record where a reference to the parent record is 

stored in the record. One parent record can be related to many child records. Child records have lookup fields in the 

form to allow them to be related to a parent record. )  

See also: parent record (A record that is in a hierarchical relationship with a child record, where a reference to the 

record is stored in the child record. One parent record can be related to many child records. )  

 

child workflow (A type of workflow that runs only when started by another workflow. It is contained within a parent 

workflow and cannot be run on its own. )  

 

close (To set the status of a record to Closed. This hides it in lists of open records and sets some types of records to 

read-only. Several types of records are closed automatically when you qualify or disqualify them. )  

 

column headings (Text used in the first row of a spreadsheet or file that labels the data in each column. )  

 

comma-separated value (CSV) file (A data file with a.csv file extension. Typically a CSV file consists of fields and 

records, stored as text, in which the fields are separated from one other by commas. )  

See also: delimited text (A file that contains data in which individual field values are separated by commas, tabs, 

semicolons, or other characters. Delimited text file names typically end with a.txt file extension (for example, 

"my_file.txt"). )  

 

competitor (A company or organization that might compete for sales opportunities with your business unit. Competitor 

records can be linked to opportunity, product, and sales literature records so that they are available when you are 

competing for a sale. )  

See also: opportunity (A potential revenue-generating event or sale to an account that needs to be tracked through a 

sales process to completion. ), product (An item in the product catalog. Products can be linked to other records, such as 

quotes, campaigns, and cases. ), sales literature (The documents that are created with specific information about 

products or services and given to customers to help increase sales. )  

 

condition (An element of workflow logic that defines a specific situation and any actions that should be taken when that 

situation occurs. A logical "if-then" statement in a workflow. )  
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conditional branch (An element of workflow logic that defines an alternative condition and action or additional steps, in 

cases when the criteria in a condition element are not met. A logical "else-if-then" statement in a workflow. )  

 

configurable cascade (A relationship between parent and child entities in which any action taken on a parent entity 

record can also be applied to any child entity records that are related to the parent entity record. You can define the 

behavior for each type of action. For example, you can set it up so that if you share a record in the parent entity, any 

related records for the child entity are not automatically shared. But if you delete a parent entity record, any related 

child entity records are automatically deleted. )  

See also: parental (A relationship between entities in which any action taken on a record of the parent entity is also 

taken on any child entity records that are related to the parent entity record. For example, if you delete a record in the 

parent entity, the related child entity records are also deleted; or if you share a parent entity record, the related records 

from the child entity are also shared. ), referential (A relationship between two entities in which you can navigate to 

any related records, but actions taken on one will not affect the other. ), referential, restrict delete (A relationship 

between two entities in which you can navigate to any related records. Actions taken on the parent record will not be 

applied to the child record, but the parent record cannot be deleted while the child record exists. However, you cannot 

delete a record when related records exist. )  

 

contact (A person who represents a customer or potential customer, or an individual related to an account. For 

example, an individual who purchases products or services for their own use, or an employee of an account. A contact 

may also be a person involved in a business transaction, such as a supplier or a colleague. )  

See also: account (A company that might do business with your organization. ), lead (A potential customer who must 

be qualified or disqualified as a sales opportunity. If a lead is qualified, it can be converted to an opportunity, account, 

and/or contact. ), opportunity (A potential revenue-generating event or sale to an account that needs to be tracked 

through a sales process to completion. )  

 

contract (An agreement to provide support during specified coverage dates or for a specified number of cases or length 

of time. When customers contact customer service, the level of support they receive is determined by their contract. )  

See also: allotment type (A unit of service, such as a case or a range of coverage dates, specified in a service contract 

that indicates how much access a customer has to customer service. ), case (A customer service issue or problem 

reported by a customer and the activities that customer service representatives use to resolve it. )  

 

contract line (A line item in a contract that describes the service support to be provided. A contract line often includes 

pricing information and how support will be allotted. )  

 

convert (The process of changing or recategorizing a record from one record type to another. For example, converting 

a campaign response to a lead, and then converting the lead to an account, contact, or opportunity. )  

 

custom attribute (An attribute that is not included in Microsoft Dynamics CRM by default. Instead, a customer or 

partner adds it after they install the software, to help adapt the software to the customer's needs. )  

See also: system attribute (An attribute that is included in Microsoft Dynamics CRM by default. For example, the name 

attribute in the Account entity is a system attribute. )  

 

custom entity (An entity that is not included in Microsoft Dynamics CRM by default. You can create custom entities by 

using the customization tools. )  

See also: entity (A structure used to manage data. Microsoft Dynamics CRM entities include Account, Case, and Activity. 

), related entity (An entity that is associated with a primary entity (record type) through a unique reference defined by 

using a lookup control on the related entity form. For example, an account has a unique reference to a primary contact. 

), system entity (An entity that is included in Microsoft Dynamics CRM by default, such as Account. )  

 

custom workflow action (An element of workflow logic that specifies a custom operation that should be performed by 

workflow jobs when conditions defined in the workflow have been met. Custom workflow actions can be developed by 

using the information in the Microsoft Dynamics CRM 4.0 Software Development Kit, and are not available in Microsoft 

Dynamics CRM by default. )  
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custom step (An element of workflow logic that provides extensions to the logical elements available by default in 

Microsoft Dynamics CRM. Steps can include conditions, actions, other steps, or a combination of these elements. 

Custom workflow steps can be developed by using the information in the Microsoft Dynamics CRM 4.0 Software 

Development Kit. )  

 

customer (The account or contact with which a business unit conducts a business transaction. )  

See also: account (A company that might do business with your organization. ), contact (A person who represents a 

customer or potential customer, or an individual related to an account. For example, an individual who purchases 

products or services for their own use, or an employee of an account. A contact may also be a person involved in a 

business transaction, such as a supplier or a colleague. )  

 

D 

data delimiter (The character used to surround data that includes the field delimiter. For example, if the field delimiter 

is a comma, and the data delimiter is quotation marks, one column in a file could contain "Redmond, WA" and still be 

treated as a single column. )  

 

data field (A placeholder that inserts text into an e-mail message or document automatically. The data field represents 

a category of information that corresponds to one column of information in a data source. The name of each data field 

is listed in the first row (column heading) of the data source. "PostalCode" and "LastName" are examples of data field 

names. Placeholders that insert text into an e-mail message or document automatically. )  

See also: dynamic values (A placeholder that inserts text into a Microsoft Dynamics CRM record automatically. You can 

set dynamic values for the entities or records in a workflow only by using the Form Assistant pane. )  

 

data map (A file that contains information about how data from a source system corresponds to data in Microsoft 

Dynamics CRM. )  

 

data migration (The process of loading data from another customer relationship management system into Microsoft 

Dynamics CRM. )  

 

deactivate (To make a record unavailable for updating (read-only) while maintaining the data. This is usually preferable 

to deleting a record, which removes all data. )  

 

default filter (Criteria used to limit data in Microsoft SQL Server Reporting Services reports. Typically, the default filter 

restricts data to active records that have been modified within a certain time period. )  

 

delimited text (A file that contains data in which individual field values are separated by commas, tabs, semicolons, or 

other characters. Delimited text file names typically end with a.txt file extension (for example, "my_file.txt"). )  

See also: comma-separated value (CSV) file (A data file with a.csv file extension. Typically a CSV file consists of fields 

and records, stored as text, in which the fields are separated from one other by commas. )  

 

department (An organizational level of a company. For example, marketing department, accounting department, and 

research and development department. In Microsoft Dynamics CRM, a department can be represented by a business 

unit. )  

See also: business unit (A way of representing a division or department in a company. Business units are arranged in a 

hierarchy, and all users are assigned to one business unit. ), division (An organizational level of a company. Divisions 

can be based on geography, (East Division, West Division); product specializations, (New Technologies Division); or any 

other characteristics. In Microsoft Dynamics CRM, a division can be represented by a business unit. ), organization (The 

top level of the business hierarchy. The organization is divided into business units. There can be only one organization 

per deployment. )  

 

direct e-mail (The distribution of marketing materials in e-mail over an intranet or the Internet, usually to a large 
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number of recipients. The e-mail goes to each recipient individually, giving the appearance of the communication being 

sent personally. )  

 

discount (A reduction in the selling price of products or services. Discounts are usually offered by the seller when the 

buyer agrees to meet specific conditions. )  

 

discount list (A group of price reductions that can be applied to a product, based on volume purchased. Discount lists 

can be added to price list items in a product. )  

See also: price list (A group of the specific prices that can be charged for each unit in the unit group of a product. Price 

lists are used to determine the pricing in a quote for a customer. A default price list can be added to a product. ), 

product (An item in the product catalog. Products can be linked to other records, such as quotes, campaigns, and 

cases. ), unit group (A compilation of the different measurements that a product is available in. A unit group contains 

the base unit in which a product is available, for example, a two-liter bottle. It then lists all the different increments that 

this base unit is packaged in for sale, such as an individual two-liter bottle or a case of 6 two-liter bottles, and also 

indicates which measurement is the primary unit. )  

 

disqualify (To verify that a record does not fit specific criteria and should not be converted to an opportunity, account, 

or contact, or be added to a marketing list. )  

 

distribute (To create campaign activities for each account, contact, or lead in a marketing list associated with a 

campaign, and then to assign the activities to the specified owners, or to perform the activities automatically (such as 

sending e-mail messages). )  

 

division (An organizational level of a company. Divisions can be based on geography, (East Division, West Division); 

product specializations, (New Technologies Division); or any other characteristics. In Microsoft Dynamics CRM, a 

division can be represented by a business unit. )  

See also: business unit (A way of representing a division or department in a company. Business units are arranged in a 

hierarchy, and all users are assigned to one business unit. ), organization (The top level of the business hierarchy. The 

organization is divided into business units. There can be only one organization per deployment. )  

 

draft contract (A contract that has not been activated or invoiced. )  

 

duplicate detection (Process of automatically identifying potential duplicate records. )  

 

dynamic values (A placeholder that inserts text into a Microsoft Dynamics CRM record automatically. You can set 

dynamic values for the entities or records in a workflow only by using the Form Assistant pane. )  

 

E 

entitlement (The service support that is available to a customer, as written in a contract. For example, the type of 

support and the total number of minutes with a customer service representative. )  

See also: case (A customer service issue or problem reported by a customer and the activities that customer service 

representatives use to resolve it. ), contract (An agreement to provide support during specified coverage dates or for a 

specified number of cases or length of time. When customers contact customer service, the level of support they 

receive is determined by their contract. )  

 

entity (A structure used to manage data. Microsoft Dynamics CRM entities include Account, Case, and Activity. )  

See also: record type (A group of records. For example, all account records are grouped as the Account record type. 

Also called an entity. )  

 

equipment (The tools or assets used to perform a service activity. )  

See also: facility (A physical space, such as a conference room or service bay, where a service activity can be 

performed. ), resource (A user that performs a service, or the equipment or facility that is required for a service. ), 



 

482 Microsoft Dynamics CRM 4.0 User’s Guide 
 

service (A type of work performed for a customer by one or more resources. Services are schedulable activities. )  

 

Express mode (A mode of the Data Migration Wizard used when you already have a data map and do not need to 

review the mappings in the map. In this mode, you map only files, columns, and users that are not included in the data 

map. )  

 

F 

facility (A physical space, such as a conference room or service bay, where a service activity can be performed. )  

See also: equipment (The tools or assets used to perform a service activity. ), resource (A user that performs a service, 

or the equipment or facility that is required for a service. ), service (A type of work performed for a customer by one or 

more resources. Services are schedulable activities. )  

 

field delimiter (Character used to separate columns of data in a file. )  

 

filtered view (A view of data in the Microsoft Dynamics CRM database used for reports and exported dynamic Microsoft 

Office Excel files. When users view a report or file that uses a filtered view, they can see only the data that they have 

permission to view. )  

 

fiscal year (A span of time during which the financial activities of an organization are calculated. A fiscal year is divided 

into fiscal periods, typically defined as semesters, quarters, or months. The organization determines the dates that 

begin and end its fiscal year, which may not correspond to a traditional calendar year. )  

See also: sales quota (A revenue objective specified as a monetary amount that has been assigned to a salesperson for 

a specified fiscal period. )  

 

form (A page that displays detailed information that users have entered into Microsoft Dynamics CRM about a specific 

record, such as all information about a contact. Information that users enter in a form is stored in Microsoft Dynamics 

CRM as a record. )  

See also: list (The summary view for a group of records, such as accounts or contacts, or the result of an Advanced 

Find query. You can view detailed information about a record by opening the form for the record. ), record (An entry in 

the Microsoft Dynamics CRM database that stores all the information about a specific item, such as a contact. Records 

are like individual index cards in an index-card filing system. You can view basic information about records in a list, and 

you can view or change detailed information about records in a form. )  

 

Form Assistant pane (A search pane that displays a list of filtered records. The records displayed are determined by 

which field that you are in and what data that you enter. In some areas of Microsoft Dynamics CRM, you can also 

create a follow-up activity from the Form Assistant pane pane. Using the Form Assistant pane is an alternative to using 

the Look Up Records dialog box. )  

 

G 

globally unique identifier (GUID) (A unique 128-bit value that is used to identify a record. )  

H 

 

I 

IFRAME (A windowless inline floating frame that is typically used for including Web pages in a form. Examples of Web 

pages that can be included are a page from a Microsoft SharePoint site, a section of HTML such as a button, or a 

custom application. )  

 

import (Process for uploading data from a comma-separated value (CSV) file to Microsoft Dynamics CRM by using the 

Import Data Wizard. )  
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Import Data Wizard (A wizard used to import multiple records from a comma-delimited text file into Microsoft Dynamics 

CRM as records. )  

 

Index (The dynamic alphabet bar located on the bottom of the lists in the Microsoft Dynamics CRM application window. 

When a letter or the number sign (#) is clicked, the list displays the available records by that letter. )  

See also: Advanced Find (A tool used to search for specific records and activities. ), view (A filter applied to a list of 

records. Users can choose different views that contain all the records or activities of a particular type or that are a 

subset of that type. )  

 

invoice (An order that has been billed. An invoice is also a record of a sale to a customer, including details about the 

products or services purchased. )  

See also: order (A confirmed request for delivery of goods or services based on specified terms. An order is a quote 

that has been accepted by a customer. ), quote (A formal offer for products or services, proposed at specific prices and 

related payment terms, which is sent to an opportunity, account, or contact. )  

 

ISV.Config (An XML configuration document used to update the navigation structure of Microsoft Dynamics CRM, 

including adding custom buttons, tabs, and menus to entity forms. )  

 

J 

 

K 

kit (A group of finished items that compose a set. In Microsoft Dynamics CRM, a kit is comprised of a set of products in 

the product catalog. )  

 

kit product (Any product in the product catalog that is part of a kit. )  

 

knowledge base (A feature in Microsoft Dynamics CRM that provides a process for drafting, submitting, reviewing, and 

publishing articles about an organization's products and services. Users with manager-level security roles can approve, 

reject, add comments to, and unpublish articles that are submitted for review. )  

See also: article (A text-based piece of content in the knowledge base. ), template (A framework for an e-mail 

message, contract, or article. Templates are used to ensure consistent layouts and content in similar types of 

documents. )  

 

L 

lead (A potential customer who must be qualified or disqualified as a sales opportunity. If a lead is qualified, it can be 

converted to an opportunity, account, and/or contact. )  

See also: account (A company that might do business with your organization. ), contact (A person who represents a 

customer or potential customer, or an individual related to an account. For example, an individual who purchases 

products or services for their own use, or an employee of an account. A contact may also be a person involved in a 

business transaction, such as a supplier or a colleague. ), opportunity (A potential revenue-generating event or sale to 

an account that needs to be tracked through a sales process to completion. )  

 

list (The summary view for a group of records, such as accounts or contacts, or the result of an Advanced Find query. 

You can view detailed information about a record by opening the form for the record. )  

See also: form (A page that displays detailed information that users have entered into Microsoft Dynamics CRM about a 

specific record, such as all information about a contact. Information that users enter in a form is stored in Microsoft 

Dynamics CRM as a record. ), record (An entry in the Microsoft Dynamics CRM database that stores all the information 

about a specific item, such as a contact. Records are like individual index cards in an index-card filing system. You can 

view basic information about records in a list, and you can view or change detailed information about records in a form. 

)  
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list view (See "view". )  

 

local data (Data that is available offline and stored on the local computer. )  

 

local data group (A filter that determines what data is available offline and stored on the local computer. )  

 

locale (A combination of language and geographic location used to format the display of the date, time, currency, and 

various measurements. )  

 

logical operator (An element of logic that affects the outcome of a logical expression. Examples of logical operators 

include Equals and Contains. In Microsoft Dynamics CRM, logical operators are used in Advanced Find queries, as well 

as in workflow conditions and dynamic values. )  

See also: query relational operator (Part of an expression (for example "is equal to" or "contains") that defines how a 

specified attribute should be compared with a value. )  

 

M 

manual discount (The amount subtracted from the set price of a product or service. )  

See also: discount list (A group of price reductions that can be applied to a product, based on volume purchased. 

Discount lists can be added to price list items in a product. ), volume discount (The amount subtracted from the unit of 

a product or service based on the volume purchased. )  

 

map (To identify where specific data in a source file should be imported or migrated into Microsoft Dynamics CRM. )  

 

marketing list (A list of accounts, contacts, or leads that matches a specific set of criteria. )  

 

marketing list members (Accounts, contacts, or leads that are included in a marketing list. )  

 

master record (The record that stays active when records are merged. Data from the subordinate record is added to 

this record. )  

See also: subordinate record (The record that is deactivated when records are merged. Data from the subordinate 

record is added to the master record. )  

 

matchcode (A code that is created for every record that a duplicate-detection rule might apply to, used as part of the 

process of detecting duplicates. )  

 

N 

Navigation Pane (The column on the left side of Microsoft Dynamics CRM that includes panes, such as Workplace and 

Marketing, and the categories within each pane. Click a category under the pane to show the items in the list. )  

See also: Form Assistant pane (A search pane that displays a list of filtered records. The records displayed are 

determined by which field that you are in and what data that you enter. In some areas of Microsoft Dynamics CRM, you 

can also create a follow-up activity from the Form Assistant pane pane. Using the Form Assistant pane is an alternative 

to using the Look Up Records dialog box. ), Site Map (An XML representation of the structure of the Navigation Pane 

in Microsoft Dynamics CRM, including the areas, groups, and subareas where entities are displayed, and the privileges 

associated with each subarea. )  

 

O 

on-demand workflow (A type of workflow that only runs when a user chooses to apply it to records from a toolbar or 

menu in Microsoft Dynamics CRM. )  

See also: automatic workflow (A type of workflow that runs as soon as the conditions defined in the workflow logic are 

met. No user action is required to start the workflow. )  
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opportunity (A potential revenue-generating event or sale to an account that needs to be tracked through a sales 

process to completion. )  

See also: account (A company that might do business with your organization. ), contact (A person who represents a 

customer or potential customer, or an individual related to an account. For example, an individual who purchases 

products or services for their own use, or an employee of an account. A contact may also be a person involved in a 

business transaction, such as a supplier or a colleague. ), lead (A potential customer who must be qualified or 

disqualified as a sales opportunity. If a lead is qualified, it can be converted to an opportunity, account, and/or contact. 

)  

 

opportunity relationship (A type of relationship role that describes the relationship between an account or contact and 

an opportunity. )  

 

order (A confirmed request for delivery of goods or services based on specified terms. An order is a quote that has 

been accepted by a customer. )  

See also: invoice (An order that has been billed. An invoice is also a record of a sale to a customer, including details 

about the products or services purchased. ), quote (A formal offer for products or services, proposed at specific prices 

and related payment terms, which is sent to an opportunity, account, or contact. )  

 

organization (The top level of the business hierarchy. The organization is divided into business units. There can be only 

one organization per deployment. )  

See also: business unit (A way of representing a division or department in a company. Business units are arranged in a 

hierarchy, and all users are assigned to one business unit. ), division (An organizational level of a company. Divisions 

can be based on geography, (East Division, West Division); product specializations, (New Technologies Division); or any 

other characteristics. In Microsoft Dynamics CRM, a division can be represented by a business unit. )  

 

originating lead (The source of the lead that led to an account or opportunity. )  

See also: lead (A potential customer who must be qualified or disqualified as a sales opportunity. If a lead is qualified, it 

can be converted to an opportunity, account, and/or contact. )  

 

P 

parent account (An account record associated with one or more other account records. )  

 

parent business unit (A business unit that is immediately above another business unit in the business hierarchy of an 

organization. )  

 

parent record (A record that is in a hierarchical relationship with a child record, where a reference to the record is 

stored in the child record. One parent record can be related to many child records. )  

 

parental (A relationship between entities in which any action taken on a record of the parent entity is also taken on any 

child entity records that are related to the parent entity record. For example, if you delete a record in the parent entity, 

the related child entity records are also deleted; or if you share a parent entity record, the related records from the 

child entity are also shared. )  

 

parallel wait branch (An element of workflow logic that defines an alternative wait condition with a corresponding set of 

additional steps that are performed only when the initial criterion is met. You can use parallel wait branches to create 

timeouts in your workflow logic. They help prevent the workflow from waiting indefinitely until the criteria defined in a 

wait condition have been met. )  

 

POP3 (A common protocol that is used to retrieve e-mail messages from an Internet e-mail server. )  

 

price list (A group of the specific prices that can be charged for each unit in the unit group of a product. Price lists are 

Haghighat Sabet
Highlight

Haghighat Sabet
Highlight

Haghighat Sabet
Highlight

Haghighat Sabet
Highlight



 

486 Microsoft Dynamics CRM 4.0 User’s Guide 
 

used to determine the pricing in a quote for a customer. A default price list can be added to a product. )  

See also: discount list (A group of price reductions that can be applied to a product, based on volume purchased. 

Discount lists can be added to price list items in a product. ), product (An item in the product catalog. Products can be 

linked to other records, such as quotes, campaigns, and cases. ), unit group (A compilation of the different 

measurements that a product is available in. A unit group contains the base unit in which a product is available, for 

example, a two-liter bottle. It then lists all the different increments that this base unit is packaged in for sale, such as 

an individual two-liter bottle or a case of 6 two-liter bottles, and also indicates which measurement is the primary unit. )  

 

Prices Locked (A type of pricing behavior that prevents changes to the price per unit for products in open orders or 

invoices. Even if a price changes in the product catalog, the original price will remain for any open orders or invoices in 

which Prices Locked has been enabled. )  

See also: Use Current Pricing (A type of pricing behavior that directly associates the price per unit for a product with the 

price listed in the product catalog. If a price changes in the product catalog, the unit price changes in any open invoices 

or orders. )  

 

pricing method (The approach that determines what amount will be charged for an item in the product catalog. You can 

choose to use the prices defined in the product catalog or you can override the default prices with a specific amount or 

a percentage. )  

 

primary unit (The measurement used to define the most commonly sold unit of a product. )  

See also: base unit (The initial measurement of a product. A unit group contains the lowest unit of measurement in 

which a product is available, such as a liter. It then lists all the different increments that this base unit is packaged in 

for sale, and indicates which one is the primary unit. ), unit group (A compilation of the different measurements that a 

product is available in. A unit group contains the base unit in which a product is available, for example, a two-liter 

bottle. It then lists all the different increments that this base unit is packaged in for sale, such as an individual two-liter 

bottle or a case of 6 two-liter bottles, and also indicates which measurement is the primary unit. )  

 

privilege (A user's right to perform a specific action on a specific record type or to perform a task. Privileges are 

assigned by system administrators to security roles. Users are then assigned security roles. Examples of privileges 

include Update Account and Publish Customizations. )  

See also: security role (A defined set of privileges. The security role assigned to a user determines which tasks the user 

can perform and which parts of the user interface the user can view. All users must be assigned at least one security 

role in order to access the system. )  

 

probability (The likelihood of something happening. For example, the probability of a sale being made. )  

 

product (An item in the product catalog. Products can be linked to other records, such as quotes, campaigns, and 

cases. )  

See also: discount list (A group of price reductions that can be applied to a product, based on volume purchased. 

Discount lists can be added to price list items in a product. ), price list (A group of the specific prices that can be 

charged for each unit in the unit group of a product. Price lists are used to determine the pricing in a quote for a 

customer. A default price list can be added to a product. ), unit group (A compilation of the different measurements 

that a product is available in. A unit group contains the base unit in which a product is available, for example, a two-

liter bottle. It then lists all the different increments that this base unit is packaged in for sale, such as an individual two-

liter bottle or a case of 6 two-liter bottles, and also indicates which measurement is the primary unit. )  

 

product catalog (A compilation of all products that are available for sale. )  

See also: discount (A reduction in the selling price of products or services. Discounts are usually offered by the seller 

when the buyer agrees to meet specific conditions. ), kit (A group of finished items that compose a set. In Microsoft 

Dynamics CRM, a kit is comprised of a set of products in the product catalog. ),  

 

Q 
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qualify (To verify that a record fits specific criteria and should be converted to an opportunity, account, or contact, or 

be added to a marketing list. )  

 

query relational operator (Part of an expression (for example "is equal to" or "contains") that defines how a specified 

attribute should be compared with a value. )  

See also: logical operator (An element of logic that affects the outcome of a logical expression. Examples of logical 

operators include Equals and Contains. In Microsoft Dynamics CRM, logical operators are used in Advanced Find 

queries, as well as in workflow conditions and dynamic values. )  

 

queue (A holding container for activities that need to be completed. There are queues that contain cases and activities 

in the Workplace, and queues of articles in the knowledge base. )  

See also: Workplace (A pane in the Navigation Pane that contains the work a user has been assigned, is currently 

working on, and is available in queues to which the user has access. Users can accept, assign, and delete assignments 

from here. Users can also access their calendars and the knowledge base. )  

 

quick campaign (A communication method that creates a single activity for distribution to a group of marketing lists, 

accounts, contacts, or leads. Contrast with campaigns, which support end-to-end marketing programs that have 

multiple activities. )  

 

quote (A formal offer for products or services, proposed at specific prices and related payment terms, which is sent to 

an opportunity, account, or contact. )  

See also: invoice (An order that has been billed. An invoice is also a record of a sale to a customer, including details 

about the products or services purchased. ), order (A confirmed request for delivery of goods or services based on 

specified terms. An order is a quote that has been accepted by a customer. )  

 

R 

record (An entry in the Microsoft Dynamics CRM database that stores all the information about a specific item, such as 

a contact. Records are like individual index cards in an index-card filing system. You can view basic information about 

records in a list, and you can view or change detailed information about records in a form. )  

See also: form (A page that displays detailed information that users have entered into Microsoft Dynamics CRM about a 

specific record, such as all information about a contact. Information that users enter in a form is stored in Microsoft 

Dynamics CRM as a record. ), list (The summary view for a group of records, such as accounts or contacts, or the result 

of an Advanced Find query. You can view detailed information about a record by opening the form for the record. )  

 

record type (A group of records. For example, all account records are grouped as the Account record type. Also called 

an entity. )  

See also: entity (A structure used to manage data. Microsoft Dynamics CRM entities include Account, Case, and Activity. 

), related entity (An entity that is associated with a primary entity (record type) through a unique reference defined by 

using a lookup control on the related entity form. For example, an account has a unique reference to a primary contact. 

)  

 

referential (A relationship between two entities in which you can navigate to any related records, but actions taken on 

one will not affect the other. )  

See also: configurable cascade (A relationship between parent and child entities in which any action taken on a parent 

entity record can also be applied to any child entity records that are related to the parent entity record. You can define 

the behavior for each type of action. For example, you can set it up so that if you share a record in the parent entity, 

any related records for the child entity are not automatically shared. But if you delete a parent entity record, any 

related child entity records are automatically deleted. ), parental (A relationship between entities in which any action 

taken on a record of the parent entity is also taken on any child entity records that are related to the parent entity 

record. For example, if you delete a record in the parent entity, the related child entity records are also deleted; or if 

you share a parent entity record, the related records from the child entity are also shared. ), referential, restrict delete 

(A relationship between two entities in which you can navigate to any related records. Actions taken on the parent 
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record will not be applied to the child record, but the parent record cannot be deleted while the child record exists. 

However, you cannot delete a record when related records exist. )  

 

referential, restrict delete (A relationship between two entities in which you can navigate to any related records. Actions 

taken on the parent record will not be applied to the child record, but the parent record cannot be deleted while the 

child record exists. However, you cannot delete a record when related records exist. )  

See also: configurable cascade (A relationship between parent and child entities in which any action taken on a parent 

entity record can also be applied to any child entity records that are related to the parent entity record. You can define 

the behavior for each type of action. For example, you can set it up so that if you share a record in the parent entity, 

any related records for the child entity are not automatically shared. But if you delete a parent entity record, any 

related child entity records are automatically deleted. ), parental (A relationship between entities in which any action 

taken on a record of the parent entity is also taken on any child entity records that are related to the parent entity 

record. For example, if you delete a record in the parent entity, the related child entity records are also deleted; or if 

you share a parent entity record, the related records from the child entity are also shared. ), referential (A relationship 

between two entities in which you can navigate to any related records, but actions taken on one will not affect the 

other. )  

 

relationship role (A definition of one side of a business relationship between accounts, opportunities, or contacts. )  

 

resource (A user that performs a service, or the equipment or facility that is required for a service. )  

See also: equipment (The tools or assets used to perform a service activity. ), facility (A physical space, such as a 

conference room or service bay, where a service activity can be performed. ), service (A type of work performed for a 

customer by one or more resources. Services are schedulable activities. ), user (A person who has an active user 

account in Microsoft Dynamics CRM. )  

 

resource group (Two or more resources (users, facilities, or equipment) that can be scheduled interchangeably. )  

 

S 

sales forecast (An estimate of sales revenue that typically spans a specific period, such as a month, quarter of a year, 

one half of a year, or a full year. Sales forecasts are determined by information that is derived from opportunity 

records. )  

 

sales literature (The documents that are created with specific information about products or services and given to 

customers to help increase sales. )  

See also: competitor (A company or organization that might compete for sales opportunities with your business unit. 

Competitor records can be linked to opportunity, product, and sales literature records so that they are available when 

you are competing for a sale. ), product (An item in the product catalog. Products can be linked to other records, such 

as quotes, campaigns, and cases. )  

 

sales quota (A revenue objective specified as a monetary amount that has been assigned to a salesperson for a 

specified fiscal period. )  

See also: fiscal year (A span of time during which the financial activities of an organization are calculated. A fiscal year 

is divided into fiscal periods, typically defined as semesters, quarters, or months. The organization determines the dates 

that begin and end its fiscal year, which may not correspond to a traditional calendar year. )  

 

sales territory (A segment of an organization's market that is assigned to a salesperson or a group of salespeople. )  

 

saved view (An Advanced Find search that has been saved. Saved views are personal views that appear in the View 

lists for the record types they are searching on. With saved views, you can save the criteria of a search to use again 

later. You can also share your saved views with others. )  

See also: Advanced Find (A tool used to search for specific records and activities. ), view (A filter applied to a list of 

records. Users can choose different views that contain all the records or activities of a particular type or that are a 

Haghighat Sabet
Highlight



 

 

 Microsoft Dynamics CRM 4.0 User’s Guide 489 

 

subset of that type. )  

 

schedule (A list of times that a resource is available for work. Also, a list of service activities for a specific period of 

time. )  

See also: service activity (A schedulable appointment to provide a service to a customer. A service activity uses one or 

more resources to perform a service at a specific time and place. )  

 

security role (A defined set of privileges. The security role assigned to a user determines which tasks the user can 

perform and which parts of the user interface the user can view. All users must be assigned at least one security role in 

order to access the system. )  

See also: access level (A security role setting that determines, for a given entity, who can access records. There are 

four options: just the owner of the record, all users in the current business unit, all users in the current or child 

business unit, or all users. ), privilege (A user's right to perform a specific action on a specific record type or to perform 

a task. Privileges are assigned by system administrators to security roles. Users are then assigned security roles. 

Examples of privileges include Update Account and Publish Customizations. )  

 

selection rule (A set of criteria that specifies which personnel, equipment, facilities, or resource groups are required to 

perform a service, or how to select these resources, based on parameters like quantity and capacity. )  

 

service activity (A schedulable appointment to provide a service to a customer. A service activity uses one or more 

resources to perform a service at a specific time and place. )  

See also: appointment (An activity represented by a time interval that has a start time, an end time, and a duration. An 

appointment does not include a service or check for conflicts, and you cannot search for available times. ), service (A 

type of work performed for a customer by one or more resources. Services are schedulable activities. )  

 

service coverage (The specific hours and days of the week for which service support will be provided. This is defined in 

the contract template, but is not enforced by the system. )  

See also: allotment type (A unit of service, such as a case or a range of coverage dates, specified in a service contract 

that indicates how much access a customer has to customer service. ), billing frequency (A pre-defined period of time 

that specifies how often a customer should be billed. Common billing frequencies are monthly, quarterly, and annually. 

), contract line (A line item in a contract that describes the service support to be provided. A contract line often includes 

pricing information and how support will be allotted. )  

 

service level (The type of service specified in a contract. The default levels are gold, silver, or bronze. Like medals in a 

competition, gold denotes the highest level of service and bronze the lowest. The organization determines what each 

service level offers. Some common differentiations between levels include response time and access to specialists. )  

 

service restriction (A limitation of when a resource can perform a specific service. )  

 

share (To allow another user or team to have a specified amount of access to a record, such as a case, account, or 

contract. For example, you can share an account with a team and specify that its members can read the account 

record, but cannot have write access to it. )  

See also: assign (To specify the owner of a record, such as an account or case, or an activity, such as an e-mail 

message or phone call. Users can assign cases and activities to either a user or a queue. )  

 

SIC Code (Standard Industrial Classification code. A four-digit number assigned by the U.S. government to designate 

the economic activity of a business. )  

 

site (A business location to which resources are assigned. A site is used to ensure that all resources required for a 

service are in the same physical location. )  

 

Site Map (An XML representation of the structure of the Navigation Pane in Microsoft Dynamics CRM, including the 

areas, groups, and subareas where entities are displayed, and the privileges associated with each subarea. )  
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See also: Navigation Pane (The column on the left side of Microsoft Dynamics CRM that includes panes, such as 

Workplace and Marketing, and the categories within each pane. Click a category under the pane to show the items 

in the list. )  

 

snapshot (A static file that contains the results of a report that was run at a particular time. )  

 

snapshot definition (A collection of settings required to produce a snapshot, including user credentials, filter criteria, 

parameters, and schedule information. )  

 

status (The state of a record or activity. For example, a case can be Active or Resolved, and an e-mail activity can have 

a status of Draft or Sent. Status is also used by workflow rules to determine when to move to the next stage in a 

workflow or sales process. )  

See also: status reason (The description of the status of a record or activity. For example, if a case has a status of 

Active, the status reason could be Researching or Waiting for Details. The options available are based on what type of 

record is open and the status of the record. When the status of a record changes, if more than one status reason is 

possible, a dialog box is displayed to enable the user to select the appropriate status reason. ), workflow rule (A set of 

action steps in a business process or sales process. Workflow rules determine the required activities for a workflow and 

the order in which those activities must be performed. )  

 

status reason (The description of the status of a record or activity. For example, if a case has a status of Active, the 

status reason could be Researching or Waiting for Details. The options available are based on what type of record is 

open and the status of the record. When the status of a record changes, if more than one status reason is possible, a 

dialog box is displayed to enable the user to select the appropriate status reason. )  

See also: status (The state of a record or activity. For example, a case can be Active or Resolved, and an e-mail activity 

can have a status of Draft or Sent. Status is also used by workflow rules to determine when to move to the next stage 

in a workflow or sales process. )  

 

subordinate record (The record that is deactivated when records are merged. Data from the subordinate record is 

added to the master record. )  

See also: master record (The record that stays active when records are merged. Data from the subordinate record is 

added to this record. )  

 

synchronization (The exchange of data between a user's local data and the Microsoft Dynamics CRM database so that 

the data is the same. )  

 

system attribute (An attribute that is included in Microsoft Dynamics CRM by default. For example, the name attribute 

in the Account entity is a system attribute. )  

See also: custom attribute (An attribute that is not included in Microsoft Dynamics CRM by default. Instead, a customer 

or partner adds it after they install the software, to help adapt the software to the customer's needs. )  

 

system entity (An entity that is included in Microsoft Dynamics CRM by default, such as Account. )  

See also: custom entity (An entity that is not included in Microsoft Dynamics CRM by default. You can create custom 

entities by using the customization tools. ), entity (A structure used to manage data. Microsoft Dynamics CRM entities 

include Account, Case, and Activity. ), related entity (An entity that is associated with a primary entity (record type) 

through a unique reference defined by using a lookup control on the related entity form. For example, an account has a 

unique reference to a primary contact. )  

 

system job (A process that Microsoft Dynamics CRM performs independently or in the background. Other processes can 

be started before a system job has finished. Examples of system jobs include workflow jobs and duplicate detection 

jobs. )  

See also: workflow job (A type of system job that performs the actions defined in a workflow on a specific record. )  
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T 

team (A group of users who share and collaborate on business records. A team can consist of members who all report 

to one business unit or members who report to different business units. )  

See also: share (To allow another user or team to have a specified amount of access to a record, such as a case, 

account, or contract. For example, you can share an account with a team and specify that its members can read the 

account record, but cannot have write access to it. )  

 

template (A framework for an e-mail message, contract, or article. Templates are used to ensure consistent layouts and 

content in similar types of documents. )  

 

ticker symbol (An identification code used to identify a publicly traded corporation on a particular stock market. )  

 

timeout (A type of wait condition in workflow logic that stops all actions in the workflow until a specified time. You can 

create a timeout by selecting the following values for the wait condition: Workflow (under Local Values), Timeout, 

Equals, and a date or specific time. )  

 

track (To link between a record in Microsoft Dynamics CRM and Microsoft Office Outlook. Records that are marked for 

tracking are updated in both applications, including creating new activities. )  

 

transform (To concatenate multiple columns, split a column, replace a string, use a substring, or modify a date while 

migrating data. )  

 

U 

unit (A measurement that specifies in what quantity a product will be sold. )  

See also: base unit (The initial measurement of a product. A unit group contains the lowest unit of measurement in 

which a product is available, such as a liter. It then lists all the different increments that this base unit is packaged in 

for sale, and indicates which one is the primary unit. ), primary unit (The measurement used to define the most 

commonly sold unit of a product. ), unit group (A compilation of the different measurements that a product is available 

in. A unit group contains the base unit in which a product is available, for example, a two-liter bottle. It then lists all the 

different increments that this base unit is packaged in for sale, such as an individual two-liter bottle or a case of 6 two-

liter bottles, and also indicates which measurement is the primary unit. )  

 

unit group (A compilation of the different measurements that a product is available in. A unit group contains the base 

unit in which a product is available, for example, a two-liter bottle. It then lists all the different increments that this 

base unit is packaged in for sale, such as an individual two-liter bottle or a case of 6 two-liter bottles, and also indicates 

which measurement is the primary unit. )  

See also: base unit (The initial measurement of a product. A unit group contains the lowest unit of measurement in 

which a product is available, such as a liter. It then lists all the different increments that this base unit is packaged in 

for sale, and indicates which one is the primary unit. ), discount list (A group of price reductions that can be applied to 

a product, based on volume purchased. Discount lists can be added to price list items in a product. ), price list (A group 

of the specific prices that can be charged for each unit in the unit group of a product. Price lists are used to determine 

the pricing in a quote for a customer. A default price list can be added to a product. ), primary unit (The measurement 

used to define the most commonly sold unit of a product. ), product (An item in the product catalog. Products can be 

linked to other records, such as quotes, campaigns, and cases. ), unit (A measurement that specifies in what quantity a 

product will be sold. ), unit group (A compilation of the different measurements that a product is available in. A unit 

group contains the base unit in which a product is available, for example, a two-liter bottle. It then lists all the different 

increments that this base unit is packaged in for sale, such as an individual two-liter bottle or a case of 6 two-liter 

bottles, and also indicates which measurement is the primary unit. )  

 

Use Current Pricing (A type of pricing behavior that directly associates the price per unit for a product with the price 

listed in the product catalog. If a price changes in the product catalog, the unit price changes in any open invoices or 

orders. )  
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See also: Prices Locked (A type of pricing behavior that prevents changes to the price per unit for products in open 

orders or invoices. Even if a price changes in the product catalog, the original price will remain for any open orders or 

invoices in which Prices Locked has been enabled. )  

 

user (A person who has an active user account in Microsoft Dynamics CRM. )  

See also: resource (A user that performs a service, or the equipment or facility that is required for a service. )  

 

V 

view (A filter applied to a list of records. Users can choose different views that contain all the records or activities of a 

particular type or that are a subset of that type. )  

See also: associated view (The view of an entity that is displayed in the forms of other entities. The associated view is 

different from the views that are visible for the entity in its own area of the user interface. For example, in an account 

record, under Details, you can click Contacts to view and open a contact form. That is the Contacts associated view. 

There can be only one associated view of each entity. ), Index (The dynamic alphabet bar located on the bottom of the 

lists in the Microsoft Dynamics CRM application window. When a letter or the number sign (#) is clicked, the list 

displays the available records by that letter. ), form (A page that displays detailed information that users have entered 

into Microsoft Dynamics CRM about a specific record, such as all information about a contact. Information that users 

enter in a form is stored in Microsoft Dynamics CRM as a record. ), list (The summary view for a group of records, such 

as accounts or contacts, or the result of an Advanced Find query. You can view detailed information about a record by 

opening the form for the record. ), record (An entry in the Microsoft Dynamics CRM database that stores all the 

information about a specific item, such as a contact. Records are like individual index cards in an index-card filing 

system. You can view basic information about records in a list, and you can view or change detailed information about 

records in a form. )  

 

volume discount (The amount subtracted from the unit of a product or service based on the volume purchased. )  

See also: discount list (A group of price reductions that can be applied to a product, based on volume purchased. 

Discount lists can be added to price list items in a product. ), manual discount (The amount subtracted from the set 

price of a product or service. )  

 

W 

wait condition (An element of workflow logic that enables a workflow to pause itself until the criteria defined by the 

condition have been met. The workflow starts again automatically when the criteria in the wait condition have been 

met. )  

 

work hours (The times that a user is available to be scheduled for appointments and service activities. This includes 

start and end times, breaks, and time off. )  

 

workflow (A set of logical rules that define the steps necessary to automate a specific business process, task, or set of 

actions to be performed on Microsoft Dynamics CRM records. )  

 

workflow actions (Elements of workflow logic that specify the actions that should be performed by workflow jobs when 

conditions defined in the workflow have been met. )  

 

workflow job (A type of system job that performs the actions defined in a workflow on a specific record. )  

See also: system job (A process that Microsoft Dynamics CRM performs independently or in the background. Other 

processes can be started before a system job has finished. Examples of system jobs include workflow jobs and 

duplicate detection jobs. )  

 

workflow logic (All of the conditions, actions, and other logical elements that define when and how a particular 

workflow takes action on Microsoft Dynamics CRM records. )  
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workflow scope (The range of records that a particular workflow is allowed to take action on. The options available 

when you specify the scope of a workflow depend on the access level that you have on your workflow's primary entity. 

Workflow jobs started by your workflow will not take action on records owned at a higher access level than your access 

level. )  

 

workflow stage (An element of workflow logic that groups steps. Adding stages to a workflow does not affect how the 

steps function. Stages are purely for conceptual grouping of steps within complex workflows. )  

 

workflow step (An element of workflow logic that defines a unit of business logic within a workflow. Steps can include 

conditions, actions, other steps, or a combination of these elements. )  

 

workflow template (A type of workflow that serves exclusively as the basis for creating other workflows. Workflow 

templates cannot start workflow jobs. )  

 

Workplace (A pane in the Navigation Pane that contains the work a user has been assigned, is currently working on, 

and is available in queues to which the user has access. Users can accept, assign, and delete assignments from here. 

Users can also access their calendars and the knowledge base. )  
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